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Chapter 1. Overview of the IBM Flex System management
node

IBM® Flex System Manager management software is the software stack for
managing multiple chassis that comes preinstalled on the Flex System Manager
Types 7955, 8731, and 8734 management node. It provides a consistent interface
that you can use to efficiently manage more than one chassis.

The Flex System Manager Types 7955, 8731, and 8734 management node is
supported in the Flex System Enterprise Chassis only.

The Flex System Manager Types 7955, 8731, and 8734 management node comes
with a limited warranty. For information about the terms of the warranty and
getting service and assistance, see the Warranty Information document on the IBM
Documentation CD. You can obtain up-to-date information about the management
node at http://www.ibm.com/supportportal/.

This documentation might be updated occasionally to include information about
new features. Technical updates might also be available to provide additional
information that is not included in the documentation.

You can subscribe to information updates that are specific to the management node
at http://www.ibm.com/support/mynotifications/.

The model number and serial number are on the ID label that is located next to the
power LED on the management node bezel. They are also on a label on the side of
the management node that is visible when the management node is not in the Flex
System Enterprise Chassis.

What’s new in version 1.3.2
IBM Flex System Manager management software version 1.3.2 provides new
features and enhancements.

Compute node support

Version 1.3.2 supports the following compute nodes:
v IBM Flex System® x880
v Lenovo Flex System x240 M5, Grantley
v Lenovo Flex System x440, Ivy Bridge Refresh

Switch module support

Version 1.3.2 extends support to the following switch modules:
v Support for Fibre Channel over Ethernet on the IBM Flex System EN4023 10Gb

Scalable Switch

Additional hardware support

Version 1.3.2 extends support to the following additional hardware components:
v IBM Flex System CN4058 8-port 10 Gb Virtual Fabric Adapter for the System

x880 compute node

© Copyright IBM Corp. 2012, 2015 1

http://www.ibm.com/supportportal/
http://www.ibm.com/support/mynotifications/


v IBM Flex System EN4172 2-port 10Gb Ethernet Adapter
v IBM Flex System CN4052 2-port 10Gb Virtual Fabric Adapter
v IBM Flex System CN4058S 8-port 10Gb Virtual Fabric Adapter
v Feature-on-Demand upgrade of the IBM Flex System CN4058 to support Fibre

Channel over Ethernet
v Support for the following IBM eXFlash Memory Channel Storage on the System

x8731 management and x880 compute nodes:
– IBM eXFlash 200GB DDR3 Storage DIMM
– IBM eXFlash 400GB DDR3 Storage DIMM

Before you begin
Use this background information to learn more about IBM Flex System Manager
management software and Flex System Manager Types 7955, 8731, and 8734
documentation resources.

Related documentation
Use this information to identify and locate related documentation.

This documentation contains general information about the IBM Flex System
Manager management software, including how to configure and use the software
to manage resources in multiple chassis.

IBM Flex System Manager management software documentation

In addition to this document, the following documentation is also available in the
IBM Flex System Manager Information Center at http://publib.boulder.ibm.com/
infocenter/flexsys/information/index.jsp:
v Flex System Manager Types 7955, 8731, and 8734 Installation and Service Guide

v IBM Flex System Manager Command Reference Guide

v IBM Flex System Manager Management Software Troubleshooting Guide

v IBM Flex System Manager Service and Support Manager (Electronic Service Agent™)

v IBM Flex System Manager Network Control

v IBM Flex System Manager VMControl

IBM Flex System Chassis Management Module documentation
v Chassis Management Module Installation Guide

This document explains how to install a Chassis Management Module in an Flex
System Enterprise Chassis. See the IBM Flex System Chassis Management
Module Installation Guide at http://publib.boulder.ibm.com/infocenter/flexsys/
information/topic/com.ibm.acc.cmm.doc/dw1ku_cmm_ig_book.pdf for more
information.

v Chassis Management Module Command-Line Interface Reference Guide

This document explains how to use the Chassis Management Module
command-line interface (CLI) to directly access Flex System Enterprise Chassis
management functions. See the IBM Flex System Chassis Management Module
User's Guide at http://publib.boulder.ibm.com/infocenter/flexsys/information/
topic/com.ibm.acc.cmm.doc/dw1kt_cmm_cli_book.pdf for more information.

v Chassis Management Module Events

This section in the information center provides a complete list of all
non-device-specific events and recommended actions, sorted by event ID. See
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http://publib.boulder.ibm.com/infocenter/flexsys/information/topic/
com.ibm.acc.8721.doc/cmm_error_messages.html for more information.

v Chassis Management Module User's Guide

This document provides information about configuring a Chassis Management
Module and managing components that are installed in an Flex System
Enterprise Chassis. This document explains how to use the Chassis Management
Module command-line interface (CLI) to directly access Flex System Enterprise
Chassis management functions. See the IBM Flex System Chassis Management
Module User's Guide at http://publib.boulder.ibm.com/infocenter/flexsys/
information/topic/com.ibm.acc.cmm.doc/dw1kt_cmm_ug_pdf.pdf for more
information.

Flex System Enterprise Chassis and IBM Flex System compute
node documentation
v Flex System Enterprise Chassis Installation and Service Guide

This document explains how to install, configure, and service the Flex System
Enterprise Chassis. See the Flex System Enterprise Chassis Installation and
Service Guide at http://publib.boulder.ibm.com/infocenter/flexsys/
information/topic/com.ibm.acc.8721.doc/nn1gw_chassis_pdf.pdf for more
information.

v Flex System x240 Compute Node Installation and Service Guide

The Flex System x240 Compute Node is an X-Architecture compute node that
can be managed by management software. This document contains installation
and service information about the compute node. See the Flex System x240
Compute Node Installation and Service Guide at http://
publib.boulder.ibm.com/infocenter/flexsys/information/topic/
com.ibm.acc.8737.doc/dw1ko_book.pdf for more information.

v IBM Flex System p260 Compute Node and IBM Flex System p460 Compute Node
Installation and Service Guide

The Flex System p260 and p460 Compute Nodes can be managed by
management software. This document contains installation and service
information about the compute node. See the IBM Flex System p260 and p460
Compute Nodes Installation and Service Guide at http://
publib.boulder.ibm.com/infocenter/flexsys/information/topic/
com.ibm.acc.7895.doc/ps7895_pdf.pdf for more information.

To check for updated documentation, go to http://www.ibm.com/supportportal/.

The IBM Documentation CD
The IBM Documentation CD contains documentation for your hardware in Portable
Document Format (PDF). It includes the IBM Documentation Browser to help you
find information quickly.

You can run the IBM Documentation CD on any computer that meets the hardware
and software requirements.

Hardware and software requirements
Use this information to determine the minimum hardware and software
requirements.

The IBM Documentation CD requires the following minimum hardware and
software:
v Microsoft Windows or Red Hat Linux
v 100 MHz microprocessor
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v 32 MB of RAM
v Adobe Acrobat Reader 3.0 (or later) or xpdf, which comes with Linux operating

systems

Using the Documentation Browser
Use this information to start the Documentation Browser.

Use the Documentation Browser to browse the contents of the CD, read brief
descriptions of the documents, and view documents, using Adobe Acrobat Reader
or xpdf. The Documentation Browser automatically detects the regional settings in
use in your system and displays the documents in the language for that region (if
available). If a document is not available in the language for that region, the
English-language version is displayed.

Use one of the following procedures to start the Documentation Browser:
v If Autostart is enabled, insert the CD into the CD or DVD drive. The

Documentation Browser starts automatically.
v If Autostart is disabled or is not enabled for all users, use one of the following

procedures:
– If you are using a Windows operating system, insert the CD into the CD or

DVD drive and click Start → Run. In the Open field, type
e:\win32.bat

where e is the drive letter of the CD or DVD drive, and click OK.
– If you are using Red Hat Linux, insert the CD into the CD or DVD drive;

then, run the following command from the /mnt/cdrom directory:
sh runlinux.sh

Select the compute node from the Product menu. The Available Topics list
displays all the documents for the compute node. Some documents might be in
folders. A plus sign (+) indicates each folder or document that has additional
documents under it. Click the plus sign to display the additional documents.

When you select a document, a description of the document is displayed under
Topic Description. To select more than one document, press and hold the Ctrl key
while you select the documents. Click View Book to view the selected document
or documents in Acrobat Reader or xpdf. If you selected more than one document,
all the selected documents are opened in Acrobat Reader or xpdf.

To search all the documents, type a word or word string in the Search field and
click Search. The documents in which the word or word string appears are listed
in order of the most occurrences. Click a document to view it. Press Ctrl+F to use
the Acrobat search function, or press Alt+F to use the xpdf search function within
the document.

Click Help for detailed information about using the Documentation Browser.

Notices and statements in this document
Use this information to understand the most common documentation notices and
statements and how they are used.
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The caution and danger statements in this document are also in the multilingual
Safety Information document, which is on the IBM Documentation CD. Each
statement is numbered for reference to the corresponding statement in the Safety
Information document.

The following notices and statements are used in this document:
v Note: These notices provide important tips, guidance, or advice.
v Important: These notices provide information or advice that might help you

avoid inconvenient or problem situations.
v Attention: These notices indicate possible damage to programs, devices, or data.

An attention notice is placed just before the instruction or situation in which
damage might occur.

v Caution: These statements indicate situations that can be potentially hazardous
to you. A caution statement is placed just before the description of a potentially
hazardous procedure step or situation.

v Danger: These statements indicate situations that can be potentially lethal or
hazardous to you. A danger statement is placed just before the description of a
potentially lethal or hazardous procedure step or situation.

Managed resources
Use the information in this section to understand the types of compute nodes and
the Chassis Management Module (CMM) in Flex System Enterprise Chassis that
IBM Flex System Manager management software can manage.

The management software provides centralized configuration and management
functions for the node, network, power, and cooling devices in multiple Flex
System Enterprise Chassis. All communication to and from the management
software to the chassis devices is through the secure management network of the
Chassis Management Module (CMM).

For more information about network requirements for managed resources, see
“Network configuration and requirements” in the IBM Flex System Manager®

Systems Management Guide document..

Note: The network devices and storage resources that can be managed by the
management software are not described in this section. For more information about
supported network devices, see http://publib.boulder.ibm.com/infocenter/flexsys/
information/topic/com.ibm.acc.networkdevices.doc/network.html. For more
information about supported storage components, see http://
publib.boulder.ibm.com/infocenter/flexsys/information/topic/
com.ibm.director.storagectrl.helps.doc/fqm0_c_sc_overview.html.

Chassis Management Module (CMM) in an IBM Flex System
environment

An Flex System Manager Types 7955, 8731, and 8734 management node in an Flex
System Enterprise Chassis manages Chassis Management Modules (CMMs) in
multiple chassis.

The management software on an Flex System Manager Types 7955, 8731, and 8734
management node can manage multiple Flex System Enterprise Chassis, including
CMMs. After a management node is installed in a chassis, the management
software configures and uses the CMMs, integrated management modules, Flexible
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Service Processors (if applicable), and network devices. The management software
is the systems-management focal point for each chassis that it manages.

Note: A CMM can be managed by only one management node.

For more information about CMMs, see http://publib.boulder.ibm.com/
infocenter/flexsys/information/topic/com.ibm.acc.cmm.doc/
cmm_product_page.html.

X-Architecture compute nodes in an IBM Flex System
environment

IBM X-Architecture compute nodes are one type of compute node that is available
for the Flex System Enterprise Chassis that can be managed by the management
software.

IBM X-Architecture compute nodes come with Intel Xeon microprocessors and
provide the function, reliability, and performance of the X-Architecture systems in
a small-form-factor design. They support a variety of Microsoft Windows, Linux,
and VMware operating systems and are ideally suited for high-performance and
virtualized environments such as memory-intensive computing, collaboration,
general and mission-critical processing, and enterprise application workloads. All
models come with an integrated management module (IMM) that connects to the
Chassis Management Module to provide the integrated systems-management
functions for the node.

The Flex System PCIe Expansion Node and Flex System Storage Expansion Node
are optional nodes that can be installed in an Flex System Enterprise Chassis and
connected to an X-Architecture compute node. All system-management functions
of the PCIe expansion node and Storage expansion node must be performed
through the connected compute node; the expansion nodes do not interact directly
with the management node or Chassis Management Module (CMM). For more
information about the PCIe expansion node, see http://publib.boulder.ibm.com/
infocenter/flexsys/information/topic/com.ibm.acc.pme.doc/product_page.html.
For more information about the Storage expansion node, see the Flex System Storage
Expansion Node Installation and Service Guide.

For more information about managing X-Architecture compute nodes with the
management software, see http://publib.boulder.ibm.com/infocenter/flexsys/
information/topic/com.ibm.director.systemx_bc.helps.doc/
fqm0_t_managing_systemx_bc.html.

Power Systems compute nodes in an IBM Flex System
environment

IBM Power Systems™ compute nodes are one type of compute node that is
available for the Flex System Enterprise Chassis that can be managed by the
management software.

IBM Flex System Manager management software is required for Power Systems
compute nodes installed in a Flex System Enterprise Chassis.

IBM Power Systems compute nodes come with IBM Power7 microprocessors and
provide the function, reliability, and performance of the Power7 systems in a
small-form-factor design. They support a variety of AIX®, Linux, and IBM i OS
operating systems and are ideally suited for demanding commercial workloads
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and virtualized environments such as collaboration, application development,
modeling and simulation, critical-business processing, and cloud computing. All
models come with a Flexible Service Processor (FSP) that connects to the Chassis
Management Module to provide the integrated systems-management functions for
the node.

Important:

v IBM Flex System Manager manages Power Systems differently than
X-Architecture compute nodes. For more information about managing Power
Systems compute nodes with the management software, see
http://publib.boulder.ibm.com/infocenter/flexsys/information/topic/
com.ibm.acc.8731.doc/managing_power_systems.html.

v IBM Flex System Manager management software version 1.1.0 is compatible
with IBM Flex System p260 and p460 Compute Nodes running 740 firmware
with 74x updates only.

Storage systems and network switches in an IBM Flex System
environment

You can manage and configure system storage, including storage subsystems and
network switches, with the management software in a Flex System environment.

The management software is capable of managing storage configurations that
include the following components:
v Flex System storage nodes installed in a Flex System Enterprise Chassis, such as

the IBM Flex System V7000 Storage Node
v Some external storage subsystems, such as the IBM Storwize® V7000 and IBM

System Storage® SAN Volume Controller
v Storage network devices, including Fibre Channel and Fibre Channel over

Ethernet switches like the IBM Flex System FC3171 8Gb SAN Switch and IBM
Flex System FC5022 16Gb SAN Switch

For more information about managing and configuring system storage with the
management software, see Chapter 19, “Managing external storage resources,” on
page 599.

For more information about the Flex System V7000, see the http://
publib.boulder.ibm.com/infocenter/flexsys/information/topic/
com.ibm.acc.4939.doc/site_product_page.html documentation. For more
information about the Storwize V7000, see http://publib.boulder.ibm.com/
infocenter/storwize/ic/index.jsp.

For more information about the network devices that are available for your Flex
System environment, see http://publib.boulder.ibm.com/infocenter/flexsys/
information/topic/com.ibm.acc.networkdevices.doc/network.html.

Port and operating system requirements
IBM Flex System Manager management software has specific requirements for
management node ports and operating systems that are installed on managed
compute nodes. These requirements comprise the specified operating environment
for the management software and the resources that it manages.
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Port availability
IBM Flex System Manager processes require access to a number of ports in the
installation and systems-management environment. If these ports are blocked by a
firewall or used by another process, some management software functions might
not work.

About this task

The following tables show the predefined port values for the IBM Flex System
Manager management node and managed systems.

Note:

1. You cannot change the port values on the management node.
2. When the management software security policy is set to Legacy, you can open

or close some ports. For example the chLegacyProtocol command opens and
closes the following ports:
v 20 (FTP)
v 23 (Telnet)
v 69 (TFTP)
v 80/8421 (HTTP)
v 162 (SNMP)

3. Port 9520 is opened as needed on the management node for Secure File
Transfer Protocol (SFTP) communication. This TCP port enables inbound
communication from managed endpoints to the management node.

Management software ports

The IBM Flex System Manager configuration processes and web server require
access to a number of ports on the management node. If these ports are blocked by
a firewall or used by another process, the configuration fails. By default, the IBM
Flex System Manager requires the following ports:
v 8091
v 8421
v 8422
v 20000

Note: By default, port 8421 is closed. You can open the port with the
chLegacyProtocol command.

Managed system ports

Make sure that the managed system ports in the following table are open and
accessible to the management software. Managed systems include Common Agent
managed systems and Platform Agent managed systems.
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Table 1. Ports on managed systems

Port
TCP or
UDP Direction Communication description

22 TCP Inbound SSH communication with:

v Chassis Management Module (CMM)

v I/O modules

v Platform Agent installed on systems running Linux,
including Power Systems compute nodes

v SSH used by Power® systems

v Non-Windows Agentless managed systems

135 TCP, UDP Inbound (Windows only) Software installation and remote access
communication with Platform Agent

137 TCP, UDP Inbound (Windows only) Communication with Agentless managed
systems using Microsoft Windows DCOM

138 TCP, UDP Inbound (Windows only) Communication with Agentless managed
systems using Microsoft Windows DCOM

139 TCP, UDP Inbound (Windows only) Communication with Agentless managed
systems using Windows Server Message Block (SMB)

161 UDP Inbound SNMP agent communication with:

v Chassis Management Module (CMM)

v I/O modules and network devices that are outside the
chassis

v Platform Agent
Note: This port is used when the SNMP agent for the
operating system is configured.

v Non-Windows Agentless managed systems
Note: This port is used when the SNMP agent for the
operating system is configured.

427 TCP, UDP Outbound and Inbound SLP communication with:

v Chassis Management Module (CMM)

v Common Agent

v Platform Agent

v Service Location Protocol (SLP) service agent or SLP
directory agent

445 TCP, UDP Inbound (UDP) (Windows only) Open on Agentless and Platform Agent
managed systems for the following features:

v Software installation

v Remote access communication

v (Agentless-managed systems only) Inventory collection

623 UDP Outbound Remote Management and Control Protocol (RMCP) unsecure
communication with IPMI baseboard management controller
(BMC) service processors

636 TCP Outbound Used for LDAP

3888 TCP, UDP Inbound and Outbound Remote Control application

3900 TCP, UDP Inbound and Outbound Remote Control application

5988 TCP Outbound and Inbound (Windows and Red Hat Enterprise Linux) CIM Server unsecure
port
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Table 1. Ports on managed systems (continued)

Port
TCP or
UDP Direction Communication description

5989 TCP Outbound and Inbound v (Windows and Red Hat Enterprise Linux) CIM Server secure
port

v CIMOM for Power Systems management

6987 TCP Inbound CIM listener for indications over http

6989 TCP Inbound CIM listener for indications over http

6990 TCP Inbound CIM listener for indications over https

9510 TCP Inbound Communication with Common Agent and CAS Web services

9511-9513 TCP Outbound Used for Agent manager

14252 TCP, UDP Inbound, Outbound Source port for SLP communication

There are undocumented ports used by IBM Flex System
Manager and Common Agent. The default source port is 14252
for both the server and agent.

When firewalls are used to block traffic on unused ports, you
must open additional source ports in order for Service Locator
Protocol (SLP) discovery to work. On both the management
node and the agent, the configured or default source port plus
the next sequential 25 ports must be opened. You may need to
open more or fewer source ports, depending on the number of
systems being discovered concurrently. Generally, if the
discovery of many systems at a time is attempted and fails,
more source ports need be opened, up to a maximum of 75. If
discovery is done for only a small number of systems at a time,
fewer ports need to be opened.

The source port can be overridden on both the server and
agent by configuring the port in the slp.prop file.

15988 TCP Outbound and Inbound v (For SUSE Linux Enterprise Server) CIM Server (alternative
unsecure port) communication with Platform Agent
managed system

v Service processor communication with SUSE Linux
Enterprise Server 10.

v CIM Server (alternative unsecure port) communication with
Platform Agent managed system

15989 TCP Outbound and Inbound (For SUSE Linux Enterprise Server) CIM Server (alternative
secure port) communication with Platform Agent managed
system

20000 TCP Inbound v CAS events

v Communication with VMware

Note: If you plan to manage systems running VMware
VirtualCenter, or VMware ESX Server, see the VMware
documentation to make sure port requirements are met.

49153 TCP Inbound Used for SNMP alert
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Procedure

Option Description

Management software The IBM Flex System Manager configuration
processes and Web server require access to a
number of ports on the management server.
If these ports are blocked by a firewall or
used by another process, the configuration
fails. By default, IBM Flex System Manager
server requires the following ports:

v 8091

v 8421

v 8422

v 20000

Note: By default, port 8421 is closed. You
can open the port with the
chLegacyProtocol command.

Preparing firewalls and proxies for IBM Flex System Manager
You must configure the firewalls and proxy server to enable operation of IBM Flex
System Manager if you have firewalls in your network, or if the management node
must use a proxy server to access the internet.

About this task

IBM Flex System Manager must be able to access all the managed objects in the
network, and if you use a remote web browser to access the management node,
the remote systems running the web browser and the management node must
have access to each other. In addition, some functions of IBM Flex System
Manager, including update manager, require access to the Internet.

To enable this access, you must configure firewalls and proxies in your network to
allow access by IBM Flex System Manager components.

Complete the following steps to configure firewalls and proxies in your network:

Procedure
1. Identify the ports that you use in your systems-management environment and

ensure that those ports are open before you start installation. For example, you
must ensure that the listener ports for IBM Flex System Manager and Common
Agent are open.

Note: HTTP port 80 is must be open to download updates by using Update
Manager.

2. Ensure that internet connections exist to the following internet addresses as
they are required by IBM Flex System Manager and various plug-ins.

Note: IP addresses are subject to change, so ensure that you use DNS names
whenever possible.

Important: When you test whether the internet connections are configured
correctly, ensure that all the following addresses and ports are open on the
firewall.
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Table 2. Required internet connections

DNS name IP address Ports Protocols

Update manager and Service and Support Manager

www.ibm.com 129.42.56.216,
129.42.58.216,
129.42.60.216

443 and 80 https and http

www-03.ibm.com 204.146.30.17 443 and 80 https and http

download3.boulder.ibm.com 170.225.15.76 443 and 80 https and http

download3.mul.ie.ibm.com 129.35.224.114 443 and 80 https and http

download4.boulder.ibm.com 170.225.15.107 443 and 80 https and http

download4.mul.ie.ibm.com 129.35.224.107 443 and 80 https and http

delivery04-bld.dhe.ibm.com 170.225.15.104,
129.35.224.104

443 and 80 https and http

delivery04-mul.dhe.ibm.com 129.35.224.115,
170.225.15.115

443 and 80 https and http

delivery04.dhe.ibm.com 129.35.224.105,
170.225.15.105

443 and 80 https and http

eccgw01.boulder.ibm.com 207.25.252.197 443 https

eccgw02.rochester.ibm.com 129.42.160.51 443 https

Service and Support Manager only

www-945.ibm.com 129.42.26.224,
129.42.42.224,
129.42.50.224

443 https

www6.software.ibm.com 170.225.15.41 443 https

www.ecurep.ibm.com 192.109.81.20 443 https

testcase.boulder.ibm.com 170.225.15.31 21 ftps

3. If the management node requires access to the Internet but does not have direct
access, complete the following steps to configure the management server to use
the proxy when accessing the Internet:
a. Ensure that the selected proxy server is configured to use basic

authentication. The update manager task supports only basic authentication
with the proxy server. If digest or NTLM authentication are required,
update manager will be unable to access update packages from IBM.

b. Use the update manager Settings page to configure the management server
to use the proxy server.

What to do next

Note:

v Service and Support Manager makes outbound calls to send and receive data. It
does not support inbound calls.

v A DNS configuration is the best practice especially in a proxy or firewall
environment.

Operating systems supported by IBM Flex System Manager
IBM Flex System Manager 1.3.4 provides support for many operating systems.
However, support varies depending on the selected hardware.
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IBM Flex System Manager supports only products that are currently supported by
the owners or manufacturers of that product. If a product is no longer supported
by its owner or manufacturer, it is implicit that IBM Flex System Manager also no
longer supports that product.

Unless stated otherwise, IBM Flex System Manager provides agentless support for
all operating systems listed in this topic.

Note: IBM Flex System Manager is supported on VMware ESX Server if IBM Flex
System Manager is supported on the selected guest operating system. Supported
guest operating systems are those that are supported by both IBM Flex System
Manager and the specified version of VMware. See the VMware product
documentation for a list of supported operating systems.

Table 3. Windows versions supported by IBM Flex System Manager on X-Architecture compute nodes

Operating system
Common
Agent

Platform
Agent

Editions of Windows for 32-bit systems:

Windows Server 2003 Datacenter Edition, Release 2 (service pack 2) X X

Windows Server 2003, Enterprise and Standard Editions, Release 2 (service pack 2) X X

Windows Server 2003 Datacenter Edition (service pack 2) X X

Windows Server 2003, Enterprise and Standard Editions (service pack 2) X X

Windows Server 2008 Datacenter Edition (service packs 1 and 2) X X

Windows Server 2008, Enterprise and Standard Editions (service packs 1 and 2) X X

Editions of Windows for 64-bit systems:

Windows Server 2003 Datacenter x64 Edition, Release 2 (service pack 2) X X

Windows Server 2003, Enterprise and Standard x64 Editions, Release 2 (service pack
2)

X X

Windows Server 2003 Datacenter x64 Edition (service pack 2) X X

Windows Server 2003, Enterprise and Standard x64 Editions (service pack 2) X X

Windows Server 2008 Datacenter x64 Edition (service packs 1 and 2) X X

Windows Server 2008, Enterprise and Standard x64 Editions (service packs 1 and 2) X X

Windows Server 2008 Datacenter x64 Edition, Release 2 (with or without service
pack 1)

X X

Windows Server 2008, Enterprise and Standard x64 Editions, Release 2 (with or
without service pack 1)

X X

Windows Server 2008, Enterprise, Standard, and Datacenter x64 Editions with
Hyper-V role enabled, Release 2 (with or without service pack 1)

X X

Windows Server 2008, Enterprise, Standard, and Datacenter x64 Editions with
Hyper-V role enabled, (service packs 1 and 2)

X X

Guest OS information is found in Table 4 of this topic.

Windows Server 2012, all Editions
Note: For more information about agentless discovery of a Windows Server 2012
compute node, see Windows Server 2012 managed systems.

X X

Windows Server 2012 R2 X X
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Table 4. Linux versions supported by IBM Flex System Manager on System x systems (IBM and third-party
x86-based systems)

Operating system
Common
Agent

Platform
Agent

Versions of Linux for 32-bit systems:

Red Hat Enterprise Linux Advanced Platform, version 5.0 (Updates 1, 2, 3, 4, 5, 6, 7,
and 8)

X X

Red Hat Enterprise Linux, version 5.0 (Updates 1, 2, 3, 4, 5, 6, 7, and 8) X X

Red Hat Enterprise Linux Desktop with Workstation option, version 5.0 (Updates 1,
2, 3, 4, 5, 6, 7 and 8)

X X

Red Hat Enterprise Linux, All Editions, version 5.0, with Xen Kernel (Updates 1, 2, 3,
4, 5, 6, 7, and 8)

X

Red Hat Enterprise Linux Advanced Platform, version 6.0 (Updates 1, 2, and 3)
Restriction: You cannot manage the RSA in-band. You can manage it out-of-band by
connecting it to the network and discovering it with IBM Flex System Manager.

X X

Red Hat Enterprise Linux, version 6.0 (Updates 1, 2, and 3)
Restriction: You cannot manage the RSA in-band. You can manage it out-of-band by
connecting it to the network and discovering it with IBM Flex System Manager.

X X

Red Hat Enterprise Linux Desktop with Workstation option, version 6.0 (Updates 1,
2, and 3)
Restriction: You cannot manage the RSA in-band. You can manage it out-of-band by
connecting it to the network and discovering it with IBM Flex System Manager.

X X

SUSE Linux Enterprise Server 10 for x86 (service packs 1, 2, 3, and 4) X X

SUSE Linux Enterprise Server 10, with Xen Kernel (service packs 1, 2, 3, and 4) X

SUSE Linux Enterprise Server 11 for x86 (service packs 1, 2, and 3)

Restriction: You cannot manage the RSA in-band. You can manage it out-of-band by
connecting it to the network and discovering it with IBM Flex System Manager.

X X

Versions of Linux for 64-bit systems:

Red Hat Enterprise Linux Advanced Platform, version 5.0, for AMD64 and EM64T
(Updates 1, 2, 3, 4, 5, 6, 7, and 8)

X X

Red Hat Enterprise Linux, version 5.0, for AMD64 and EM64T (Updates 1, 2, 3, 4, 5,
6, 7, and 8)

X X

Red Hat Enterprise Linux Desktop with Workstation option, version 5.0, for AMD64
and EM64T (Updates 1, 2, 3, 4, 5, 6, 7, and 8)

X X

Red Hat Enterprise Linux, All Editions, version 5.0, for AMD64 and EM64T, with
Xen Kernel (Updates 1, 2, 3, 4, 5, 6, 7, and 8)

X

Red Hat Enterprise Linux Advanced Platform, version 6.0, for AMD64 and EM64T
(Updates 1, 2, and 3)
Restriction: You cannot manage the RSA in-band. You can manage it out-of-band by
connecting it to the network and discovering it with IBM Flex System Manager.

X X1

Red Hat Enterprise Linux, version 6.0, for AMD64 and EM64T (Updates 1, 2, and 3)
Restriction: You cannot manage the RSA in-band. You can manage it out-of-band by
connecting it to the network and discovering it with IBM Flex System Manager.

X X1

Red Hat Enterprise Linux Desktop with Workstation option, version 6.0, for AMD64
and EM64T (Updates 1, 2, and 3)
Restriction: You cannot manage the RSA in-band. You can manage it out-of-band by
connecting it to the network and discovering it with IBM Flex System Manager.

X X1

SUSE Linux Enterprise Server 10 for AMD64 and EM64T (service packs 1, 2, 3, and
4)

X X
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Table 4. Linux versions supported by IBM Flex System Manager on System x systems (IBM and third-party
x86-based systems) (continued)

Operating system
Common
Agent

Platform
Agent

SUSE Linux Enterprise Server 10, for AMD64 and EM64T, with Xen Kernel (service
packs 1, 2, 3, and 4)

X

SUSE Linux Enterprise Server 11 for AMD64 and EM64T (service packs 1, 2, and 3)
Restriction: You cannot manage the RSA in-band. You can manage it out-of-band by
connecting it to the network and discovering it with IBM Flex System Manager.

X X

1 If you use Linux Kernel-based Virtual Machine (KVM), you can install either the IBM Flex System Manager
6.3.2 Platform Agent for RHEL 6 for Linux on IBM x86-64 on KVM to enable virtualization tasks, or you can
install the IBM Flex System Manager 6.3.2 Platform Agent for Linux on IBM x86 for basic platform management
capabilities.

Table 5. VMware ESX Server, standard VMware ESXi, and IBM customized VMware ESXi, versions supported by
IBM Flex System Manager on X-Architecture compute nodes

Operating system
Common
Agent

Platform
Agent

Standard VMware ESXi and IBM customized VMware ESXi, version 4.0, Update 1,
and 2; version 4.1, Update 1 and 2; all under the control of VMware vCenter.
Note: Standard VMware ESXi and IBM customized VMware ESXi are supported on
agentless managed systems. IBM customized VMware ESXi offers in-band alerting of
hardware events.

Standard VMware vSphere and IBM customized VMware vSphere, version 5.0, 5.0
updates 1, 2, and 3; version 5.1, 5.1 updates 1 and 2; version 5.5; all under the
control of VMware vCenter.
Note: Standard VMware vSphere and IBM customized VMware vSphere are
supported on agentless managed systems. IBM customized VMware vSphere offers
in-band alerting of hardware events.

Table 6. Support for guest operating systems

Operating system
Common
Agent

Platform
Agent

Supported guest operating systems are those that are supported by both IBM Flex
System Manager and the hypervisor. In other words, if the following conditions are
true:

1. the given OS platform supported is documented in this topic

2. the given OS platform is supported as a guest OS by a hypervisor

3. the hypervisor is supported by IBM Flex System Manager

then IBM Flex System Manager support of that OS platform extends to running it as
a guest OS on that hypervisor.

See also the hypervisor product documentation for a list of supported operating
systems.

X X
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Table 7. AIX versions supported by IBM Flex System Manager on IBM Power Systems compute nodes

Operating system
Common
Agent

Platform
Agent

AIX Version 6.1 TL05 to TL09 and all their SPs
Note:

1. Agentless support includes only discovery, limited remote access, a limited subset
of the agent installation wizard, and the ability to start the AIX Management
Console for AIX Version 6.1 agents.

2. An older version of Common Agent is installed with AIX and is started by
default. For more information that describes which Agent version is installed
with which AIX version, see "Common Agent versions shipped with AIX and
VIOS". If you are using the agent installed with AIX 6.1.8.0, make sure to
upgrade to AIX 6.1.8.1.

X

IBM AIX Version 7.1:

v AIX 7.1 TL00 to TL02 and all their SPs

v AIX 7.1 TL03 with all service packs up to SP7

Note:

1. Agentless support includes only discovery, limited remote access, a limited subset
of the agent installation wizard, and the ability to start the AIX Management
Console for AIX Version 7.1 agents.

2. An older version of Common agent is installed with AIX and is started by
default. For more information that describes which Agent version is installed
with which AIX version, see "Common Agent versions shipped with AIX and
VIOS". If you are using the agent installed with AIX 7.1.2.0, make sure to
upgrade to AIX 7.1.2.1.

3. AIX 7.1.3 is the last version of the AIX operating system that supports IBM Flex
System Manager. AIX 7.1.3 is supported for IBM Flex System Manager until IBM
Flex System Manager support ends in April 2018.

X

Table 8. IBM i versions supported by IBM Flex System Manager on IBM Power Systems compute nodes

Operating system
Common
Agent

Platform
Agent

IBM i 7.2i 7.2
Notes:

1. Platform Agent managed system support is provided by the IBM 5770–UME
product.

2. OS and LPP program temporary fix (PTF) updates for IBM i are supported when
they become available.

X

IBM i 7.1i 7.1
Notes:

1. Platform Agent managed system support is provided by the IBM 5770–UME
product.

2. OS and LPP program temporary fix (PTF) updates for IBM i are supported when
they become available.

3. Technology Refresh (TR) 4 is required for VMControl server system pools
support.

X
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Table 8. IBM i versions supported by IBM Flex System Manager on IBM Power Systems compute nodes (continued)

Operating system
Common
Agent

Platform
Agent

IBM i 6.1 (formerly i5/OS, Version 6 Release 1)i 6.1 (formerly i5/OS, Version 6
Release 1)
Notes:

1. Platform Agent managed system support is provided by the IBM 5770–UME
product.

2. OS and LPP program temporary fix (PTF) updates for IBM i are supported when
they become available.

X

Table 9. Linux versions supported by IBM Flex System Manager on IBM Power Systems compute nodes

Operating system
Common
Agent

Platform
Agent

Red Hat Enterprise Linux Advanced Platform, versions 6.0 on IBM Power Systems
compute nodes (Updates 1, 2, 3, 4 and 5)

X X

SUSE Linux Enterprise Server 11 on IBM Power Systems (service packs 1, 2, and 3) X X

Note: See for information on support of Red Hat Enterprise Linux Advanced Platform, versions 5 on IBM Power
Systems and SUSE Linux Enterprise Server 10 on IBM Power Systems with IBM Flex System Manager. Red Hat and
SUSE information is in Table 2 of the above url.

IBM Flex System Manager task support for VMware ESXi
(vSphere) systems

IBM Flex System Manager tasks provide limited task support for both the standard
VMware ESXi (vSphere) product and an IBM customized version of VMware ESXi
(vSphere). The customized version offers in-band alerting of hardware events.

The customized version of VMware ESXi (vSphere) can be downloaded from the
IBM Fix Central website (http://www.ibm.com/support/entry/portal/
search_results?sn=spe&filter=keywords%3Aibmsupportfixcentralsearch&q=IBM
%20Customization%20VMware/). If this version is used, some events can be
managed in-band.

Important:

v Updating firmware on VMware vSphere 5.5 update 1 (ESXi) nodes when using
the IBM Flex System Manager requires the IBM customized image. It is critical
that you apply the latest patches to the vSphere system. You must restart the
vSphere system, and wait 20 minutes before you apply the firmware updates.
Download the VMware vSphere ESXi 5.0 with IBM Customization Patch from
the IBM website at http://www-947.ibm.com/support/entry/portal/
docdisplay?lndocid=MIGR-5091988&brandind=5000008.

v Set up your system for both in-band and out-of-band management to ensure
that all hardware events are forwarded to the IBM Flex System Manager.

Note: You must upgrade to the current VMware ESXi (vSphere) version, if you
plan to manage the VMware ESXi server with IBM Flex System Manager.

The following table outlines the IBM Flex System Manager task support available
for the standard VMware ESXi (vSphere) product and the IBM customized version.
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Table 10. IBM Flex System Manager task support for Standard VMware ESXi (vSphere) and IBM customized
VMware ESXi (vSphere)

Tasks and subtasks Standard VMware
ESXi (vSphere)

IBM customized
VMware ESXi

(vSphere)

Command Automation No No

Event Log Yes Yes1

File Management No No

Inventory (hardware) Yes2 Yes3

Inventory (software) Yes4 Yes5

Problems (formerly Hardware Status) Yes Yes6

Remote Control Yes7 Yes7

Remote Command Line No No

Resource Monitors No No

Storage Manager No Yes8

Virtualization Management Yes Yes9

Update Manager Yes10 Yes10

Notes:

1. Supports events from vendor Common Information Model (CIM) providers and VMware CIM providers.

2. Only supports basic system inventory.

3. Supports additional hardware inventory, for example, inventory of vendor adapters.

4. Only supports basic software inventory.

5. Supports additional inventory for some vendor adapters, such as firmware and driver levels for vendor Fibre
Channel adapters.

6. Supports problem status for vendor adapters.

7. Supports when VMware ESXi (vSphere) is being managed through VMware vCenter.
Restriction: When a VMware ESXi (vSphere) host, attached to VMware vCenter, is in lockdown mode, IBM
Flex System Manager cannot access the VMware ESXi (vSphere) system. Lockdown mode forces all operations
to be done through VMware vCenter. However, VMware vCenter, allows only a privileged VMware vCenter
administrator access to the VMware ESXi (vSphere) host in lockdown mode. Other users cannot carry out any
operations directly on the VMware ESXi (vSphere) host.

8. Only supports LSI, Brocade CIM providers.

9. IBM Flex System Manager with VMControl supports virtualization management for VMware ESXi (vSphere)
hosts.

10. Update manager supports firmware updates to systems that run VMware ESXi (vSphere), but it does not
support updates to VMware ESXi (vSphere). For more information about updating VMware ESXi (vSphere)
systems, see “Update Considerations for VMware ESXi systems”.

Management domains
IBM Flex System Manager management software management domains determine
which resources are under management for a management node.

A management domain consists of the Flex System Enterprise Chassis hardware
and resources that are under management of the management software. The
management domain includes managed chassis and any devices that are managed
by the management software, whether they are internal or external to a chassis.

18 Systems Management Guide



The Management Domain page in the web interface can be used to perform the
following chassis-management actions:
v Manage or unmanage a chassis

Note:

1. Before you unmanage a chassis, make sure that you complete the procedures
that are described in Chapter 13, “Unmanaging a chassis,” on page 517.
Otherwise, the compute nodes in that chassis will not be removed from the
management software.

2. A CMM can be managed only by one management node at a time.
Additionally, if a CMM is managed by one management node, and you want
to manage it with another management node, you must first unmanage the
CMM on the initial management node Management Domain page. After you
click Unmanage, you might have to use the lschassisind command to clear
the settings that link that CMM to the initial management node. After you
clear the settings, you can click Unmanage for the initial management node;
then, you are able to manage the CMM with the new management node.

v Discover a chassis by clicking Discover Chassis. In the Discover New Chassis
dialog, you can automatically discover local chassis, or discover a remote chassis
by selecting Add an external chassis and specifying the hostname, IPv4, or IPv6
address of the external chassis.

v View a list of all chassis (including those that are unmanaged and those that are
managed by another management node in your environment)

v Go to the Chassis Manager page for another management node
v Go to the Chassis Map view for a chassis, regardless of which management node

manages it

See “Using management domains” on page 503 for information about how to
access the Management Domain page.

See “Adding or removing a chassis” on page 504 for information about how to
remove a chassis from a management domain.

Chassis management
IBM Flex System Manager management software can manage multiple Flex System
Enterprise Chassis, including the security policies and user registries on the
Chassis Management Modules (CMMs) in those chassis.

IBM Flex System Manager management software supports both local and external
user registries. A local user registry operates within the IBM Flex System Manager
management software. An external user registry is a registry outside of your IBM
Flex System Manager.

The management software provides a user authentication and authorization system
that can be used by all Flex System Enterprise Chassis components.

For each chassis that is managed by the management software, you can select
whether security policy and user accounts are managed centrally by the
management software (centralized management) or in a distributed fashion on
each CMM (decentralized management). Decentralized management refers to
security policies and user accounts defined on each CMM or security policies and
user accounts in an external user registry (for example, on a Windows Active
Directory server).
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Note: Whether using Centralized or Decentralized management, a CMM can be
managed by only one management node at a time.

Management software user registry
The Flex System Manager Types 7955, 8731, and 8734 and IBM Flex System
Manager management software ensure secure user access through the management
software user registry.

The management software supports both local and external user registries. A local
user registry is in the Flex System Manager Types 7955, 8731, and 8734
management node and the Chassis Management Modules that it manages. An
external user registry is a registry outside your IBM Flex System hardware.

For more information about centralized and decentralized user management and
how to select and configure the user registry, see “Configuring the management
software user registry” on page 141.

The local user registry has the following qualities:
v Through the user registry, you can manage all users of Flex System Enterprise

Chassis hardware.
v External user registry modes work the same with the management software as

with previous IBM BladeCenter hardware.

Note:

1. In addition to the user registry on the management node, IBM Flex System
Manager management software supports Microsoft Active Directory as an
external user registry on an outboard Microsoft Windows server. See Using
Active Directory for more information.

2. If you use an external user registry, it must be connected to the management
network.

Centralized user management
A centralized management configuration uses a single user authentication
repository for all of the Chassis Management Modules (CMMs) in a management
domain. The user accounts that are created for the IBM Flex System Manager
management software are used by all of the CMMs and compute node service
processors in the chassis.

When you use the IBM Flex System Manager management software to place a
chassis under centralized management, the Chassis Management Module (CMM) is
configured to use the registry that is stored on the management node. The local
user accounts in the CMM registry are disabled, and the new user account
RECOVERY_ID is created for future authentication to the CMM (as long as it is
configured to use the centralized user registry on the management node).

Notes:

v Only use the RECOVERY_ID account in an emergency; for example, if the
management node fails, or if a network problem prevents the CMM from
contacting the management node to authenticate users.

v The password for the RECOVERY_ID account is expired by default, and must be
reset during initial login. If you need to use the RECOVERY_ID account, log in
to the CMM with the RECOVERY_ID user name, change the password, and
store the new password where you can find it again in the future.
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v After the CMM is unmanaged (or changed to be managed in decentralized
management mode), all the local CMM accounts are re-enabled, and the
RECOVERY_ID account is deleted.

After the CMM detects the management node user registry, it uses the
management node registry configuration to provision all of the managed resources
in the chassis (except for network switches) so that they also use the central
management node user registry. When you log in to an IMM or FSP on a compute
node in a centrally-managed chassis, you must use a user name and password that
are stored in the IBM Flex System Manager user registry.

With centralized management, a single security policy is distributed and enforced
on all of the Chassis Management Modules in a management domain. In addition,
a single set of user accounts and a single password policy is in effect.

Note: Each CMM that is under centralized user management must match the
security policy level of the management software.

If a CMM does not match the security policy level of the management software, its
status is Out of Sync. In the Chassis Manager view of the management software
web interface, Warning is displayed in the status column. Click Warning to see
details about the user registry and the security policy status.

Note: If your network interface for the management network is configured to use
DHCP, the management interface IP address might change when the DHCP lease
expires. If the IP address changes, you must unmanage the chassis, and then
re-manage the chassis. To avoid this problem, either change the management
interface to a static IP address, or make sure that the DHCP server configuration is
set so that the DHCP address is based on a MAC address or that the DHCP lease
does not expire.

Chassis that are not centrally managed might have different security policies,
different user accounts, and different passwords from those that are set for the
management domain. If chassis are centrally managed, user accounts can be edited
only by the management software.

For more information about managing chassis with a single management node
user registry, see “Using centralized user management” on page 505.

For centralized user management troubleshooting, see “Centralized user
management problems” in the IBM Flex System Manager Management Software
Troubleshooting Guide document.

For information about changing the user management configuration from
decentralized to centralized, or centralized to decentralized, see “Changing the
user management mode of a managed chassis” on page 506.

Decentralized user management
User management is decentralized when a Chassis Management Module (CMM)
uses its own user registry (and not that of the IBM Flex System Manager
management software) or uses an external user registry such as an external LDAP
server.

Note: It is not mandatory for a CMM to match the security policy level of the
management software. However, if the security policies do not match, Warning is
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displayed in the status column in the Chassis Manager view of the management
software web interface. Click Warning to see details about the management
software and CMM user registry and security policy status.

With decentralized management, the user accounts on the management software
and CMMs can be unique. For example, each CMM can have a local myuser
account with different passwords.

Network configuration and requirements
IBM Flex System Manager management software uses a management network to
connect to managed resources in multiple Flex System Enterprise Chassis. An
optional data network supports the discovery of operating systems on managed
resources and provides connections for other management software functionality.

Management and data networks

There are two Ethernet network interfaces for the Flex System Manager Types
7955, 8731, and 8734 management node: Eth0 and Eth1. The Ethernet interface Eth0
is associated with the management network. Eth1 is associated with the data
network. For more information about configuring the network for Flex System
Enterprise Chassis, including network integration diagrams, see
http://publib.boulder.ibm.com/infocenter/flexsys/information/topic/
com.ibm.acc.common.nav.doc/network_integration_planning.html.

Note:

1. The management node console can be connected to the management network
or the data network. To configure the management software to access a single
network that is using a single IP subnet, configure only the Eth0 interface. To
configure Eth0 and Eth1, you must configure them on different IP subnets.

2. To manage a chassis on the local subnet, make sure that the IP address that is
assigned to Eth0 is on the same IPv4 subnet or IPv6 network as the IP address
that is assigned to the CMM. To manage a chassis on another subnet, you must
first discover the chassis manually. After the chassis is discovered, it appears in
the chassis list on the Management Domain page.

When you start the management node for the first time, you must establish an
initial network configuration so that the initial setup wizard is accessible from a
web browser.

Important: DNS server configuration is required on the data network (Eth1) for
the following management software functions:
v Using VMControl to manage virtual machines and operating systems that are

running on compute nodes
v Updating the device drivers in the operating systems that are running on IBM

Power Systems compute nodes

If the management software is managing one or more chassis in centralized user
management mode, and you want to modify the IP address for the Eth0 interface,
you must first unmanage the chassis that are centrally managed. After you modify
the IP address, you can manage the chassis again. For more information, see
“Centralized user management” on page 20.

For more information about initially configuring the network, see “Initial setup” on
page 132. For more information about configuring network settings in the Setup
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wizard, see “Setting up the IBM Flex System Manager management node” on page
132.

Network requirements for the IBM Flex System Manager
management node

To manage a chassis and all resources in a chassis, the IBM Flex System Manager
management node and all other chassis resources must have routable IP addresses
on the management network. Whether you use IPv4 or IPv6 addressing, all
interfaces must have routable IPv4 or IPv6 addresses.

Important: If you use IPv4 and IPv6 for the management node Eth0 (management
network interface), each managed chassis and chassis component must have an
IPv4 address.

You can select an IPv6 Unique Local Address (ULA) IP address to ensure that the
Eth0 port has a valid IP address. If the option was selected when the initial setup
wizard was completed, the management node network port (Eth0) IPv6 address
might have already been assigned.

Important: The management software virtual machine uses the mgmt0 interface to
communicate with the host operating system. Do not change the mgmt0 interface.

Attention: IBM Flex System Manager uses the 10.3.x.x network for internal
communications. The TCP standard states that the 10.x.x.x network is a private
network that cannot be used for routed systems. If FSM is configured on this
network, it is likely that FSM cannot communicate on the network. However, the
Integrated Management Module (IMM2) of FSM on the same network can
communicate without any issue.

Network requirements for managed resources

Be aware of the following network requirements for managed chassis, compute
nodes, and network devices.
v A network device or switch must have a static, DHCPv6, or stateless IP address

assigned to it; a network device with a link-local address (LLA) cannot be
managed by the management software.

Note: When Flex System is set up, the RHEV-H partition uses a specific IP
address (10.3.0.1) that is hardcoded in the system. Therefore, when you manage
resources in Flex System do not use the IP address 10.3.0.1 as it is reserved for
the RHEV-H partition.

v A compute node or storage node that is on the same subnet as the management
node can use an LLA if the configuration is on a flat L2 network (with no
routers). Routers will not forward packets with LLAs. If the configuration is on a
routed network, the compute node must have a static, DHCPv6, or stateless IP
address assigned to it.

v Static addresses can be IPv4 or IPv6.
v If you use IPv4 and IPv6 for the management node Eth0 (management network

interface), each managed chassis and chassis component must have an IPv4
address.

v IPv6 ULAs meet IBM Flex System network requirements. A ULA specifies an IP
address that is globally unique, and is intended for local communications.
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Attention: If the IPv6 ULA option on the Management Domain page is selected
when a chassis is managed, the management software will overwrite any static
or DHCP IPv6 address that was set previously on a Chassis Management
Module (CMM). The IPv6 address for the IBM Flex System management node
must have the same 64-bit prefix as the IPv6 address for the chassis CMMs.

Note:

– A specified prefix or global ID must be unique. The default value is generated
based on an internal time stamp.

– A valid IPv6 address must be assigned to a managed resource before you can
use Configuration Patterns to configure settings for a resource.

v If the Chassis Management Module (CMM) and compute nodes are set up to use
DHCP, and the CMM loses connectivity to the network, the CMM attempts to
acquire a new IP address when network connectivity is restored. The compute
nodes will not attempt to acquire an IP address again; they will continue to use
their original IP addresses. Therefore, if you experience network problems on
compute nodes after connectivity between the CMM and the network is
restored, you might have to reset the service processor on each of the compute
nodes in the chassis (including the management node). See the “Connectivity
problems” topic in the Troubleshooting section of the documentation for your
compute node for more information.

v If you are using centralized user management mode, be aware of a potential
problem with using DHCP. If your network interface for the management
network is configured to use DHCP, the management interface IP address might
change when the DHCP lease expires. If the IP address changes, you must
unmanage the chassis, and then re-manage the chassis. To avoid this problem,
either change the management interface to a static IP address, or make sure that
the DHCP server configuration is set so that the DHCP address is based on a
MAC address or that the DHCP lease does not expire.

v If you are using centralized user management mode, make sure that you change
the user management mode to decentralized before you change the management
network (Eth0) IP address. See “Changing an IBM Flex System Manager
management node IP address” on page 149 for more information.

v The management software can manage an Flex System Enterprise Chassis that is
in a different geographic location than the management node, if the remote
chassis is on the same management network. However, the procedure that is
required to manage a remote chassis differs from the procedure required to
manage a chassis that is on the same network subnet as the management node.
See “Managing a remote chassis” on page 508 for more information.

Security
Unsecured systems-management tools can damage hardware and software. It is
extremely important that you understand all security risks in your system
environment and what you can do to minimize these risks. IBM Flex System
Manager management software offers advanced security capabilities and
user-management settings to help you secure your environment.

For educational information about management software security and user
management, see http://publib.boulder.ibm.com/infocenter/flexsys/information/
topic/com.ibm.acc.common.nav.doc/learning_security.html. For an overview of
IBM Flex System security, see http://publib.boulder.ibm.com/infocenter/flexsys/
information/topic/com.ibm.acc.common.nav.doc/security_planning.html.
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Security policies
An IBM Flex System Manager management software security policy is a set of
security-related characteristics that define a particular level of protection from
security exposures. Depending on its level, the security policy might include
account-related policies, communication-protocol enablement, and event-tracking
levels.

The management software enforces a chosen security policy for all of its managed
resources. The management software offers two types of security policy: Legacy and
Secure. Neither policy is customizable.

The management software communicates with managed chassis and identifies
them as out-of-sync, or as Managed with a warning icon, if the security policy on
the Chassis Management Module (CMM) and the management software do not
match.

If a CMM is in a pending state, the CMM is in the process of distributing its
security policy to all of the devices it manages. The CMM might have to wait for
all the subordinate devices to be restarted or for various other conditions to be
corrected before it activates the new policy.

Note: You might shorten the duration that a CMM is in a pending state if you
restart the components in the chassis that are also in a pending state.

Secure security policy
The IBM Flex System Manager management software Secure security policy is the
most secure and least flexible setting that is available for your configuration.

The Secure security controls setting, or Secure policy, is the default security setting
that establishes a secure chassis infrastructure with a moderate level of user control
over the chassis configuration. It helps to ensure a secure chassis infrastructure and
enforces the use of the following conditions:
v Strong password policies with automatic validation and verification checks

Note: For more information about the password policy settings that are required
for the Secure security policy, see “Password policy settings for the Secure
security policy” on page 32.

v Updated passwords that replace the manufacturing default passwords after the
initial setup

v Only secure communication protocols may be enabled
v Secure and trusted connections are required for all communication with the IBM

Flex System Manager management node

Legacy security policy
The IBM Flex System Manager management software Legacy security policy is the
least secure and most flexible setting that is available for your configuration.

The Legacy level of management software security policy provides flexibility in
managing platform security, but this policy is the least secure. It permits the use of
the following conditions:
v Weak password policies with minimal controls are permitted
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Note: For more information about the password policy settings that are allowed
for the Legacy security policy, see “Password policy settings for the Legacy
security policy” on page 33.

v Manufacturing default passwords that do not have to be changed
v Unencrypted communication protocols such as Telnet, SNMPv1, TCP Command

Mode, FTP Server, and TFTP Server

Changing the management software security policy
You can change the IBM Flex System Manager management software security
policy setting in the web interface.

To change the security policy for all management software management domains
in the web interface, complete the following steps:
1. On the Home page, click the Administration tab.
2. Under Security tasks, click Configure Security Policy. The Configure Security

Policy wizard opens.
3. Select the security policy you want and click OK. The wizard shows the chassis

under centralized management that will be affected by the security policy
change.

Note: The default security policy is Secure (see “Secure security policy” on
page 25).

To change the security policy for a chassis, complete the following steps:
1. On the Chassis Manager page, in the Actions list, select Manage Security

Policy. The Manage Security Policy page opens, and a list of managed chassis
is displayed.

2. On the Manage Security Policy page, select the managed chassis to which you
want to apply the changed security policy and click Set Security Policy.

3. Select the changed security policy from the Select the security policy to apply
to the selected chassis list and click Apply.

4. If any compute nodes are in a Pending state after the security policy changes,
use the Chassis Management Module (CMM) command-line interface (CLI) to
reset the compute node:
a. Open the CMM CLI. See http://publib.boulder.ibm.com/infocenter/

flexsys/information/topic/com.ibm.acc.cmm.doc/cmm_cli_guide.html for
more information.

b. Use the reset command and applicable target to reset each compute node
that is in a Pending state. For more information about using the reset
command, see http://publib.boulder.ibm.com/infocenter/flexsys/
information/topic/com.ibm.acc.cmm.doc/cli_command_reset.html.

Password policies
An IBM Flex System Manager management software password policy is a set of
criteria that determines how management software passwords are created and how
the management software implements password security.

You can set password policy conditions in the web interface that affect all users of
the management software. Although password policy settings can be changed
independently of the management software security policy, the security policy of
the management software might require that the password policy settings have
secure values. For example, if you attempt to change the security policy level from
Legacy to Secure, the management software might require that you change some

26 Systems Management Guide

http://publib.boulder.ibm.com/infocenter/flexsys/information/topic/com.ibm.acc.cmm.doc/cmm_cli_guide.html
http://publib.boulder.ibm.com/infocenter/flexsys/information/topic/com.ibm.acc.cmm.doc/cmm_cli_guide.html
http://publib.boulder.ibm.com/infocenter/flexsys/information/topic/com.ibm.acc.cmm.doc/cli_command_reset.html
http://publib.boulder.ibm.com/infocenter/flexsys/information/topic/com.ibm.acc.cmm.doc/cli_command_reset.html


password policy settings to secure values before the security policy can be changed
to Secure. However, if you change the security policy from Secure to Legacy, but
you do not change the password policy settings, the level of password validation
that occurs remains the same as before.

To change the management software password policy settings, complete the
following steps:
1. From the Home page, click the Administration tab.
2. Under Security tasks, click Configure Password Policy. The Configure

Password Policy window opens.
3. After you change the settings, click OK.

For more information about setting a new password, see “Setting a new password”
on page 29.

Password policy settings
The IBM Flex System Manager management software password policy consists of
the following settings.

The default password policy settings are secure, and are configured to be used
with the default security policy. For more information about the Secure security
policy, see “Secure security policy” on page 25. For more information about the
required password policy settings for the Secure security policy, see “Password
policy settings for the Secure security policy” on page 32.

The Legacy security policy allows more flexible, and less secure, password policy
settings. For more information about the Legacy security policy, see “Legacy
security policy” on page 25. For more information about the password policy
settings that are allowed for the Legacy security policy, see “Password policy
settings for the Legacy security policy” on page 33.

The following table lists the password policy settings displayed in the Configure
password policy window.

Table 11. Password policy settings

Password setting Description

Maximum number of used passwords
remembered

This setting determines the number of
passwords that are maintained in a list of
previously used passwords for a user
account. When a user changes a password,
the new password is checked against the
password history. If the new password is in
the list of previously used passwords, it is
rejected. If the password is not on the list, it
is added, and the oldest password on the list
is deleted. If the value for this setting is 0,
then no list of previously used passwords is
maintained.

Minimum password age (days) This setting determines the number of days
between password changes for a user
account. Any attempts to change a password
before the set amount of time has elapsed
will be rejected. If the value for this setting
is 0, the password can be changed anytime
after the last change.
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Table 11. Password policy settings (continued)

Password setting Description

Maximum password age (days) This setting determines the maximum
number of days that a password remains
valid. After the maximum password age, the
expired password must be changed. If the
value for this setting is 0, passwords never
expire.

Minimum password length (characters) This setting determines the minimum
number of characters that must comprise a
password. For more information about the
types of characters that must be used in
management software passwords, see
“Setting a new password” on page 29.

Password grace authentication limit This setting determines whether a user is
allowed to log in after a password has
expired. If the value for this setting is 0, any
login attempted with an expired password is
rejected and a Supervisor must reset the
user’s password. No grace authentication is
allowed. A value of 1 or more determines
the number of times a user is allowed to
login to change an expired password.

The initial supervisor account (by default,
USERID) can always change their expired
password.

Enable the server to check for password
quality

This setting determines whether the
management node verifies, after a login
attempt, that a user’s password meets the
password character rules described in
“Setting a new password” on page 29.

Accept the password if unable to check it This setting is only applicable if the Enable
the server to check for password quality
box is selected. This setting determines
whether a user can login if the management
node cannot verify the password.

Users must change password at first login. This setting determines whether the user
must change a password at the initial login.

Allow users to change their own passwords This setting determines whether a user is
allowed to change passwords. If the Allow
users to change their own passwords box is
not selected, a management software
administrator must change the password for
the user.

Enable Account lockout This setting determines whether a user is
locked out of the management software after
consecutive attempts to log in with an
invalid password. If the Enable Account
lockout box is selected, the account is locked
and no future login attempts are allowed
until the account is unlocked by a
management software administrator. If the
box is not selected, any number of login
attempts with invalid passwords are
allowed.
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Table 11. Password policy settings (continued)

Password setting Description

Account lockout threshold (attempts) This setting determines the number of
consecutive login attempts with invalid
passwords, including repeat password
attempts, are allowed before the user is
locked out of the management software. If
the value for this setting is 0, no repeat
password checking is performed, no future
login attempts are allowed, and the user is
locked out after a login with an invalid
password is attempted. A value is 1 or more
determines how many consecutive login
attempts with invalid passwords are allowed
before the user is locked out. A successful
login resets the threshold for the user
account.

Account lockout duration (minutes) This setting determines how long an account
is locked. If the value for this setting is 0,
the user cannot log in until the account is
unlocked by a management software
administrator. A value of 1 or more
determines the number of minutes that the
account remains locked before the user can
attempt another login.

Reset account lockout interval (minutes) This setting determines when the count of
consecutive login attempts with invalid
passwords is reset. If the value for this
setting is 0, the count of consecutive login
attempts with invalid passwords is reset
only after a successful login. A setting of 1
or more determines the number of minutes
after which the count of consecutive login
attempts with invalid passwords is reset,
even if a user has not logged in successfully.

Setting a new password
Depending on the password policy configuration for the IBM Flex System Manager
management software, the management software might require that new
passwords meet certain criteria to ensure system security.

The following list of password criteria apply only when the security policy is set to
Secure, or when the security policy is set to Legacy and the password policy
setting Enable the server to check for password quality on the Configure
password policy window is selected.

A new password must comply with the password settings selected for the
management software password policy. See “Password policy settings” on page 27
for more information about the password settings that can be configured in the
Configure password policy window.

A new password must also comply with the following rules:
v A password must contain at least 8 characters
v A password must have at least two characters that are different from the

previous password
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v A password cannot be the same as, or the reverse of, the associated user ID
v A password cannot contain more than three of the same consecutive characters
v A password must contain at least three of the following types of characters:

– one lower case alphabetical character
– one upper case alphabetical character
– one numeric character
– one special character or symbol (non-numeric and non-alphabetical character)

Important: If you use any of the following characters in a password that you
create in the command-line interface, you must add \ (backslash) in front of
each special character: @, $, #, !, &, (, ), ’. If you do not use the backslash with
each of these characters, an error occurs or an unexpected password value is
stored in the management software.

The following characters can cause conflicts with other components in the
system and should not be used: ", |, <, >, and any whitespace character such
as space or tab.

Changing a user password
Use the IBM Flex System Manager management software web interface or
command-line interface (CLI) to change a user’s password.

The management software uses two types of passwords: user account passwords
and system passwords. Depending on the password settings of the password
policy, users might be allowed to change their own account passwords. See
“Password policy settings” on page 27 for more information about the password
settings that can be configured in the Configure password policy window. For a
description of password criteria that is required for your system security policy, see
“Setting a new password” on page 29.

If you have adequate permissions for your user account, you can change the user
password in the management software web interface or the command-line interface
(CLI). To use the web interface to change the password for the active user ID (the
one that was used to log in to the management software), complete the following
steps:
1. From the Home page, click the Administration tab.
2. Click Change password under Security tasks. The Change Password page

opens.
3. Enter the old password, new password, and confirm the new password by

entering it again.
4. Click OK.

To use the CLI to change the password for the active user profile, enter the
command chuserpwd.

To use the web interface to change the password for any user ID, complete the
following steps.

Notes:

v If you use any of the following characters in a password that you create in the
command-line interface, you must add \ (backslash) in front of each special
character: @, $, #, !, &, (, ), |, <, >, ", '. If you do not use the backslash with each
of these characters, an error occurs or an unexpected password value is stored in
the management software. The following characters can cause conflicts with
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other components in the system and should not be used: ", |, <, >, and any
whitespace character such as space or tab.

v You must have admin permissions to change the password for another
management software user.

1. From the Home page, click the Administration tab.
2. Click View or modify user accounts under Security tasks. The Users and

Groups page opens.
3. In the Name column of the table, click the user ID for which you want to

change the password.
4. Click Actions > Reset Password. The Reset Password window opens.
5. Enter the new password and confirm the new password by entering it again.

Note: The new password will be set to expired automatically, and must be
changed the first time the user attempts to log in with it.

6. Click OK.

Important: A changed password must comply with the configured password
policy.

For more information about changing the system password, see “Changing the
system password.”

Changing the system password
Use the IBM Flex System Manager management software web interface or
command-line interface (CLI) to reset the system password.

The management software uses two types of passwords: user account passwords
and system passwords. See “Password policy settings” on page 27 for more
information about the password settings that can be configured in the Configure
password policy window. For a description of password criteria that is required for
your system security policy, see “Setting a new password” on page 29.

The system password is required by the management software to perform
system-management functions, such as enabling access to the local user registry.
The management software system password is specified when the management
software is set up initially, during the Management Server Setup wizard.

Although the system password does not expire and you are not required by the
management software to change it, you can improve system security by changing
the system password regularly. When you change the system password, the
management software must be restarted immediately.

Note: The management software also requires access to other repositories, such as
keystore and truststore files. Therefore, you must update the keystore and
truststore passwords manually to keep them synchronized.

You must have full admin permissions to change the system password. If you have
adequate permissions, you can change the system password in the management
software web interface. To change a user password in the web interface, from the
Home page, click the Administration tab; then, click Change System password
under Security tasks.

Important: If you use any of the following characters in a password that you
create in the command-line interface, you must add \ (backslash) in front of each
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special character: @, $, #, !, &, (, ), |, <, >, ", '. If you do not use the backslash with
each of these characters, an error occurs or an unexpected password value is stored
in the management software. The following characters can cause conflicts with
other components in the system and should not be used: ", |, <, >, and any
whitespace character such as space or tab.

For more information about changing a user password, see “Changing a user
password” on page 30.

For more information about predefined user IDs and passwords, see “Predefined
user IDs and passwords” on page 38.

Password policy settings for the Secure security policy
The IBM Flex System Manager management software password policy must have
secure settings to be used on a management node that has a Secure security policy.

You can set password policy conditions in the web interface that affect all users of
the management software. Although password policy settings can be changed
independently of the management software security policy, the security policy of
the management software might require that the password policy settings have
secure values. For example, if you attempt change the security policy level from
Legacy to Secure, the management software might require that you change some
password policy settings to secure values before the security policy can be changed
to Secure. However, if you change the security policy from Secure to Legacy, but
you do not change the password policy settings, the level of password validation
that occurs remains the same as before.

To change the management software password policy settings, complete the
following steps.

Note: For a description of each password setting in the Configure Password Policy
window, see “Password policy settings” on page 27.
1. From the Home page, click the Administration tab.
2. Under Security tasks, click Configure Password Policy. The Configure

Password Policy window opens and displays the default password settings.
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3. After you change the settings, click OK.

For more information about setting a new password, see “Setting a new password”
on page 29.

Password policy settings for the Legacy security policy
When the IBM Flex System Manager management software password policy is
configured for use with the Legacy security policy, it can allow more flexible, and
less secure, password conditions.

You can set password policy conditions in the web interface that affect all users of
the management software. Although password policy settings can be changed
independently of the management software security policy, the security policy of
the management software might require that the password policy settings have
secure values.

Chapter 1. Overview of the IBM Flex System management node 33



For example, if you attempt change the security policy level from Legacy to Secure,
the management software might require that you change some password policy
settings to secure values before the security policy can be changed to Secure.
However, if you change the security policy from Secure to Legacy, but you do not
change the password policy settings, the level of password validation that occurs
remains the same as before.

For more information about the Secure and Legacy security policies, see “Secure
security policy” on page 25 and “Legacy security policy” on page 25.

To change the management software password policy settings, complete the
following steps.

Note: For a description of each password setting in the Configure Password Policy
window, see “Password policy settings” on page 27.
1. From the Home page, click the Administration tab.
2. Under Security tasks, click Configure Password Policy. The Configure

Password Policy window opens and displays the default password settings.
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3. After you change the settings, click OK.

Note: If you changed the password policy based on a legacy security policy,
and want to switch back to a secure security policy, click Reset to secure
default values and click OK.

For more information about setting a new password, see “Setting a new password”
on page 29.

Certificate policies
The IBM Flex System Manager management software certificate policy determines
how the management software manages certificates from managed systems. An
implicit policy is the default certificate policy for the management software.
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Implicit certificate policy
When the management software certificate policy is set to implicit, the management
software automatically adds valid certificates that are received during the first
Secure Sockets Layer (SSL) handshake with each managed system. An implicit
policy is the default certificate policy for the management software.

The implicit certificate policy enables the management software to trust certificates
from managed systems automatically. The implicit policy also enables an Accept
Certificates task, which provides you with a list of valid certificates that were
received during the most recent SSL connection interchange with managed
systems. You can choose to add those certificates to the trust store directly.

Like the explicit certificate policy, the implicit policy allows you to manually
import valid certificates from managed systems.

To view the certificates for a chassis or single managed system and manage those
certificates, complete the following steps:
1. From the Chassis Manager page, click the chassis for which you want to see the

certificates. The Chassis Map opens.
2. From the Chassis Map graphical view, click the chassis or managed system.
3. In the Details section (under the graphical representation of the chassis), click

Actions > Security > View Certificates. The View Certificates page opens, and
the certificates for the selected system are displayed.

Note: To see all of the certificates stored by the management software, click
Actions > Security > Certificate Trust Store.

You can specify the implicit certificate policy by using the cfgcertpolicy
command.

For more information about using the management software command-line
interface to change the certificate policy, see “Changing the certificate policy” on
page 37.

Explicit certificate policy
When the management software certificate policy is set to explicit, you must
perform explicit actions to manage all certificates that are used to establish a
trusted connection with managed systems.

If you specify the explicit certificate policy by using the cfgcertpolicy command,
you must import valid certificates into the management software trust store
manually before a Secure Sockets Layer (SSL) handshake can be established to a
managed system.

To view the certificates for a chassis or single managed system and manage those
certificates, complete the following steps:
1. From the Chassis Manager page, click the chassis for which you want to see the

certificates. The Chassis Map opens.
2. From the Chassis Map graphical view, click the chassis or managed system.
3. In the Details section (under the graphical representation of the chassis), click

Actions > Security > View Certificates. The View Certificates page opens, and
the certificates for the selected system are displayed.
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Note: To see all of the certificates stored by the management software, click
Actions > Security > Certificate Trust Store.

To manually import a certificate, complete the following steps:
1. From the Chassis Manager page, click the chassis. The Chassis Map opens.
2. From the Chassis Map graphical view, click the chassis or managed system.
3. In the Details section (under the graphical representation of the chassis), click

Actions > Security > Certificate Trust Store. The Certificate Trust Store page
opens, and the certificates stored by the management software are displayed.

4. From the Certificate Trust Store page, click the Import button. A Certificate
Import page is opened.

5. From the Certificate Import page, in the file name field, point to the certificate
that was exported as a local file. Specify any Display name value that helps
describe this certificate.

6. Click OK.

For more information about using the management software command-line
interface to change the certificate policy, see “Changing the certificate policy.”

Changing the certificate policy
You can change the management software certificate policy with the cfgcertpolicy
command. Consider the following scenarios before you change the certificate
policy. An implicit policy is the default certificate policy for the management
software.

Use the cfgcertpolicy command and its options to determine or change the
certificate policy type.

Note: You can use only the command-line interface to determine or change the
management software certificate policy; the web interface does not have this
functionality.

Determining the certificate policy type

To determine which type of certificate policy is established in the management
software, use the following command:
smcli cfgcertpolicy

Changing the certificate policy from implicit to explicit

The implicit certificate policy is the default setting for the management software.
The implicit policy enables you to make sure that the management node and
managed resources are operational after initial setup of the IBM Flex System
hardware. You might choose to change the policy to explicit later, so that you can
enhance security and manage new systems as they are discovered by the
management software.

If you change the certificate policy to explicit, make sure that you validate the
contents of trust store and manually remove unwanted certificates. All certificates
in the trust store are trusted when the certificate policy is changed from implicit to
explicit, and future certificates must be added explicitly.

Note: Changing the policy takes effect immediately.
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To change the certificate policy to explicit, use the following command:
smcli cfgcertpolicy -e

Changing the certificate policy from explicit to implicit

The explicit policy enables you to have a secure configuration. If you later decide
that all of your managed systems are fully trusted, you might want to change the
certificate policy from explicit to implicit. New certificates are added to trust store
automatically for new systems.

Note: Changing the policy takes effect immediately.

To change the certificate policy to implicit, use the following command:
smcli cfgcertpolicy -i

Predefined user IDs and passwords
Predefined user IDs and passwords are included with IBM Flex System Manager
management software.

The management software has two predefined user IDs and passwords. You cannot
delete or change the predefined user IDs, but if you have admin permissions, you
can change the passwords for the predefined user IDs in the management
software. See “Changing a user password” on page 30 for more information.

You are prompted to change the predefined password in the Setup wizard during
initial management software configuration.

Important: To optimize security and auditing for your IBM Flex System
environment, create a user account for each person who will use the management
software. Each management software user should always use an assigned,
individual user account to access the management software.

After you complete the Setup wizard, you can create additional users through the
Users and Groups page in the web interface; see “Users and Groups page in the
web interface” on page 39 for more information.

The management software has the following two predefined user IDs and
passwords.

Note: The predefined user IDs are case-sensitive only if they are used for an SSH
session. The predefined passwords are always case-sensitive.

Table 12. Predefined management software user IDs and passwords

User ID Password Purpose

USERID Passw0rd USERID is the default user
ID and can be used to log in
to the management software.

pe Passw0rd The product engineer user ID
and password provides
support access to your
system. A product engineer
assists in support situations.
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Note: The root ID is a predefined system user ID. You cannot use the root user ID
to log in to the management software. However, the root user ID might appear in
the management software web interface or command-line interface.

Users, user groups, and roles
IBM Flex System Manager management software offers authentication and user
administration options that enable you to specify user privileges for specific tasks
and resources. User registry integration, integrity, confidentiality, and secure
sockets layer (SSL) supported secure data transmission are other key elements of
the management software security.

Management software user accounts are subjected to two interdependent processes:
authentication and authorization. Authentication is used to determine the identity
of the user and verify and validate that identity. Authorization checks the
permissions of the authenticated user and controls access to resources according to
the roles that are assigned to the user.

If you have admin permissions, you can use the management software to create,
edit, and delete user accounts.

Note: The Chassis Manager view in the management software is the primary
interface for selecting managed resources and performing management tasks on
those resources. However, some of the procedures in this section include steps that
instruct you to use the navigation area, which is hidden, by default, in the web
interface.

The navigation area provides links to tasks and task categories such as Resource
Explorer, Inventory, and Health Summary. To open the navigation area, click the
arrow icon on the left side of the window.

Users and Groups page in the web interface
The Users and Groups page in the IBM Flex System Manager management
software web interface enables you to create, edit, and delete management
software users and user groups.

You can also use the Users and Groups page to authorize users and groups, and
manage their access to systems and tasks. You can authorize existing unauthorized
user groups to access the management node, or remove authorization for user
groups that have access.

The Users and Groups page lists all of the users and user groups that have
management software accounts. The list is populated automatically with the
accounts that are created in the management software. From the Users and Groups
page, you can also manage the roles for these existing accounts.

To open the Users and Groups page from the Home page of the web interface,
click the Additional Setup tab; then, click Manage Users and Groups.

Users tab:

Use the Users tab to manage the user accounts on the management server. You can
assign, edit, copy, and remove user roles from the listed users who are defined in
your environment.
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Actions

Create Launches the Create User wizard, from which you can create a new user
account in the system registry. The Create User wizard requires you to
assign the new user a role. If you assign the role Supervisor or Operator,
you must also assign the new user to a group.

Edit Launches the Edit User wizard for the selected user, from which you can
edit attributes of the user. This option is enabled only when you have one
user selected in the table.

CAUTION:
Do not edit or delete the user IBMNETMGMTAGENT. This user account is not
directly used by the administrator. VMControl performs power node
management operations by using this user account. If you edit or delete
this user, it will affect the power system management operations and
you will need to reinstall IBM Flex System Manager to recover this user
and resume power node management.

Delete Deletes the currently selected user accounts. You must first select one or
more users.

Reset Password
Generates a new password of the currently selected user. This option is
enabled only when you have one user selected in the table.

Assign Role
Displays the Assign Role page, from which you can assign a specific role
to the selected users. You must first select one or more users.

Copy Role to User
Displays the Copy Role to User page, from which you can copy an existing
role to the selected user. You must first select one or more users.

Attributes

Name The name of the user.

State The state of the user in the management software. Possible states are:
v Active: The user is logged on. If the user is logged in more than once,

the number of login sessions is displayed next to the user state.
v Offline: The user is not logged on.
v Locked: The specified user is locked out of the management software.

This can occur if an administrator locks the user out of the system, or if
the user attempted too many invalid logins. To determine if the user is
locked out, you can either use the or attempt to log in to the web
interface with the credentials for the user.

Full Name
The full name for the user. This field is optional.

Description
An informative description of the user. A description might not be
available because it is optional when creating a user account on most
operating systems.

Role The name of the management software role that is assigned to the user.

E-mail Address
The e-mail address of the user. This field is optional.
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Phone Number
The telephone number for the user. This field is optional.

Mobile Phone Number
The mobile phone number for the user. This field is optional.

Home Phone Number
The home phone number for the user. This field is optional.

Pager Number
The pager number for the user. This field is optional.

Groups tab:

Use the Groups tab to manage group accounts on the management node, including
group access to systems and tasks. You can also create, edit, and delete user groups
from the Groups tab.

Actions

To perform the actions in the following list, click the applicable button or select the
action from the Actions list.

Note: Predefined groups, such as smuser and smadmin, cannot be edited or
deleted.

Create Launches the Create Group wizard, from which you can create a new
group account in the system registry.

Edit For a selected group, the Edit Group wizard enables you to change the
group description, membership, or custom access. This option is enabled
only when you have one group selected in the table.

Click Edit Members to display the Edit Members page, from which you
can add or remove members from the group.

Click Assign Access to display the Assign Access page, from which you
can assign roles and resources to the selected users.

Delete Deletes the currently selected group accounts. You must first select one or
more groups.

Assign Role
Displays the Assign Role page, from which you can assign a specific role
to the selected group. You must first select one or more groups.

Copy Role to User
Displays the Copy Role to User page, from which you can copy an existing
role to the selected group. You must first select one or more groups.

Viewing group properties

To view the user group properties, click the group name. The Properties page for
that group opens, and three tabs are displayed: General, Roles, and Group
Membership.

Authenticating users to IBM Flex System Manager
Authentication is the process that IBM Flex System Manager uses to determine if
the identity claimed by a user, a system, or an application is correct. The process of
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authenticating users involves a user registry and an authentication mechanism.
With user authentication, you can access and manage resources with the IBM Flex
System Manager Web interface.

About this task

Note: Network Information Services is not supported by IBM Flex System
Manager.

User authentication:

User authentication is the security mechanism by which a user's credentials that
are used to access a system are verified. After authentication, a user can access the
system. However, to access a specific resource or perform a specific task, the user
must also have the appropriate authorization. Authentication prevents
unauthorized management servers or rogue managed-system applications from
accessing the resources.

To be authenticated, users are required to enter a user ID and password for the
system that they want to access. The authentication process uses the configured
user registry, which is from either the operating system, Lightweight Directory
Access Protocol (LDAP), or the domain controller.

The user accounts and groups that are created at the user registry level to log in to
a system are also used by IBM Flex System Manager. For example, to log in to IBM
Flex System Manager Web interface, a user must authenticate by logging in with a
user registry level account for the management server. To use IBM Flex System
Manager Web interface to access another system, the user must first have the
appropriate credentials to access that other system.

Users and user groups in IBM Flex System Manager:

In IBM Flex System Manager, users and user groups are based on users and
groups that are defined in the configured registry. IBM Flex System Manager uses
the user and group information for authentication and authorization.

IBM Flex System Manager provides the capability to create, update, or delete users
or groups in only the local user registry. You can create new users, user groups,
and chassis roles from the management software web interface or command-line
interface.

To open the Users and Groups page from the Home page of the web interface,
click the Additional Setup tab; then, click Manage Users and Groups. For more
information about how to use the Users and Groups page to create, edit, or delete
users and user groups, see .

When you create a new user on the Users page, the Create User wizard requires
that you select a role that defines the permissions for that user. The available roles
and permissions are:

Supervisor
A user with the Supervisor role has full access to all resources

Operator
A user with the Operator role has read-only access to all resources

Set Custom permissions
This selection enables you to set permissions based on specific resources
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Note: Every new user account has sufficient authority to log in to the management
software web interface and change the account password.

Access to particular resources or tasks is governed by restrictions based on the user
ID or user group membership and the roles that are defined for each user. If you
select the Supervisor or Operator role when you create a new user, you must select
a group for the new user. All users have the group smdefault assigned
automatically.

In a default IBM Flex System Manager installation scenario that uses the local
registry, the following IBM Flex System Manager user groups are automatically
created at the system level on the management node.

Note:

v Members of the Administrators group are authorized for all operations on all
resources.

v Every new user is assigned to a role, which determines the permissions for the
user. An administrator can assign additional roles to give additional authority to
the user.

v IBM Flex System Manager does not support Network Information Services
(NIS).

smadmin (Administrator group)
Members of the smadmin group are authorized for all operations. They
have administrative access to IBM Flex System Manager and can perform
all administrative tasks. These members can define the privileges available
to the smmgr, smmon, smuser, and groupread groups. The privileges
available to members of the smadmin group cannot be restricted.

Note: At the operating system level, the smadmin group maps to
SMAdministrator role. A best practice is to add or remove users from the
user groups but to not delete the system-defined user groups because IBM
Flex System Manager uses them in the IBM Flex System Manager Web
interface to authorize users to IBM Flex System Manager.

Important: If you add a user to this group, the user can modify or delete
all system-level resources and resources for all other users, including
operating-system and user files and processes. Before assigning a user to
this group, be sure that the user requires SMAdministrator authority.

smdefault (Default group)
All users of the management software are members of the smdefault
group.

smmgr (Manager group)
Members of the smmgr group can perform management operations, which
are a subset of the functions that a member of the smadmin group can
perform.

smmon (Monitor group)
Members of the smmon group can access those administrative functions
that provide read-only access, such as monitoring.

smuser (User group)
Members of the smuser group can perform only a basic set of operations.
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Using Active Directory for external user authentication:

IBM Flex System Manager supports Microsoft Active Directory as an external user
registry on an outboard Microsoft Windows server.

To configure the management software to use an Active Directory registry on an
external server, complete the following steps:
1. From the Home page, click the Administration tab.
2. Under Configuration tasks, click Configure Flex System Manager User

Registry. The User Registry Configuration wizard opens.
3. Complete the steps in the User Registry Configuration.

Note: The default security policy for the management software is Secure; it requires
that external registry communication is SSL-encrypted. If you want to use
unencrypted communication, you must change the security policy to Legacy. See
Changing the security policy for instructions.

To create a Microsoft Active Directory user account that has access to IBM Flex
System Manager, complete the following steps:
1. Create a user account in the Active Directory user registry. For instructions

about creating a user account in the domain server user registry, see the Active
Directory documentation.

2. Create an Active Directory global security group with the name of a predefined
and authorized security group. The predefined group names are: smadmin,
smmgr, smmon, smuser, smdefault. The security group must exist within the
context of the Base Distinguished Name defined in the user registry
configuration.

3. Add the Active Directory user as a member of the security group you created
above.

4. Login to the management software web interface using the Active Directory
user name.

5. Optionally, you can define and create additional security groups. You can
authorize these groups and assign roles to them from the Users and Groups
page.

All of the users appear in the management software list of users and can log in to
the management software with the applicable levels of authority.

Editing user properties:

IBM Flex System Manager provides the capability to create, update, or delete users
or groups in only the local user registry. You can create new users, user groups,
and chassis roles from the management software web interface or command-line
interface.

About this task

To edit the properties that IBM Flex System Manager associates with each user or
group, complete the following steps:

Procedure

1. From the Home page in the management software web interface, click the
Additional Setup tab.

2. Click Manage Users and Groups. The Users and Groups page is displayed.
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3. Select the box for the user ID that you want to edit and then, click Edit. The
Edit User wizard is displayed.

4. Edit the user ID properties (including settings for permissions and group
membership) and then, click Finish.

Logging in with a temporary password after a password reset:

Use this information to log in with a temporary password in the IBM Flex System
Manager management software web interface or command-line interface (CLI).

When an administrator resets a user password in the management software web
interface or CLI, the user is assigned a temporary password by the administrator.

The following procedures describe the procedure that the user must follow to log
in with the temporary password and enter a new password.

Logging into the web interface after a password reset

After the administrator who reset your password provides you with your
temporary password, complete the following steps:
1. Log in to the web interface with your user ID and temporary password. The

Log in page refreshes.
2. In the Old Password field, type the temporary password.
3. In the New Password field, enter a new password.
4. In the Confirm New Password field, enter the new password again.
5. Click Log in.

The Log in page refreshes, and you can log in with your user ID and new
password.

Logging into the CLI after a password reset

After the administrator who reset your password provides you with your
temporary password, complete the following steps:
1. Log in to the CLI with your user ID and temporary password.
2. When you are prompted, You are required to change your LDAP password

immediately. Enter login(LDAP) password:, enter the temporary password.

Note: If you do not enter the temporary password immediately, your account
is locked out of the management software.

3. When you are prompted, Enter login(LDAP) password:, enter the temporary
password again.

4. When you are prompted, New LDAP password:, enter a new password.
5. When you are prompted, Retype new LDAP password:, enter the new password

again.
The following message is displayed:
LDAP password information changed for user_ID

where user_ID is your user name.

Authorizing users to IBM Flex System Manager
Authorization is the process that determines whether an authenticated user or
group has the necessary privileges to access specific resources. With user
authorization, IBM Flex System Manager users can perform tasks on specific
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resources by using IBM Flex System Manager Web interface. You must use IBM
Flex System Manager to configure the authorizations that provide access to IBM
Flex System Manager tasks and resources.

About this task

Using IBM Flex System Manager, you can create and manage the roles that control
authorization for IBM Flex System Manager users.

User authorization:

User authorization occurs when an authenticated user uses IBM Flex System
Manager to perform a task on a resource. The authorization mechanism compares
the user account, or the group to which the user belongs, to the role-based access
control (RBAC) settings for that user or group. If a role exists that contains the
authorizations necessary to complete that task on that specified resource, then the
task proceeds.

Users can access only the applications, tasks, and resources that their user accounts
are authorized to access. The authorities that you grant to a user determine the
console and resource information that the user can access, and the tasks that the
user can perform on those resources.

The authorization process that IBM Flex System Manager performs when accessing
a resource is independent of the authentication that is required to access that
resource. For example, a user might be able to authenticate to and therefore access
IBM Flex System Manager Web interface or another resource by using IBM Flex
System Manager Web interface, but to perform a task on that resource, both the
task and the resource must be authorized in the role settings that are assigned to
that user or the authorization group to which the user belongs.

After a user account is added to the applicable IBM Flex System Manager group to
provide access to IBM Flex System Manager Web interface, you can log in to IBM
Flex System Manager Web interface as an administrator and configure the
authorization policies and rules for IBM Flex System Manager tasks and resources
for that user.

Roles:

You can assign roles to IBM Flex System Manager management software users to
control their access to resources and limit the tasks that they can perform on those
resources. The authorities that you configure for a role determine the level of
access that is granted to each user who is assigned to that role. Each user or group
of users that access management software must have a user-role assignment.

The management software uses a role-based access control (RBAC) service with
which an administrator can create custom sets of permissions, known as roles, and
assign them to individual users or groups. A set of task, command-line interface
(CLI), and application permissions that is applied to one or more resources defines
an authorization role. Each role can be applied to many users, and each user can
have many roles. Regulating user roles is an effective way to control security for
your system, because it enables you to control access to every task and CLI
command.

Note: By default, the only user ID that is assigned to the SMAdministrator role
(the only one that can take any action immediately after installation) is the user ID
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that was used during the management software installation. Even if other
administrators are defined on the management server, a role is not assigned to
them and they are unable to administer management software. Instead, they will
receive a message telling them to contact their system administrator. To ensure that
you are using the correct user ID, before you log on to the management software
web interface, make sure that you can use that same user ID and password to log
on to the management node.

To allow users access to the management software web interface, each user must
be assigned to a role. These user roles define the types of tasks that users or
groups can perform. To be assigned to a role, each user or group of users must
have a valid user ID or group ID in the user registry on the management server.
Both individual users and a group of users can be assigned to a role. All users in a
group are assigned the role of the group. If a user is assigned to one role as an
individual and a different role as a member of a group, the user has access to the
functions of the role that has greater access.

CAUTION:
When you assign a user a role or to a user group, the user has the permissions
and authorization associated with that role or user group. For example, if you
assign a user to the smadmin group, the user has SMAdministrator role
permissions, which includes full authority to all tasks and commands, including
security administration, product installation, and configuration.

The management software provides reusable roles that you can assign more than
once and use to build other roles. The management software also provides
instance-based authorization. This enables you to define which tasks apply to
which groups in a system.

The following types of management software user roles are available.

Table 13. Management software roles

Role name Description

GroupRead Grants a user the ability to view or open a
group.

SMAdministrator Has full authority to all tasks and
commands, including security
administration, product installation, and
configuration.

SMManager Can perform a subset of the tasks that an
Administrator can perform. Typically, system
administration, system health management,
and configuration tasks are available.

SMMonitor Can access those administrative functions
that provide read-only access. Primarily,
monitoring, notifications, and status tasks
are available.

SMDefault Does not have access to any managed
resources, but can log in to management
software.

SMUser Includes any authenticated user, and can
perform only basic operations such as
viewing resources and properties.
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The Chassis Management Module (CMM) and Integrated Management Module
(IMM) are associated with a particular managed resource and can be assigned to a
user or a user group.

The following two types of CMM and IMM roles are available.

Table 14. CMM and IMM roles

Role name Description

Supervisor Has administrator privileges. A Supervisor
can view any page and change any field and
has permission for all actions that are
provided by the interface.

Operator The Operator role has read-only access. An
Operator cannot perform any maintenance
procedures (for example, restart, remote
actions, firmware updates) and is unable to
modify any settings.

Permissions and roles required to run smcli commands:

A user ID must be authorized with certain permissions and roles to run the smcli
commands.

Important: A newly created user must run the smcli lsuser command before
running any other command.

Note: A user ID must have the AllPermission permission to run supported
commands.

System commands

Command Required permission Predefined role

accesssys SecurityPermission SMAdministrator

chsys GeneralPermission SMAdministrator

lsChassis GeneralPermission SMManager

lsFSM GeneralPermission SMManager

lsFsmSecPolicy GeneralPermission SMManager

lssys GeneralPermission SMUser

pingsys GeneralPermission SMAdministrator

rmsys GeneralPermission SMAdministrator

rpower PowerOnOffPermission SMAdministrator

Group commands

Command Required permission Predefined role

chgp GeneralPermission SMManager

lsgp GeneralPermission SMUser

mkgp GeneralPermission SMManager

rmgp GeneralPermission SMManager
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Discovery and inventory commands

Command Required permission Predefined role

collectinv InventoryPermission SMAdministrator

discover InventoryPermission SMAdministrator

lsinv InventoryPermission SMMonitor

Configuration plan and template commands

Command Required permission Predefined role

lscfgplan SystemConfigurationPermission SMMonitor

lscfgtmpl SystemConfigurationPermission SMMonitor

mkcfgplan SystemConfigurationPermission SMManager

mkcfgtmpl SystemConfigurationPermission SMManager

rmcfgplan SystemConfigurationPermission SMManager

rmcfgtmpl SystemConfigurationPermission SMManager

Status commands

Command Required permission Predefined role

chled SystemStatusAndHealthPermission SMManager

lsled SystemStatusAndHealthPermission SMMonitor

lsstatus SystemStatusAndHealthPermission SMMonitor

Resource monitor commands

Command Required permission Predefined role

chresmonthresh SystemStatusAndHealthPermission SMManager

lsresmon SystemStatusAndHealthPermission SMMonitor

lsresmonrec SystemStatusAndHealthPermission SMMonitor

lsresmonthresh SystemStatusAndHealthPermission SMMonitor

mkresmonrec SystemStatusAndHealthPermission SMManager

mkresmonthresh SystemStatusAndHealthPermission SMManager

rmresmonrec SystemStatusAndHealthPermission SMManager

rmresmonthresh SystemStatusAndHealthPermission SMManager

runresmon SystemStatusAndHealthPermission SMManager

stopresmonrec SystemStatusAndHealthPermission SMManager

Process monitor commands

Command Required permission Predefined role

lsps SystemStatusAndHealthPermission SMMonitor

mkpmtask SystemStatusAndHealthPermission SMManager

rmpmtask SystemStatusAndHealthPermission SMManager
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Event automation plan and event commands

Command Required permission Predefined role

chevtautopln AutomationPermission SMAdministrator

evtacthist AutomationPermission SMManager

evtautopln AutomationPermission SMAdministrator

evtlog AutomationPermission SMManager

genevent AutomationPermission SMAdministrator

lsevtact AutomationPermission SMMonitor

lsevtacthist AutomationPermission SMMonitor

lsevtautopln AutomationPermission SMMonitor

lsevtfltr AutomationPermission SMMonitor

lsevtlog AutomationPermission SMMonitor

lsevttype AutomationPermission SMMonitor

mkevtact AutomationPermission SMAdministrator

mkevtactemail AutomationPermission SMAdministrator

mkevtactstpgm AutomationPermission SMAdministrator

mkevtactsttask AutomationPermission SMAdministrator

mkevtautopln AutomationPermission SMAdministrator

mkevtfltr AutomationPermission SMAdministrator

rmevtact AutomationPermission SMAdministrator

rmevtautopln AutomationPermission SMAdministrator

rmevtfltr AutomationPermission SMAdministrator

rmevtlog AutomationPermission SMAdministrator

testevtact AutomationPermission SMAdministrator

Task and scheduled job commands

Command Required permission Predefined role

lsjob TaskManagementPermission SMUser

lsjobhistory TaskManagementPermission SMUser

lstask TaskManagementPermission SMUser

rmjob TaskManagementPermission SMAdministrator

rmjobhistory TaskManagementPermission SMAdministrator

runjob TaskManagementPermission SMUser

runtask TaskManagementPermission SMUser

Update commands

Command Required permission Predefined role

checkupd ReleaseManagementPermission SMMonitor

cleanupd ReleaseManagementPermission SMManager

importupd ReleaseManagementPermission SMManager
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Command Required permission Predefined role

installneeded ReleaseManagementPermission SMAdministrator

installupd ReleaseManagementPermission SMManager

lsupd ReleaseManagementPermission SMMonitor

uninstallupd ReleaseManagementPermission SMManager

Security commands

Command Required permission Predefined role

authusergp SecurityPermission SMAdministrator

cfgaccess SecurityPermission SMUser

cfgappcred SecurityPermission SMAdministrator

cfgcertpolicy SecurityPermission SMAdministrator

cfgcred SecurityPermission SMUser

cfgpwdpolicy SecurityPermission SMAdministrator

chaudit SecurityPermission SMAdministrator

chcred SecurityPermission SMUser

chFsmSysPwd SecurityPermission SMAdministrator

chLegacyProtocol SecurityPermission SMAdministrator

chrole SecurityPermission SMAdministrator

chuser SecurityPermission SMAdministrator

chusergp SecurityPermission SMAdministrator

chuserpwd SecurityPermission SMUser, SMDefault

exportcert SecurityPermission SMAdministrator

importcert SecurityPermission SMAdministrator

lockuser SecurityPermission SMAdministrator

lsaudit SecurityPermission SMAdministrator

lsauditlogs SecurityPermission SMAdministrator

lscert SecurityPermission SMAdministrator

lschassisind SecurityPermission SMAdministrator

lsFsmSecPolicy SecurityPermission SMManager

lsperm SecurityPermission SMAdministrator

lsrole SecurityPermission SMAdministrator

lsuser SecurityPermission SMAdministrator

lsusergp SecurityPermission SMAdministrator

mkrole SecurityPermission SMAdministrator

mkuser SecurityPermission SMAdministrator

mkusergp SecurityPermission SMAdministrator

pwdexpired SecurityPermission SMAdministrator

resetLdapCerts SecurityPermission SMAdministrator

resetuserpwd SecurityPermission SMAdministrator

revokecert SecurityPermission SMAdministrator
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Command Required permission Predefined role

rmauditlogs SecurityPermission SMAdministrator

rmcert SecurityPermission SMAdministrator

rmcred SecurityPermission SMUser

rmrole SecurityPermission SMAdministrator

rmuser SecurityPermission SMAdministrator

rmusergp SecurityPermission SMAdministrator

setChassisSSO GeneralPermission SMAdministrator

setFsmSecPolicy SecurityPermission SMAdministrator

unlockuser SecurityPermission SMManager,
SMAdministrator

unrevokecert SecurityPermission SMAdministrator

userlocked SecurityPermission SMAdministrator

Storage commands

Command Required permission Predefined role

lsnspool SystemConfigurationPermission SMAdministrator

manageV7000 SystemConfigurationPermission SMAdministrator

mkdatasource SystemConfigurationPermission SMAdministrator

rmdatasource SystemConfigurationPermission SMAdministrator

unmanageV7000 SystemConfigurationPermission SMAdministrator

Authorizing users to manage resources:

To log in to IBM Flex System Manager Web interface and manage the resources
that are discovered by IBM Flex System Manager, a user must have a user account
that is associated with a role that has the appropriate authority.

About this task

The following steps are required to authorize an IBM Flex System Manager user to
manage resources:

Procedure

1. If the user account that is needed does not exist, create it on the operating
system of the system that you want to manage or on the Lightweight Directory
Access Protocol (LDAP) server.

2. Log in to IBM Flex System Manager as a SMAdministrator.
3. Assign an appropriate role to the user account or group to which the user

account belongs and associate it with the resources that you want the account
to manage. You can use any of the existing initial role groups (smadmin,
smmgr, smmon, smuser) or you can create a role that includes the privileges
necessary to access the appropriate resource.

Note: Assigning a role other than smadmin, which is done with the operating
system, occurs within IBM Flex System Manager Web interface.
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Assigning a role to a user or user group:

The roles that are assigned to a user or user group determine the tasks that the
user has permission to access. From the Users page, you can assign one or more
roles to a user or user group. When you assign a role, you also associate specific
resources to which the role will apply for the selected user.

Before you begin

Before you can assign a role to a user, each user or group of users must have a
valid user ID or group ID in the local operating-system user registry on the
management server. Also, you must make sure that the role that you want to
assign to a user already exists. If it does not, you can create a new role from the
Roles page.

If you want to associate a role and user with only one resource group, you can
create a group that contains all the resources that you will assign to a specific user
and then pick that group when you work with the Assign Role wizard.

CAUTION:
When you assign a role or to a user or user group, the user or user group has the
permissions and authorization associated with that role. For example, if you
assign the role SMAdministrator to a user or user group, the user or user group
has SMAdministrator permissions, which includes full authority to all tasks and
commands, including security administration, product installation, and
configuration.

About this task

To assign a role to a user or group, complete the following steps:

Procedure

1. In the IBM Flex System Manager Web interface navigation area, expand
Security and click Users and Groups.

2. From the Users tab, select the user or group to which you want to assign a role.
3. Click Assign Role. The Welcome page for the Assign Role wizard opens.
4. Click Next. The wizard lists the roles that have been created.
5. Select the role that you want to assign.
6. Click Next.
7. Select the resource groups that you want to associate with the role and the user.

Note: Selecting a parent group does not automatically assign access its
children.

8. Click Next. The Summary page is displayed.
9. Click Finish.

Copying a role to another user:

The roles that are created in IBM Flex System Manager to control access to tasks
and resources can be applied to one or more users or groups. Use the Users page
to copy the task and resource assignments in an existing role from one user or
group to another user or group.
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About this task

When you copy a role from one user to another, the task and resource assignments
in an existing role are copied and assigned to the new user in one step. As a result,
both the task permissions and the associated resources for the selected user are
copied to the new user.

Note: The Copy Role to User... action does not result in the creation of a new role
that matches the selected role. Instead, the task and resource assignments in the
selected role are copied to the user or group. In other words, it is the task and
resource assignments in the selected role, not the role itself, that are copied to the
user or group. If you instead want to copy a role, you can do so using the Roles
page.

To copy a role to another user, complete the following steps:

Procedure

1. In the IBM Flex System Manager Web interface navigation area, expand
Security and click Users.

2. On the Users page, select the user that has the role that you want to copy, and
then click Copy Role to User.... The Copy Role to User page opens.

3. In the Copy to list, select the user to whom you want to copy the role.
4. In the Roles list box, select the roles that you want to copy.

Note: Both the task permissions and the associated resources for the selected
user are copied to the new user.

5. Click OK.

Creating a role:

With the Roles page, you can create new roles on your system.

About this task

IBM Flex System Manager uses a role-based access control (RBAC) service with
which an administrator can create a set of task permissions that can be applied to
one or more resources. The permissions that are configured for a role determine
the resources that a user can access and what tasks the user can perform on those
resources. Each role can be applied to many users or groups, and each user can
have many roles.

To create a role, complete the following steps:

Procedure

1. In the IBM Flex System Manager Web interface navigation area, expand
Security and click Roles.

2. On the Roles page, click Create. The Create Role wizard Welcome page is
displayed.

3. Click Next. The Name page is displayed.
4. In the Name field, type a name for the role that you want to create.
5. In the Description field, type an optional brief description for the role.
6. Click Next. The Permissions page is displayed.
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7. In the Available permissions field, select a permission that you want to add
to the user role and then click Add. The selected permission is added to the
Selected permissions field. Continue adding permissions until you have
identified all permissions required for the role.

Note: The permissions are ordered and grouped under specific categories,
such as inventory and security, and subcategories within those categories.
Under each category, the permissions are sorted alphabetically by permission
type. The task permissions are first, followed by the cli permissions. The
different types of permissions are designated by different icons. You can either
select a category or subcategory name, which adds all the contained
permissions, or you can drill down to select and add an individual
permission.

8. Optional: To remove a permission from the role, select a permission in the
Selected permissions field and then click Remove. The selected permission is
added back to the Available permissions field.

9. Click Next. The Summary page is displayed.
10. Click Finish.

What to do next

After you create a role, use the Assign Role wizard on the Users page to create role
and resource assignments for your users.

Managing roles:

Use IBM Flex System Manager to work with roles and assign individual users and
user groups to those roles. From the Roles page, you can view, copy, edit, or delete
a role.

Before you begin

To view, copy, edit, or delete a role, the role must already exist. You can also use
this page to create a new role that you can then manage. See “Creating a role” for
instructions.

About this task

To view, copy, edit, or delete a role, complete the following steps:

Procedure

1. In the IBM Flex System Manager Web interface navigation area, expand
Security and click Roles.

2. On the Roles page, select one of the following actions.
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Table 15. Role actions

To do this task: Complete these steps:

View details about an existing role 1. Select the role that you want to view.
2. Click View. The View page is displayed.
3. View the following details about the role:
v Name
v Description
v Permissions

4. Click OK.

Notes:

v When you view a role, you will see one of
two icons that designate the type of
permissions that the role has. One icon
indicates that the role applies to tasks in
the IBM Flex System Manager Web
interface, and the other indicates that it
applies to cli commands.

v To view a comprehensive list of role
permissions, use the lsrole command.

Copy an existing role 1. Select the role that you want to copy.
2. Click Create like. The Create Role Like

wizard is displayed. The role name
defaults to Copy of (original role name),
but the rest of the fields are populated
with the same entries and selections as is
in the original role.

3. Edit the fields as needed.
4. Click Finish. The new role based on the

original role will appear in the table on
the Roles page.

Edit an existing role Note: You cannot edit the roles that are
shipped with IBM Flex System Manager,
which are designated by the type of System
Defined.
1. Select the role that you want to edit.
2. Click Edit. The Create Role wizard is

displayed but with the fields already
filled out. You can select only certain
fields to edit.

3. Edit the role properties as needed,
clicking Next to continue through the
wizard.

4. Click Finish.

Delete an existing role Note: You cannot delete the roles that are
shipped with IBM Flex System Manager,
which are designated by the type of System
Defined.
1. Select the role that you want to delete.
2. Click Delete. A confirmation message is

displayed.
3. Click Delete in the confirmation message

box to confirm the deletion or click
Cancel to retain the selected role. The
selected role is deleted and is no longer
displayed in the table on the Roles page.
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Ending the session for another user:

You can choose to end the session for another active user if you have sufficient
authority to do so.

About this task

To end the session of another active user:

Procedure

1. In the IBM Flex System Manager Web interface navigation area, expand
Security and click Users.

2. Right-click the user for whom the session is to be ended.
3. Click End Session. The End Session confirmation dialog is displayed. If the

user is logged in more than once, the list of sessions is displayed; select which
session to end. You can select multiple sessions.

4. In the End Session confirmation dialog, click End Session. The selected user is
logged out and must log in again.

Managing credentials in IBM Flex System Manager
IBM Flex System Manager uses credentials to implement single sign-on
authentication. Various forms of credentials are supported.

Single sign-on (SSO) is an authentication process in which a user can access more
than one system or application by entering a single user ID and password. It is
used to automate access to multiple resources by requiring a user to authenticate
only once. To implement single sign-on authentication, the IBM Flex System
Manager maps IBM Flex System Manager Web interface user credentials to the
user credentials needed for authenticating to the target managed system. These
credentials are saved in registries, which enables Web interface users who are
managing remote systems over various security domains or realms to authenticate
to and manage these remote systems and the resources hosted on them.

When credentials are configured in IBM Flex System Manager, users are not
required to type the user ID and password for the target system or resource each
time that they or a task access it. IBM Flex System Manager automatically logs in
as needed by retrieving the necessary credentials. You can view those systems for
which users do not automatically have access on the IBM Flex System Manager
Web interface Home page.

With IBM Flex System Manager, you can manage shared and targeted credentials:

Shared credentials
Shared credentials are those credentials that exist in an authentication
registry that is not specific to an access point. This enables the credentials
to be reused to access multiple console access points and systems. These
credentials must be of type user ID/password. After the credentials are
configured, the IBM Flex System Manager can use them to authenticate to
user interfaces and advanced system-management functions that are hosted
on the selected system.

Shared credentials are created on the local operating system, the domain
controller, or LDAP, and are then mapped to other credentials if necessary.
In IBM Flex System Manager, use the following pages to manage shared
credentials:
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v To manually manage shared credentials and credential mappings for a
target managed system that you choose, use Security > Credentials.

v To manage single sign-on shared credentials from the selected system,
use Resource Explorer > All systems > (right-click a system) > Security
> Configure Single Sign-On Credentials.

Targeted credentials
Targeted credentials are each assigned to only one remote-service agent
access point and are located in an authentication registry that is specific to
that access point. These credentials cannot be reused to access other agent
access points. After the credentials are configured, the IBM Flex System
Manager can use them to manage the selected system.

In IBM Flex System Manager, use the following pages to manage targeted
credentials:
v To access general system-management capabilities for the selected

system, use Resource Explorer > All systems > (right-click a system) >
Security > Configure Access.

v To access advanced system-management capabilities for the selected
system, use Resource Explorer > All systems > (right-click a system) >
Security > Configure System Credentials.

Managing shared credentials:

Use IBM Flex System Manager to configure the shared credentials that are used to
log in to and manage console access points that are hosted on a managed system.

About this task

Shared credentials are those credentials that exist in an authentication registry that
is not specific to an access point. This enables the credentials to be reused to access
multiple console access points. These credentials must be of type user
ID/password. After the credentials are configured, the IBM Flex System Manager
can use them to launch user interfaces that are hosted on the selected system.

Shared credentials are created on the local operating system, the domain controller,
or LDAP, and are then mapped to other credentials if necessary. To manage shared
credentials and credential mappings, use Security > Credentials. The Credential
wizard enables you to choose the target system for which to create the credentials.

Alternatively, you can configure single sign-on shared credentials for a selected
system by using the Create and Edit Single Sign-On Credentials wizard. See
“Managing single sign-on credentials.”

Creating shared credentials:

Use the Credentials page to create shared credentials for a target managed system
that you specify in the Credential wizard.

About this task

To create a set of shared user ID / password credentials for a console access point
on a target system, complete the following steps:
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Procedure

1. In the IBM Flex System Manager Web interface navigation area, expand
Security and click Credentials.

2. On the Credentials page, click Create. The Credential wizard opens.
3. If the Welcome page is displayed, click Next. The Credential Details page is

displayed.
4. From the Authentication Registry Type list, select the type of authentication

registry that you want to create. The three authentication registry types are as
follows:

Local OS
Authenticates user login requests with the local operating system of the
target system. The target system must have a corresponding user
account in the operating-system registry.

LDAP Authenticates user login requests with a Lightweight Directory Access
Protocol (LDAP) server. Ensure that the LDAP server is configured in
your environment and available to the target system.

Domain
Authenticates user login requests with a specific domain server. Ensure
that the domain server is configured in your environment and available
to the target system.

5. From the Target system list, select the name of the target system. If your target
system does not appear in the list, click Browse to search for it.

6. Enter the appropriate user ID and password for the system. If you are creating
a credential for a resource that has defined a specific user ID that must be used
when authenticating, you cannot change the value in the User ID field.

7. Click Next. The Summary page is displayed.
8. Click Finish. The credentials are automatically used to authenticate to the

specified system.

What to do next

For information about how to map a user's credentials in one user registry to
another user's credentials in another user registry, see Managing mappings.

Learn more about targets that define specific user IDs:

For some systems, a specific user ID is required to access the system. When the
system requires the use of a specified user ID, the user ID fields on the Request
Access page are fixed. You cannot change the user ID. Instead, you must enter the
password for that user ID.

Editing shared credentials:

Use the Credentials page to edit shared credentials.

About this task

With IBM Flex System Manager, you can edit existing shared credentials

To edit a set of shared user ID / password credentials, complete the following
steps:
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Procedure

1. In the IBM Flex System Manager Web interface navigation area, expand
Security and click Credentials.

2. On the Credentials page, select the shared credential that you want to edit.
3. Click Edit. The Edit Credential wizard opens.
4. If the Welcome page is displayed, click Next. The Credential Details page is

displayed.
5. Change the details that are available for changing and verify the password for

the credential.
6. Click Next. The Summary page is displayed.
7. Click Finish.

What to do next

For information about how to map a user's credentials in one user registry to
another user's credentials in another user registry, see Managing mappings.

Deleting shared credentials:

Use the Credentials page to delete shared credentials that are no longer needed.

Before you begin

If you have created any automated tasks in IBM Flex System Manager, ensure that
you check the systems that are the targets of those tasks and the credentials that
are used to log in to those systems. Some tasks might be configured to use a set of
credentials to accomplish the procedures in the task. Deleting the set of credentials
that are used by one of these automated tasks will prevent the task from accessing
targeted systems that are secured.

Note: You will not receive a warning when deleting a credential that is associated
with an automated task, and the task will no longer be able to access the system.

About this task

To delete a set of shared credentials, complete the following steps:

Procedure

1. In the IBM Flex System Manager Web interface navigation area, expand
Security and click Credentials.

2. On the Credentials page, select the credentials that you want to delete.
3. Click Delete. A confirmation message is displayed.
4. Click OK.

Managing single sign-on credentials:

Use IBM Flex System Manager to manage single sign-on shared credentials for the
selected system. These credentials are mapped from specific user credentials on
that system to IBM Flex System Manager Web interface users.
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Before you begin

Ensure that you have the correct authorization to access the resource and its access
points.

About this task

Like other shared credentials, single sign-on credentials are those credentials that
exist in an authentication registry that is not specific to an access point. This
enables the credentials to be reused to access multiple console access points and
systems. These credentials must be of type user ID/password. After the credentials
are configured, the IBM Flex System Manager can use them to launch user
interfaces that are hosted on the selected system.

Creating single sign-on credentials:

Use the Create and Edit Single Sign-On Credentials wizard to create single sign-on
shared credentials for the selected system.

About this task

Single sign-on credentials map user credentials on the selected system to specified
IBM Flex System Manager Web interface users. To create a single sign-on credential
for a console access point on the selected system, complete the following steps:

Procedure

1. In the IBM Flex System Manager Web interface navigation area, click Resource
Explorer > group name > system name.

2. Click Actions > Security > Configure Single Sign-On Credentials. The
Configure Single Sign-On Credentials page is displayed.

3. Click a remote-service console access point. The credentials associated with
that access point are listed.

4. Click Create. The Create and Edit Single Sign-On Credentials wizard is
displayed.

Notes:

v If the Create button is disabled, all credential mappings that you have the
authority to create have been created for the configured authentication
registry on the selected system. A credential mapping can be created only
for those Web interface users who have logged in to IBM Flex System
Manager at least once. Existing credential mappings can still be edited or
deleted.

v If the Create button is unavailable, the selected console access point is on
the IBM Flex System Manager. Single sign-on credentials for these access
points can only be displayed. You cannot create or edit these credentials
because they are automatically created when Web interface users log in to
IBM Flex System Manager.

5. From the Authentication Registry Type list, select the type of authentication
registry that you want to create.

Note: If an authentication registry has already been configured for the
selected console access point, the value for the authentication registry type
cannot be changed. It is set to the previously configured authentication
registry type for the access point.
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The three authentication registry types are as follows:

Local OS
Authenticates user login requests with the local operating system of
the target system. The target system must have a corresponding user
account in the operating-system registry.

LDAP Authenticates user login requests with a Lightweight Directory Access
Protocol (LDAP) server. Ensure that the LDAP server is configured in
your environment and available to the target system.

Domain
Authenticates user login requests with a specific domain server.
Ensure that the domain server is configured in your environment and
available to the target system.

6. Enter the appropriate user ID and password for the system. If you are creating
a credential for a resource that has defined a specific user ID that must be
used when authenticating, you cannot change the value in the User ID field.

7. Click Next. The “Assign to IBM Flex System Manager User” page is
displayed.

Note: This page lists only Web interface users who have logged in to IBM
Flex System Manager. These users must log in at least once before a credential
mapping can be created.

8. Select the IBM Flex System Manager Web interface user for whom the single
sign-on credential is being created. You can use the current user or choose
another user from the table.

Remember: Only one mapping can be created for each of the users on this
page.

9. Click Next. The Summary page is displayed.
10. Click Finish. The credentials are automatically used to authenticate to the

selected console access point on the system.

What to do next

Repeat the credential creation process for other console access points you plan to
access.

Editing single sign-on credentials:

Use the Create and Edit Single Sign-On Credentials wizard to edit single sign-on
shared credentials.

About this task

To edit a single sign-on credential, complete the following steps:

Procedure

1. In the IBM Flex System Manager Web interface navigation area, click Resource
Explorer > group name > system name.

2. Click Actions > Security > Configure Single Sign-On Credentials. The
Configure Single Sign-On Credentials page is displayed.

3. Click a remote-service console access point. The credentials associated with that
access point for the configured authentication registry are listed.
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4. Select the credential that you want to edit.
5. Click Edit.

Note: If the Edit button is unavailable, the selected console access point is on
the IBM Flex System Manager. Single sign-on credentials for these access points
can only be displayed. You cannot create or edit these credentials because they
are automatically created when Web interface users log in to IBM Flex System
Manager.
The Create and Edit Single Sign-On Credentials wizard is displayed.

6. If the Welcome page is displayed, click Next. The Create Single Sign-On
Credential page is displayed.

7. Change the details that are available for changing.
8. Click Next. The Summary page is displayed.
9. Click Finish.

Deleting single sign-on credentials:

Use the Configure Single Sign-On Credentials page to delete single sign-on shared
credentials that are no longer needed.

Before you begin

If you have created any automated tasks in IBM Flex System Manager, ensure that
you check the systems that are the targets of those tasks and the credentials that
are used to log in to those systems. Some tasks might be configured to use a set of
credentials to accomplish the procedures in the task. Deleting the set of credentials
that are used by one of these automated tasks will prevent the task from accessing
targeted systems that are secured.

Note: You will not receive a warning when deleting a credential that is associated
with an automated tasks, and the task will no longer be able to access the system.

About this task

To delete a single sign-on credential, complete the following steps:

Procedure

1. In the IBM Flex System Manager Web interface navigation area, click Resource
Explorer > group name > system name.

2. Click Actions > Security > Configure Single Sign-On Credentials. The
Configure Single Sign-On Credentials page is displayed.

3. Click a console access point. The credentials associated with that access point
are listed.

4. Select the credential that you want to delete.
5. Click Delete. A confirmation message is displayed.
6. Click OK.

Managing mappings:

Use IBM Flex System Manager to map a user's credentials in one user registry to
another user's credentials in another user registry.
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About this task

Mappings represent associations between a source credential in one security
domain and a target credential in another domain. For example, you can map
credentials from your local registry to various other types of authentication
registries, such as Lightweight Directory Access Protocol (LDAP).

Mappings:

Mappings represent associations between a source credential in one security
domain and a target credential in another domain. For example, you can map
credentials from your local registry to various other types of authentication
registries, such as Lightweight Directory Access Protocol (LDAP).

Depending on the values used in the mapping and how the mapping is associated
with an access point, the following three types of mapping associations are
possible:

One-to-one mapping

This most basic type of mapping is used when a specific user wants to
request the services of an access point. A source credential and a target
credential are specified, and the target credential must be valid in the same
registry that the access point uses for validation. This mapping can be used
by any access point that happens to validate to the same registry.

One-to-one mapping with access point association

Use one-to-one mapping with access point association if you want to
restrict a mapping to a particular access point.

As with one-to-one mapping, a source credential and a target credential are
specified. The target credential must still be valid in the registry the access
point uses for validation. However, the mapping is associated with a
specific access point.

Many-to-one mapping with access point association

Use many-to-one mapping with access point association if you want to
have a mapping with which any user can request the services of a
particular access point. This method avoids the need to create many
one-to-one mappings when all users must use the same target credential
for an access point.

Note: Because this type of mapping can enable broad access, IBM Flex
System Manager requires that you associate this type of mapping with an
access point.

Creating mappings:

Use the Credentials mapping page to map one credential to another to create a
one-to-one credential mapping.

About this task

To create a one-to-one mapping between two credentials, complete the following
steps:
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Procedure

1. In the IBM Flex System Manager Web interface navigation area, expand
Security and click Credentials.

2. On the Credentials page, select the target credential that you want to map.
3. Click Actions > Mapping.
4. On the Mapping page, click Create. The Credential Mapping wizard opens.
5. If the Welcome page is displayed, click Next. The Source credential page is

displayed.
6. Choose whether you would like to use the current console credential or a

credential that was previously created and is displayed in the credential table.
If you choose to select a credential from the table, select it.

Note: A credential mapping can be created only for those Web interface users
who have logged in to IBM Flex System Manager at least once. Existing
credential mappings can still be edited or deleted.

7. Click Next. The Summary page is displayed.
8. Click Finish.

Editing mappings:

Use the Credentials mapping page to edit an existing one-to-one credential
mapping.

About this task

To edit a one-to-one credential mapping, complete the following steps:

Procedure

1. In the IBM Flex System Manager Web interface navigation area, expand
Security and click Credentials.

2. On the Credentials page, select the target credential that you want to edit.
3. Click Actions > Mapping.
4. Select the mapping that you want to edit.
5. Click Edit. The Create Credential Mapping wizard is displayed.
6. If the Welcome page is displayed, click Next. The Source credential page is

displayed.
7. Select whether to use the current console credential or a credential that was

previously created and is displayed in the credential table.
8. If you choose to select a credential from the table, select it.
9. Click Next. The Summary page is displayed.

10. Click Finish.

Deleting mappings:

Use the Credentials mapping page to delete one-to-one credential mappings that
are no longer needed.

About this task

To delete a one-to-one mapping between credentials, complete the following steps:
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Procedure

1. In the IBM Flex System Manager Web interface navigation area, expand
Security and click Credentials.

2. On the Credentials page, select the credential that contains the mapping that
you want to delete.

3. Click Actions > Mapping.
4. On the Mapping page, select the mapping that you want to delete.
5. Click Delete. A confirmation message is displayed.
6. Click OK.

Managing targeted credentials:

Use IBM Flex System Manager to configure the targeted credentials that are used
to log in to and access remote-service agent access points that are managed by IBM
Flex System Manager.

About this task

Targeted credentials are each assigned to only one remote-service agent access
point and are located in an authentication registry that is specific to that access
point. These credentials cannot be reused to access other agent access points. After
the credentials are configured, the IBM Flex System Manager can use them to
manage the selected system.

To access general system-management capabilities for the selected system, use
Resource Explorer > All systems > (right-click a system) > Security > Configure
Access.

Optionally, you can access advanced system-management capabilities for the
selected system by configuring system credentials. See Managing system
credentials.

Creating targeted credentials:

Use the Configure Credential wizard to create targeted credentials.

About this task

With IBM Flex System Manager, you can create targeted credentials that are
specific to an agent access point on a resource.

Note: Certain types of agent access points (for example, CAS or IPC) do not
support this credential creation process. Instead, the use of the Request Access task
is all that is required to obtain access to all the agent access points on the resource
when these types of access points are present. The Request Access task creates the
necessary credentials and mappings, but they cannot be viewed or managed. If
you need to create or manage credentials for other agent access points even when
access points such as CAS or IPC are present, you can follow this process, but the
overall system access will be determined by the Request Access request.

To create a set of targeted credentials, complete the following steps:
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Procedure

1. In the IBM Flex System Manager Web interface navigation area, click Resource
Explorer > group name > system name.

2. Click Actions > Security > Configure Access. The Configure Access page is
displayed.

3. Click an agent access type that supports the creation of targeted credentials
(for example, an access type other than CAS or IPC). The credentials
associated with that access point are listed.

4. Click Configure Credentials. The Configure Credential wizard is displayed.
5. If the Welcome page is displayed, click Next. The Credential Type page is

displayed.
6. Select the type of credential that you want to create. The following credential

types are available:

Key pair
Choose this credential type to specify a key pair file and password.

Restriction: Avoid creating a key pair credential on systems that do
not support a protocol using key pairs.

SNMP v1/v2c
Choose this credential type to use either SNMPv1 or SNMPv2c and
specify a community name.

SNMP v3
Choose this credential type to manage SNMPv3 profiles.

User ID and password
Choose this credential type to specify a user ID and password for the
credential.

X509 Choose this credential type to specify a keystore location and
password, and an alias for the credential.

Note:

v This list represents all available credential types. The list of credential types
that is displayed depends on the type of access point.

v Two credentials of the same type cannot exist simultaneously on an access
point. If one of these types of credentials is already created for this access
point, that credential type option will not be displayed. Your only option is
to edit the existing credential of that type or delete it before you can create
one of the same type.

7. Click Next. The Credential Details page that applies to the type of credential
that you chose is displayed.

8. Enter the values for the chosen credential type.
9. Click Next. The Summary page is displayed.

10. Click Finish. The credentials are automatically used to authenticate to the
selected access point on the system.

Editing targeted credentials:

Use the Edit Credential wizard to edit targeted credentials.

About this task

To edit a targeted credential, complete the following steps:
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Procedure

1. In the IBM Flex System Manager Web interface navigation area, click Resource
Explorer > group name > system name.

2. Click Actions > Security > Configure Access. The Configure Access page is
displayed.

3. Click an agent access type that supports the creation of targeted credentials (for
example, an access type other than CAS or IPC). The credentials associated
with that access point are listed.

4. Select the credential that you want to edit.
5. Click Edit. The Edit Credential wizard is displayed.
6. Change the details that are available for changing.
7. Click Next. The Summary page is displayed.
8. Click Finish.

Deleting targeted credentials:

Use the Configure Credential wizard to delete targeted credentials that are no
longer needed.

Before you begin

If you have created any automated tasks in IBM Flex System Manager, ensure that
you check the systems that are the targets of those tasks and the credentials that
are used to log in to those systems. Some tasks might be configured to use a set of
credentials to accomplish the procedures in the task. Deleting the set of credentials
that are used by one of these automated tasks will prevent the task from accessing
targeted systems that are secured.

Note: You will not receive a warning when deleting a credential that is associated
with an automated task, and the task will no longer be able to access the system.

About this task

To delete a set of targeted credentials, complete the following steps:

Procedure

1. In the IBM Flex System Manager Web interface navigation area, click Resource
Explorer > group name > system name.

2. Click Actions > Security > Configure Access. The Configure Access page is
displayed.

3. On the Configure Access page, select the credentials that you want to delete.
4. Click Delete.

Note: Deleting these credentials might affect the access state of the targeted
system.
A confirmation message is displayed.

5. Click OK.

Managing system credentials:

Use IBM Flex System Manager to configure system credentials that are used to log
in to and access advanced system-management functions on target systems.
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Before you begin

Ensure that you have the correct authorization to access the resource and its access
points.

About this task

For an IBM Flex System Manager Web interface user to do certain types of
advanced system-management tasks on a target system, system credentials must
exist. These credentials map IBM Flex System Manager Web interface users to user
credentials on the selected system.

Like other targeted credentials, system credentials are each assigned to only one
remote-service agent access point and are located in an authentication registry that
is specific to that access point. These credentials cannot be reused to access other
agent access points.

After the credentials are configured, the IBM Flex System Manager can use them to
do advanced system-management functions on the selected system. In IBM Flex
System Manager, use Resource Explorer > All systems > (right-click a system) >
Security > Configure System Credentials to manage system credentials.

Creating system credentials:

Use the Create and Edit System Credentials wizard to create system credentials
that provide access to advanced system-management functions on a selected
system. These credentials map IBM Flex System Manager Web interface users to
user credentials on the target system.

About this task

To create a system credential, complete the following steps:

Procedure

1. In the IBM Flex System Manager Web interface navigation area, click Resource
Explorer > group name > system name.

2. Click Actions > Security > Configure Access. The Configure Access page is
displayed.

3. Click an access point. The credentials associated with that access point are
listed.

4. Click Create. The Create and Edit System Credentials wizard is displayed.

Note: If the Create button is disabled, all credential mappings that you have
the authority to create have been created for the configured authentication
registry on the selected system. A credential mapping can be created only for
those Web interface users who have logged in to IBM Flex System Manager at
least once. Existing credential mappings can still be edited or deleted.

5. If the Welcome page is displayed, click Next. The Create System Credential
page is displayed.

6. Enter the appropriate user ID and password for the system. If you are creating
a credential for a resource that has defined a specific user ID that must be
used when authenticating, you cannot change the value in the User ID field.

7. Click Next. The Assign to IBM Flex System Manager User page is displayed.
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Note: This page lists only Web interface users who have logged in to IBM
Flex System Manager. These users must log in at least once before a credential
can be created.

8. Select the IBM Flex System Manager Web interface user for whom the system
credential is being created. You can use the current user or choose another
user from the table.

Remember: Only one mapping can be created for each of the users on this
page.

9. Click Next. The Summary page is displayed.
10. Click Finish. The credentials are automatically used to authenticate to the

selected access point on the system.

What to do next

Repeat the credential creation process for each agent access point that you plan to
use.

Editing system credentials:

Use the Create and Edit System Credentials wizard to edit existing system
credentials.

About this task

To edit a system credential, complete the following steps:

Procedure

1. In the IBM Flex System Manager Web interface navigation area, click Resource
Explorer > group name > system name.

2. Click Actions > Security > Configure Access. The Configure Access page is
displayed.

3. Click an access point. The credentials associated with that access point are
listed.

4. Select the credential that you want to edit.
5. Click Edit. The Edit Credential Wizard is displayed.
6. If the Welcome page is displayed, click Next. The Create System Credential

page is displayed.
7. Edit the credentials as needed.
8. Click Next. The Summary page is displayed.
9. Click Finish.

Deleting system credentials:

Use the Configure System Credentials page to delete system credentials that are no
longer needed.

Before you begin

If you have created any automated tasks in IBM Flex System Manager, ensure that
you check the systems that are the targets of those tasks and the credentials that
are used to log in to those systems. Some tasks might be configured to use a set of
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credentials to accomplish the procedures in the task. Deleting the set of credentials
that are used by one of these automated tasks will prevent the task from accessing
targeted systems that are secured.

Note: You will not receive a warning when deleting a credential that is associated
with an automated task, and the task will no longer be able to access the system.

About this task

To delete a system credential, complete the following steps:

Procedure

1. In the IBM Flex System Manager Web interface navigation area, click Resource
Explorer > group name > system name.

2. Click Actions > Security > Configure Access. The Configure Access page is
displayed.

3. Click a remote service agent access point. The credentials associated with that
access point are listed.

4. Select the credential that you want to delete.
5. Click Delete. A confirmation message is displayed.
6. Click OK.

Managing access
Use IBM Flex System Manager to configure credentials that are used to access
managed systems. These credentials enable IBM Flex System Manager to
authenticate to and manage target systems by using the protocols and access
points available on the managed system.

About this task

You can request access to and configure access options for systems in your
environment by using the request access task, the configure access task, or the
configure system credentials task. You can also revoke access to an accessed
system.

Accessing a secured system with request access:

Use the Request Access page to request access to a secured system if the
management server to which you are connected has not yet authenticated to the
system. You must be able to access the system before you can perform tasks or
remotely access the system.

Before you begin

Before you start, complete the following prerequisite tasks:
v Ensure that you have the correct authorization to access the secured system.
v If you plan to request access to an agentless Windows system, ensure that the

following programs are enabled and disabled accordingly:
– Ensure that the Remote Registry (RR) is enabled.
– Ensure that the Microsoft User Account Control (UAC) is disabled.

For instructions about enabling RR and disabling UAC, see their product
documentation.
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About this task

Note: Agent access points are all access points that have an access type other than
console. If certain types of agent access points (for example, CAS or IPC) exist on a
resource, you must use this process to access all agent access points on the system.
This process creates the necessary credentials and mappings, but they cannot be
viewed or managed. For other types of agent access points on the secured
resource, you have the option of using the Configure Access task to request access.

Secured systems are displayed in IBM Flex System Manager Web interface with a
padlock icon beside them in the Access field or column of the systems details.
After a system is accessed, the padlock disappears and additional tasks and status
information are available.

The Access attribute for each resource shows the current access status. You cannot
request access to the resources that have the following types of access status:
v Offline: Use verify access instead.
v OK: No further action is required. You already have access to these resources.

To request access to secured managed systems, complete the following steps.

Note: You can select more than one system at a time as long as each requires the
same user ID and password.

Procedure

1. In IBM Flex System Manager Web interface, click Resource Explorer.
2. Navigate to the system that you want to access.
3. Right-click the system for which you want to request access and select Security

> Request Access.

Note: Alternatively, you can select Security > Configure Access and then click
Request Access on the Configure Access page.

4. On the Request Access page, type the user ID and password of a user that
belongs to the System group. Only certain users accounts can be used to
request access. The following table gives detailed requirements of what user
accounts can be used to request access.

Table 16. User accounts able to be used to access a system with request access

Common Agent Platform Agent Agentless

AIX 1. root

2. Users in the
system group

1. root

2. Users in the
system group

1. root

2. Users in the
system group

3. Users configured
with sudo

Linux 1. root 1. root

2. Users in the root
group (with root
as primary group)

1. root

2. Users configured
with sudo

Windows 1. Administrator

2. Users in the Local
Administrators
Group

1. Administrator

2. Users in the Local
Administrators
Group

1. Administrator

2. Users in the Local
Administrators
Group
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Notes:

v On AIX, only the root user or users in root group are supported for Common
Agent. Non-root, LDAP, NIS users can not access Common Agent.

v You can use the sudo utility to configure agentless managed systems running
AIX or Linux so that they are accessible by a user without administrator
privileges.

5. Click Request Access. Credentials are created and authenticated to the
managed system in an attempt to access it.

Results

If the access request is successful, the access status for the managed system
changes to OK.

What to do next

If the access status changes to Partial Access, then the access request was
unsuccessful for at least one access point. Click Configure Access to see the list of
access points and their access states. If necessary, to create additional credentials,
click an access point that does not have an access state of OK and repeat this
procedure.

Accessing a secured system with configure access:

Use the Configure Access page to configure credentials for the agent access points
on a managed system. These credentials provide access to basic system
management functions on the target system for all authorized IBM Flex System
Manager users.

Before you begin

Ensure that you have the correct authorization to access the resource and its access
points.

About this task

To maximize the management capability of a resource, ensure that all access points
that are hosted on the resource are accessible. To do this, configure credentials that
are used to authenticate to each of those access points.

Note: Certain types of agent access points (for example, CAS or IPC) do not
support this credential configuration process. Instead, the use of the Request
Access task is all that is required to obtain access to all the agent access points on
the resource when these types of access points are present. The Request Access
task creates the necessary credentials and mappings, but they cannot be viewed or
managed. If you need to configure or manage credentials for other agent access
points even when access points such as CAS or IPC are present, you can follow
this process, but the overall system access will be determined by the Request
Access request.

To configure credentials to access secured managed systems, complete the
following steps:
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Procedure

1. In IBM Flex System Manager Web interface click Resource Explorer.
2. Navigate to the system for which you want to configure access.
3. Right-click the system and select Security > Configure Access. The Configure

Access page is displayed.
4. On the Configure Access page, right-click each listed access point and select

Credential.
5. Complete the task for creating the type of credential that you want. After the

credential is created, it is automatically used to authenticate to the selected
system.

6. Repeat the credential creation process for each access point that you plan to
use.

Results

If you are successful in obtaining access to all access points on a resource, its
access state displays OK.

What to do next

If the access status changes to Partial Access, then the access request was
unsuccessful for at least one access point. Click Configure Access to see the list of
access points and their access states. If necessary, to create additional credentials,
click an access point that does not have an access state of OK and repeat this
procedure.

Revoking access to a secured system:

Use the Revoke Access action to revoke access to a system to which you previously
had access.

Before you begin

The Access attribute for each resource shows the current access status. A resource
must be accessible, with an access status of OK or Partial Access, before you can
revoke its access.

About this task

Note: The common agent services (CAS) and interprocess communication (IPC)
agent access point types do not support the revoke access action.

To revoke access to secured managed systems, complete the following steps:

Procedure

1. In IBM Flex System Manager Web interface click Resource Explorer.
2. Navigate to the system from which you want to revoke access.

Tip: You can select more than one accessible system at a time.
3. Right-click the system and select Security > Revoke Access.
4. Click OK.
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Results

If access is successfully revoked, the access status changes to No access.

Accessing a managed system with configure system credentials:

In some cases, the request access and configure access tasks might not provide the
IBM Flex System Manager with all the necessary credentials to fully manage a
target system. Use the IBM Flex System Manager configure systems credentials
task to set up credentials that provide access to advanced system-management
functions for the selected system.

Before you begin

Ensure that you have the correct authorization to access the resource and its access
points.

About this task

To maximize the management capabilities for a resource, you can configure
additional credentials by using the Configure System Credentials page to ensure
that all agent access points for the resource are accessible. System credentials are
mapped from specific IBM Flex System Manager Web interface users to user
credentials on the target system.

Managing auditing
Audit infrastructure plays a pivotal role in helping organizations adhere to
compliance standards. IT administrators prepare for compliance audits by using
event log managers and robust change management software to allow tracking and
documenting authentication and controls in IT systems. With IBM Flex System
Manager's auditing capabilities, you can track what takes place on an IBM Flex
System Manager by viewing four categories of audit data : Security, Task, System
Configuration, and System Triggers. In addition, IBM Flex System Manager
plug-ins can use these existing categories or define new categories to audit their
important events. Use IBM Flex System Manager Server Auditing to enable and
disable auditing on IBM Flex System Manager, select which audit records to log
(by choosing which categories to enable), view and change the current audit
settings, view audit log events, and delete audit log events.

About this task

Tip: For your awareness, auditing can be managed using the following smcli
commands. You can find more information about these commands in Security
commands.

chaudit
Use the chaudit command to modify audit settings.

lsaudit
Use the lsaudit command to list audit settings and categories.

lsauditlogs
Use the lsauditlogs command to list a specific number of audit log
messages for one or more audit categories.

rmauditlogs
Use the rmauditlogs command to remove the audit log for one or more
audit categories.
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Audit records:

The audit records provide information that is necessary to track basic, important,
high-level actions. You can select from several categories of information to audit,
including security, task, system configuration and system triggers.

IBM Flex System Manager provides several categories of audit records.

Security audit records:

This category enables auditing for security-related events in IBM Flex System
Manager, such as user authentication, authorization, access privileges, and user
administration.

Security audit records include the following data:
v Encryption turned on
v Encryption turned off
v Successful request access
v Unsuccessful request access
v Successful revoke access
v Unsuccessful revoke access
v User administration settings changed
v Successful login
v Successful logout
v Unsuccessful login
v Create role
v Remove role
v Add role to user
v Remove role from user
v Add permission to role
v Remove permission from role
v Modify user
v Modify group
v Create credential
v Modify credential
v Remove credential
v Create mapping
v Modify mapping
v Remove mapping

The following output is an example of security audit-log information:
Role "SMMonitor" successfully added to user "Diruser"

Task audit records:

When this category is selected, audit records are logged when IBM Flex System
Manager tasks start or end.

The task audit records include the following data:
v Task activated
v Task deactivated
v Task scheduled
v CLI command successful
v CLI command not executed
v CLI command failed
v Create resource group
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v Modify resource group
v Remove resource group
v Import resource group
v Export resource group
v Modify endpoint
v Remove endpoint
v Import Management Information Base
v Load Management Information Base
v Unload Management Information Base
v Schedule job
v Cancel job
v Delete job

The following output is an example of task audit-log information:
CLI command "lsbundle" succeeded

System Configuration audit records:

This category captures all actions or events that a systems administrator performs
to configure the systems, such as deployment, install, and configuration actions on
server, storage, and network.

Audit records are displayed in this category when an IBM Flex System Manager
plug-in is installed.

The system configuration audit records include the following data:
v Enable auditing globally
v Disable auditing globally
v Enable audit category
v Disable audit category
v Delete audit logs
v Restore audit configuration
v Modify event log preferences
v Edit auto rename template
v Modify auto rename settings
v Modify server preferences

The following output is an example of system configuration audit-log information:
Auditing setting restored to default value

System Triggers audit records:

This category captures the events that are automatically generated by the system to
indicate triggers such as status change, failure, or scheduling.

Audit records are displayed in this category when an IBM Flex System Manager
plug-in is installed.

The system triggers audit records include the following data:
v Job executed

The following output is an example of system triggers audit-log information:
Job "Collect Inventory" is running on "rev4.in.ibm.com"
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Setting server-auditing preferences:

You can customize your preferences for logging IBM Flex System Manager audit
information. These preferences include whether auditing is turned on and what
types of audit records to log. The audit records provide information that is
necessary to track basic, important, high-level actions. You can select from several
categories of information to audit, including security, task, system configuration
and system triggers.

Before you begin

Note: Server auditing is enabled by default for the Security category.

About this task

To set the server auditing preferences for IBM Flex System Manager, complete the
following steps:

Procedure

1. In the IBM Flex System Manager Web interface navigation area, expand
Security and click Server Auditing.

2. On the Server Auditing page, if you want to disable auditing, clear the Enable
Auditing check box.

3. Select the categories of information that you want to audit. Use the Add and
Remove buttons to move items between the Available list and the Selected list.
You can select from the following auditing categories.

Security
This category enables auditing for security-related events in IBM Flex
System Manager, such as user authentication, authorization, access
privileges, and user administration.

Task When this category is selected, audit records are logged when IBM Flex
System Manager tasks start or end.

System configuration
This category captures all actions or events that a systems administrator
performs to configure the systems, such as deployment, install, and
configuration actions on server, storage, and network.

System triggers
This category captures the events that are automatically generated by
the system to indicate triggers such as status change, failure, or
scheduling.

4. When you are satisfied with your settings, click OK to save the settings and
close the page. To save the setting but not close the page, click Apply. To close
the page without saving the settings, click Cancel. To reset the settings to the
system-defined values, click Restore Defaults. You still must click OK or
Apply to save the restored settings.

What to do next

For information about viewing audit logs, see Viewing the audit log.
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Viewing the audit log:

If you have enabled auditing for IBM Flex System Manager, you can view the
audit log.

About this task

Note: The audit log is in event format and can be viewed on the Event Log page.

To view the audit log when auditing is enabled, complete the following steps:

Procedure

1. In the IBM Flex System Manager Web interface navigation area, expand
Security and click Server Auditing.

2. On the Server Auditing page, click View Audit Log. It will navigate to the
Event Log page.

Deleting the audit log:

Use Server Auditing to delete the audit logs.

About this task

Attention: Deleting the audit log is a task that cannot be undone.

To delete the audit log, complete the following steps:

Procedure

1. In the IBM Flex System Manager Web interface navigation area, expand
Security and click Server Auditing.

2. On the Server Auditing page, click Delete All Logs to delete all logged audit
events.

3. A confirmation window is displayed. Click Delete to confirm deleting all
logged audit events.

Communication protocols and supported encryption algorithms
The IBM Flex System Manager can communicate with target resources by using a
predetermined set of communication protocols. Depending on the type of managed
system, these communication protocols support various levels of encryption.

The following combinations of communication protocols and encryption algorithms
are supported.
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Table 17. Supported communication protocols and encryption algorithms

Managed system type Communication protocol Encryption algorithm

Agentless managed system Windows Distributed component object
model (DCOM)

RC2.

Simple Network Management Protocol
(SNMP) v1 and v2

Not encrypted.

SNMP v3 Encrypted. Advanced Encryption
Standard (AES) or Data Encryption
Standard (DES).

Secure Shell (SSH)
Notes:

v SSH is unsupported on managed
systems running the Windows
operating system.

v IBM Flex System Manager does not
include an SSH server. Use the SSH
server included with the operating
system or an SSH-compliant server
from a third party.

Encryption algorithm is negotiated.

Platform Agent managed
system

Agentless Supports the communication protocols
and encryption algorithms listed for
Agentless managed system.

Common Information Model (CIM) If configured, encryption is enabled by
default using Secure Sockets Layer (SSL)
port 5989.

Common Agent managed
system

5.x interprocess communication (IPC) Encrypted (AES, DES, or Triple DES).

Tivoli® Common Agent Services 6.x Encrypted Web services (SSL).

Other Service Location Protocol (SLP) Not encrypted.

Access states of managed resources
The Access column in the table view of the IBM Flex System Manager
management software web interface displays the access states for managed
resources. The access state for a resource is a short description of the connection
between the management software and the managed resources (endpoints such as
chassis or components installed in chassis). The following list describes the
possible access states and procedures for configuring access, if applicable:

Note: This topic describes how to access this task in the IBM Flex System Manager
Web user interface. If you are using the IBM FSM Explorer, use the finder at the
top of the user interface (shown here) to locate this task:

Unknown
The access state Unknown indicates that the management software cannot
determine the access state for the managed resource (for example, the
management software might not have attempted to connect to the
endpoint). This access state should not be displayed during normal
operation.
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To correct the problem, complete the following steps:
1. From the table view, select the box for the unknown resource.
2. Click Actions > Security > Verify Connection.
3. If the problem remains, contact your IBM representative.

Offline
The access state Offline indicates that all of the management software
remote service access points (RSAPs) to the managed resource are not
responding, so the management software has no connectivity.

Note: You might be able ping the managed resource from the management
node (if you use telnet or SSH to it), but the management software requires
a response through the protocols that it is using to manage the resource.

There are many possible reasons for this failure. Make sure that you
investigate and, if necessary, address each of the following conditions that
might be causing the failure:
v there is no physical connectivity
v firewall configuration for the network is preventing connectivity
v the managed resource is powered off and must be powered on
v the managed resource needs to be restarted

After the problem has been identified and resolved, reestablish a
connection by either waiting for the next periodic operational status query
(the default is 15 minutes) or complete the following steps:
1. From the table view, select the box for the offline resource.
2. Click Actions > Security > Verify Connection.
3. If the problem remains, contact your IBM representative.

Not trusted
The access state Not trusted indicates that the management software has
connectivity to the managed resource, but the certificate presented by one
or more of the RSAPs is not trusted. The following list describes scenarios
where this access state is common, and the procedures required to establish
trusted access:
v You replaced the only Chassis Management Module (CMM) in your

chassis with a new one or replaced the CA certificate for a CMM. The
new CMM regenerates a CA certificate, but because the new certificate
has not been added to the management software Certificate Trust Store,
all of the hardware components in the chassis are not trusted.
To add the new certificate to trust store and establish access with the
new CMM, complete the following steps:
1. From the table view, select the box for the untrusted CMM.
2. Click Actions > Security > View Certificates.
3. Select the box for the new, untrusted certificate; then, click Accept.

The chassis is now trusted, but the compute nodes and network
devices in the chassis are still not trusted.

4. From the original table view, select the box for the chassis; then click
Actions > Security > Revoke Access.

5. Revoke access for the new CMM; then, request access to the same
CMM to establish trust for all of the managed endpoints in the
chassis:
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a. Select the box for the CMM; then, click Actions > Security >
Revoke Access.

b. Make sure that the box for the CMM is selected; then, click
Actions > Security > Request Access.

Note: The chassis transitions to a trusted state quickly; however, the
chassis components might take several minutes to be trusted.

v You reset the CMM to factory defaults. The certificate is regenerated,
and you must complete one of the following procedures, depending on
whether your management software certificate policy is Explicit or
Implicit.
If the management software certificate policy is set to Explicit, you
must manually copy the CA certificate from the CMM and save it to
management software trust store. To add the certificate to the trust store
and establish a connection to the CMM, complete the following steps:
1. Manually add the certificate to the trust store. See “Explicit certificate

policy” on page 36.
2. From the table view, select the box for the CMM that was reset.
3. Click Actions > Security > View Certificates.
4. Select the box for the new, untrusted CMM certificate; then, click

Accept. The chassis is now trusted (the compute nodes and network
devices in the chassis are still not trusted).

5. Revoke access for the new CMM; then, request access to the same
CMM to establish trust for all of the managed endpoints in the
chassis:
a. Select the box for the CMM; then, click Actions > Security >

Revoke Access.
b. Make sure that the box for the CMM is selected; then, click

Actions > Security > Request Access.

Note: The chassis transitions to a trusted state quickly; however, the
chassis components might take several minutes to be trusted.

If the management software certificate policy is set to Implicit,
complete the following steps:
1. From the table view, select the box for the CMM that was reset.
2. Click Actions > Security > View Certificates.
3. Select the box for the new, untrusted certificate; then, click Accept.

The chassis is now trusted (the compute nodes and network devices
in the chassis are still not trusted).

4. Revoke access for the new CMM; then, request access to the same
CMM to establish trust for all of the managed endpoints in the
chassis:
a. Select the box for the CMM; then, click Actions > Security >

Revoke Access.
b. Make sure that the box for the CMM is selected; then, click

Actions > Security > Request Access.

Note: The chassis transitions to a trusted state quickly; however, the
chassis components might take several minutes to be trusted.

v You are managing a compute node without first managing the chassis
where the compute node is installed, and the compute node access state
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is Not trusted after it reboots, or after the CMM for the chassis fails over.
This occurs because the compute node requests a new certificate from
the CMM. Regardless of the management software certificate policy,
complete the following steps to recover the trust state for the compute
node:
1. From the table view, select the box for the compute node that is not

trusted.
2. Click Actions > Security > View Certificates.
3. Select the box for the new, untrusted certificate; then, click Accept.

The compute node is now trusted.
v You change the certificate that is used by a managed resource to a

certificate that is not signed by the CMM (for example, Verisign).
v The management software certificate policy is set to Explicit and a new

chassis is discovered by the management software. To add the new
CMM certificate to the trust store and establish a connection to the
CMM, complete the following steps:
1. Manually add the certificate to the trust store. See “Explicit certificate

policy” on page 36.
2. From the table view, select the box for the new CMM.
3. Click Actions > Security > View Certificates.
4. Select the box for the new, untrusted certificate; then, click Accept.

The chassis is now trusted (the compute nodes and network devices
in the chassis are still not trusted).

5. Revoke access for the new CMM; then, request access to the same
CMM to establish trust for all of the managed endpoints in the
chassis:
a. Select the box for the CMM; then, click Actions > Security >

Revoke Access.
b. Make sure that the box for the CMM is selected; then, click

Actions > Security > Request Access.

Note: The chassis transitions to a trusted state quickly; however, the
chassis components might take several minutes to be trusted.

v If an IBM Flex System Manager management node is not managing the
chassis in which it is installed, and the CMM in the chassis fails over,
the access state of the management node endpoint might change to Not
trusted. This is caused by a change to the IMM certificate on the
management node.
To add the changed certificate to the trust store, complete the following
steps:
1. From the table view, select the box for the management node

endpoint.
2. Click Actions > Security > View Certificates.
3. Select the box for the untrusted certificate; then, click Accept. The

management node is now trusted.
v If an IBM Flex System Manager management node is not managing the

chassis in which it is installed, and you update the firmware or install a
management software fix pack for that management node, the
management node endpoint will have the access state Not trusted after
the management node restarts. When the integrated management

Chapter 1. Overview of the IBM Flex System management node 83



module (IMM) firmware is updated on the management node, the
management node will not have the CMM CA certificate that is required
to validate the new IMM certificate.
To add the new certificate to the trust store, complete the following
steps:
1. From the table view, select the box for the management node.
2. Click Actions > Security > View Certificates.
3. Select the box for the untrusted certificate; then, click Accept. The

management node is now trusted.

No Access
The access state No access indicates that the management software has
connectivity to the managed resource (and the managed resource might not
be trusted). However, all of the RSAPs for the resource have no credentials,
invalid credentials, or valid credentials with an expired password.

Notes:

v If the managed resource is a compute node in the chassis, the problem
might be solved at the chassis level or through direct action to the
compute node endpoint. If access to the managed chassis endpoint is
unlocked, but access to a compute node endpoint in that chassis is
locked, then access problems must be resolved by selecting and
configuring access for that compute node.

v If the managed resource is a new compute node or storage node in a
chassis with centralized user management mode, the problem might be
node firmware that is not current.

To correct the problem, complete the following steps:
1. Select the box for the resource with no access:
v If the resource with no access is a chassis or compute node in a

chassis with no access, select the box for the CMM.
v If the resource is a compute node with no access in a chassis that

does have access, select the box for the compute node.
v If the resource with no access is another hardware component, and

not a chassis or compute node, select the box for that resource.
2. Click Actions > Security > Request Access.

Note: If the password has expired it is indicated in the status, and you
must change the password before you request access to the resource.
Click Change Password to update the password.

3. Click Request Access.

Partial Access
The access state Partial access indicates that the management software has
connectivity to the managed resource. However, one or more (but not all)
RSAPs have no credentials, invalid credentials, or valid credentials with an
expired password. To solve the problem, complete the following steps.

Note: The following procedure will solve the partial access problem if the
problem is caused by one or more of the RSAP credentials for the managed
resource. However, there might be other reasons why the access is partial
(for example, a firewall might be blocking one of the RSAPs).
1. Select the box for the resource; then, click Actions > Security >

Configure Access.
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2. Enter the valid credentials as needed.
3. Click OK.

If you complete the preceding procedure and the partial access problem
remains, investigate and address each of the following conditions as
needed:
v there is no physical connectivity
v firewall configuration for the network is preventing connectivity
v the managed resource is powered off and must be powered on
v the managed resource needs to be restarted

OK The access state OK indicates that the management software has
connectivity to the managed resource and the credentials are valid
(unexpired). The management software has full access to the resource, and
no corrective action is required.

Agents
IBM Flex System Manager management software provides a central point of
control for aggregating and managing discovered systems based on a
service-oriented architecture. The management software includes two
operating-system agents: Common Agent and Platform Agent.

The operating-system agents serve as the control point for accessing operating
system and host information that might not be accessible through an out-of-band
interface. These agents run on operating-system-based and hardware-based
endpoints, called systems, that can be discovered and managed by the
management software. The level of system management depends on the agent that
is installed on the system: Common Agent or Platform Agent. Each agent provides
a different footprint size, level of performance, and set of management functions.

The management software can discover and manage some systems on which
neither of these operating-system agents is installed, but the level of management
is limited.

Important: If your IBM Flex System hardware consists only of X-Architecture
compute nodes, and you use management software for basic hardware
management, such as firmware updates, you might not need Common Agent or
Platform Agent. If you have IBM Power Systems compute nodes, or you need
virtualization or file management, you might need Platform Agent, Common
Agent services, or both.

For Platform Agent, a web-connected management node installs and updates
agents automatically. For Common Agent, the installation and update processes are
always manual; you must download, import, and install them manually.

IBM Flex System Manager task support by operating system
and agent levels

Some IBM Flex System Manager tasks are supported on certain operating systems
or only on Platform Agent managed systems or Common Agent managed systems.

Support for IBM Flex System Manager tasks can vary depending on the following
items:
v The system or hardware device model (the resource)
v The operating system that is installed on a resource
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v The service processor installed in the managed system
v The level of the device drivers that are installed on the managed system

Attention: The device drivers that are available for a managed system depend
on the service processor and operating system that are installed on the managed
system.

v The level of IBM Flex System Manager support installed on the system or
device. In Table 18, the following symbols are used:
– IBM Flex System Manager indicates the task is supported by IBM Flex System

Manager.
– Level 0 indicates the task support is provided by the operating system.
– Level 1 indicates the task is supported for managed resources with Platform

Agent installed.
– Level 2 indicates the task is supported for managed resources with Common

Agent installed.

Table 18. IBM Flex System Manager task support across operating systems

Task

Operating systems

AIX IBM i Linux

Microsoft
Virtual
Server

VMware
ESX Server
and VMware
ESXi15 Windows

Command Automation IBM Flex
System
Manager,
Level 2

Level 2 IBM Flex
System
Manager,
Level 2

IBM Flex
System
Manager,
Level 2

Event Log IBM Flex
System
Manager,
Level 2

Levels 1, 2 IBM Flex
System
Manager,
Levels 1, 2

Levels 1, 2 Levels 01, 1,
2

IBM Flex
System
Manager,
Levels 1, 2

File Transfer IBM Flex
System
Manager,
Level 2

Level 2 IBM Flex
System
Manager,
Level 2

Level 2 Level 22 IBM Flex
System
Manager,
Level 2

Inventory (hardware)3 IBM Flex
System
Manager,
Level 2

Levels 0,1, 2 IBM Flex
System
Manager,
Levels 0, 1,
24

Levels 0, 1, 2 Levels 01, 1,
2

IBM Flex
System
Manager,
Levels 0, 1,
24

Inventory (software) IBM Flex
System
Manager,
Levels 0, 2

Levels 0, 1,
25

IBM Flex
System
Manager,
Levels 0, 1, 2

Levels 0, 1, 2 Levels 0, 1, 2 IBM Flex
System
Manager,
Levels 0, 1, 2

Problems (formerly
Hardware Status)6,

Level 2 Levels 1, 2 Levels 1, 2 Levels 1, 2 7 Levels 1, 2 8 Levels 1, 2

Process Management IBM Flex
System
Manager,
Level 2

Level 2 IBM Flex
System
Manager,
Level 2

Level 2 9 Level 2 9 IBM Flex
System
Manager,
Level 2

Remote Control IBM Flex
System
Manager,
Levels 0, 2

IBM Flex
System
Manager,
Levels 0, 1, 2

Level 2 Levels 0, 1,
210

IBM Flex
System
Manager,
Levels 0, 1, 2
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Table 18. IBM Flex System Manager task support across operating systems (continued)

Task

Operating systems

AIX IBM i Linux

Microsoft
Virtual
Server

VMware
ESX Server
and VMware
ESXi15 Windows

Remote Command Line IBM Flex
System
Manager,
Levels 0, 2

Levels 0, 1, 2 IBM Flex
System
Manager,
Levels 011,
111, 2

Level 2 Levels 0, 1, 2 IBM Flex
System
Manager,
Level 2

Resource Monitors IBM Flex
System
Manager,
Level 2

Levels 1, 2 IBM Flex
System
Manager,
Levels 1, 2

Console only
12

Console only
12

IBM Flex
System
Manager,
Levels 1, 2

Storage Manager IBM Flex
System
Manager

IBM Flex
System
Manager,
Levels 1, 2 13,

,

Levels 1, 2 Levels 1, 2 IBM Flex
System
Manager,
Levels 1, 2

Update Manager IBM Flex
System
Manager,
Levels 2

Levels 0, 1, 2 IBM Flex
System
Manager,
Levels 0, 1, 2

Levels 1, 2 14 Levels 1, 214 IBM Flex
System
Manager,
Levels 0, 1, 2

Notes:

1. Agentless-managed system support is available for VMware ESX Server 3i
only.

2. File systems that are displayed for the guest operating system are limited to
file systems within its virtual disk.

3. Inventory data provided can vary among Agentless, Platform-Agent, and
Common-Agent managed systems.

4. Hardware-platform-specific data is unavailable for hardware inventory.
5. Software Catalog Signatures not supported
6. Unless otherwise indicated, this task is supported (although the support might

be limited) by:
v Out-of-band notifications generated by the service processor
v CIM indications generated by Platform Agent or Common Agent

7. Limited supported for Problems (formerly hardware status) in levels 1 and 2
of Microsoft Virtual Server.

8. VMware support for the Problems task has the following limitations:
v No support for Platform Agent or Common Agent on VMware ESX Server

3i (Embedded and Installable Editions) although enhanced Agentless
support includes Problems support.

v Support is limited for guest operating systems.
v Support for console is limited to out-of-band notifications generated by a

service processor or in-band events generated by CIM (CIM support is
system-specific).

9. Supported on guest operating systems only.
10. Supported on Windows guest operating systems only.
11. Supported for Linux on Power Systems only.
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12. Limited support provided by virtualization manager.
13. Not supported for Linux on Power Systems.
14. On guest operating systems, support is provided for Linux updates and IBM

Flex System Manager agent updates only.
15. Where 1 is specified for Platform Agent (Level 1) support, the support is for

VMware ESX Server only; there is no Level 1 support for VMware ESXi.

Choosing the level of agent capabilities to deploy on managed
systems

IBM Flex System Manager provides four tiers of agents for managed systems. For
each managed system, you need to choose the tier that provides the amount and
level of capabilities that you need for that managed system.

About this task

Depending on the type of managed system and the management tasks you need to
perform, you can choose the level of agent capabilities that best fits your needs.
IBM Flex System Manager has four agent tiers:

Agentless in-band
Managed systems without any IBM Flex System Manager software
installed. IBM Flex System Manager communicates with the managed
system through the operating system.

Agentless out-of-band
Managed systems without any IBM Flex System Manager software
installed. IBM Flex System Manager communicates with the managed
system through something other than the operating system, such as a
service processor or a hardware management console.

Platform Agent
Managed systems with Platform Agent installed. IBM Flex System
Manager communicates with the managed system through the Platform
Agent.

Common Agent
Managed systems with Common Agent installed. IBM Flex System
Manager communicates with the managed system through the Common
Agent.

Considerations:
v Common Agent requires a significant footprint in regard to memory,

disk, and network requirements. For more information, see "Hardware
requirements for systems running Common Agent or Platform Agent."

v A managed system using Common Agent can be managed by only one
IBM Flex System Manager.

These agent tiers provide different amounts and levels of capabilities in IBM Flex
System Manager.

Procedure
1. For each managed system, determine which agent tiers support the managed

system based on the type of the managed system:
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Table 19. Agent tier support by managed system type1d

Managed system types
Agentless
in-band

Agentless
out-of-
band

Platform
Agent

Common
Agent

IBM systems running AIX X1a X1a X1b

IBM systems running IBM i X X X 1c X

IBM systems running Linux X X

IBM systems running Linux and
supporting the SSH 1e protocol

X X X X

IBM systems running Windows X X

IBM systems running Windows and
supporting either the SSH or DCOM1f

protocol

X X X X

Non-IBM systems running Linux and
supporting either the SSH or DCOM
protocol

X X

Non-IBM systems running Windows and
supporting either the SSH or DCOM
protocol

X X

Other managed resources, including
management processors supporting SSH,
racks, and SNMP devices

X X

Notes:
a. Agentless management is supported only with SSH, and it is limited

agentless support.
b. Common Agent is supported with and without SSH.
c. Platform Agent managed system support is not provided by the Platform

Agent but by either the 5722UME or 5770UME product.
d. In this table, "systems" include servers, desktop computers, workstations,

and mobile computers.
e. SSH = Secure Shell
f. DCOM = Distributed Component Object Model

2. For each managed system, determine which agent tiers support the managed
system based on the attributes of the managed system:

Table 20. Agent tier support by managed system attribute1d

Managed system attributes
Agentless
in-band

Agentless
out-of-band

Platform
Agent

Managed system has a supported
workgroup/enterprise management agent
installed

X

Minimal additional memory constraint on
managed system

X

No additional memory constraint on managed
system

X X

No Common Agent license required X X X

No software required on managed system X X
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3. For each managed system, determine the capabilities of IBM Flex System
Manager that you need and decide which agent tier you want to deploy. For
instructions, see one or both of the following tasks:
v “Choosing the level of agent capabilities to deploy on IBM Power Systems”

on page 92
v “Choosing the level of agent capabilities to deploy on X-Architecture

managed systems”

Choosing the level of agent capabilities to deploy on
X-Architecture managed systems
IBM Flex System Manager provides four tiers of agents for X-Architecture
managed systems. For each managed system, you need to choose the tier that
provides the amount and level of capabilities that you need for that managed
system.

Procedure
1. For each managed system, determine the capabilities of IBM Flex System

Manager that you need.
2. For each managed system, decide which agent tier you want to deploy:

Table 21. Agent-tier selection worksheet

Capabilities
Agentless
in-band

Agentless
out-of-
band

Platform
Agent

Common
Agent

Upward integration module support (for
example: Tivoli, Microsoft, CA, BMC)

X X

Virtualization management through the
KVM hypervisor using IBM Flex System
Manager VMControl

X1

Automation manager

Manage operating system resources and
processes

X

Configuration manager

Network configuration (through CIM
Protocol)

X X X

System account configuration X X

Asset ID configuration X X

NTP configuration X X X

Power management configuration X X X

SNMP agent configuration X X

Global Configuration of CIM-Indication
Subscriptions

X X

Discovery manager

Detailed software information (for
example: applications and drivers)

X X X

Operating system (for example:
information and network configuration)

X X X

Vendor function (for example: Broadcom,
LSI, QLogic, and Brocade)

X X X

Memory DIMM inventory X X X X
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Table 21. Agent-tier selection worksheet (continued)

Capabilities
Agentless
in-band

Agentless
out-of-
band

Platform
Agent

Common
Agent

Processor information X X X X

Chassis and VPD inventory X X X

IMM (for example: authentication, user
accounts, event logs, information, and
network configuration)

X X X

Remote access manager

Limited remote access X X

Remote access file transfer X

Status manager

Vendor function (for example: Broadcom,
LSI, QLogic, and Brocade)

X X X

Boot control X

Power management X X

Hardware alerts and status (for example:
disk, fan, power, temperature, and
voltage)

X X X

IMM (for example: authentication, user
accounts, event logs, information, and
network configuration)

X X X

Health and status monitoring X X

Limited restart X X

Platform alerts X X

Manage operating system resources and
processes

X

Monitor resources and processes X X

Update manager

Non-chassis firmware updates (for
example: I/O card)

X X X

Vendor function (for example: Broadcom,
LSI, QLogic, and Brocade)

X X X

System firmware updates (for example:
UEFI, DSA, and IMM)

X X X X

IMM (for example: authentication, user
accounts, event logs, information, and
network configuration)

X X X

Deploy agent updates
Note: Agent installation is performed
either manually or with the Agent
Installation Wizard. See “Installing agents”
for more information.

X X

1 This function requires the IBM Flex System Manager Platform Agent for RHEL 6 for
Linux on IBM x86-64 on KVM.

Chapter 1. Overview of the IBM Flex System management node 91



Choosing the level of agent capabilities to deploy on IBM Power
Systems
IBM Flex System Manager provides four tiers of agents for IBM Power Systems
managed systems. For each managed system, you need to choose the tier that
provides the amount and level of capabilities that you need for that managed
system.

Procedure
1. For each managed system, determine the capabilities of IBM Flex System

Manager that you need.
2. For each managed system, decide which agent tier you want to deploy:

Table 22. Agent-tier selection worksheet

Capabilities
Agentless
in-band

Agentless
out-of-
band

Platform
Agent

Common
Agent

Automation manager

Manage operating system resources and
processes

X

IBM i message queue monitor With
5770UME

version

X

Discovery manager

Operating system X X X

Hardware inventory X X X

Software inventory X X

Hardware inventory (IBM i) X for
limited

hardware

X X

Software inventory (IBM i) X X X

Remote access manager

Launch-in-context X X

Launch-in-context for IBM i management X X

Limited remote access X

Remote access file transfer X

DShell X

Status manager

Hardware alerts X X X

Power management X X

Monitoring X

IBM i monitors X X

Update manager

Management software X

System firmware X X

AIX X

Virtual I/O Server X

I/O firmware X
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Table 22. Agent-tier selection worksheet (continued)

Capabilities
Agentless
in-band

Agentless
out-of-
band

Platform
Agent

Common
Agent

IBM i X X X

Features on Demand
IBM Features on Demand provides optional software that is available for Flex
System Manager Types 7955, 8731, and 8734 and IBM Flex System Manager
management software. You can also use the management software to enable
optional features for managed compute nodes.

Features on Demand provides a convenient way for you to order and activate
optional features from IBM through the management software web interface. You
can also upload compute node Features on Demand keys to the management node
and administer the keys to managed compute nodes through the management
software.

Any Features on Demand software that were ordered with your IBM Flex System
Manager management node, and were installed during the manufacturing process,
are preactivated and do not require manual activation through the management
software interface.

If you ordered the Features on Demand software separately from your IBM Flex
System Manager management node, without the assembly option, you must
activate it manually in the management software.

If you did not order management software Features on Demand when you ordered
the Flex System Manager Types 7955, 8731, and 8734 management node, you can
purchase Features on Demand as you would any other software and hardware
option. You can redeem Features on Demand for the management software by
emailing IBM Features On Demand license key support, at: FOD@us.ibm.com.

Important:

1. You can only enable Features on Demand keys on compute nodes through the
management software if the compute node is configured to boot a
UEFI-compatible operating system. If the compute node was configured in the
Setup Utility to boot in legacy mode, you cannot activate Features on Demand
keys.

2. Install Features on Demand keys through the management software web
interface. If you use the IMM2 interface or any other method to import and
install Features on Demand keys, the activated software will not work until you
restart the management software.

Using Features on Demand keys
Features on Demand keys enable you to view and install optional features for IBM
Flex System Manager management software and managed IBM Flex System
resources.

Important:

1. You can enable Features on Demand keys on compute nodes only through the
management software if the compute node is configured to boot a

Chapter 1. Overview of the IBM Flex System management node 93

mailto:FOD@us.ibm.com


UEFI-compatible operating system. If the compute node was configured in the
Setup Utility to boot in legacy mode, you cannot activate Features on Demand
keys.

2. Install Features on Demand keys through the management software web
interface. If you use the IMM2 interface or any other method to import and
install Features on Demand keys, the activated software will not work until you
restart the management software.

The Manage Features on Demand Keys page has a view list, from which you can
select either IBM FSM keys or All keys. The “FSM keys” view enables you to add
and remove only the keys that apply to the management software. The “All keys”
view enables you to add and remove keys from the management software and
managed compute nodes. The process of adding a key to one or more compute
nodes involves creating and configuring a configuration template.

Note: This topic describes how to access this task in the IBM Flex System Manager
Web user interface. If you are using the IBM FSM Explorer, use the finder at the
top of the user interface (shown here) to locate this task:

To manage the Features on Demand keys that are installed, or to import a new key,
complete the following steps:
1. On the Home page, click the Administration tab.
2. Under Feature on Demand tasks, click Manage Features on Demand Keys. The

Manage Features on Demand Keys page opens and the installed keys are
displayed.

3. Select the keys that you want to view:
v To view management software keys, select IBM FSM keys from the View

list.
v To view all IBM Flex System keys, including keys for managed resources,

select All keys from the View list.
4. To import a key, click the Add IBM FSM Keys or Add Node Keys button

(depending on the view):
v If you click Add IBM FSM Keys, an Add IBM FSM Keys window opens that

enables you to import a key.
v If you click Add Node Keys, the Configuration Templates table is displayed.

Create a configuration template for the key that you want install:
a. Click Create. The Create window opens.
b. Select the applicable template type from the Template type list.
c. From the Configuration to create a template list, select Feature

Activation Manager Configuration.
d. Enter a configuration template name and description.
e. Click Continue. The Feature Activation Configuration wizard is

displayed.
f. Complete the Feature Activation Configuration wizard. After you specify

the feature activation settings, click Finish to save the feature activation
configuration.
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g. From the Configurations Templates page, select the feature activation
template that you created; then, click Deploy.

List of Features on Demand
The following Features on Demand options are available for Flex System Manager
Types 7955, 8731, and 8734 and IBM Flex System Manager management software.

You can use the management software web interface to install the following
Features on Demand options.

If you did not order management software Features on Demand when you ordered
the Flex System Manager Types 7955, 8731, and 8734 management node, you can
purchase Features on Demand as you would any other software and hardware
option. Contact IBM Features On Demand license key support, by sending an
email to: FOD@us.ibm.com to request activation keys for the option.

Table 23. Flex System Enterprise Chassis Features on Demand

Feature type code Description

000b IBM Flex System Manager License

0010 IBM Flex System Manager Service Fabric
Provisioning

0018 IBM Flex System Manager Advanced Bundle

Installing Features on Demand keys on network switches
Use the Manage Features on Demand page in the IBM Flex System Manager
management software web interface to create a configuration template that will
install the Features on Demand key on network switches.

The process of adding a key to one or more network switches involves creating
and configuring a configuration template. To install Features on Demand keys on
network switches from the management software web interface, complete the
following steps.

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

1. From the Home page, click the Administration tab.
2. Under Features on Demand tasks, click Manage Features on Demand Keys.

The Manage Features on Demand Keys page is displayed.
3. From the View menu, select All Keys.
4. Click Add Node Keys. The Configuration Templates table is displayed.
5. Click Create. The Create Configuration Template page is displayed.
6. Select the applicable template type from the Template type list.
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7. From the Configuration to create a template list, select Feature Activation
Manager Configuration.

8. Enter a configuration template name and description.
9. Click Continue. The Feature Activation Configuration wizard is displayed.

10. Complete the Feature Activation Configuration wizard. After you specify the
feature activation settings, click Finish to save the feature activation
configuration.

11. From the Configurations Templates page, select the feature activation template
that you created; then, click Deploy.

Backing up and restoring the management software
Use the IBM Flex System Manager management software to back up or restore
your software image.

On the Backup and Restore page in the management software web interface, you
can initiate a backup of the management software image, schedule future backups
of the management software image, and restore a management software image.

Important: The backup file that is created through the management software
backup task is unencrypted, and contains unsecured data that is otherwise
restricted in an IBM Flex System environment. Use your own method to protect
the backup file.

A backup of the management software includes the following data:
v The management software image
v The local IBM Flex System Manager user registry
v IBM Flex System Manager configuration settings (including network settings)
v Discovered endpoints and inventory
v Configuration pattern data

Note: When you initiate a backup, the management software checks for jobs that
are active and in process. If one or more jobs are running when you initiate the
backup, the backup will not proceed.

Backing up the management software image
You can back up the IBM Flex System Manager management software image to the
management node hard disk drive, a USB drive, or a secure FTP server. The
backup image is a full backup, and includes all applied fixes, data on managed
chassis, and any custom settings.

A backup of the management software includes the following data:
v The management software image
v The local IBM Flex System Manager user registry
v IBM Flex System Manager configuration settings (including network settings)
v Discovered endpoints and inventory
v Configuration pattern data

Important: The backup file that is created through the management software
backup task is unencrypted, and contains unsecured data that is otherwise
restricted in an IBM Flex System environment. Use your own method to protect
the backup file.
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Choosing a location for management software backups

Attention: The option to back up the management software to the local hard disk
drive is selected by default in the web interface. However, a backup that is stored
on the local drive is useless if that drive fails. To protect your backup from a disk
failure, make sure that you back up to a secure FTP (SFTP) server or USB drive.

Important: To backup the management software to an SFTP server, the destination
server must have Linux with Secure Shell (SSH) enabled. Otherwise, the backup
operation might fail.

To create a backup that is available in a disaster recovery situation, backup the
management software to an SFTP server in a remote location or to a USB drive
that will be stored in a remote location. It is recommended that you schedule your
backups to an SFTP server on a regular basis for use in a manual failover scenario.

The local hard disk drive in the IBM Flex System Manager management node has
a limited amount of available space for storing backups. Typically, the local hard
drive has space for only three backups. USB drives have similar space constraints.
An SFTP server, which potentially has more backup storage space, might be the
best backup location for your management software backup images.

Choosing when to back up the management software

Back up the management software often. For a typical IBM Flex System
environment, you might want to backup the management software once or twice
weekly. You can schedule backups so that the backup image is created and saved
automatically; see “Scheduling management software image backups” on page 101
for more information.

Note: You can schedule only one backup at a time.

In addition to regular and scheduled backups, back up the management software
in the following situations:
v After multiple new managed resources are discovered or removed.
v After multiple new virtual machines are deployed or removed.
v After a management software policy change (for example, the security policy or

password rules policy).
v Before and after every management software update or upgrade.
v After an IP configuration change or other network configuration change.
v After user accounts are created, deleted, or modified (for example, after user

passwords expire or reset).
v After user credentials or permissions are modified.
v After you have created, modified, or deployed configuration patterns.
v After obtaining new updates for managed resources, even it the updates are not

yet deployed.

See “Restoring the management software image” on page 102 for information
about how to restore the management software image.
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Backing up the management software image to the hard disk
drive
Use this information to back up the IBM Flex System Manager management
software image to the management node hard disk drive. The backup image
includes all applied fixes, data on managed chassis, and any custom settings.

You can back up the management software image to the hard disk drive by using
either the Backup and Restore page in the web interface or the command-line
interface (CLI). The management node hard disk drive is the only hard disk drive
in the chassis that supports backup.

Approximately 400 Gb of space is available on the management node hard disk
drive for backup storage. If you use all of the backup storage space, the next
backup that you attempt will fail.

Attention: The option to back up the management software to the local hard disk
drive is selected by default in the web interface. However, a backup that is stored
on the local drive is useless if that drive fails. To protect your backup from a disk
failure, make sure that you back up to a secure FTP server or USB drive.

For information about backing up the software to a SFTP server or USB drive, see
“Backing up the management software image to a secure FTP server” on page 100
or “Backing up the management software image to a USB drive.”

Important: Do not power off the IBM Flex System Manager management node
while a backup operation is in process. Otherwise, the backup will fail.

To back up the management software image to the local hard drive with the
management software web interface, complete the following steps:
1. From the Home page, click the Administration tab.
2. On the Administration tab under Serviceability tasks, click Backup and

Restore. The Backup and Restore page opens.
3. From the Backup and Restore page, click Backup Now. The Backup Now

window opens.
4. Select IBM Flex System Manager; then, click OK.

To back up the management software image to the hard disk drive with the
backupHDD command in the management software CLI, complete the following
steps:
1. Open a CLI prompt.
2. Use the backupHDD command to back up the software image to the hard disk

drive. A file named yyyymmddhhmmss.tar.gz (where yyyymmddhhmmss is the
year, month, day, hour, minute, and second the file was created) is saved on the
hard disk drive.

See “Restoring a management software image from the hard disk drive” on page
103 for information about how to restore the management software image from the
hard disk drive.

Backing up the management software image to a USB drive
Use this information to back up the IBM Flex System Manager management
software image to a USB drive. The backup image includes all applied fixes, data
on managed chassis, and any custom settings.
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You can back up the management software image to a USB drive by using either
the Backup and Restore page in the web interface or the command-line interface
(CLI). For more information about backing up the software to a secure FTP server
or the management node hard disk drive, see “Backing up the management
software image to a secure FTP server” on page 100 or “Backing up the
management software image to the hard disk drive” on page 98.

Important: Do not power off the IBM Flex System Manager management node
while a backup operation is in process. Otherwise, the backup will fail.

Before you initiate a management software backup to a USB drive, be aware of the
following conditions:
v The only supported USB file system formats are FAT32, ext3, and ext4.
v If you use the management software web interface to back up the management

software image, the USB drive is mounted automatically as part of the backup
process.
See “Scheduling management software image backups” on page 101 for more
information about scheduling a management software backup.

v Some USB drives might not be recognized when they are first mounted. If you
remove and reinsert the USB drive, it should then be recognized.

v If you back up to a USB device that does not support a minimum write speed of
5 MBps, the management software pauses for several minutes, and the
management node is inoperable.

To back up the management software image to a USB drive with the management
software web interface, complete the following steps:
1. From the Home page, click the Administration tab.
2. On the Administration tab under Serviceability tasks, click Backup and

Restore. The Backup and Restore page opens.
3. From the Backup and Restore page, click Backup Now. The Backup Now

window opens.
4. Select USB device; then, click OK.

To back up the management software image to a USB drive with the backup
command in the management software CLI, complete the following steps.

Important: A backup that is created with the backup command (whether on an
SFTP server or a USB device) does not appear in the list that is generated when
you run the listBackups command, or in the Recent Backups table on the Backup
and Restore page in the management software web interface.
1. Insert a USB device into the USB port on the management node. The USB

device is mounted automatically.
2. Open a CLI prompt.
3. Use the backup -l usb command to back up the software image to the USB

drive. A file named yyyymmddhhmmss.tar.gz (where yyyymmddhhmmss is the
year, month, day, hour, minute, and second the file was created) is saved on the
USB drive.

See “Restoring a management software image from a USB drive” on page 103 for
information about how to restore the management software image from a USB
drive.
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Backing up the management software image to a secure FTP
server
Use this information to back up the IBM Flex System Manager management
software image to a secure FTP (SFTP) server that has Secure Shell (SSH). The
backup image includes all applied fixes, data on managed chassis, and any custom
settings.

You can back up the management software image to an SFTP server by using
either the Backup and Restore page in the web interface or the command-line
interface (CLI).

Important: To backup the management software to an SFTP server, the destination
server must have Linux with Secure Shell (SSH) enabled. Otherwise, the backup
operation might fail.
For more information about backing up the software to a USB drive or the
management node hard disk drive, see “Backing up the management software
image to a USB drive” on page 98 or “Backing up the management software image
to the hard disk drive” on page 98.

Important: Do not power off the IBM Flex System Manager management node
while a backup operation is in process. Otherwise, the backup will fail.

To back up the management software image to an SFTP server with the
management software web interface, complete the following steps:
1. From the Home page, click the Administration tab.
2. On the Administration tab under Serviceability tasks, click Backup and

Restore. The Backup and Restore page opens.
3. From the Backup and Restore page, click Backup Now. The Backup Now

window opens.
4. Select SFTP Server.
5. Type the SFTP filepath, user name, and password; then, click OK.

Note: Please note that the following characters cannot be used in the directory
paths for SFTP backups created using the web interface: '_', '#', '$', and '*'.

To back up the management software image with the backup command in the
management software CLI, complete the following steps.

Important: A backup that is created with the backup command does not appear in
the Recent Backups table on the Backup and Restore page in the management
software web interface.
1. Open a CLI prompt.
2. Use the backup command with the SFTP server name, path, user name, and

password (see the following example) to back up the software image to SFTP:
backup -l sftp -s [sftp server name] -d [path on sftp server]
-u [sftp user name] -p [sftp_password]

A file named yyyymmddhhmmss.tar.gz(where yyyymmddhhmmss is the year,
month, day, hour, minute, and second the file was created) is saved on the
SFTP server.

See “Restoring the management software image from a secure FTP server” on page
104 for information about how to restore the management software image from an
SFTP server.

100 Systems Management Guide



Scheduling management software image backups
Schedule regular backups of your IBM Flex System Manager management software
image to ensure that you have a working software image in the event of system
failure.

Note:

1. You can schedule only one backup at a time.
2. If you are planning for a manual failover scenario, it is recommended that you

schedule your backups to a secure FTP server.

To schedule backups of the management software image to the management node
hard disk drive, a USB device, or a secure FTP server with the management
software web interface, complete the following steps:
1. On the Home page, click the Administration tab.
2. Under Serviceability Tasks, click Backup and Restore. The Backup and Restore

page opens.
3. Click Schedule backups. The Backup Scheduler wizard opens.
4. Complete the steps in the Backup Scheduler wizard.

The Backup Scheduler wizard offers the following backup options:
v Scheduled backups:

– Disable scheduled backups
– Enable scheduled backups to a USB device
– Enable scheduled backups to a secure FTP server

v Frequency:
– Start date
– Time of day
– Repeat options: weekly, monthly, or yearly
– Duration: for a particular period, until a particular date, or for an unlimited

amount of time

Restoring and version compatibility
Make sure that you understand the version restrictions for backup images before
you restore a backup image.

In most situations that require you to restore a backup of the IBM Flex System
Manager management software, make sure that the management software version
in the backup file matches the management software version that you use to
restore the backup. The following guidelines show the compatible backups for each
management software version.

Note: When you restore an IBM Flex System Manager management software, the
restored IBM Flex System Manager management software will use the firmware
level from the backup.
v In version 1.3.0, you can restore only a backup of version 1.3.0 or version 1.2.1
v With version 1.2.1, you can restore only a backup of version 1.2.1
v With version 1.2.0, you can restore only a backup of version 1.2.0
v With version 1.1.1, you can restore only a backup of version 1.1.1
v With version 1.1.0, you can restore only a backup of version 1.1.0
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You cannot restore a backup image from management software version 1.1.1 or
earlier on an IBM Flex System Manager management node with management
software version 1.2.0 installed. If you must restore an image from version 1.1.1 or
earlier, use the IBM Flex System Manager management software Recovery DVDs
for the management software version that you want to restore.

If you want to restore from a backup image that is stored locally on the
management node hard disk drive, make sure that you use the Recovery DVDs for
version 1.1.1 and not version 1.1.0. A problem with version 1.1.0 requires that you
noted the local backup image name before performing the recovery. With version
1.1.1, you can use the command-line interface (CLI) to list the local backups; then,
you can restore the local backup from the CLI. For more information about
restoring an earlier version of the management software, see “Restoring an earlier
version of the management software image” on page 105.

Restoring the management software image
You can restore an IBM Flex System Manager management software image from a
backup that is stored on the management node hard disk drive, USB drive, or a
secure FTP server (SFTP).

Preparing to restore a backup image

You cannot restore a backup image from management software version 1.1.1 or
earlier on an IBM Flex System Manager management node with management
software version 1.2.0 installed. If you must restore an image from version 1.1.1 or
earlier, use the IBM Flex System Manager management software Recovery DVDs
for the management software version that you want to restore.

Before you restore a backup image, make sure that you understand the following
conditions.

Configuring the management software after you restore a backup
image

After a restore operation is complete, collect inventory for all of the managed
resources in your IBM Flex System environment.

If you restored a backup that was taken from an earlier version of the management
software, update the management software to the same version as before the
restore operation.

Important: If you do not update the management software in this situation, the
management software version might be older than other components in your
environment, which might cause compatibility problems.

If any managed resources were removed from management after a backup was
created, and you restore that backup image, the endpoints for the deleted resources
will reappear in the management software. You must delete the endpoints
manually to remove them.

Similarly, any managed resources that were discovered after a backup image was
created must be re-discovered after that backup is restored.

If a chassis was managed in centralized user management mode, and you restore a
backup image that was created before centralized user management mode was
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enabled, you might have to use the RECOVERY_ID account to re-manage the
chassis. See “Recovering chassis management with a CMM after a management
node failure” on page 507 for more information.

Restoring a management software image from the hard disk
drive
You can restore an IBM Flex System Manager management software image from a
backup that is stored on the management node hard disk drive, USB drive, or a
secure FTP server (SFTP).

About this task

The management software backup image includes all applied fixes, data on
managed chassis, and any custom settings. For information about restoring a
backup image from a USB drive or secure FTP server, see “Restoring a
management software image from a USB drive” or “Restoring the management
software image from a secure FTP server” on page 104.

Notes:

v If the management software has failed and the management node will not boot,
you can boot the management software and restore or reinstall the management
software image from optical media. See Chapter 22, “Management software
recovery and reinstallation,” on page 667 for more information.

v You can use the listBackups command to see a list of all of the backups. The list
displays the name of the backup file and the location where it is stored.

To restore the management software image with the web interface, click Restore
now on the Backup and Restore page, select the backup location and file for the
image that you want to restore, and click OK.

To restore the management software image from the hard disk drive with the
restoreHDD command in the CLI, complete the following steps:

Procedure
1. Open a CLI prompt.
2. Use the restoreHDD file name command, where file name is the name of the

backup file, to restore the image from the hard disk drive.

Restoring a management software image from a USB drive
You can restore an IBM Flex System Manager management software image from a
backup that is stored on a USB drive or a secure FTP server (SFTP).

About this task

The management software backup image includes all applied fixes, data on
managed chassis, and any custom settings. For information about restoring a
backup image from a secure FTP server or the management node hard disk drive,
see “Restoring the management software image from a secure FTP server” on page
104 or “Restoring a management software image from the hard disk drive.”

Note: If the management software has failed and the management node will not
boot, you can boot the management software and restore or reinstall the
management software image from optical media. See “Reinstalling management
software components from optical media after replacing the hard disk drive” on
page 668 for more information.
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Before you restore a management software image from a USB drive, be aware of
the following conditions:
v The only supported USB file system formats are FAT32, ext3, and ext4.
v If you use the management software web interface to restore the management

software image, the USB drive is mounted automatically as part of the restore
process.

v Some USB drives might not be recognized when they are first mounted. If the
USB drive is not recognized initially, remove and reinsert the USB drive.

v If you restore from a USB drive that does not support a minimum write speed
of 5 MBps, the management software pauses for several minutes, and the
management node is inoperable.

To restore the management software image with the web interface, click Restore
now on the Backup and Restore page, select the backup location and file for the
image that you want to restore, and click OK.

To restore the management software image with the restore command in the CLI,
complete the following steps:

Procedure
1. Insert a USB device into the USB port on the management node. The USB

device is mounted automatically.
2. Open a CLI prompt.
3. Use the restore -l usb command to restore the image from the USB drive.

Restoring the management software image from a secure FTP
server
You can restore an IBM Flex System Manager management software image from a
backup that is stored on a secure FTP server (SFTP).

About this task

Important: To restore a management software backup that was saved to
management software to an SFTP server, the destination server must have Linux
with Secure Shell (SSH) enabled. Otherwise, the backup operation might have
failed.

The management software backup image includes all applied fixes, data on
managed chassis, and any custom settings. For information about restoring a
backup image from a USB drive or the management node hard disk drive, see
“Restoring a management software image from a USB drive” on page 103 or
“Restoring a management software image from the hard disk drive” on page 103.

Note: If the management software has failed and the management node will not
boot, you can boot the management software and restore or reinstall the
management software image from optical media. See “Reinstalling management
software components from optical media after replacing the hard disk drive” on
page 668 for more information.

To restore the management software image with the web interface, click Restore
now on the Backup and Restore page, select the backup location and file for the
image that you want to restore, and click OK.
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To restore the management software image from an SFTP server with the restore
command in the CLI, complete the following steps:

Procedure
1. Open a CLI prompt.
2. Use the restore command with the SFTP server name, path, user name, and

password (see the following example) to back up the software image to SFTP:
restore -l sftp -s [sftp server name] -d [path on sftp server]
-u [sftp user name] -p [sftp_password]

Restoring an earlier version of the management software image
In some circumstances, you might want to restore a management software image
that is earlier than the version that is installed when a management node fails. Use
this information to understand the conditions for restoring an earlier management
software version.

Before you begin

Before you restore an earlier version of the management software to the
management node, make sure that you understand the following conditions:
v You cannot restore a backup image from management software version 1.1.1 or

earlier on an IBM Flex System Manager management node with management
software version 1.2.0 installed. If you must restore an image from version 1.1.1
or earlier, use the IBM Flex System Manager management software Recovery
DVDs for the management software version that you want to restore.

v If you want to restore a backup image that is stored locally on the management
node hard disk drive, you might need to restore version 1.1.1 and not version
1.1.0. A problem with version 1.1.0 requires that you noted the local backup
image name before performing the recovery; the local backup files are retained
after recovery, but the names are lost. With version 1.1.1, you can use the
command-line interface (CLI) to list the local backups; then, you can restore the
local backup from the CLI.

About this task

To restore an earlier version of the management software, complete the following
steps.

Important: If you want to restore a local backup after recovering the management
software, make sure that you recover to version 1.1.1 (and not version 1.1.0).

Procedure
1. Use the Recovery DVDs to recover the management software image by

completing the procedure in “Reinstalling management software components
from optical media after replacing the hard disk drive” on page 668.

Note: Before you request the Recovery DVDs from IBM Support, see
“Obtaining the IBM Flex System Manager Recovery DVDs” on page 672 to
determine the FRU part number for your version of the management software.

2. Open the management software CLI, and run the listBackups command. The
output displays all types of management software backups (local hard disk
drive, USB, and SFTP). Note the name of the backup file that you want to
restore.
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3. Depending on the location of your backup file, complete one of the following
actions"
a. To restore a backup from SFTP or USB, use the restore to restore the

backup image.
b. To restore a backup from the local management node hard disk drive, use

the restoreHDD command.

Moving files to and from the management node
There are a few different methods for copying files securely to and from Flex
System Manager Types 7955, 8731, and 8734 management nodes. Use these
methods to copy updates, fix packages, agent files, or other files.

About this task

Use one of the following methods to copy files to the /home/USERID directory on
the management node:

Using a SCP tool
Use a Secure Copy (SCP) tool on a laptop or workstation attached to the
management or data network.

Important: Make sure that the SCP tool transfers the files to the
management node in a binary format. If the files are transferred as text, the
transfer process might modify the readme files and corrupt them.

Using the scp command
Use the scp command in the management software CLI to retrieve the fix
package from an SSH server on the management or data network. See the
following examples.

From a management software console, logged in as USERID:
scp USERID @<remote_host_name>:/directory/* /home/*

From a remote server or workstation:
scp * USERID@<management_node_host_name>:/home/USERID/*

Using a USB storage device
To copy the files from a USB storage device that is formatted for FAT16,
FAT32, ext2, or ext3 file systems, complete the following steps.

Note: The maximum file size that is supported by FAT16 is 2 GB; the
maximum for FAT32 is 4 GB. If your update files are larger, format your
USB storage device for the ext2 or ext3 file system.
1. Insert a USB storage device into the USB port on the front of the

management node. It will take 5 - 10 seconds for the device to be
recognized.

2. SSH to the management node.
3. Log in with the default USERID and password.
4. Use the lsmediadev command to list the storage media devices that are

available for use on the system and identify the USB storage device.
The resulting output will be similar to the following, where vdi1 is the
USB storage device:
device=/dev/cdrom,mount_point=/media/cdrom,
type=1,description=CD/DVD
device=/dev/vdi1,mount_point=/media/vdi1,
type=3,description=USB flash memory device
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5. Type mount /dev/vdi1 and press Enter.
6. Use the command cp to copy the files. For example:

cp /media/vdi1/<file_name> /home/USERID

7. Type umount /dev/vdi1 and press Enter to unmount the USB storage
device.
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Chapter 2. User interfaces

You can use the IBM Flex System Manager management software web interface or
a command-line interface (CLI) to manage resources in the IBM Flex System
environment.

In addition to the standard web interface, you can use the IBM FSM Explorer
console to find management software tasks and resources. See Introduction to the
Flex Explorer console for more information.

For more information about the command-line interface, including specific
commands, see the IBM Flex System Manager Command Reference Guide document.

In an IBM Flex System environment with typical usage activity, the management
software supports 10 concurrent users.

Note:

1. The management software web interface and CLI are available in English only,
and only English-language keyboards are supported.

2. The maximum number of concurrent users that the management software can
support depends on the each user’s activities within the management software.

For educational information about management software interfaces, see
http://publib.boulder.ibm.com/infocenter/flexsys/information/topic/
com.ibm.acc.common.nav.doc/learning_interface_tour.html.

Using the web interface
You can use the IBM Flex System Manager management software, Integrated
Management Module (IMM, for X-Architecture compute nodes), Advanced System
Management (ASM, for flexible service processors in IBM Power Systems compute
nodes), and Chassis Management Module (CMM) web interfaces to perform
systems-management tasks. Data is transferred securely between the web browser
and web interface through HTTPS.

IBM Flex System Manager management software provides the web interface
through which you can view resources and use tasks in your systems-management
environment. This section provides information about the web interface, including
the Home page, the different ways to view resources, and how to work with tables
and topology maps that are used in these different views; how to find resources;
how to create and work with groups of resources; how to find and start tasks; how
to schedule tasks, and much more.

In addition to these fundamental tasks, the management software provides the
following tasks and features through integrated software components (or plug-ins)
that are already installed:
v Managing chassis and compute nodes (see Chapter 12, “Managing a chassis,” on

page 503 and Chapter 14, “Managing compute nodes,” on page 523)
v System status, health, event logs, and active status events (see Monitoring

system status and health)
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v Management and installation of updates to existing software products and
firmware, external network and storage switches, as well as external storage
servers (see the Updating systems chapter)

v A number of security features that include authentication and
user-administration options (see “Security” on page 24)

Accessing the management software web interfaces
There are multiple web-based user interfaces available in an IBM Flex System
environment. Browser requirements vary, depending on the interface that you use.

You can use the following web interfaces to perform systems-management tasks:
v IBM Flex System Manager management software
v Chassis Management Module (CMM)
v Integrated Management Module (IMM, for X-Architecture compute nodes)
v Advanced System Management (ASM, for flexible service processors in IBM

Power Systems compute nodes)
v Flex System V7000 management web interface (for the IBM Flex System V7000

Storage Node and IBM Storwize V7000 storage systems)

Data is transferred securely between the web browser and web interface through
HTTPS.

IBM Flex System environment considerations

Note: Each type of IBM Flex System component supports different web browsers.

The following browsers are supported by all of the IBM Flex System web
interfaces:
v Mozilla Firefox Extended Support Release (ESR) 31.x.x
v Microsoft Internet Explorer versions 9.0, 10.0 and 11.0

Note:

1. Additional requirement for the IBM Flex System FC3171 8Gb SAN Switch:
Java™ 2 Standard Edition Runtime Environment 1.4.2 or later is required to
support the web applet

2. Additional requirement for the IBM Flex System FC5022 16Gb SAN Scalable
Switch: Brocade Web Tools requires any browser that conforms to HTML
version 4.0, JavaScript version 1.0, and Java Plug-in 1.6.0_24 or later.

3. The FC5022 16Gb SAN Scalable Switch might not support Microsoft Internet
Explorer on Windows 7.

IBM Flex System Manager management software web interface

The following browsers are supported by the management software web interface:
v Mozilla Firefox Extended Support Release (ESR) 31.x.x. (Remote presence

function for x86 is supported only from supported Windows and Linux
operating systems.)

v Microsoft Internet Explorer versions 9.0, 10.0, and 11.0

To log in to the management software, complete the following steps:
1. Point your browser to the management software URL that your system

administrator defined during initial configuration.
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2. Type your user ID and password (assigned by a system administrator).
3. Click Log in.

Note:

1. The tabs displayed at your first log in are determined by the groups that your
USERID belongs to. If your group memberships change, you can update your
tabs using My Startup Pages.

2. If you log into the management software by using a web browser, and log into
management software again using the same browser application from the same
system, unpredictable results, including empty web pages, might occur in both
browser sessions.

3. For optimal performance, make sure that no more than 10 users are logged in
at one time.

4. If you do not actively use the management software web interface for 30
minutes, the automatic-timeout feature will log out your user ID.

5. Although the IBM Flex System Manager management software and Integrated
Management Module (IMM) web interfaces support Internet Explorer 7.0, the
CMM web interface supports only version 8.0 and later.

Chassis Management Module (CMM) web interface

The following browsers are supported for use with the CMM web interface:
v Mozilla Firefox version 3.6 and later
v Microsoft Internet Explorer version 8.0 and later

Note: Although the IBM Flex System Manager management software and
Integrated Management Module (IMM) web interfaces support Internet Explorer
7.0, the CMM web interface supports only version 8.0 and later.

Integrated Management Module (IMM) web interface

The following browsers are supported for use with the IMM web interface:
v Mozilla Firefox version 3.5 and later
v Microsoft Internet Explorer version 7.0 and later

Additionally, the IMM web interface supports the following browser and client
operating system combinations:
v SLES version 11 and later with Firefox 3.5 and later
v RHEL5 and later with Firefox 3.5 and later
v Microsoft Windows XP with Internet Explorer 7.0 and later
v Microsoft Windows XP with Firefox 3.5 and later
v Microsoft Windows Vista with Internet Explorer 7.0 and later
v Microsoft Windows Vista with Firefox 3.5 and later
v Microsoft Windows 2008 with Internet Explorer 7.0 and later
v Microsoft Windows 2008 with Firefox 3.5 and later

Note: Although the IBM Flex System Manager management software and
Integrated Management Module (IMM) web interfaces support Internet Explorer
7.0, the CMM web interface supports only version 8.0 and later.
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Advanced System Management (ASM) web interface

The ASM interface supports the following browsers:
v Mozilla Firefox version 2.0.0.11
v Microsoft Internet Explorer version 7.0
v Opera version 9.24

Note:

1. Later versions of these browsers might work, but are not officially supported.
2. ASM requires that the JavaScript language and cookies are enabled.

Flex System V7000 management web interface

The following browsers are supported for use with the Flex System V7000
management GUI:
v Mozilla Firefox versions 18 and ESR 17.0.x
v Microsoft Internet Explorer versions 8.0 and 9.0
v Google Chrome 24

The web interface
IBM Flex System Manager provides tasks and unique views to help you manage
your systems-management environment. You can access all tasks available in IBM
Flex System Manager and you can launch tasks in several other management tools.
You can access your resources using Resource Explorer.
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Content area
When you open the web interface, by default you see the Home page for
IBM Flex System Manager in the content area. The content area changes
depending on the item you select in the navigation area. You can
customize aspects of the content area using the Navigation Preferences.

Select Action list
This list provides the following ways to work with task pages:

My Startup Pages
Customizes the pages that are started automatically when you log
in to IBM Flex System Manager, the page that is displayed first of
these automatically started pages, and the default navigation area
view. For more information, see “Customizing the Web interface.”

Manage Open Pages
Provides a way to manage and close one or more open pages.

Close Page
Closes the page that you are viewing.

Help
Displays the help system.

Logout
Logs out of IBM Flex System Manager.

Figure 1. web interface
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Chassis Manager tab

Click the tab to go directly to the Chassis Manager page.

Navigation area
The navigation area of IBM Flex System Manager Web interface is hidden
by default. If you prefer to use the Navigation area, instead of navigating
to management software pages through the Content area, click the arrow
icon to open the Navigation area. The Navigation area provides categories
of tasks, and links to tasks that you can perform on your resources.
Examples of typical tasks might include Resource Explorer, Inventory,
Health Summary, and Automation and Settings.

Finding and navigating resources
The IBM Flex System Manager Web interface provides many ways to navigate
resources. This section includes information about finding resources; the available
ways to view resources and resource information, including working with
resources in tables; and working with resources in topology maps.

Before you begin

About this task

The Web interface provides navigational actions for resources by way of the
Actions menu and the complementary pop-up menu that is displayed when you
right-click a resource. These actions vary depending on the resource. When you
click a resource, the default navigational task occurs; the default task, too, can vary
depending on the resource. For example, if you click a group, the members of that
group are displayed. When you right-click a group, the first navigational action
provided in the pop-up menu is View Members, which displays the members of
the group. If you click a resource, the Properties page for that resource is
displayed. When you right-click a resource, Properties is provided at the bottom of
the pop-up menu.

The menu also provides the following navigational actions:
v When you select a resource, the Related Resources menu item provides a list of

any and all resources that are related to the currently selected resource.
v When you view members of a group, the menu provides group-specific actions.

For example, while viewing a member of the group called All My Linux Servers,
you can click Actions > All My Linux Servers to view a submenu of
appropriate actions for that group.

The Chassis Manager page in the management software is the primary interface for
selecting managed resources and performing management tasks on those resources.
For more information about using the Chassis Manager, see Using the Chassis
Manager.

As you navigate from one resource to another or drill down from a resource to its
subcomponents, a breadcrumb path is displayed at the top of the page as a
navigational signpost. The breadcrumb path is extended each time you drill down.
If you navigate to a related resource, the breadcrumb path is updated to the
current location. The last link in the path identifies your current location in the
resource navigation. If you right-click on this last link, a menu is displayed. This
menu provides the same options as the Actions menu at this current location. The
following examples illustrate specific resources and the pop-up menus that are
displayed when you right-click the breadcrumb path:
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v When you view members of a group, the breadcrumb path displays the menu
associated with that group.

v When you view compute nodes in a chassis, the breadcrumb path displays the
menu associated with the chassis.

v When you view a resource in a topology map, the breadcrumb path displays the
menu associated with that resource.

The Welcome banner area
The Welcome banner area provides links to the Active Status (compliance) page,
where you can view the active compliance issues for all discovered systems and
the Problems page, where you can view the active problems for all discovered
systems.

In the Welcome banner area, you can get a quick view of system status by viewing
the following icons next to Compliance or Problems:

v Warning

v Critical

For more detailed information, click Compliance, to view the Active Status
(compliance) page or click Problems to view the Problems page.

To view only the warnings or critical events on either the Active Status or
Problems pages, click the number for the event type.

Table view
The table view can display a list of the resources or tasks. Tables are the basic way
that information is displayed in IBM Flex System Manager.

Use the following example and descriptions to learn about the table view.
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Breadcrumb path

Provides a collection of links that show the navigation path to the current
view. You can click any of these links to go back in the path.

Toolbar
Provides frequently used tasks as buttons. Available buttons vary,
depending on the task page. In this example, the Create Group button is
provided, but on other task pages, the Create Group button might not be.

Actions
Opens a list of available actions. These actions include those that are
provided in the toolbar and elsewhere on the page as well as actions that
are common to all tables. For common table actions, see “Table navigation
in IBM Flex System Manager.”

Search the table
Searches the table with the string or phrase provided. When you type a
string in this field, any matching strings in the currently displayed table
are highlighted. Additionally, if you click Search, all of the pages of a table
are searched for the provided string; only the rows that contain the string
are displayed in the table.

Resource area
Displays the content of the resource area depending on the resources that
you have chosen to view. To see the members of a group, click on a group
in the table. The view drills down to view the group members in the table
and another step is added to the breadcrumb path. For example, if you
click Common-Agent systems in the table, all systems in your

6

5

43 2

1

7

Figure 2. Table view
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environment that have Common Agent installed are displayed. The
resource view functions in the same way regardless of the resources that
you have chosen to view.

To perform an action on a resource in the view, right-click the resource and
select an action.

Table state information
Provides navigation between pages of the table. The table view displays a
limited number of entries on a single page. To move to the next page, click
the arrow button at the bottom left portion of the table. The table view
indicates the number of pages of data that is being displayed, for example,
Page 1 of 3. It displays the count of resources or relationships currently
shown, filtered, and the number selected. To change the number of entries
that are displayed in the table, change the Rows per table setting in the
Navigation Preferences page. For more information see “Setting navigation
preferences.”

Tip: To got to a specific page, type a number in the provided entry field
and press Enter. If you specified an number that is not valid, the page in
the table does not change.

Common actions
Provides links to management tasks and quick navigation options to
summary pages for other management software components.

Managing and closing open pages in the web interface
The IBM Flex System Manager Web interface provides several ways to manage and
close open pages.

About this task

The web interface provides page controls in the upper-right corner in the Select
Action list. Also, when you have more page tabs that can be displayed in the
width of the web interface, an arrow is displayed that you can click to view the
additional tabs.

To manage and close open pages, complete any of the following steps:

Procedure
v In the IBM Flex System Manager Web interface, click Manage Open Pages from

the Select Action list that is located in the upper-right corner of the web
interface content area. On the Manage Open Pages page, you can close all pages
by clicking Close All Pages, close selected pages by selecting one or more pages
and clicking Close Page, or view a selected page by clicking the page link.

v To close a page that you are viewing, click Close Page from the Select Action
list.

v To close a page, click X on the page tab.
v When applicable, click the OK or Cancel buttons on the page.

Figure 3. Select Action list
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Groups
You can use IBM Flex System Manager to organize logical sets of resources into
groups.

Groups have the following general characteristics:
v Groups can include resources.
v Groups can include other groups.
v Resources can belong to multiple groups.
v You can perform tasks on groups in order to perform the task on every group

member.
v When you select a group in Resource Explorer, the resources that are members

of that group are displayed.

Planning Secure Sockets Layer configuration on IBM Flex
System Manager

IBM Flex System Manager provides, by default, a Secure Sockets Layer (SSL)
certificate that supports HTTPS connections between IBM Flex System Manager
and web browsers. However, to ensure server authentication, data privacy, and
data integrity, replace the default certificate with either a self-signed certificate or a
certificate that is signed by a certificate authority (CA), and change the keystore
password. PA certificate of the client can be changed only through IBM Flex
System Manager. If you must change the certificates, use IBM Flex System
Manager.

Before you begin

It is not required that you use SSL to secure the network traffic between your
management server and targets. However, configuring SSL ensures data integrity
and data confidentiality between the management server and its targets. This
protection is especially important if you access IBM Flex System Manager from
outside your network.

Note: Make sure that the host name you specify in the Common Name field of the
SSL certificate matches the host name that you specify in the URL that you use to
access the targets. For example, if you specify a long name for the host name in the
Common Name field of the certificate, you must specify a long name in the URL.
If these host names do not match, you might receive errors when you try to access
the targets. Complete the steps in the following procedure to make sure that you
specify the correct host name in the Common Name field of the certificate.

Note: The default keystore password is ibmpassw0rd. Do not change the default
password because signed certificates must use ibmpassw0rd as the password.

About this task

To replace the default certificate with a new certificate and to change the keystore
password for SSL, complete the following steps:

Procedure
1. If you are replacing the default certificate with a new CA signed certificate:

a. Request a CA signed certificate. For information, see “Requesting a CA
signed certificate.”
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Important: Do not continue with the remaining steps until you are ready to
receive the new CA signed certificate. Requests for new CA signed
certificates may take several days to process.

b. Using a remote-access facility, such as SecureShell (SSH), log in to the IBM
Flex System Manager management node to access the command-line
interface (CLI). Log in using a user account with administrator privileges,
such as USERID.

Note: As an alternative to using the remote-access facility, you can use the
web-based interface. Log in using a user account with administrator
privileges, open the Certificate Key Store, select and right-click on the FSM
SSL Certificate, and choose Replace. For more information about replacing
an SSL certificate, see Replacing an SSL certificate and Certificate
management.

c. Use the updcert command to replace the default certificate.
For example, assume that you are going replace the default certificate in the
keystore file with the SSL certificate "DSSecPubCert.arm" and import the CA
signing certificates "intcert1.arm" and "intcert2.arm", which were received
from a trusted authority such as VeriSign:
1) If the CA sends the new certificate to you as part of an e-mail message,

you must cut and paste the certificate from the e-mail message and save
it in a certificate file, for example "DSSecPubCert.arm".

Note: Note: The e-mail message from the CA might include
supplemental text in front of and after the certificate. You might see the
text "BEGIN CERTIFICATE" in front of the certificate and "END
CERTIFICATE" after the certificate. In this case, make sure that you cut
and paste the supplemental text along with the certificate text.

2) Save the file in the applicable directory in /home/<userid>/.
3) The certificate authority might send more than one certificate. In

addition to the certificate for your server, the CA might also send
additional signing certificates or intermediate CA certificates. For
example, VeriSign includes an intermediate CA certificate when sending
a global server ID certificate. Copy and paste the contents of any of
these certificates into separate files and save them in the applicable
directory.

Note:

v Check with the CA for the procedure for storing the intermediate
certificates. Examples are /home/<userid>/intcert1.arm and
/home/<userid>/intcert2.arm.

v Save the signing certificate files and the SSL certificate file with an
extension of .arm. The updcert command supports only file types of
.arm and .cer.

4) If the certificate authority sends a test root certificate, check with the CA
regarding what to do with the certificate.

5) Run the updcert command:
updcert -t

-i /home/<userid>/intcert1.arm,
/home/<userid>/intcert2.arm

-c /home/<userid>/DSSecPubCert.arm
-n passw0rd -d passw0rd2

For more information about the updcert command, type updcert --
help from a command line.
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d. Update the targets with the new certificate. For information, see “Updating
the targets with the new certificate.”

2. If you are replacing the default certificate with a new self-signed certificate:
a. Create a new self-signed certificate. For information, see “Creating a

self-signed certificate.”
b. Using a remote-access facility, such as SecureShell (SSH), log in to the IBM

Flex System Manager management node to access the command-line
interface (CLI). Log in using a user account with administrator privileges,
such as USERID.

c. Run the updcert command. For example, to replace the default certificate in
the keystore file with a self-signed certificate named "selfsignedcert".
updcert -s -k /home/<userid>/sample.jks

-l selfsignedcert -p ibmpassw0rd -n passw0rd -d passw0rd2

For more information about the updcert command, type updcert -- help
from a command line.

d. Update the targets with the new certificate. For information, see “Updating
the Web browser with the new certificate.”

Requesting a CA signed certificate
You can request a digital certificate from a certificate authority (CA). Because
certificate authorities are public entities that issue certificates to identify other
entities, CA signed certificates provide a level of public trust. Therefore, this type
of certificate is better suited for your production environment.

Before you begin

Note: If you have your own public key infrastructure (PKI), with your own
internal certification authority, you can use your PKI instead of completing the
following procedure.

Important: If you are creating a self-signed certificate, do not perform this
procedure.

About this task

You must create a certificate-signing request (CSR) to request a digital certificate
from a CA. To create a certificate-signing request from the management software
command-line interface, complete the following steps:

Procedure
1. Using a remote-access facility, such as SecureShell (SSH), log in to the IBM Flex

System Manager management node to access the command-line interface (CLI).
Log in using a user account with administrator privileges, such as USERID.

Note: As an alternative to using the remote-access facility, you can use the
web-based interface. Log in using a user account with administrator privileges,
open the Certificate Key Store, and click the Create and Download CSR
button.

2. Use the mkcert command to create a certificate request, as shown in the
following example. For more details about the command and its options, see
mkcert.
mkcert -r -l <cert_request_label> -d <distinguished_name> -s <size>
-f <request_filename> -p <keystore_password>
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The CSR file is created in the specified location and can be sent to any
authority that is trusted to obtain the CA-signed certificate.

3. Send the certificate-signing request file to the CA. See the CA Web site for
specific instructions about requesting a new certificate. You can request either a
test certificate or a production certificate from the CA. However, in a
production environment, you must request a production certificate.

What to do next

Next, you must receive the CA signed certificate. Go to “Receiving a CA signed
certificate.”

Receiving a CA signed certificate
After the certificate authority (CA) accepts the certificate-signing request, the CA
processes the request and verifies your identity. The CA sends the signed certificate
back to you by way of e-mail. You must receive and save the new certificate in the
default keystore file.

Before you begin

Before you complete this procedure, you must create and submit a
certificate-signing request. For information see “Requesting a CA signed
certificate.”

About this task

Important: If you are creating a self-signed certificate, do not perform this
procedure.

To receive a CA signed certificate from the management software command-line
interface, complete the following steps:

Procedure
1. If the CA sends the new certificate to you as part of an e-mail message, you

must cut and paste the certificate from the e-mail message and save it in a
certificate file, for example, DirServerSecPubCert.arm.

Note: The e-mail message from the CA might include supplemental text in
front of the certificate and after the certificate. For example, you might see the
text BEGIN CERTIFICATE in front of the certificate and END CERTIFICATE after the
certificate. In this case, make sure that you cut and paste the supplemental text
along with the certificate text.

2. Using a remote-access facility, such as SecureShell (SSH), log in to the IBM Flex
System Manager management node to access the command-line interface (CLI).
Log in using a user account with administrator privileges, such as USERID.

Note: As an alternative to using the remote-access facility, you can use the
web-based interface. Log in using a user account with administrator privileges,
open the Certificate Key Store, select and right-click on the FSM SSL
Certificate, and choose Replace. For more information about replacing an SSL
certificate, see Replacing an SSL certificate and Certificate management.

3. Use the smcli importcert command to import certificates into the keystore or
truststore, as shown in the following example. For more details about the
command and its options, see importcert.
smcli importcert [-v] -F <file_path> -t <target_store> [-V] -a <alias_name>
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What to do next

Next, you must update the Web container properties. Go to “Updating the Web
container properties.”

Creating a self-signed certificate
Self-signed certificates are certificates that you create yourself for private use. After
you create a self-signed certificate, you can use it immediately. Because anyone can
create self-signed certificates, they are not considered publicly trusted certificates.
Therefore, use self-signed certificates only on a temporary basis while you test
your environment. You can replace the default certificate with a self-signed
certificate.

About this task

Important: If you want to request a CA signed certificate, do not perform this
procedure. Instead, see “Requesting a CA signed certificate.”

To create a self-signed certificate from the management software command-line
interface, complete the following steps:

Procedure
1. Use the mkcert command to create a self-signed certificate, as shown in the

following example. For more details about the command and its options, see
mkcert.
mkcert -c -k <keystore_name> -n <cert_label> -p <ibmpassw0rd>
-d <distinguished_name> -e <cert_expiry> -s <size>

Tip:

v Specify the :
/opt/ibm/director/data/security/keystore/ibmjsse2.jks

v The distinguished name (-d option) must use the following format where
CN, O, and C are required:
"CN=common_name,O=organization,OU=organization_unit,L=location,ST=state,province,C=country"

You can use the DNS host name of the IBM Flex System Manager for the
"CN" attribute. If you do not know the DNS host name, use a tool, such as
nslookup, to determine the DNS host name from the IP address.

2. Use the upcert command to import the self-signed certificate from the mkcert
command keystore to into the default keystore.
For example, if you saved the keystore name to /home/USERID/sample.jks,
you can use the following command to add it to the default keystore:
updcert -s -k /home/USERID/sample.jks

-l selfsignedcert -p ibmpassw0rd -n passw0rd -d passw0rd2</p>

Note: The default keystore password is ibmpassw0rd. Do not change the default
password because signed certificates must use ibmpassw0rd as the password.

Updating the Web browser with the new certificate
You must update your Web browser with the new certificate.

About this task

To update the Web browser with the new self-signed certificate, complete the
following steps.
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Note: If the public version of the CA signed certificate is already stored in the
browser truststore file, go to step 11. Some browsers contain the public version of
well known CA signed certificates.

Procedure

Complete the following steps to update your Web browser with a self-signed
certificate.
1. In a Web browser, type the following URL to point to IBM Flex System

Manager: https://server_name:8422/ibm/console, where server_name is the
host name of IBM Flex System Manager.

Note: The procedure for accepting a new self-signed certificate might vary
slightly from the following steps, depending on the version of Internet
Explorer or Mozilla Firefox that you are using.

Option Description

For Microsoft Internet Explorer A Security Alert window is displayed, for
example, you might see the following
message: The security certificate was
issued by a company you have not chosen
to trust. View the certificate to
determine whether you want to trust the
certifying authority. Continue to step 2.

For Firefox An Untrusted Connection window is
displayed. Click Add Exception. An Add
Security Exception window is displayed.
Make sure that the Permanently store this
exception box is checked; then, click
Confirm Security Exception.

Note: The following steps describe the process for importing a certificate in
Internet Explorer. If you are using Firefox, the following steps do not apply.

2. In the Security Alert window, click View Certificate.
3. In the Certificate window, click Install Certificate.
4. In the Certificate Import Wizard, on the Welcome page, click Next.
5. On the Certificate Store page, select the way that you want to store the

certificate and click Next.

Note: If you are importing a certification authority certificate, make sure that
it is imported as a trusted root certification authority, and not just an
intermediate certification authority or server certification authority.

6. On the Summary page, click Finish. A Security Warning window is displayed.
7. In the Security Warning window, click Yes.
8. In the Certificate Import Wizard window, click OK.
9. In the Certificate window, click OK.

10. In the Security Alert window, click Yes.
11. When you use a launched task in the IBM Flex System Manager Web

interface, the following message is displayed: The application's digital
signature has been verified. Do you want to run the application? Be sure
to select Always trust content from this publisher and click Yes.
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Introduction to the IBM FSM Explorer console
The IBM FSM Explorer console provides an alternate view of your resources and
helps you manage your systems-management environment.

IBM FSM Explorer provides a resource-based view of your environment with
intuitive navigation of those resources. Some additional features are as follows:
v You can view basic information about your resources just by hovering over

them; you do not have to click to access information about them.
v You can use standard browser features to navigate between pages such as using

your browser’s back and forward buttons. You can also bookmark pages that
you use a lot so you can return to them easily.

v You can work on multiple pages at one time by having those pages open in
separate browser tabs.

v You can copy and paste the URL for a page and send it to a co-worker in e-mail
or instant message. Your co-worker can copy and paste the URL into their
browser and, after authenticating to the server, view the same page.

Following are some of the tasks that you can do in IBM FSM Explorer:
v Configuring local storage, network adapters, boot order, and Integrated

Management Module (IMM) and Unified Extensible Firmware Interface (UEFI)
settings for one or more compute nodes before you deploy operating-system or
virtual images to them.

v Installing operating system images on X-Architecture compute nodes.
v Navigating resources, viewing the properties of resources, and performing some

basic management tasks such as power on and off, collect inventory, and
working with LEDs.

v Using the Chassis Map to edit compute node details, view server properties, and
manage compute node actions.

v Working with resource views, such as All Systems, Chassis and Members, Hosts,
Virtual Servers, Network, Storage, and Favorites.

v Visual monitoring of status and events.
v Viewing event history and active status.
v Viewing inventory.
v Visual monitoring of job status.

For other tasks, you are launched from IBM FSM Explorer into IBM Flex System
Manager in a separate browser window or tab. You can return to the IBM FSM
Explorer tab when you’ve completed those tasks. As more tasks are available in
IBM FSM Explorer you will need to launch into IBM Flex System Manager less
often.

Finding groups, resources, and tasks in IBM FSM Explorer
The IBM FSM Explorer finder enables you to access groups, resources, and tasks
from a single location in the interface. If a task is not available in IBM FSM
Explorer, you are launched into IBM Flex System Manager to complete the task.

Use the finder at the top of the user interface (shown here) to locate a group,
resource, or task:
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As you type in the field, you see a dynamic list of the items that match what you
are typing. When you see the item you are looking for, select it from the list.

Using IBM Flex System Manager for mobile devices
IBM Flex System Manager for mobile devices is a simple, free tool that you can
download for a mobile device that has an Android, Apple iOS, or BlackBerry
operating system. IBM Flex System Manager for mobile devices enables you to
monitor and manage your IBM Flex System hardware remotely.

Note:

For troubleshooting information about the IBM Flex System Manager for mobile
devices application, see the IBM Flex System Manager Management Software
Troubleshooting Guide document.

The IBM Flex System Manager for mobile devices enables you to manage your
IBM Flex System and PureFlex® System hardware remotely with the following
hardware-management actions:
v Manage multiple chassis and multiple management nodes from a single

application
v Perform actions on compute nodes, such as Power On, Power Off, Restart, and

Shut Down and Power Off

v Perform actions on the Chassis Management Module (CMM), such as Virtual
Reseat and Restart Primary CMM

The app also enables you to view the following types of IBM Flex System
information:
v Managed resource health problems and status
v Event history for chassis, compute nodes, and network devices
v Front and rear graphical views of a chassis
v Hardware components installed in a chassis
v Managed resource Vital Product Data (VPD) and firmware levels
v Recent scheduled jobs

Downloading the IBM Flex System Manager for mobile devices
application

The IBM Flex System Manager for mobile devices application is available as a free
download for Android OS, Apple iOS, and BlackBerry OS.

Important: Before you can use the mobile app to connect to an IBM Flex System
Manager management node, you must complete the actions that are described in
“Setting up IBM Flex System Manager for mobile devices” on page 126.

You can download the IBM Flex System Manager for mobile devices application
from one of the following app stores:
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Note: Mobile support using Android is no longer supported.
v For Apple iOS, see https://itunes.apple.com/us/app/ibm-flex-system-manager-

for/id576901013?mt=8
v For BlackBerry OS, see the BlackBerry App World page at http://

appworld.blackberry.com/webstore/content/20199697/?lang=en

Note: The IBM Flex System Manager for mobile devices application does not
support BlackBerry OS version 7.0 or earlier.

Setting up IBM Flex System Manager for mobile devices
IBM Flex System Manager for mobile devices can use SSL certificates to create a
secure connection to the IBM Flex System Manager management software.

Important: If you have not configured SSL certificates on the IBM Flex System
Manager, the app will prompt you with the option to connect in an unsecure
manner.

Use the information in this section to set up the certificate and keystore for the
mobile application and install the application on your device. For more
information about configuring SSL on your management node, see Planning Secure
Sockets Layer configuration on IBM Flex System Manager.

To ensure that the connection is secure, the certificate installed on the management
node must be a valid certificate for the URI that will be used to access the
management node, and the certificate must be signed by a separate Certificate
Authority (CA). Self-signed certificates are not accepted by the IBM Flex System
Manager for mobile devices application.

There is an issue with importing certificates that were signed by an intermediate
CA instead of a root CA into the default keystore on the management node. You
must create a new keystore on a separate system (with Java installed) from the
management node and replace the existing keystore with the new one. To replace
the existing keystore, the IBM Flex System Manager management software must be
at level 1.2.0 or later.

The following topics describe the actions necessary to ensure that the management
node has the correct certificate for your mobile application installed:
1. “Creating a Java keystore and Certificate Signing Request to submit to a CA”

on page 127
2. “Installing a keystore on the management node” on page 128
3. “Installing certificates on mobile device operating systems” on page 129

For more information, see the IBM Flex System Manager for mobile devices
download page at https://www.ibm.com/support/knowledgecenter/HW94A/
com.ibm.acc.8731.doc/downloading_the_mobile_app.html. For troubleshooting
information about the IBM Flex System Manager for mobile devices application,
see the IBM Flex System Manager Management Software Troubleshooting Guide
document.
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Creating a Java keystore and Certificate Signing Request to
submit to a CA
Before you can connect the IBM Flex System Manager for mobile devices
application to your IBM Flex System Manager management node, you must create
a Java keystore on a computer that is not a part of your IBM Flex System
environment.

Java comes with a utility named keytool in its bin directory that you can use to
create and edit keystore files. To create a new keystore, complete the following
steps:
1. Create a keystore by using the following command (replace the italicized

options in the following examples with the options for your keystore):
keytool –genkey –alias <keystore_alias> -keyalg <encryption_algorithm>
–keystore <path_to_the_keystore_being_created> –keysize <size_of_encryption_key>

For example:
keytool –genkey –alias Flex_Manager -keyalg RSA –keystore flexStore.jks –keysize 2048

Note: Use a strong keysize; some mobile operating systems have restrictions on
the keysize that they will accept.

2. When you are prompted, type a password for the keystore that you are
creating.

Note: This password is required when you replace the keystore on the
management node and for each subsequent keytool command that you run
against the created keystore.

3. When you are prompted, type your organization and location information.
4. When you are prompted, type a password for the keystore alias.

Note: The keystore alias password can be the same as the previous password
that you created.

5. After the keystore has been created, use the following command to issue a
Certificate Signing Request (CSR) for the keystore (replace the italicized options
in the following examples with the options for your keystore):
keytool -certreq -alias <keystore_alias> -keystore <path_to_the_keystore>
-file <path_to_the_csr_file_being_created>

For example:
keytool -certreq -alias Flex_Manager -keystore flexStore.jks -file mydomain.csr

6. The Certificate Signing Request that you generated can be submitted to a CA to
create a certificate signed by the CA. Send the certificate-signing request file to
the CA; see the CA website for specific instructions about requesting a new
certificate. You can request either a test certificate or a production certificate
from the CA. However, in a production environment, you must request a
production certificate.

Important: Before completing the following steps, the signed certificates must
be returned from the CA.

7. Install the CA root and any intermediate certificates into the keystore; then,
install the generated server certificate into the keystore. These certificates can be
acquired from the CA used to generate the server certificate.
a. To install root and intermediate certificates (start with the root certificate

first), run the following command (replace the italicized options in the
following examples with the options for your keystore):
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keytool -import -trustcacerts -alias <root_certificate_alias> -file
<path_to_the_root_certificate> -keystore <path_to_the_keystore>

For example:
keytool -import -trustcacerts -alias root -file root.crt -keystore flexStore.jks

where root.crt is the CA root or intermediate certificate and flexStore.jks is the
name of the previously generated keystore.

b. When you are prompted, select to trust the certificate being installed.
c. Repeat steps a and b for each certificate in the certificate chain.
d. Import the server certificate that was returned from the CA by running the

following command (replace the italicized options in the following
examples with the options for your keystore):
keytool -import -trustcacerts -alias <server_certificate_alias> -file
<path_to_server_certificate> -keystore <path_to_the_keystore>

For example:
keytool -import -trustcacerts -alias Flex_Manager_Server
-file mydomain.crt -keystore flexStore.jks

where the alias used is the alias for the server certificate, and the file
provided is the server certificate file.

To install the new keystore on the IBM Flex System Manager management node,
complete the procedure that is described in “Installing a keystore on the
management node.”

Installing a keystore on the management node
After you have created a keystore and added CA-signed certficates to the keystore,
you can install the keystore on the IBM Flex System Manager management node.

You must have a keystore with the signed certificates for your mobile device before
you complete this procedure. If you have not created a Java keystore and installed
CA-signed certificates in the keystore, see “Creating a Java keystore and Certificate
Signing Request to submit to a CA” on page 127.

To install the keystore on the management node, complete the following steps:
1. Copy the keystore to the management node. For information about the options

for copying files to the management node, see “Moving files to and from the
management node” on page 106.

2. Log in to an IBM Flex System Manager SSH session.
3. Run the smstop command to stop the processes that are running on the

management node.
4. Run the following updcert command (replace the italicized options in the

following examples with the options for your keystore):
updcert -I -n <password of the keystore> -f <path to the keystore file>

where the -f option specifies the location of the keystore file that you copied to
the management node. For example:
updcert –I –n password –f /home/USERID/flexStore.jks

5. The IBM Flex System Manager management node restarts automatically.

Note: You can check the progress of the restart with the smstatus command.
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Installing certificates on mobile device operating systems
The following topics describe procedures for installing custom certificates on
mobile devices. Use the information that is applicable to your mobile device
operating system.

Installing certificates on Android OS:

Use this information to install the custom certificates for the IBM Flex System
Manager for mobile devices application on a mobile device that is running the
Android operating system.

Android OS version 4.0 and later

Starting with version 4.0, Android provides native support for installing CA
certificates. For more information about installing the certificates, go to the
Android OS help website at http://support.google.com/android and search for the
phrase work with certificates.

On Android 4.0 and later, you can check the installed certificates for the device in
Settings > Security.

After you verify that the certificates were installed on your mobile device, the
mobile application should be able to connect to an IBM Flex System Manager
management node that has a server certificate signed by the CA certificate
installed.

Note: If the Android device does not connect to the management node after you
installed a CA certificate, restart the mobile device.

Android OS version 2.3

Installation of custom CA certificates on Android version 2.3 is supported only on
Motorola devices. Motorola allows you to install custom CA certificates through its
custom certificate manager. For more information, go to the Motorola help website
at https://motorola-enterprise.custhelp.com/app/answers/detail/a_id/57093/~/
android---root-certificate-management.

To use the mobile application with Android 2.3 devices by manufacturers other
than Motorola, the certificate installed on the IBM Flex System Manager
management node must be recognized by one of the preinstalled certificate
authorities on the Android device. If you installed a certificate that is trusted by
one of these preinstalled certificates, the mobile device should connect to an IBM
Flex System Manager management node.

Installing certificates on Apple iOS:

Use this information to install the custom certificates for the IBM Flex System
Manager for mobile devices application on a mobile device that is running the
Apple iOS operating system.

For an Apple iOS device, complete the following steps:
1. Acquire the CA root certificate on the iOS device through email, a website link,

or another method.
2. Click the link or file name of the CA root certificate. The Install Profile screen

opens.
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3. On the Install Profile screen, press Install > Install Now.
4. To verify that the certificate was installed, open the Settings menu and go to

General > Profiles. If the imported CA certificate is listed, the mobile
application should be able to connect to an IBM Flex System Manager
management node that has a server certificate signed by the CA certificate
installed.

Installing certificates on BlackBerry iOS:

Use this information to install the custom certificates for the IBM Flex System
Manager for mobile devices application on a mobile device that is running the
BlackBerry operating system.

There are two ways to get a CA certificate onto a Blackberry device. They can be
installed using Blackberry Desktop Software or by importing it directly to the
device.

Installing a certificate with the BlackBerry Desktop Software

To import the certificate using the Blackberry Desktop Software, complete the
following steps:
1. Download the certificate onto a device management system.
2. Import the certificate onto the management system through the web browser.
3. Connect to the device using Blackberry Desktop Software.
4. Select Tools > Desktop Options.
5. When you are prompted, select the General tab.
6. Select the Use certificate synchronization box; then, click OK.
7. In the left pane, select Certificates.
8. Select the store where the CA certificate was imported.
9. Select the certificate; then, select Sync Certificates.

To verify the certificate was installed, go to Home > Options > Security >
Advanced Security > Certificates. After you verify that the certificates were
installed on your mobile device, the mobile application should be able to connect
to an IBM Flex System Manager management node that has a server certificate
signed by the CA certificate installed.

Installing a certificate directly on a BlackBerry device

To install the certificate directly, complete the following steps:
1. Download the CA certificate to the device.
2. Open the file.
3. When you are prompted, click Import.
4. Create a password for the keystore; then, click OK. After you set the password,

the BlackBerry device shows the certificate details and a green checkmark,
which indicates that it was installed.

To verify the certificate was installed, go to Home > Options > Security >
Advanced Security > Certificates. After you verify that the certificates were
installed on your mobile device, the mobile application should be able to connect
to an IBM Flex System Manager management node that has a server certificate
signed by the CA certificate installed.
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Chapter 3. Configuring the IBM Flex System Manager
management software

After you install the Flex System Manager Types 7955, 8731, and 8734 hardware in
an Flex System Enterprise Chassis, you need to configure the hardware and the
IBM Flex System Manager management software.

Before you begin

The following topics describe important IBM Flex System Manager management
software and Flex System Manager Types 7955, 8731, and 8734 configuration tasks.

Before you configure management software, make sure that you have completed
the following tasks:
v Install the Flex System Enterprise Chassis and other components in the rack. For

more information about installing the chassis and components, see
http://publib.boulder.ibm.com/infocenter/flexsys/information/topic/
com.ibm.acc.8721.doc/installing_the_system.html.

v Install your Flex System Manager Types 7955, 8731, and 8734 hardware into the
chassis. For more information about installing the Flex System Manager Types
7955, 8731, and 8734 hardware, see http://publib.boulder.ibm.com/infocenter/
flexsys/information/topic/com.ibm.acc.8721.doc/
initially_installing_the_flexible_resource-manager.html.

v Configure the CMM; for example, set IP addresses and user authentication.

Important: If the CMM is not configured correctly before the Flex System
Manager Types 7955, 8731, and 8734 is installed, you will not be able to set up
management software.

v Configure the Flex System Manager Types 7955, 8731, and 8734 according to the
procedures in http://publib.boulder.ibm.com/infocenter/flexsys/information/
topic/com.ibm.acc.8721.doc/initially_installing_the_flexible_resource-
manager.html. The Management Server Setup wizard opens.

What to do next

During initial setup of the IBM Flex System environment, you must update the
management software, management node firmware, and firmware for resources in
your chassis: Chassis Management Modules, compute nodes, and network devices.
“Initial setup” on page 132 describes wizards that can help you update firmware
for managed components through the management software web interface. After
initial setup, you can use Update Manager (on the Plug-ins tab on the Home page)
or the command-line interface for advanced update capabilities. For more
information about these advanced update capabilities, see the documentation in
the Updating systems chapter.

See http://publib.boulder.ibm.com/infocenter/flexsys/information/topic/
com.ibm.acc.common.nav.doc/learning_initial_setup.html for educational
information about initial setup of your IBM Flex System Manager management
software and hardware.
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Important: If configured and activated in the management software, IBM
Electronic Service Agent (ESA) automatically reports hardware problems to IBM
Support and collects system service information for monitored systems. For more
information about setting up ESA, see “Setting up Electronic Service Agent (ESA)”
on page 140 in “Additional setup” on page 140.

Initial setup
The IBM Flex System Manager management software web interface guides you
through the initial setup of the systems-management software.

Initial setup of the IBM Flex System environment requires that you update the
management software, management node firmware, and firmware for resources in
your chassis: Chassis Management Modules, compute nodes, and network devices.
The information in this section describes wizards that can help you update
firmware for managed components through the management software web
interface. These wizards are found on the Initial Setup tab on the IBM Flex System
Manager Home page.

After initial setup, you can use Update Manager (on the Plug-ins tab on the Home
page) or the command-line interface for advanced update capabilities. For more
information about these advanced update capabilities, see the documentation in
the Updating systems chapter.

Important:

1. Initial management software setup might take 1 hour or more to complete,
depending on the firmware and software levels of your management software.

2. The management software update process that is described in “Checking and
updating the management software” on page 135 might take 45 minutes or
more to complete. You can perform other setup tasks while the management
software is being updated, such as installing operating systems on compute
nodes or installing additional chassis.

Setting up the IBM Flex System Manager management node
The Management Server Setup wizard enables you to configure the IBM Flex
System Manager management software for your network.

Before you begin

Before you use the Management Server Setup wizard to configure network
settings, consider whether you want to assign static IP addresses to
system-management elements or use a DHCP server to assign IP addresses to these
elements dynamically. System-management elements include Chassis Management
Modules (CMMs), Integrated Management Modules (IMMs), System-management
processors, and network switches. To assign IP addresses to system-management
elements dynamically, you must attach an external DHCP server to the
management network (Eth0).

About this task

During the initial setup of the management software, the Management Server
Setup wizard opens automatically.

Within the Management Server Setup wizard, configure the following information:
v Date and time. Specify the location of the NTP server.
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Note: You must set your keyid and password on an external NTP server to
match the keyid and password that you set in the management software. For
more information about setting the keyid and password on your NTP server, see
the documentation that came with your NTP server.

If you use the management node as the NTP server, the external NTP server
authentication key index and key must be set to match key index and key that
are set in the management software.

v Local area network (LAN) settings. Specify the IP address, DNS, and other
network settings for both adapters:
– Management network (Eth0)
– Data network (Eth1)

v User credentials, including ID, password, and permissions.

Procedure

Complete the following steps to access the initial setup wizard.

Note: If you encounter problems during the Setup Wizard, see the Flex System
Manager Types 7955, 8731, and 8734 Installation and Service Guide document for
troubleshooting information.
1. Connect an Ethernet cable from a notebook computer to a Chassis

Management Module (CMM) in the chassis.
2. From a client computer, point a browser to

https://default_IP_address_or_host_name

where default_IP_address_or_host_name is either the IPv4 address or the default
host name, FSM-<MAC address>, on the network access tag that is attached to
the IBM Flex System Manager management node. The static IPv4 address
depends on the bay where you installed the management node. If you use the
static IP address to connect to the network, make sure that the IP address and
subnet of the client computer is set to the same value as the management
node (the default subnet is 255.255.255.0). The IP address of the management
node must also be in the same local domain as the client computer. To connect
to the management node for the first time, you might need to change the IP
properties on the client computer.
The host name can be used if the configuration is assigned through a DHCP
server; otherwise, use the IPv4 static IP address on the network access tag.

Note: The IPv6 LLA on the tag can be used only for an SSH session. You
cannot use it to connect through a web browser.
A page with the Software License Agreement (SLA) is displayed.

Note: If the network is configured incorrectly, you must use the Flex System
Manager Types 7955, 8731, and 8734 console breakout cable to correct the
mistake. See http://ralfss21.raleigh.ibm.com:7030/help/topic/
com.ibm.acc.8721.doc/connecting_to_fsm_locally_using_kvm_dongle.html for
more information.

3. Accept the SLA to continue setting up IBM Flex System Manager management
software. If you click Accept, the Management Server Setup wizard opens.

4. Configure the settings on the Date and Time page.
5. Configure the settings on the System-level User ID and Password page.
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Note: The password that you set for the system-level user ID (the default is
USERID) is set automatically for the pe user account.
For more information about the system requirements for passwords, see
“Setting a new password” on page 29.

6. Configure the settings on the Network Topology page. Diagrams of both
network topologies are shown on this page.

Important:

a. The management node console can be connected to the management
network or the data network. To configure the management software to
access a single network that is using a single IP subnet, configure only the
Eth0 interface. To configure Eth0 and Eth1, you must configure them on
different IP subnets.

b. Do not use a DHCP server to assign IP addresses for Eth0 and Eth1;
otherwise, the separate management and data networks might be assigned
to the same subnet.

c. The host name must be configured on the network to which you will
connect the management node. Configure the host name on the Eth0
interface if you will be connect to the management node on the
management network, or configure the host name on the Eth1 interface if
you will connect to the management node on the data network.

7. On the Local Area Network (LAN) Adapters page, choose the LAN adapter
that you want to configure. To see a network validation and recovery
summary when this setup is completed, select the check box below the table.
After you select either the management or data network for configuration, the
IP Address page opens.

8. Configure the IP addresses for the LAN adapter that you selected in the
previous step.

Important:

a. Make sure that the IP address that is assigned to Eth0 is on the same IPv4
subnet or IPv6 network as the IP address that is assigned to the CMM.

b. The Setup wizard enables you to use a DHCP server that will assign IPv4,
IPv6, or both types of IP addresses to system-management elements (for
example, the CMM, IMM, System-management processors, and network
switches). For the Setup wizard to obtain IP addresses automatically, a
DHCP server must be attached to the management network. If you want
to assign static IP addresses, a DHCP server is not required.

c. IP addresses in the range 192.168.70.200 through 192.168.70.299 are
reserved for use by the management software. If you assign an IP address
in this range to the Eth0 management network, you are forced to change it
to an available IP address.

9. Configure the settings on the Network Settings page.

Note: The management software supports only one default gateway.
10. Configure the settings on the Domain Name System (DNS) page.

Important: DNS server configuration is required on the data network (Eth1)
for the following management software functions:
v Using VMControl to manage virtual machines and operating systems that

are running on compute nodes
v Updating the device drivers in the operating systems that are running on

IBM Power Systems compute nodes
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Results

Approximately 5 minutes after the wizard completes the setup, you are prompted
to accept the security certificate for the server. If you want to monitor the status of
the process, you must accept this certification.

Depending on the browser that you use, you might have to accept the security
certificate every time you log in to the IBM Flex System Manager management
software. With Mozilla Firefox, the warning is displayed only during initial setup;
if you add the exception during initial setup, the exception is added automatically
in the future. However, Microsoft Internet Explorer might require you to accept the
security certificate every time you log in.

Important: After the setup is complete, the management node restarts. Continue
the next setup process, which is described in “Selecting chassis for management”
on page 136. If you are configuring this management software as a backup node
for manual failover, no further configuration is needed.

Checking and updating the management software
Before you configure the software and other IBM Flex System resources during
initial setup, make sure that the IBM Flex System Manager management software
and management node firmware are current.

About this task

To check for updates and update the management software if necessary complete
the following steps.

Important: The management software update process might take 45 minutes or
more to complete. You can perform other setup tasks while the management
software is updating, such as installing operating systems on compute nodes or
installing additional chassis.

Procedure
1. From the Initial setup tab on the Home page, click Check and Update Flex

System Manager. The management software checks for updates.

Note: If you click Stop and do not have an internet connection, the
management software gives you the option to install the updates manually. For
more information about installing updates manually, see http://
publib.boulder.ibm.com/infocenter/flexsys/information/topic/
com.ibm.director.updates.helps.doc/
fqm0_t_um_updates_director_manual_download.html.

2. If software or firmware updates are available, the Update Manager window
opens. Make sure that the Run Now radio button is selected and click OK. A
message confirms that the update has been scheduled, the updates are
installed, and the management node restarts.

What to do next

Important:

1. Be sure to update the management software before you select chassis for
management and configure and update one or more Chassis Management
Modules (CMMs).
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2. Do not restart the Flex System Manager Types 7955, 8731, and 8734
management node until after all of the management software and CMM update
operations are complete.

Selecting chassis for management
The Management Domain page enables you to select which Flex System Enterprise
Chassis to manage.

About this task

You can use the IBM Flex System Manager management software to select one or
more discovered chassis for management. On the Home page, click Select Chassis
to be Managed; the Management Domain page opens. The Management Domain
page lists the names and Chassis Management Module (CMM) IP addresses of
discovered chassis.

The Management Domain page also has one management option check box:

Authenticate using the Flex System Manager user registry
Select this box before you click Manage if you want to configure the
chassis for centralized user management mode. If you select this option
and click Manage, a Request access window opens and you are required to
enter administrator account credentials.

Note: The default credentials are the administrator user ID and password
that you established in the setup wizard. Make sure that you log in with
the administrator account credentials that will be used to access the CMM
after centralized management is complete; this account will be logged in
the audit trail.
For more information about how the CMM is configured in centralized
user management mode (including the RECOVERY_ID account), and for
details about changing centralized management settings, see “Using
centralized user management” on page 505. For an overview of centralized
user management mode, see “Centralized user management” on page 20.

An IPv6 Unique Local Address (ULA) is set on each chassis component when the
chassis is centrally managed. The IPv6 ULA is required for the management node
to have routable IP addresses on the management network to communicate with
each chassis component. The IPv6 ULA is set with the same 64-bit prefix as the
chassis CMMs.

After you select the chassis that you want to manage and select the configuration
options for the chassis, click Manage.

Important:

1. The Management Domain page displays only the Flex System Enterprise
Chassis that are on the same local subnet as the management node. To manage
a chassis on another subnet, you must first discover the chassis manually. After
the chassis is discovered, it appears in the chassis list on the Management
Domain page.

2. When you manage a chassis that has an IBM Flex System V7000 Storage Node
installed, the management software overwrites the preexisting SSH key for the
user ID superuser. After the management process is complete, you can reapply
the previous SSH key.
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For more information about how to change the user management mode of a
managed chassis from decentralized to centralized, see “Changing the user
management mode of a managed chassis” on page 506.

To discover a chassis manually, complete the following steps:
1. On the Management Domain page, select the Discover New Chassis button.
2. Select the Add or remove remote chassis option.
3. Add the IP address of the remote chassis and select the Add option.
4. When all the remote chassis IP addresses are added, select the Save and

Discover button.

Attention: If the chassis is not added to the Management Domain page after
discovery, verify that the chassis is reachable on the management network from the
management node.

Note: If one or more chassis are not shown in the table, make sure that a Chassis
Management Module (CMM) in the chassis is cabled to the top-of-rack switch in
your hardware configuration. See http://publib.boulder.ibm.com/infocenter/
flexsys/information/topic/com.ibm.acc.8721.doc/cabling_the_system.html for more
information.
For more information about managing a remote chassis on a different subnet than
the management node, see “Managing a remote chassis” on page 508.

For information about changing the user management configuration from
decentralized to centralized, or centralized to decentralized, see “Changing the
user management mode of a managed chassis” on page 506.

Results

Configuring chassis components
Use the IBM Flex System Manager management software web interface to
configure the components, or resources, in a managed Flex System Enterprise
Chassis.

During initial setup of the management software, you can configure the resources
in a managed chassis. When you click Configure Chassis Components on the
Initial Setup page, the Configure Chassis Components page opens and displays the
following options:

Request Access for Compute Nodes
This page shows a list of compute nodes to which the management
software does not have full access. For more information about access
states of compute nodes and other managed resources, see “Access states
of managed resources” on page 80.

Note: For more information about changing the compute node name that
is displayed in the management software web interface, see “Naming
managed resources in a chassis” on page 514.

Access I/O Modules
The I/O Modules Access page enables you to configure network device
SNMP and security access, and provide user credentials.

Collect Inventory
A Launch Job window opens that enables you to collect inventory for the
managed resources in the chassis.
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Configure Chassis Components using Configuration Patterns
Configuration Patterns enables you to provision or pre-provision managed
resources by configuring local storage, network adapters, boot order, and
Integrated Management Module (IMM) and Unified Extensible Firmware
Interface (UEFI) settings. For more information about Configuration
Patterns, see “Modifying firmware and hardware configuration settings”
on page 532.

Note: A valid IPv6 address must be assigned to a managed resource before
you can use Configuration Patterns to configure settings for the resource.

Configure I/O Modules Advanced Settings
The Configuration Templates page displays a list of pre-defined templates,
and enables you to create new templates for network devices.

Configure Additional Components
Advanced settings for system storage and IBM Power Systems compute
nodes must be configured outside of the management software. For more
information about storage resources, see Managing and configuring
storage. For more information about configuring IBM Power Systems
compute nodes, see Chapter 16, “Managing Power Systems compute
nodes,” on page 587.

Deploying operating systems
How you deploy an operating system to a compute node depends on the compute
node architecture and how you access the compute node. Use this information to
deploying operating systems to IBM Power Systems compute nodes and
X-Architecture compute nodes.

Power Systems compute nodes

If you are not using an unattended network-installation method to install your
operating system, you must first provide a serial over LAN (SOL) connection to
the compute node to install your operating system. After you have opened a SOL
connection, follow the installation instructions that came with your Power Systems
compute node.

X-Architecture compute nodes

There are several ways to install an operating system on an X-Architecture
compute node:

Use the Remote Control function of the management software

v If you want to install an operating system on an X-Architecture compute
node while you are accessing the management software from a remote
client, such as a laptop, see “Remotely installing an operating system on
an X-Architecture compute node” on page 553.

v If you want to install an operating system on an X-Architecture compute
node while you are accessing the management software locally, see
“Installing an operating system on an X-Architecture compute node” on
page 554.

Note: With this method, the management software does not need to be
connected to the data network.

Use the Deploy Compute Node Images page to deploy VMware ESXi and RHEL
KVM You can use management software to deploy VMware ESXi and RHEL
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Kernel-based Virtual Machine (KVM) hypervisors to multiple compute
nodes quickly and easily. See for more information.

Important: Updating firmware with VMware vSphere 5 (ESXi) using the
management software requires the IBM customized image. It is critical that
you apply the latest patches to the vSphere system. You must reboot the
vSphere system, and then wait 20 minutes after the system reboots before
you apply the firmware updates. Download the VMware vSphere ESXi 5.0
with IBM Customization Patch from the IBM website at
http://www-947.ibm.com/support/entry/portal/
docdisplay?lndocid=MIGR-5091988&brandind=5000008.

Note: You can use Configuration Patterns to assign firmware and boot
order settings for the X-Architecture compute nodes before you deploy
operating systems or virtual images to them. See for more information
about Configuration Patterns.

Updating chassis components
Before you begin using a managed chassis and its components, make sure that
your IBM Flex System hardware has the most current firmware and software.

Use the IBM Flex System Manager management software web interface to update
managed-component firmware and software. When you click Update Chassis
Components on the Initial Setup page, the Update Chassis Components page
opens and displays links to the following component update pages:
v CMMs - Check and Update Firmware
v Compute Nodes - Check and Update Firmware
v Storage Nodes - Check and Update Firmware
v I/O Modules - Check and Update Firmware

Important: For a detailed summary of update procedures for all IBM Flex System
components, see the IBM Flex System Firmware Update Guides at
http://www.ibm.com/support/entry/portal/docdisplay?lndocid=MIGR-5091991.

The Update Manager function in the management software has advanced update
capabilities that are not possible with the update wizards on the Initial Setup tab
(on the Home page of the management software web interface). You can also use
Update Manager to update additional components (such as operating systems) that
the Initial Setup wizards cannot update.

Launching IBM FSM Explorer
The IBM FSM Explorer console provides an alternate view of your resources and
helps you manage your systems-management environment.

IBM FSM Explorer provides a resource-based view of your environment with
intuitive navigation of those resources. Some additional features are as follows:
v You can view basic information about your resources just by hovering over

them; you do not have to click to access information about them.
v You can use standard browser features to navigate between pages such as using

your browser’s back and forward buttons. You can also bookmark pages that
you use a lot so you can return to them easily.

v You can work on multiple pages at one time by having those pages open in
separate browser tabs.
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v You can copy and paste the URL for a page and send it to a co-worker in e-mail
or instant message. Your co-worker can copy and paste the URL into their
browser and, after authenticating to the server, view the same page.

Following are some of the tasks that you can do in IBM FSM Explorer:
v Configuring local storage, network adapters, boot order, and Integrated

Management Module (IMM) and Unified Extensible Firmware Interface (UEFI)
settings for one or more compute nodes before you deploy operating-system or
virtual images to them.

v Installing operating system images on X-Architecture compute nodes.
v Navigating resources, viewing the properties of resources, and performing some

basic management tasks such as power on and off, collect inventory, and
working with LEDs.

v Using the Chassis Map to edit compute node details, view server properties, and
manage compute node actions.

v Working with resource views, such as All Systems, Chassis and Members, Hosts,
Virtual Servers, Network, Storage, and Favorites.

v Visual monitoring of status and events.
v Viewing event history and active status.
v Viewing inventory.
v Visual monitoring of job status.

For other tasks, you are launched from IBM FSM Explorer into IBM Flex System
Manager in a separate browser window or tab. You can return to the IBM FSM
Explorer tab when you’ve completed those tasks. As more tasks are available in
IBM FSM Explorer you will need to launch into IBM Flex System Manager less
often.

Additional setup
The Additional Setup tab on the Home page lists more configuration and setup
tasks for IBM Flex System Manager management software.

Note: Only some of the additional setup procedures in the management software
web interface are described in this documentation.

Setting up Electronic Service Agent (ESA)
Enable and configure Electronic Service Agent (ESA) on the Additional Setup page.

About this task

IBM Service and Support Manager monitors, tracks, and captures system hardware
errors and service information and reports serviceable problems directly to IBM
Support by using the IBM Electronic Service Agent (ESA) tool. ESA is the Flex
System Enterprise Chassis feature that automatically reports hardware problems
and collects system service information for monitored systems. If ESA is activated
on the management software, the software can monitor managed chassis,
X-Architecture compute nodes, Power Systems compute nodes, and Flex System
V7000 storage nodes. If a problem occurs and the application is enabled, ESA can
report the problem to IBM Support. If your configuration has virtual servers, ESA
reports serviceable events and associated data for service and support, either
automatically or manually, under your authorization.
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You must enable and configure ESA by using the Setting up Electronic Service
Agent (ESA) wizard on the Additional Setup page. The management software
disables ESA from the Chassis Management Modules (CMMs) that are configured
for ESA, so that duplicate messages are not generated. When an ESA event is
received, the management software collects Dynamic System Analysis (DSA)
information from the managed node, and the applicable service data is sent to IBM
Support. If the DSA information cannot be obtained, service data from the service
processor will be collected. A service request number (or ticket number) is
provided to you for future reference, and IBM Support calls you to work through
the problem for the failing component or node. For secure sites that do not have
internet access, the data for the ESA can be collected manually.

The switches in the Flex System Enterprise Chassis also provide ESA service data.
The management software automatically configures the switches to send SNMP
traps to the management software. A common IBM management information base
(MIB) supports configuration and retrieval of service data. When ESA is enabled,
ESA and the management software allow inventory to be sent to IBM periodically.

After you set up ESA, consider taking the following actions to ensure that you
provide the best possible problem information to IBM Support:
1. Be sure to add the External Service Request and External Service Request

Status columns to the Active Status (Problems) view in the management
software web interface. To add these columns, click Actions > Columns on the
Active Status page; then, select the column names and click Add.

2. In the Electronic Service Agent settings, select the Software quality data check
box. This ensures that your system will send the best available information
about the management software to help with problem resolution.

You can change ESA settings through Service and Support Manager. To access the
settings, click Service and Support Manager on the Plug-ins page. Then, click
Manage settings.

For more information about Service and Support Manager and ESA, see Service
and Support Manager.

For educational information about Service and Support Manager, see
http://publib.boulder.ibm.com/infocenter/flexsys/information/topic/
com.ibm.acc.common.nav.doc/learning_service_and_support.html.

Configuring the management software user registry
An internal user registry is automatically configured during the initial setup
process. If you want to use an external user registry, use the User Registry
Configuration wizard in the IBM Flex System Manager management software web
interface to choose the type of user registry, and other registry settings, for your
IBM Flex System hardware configuration.

The IBM Flex System Manager management software uses Lightweight Directory
Access Protocol (LDAP) to authenticate user credentials. By default, the
management software is configured to use the local LDAP registry, but you can use
any LDAP server available in your network.

The management software supports both local and external user registries. A local
user registry is in the Flex System Manager Types 7955, 8731, and 8734
management node. An external user registry is a registry outside your IBM Flex
System hardware.
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Note: When you add users, make sure that you add the new users to either the
local or external registry, but not both registries. Users with the same names in the
local and external registries can lead to unintended results. For example, a user
might update a login password in one registry and not the other.

Tip: Set the Security Policy (Home > Administration > Security Tasks >
Configure Security Policy) to Legacy and configure the external LDAP user
registry to validate the configuration. After the user registry configuration works
successfully using the Legacy Security policy, configure using the Secure Policy.
This technique can isolate SSL configuration problems for faster troubleshooting.

Important: If you are using an external user registry, you must make sure that
user groups defined for the external user registry are added to the list of
authorized group on the IBM Flex System Manager management software the
management software, such as smadmin, smmgr, smmon, or smuser. To add a
group:
1. From the home page, click the Additional Setup tab.
2. Click Manage Users and Groups.
3. Select the Groups tab and click Create Group to start the Create User Groups

wizard.
4. Follow the steps in the wizard to create the group.

The User Registry Configuration wizard guides you through the following process
of selecting and configuring the external registry that the management software
will use:

User registry type
On this panel, you can accept the default settings, or you can provide the
name or address of an external LDAP server accessible through your
network. If the Security Policy is set to Secure, the usual port is 636. If the
Security Policy is set to Legacy, the usual port is 389.

Note:
v If you select Use an external User Registry, you must enter a valid

hostname for the external registry and verify the port number.
v If you have chosen to use the NIST-800-131a-Strict cryptography settings,

the management software will be unable to connect to an external LDAP
server using a secure port (for example, using LDAPS over default port
636). You can instead use the LDAP feature StartTLS, which allows you
to start secure communications using TLS v1.2 over an existing
non-secure connection, such as the default port, 389.

Distinguished name
Use this panel to specify the LDAP Distinguished Name information that
will be used to search the external user registry. The following fields are
displayed:
v Default base Distinguished Name (DN)

This is the base Distinguished Name (DN) to use to search the registry.
The base Distinguished Name indicates the highest level of the LDAP
hierarchy to search.

v Bind Distinguished Name (DN)

This is the fully qualified Distinguished Name that the management
software will use to bind to the defined server. If the Bind Distinguished
Name is not specified, the management software will attempt to bind to
the server anonymously.
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v Bind Distinguished Name (DN) password

This is the password for use with the Bind Distinguished Name to
access the LDAP server.

Filters The management software will use the external LDAP server to
authenticate user credentials. Use this panel to specify the filters to be used
to locate user data in the LDAP server. The following fields are displayed:

Note: Some LDAP servers limit the amount of data that they return in
response to a search request. Therefore, be as specific as possible without
excluding any users or groups for which you intend to give login rights.

In general, you can use broad search filters for smaller LDAP
environments, such as environments with hundreds of LDAP users and
fewer than 1500 user groups. You must use more narrow search filters for
larger LDAP environments, such as environments with thousands of LDAP
users and more than 1500 user groups. Note that the examples below are
broad filters for use in smaller environments, and can cause performance
issues in environments with thousands of users and more than 1500 user
groups.

Important: When you are using an external registry, make sure that it is
configured correctly before applying filters. Otherwise, you might not be
able to log in to the IBM Flex System Manager management node after the
filters have been applied. If you run into this situation, you will need to
make sure that you have the password for the pe user account. In addition,
you will need to obtain root access to the IBM Flex System Manager. To
obtain root access:
1. Call IBM Support and obtain the password that is required to run the

pesh command.
2. From the management software command-line interface, use the

lsconfig -v command to determine the UVMID of management node.
3. Run the command pesh UVMID, where UVMID is the system ID that

you determined in the previous step. When you are prompted, enter
the password that you obtained from IBM Support.

v User search filter

The user filter is used for searching the registry for users based on their
user IDs. The format of the search filter varies by LDAP server type.
– For Tivoli Directory Server or OpenLDAP servers:

(&(uid=%v)(objectclass=inetOrgPerson)) or (&(uid=
%v)(objectclass=person))

– For Microsoft Active Directory servers: (&(sAMAccountName=
%v)(objectcategory=user))

The variable %v is used to filter by user ID. At runtime, it is replaced
with the user ID of the user that is being authenticated.

v User group object filter

The user group object filter is used to search for user groups in the
LDAP registry.
– For Tivoli Directory Server or Open LDAP servers:

(|(objectclass=groupOfNames)(objectclass=groupOfUniqueNames)) or
(objectclass=groupOfNames)

– For Microsoft Active Directory servers: (objectCategory=group)
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Note: By default the objectCategory is set to group, which is
extremely broad. In large environment, such a broad setting might
return too many results when the user registry is queried, which will
in users not being able to log on. Therefore, consider setting
objectCategory to a more specific setting, such as
(|(CN=smadmin)(CN=smmgr)(CN=smuser)(CN=smmon)(CN=customgroup))

The above example sets objectCategory to predefined groups, such as
smmgr as well as a custom group (customgroupv). You can use the
authusergp command to authorize custom groups to access the IBM
Flex System Manager management software.

v User object filter

The user object filter is used to search the external LDAP directory for
all users.
For Tivoli Directory Server or Open LDAP servers:
(objectclass=person) or (objectclass=inetOrgPerson)
For Microsoft Active Directory servers:
(|(objectCategory=person)(objectCategory=user))

v Login attribute

The Login attribute is used to identify a login name.
For Tivoli Directory Server or Open LDAP servers: uid
For Microsoft Active Directory servers: sAMAccountName

v Member attribute

The member attribute is used to identify that an object belongs to a
group. The value contained in this attribute is expected to be the DN of
the member object, for example member. You can specify multiple
member attributes as a comma separated list of attributes, for example:
member1,member2,member3.

Secure Socket Layer (SSL)
To connect to the external LDAP server, you must provide the SSL
certificate from the server. Use this panel to specify the local path to the
certificate.

Summary
The summary page shows the user registry configuration options you have
chosen. Verify your configuration and correct it if necessary, then click
Finish to apply the changes.

For more information about using a Microsoft Active Directory user registry on an
external server, see Using Active Directory.

Managing users and user groups
The Users and Groups page in the IBM Flex System Manager management
software web interface enables you to create, edit, and delete management
software users and user groups.

See “Users and Groups page in the web interface” on page 39 and “Security” on
page 24 for more information about the user management capabilities of the
management software.
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Automate checking for updates
Use the Updates wizard to configure IBM Flex System Manager management
software to notify you of available updates and to select compliance policy settings
for managed resources. It does not set up an automatic installation of updates.

About this task

With the management software Updates wizard, you can determine whether the
systems-management software connects to the Internet directly or through an
HTTP proxy server. You can also set the start date, time of day, and frequency that
the management software automatically checks for updates.

Note: The Integration Wizard Updates group will be created for updates that
apply to the FSM Elements List group, which is monitored for compliance with
these updates.

For more information about updating systems and keeping managed resources in
compliance, see http://publib.boulder.ibm.com/infocenter/flexsys/information/
topic/com.ibm.director.updates.helps.doc/fqm0_t_um_updating_systems.html.

Deploying common configurations
IBM Flex System Manager management software configures some hardware and
software settings automatically during initial setup. For other common settings, the
management software comes with Configuration Patterns that enable you to
provision multiple managed resources quickly and easily. The management
software also has predefined configuration templates and plans that enable you to
deploy specific configurations to managed resources.

Configuration Patterns enable you to quickly provision or pre-provision multiple
compute nodes by configuring local storage, network adapters, boot order, and
other Integrated Management Module (IMM) and Unified Extensible Firmware
Interface (UEFI) settings.

Important: The Configuration Patterns function is compatible only with
X-Architecture compute nodes.
Configuration Patterns integrates support for IBM Fabric Manager so that you can
virtualize fabric connections, and failover or re-purpose servers without disrupting
the fabric. You can also initiate fabric change requests through your
change-management process before your hardware arrives by pre-configuring host
interconnect addresses.

See for more information.

Configuration templates deploy individual settings to operating systems, service
processors, or network switches. A configuration template stores your setting
choices, which enables you to deploy the same settings multiple times. The settings
that you can deploy include IP address, Boot device order, and user accounts.

Note:

v You cannot use configuration templates on the director server you are operating
on.

v You cannot use configuration templates on an FSM because an FSM cannot be a
managed endpoint.

v You cannot add a user to VIOS OS MEP.
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Configuration plans deploy multiple settings as a group to a managed resource in
a single operation. A configuration plan consists of multiple configuration
templates. For example, you can group configuration templates for UEFI, power
scheduling, and network IP address configuration into a single configuration plan,
and deploy them in a single operation.

After you complete the initial setup of the management software, you can begin
working with configuration templates and plans. From the Home page, click the
Additional setup tab; then, click Deploy Common Configurations.

Predefined configuration templates

The following predefined configuration templates come with the management
software.

Note: If you do not find a predefined configuration template that suits your
environment, you can use the Configuration Manager component of the
management software to create your own configuration template.
v IPv4 Address Pool template
v IPv6 Address Pool template
v Server Network template
v Server Legacy OS Boot Order
v Server Primary Boot Order
v Server Wake On LAN Boot Order
v Server SNMPv1 template
v Server SNMPv3 template
v Server Immediate Power Off
v Server Immediate Power On
v Server Scheduled Power Off
v Server Scheduled Power Off and Restart template
v Operating System IPv4 Network template
v Operating System IPv6 Network template
v Operating System Create Linux Account template
v Operating System Create Windows Account template
v Operating System Create i5 Account template
v Operating System Immediate Power Off
v Operating System Immediate Restart
v Ethernet 1GB Switch Protocol Configuration template
v Ethernet 1GB Switch VLAN Configuration template
v 8GB SAN Switch Protocol Configuration template

Predefined configuration plans

The following two predefined configuration plans come with the management
software.

Note: If you do not find a predefined configuration plan that suits your
environment, you can use the Configuration Manager component of the
management software to create your own configuration plan.
v Windows Server on IPv4 Network Plan

146 Systems Management Guide



– Server Primary Boot Order
– Server Scheduled Power Off and Restart template
– Operating System IPv4 Network template
– Operating System Create Windows Accounts template

v Linux Server on IPv6 Network
– Server Wake On LAN Boot Order
– Server Scheduled Power Off and Restart template
– Operating System IPv6 Network template
– Operating System Create Linux Accounts template

Deploying agents
IBM Flex System Manager management software uses an agent manager to
communicate with the common agents that are installed on managed resources.
Install and deploy agents on managed resources to extend the management
capabilities of the management software. The Deploy Agent wizard assists you
with agent setup.

About this task

For you to install agents on managed compute nodes, the operating-system
endpoints must meet the following prerequisites:
v The compute node operating systems must be discovered and unlocked.

Note: Agent installation requires that the management software is managing
compute node operating systems.

v The compute nodes must have SSH or DCOM unlocked.
v The management software must have completed inventory of the compute node.

Note: You can install agents on a managed endpoint only if you are logged in
with sufficient user profile authority for that endpoint.

For an overview of agents, including planning information for specific managed
system types and operating systems, see “Agents” on page 85.

For more information about managing agents with the management software, see
http://publib.boulder.ibm.com/infocenter/flexsys/information/topic/
com.ibm.director.agent.helps.doc/fqm0_t_managing_agents.html.

Backing up the management software image after setup
Back up the IBM Flex System Manager management software image at the end of
the setup process, so that you can restore the configuration data from initial setup
if the management node fails. The backup image includes all applied fixes, data on
managed chassis, and any custom settings.

Important: After you complete the management software setup, back up the
management software image to prevent the loss of configuration data.
You can use the management software web interface to back up the management
software image to the management node hard disk drive, a USB drive, or a secure
FTP server.
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If you restore the management software to its default settings, the backups remain
intact. After you log in to the management software, you can click the restore
button again and bring the image back to a known state.

See “Backing up and restoring the management software” on page 96 for more
information about backing up and restoring a management software image.

Adding or removing NTP servers
You can use the IBM Flex System Manager management software web interface to
add or remove a Network Time Protocol (NTP) server in your IBM Flex System
environment.

Note: If you add an NTP server, you must set your keyid and password on the
NTP server to match the keyid and password that you set in the management
software. The process for setting the key ID and password varies by operating
system. For example, if your external NTP server is running Linux, and if your
keyid is 1234 and your password is my_password, you would typically modify
/etc/ntp.keys by adding the line 1234 M my_password and modify /etc/ntp.conf
by adding the line trustedkey 1234.

For more information about setting the keyid and password on your NTP server,
see the documentation that came with your NTP server.

Note: The IBM Flex System Manager management software can point to a remote
NTP server. However, all the chassis components including the CMM must directly
point to the IBM Flex System Manager management software and not to the NTP
server.

To add or remove an NTP server in the web interface, complete the following
steps:
1. From the Home page, click the Administration tab.
2. Under Configuration tasks, click Configure Date/Time. The Date/Time

Configuration page opens.
3. Click the Time Server tab. The time servers that are defined in the Network

Time Protocol (NTP) configuration file are displayed in the table.
4. On the Time Server tab, the following actions are available:

Add an NTP server
Click Add to define a new NTP server. In the Add Time Server
window, enter the settings for the NTP server; then, click OK.

Remove an NTP server
To remove an NTP server, select the button for the server; then, click
Remove. Click OK.

Configure an NTP server to manage the date and time
To configure an NTP server to manage the date and time, select the
button for the time server; then select the Enable NTP service box
below the table. Click OK.

Note: The poll interval for the NTP service cannot be configured manually.
5. If you are prompted, restart the management node.
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Changing an IBM Flex System Manager management node IP address
Before you change the management network IP address for a management node
that is managing one or more chassis in centralized user management mode, make
sure that you remove the chassis from centralized management mode. For
managed chassis in decentralized user management mode, you must update the
NTP configuration for each chassis and CMM with the new management node IP
address.

The following sections describe different procedures for configuring centralized
and decentralized chassis when you change the management node IP address. If
you have chassis in centralized user management mode and other chassis in
decentralized management mode, use information from both of the following
procedures but change the management node IP address only once.

Changing the management node IP address when managed
chassis are in centralized management mode

To temporarily remove chassis from centralized user management mode, change
the management network IP address, and re-enable centralized user management
mode, complete the following steps:
1. From the IBM Flex System Manager management software command-line

interface, run the following command:
smcli lsCentrallyManagedChassis

The output from the command shows the universal identifier (UUID) for each
chassis that is centrally managed.

2. Run the following command:
smcli rmCentrallyManagedChassis -u chassis_UUID

where chassis_UUID is the UUID for the chassis that you want to change from
centralized to decentralized user management mode. Repeat this step for every
chassis that is centrally managed.

Note: The rmCentrallyManagedChassis command does not unmanage the
chassis.

3. Change the management node IP address (Eth0, or the management network IP
address) in the management software web interface:
a. From the Home page, click the Administration tab.
b. Under Configuration tasks, click Configure Network. The Network

Configuration wizard opens.
c. Select the management network and change the settings in the wizard for

the new IP address.
d. After you change the network configuration, click Finish.

4. Restart the management node.
5. To restore the chassis to centralized user management mode by using the

management software CLI, run the following command:
manageChassis --Uc -c <userid:password@1.1.1.1> --Cu <centralized user ID> --Cp <centralized password> --Rp <RECOVERY_ID password>

where the variables in the command are:
v userid:password@1.1.1.1 represents the administrator credentials and IP

address for the target chassis
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v centralized user ID is an administrator user ID with supervisor authority on
the management node. This account is used to request access to the CMM on
behalf of the management node and managed nodes after the CMM is
centrally managed.

v centralized password is the password for the centralized user ID
v RECOVERY_ID password is the password for the CMM recovery account,

which has the user ID RECOVERY_ID.

For more information about the command and its options, see .

Changing the management node IP address when managed
chassis are in decentralized management mode

If the management node manages one or more chassis in decentralized user
management mode, complete the following steps to change the management node
IP address and update the CMM NTP configuration with the new IP address:
1. Change the management node IP address (Eth0, or the management network IP

address) in the management software web interface:
a. From the Home page, click the Administration tab.
b. Under Configuration tasks, click Configure Network. The Network

Configuration wizard opens.
c. Select the management network and change the settings in the wizard for

the new IP address.
d. After you change the network configuration, click Finish.

2. Restart the management node.
3. For each chassis that is managed in decentralized user management mode,

complete the following steps:
a. Log in to the CMM command-line interface.
b. Run the following command:

ntp -T mm[p] -i <new_IP_address>

where <new_IP_address> is the new management node IP address.
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Chapter 4. Updating systems

Use the IBM Flex System Manager update manager to complete advanced updates
to managed resources. Update manager enables you to acquire, install, and manage
updates, as well as to monitor your systems to ensure that they remain current.

About this task

Update manager enables you to keep your systems at desired software or firmware
update levels by automatically checking for available updates and identifying
which systems need attention. It also provides you with the ability to monitor your
systems for needed updates and schedule the installation of updates at times that
are convenient for your network and users.

For a detailed summary of update procedures for all IBM Flex System components,
see the IBM Flex System Firmware Update Guides at http://www.ibm.com/
support/entry/portal/docdisplay?lndocid=MIGR-5091991.

Note: If you are setting up your IBM Flex System environment for the first time,
or if you need only to complete basic update operations for managed resources,
use the management software update wizards. For more information about each
update wizard, see the documentation in Initial Setup.

Update manager compares update information that is loaded into it with the
inventories of specified systems to determine whether updates are needed. To load
current information about available updates into update manager, you can use the
update manager Acquire updates task. Within that task, you can use either of the
following functions, both of which supply the same exact source for update
manager:
v Acquire updates: If an Internet connection is available, the acquire updates task

automatically contacts the update repository and downloads information about
the latest available updates into update manager.

Note: To acquire updates, the IBM Flex System Manager must have Internet
access. If a connection is unavailable, you can instead import the updates
manually. See Acquiring and installing updates for more information.

v Import updates from the file system: If no Internet connection is available, you
can manually download supported updates and then import them into update
manager.

Update manager then enables you to examine recently acquired updates and install
any that are needed.

Note: Because update manager determines needed updates by comparing
information about available updates with system inventories, the update
information must be current. To help keep update manager up to date, schedule a
recurring Acquire updates task that will regularly download update information
since the last acquire updates was run. Alternatively, you can regularly monitor
www.ibm.com/support/fixcentral/ and import updates that your systems might
need into update manager.

If your systems need updates, you can use update manager to manage the
installation.
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Important:

v For update manager to determine which updates are needed, you must ensure
that the software inventory for monitored systems is collected and current. Most
update manager methods cannot determine the applicability of updates to a
system unless inventory was previously collected on the system.

v The LAN over USB interface must be enabled on an X-Architecture compute
node before you can update the firmware on that compute node. For more
information, see Update considerations for X-Architecture compute nodes.

To view a table of the updates needed by your systems, you can use the update
manager Show and install updates task. From this table, you can select which
updates to install.

Notes:

v Before update manager installs updates, it displays information about whether
system restarts are required. You can allow or disable automatic restarts. If
automatic restarts are allowed, update manager calculates the installation
sequence that minimizes the number of restarts. Alternatively, you can manually
control the restarts.

v During installation, update manager automatically downloads the update
installation files and distributes them across your network to complete the
installation. As with restarts, you can also manually control these steps to
minimize disruption.

To receive an automatic notification when updates are required to keep your
systems current or at a specified update level, you can use update manager to set
up compliance policies. These policies specify which systems are monitored and
which updates you must install to keep the systems in compliance. Update
manager uses these policies to check the status of your systems and notifies you
when systems need updates, and which updates are needed. To set up compliance
policies, you can use the update manager Create and configure compliance
policies task. After a compliance policy is set up, the compliance pie chart then
appears on the Update Manager summary page and you can use that to monitor
compliance status and take any necessary corrective action.

Note: As a best practice, plan to update to the latest update or patch for your
release of IBM Flex System Manager at least twice a year. Maintaining this
schedule will help to eliminate unnecessary exposure to problems that are already
resolved in more current updates and patches. Staying farther back on
maintenance can also inhibit the ability of your service representative to provide a
formal fix without first requiring the application of a more current update or
patch.

Planning to update systems
Complete these planning steps before starting the actual update process to ensure
that the update process that you follow is successful and meets your needs.

About this task

For a detailed summary of update procedures for all IBM Flex System components,
see the IBM Flex System Firmware Update Guides at http://www.ibm.com/
support/entry/portal/docdisplay?lndocid=MIGR-5091991.
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Supported update tasks
You can use update manager to complete various update tasks, including
downloading and installing updates to existing software and setting up compliance
policies to monitor your systems. You can also use update manager to manage
individual updates or sets of updates that are known as update collections.

Update manager performs the following tasks:
v Manage and install updates to existing software products and firmware, external

network and storage switches, and external storage servers.
v Install updates to IBM Flex System Manager.
v Install updates to IBM Flex System Manager agents that have already been

installed.
v Acquire and install an individual update or update collection with the following

sequence of tasks:
1. Downloading, which copies the installable files for an update to the

management server.
2. Installation staging, which copies the installable files for an update to an

appropriate location for eventual installation.
3. Installing, which installs an update.
4. Uninstalling, which removes an update.

Note: Not all updates support the uninstallation task.
v Manage compliance policies, which provide notification of when systems are in

need of updates and which updates are needed.
v Schedule a check for updates, which is a search for new updates of which

update manager is not currently aware. If any new updates are found, update
manager obtains the necessary information that is required to include these
updates.

v Provide details about a specific update, such as its documentation and
prerequisite requirements (requisite updates).

v Display information about updates that were installed by IBM Flex System
Manager.

Note: Updates installed by other means are not displayed.

Update manager does not perform the following tasks:
v Install new software products.
v Install IBM Flex System Manager agents on systems that currently do not have

an agent.
Instead, install IBM Flex System Manager agents with the agent manager plug-in
of IBM Flex System Manager.

v Perform actions on systems that are not accessible. You can perform update
actions on only those systems that are accessible.

Notes:

– If a system is not accessible, the update menu actions are not displayed for it.
You cannot select a system that is not accessible in any of the system selection
actions, for example on the System page in the Installation wizard, on the
Installation staging wizard, and so on.

– If you want to monitor update management and compliance status on any
systems that are not accessible, you must first run inventory collection on
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them. Most update manager methods cannot determine the applicability of
updates to a system unless inventory was previously collected on the system.

v Update another, different instance of IBM Flex System Manager.

Update considerations for specific operating systems and
platforms

When you are installing updates for certain hardware and operating systems, there
are unique tasks to be performed and restrictions to consider.

Predefined update groups can be used to facilitate working with updates for a
particular platform or operating system.

Update considerations for AIX systems
Updating AIX systems with IBM Flex System Manager requires the use of Network
Installation Management (NIM) software and a Common Agent. IBM Flex System
Manager supports updating AIX 6.1 and later releases.

Terms used for updating AIX

These are terms you will encounter when you are working with AIX updates:

Network Installation Manager (NIM) master
An AIX system that has been designated as a focal point to receive updates
and install them on other AIX systems, known as NIM clients.

Network Installation Manager (NIM) client
An AIX system that is installed from a NIM master.

Technology Level
The twice yearly AIX releases, which contain new hardware and software
features and service updates. The first of the twice yearly technology levels
is restricted to hardware features and enablement, as well as software
service. The second of the twice yearly technology levels includes
hardware features and enablement, software service, and new software
features.

Make sure that you install all parts of a technology level. Back up your
system before installing a technology level.

Service Pack
A collection of service-only updates (also known as PTFs) that are released
between Technology Levels to be grouped for easier identification. These
fixes address highly pervasive, critical, or security-related issues.

Maintenance Level 
The service updates (fixes and enhancements) that are necessary to
upgrade the Base Operating System (BOS) or an optional software product
to the current release level.

Recommended level
The level of a service pack that is recommended for a given AIX
technology level. Not all technology levels have a recommended service
pack level.

Latest level
The most recent level of service pack or technology level.
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Tips for updating AIX

Be aware of these tips and restrictions when you are working with AIX updates:
v Do not upgrade the AIX host operating system that IBM Flex System Manager is

running on. Doing so would break the connection between IBM Flex System
Manager agent and IBM Flex System Manager.

v Back up your system before installing a technology level.
v Updates can be installed only within a release of AIX. You cannot perform a

migration to a new version of AIX with update manager.
v You cannot perform a new overwrite installation of AIX with update manager.
v AIX 6.1 and later releases are supported.
v To perform an installation or installation staging for AIX updates, your system

must adhere to the following requirements:
– Ensure that your AIX has a NIM master.

Note: During installation, IBM Flex System Manager automatically adds the
target AIX system as a NIM client of the NIM master.

– Ensure that your AIX has a NIM environment.
– Ensure that the AIX NIM master and the AIX managed systems (NIM clients)

contain Common Agent.
– Ensure that the NIM master is correctly initialized and configured.
– If you are updating an agentless or Platform Agent system, ensure that the

/tmp directory has full public read/write/execute permissions and enough
allotted disk space to accommodate the staged update.

v The updates will always be staged to a NIM master. IBM Flex System Manager
update manager creates a separate file system named /export/um_lpp_source if
it does not exist. The size is initially set to 1G, but IBM Flex System Manager
update manager will increase the size if the available space is not large enough
to hold the update files.

v Installation of an update that requires a license acceptance must be done
manually on the AIX target system. There are cases in which an update
contained in a technology level or a service pack can require license acceptance.
The ability to accept a license is not supported from the user interface and must
be performed by installing the file set through the System Management Interface
Tool (SMIT) interface and responding yes to the query ACCEPT new license
agreements?.

v If you plan to import updates on an AIX system, note that you can import only
those updates that contain descriptor files. Fix Central is typically the only
location from which you can obtain updates with descriptor files, so updates
obtained from the DVD might not properly import.

v Update manager cannot install AIX iFixes in the .EPKG.Z format. IBM Flex
System Manager can import and apply fixes on AIX only when the fix packages
are published on ECC (Electronic Customer Care) and include all supported files
such as the .sdd file. When such a fix package is available, you can install it with
the following command:
emgr -i -C package_name.epkg.Z

For more information about the emgr command and installing iFixes on AIX, see
emgr Command.
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Update considerations for Hardware Management Console
systems
Hardware Management Console systems can have these items installed: updates,
upgrades, and interim fixes.

Note these restrictions and hints for working with Hardware Management Console
updates:
v Only Hardware Management Console Version 7 Release 3.3 SP2, and later

versions and releases, are supported.
v Only Virtual I/O Server Version 1.5.2.1 and later fix packs are supported.
v Hardware Management Console upgrades are not supported for the installation

staging task. If installation staging is attempted, a message is displayed with
instructions for creating and using a CD to manually perform this task.

v An ISO image is a disk image for an ISO 9660 file system, and contains the
installable files for a particular update or upgrade. A download is automatically
performed for the ISO image, and the files that are downloaded can be used for
installation on the management server. You must manually create a CD with this
ISO image and then install the update from the CD.

v Hardware Management Console upgrades are not supported for the installation
task. If you attempt an installation task, after having successfully performed a
manual installation staging task, a message is displayed with instructions for
installing the upgrades on each Hardware Management Console system. If you
attempt an installation task and installation staging has not been performed
manually, a message is displayed with the installation staging instructions using
CDs mentioned above.

v Uninstalling and rolling back Hardware Management Console updates,
upgrades, or interim fixes is not supported.

v Updating a Hardware Management Console system might remove existing CIM
indication subscriptions. To ensure that IBM Flex System Manager correctly
registers the CIM indication subscriptions and continues to accurately display
the status of the updated Hardware Management Console system, revoke and
then reinstate access to the system.

v Extended discovery or inventory discovery must be performed for the target
Hardware Management Console before using any Hardware Management
Console functions in update manager.

v When you update the Hardware Management Console by using IBM Flex
System Manager Update Manager, select the Latest option as the update type.
To use this option, complete the following steps:
1. From the Acquire Updates page, select Check for updates (Internet

connection required option).
2. In Available update types, select HMC > Update > Latest.
3. Click Add to move the Latest option in the Selected update types list.

Attention: If the Latest option is not used, then IBM Flex System Manager
Update Manager cannot create a relationship between the acquired Hardware
Management Console updates. Therefore, higher version in the Hardware
Management Console shows as Applies To while the lower version Hardware
Management Console updates show as Needed Updates. To show the
appropriate updates in the Show and install updates page, do not use the HMC
> Update > Recommended option.

Update considerations for IBM i systems
Consider these factors when updating IBM i (formerly i5/OS) systems.
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v IBM Flex System Manager must support the IBM i version that you want to
update.

v To distribute and apply IBM i PTFs, a credential must be created authorizing the
user after IBM Flex System Manager has obtained access to the IBM i system.
The IBM i system must be an agentless-managed, platform-managed, or
common agent services managed system with access granted. Refer to the topic
“Creating single sign-on credentials” on page 61 for instructions to create the
credentials.

v IBM i PTFs are first installed with the apply type *IMMDLY. PTFs that cannot be
installed as *IMMDLY are installed as *DLYIPL. You cannot configure the PTF
apply type that IBM Flex System Manager uses.

v Updates that are permanently installed on the system cannot be uninstalled.
v If an update requires a system restart, the administrator must perform the restart

manually. No automatic system restarts are performed for IBM i systems.
v You can also designate an IBM i network install server as a focal point to receive

updates and to install them on the other IBM i systems. To designate an IBM i
network install server, go to the Update Manager summary page and click
Configure settings. On the IBM i tab, select an IBM i system from the list.

For more information about updating IBM i systems, see Best practices for working
with updates for IBM i.

Update considerations for Linux systems
Each Linux Distribution Partner provides updates for its specific Linux
distribution. To download updates and install them, you must have an Internet
connection and be registered with the Linux Distribution Partner.

Consider these factors when updating Linux systems.
v IBM Flex System Manager supports the application of updates only to Red Hat

Enterprise Linux versions 5.x and 6.x, SUSE Linux Enterprise Server 10 with any
of the applicable service packs, and SUSE Linux Enterprise Server 11.

v Only users with administrative authority can manage Common Agents.
v On 64-bit Linux, the 32-bit compatibility libraries are required.
v The target system must have network connectivity with the management server

and either direct or proxy connectivity with the Internet. The Internet connection
is needed to obtain the updates from the Linux Distribution Partner.

v Update manager for Linux systems does not support repositories that are
registered multiple times. Before you update the Linux system, the target system
must clean all registered repositories and then register one repository for the
updating process.

v If the target system has a dependency issue when you update a Linux system,
copy the dependent packages to the repository that is registered. You can also
register a repository that contains dependent packages and then complete the
update operation.

Note: If you register multiple repositories for a target system that has a
dependency issue, do not collect inventory on the target system again. Later,
remove the repositories when the update operation completes.

v To apply Linux updates, each system must be registered with the update server
for the appropriate Linux distribution's update service.
See these websites for more information:
– For Red Hat Enterprise Linux distributions, https://www.redhat.com or

https://rhn.redhat.com
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– For SUSE Linux distributions, http://www.novell.com or
http://www.novell.com/customercenter

v Ensure that the following commands are installed on each system that is to
receive an update:
– zip
– gunzip
– rug (for SUSE Linux Enterprise Server 10 with the service pack)
– zypper (for SUSE Linux Enterprise Server 11)
– yum (for Red Hat Enterprise Linux versions 5.x and 6.x)

v Uninstalling updates and rolling back updates are not supported.
v To receive updates, the Linux system must either be an Agentless managed

system, a Platform Agent managed system, or a Common Agent managed
system.

v If you are updating an agentless or Platform Agent system, ensure that the /tmp
directory has full public read/write/execute permissions and enough allotted
disk space to accommodate the staged update.

Update considerations for IBM Power I/O firmware
Consider these factors when updating IBM Power I/O firmware.
v AIX is required on the target system to update IBM Power I/O firmware.

Updates to network devices in Power Systems compute nodes that run Linux
are not supported.

v Common Agent is required on the target system to install IBM Power I/O
firmware.

v You must perform extended discovery or inventory collection for the target
system before working with IBM Power I/O firmware updates.

v If you will update a shared device, ensure that it is not used on other partitions.
v You cannot use update manager to downgrade or roll back an IBM Power I/O

firmware level.
v The IBM Flex System Manager Web interface allows you to select multiple

criteria values at the same time. If you select the criteria value of All, other
selected criteria values are ignored.

Update considerations for Power Systems firmware
Consider these factors when updating Power Systems firmware.

The following list contains general considerations for updating Power Systems
firmware. See Managing host updates for more specific information.
v You must perform extended discovery or inventory collection for the target

system before working with Power Systems firmware updates.
v IBM Flex System p260 and p460 Compute Nodes that come with management

software 1.1.0 are compatible with 740 firmware and 74x updates only.
v Uninstalling and rolling back Power Systems firmware updates or upgrades is

not supported.

Update considerations for X-Architecture compute nodes
Consider these factors when updating X-Architecture compute nodes.
v Before you attempt to update the firmware for an X-Architecture compute node,

make sure that the LAN over USB interface is enabled on the compute node.
To check if the interface is enabled, and to enable the LAN over USB interface if
necessary, complete the following steps:
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1. Log in to the Chassis Management Module (CMM) web interface (see for
more information).

2. From the CMM web interface home page, click Chassis Management >
Compute Nodes.

3. Click the compute node name.
4. Click the General tab.
5. Select Enable Ethernet Over USB to enable the LAN over USB interface.

v You can use update manager to install updates to X-Architecture compute nodes,
but you cannot use update manager to uninstall or roll back X-Architecture
compute node updates.

v X-Architecture compute node and IBM Flex System firmware updates for UEFI
and IMMv2, and PBDSA firmware updates on IMMv2 systems, are available in
an operating system agnostic format. This means that you can install any of
these types of updates on any operating system that resides on a system with
the applicable machine type. To install these updates, which are not
self-executable binary files, you must use IBM UpdateXpress System Pack
Installer (UXSPi). In IBM Flex System Manager, ensure that the latest version of
UXSPi is imported, then use the UXSPi settings tab to view obtained operating
system agnostic updates and manually import new ones. When you use the
UXSPi update for the new System x hardware, you must use the Lenovo UXSPi
package name that starts with lnvgy_utl_ instead of the older hardware that
belongs to IBM USXPi package and starts with ibm_utl_.

Note: You must also use UXSPi to run compliance checks on such
X-Architecture compute node and IBM Flex System firmware updates. Ensure
that the latest version of UXSPi is imported before running compliance.

v The designated severity levels of X-Architecture compute node updates can
dynamically change depending on the updates that are already installed on the
system. For example, if no previous versions of an update exist on a system, the
current version of the update might have a higher level of severity than it would
if a previous version of the update existed.

Note:

v To install updates by using UXSPi on a Windows system, ensure that either
common agent services (CAS) or a DCOM Service Access Point (SAP) is
discovered on the system.

v IBM Flex System Manager update manager does not support UXSPi update on
Hyper-V type systems. This configuration is not supported for the UXSPi and
you must perform the update independent of IBM Flex System Manager. To
update the UXSPi package on Hyper-V type systems, you must update the
firmware by using the UXSPi tool on the Windows system that is hosting the
Hyper-V system.

Update considerations for Virtual I/O Server systems
Updating Virtual I/O Server systems with IBM Flex System Manager by using a
migration image requires the use of Network Installation Management (NIM)
software. The NIM server must be running AIX 6.1 or later.

A NIM master is not required when updating Virtual I/O Server systems with fix
pack, service pack, or interim fix updates.
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Terms used for updating Virtual I/O Server

These are terms you will encounter when you are working with Virtual I/O Server
updates:

Network Installation Manager (NIM) master
An AIX system that has been designated as a focal point to receive updates
and install them on other Virtual I/O Server systems, known as NIM
clients.

Network Installation Manager (NIM) client
A Virtual I/O Server system that will use a NIM master for migration.

Fix pack
A fix pack updates your Virtual I/O Server release to the latest level. A fix
pack update can contain product enhancements, new functions, and fixes.

Service Pack
A Service Pack applies to only one Virtual I/O Server level. A Service Pack
contains critical fixes for issues found between fix pack releases. A Service
Pack does not update Virtual I/O Server to a new level, and it can only be
applied to the fix pack release for which it is specified.

Interim fix (iFix)
An interim fix (iFix) applies to only one Virtual I/O Server level and
provides a fix for a specific issue.

Migration image
A Migration image supports the upgrade from a Virtual I/O Server version
to a newer version.

Tips for updating Virtual I/O Server

Be aware of these tips and restrictions when you are working with Virtual I/O
Server updates:
v Only Virtual I/O Server 1.5.2.1-FP11.1 and later releases are supported.
v You cannot use IBM Flex System Manager update manager to perform a fresh

installation of Virtual I/O Server.
v To perform an installation or installation staging for the Virtual I/O Server

migration image, your system must meet the following requirements:
– A NIM environment is required.
– An AIX NIM master is required to migrate Virtual I/O Server to higher

release, such as from Virtual I/O Server 1.5.2.1-FP11.1 to 2.1.0.0.
– Do not update the NIM master when you are migrating Virtual I/O Server

using that NIM master.
– The operating system level for the NIM master must be AIX 6.1 or later.

v Do not migrate to Virtual I/O Server 2.1.0.0 directly from a lower version such
as 1.5.2.1-FP11.1 because Virtual I/O Server 2.1.0.0 is not officially supported by
IBM Flex System Manager. Install the fix pack or Service Pack for Virtual I/O
Server 2.1.0.0 directly when you are migrating from a version earlier than Virtual
I/O Server 2.1.0.0. The update manager for Virtual I/O Server extension will
automatically install Virtual I/O Server 2.1.0.0 and the selected fix pack or
service pack for you.

Note: You also need a NIM environment because migrating to Virtual I/O
Server 2.1.0.0 is based on NIM operation
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v If there are any LPARs managed by the Virtual I/O Server system, you must
close them before installing updates on the Virtual I/O Server system.

v Back up your system before migrating it to a higher release.
v When performing migration, the migration image will always be staged to a

NIM master. The image requires 16G of available space and will be put into a
separate file system named /export/um_lpp_source. If the file system does not
exist on the NIM master, IBM Flex System Manager update manager will create
it. If the file system does not have enough available space, IBM Flex System
Manager update manager will increase the size of the file system.

v For the installation of a fix pack, service pack, or iFix, 5G of available space is
required on the /opt file system of the target Virtual I/O Server system.

v The update manager for IBM Flex System Manager extension will automatically
accept the license if the update requires it.

v IBM Flex System Manager update manager does not support rollback for Virtual
I/O Server extensions.

v The size of some updates might exceed the file size limit of the system on which
IBM Flex System Manager is installed. Therefore, you should set the file size
limit to unlimited before proceeding. Refer to the system documentation for
information about checking and setting file size limits.

v If you distribute an update that is a migration image, the progress bar will reach
100% complete while the status is still running. The task will actually be
complete when the status is changed to Complete.

v Although the IBM Flex System Manager Web interface allows you to select
multiple criteria values at same time, only one of them will take effect:
– When the criteria value All is selected, other selected criteria values will be

ignored.
– When the criteria value All is not selected and the criteria value Latest

Upgrade is selected, only the latest upgrade takes effect. All other selected
criteria values will be ignored.

v Only migration tasks are staged to the NIM master. All other update tasks, such
as for firmware or fix packs, are staged directly to the managed server.

Update considerations for VMware ESXi systems
Consider these factors when updating VMware ESXi systems.
v The following firmware update types are supported when updating version 5.5

update 1 of either the standard VMware ESXi (vSphere) product or an IBM
customized version of VMware ESXi (vSphere):

Table 24. VMware ESXi supported firmware

Firmware update type
Standard VMware ESXi
(vSphere)

IBM customized version of
VMware ESXi (vSphere)

Brocade N Y

Broadcom N N

DSA Y Y

Emulex N Y

FPGA Y Y

IMM Y Y

QLogic CNA N Y

QLogic FC N Y

uEFI Y Y
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v Updates are not supported on IBM customized VMware ESXi (vSphere) versions
4.0 or 4.1.

v To manage firmware updates for systems running standard VMware ESXi, you
must first discover and access both the OperatingSystem resource and the
related Server resource, which is, for example, an IMM.

Note: Discovering and accessing only the VMware ESXi OperatingSystem
resource will not create the correct Server resource because the OperatingSystem
resource and the Server resource are typically assigned different IP addresses.
See Viewing system discovery results for more information.

v To manage firmware updates for systems running the IBM customized version
of VMware ESXi, the OperatingSystem resource must be discovered; this
discovery occurs automatically in an IBM Flex System environment.

v For updates to management modules, the management software enables SSH
File Transfer Protocol (SFTP) automatically. You can also install updates to
management modules from a server with Trivial File Transfer Protocol (TFTP) or
File Transfer Protocol (FTP). If necessary, use the Settings function to specify
TFTP or FTP server properties.

Notes:

– If you are updating the IBM customized version of VMware ESXi, SFTP is the
only supported protocol.

Note: IBM UXSPi is applicable to IBM systems, whereas Lenovo UXSPi is
applicable to Lenovo systems. Therefore, use the correct UXSPi on the respective
systems. As IBM UXSPi has stopped release of new versions after 9.63, newer
operating systems on IBM systems cannot be supported by IBM UXSPi. For
example, IBM UXSPi does not support SUSE Linux Enterprise Server 12 on IBM
manufactured systems. For more information, refer to UXSPi release documents.

v IBM UXSPi cannot be used to update agents on Hyper-V systems.
v Use IBM ToolsCenter Bootable Media Creator (BoMC) or UpdateXpress System

Pack Installer (UXSPI) to update VMware ESXi versions that IBM Flex System
Manager does not support.

v Before updating firmware on an IBM customized version of VMware ESXi
(vSphere), ensure that you apply the latest VMware ESXi drivers and the latest
VMware ESXi IBM customized image patches to the ESXi system.

Update considerations for multi-node systems
Consider these items before updating system firmware on multi-node systems.

In a multi-node system, also called a scalable system, update manager is
responsible for keeping the following four types of system firmware at the same
level on all physical servers across the system:
v DSA
v IMM
v UEFI

To achieve this, if any system firmware update is needed on the physical server,
update manager marks the needed relationship on the top level system, also called
the cluster system. Then, during installation, the update is applied to all the
physical servers in the multi-node system.

162 Systems Management Guide

https://www.ibm.com/support/home/docdisplay?lndocid=tool-bomc
https://www.ibm.com/support/home/docdisplay?lndocid=SERV-XPRESS
https://www.ibm.com/support/home/docdisplay?lndocid=SERV-XPRESS


Note: Update manager does not support multi-node systems that have ESXi
installed on them.

Consider the following items when updating the system firmware on multi-node
systems:
v Before starting any system firmware update processes, ensure that the

multi-node systems are discovered with both inband mode and OOB mode. See
Discovering a scalable BladeCenter system with multiple nodes for more
information about how to discover multi-node systems.

v Ensure that all inventory has been collected on the scalable partition systems
and cluster systems.

v When checking compliance, the system firmware listed above is shown on the
cluster manageable endpoint of the multi-node system instead of on the physical
server system.

v The systems firmware updates are installed to all the physical server systems
when you install the update on the multi-node system. All the partition systems
are then rebooted after the installation.

v If you are installing multiple update packages, install the DSA, IMM, and UEFI
updates first. After these updates have completed successfully you can begin
installing the remaining updates to each system.

Update considerations for Nimitz firmware
Consider these factors before you update system firmware on Nimitz systems.

Prerequisites

Make sure that the following prerequisites are met before you install the update:
v Discover and unlock the storage cluster.
v Complete the system inventory collection.
v Download the most recent upgrade test utility and update the storage Integrated

Technology Element (ITE) with Check for update or Import update options.

To install the storage ITE update, complete the following steps:
1. Run the installupd command to install the storage ITE update.
2. Use IBM Flex System Manager web console or run the following command:

smcli installupd

smcli installupd -i [ip_address | host_name] -u [update_oid | update_fix_id] -V [ignore_check_setting]
Option:

-V [ignore_check_setting]
ignore_check_setting: IGNORE_CHECK=true | IGNORE_CHECK=false (default)

The following examples show the usage of the command:
v Installation of the Nimitz firmware update without taking into account the

result of a central control unit (CCU) check.
smcli installupd -i x.x.x.x -u StorageDisk-x-x.x.x.x -V IGNORE_CHECK=true

v Installation of the Nimitz firmware update according to the result of a CCU
check.
smcli installupd -i x.x.x.x -u StorageDisk-x-x.x.x.x -V IGNORE_CHECK=false

Determining the installed IBM Flex System Manager version
Before you update an installation of IBM Flex System Manager, determine the
version of the IBM Flex System Manager or agent that is installed.
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About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To determine the installed version of IBM Flex System Manager:
v Web interface: From the Home page, click the Plug-ins tab. The current version

number of the management software is displayed beside IBM Flex System
Manager, at the top of the list of plug-ins.

v CLI: Run the command smcli lsconfig.

To determine the installed version of IBM Flex System Manager agent:
v From IBM Flex System Manager:

– Web interface: Open the navigation area (hidden by default) by clicking the
tab with the arrow on the left side of the screen. Expand Release
Management; then, click Agents. Click All Agent Packages. The version
numbers for the installed agents are displayed in the Version column.

– CLI: Run the lssys command, with the ManagementSoftware attribute. For
example: smcli lssys -A ManagementSoftware -i 9.22.103.245.

Note: Maintenance is not delivered for every manager at each update or patch. For
example, the update for a particular version might be released for automation
manager without the release of a corresponding update for configuration manager.

Starting to monitor and update systems
To monitor and update systems, you must set up update manager correctly,
including choosing the systems to monitor. You must also ensure that an Acquire
updates task is run on a recurring basis, and that someone is periodically checking
systems that have compliance issues. Lastly, you must install needed updates.

Before you begin

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

For systems that are to be monitored for update management and compliance
status, you must:
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v Make sure that the systems are discovered and accessible.
v Collect inventory on the systems. Most update manager methods cannot

determine the applicability of updates to a system unless inventory was
previously collected on the system.

Tip: To protect your system in the event of an unforeseen complication, ensure
that you back up your data before performing any update tasks.

Procedure
1. From the Plug-ins tab on the IBM Flex System Manager Web interface Home

page, click Update Manager. The update manager summary page is displayed.
2. Click the Optional: Getting started link and complete the Getting Started

wizard. See “Getting started with updates” for more information.
3. Click the Configure settings link and complete the Settings task. See

“Changing update settings” for more information.
4. Optional: Create additional update groups to facilitate update management. See

“Managing update groups” for more information.
5. Acquire and install updates for the product or system that you want to update:

Update IBM Flex System Manager
If you want to simply update IBM Flex System Manager, use “Update
IBM Flex System Manager” to let update manager take most defaults
and run most update tasks for you automatically. See “Updating IBM
Flex System Manager” for more information.

Update other systems
If you want to update other systems, or if you want to update IBM Flex
System Manager but have full control over the whole process, use the
various update manager tasks in the IBM Flex System Manager Web
interface or the installneeded command to update your systems. See
“Acquiring and installing updates” for more information.

6. Schedule an Acquire updates task to run periodically, at least once a week. See
“Acquiring new updates” for more information.

7. Review the Update Compliance section of the update manager summary page
to check if your systems meet your update specifications. See “Keeping systems
in compliance” for more information.

8. If some systems need updates, review the exact compliance issues and address
them by planning to install the needed updates.

9. Periodically, perform Steps 7 and 8, or create an Event Automation Plan to
perform this task and notify you of any systems that are in need of updates.
See “Creating an event automation plan” for more information.

Configuring update manager
Before starting to manage updates, run the Settings function and the optional
Getting Started With Updates wizard to customize your configuration.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:
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To specify settings, go to the Update Manager summary page, click Configure
settings and complete the various tabs for your configuration.

Then, use the optional Getting Started With Updates wizard to accomplish the
following tasks:
v Select a set of systems to monitor with compliance policies
v Create update groups for updates that are appropriate to the selected systems
v Configure Internet connectivity
v Run or schedule a check for updates

To run the Getting Started With Updates wizard, complete the following steps:

Procedure
1. From the Home page in the web interface, click the Plug-ins tab; then, click

Update Manager.
2. On the Update Manager summary page, click Optional: Getting started. The

Getting Started With Updates wizard displays a welcome panel.
3. Optional: If you do not want to see the Welcome page next time, clear Show

the welcome page next time.
4. Click Next. The Name and Description page is displayed.
5. Type a name and optional description for the update group that is to be

created. This group is initially empty but will acquire the updates for the
systems that were selected. It is also attached to these systems through a
compliance policy. Update manager will monitor the systems and indicate
when a system is missing a needed update from the group.

6. Click Next. The Systems page is displayed.
7. Optional: The IBM Flex System Manager is selected by default. Select it and

click Remove if you do not want monitoring of this system.
8. Select at least one system, which must be accessible, and click Add. These

systems will be automatically associated with an update group through
system compliance policies. If a selected system cannot be monitored, an error
message is displayed.

9. Click Next. The Connection page is displayed.
10. Indicate how the Internet is to be accessed to acquire updates:

v Click Use direct connection if a direct Internet connection exists and you
want it used.

v Click Use Proxy server if your proxy server requires authentication. A
proxy can be an HTTP proxy or a Hypertext Transfer Protocol Secure
(HTTPS) proxy, and must be configured and made available by your
organization.
a. Type the host name and port number of the proxy server.
b. Click Authenticate using the following credentials if you want to

access the proxy server with a user ID and password. Type the user ID
and password for the proxy server.
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Note: To acquire updates, the IBM Flex System Manager must have Internet
access. This access can be through a direct connection or through a Hypertext
Transfer Protocol (HTTP) proxy. If a connection is unavailable, updates can be
imported.

11. Optional: Click Test Connection if you want to test the connection settings
that you have specified.

12. Click Next. The Summary page is displayed.
13. This page lists the types of updates that will be added to the update group to

monitor the selected systems, and when a check for updates is run. Verify the
information on this page:
v If the information is correct, click Finish. The common launch-task window

is displayed to schedule an acquire updates for the selected systems.
Schedule this task to run on a recurring basis, not just once.

v If the information is incorrect, click Back to return to previous pages and
correct the information.

14. Specify notification and schedule settings for the task that is being launched.
In addition to launching a check for updates task, the wizard creates an
update group using the default update criteria for the systems that were
selected. A compliance check is created for each selected system to ensure that
it complies with this newly created group.

Updating IBM Flex System Manager
Use Check and Update Flex System Manager on the Initial setup tab in the IBM
Flex System Manager Web interface to automatically obtain and install all types of
updates for IBM Flex System Manager.

Before you begin

Consider these points when updating IBM Flex System Manager:
v If Update Manager fails to acquire the version 1.2.0 updates, run the following

CLI command before you import the updates with the management software
CLI:
smcli cleanupd -mva

After you run the preceding command, compliance policies indicate that all
systems are in compliance because there are no longer any updates in the
library. After you upgrade the management software to version 1.2.0, you must
acquire updates for your compliance policies before the management software
will show needed updates. See cleanupd command for more information about
the command.

v IBM periodically makes UEFI code, IMM2 firmware, diagnostic firmware
updates, and device driver updates available for the management node. Follow
the instructions in the readme file that comes with the firmware update.

v Most update manager methods cannot determine the applicability of updates to
a system unless inventory was previously collected on the system.

v You must restart IBM Flex System Manager to activate installed updates.
v You can use either the web interface or the command-line interface (CLI) to

update firmware and software. See Update commandsor the IBM Flex System
Manager Command Reference Guide document for specific CLI commands related
to updating firmware and software.

v When a hardware component in the management node is replaced, make sure
that the firmware of the new component is up to date. To update the firmware
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for the new hardware component, you must acquire an IBM Flex System
Manager update bundle; then, from the command-line interface, run the
following command
smcli installupd update_bundle_file_name -F

where update_bundle_file_name is the file name of the update bundle that you
downloaded.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To instruct update manager to take most defaults and update IBM Flex System
Manager almost automatically, complete the following steps.

Procedure
1. From the Initial setup tab on the Home page, click Check and Update Flex

System Manager; then, click Update IBM Flex System Manager. When the
acquire updates task completes, the updates needed by the IBM Flex System
Manager are displayed in the table.

Note: If the management node is not connected to the Internet, the update
action will fail.

2. Optional: If your management node does not have a connection to the Internet,
you can download IBM Flex System Manager updates and copy the updates to
the management node.
Find the update package on the Fix Central web site and download it:
a. Go to Fix Central at http://www.ibm.com/support/fixcentral/.
b. From the Product Group list, select PureSystems. The Product list is

displayed.
c. From the Select from PureSystems list, select PureFlex System.
d. From the Select from PureFlex System list, select Management devices and

solutions.
e. From the Management devices and solutions list, select Flex System

Manager Node.
f. Select the machine type for your management node; then, click Continue.

The Installed Version list is displayed.

Note: You can ignore the operating system list.
g. From the Installed Version list, select the version of IBM Flex System

Manager that is currently installed.
h. Select the fix group that you want to download and click Continue. The

Download options page is displayed.
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i. Select the Download using Download Director and Include prerequisites
and corequisite fixes (you can deselect the ones you don't need later)
options, and then click Continue. The Terms and conditions page is
displayed.

j. After you agree to the terms and conditions, the Download files using
Download Director page is displayed.

k. Click Download now to start the download of the update package. The
update package downloads to the designated location.

3. From the management software web interface, install the update or schedule
the update installation.

4. After the installation is complete, restart IBM Flex System Manager to activate
the updates.

Updating without an Internet connection
If the management node does not have an Internet connection, you can manually
download IBM Flex System Manager update packages. After an update package
has been downloaded and extracted, you can use update manager to schedule
when to import and install the updates.

About this task

Procedure
1. Download the necessary fix files from Fix Central. See “Getting fixes from Fix

Central” for more information.
2. Use one of the following methods to copy all of the downloaded update files to

the /home/USERID directory on the management node:
a. Use a Secure Copy (SCP) tool on a laptop or workstation attached to the

management or data network.

Important: Make sure that the SCP tool transfers the files to the
management node in a binary format. If the files are transferred as text, the
transfer process might modify the readme files and corrupt them.

b. Use the scp command in the management software CLI to retrieve the fix
package from an SSH server on the management or data network. See the
following examples. From a management software console, logged in as
USERID:
scp USERID @<remote_host_name>:/directory/* /home/*

From a remote server or workstation:
scp * USERID@<management_node_host_name>:/home/USERID/*

c. Copy the update files from a USB storage device that is formatted for
FAT16, FAT32, ext2, or ext3 file systems.

Note: The maximum file size that is supported by FAT16 is 2 GB; the
maximum for FAT32 is 4 GB. If your update files are larger, format your
USB storage device for the ext2 or ext3 file system.
1) Insert a USB storage device into the USB port on the front of the

management node.
2) SSH to the management node.
3) Log in with the default USERID and password.
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4) Use the lsmediadev command to list the storage media devices that are
available for use on the system and identify the USB storage device. The
resulting output will be similar to the following, where vdi1 is the USB
storage device:
device=/dev/cdrom,mount_point=/media/cdrom,
type=1,description=CD/DVD
device=/dev/vdi1,mount_point=/media/vdi1,
type=3,description=USB flash memory device

5) Type mount /dev/vdi1 and press Enter.
6) Use the command cp to copy the files. For example:

cp /media/vdi1/<file_name> /home/USERID

7) Type umount /dev/vdi1 and press Enter to unmount the USB storage
device.

3. Import and install the updates using either the command line or the IBM Flex
System Manager Web interface:

Command line
Run the following command to import and install the updates:
smcli installneeded -v -F /home/USERID

IBM Flex System Manager Web interface
Complete the following steps to import and install the updates:
a. From the IBM Flex System Manager Web interface Home page, click

Update IBM Flex System Manager.
b. On the Update IBM Flex System Manager page, click Stop to stop

the task that checks for new updates and instead display options for
downloading and importing updates.

c. In the Path field, either type the full local directory path and file
name of the downloaded update package zip file, or click Browse...
to manually search for and locate the file and then have the path
information entered into the field for you.

d. Click Import and Install to run or schedule the import and
installation of the updates.

4. After the installation is complete, restart IBM Flex System Manager to activate
the updates.

Acquiring and installing updates
The information in this section describes how to acquire and install updates with
the management software web interface and command-line interface when the
management node is connected to the Internet. If your management nodes is not
connected to the Internet, use the procedure in this topic to download updates,
import the updates to the management node, and install the updates.

About this task

If you are setting up your IBM Flex System environment for the first time, or if
you need only basic update capabilities, use the update wizards on the Initial
Setup tab on the Home page for basic update operations. For more information
about each update wizard, see Initial Setup for more information.

If you are setting up your IBM Flex System environment for the first time, or if
you need only basic update capabilities, use the update wizards on the Initial
Setup tab on the Home page for basic update operations. For more information
about each update wizard, see Initial Setup for more information.
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You can also configure the management software to notify you of available updates
and to select compliance policy settings for managed resources. See Using the
automated updates wizard for more information.

You can also configure the management software to notify you of available updates
and to select compliance policy settings for managed resources. See Using the
automated updates wizard for more information.

Note: If you are updating IBM Flex System Manager itself, see Updating IBM Flex
System Manager.

To manually download and import updates, complete the following steps:

Procedure
1. Go to Fix Central at http://www.ibm.com/support/fixcentral/.
2. Log on with your IBM user ID and password.

Tip: If you do not currently have an IBM user account, you can obtain one
from https://www.ibm.com/account/profile/us?page=reg.

3. Complete the following steps on the Fix Central page to locate and download
the needed update package:
a. From the Product Group list, select PureSystems. The Product list is

displayed.
b. From the Select from PureSystems list, select PureFlex System.
c. From the Select from PureFlex System list, select Management devices and

solutions.
d. From the Management devices and solutions list, select Flex System

Manager Node.
e. Select the machine type for your management node; then, click Continue.

The Installed Version list is displayed.

Note: You can ignore the operating system list.
f. From the Installed Version list, select the version of IBM Flex System

Manager that is currently installed.

Note: To find the current IBM Flex System Manager version number, from
the Home page, click the Plug-ins tab. The version number (for example,
1.1.0) is displayed beside IBM Flex System Manager.

g. Click Continue. The Select fixes page is displayed.
h. Select the fix group that you want to download and then click Continue.

The Download options page is displayed.
i. Select the Download using Download Director and Include prerequisites

and corequisite fixes (you can deselect the ones you don't need later)
options, and then click Continue. The Terms and conditions page is
displayed.

j. Select I agree if you agree to the terms and conditions. The Download files
using Download Director page is displayed.

k. Click Download now to start the download of the update package. The
update package downloads to the designated location.

4. Use one of the following methods to copy all of the downloaded update files to
the /home/USERID directory on the management node.
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Important: Do not to copy update files to the /tmp directory.
a. Use a Secure Copy (SCP) tool on a laptop or workstation attached to the

management or data network.

Important: Make sure that the SCP tool transfers the files to the
management node in a binary format. If the files are transferred as text, the
transfer process might modify the readme files and corrupt them.

b. Use the scp command in the management software CLI to retrieve the fix
package from an SSH server on the management or data network. See the
following examples. From a management software console, logged in as
USERID:
scp USERID @<remote_host_name>:/directory/* /home/*

From a remote server or workstation:
scp * USERID@<management_node_host_name>:/home/USERID/*

c. Copy the update files from a USB storage device that is formatted for
FAT16, FAT32, ext2, or ext3 file systems.

Note: The maximum file size that is supported by FAT16 is 2 GB; the
maximum for FAT32 is 4 GB. If your update files are larger, format your
USB storage device for the ext2 or ext3 file system.
1) Insert a USB storage device into the USB port on the front of the

management node.
2) SSH to the management node.
3) Log in with the default USERID and password.
4) Use the lsmediadev command to list the storage media devices that are

available for use on the system and identify the USB storage device. The
resulting output will be similar to the following, where vdi1 is the USB
storage device:
device=/dev/cdrom,mount_point=/media/cdrom,type=1,description=CD/DVD
device=/dev/vdi1,mount_point=/media/vdi1,type=3,description=USB flash
memory device

5) Type mount /dev/vdi1 and press Enter.
6) Use the command cp to copy the files. For example:

cp /media/vdi1/<file_name> /home/USERID

7) Type umount /dev/vdi1 and press Enter to unmount the USB storage
device.

5. Import and install the updates using either the command line or the IBM Flex
System Manager Web interface:

Command line
Run the following command to import and install the updates:
smcli installneeded -v -F /home/USERID

IBM Flex System Manager Web interface
Complete the following steps to import and install the updates:
a. From the IBM Flex System Manager Web interface Home page, click

Update IBM Flex System Manager.
b. On the Update IBM Flex System Manager page, click Stop to stop

the task that checks for new updates and instead displays options
for downloading and importing updates.

c. In the Path field, type the full local directory path and file name of
the downloaded update package zip file.
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d. Click Import and Install to run or schedule the import and
installation of the updates.

6. After the installation is complete, restart IBM Flex System Manager to activate
the updates.

Acquiring and installing updates with the IBM Flex System
Manager Web interface

Use the update manager tasks in the IBM Flex System Manager Web interface to
acquire updates, stage your installation, manage update groups, and install
updates on your systems.

Showing needed updates
Use the Show and install updates function to identify updates that are needed by
your systems.

Before you begin

This function does not show information for systems for which you have not
collected inventory.

This function can be used on systems or system groups. If you select a system
group, this task will display only those systems within the group that are in need
of updates.

The list of needed updates is produced by comparing the updates that IBM Flex
System Manager has knowledge of to the inventory on your systems. This task
does not list as needed any update that IBM Flex System Manager does not know
about. An important part of keeping your systems up-to-date is running the Show
needed updates function and reviewing the results.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To see a list of updates needed by a system, complete the following steps:

Procedure
1. From the Update Manager summary page, locate the Updates section.
2. Click Show and install updates. The Show and install updates page is

displayed.
3. Select a system or system group in the Selected systems field. Click Browse to

see a list of systems to choose from.
4. Click Show and install updates. A table of needed updates is displayed.
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5. Examine the table. There is one line for each update and details about the
update.

Notes:

v If you do not see an update that you expected to see, you can view all
updates that are available for installation on a system by selecting Show all
installable updates.

v Certain listed updates, for example UpdateXpress System Pack updates for a
IBM Flex System compute node or chassis, are actually update collections
that contain one or more member updates that are combined into one
installable image. To view the member updates within the update collection,
right-click on the update collection and select “Update”. For more
information, see your product documentation.

What to do next

Update tasks such as Install can be done from this page by clicking Actions and
selecting an available task.

Showing all installable updates
Use the Show all installable updates function to identify all updates that are
available for installation on your systems.

Before you begin

This function does not show information for systems for which you have not
collected inventory.

This function can be used on systems or system groups. If you select a system
group, this task will display only those systems within the group that have
updates that are available for installation.

The list of all installable updates is produced by comparing the updates that IBM
Flex System Manager has knowledge of to the inventory on your systems. This
task does not list as installable any update that IBM Flex System Manager does not
know about.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To see a list of all updates that are available for installation on a system, complete
the following steps:

Procedure
1. From the Update Manager summary page, locate the Updates section.
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2. Click Show and install updates. The Show and install updates page is
displayed.

3. From the Show and install updates page, click Show all installable updates.
The Show All Installable Updates page is displayed.

4. Examine the table. There is one line for each update and details about the
update.

What to do next

Update tasks such as Install can be done from this page by clicking Actions and
selecting an available task.

Showing installed updates
Use the Show installed updates function to determine which updates are installed
on a particular system. This task shows those updates that were installed by IBM
Flex System Manager. Updates installed by other means are not displayed.

Before you begin

This function does not show information for systems whose inventory you have
not collected.

Update tasks such as Uninstall can be done from this page by clicking Actions and
selecting an available task.

To change which update properties are displayed on the table, their position in the
table, or the field sizes, click Actions > Columns.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To see a list of updates installed on a particular system, complete the following
steps:

Procedure
1. From the Update Manager summary page, click Show installed updates. The

Show Installed Updates page is displayed.
2. Select a system or system group in the Selected systems field. Click Browse to

see a list of systems to choose from.
3. Click Show Installed Updates. A table of installed updates is displayed.
4. Examine the table. There is one line for each update and details about the

update.
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Checking for new updates
Use the Acquire updates task to periodically load new updates into update
manager. Schedule a check for updates task to run frequently, at least once a week.

Before you begin

Note: To check for updates, the IBM Flex System Manager must have Internet
access. This access can be through a direct connection or through a Hypertext
Transfer Protocol (HTTP) proxy. If a connection is unavailable, updates can be
imported.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To check for new updates, complete the following steps:

Procedure
1. Select Acquire updates from the Updates section of the Update Manager

summary page. The Acquire updates page is displayed.
2. Select the option to check for new updates.
3. Optional: Click Remove to remove any entries that have been selected in

error.
4. Click OK. A scheduling task is displayed
5. Optional: Type a job name.
6. Choose when to run the job:
v Click Run Now to run the job right away.
v Click Schedule and choose a date and time for the check for updates, as

well as the Repeat Options for running the task.
You are advised to schedule a repeating task, because it ensures that you
are aware of new updates as they become available. You are also advised to
choose a time when system load is light, so that the job will complete
quickly.

7. Click Notifications and enter notification options.
8. Click Options and enter other options.
9. Click OK.

10. If any new updates are found, update manager will be automatically made
aware of them. Examine any static update groups that you have created to see
if the new updates must be added.
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What to do next

This is an alternative, system-based approach. Go to the Resource Explorer area
and select a system or system group. Click Actions > Release Management >
Acquire Updates. This will scope the check for updates to just that type of system
or systems in the group.

Downloading updates
While the download of updates happens automatically as needed, you might want
to download updates when it is most convenient for your network, and to ensure
that the updates are available at the time of installation.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

You can choose to download the installable files for the update to the management
server if you have interest in installing the update, and want to make the
installation process run faster when it is scheduled. Downloading the updates
ahead of installation ensures that the valuable time allocated for system
maintenance (when typically systems are not available to the users) is not spent on
tasks such as downloading, which does not require exclusive system access.

You are not required to run the download task. If the installable files for the
update have not been downloaded when the installation task is scheduled, the
download task is automatically be invoked before the installation task.

It is important to note that the membership of an update group is not resolved at
the time that a task using the groups is scheduled. The membership of the update
group is resolved at the time that the task runs.

To download updates, complete the following steps:

Procedure
1. From any panel where a list of updates is present, click Actions > Download.
2. You will see a summary panel explaining which updates are to be downloaded

to the management server. Click OK.
3. The task scheduler is displayed. Choose to either run the download now or

schedule it for later.
4. When the download task is used on a selection of updates that must be

manually downloaded, a message is issued stating that not all the updates can
be automatically downloaded. You can click Download manually to display
the manual download page. Follow the instructions on that page to complete
this process.
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Downloading manual updates:

Some updates must be downloaded manually. An example of an update that
requires a manual download is an update that requires a licensing agreement.

Before you begin

There might be some updates that cannot be automatically downloaded due to
licensing restrictions. In this case, the downloaded column for the update will
contain the text No, manual download. When you try to download this type of
update, you will see instructions for a manual download.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

When you select the download task on an update menu, a panel is displayed to
guide you through visiting the appropriate Web site, downloading the update, and
then copying the installable files for the update.

To perform a manual download of an update, complete the following steps:

Procedure

1. From the update menu page, select Actions > Download. A panel with
instructions for each manual download is displayed.

2. Select one update and click Actions > Download. This launches a Web browser
to the appropriate Web site for downloading the installable files for the update.

3. If a licensing agreement is displayed, read it and any other information
presented to you. Accept the licensing agreement if you want to continue.

4. The download retrieves the installable files for the update. Make a note of their
location.

5. Close the browser for the download link. You will return to the Download
Updates page.

6. Put the location of the update installable files (from Step 4) in the Files to
import field.

7. Optional: Click Browse to browse the directory.
8. Repeat this step for each update that requires a manual download.
9. Click OK to import the updates you have downloaded.

What to do next

After an update has been manually downloaded, it can be managed the same way
as any other update.
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Importing updates
There are multiple methods that you can use to import updates and install them.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To import updates, complete the following steps:

Procedure
1. Use one of the following methods to copy all of the downloaded update files to

the /home/USERID directory on the management node:
a. Use a Secure Copy (SCP) tool on a laptop or workstation attached to the

management or data network.

Important: Make sure that the SCP tool transfers the files to the
management node in a binary format. If the files are transferred as text, the
transfer process might modify the readme files and corrupt them.

b. Use the scp command in the management software CLI to retrieve the fix
package from an SSH server on the management or data network. See the
following examples. From a management software console, logged in as
USERID:
scp USERID @<remote_host_name>:/directory/* /home/*

From a remote server or workstation:
scp * USERID@<management_node_host_name>:/home/USERID/*

c. Copy the update files from a USB storage device that is formatted for
FAT16, FAT32, ext2, or ext3 file systems.

Note: The maximum file size that is supported by FAT16 is 2 GB; the
maximum for FAT32 is 4 GB. If your update files are larger, format your
USB storage device for the ext2 or ext3 file system.
1) Insert a USB storage device into the USB port on the front of the

management node.
2) SSH to the management node.
3) Log in with the default USERID and password.
4) Use the lsmediadev command to list the storage media devices that are

available for use on the system and identify the USB storage device. The
resulting output will be similar to the following, where vdi1 is the USB
storage device:
device=/dev/cdrom,mount_point=/media/cdrom,type=1,description=CD/DVD
device=/dev/vdi1,mount_point=/media/vdi1,type=3,description=USB flash
memory device

5) Type mount /dev/vdi1 and press Enter.
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6) Use the command cp to copy the files. For example:
cp /media/vdi1/<file_name> /home/USERID

7) Type umount /dev/vdi1 and press Enter to unmount the USB storage
device.

2. Import and install the updates using either the command line or the IBM Flex
System Manager Web interface:

Command line
Run the following command to import and install the updates:
smcli installneeded -v -F /home/USERID

IBM Flex System Manager Web interface
Complete the following steps to import and install the updates:
a. From the IBM Flex System Manager Web interface Home page, click

Update IBM Flex System Manager.
b. On the Update IBM Flex System Manager page, click Stop to stop

the task that checks for new updates and instead displays options
for downloading and importing updates.

c. In the Path field, type the full local directory path and file name of
the downloaded update package zip file.

d. Click Import and Install to run or schedule the import and
installation of the updates.

3. After the installation is complete, restart IBM Flex System Manager to activate
the updates.

Exporting updates
Use the Export function to copy updates from the update library to a target
directory on the management server. The target directory must be accessible to the
management server.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To export updates, complete these steps:

Procedure
1. From any list of updates, select the ones that you want to export.
2. Click Actions > Export updates.
3. Specify a location for the update files by typing or browsing for the path name

on the management server in the Path field.
4. Click OK. The scheduler is displayed. You can then choose to run the task now

or schedule it to run in the future.

180 Systems Management Guide



Installation staging
Use installation staging to copy the files that comprise an update to an appropriate
location for eventual installation. That location might not be the system that the
update is to be installed on. This task is not required. If you skip this step, the
update is staged when it is needed. This task is provided to save time during
installation maintenance windows, in order to minimize system downtime and
unavailability.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

The task of installation staging is accomplished by running the Installation staging
wizard on an update. The Installation staging wizard guides you through the task
of copying the installable files for an update from the management server to an
appropriate location for eventual installation.

If the installable files for an update have not been previously downloaded, a
download is run before the installation staging is performed.

It is important to note that the membership of an update group is not resolved at
the time that a task using the group is scheduled. The membership of the update
group is resolved at the time that the task runs.

To perform an installation staging for an update, complete the following steps:

Procedure
1. Click Actions > Installation staging on the menus for an update or update

group. The page of the Installation staging wizard is displayed.
2. Clear the Show this welcome page next time box if you do not want to see

the Welcome page again.
3. Click Next. The Updates page is displayed. The Updates page is skipped if

the Installation staging wizard was invoked from an update or update group.
In this case, proceed to Step 5.

4. Select each update that you want. If an update that is part of an update
collection is chosen, a warning is issued because it is advisable to install the
update collection as a whole.

5. If you select updates that require a manual download, these updates cannot
be staged until you manually download them. The Downloads required panel
will be displayed.
a. Click Details to manually download updates.
b. Click Continue, the updates are now downloaded and ready when you

have completed the manual download.
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c. Click Skip the updates which must be manually downloaded if you do
not want to manually download these updates, or the process has failed
for one or more of them. Those updates will be removed from the list and
will not be staged.

d. Click Next The Systems page is displayed.
6. You can stage updates for installation by selecting the systems or system

groups that the updates are to be installed on. Select the system or system
group name and click Add

Be aware that if you selected system groups, the list of individual systems in
these groups is not determined until the task runs. You are presented options
only for those systems that were individually selected. Group membership is
not determined until the task runs.

7. If some of the updates are for AIX or IBM BladeCenter systems, and you had
not already specified the necessary AIX or IBM BladeCenter options on the
Settings page, it is displayed so that you can choose these options.

8. Click Next. The Options page is displayed.
9. If you do not want updates that are required for the installation of the

selected updates to also be staged for installation, clear Automatically stage
missing required updates. Clearing this box is not advised. Missing
mandatory updates will cause the installation task to fail.

10. A table of the known update requirements for each selected update is
displayed.
a. Select a system from the list of systems to see its update requirements.
b. Review the required updates that will be installed when Automatically

stage missing required updates is selected. You cannot edit the required
updates here.

11. Click Next. The Summary page is displayed.
12. Review the information on this page.

v If it is correct, click Finish. A panel is displayed for you to specify
notification and schedule settings for the installation staging task being
launched by this wizard.

v If some information is incorrect, click Back to go to previous pages and
correct the information, or click Cancel to cancel the entire process.

Results

After the installation staging task completes, the updates are staged in the
following locations:
v When staging to AIX, IBM i, and Linux systems, updates are staged to

/tmp/updatemanager/staging in all cases.
v When staging to Windows systems, updates are usually staged to

TEMP\updatemanager\staging, where TEMP usually resolves to C:\WINDOWS\TEMP
but can change depending on the resource type to which you are staging.

Note: To ensure that updates are staged to the Windows TEMP directory, specify
RELOAD_STAGING_LOCATION=true in the install_path\IBM\Director\lwi\
runtime\core\workspace\.metadata\.plugins\
com.ibm.director.mgr.updates.server\update.properties file.

To determine the exact staging path for a particular system, see the related entry in
the job log. To verify that the path has sufficient space, explicitly stage an update
to the target system and then verify the staging at that path.
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Viewing information about updates
Information about updates and updates groups is often needed to decide whether
to install the update.

The update topology perspective:

The Updates topology perspective displays a topology view tailored to the
system's update-related resources.

From any place within update manager where you can display a system, click
Actions > Topology Perspectives.

By default, a topology perspective contains all resources related to the system. The
Updates perspective limits the resource types to update-related resources that are
installed on, needed by, or applicable to the system. The following resources types
are included in the Updates perspective:
v systems
v updates
v update collections

Click the displayed resources to see the relationships displayed in the Properties
table.

Relationships for updates and update collections:

Update relationships indicate how an update relates to other updates and target
systems. The Topology view is a good way to illustrate update relationships.

This is a list of all update relationships. To simplify this discussion, the term
'update' refers to either an individual update or an update collection, unless
otherwise noted.

appliesTo
Indicates systems that an update can be installed on at this time. You can
view updates that can be installed on a system by navigating the appliesTo
relationship from the system's Related Resources submenu.

federates
Specifies the individual updates that are contained in an update collection.

installedOn
Indicates systems where the update is currently installed. You can view
where a specific update is installed by following the installedOn
relationship from the update's context menu.

This displays the systems where the update is installed using a table view.

This table view can be switched to a topology map to display a graphical
layout instead of a topology. In the topology map, the installed on
relationships between the updates and the systems are displayed.

needs Indicates updates that a system needs.

Several updates might applyTo a system, but the system might only need
one of those updates. An example is the situation where one update
supersedes another.

You can see where an update is needed for installation by following its
needs relationship using the resource navigator.
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When an update is acquired, the needs and appliesTo relationships for the
update and affected systems are automatically synchronized so that the
new update can be properly managed, and compliance policies remain
accurate.

This table view can be switched to a topology map to display a graphical
layout instead of a topology. In the topology map, the needs relationships
between the updates and the systems are displayed.

requires
Indicates that this update requires another update to be installed.

supersedes
Indicates that this update supersedes another update, meaning that the
other update is not needed if this one is installed.

Viewing properties, documentation, requirements, and other details for an
update:

You can obtain details about an update, such as general properties, installation
requirements, installable files, and documentation.

Before you begin

If an update has not been downloaded and you attempt to view the contents of an
associated documentation file, the download task will be run so that the files can
be read.

About this task

To view properties and documentation for an update, complete the following steps:

Procedure

1. From any place where an update is displayed, click the update name. A page of
general information about the update is displayed, including: name, ID, size,
version, and so on.

2. Click the General tab to see general information about the update.
In this list, the term 'update' is used to refer to an update or update group.

Note: Certain listed updates, for example UpdateXpress System Pack updates
for a IBM Flex System compute node or chassis, are actually update collections
that contain one or more member updates that are combined into one
installable image. To view the member updates within the update collection,
right-click on the update collection and select “Update”. For more information,
see your product documentation.

Name The name of the update.

Description
A description of the update.

Acquired Date
The date that this update was acquired by update manager.

Build Date
The date that the update was built. An example is the date that the
source for the update was compiled.
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Build Number
The build number of the update.

Category
The category of update.

Downloaded
Whether the update has been downloaded to the management server.

Filenames
The names of the files for the update.

Package Type
The package type of the update.

Platform
The hardware platform that the update applies to.

Product
The name of the product that the update applies to.

Restart Type
Whether a restart is required when the update is installed or
uninstalled, and what type of restart is required.

The exact wizard options that are displayed vary, depending on the
type of resource that is being updated. These are some of the possible
values:

Restart immediately after update is installed
The restart must be performed before other updates can be
installed or uninstalled.

Restart after all updates are installed
The restart can be performed at the end of the install or
uninstall task.

None There is no restart indicated for the system or resource.

Severity

The severity of the update is one of the following values:
v Critical
v High
v Normal
v Low
v Not Applicable

Note: The designated severity levels of X-Architecture compute node
updates can dynamically change depending on the updates that are
already installed on the system. For example, if no previous versions of
an update exist on a system, the current version of the update might
have a higher level of severity than it would if a previous version of
the update existed.

Software ID
A character string or value that identifies the software or firmware that
needs the update.

Superseded
Whether this update has been superseded by another.
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Total Size
The total size of all the update's files.

Uninstallable
Whether the update can be uninstalled.

Update ID
A unique identifier for the update.

Update Type
Whether the update is an individual update or an update collection.

Vendor
The manufacturer of the update.

Version
The software or firmware version that the update applies to.

3. Click the Documentation tab. A page of documentation files is displayed. Some
updates might not have documentation files.

4. Click the Requirements tab. A page of requirements that must be met in order
for the update to be installed is displayed. The type of information depends on
which software component is being updated, such as applicable operating
systems and levels.

5. Close this page by clicking the X on the page tab.

Searching update documentation:

If there is a specific area of concern or detail that you are looking for, searching
update documentation can point you to the updates that you are most interested
in.

Before you begin

Only the latest documentation for an update in its supersede chain is displayed. If
you have a situation where update A supersedes update B, the documentation for
update A is displayed rather than the documentation for update B, since update A
is the most recent update in the supersede chain.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

The Update Manager summary page contains a search field that searches the
documentation files of updates that are available for management. The search is
limited to updates that have been downloaded to the management server. For each
update, only those files that are human readable are available for searching.

To search update documentation, complete the following steps:
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Procedure

1. From the Update Manager summary page, locate the Search section.
2. In the Search local updates field, type the terms you want to search for.
3. Click Search. Search results are displayed in a separate table, sorted by

closeness to the search terms. Search results are not case-sensitive.
4. Optional: You can do various tasks from the search results page, such as

installing an update, viewing the properties, or adding it to an update group.
5. If you do not find what you are looking for, perform a check for updates to

ensure that you have all the most recent updates.

Example

You can use operators in your searches to obtain more accurate search results. Here
are examples of the supported search operators and their meanings:

Linux Matches anything that contains Linux.

Linux*
Matches anything that begins with Linux.

Linux server
Matches anything that contains either Linux or server or both.

Linux OR server
Same as Linux server.

+Linux +server
Matches anything that contains both Linux and server.

Linux AND server
Same as +Linux +server.

+Linux -Blade
Matches anything that contains Linux and does not contain Blade.

clock~ Matches anything like clock, such as block, click, clocks, and so on.

(Linux OR server) AND Blade
Matches anything that contains Blade and also contains Linux or server or
both.

"Issues and Recommendations"
Matches anything with the exact phrase 'Issues and Recommendations'.

Viewing required updates:

When preparing to install an update, it might be necessary to first install another
update on a given system. These updates are called required updates or requisite
updates.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:
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You can view the updates required by an update by navigating the requires
relationship on the update menu. The requires relationship navigation will display
the updates required by the currently selected update. The updates are displayed
in a navigator table view.

This table view can be switched by the user to a topology map to display a
graphical layout instead of a table. In the topology map, the required relationships
between the updates are displayed.

To view the required updates for a specific update, complete the following steps:

Procedure

1. From any list of updates, select the update whose required updates you want
to display.

2. Click Actions > Related Resources > Needed Updates. A table of the needed
updates is displayed.

Viewing the contents of update collections:

An update collection is an update that contains other updates, such as a service
pack. They can be managed as a single unit, just like an individual update.

Before you begin

To determine if an update is a collection or an individual update, from any table
where a list of updates is displayed, view the Update Types field. A value of
'Collection' indicates that the update is an update collection. A value of 'Individual'
indicates that the update is not a collection, but an individual update.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To view update collections, complete the following steps:

Procedure

1. From any list of updates, select an update collection.
2. Click Actions > Related Resources > Updates. A table of the member updates

is displayed.
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What to do next

Although you can view the member updates in an update collection, you are
advised not to install these individual members separately. Instead, install the
entire update collection.

Viewing the supersede relationships for an update:

One update supersedes another if installation of the one update will make the
other no longer needed.

About this task

The concept of supersede can be explained by this example. UpdateA supersedes
UpdateB if UpdateA contains all the information in UpdateB, or installing
UpdateA creates a situation where UpdateB is not needed. UpdateA can be said to
supersede UpdateB or be a supersede of UpdateB. UpdateB can be said to be
superseded by UpdateA.

You can see the updates that are superseded by a given update by selecting
supersedes on the Related Resources submenu at the top of the update menu. It is
possible that an update does not supersede any other. It is also possible that an
update is not superseded by any other

This table view can be switched by the user to a topology map to display a
graphical layout instead of a table. In the topology map, the superseded
relationships between the updates are displayed.

Viewing parent update collections:

For a given update, a parent update collection is an update collection that contains
this update, as well as possibly others. Not all updates will have a parent update
collection.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

Parent update collections are updates themselves, and can be installed as an
update. These are similar in concept to service packs.

To view update collections, complete the following steps:

Procedure

1. From any list of updates, select an update whose parent update collection you
want to view.
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2. Click Actions > Related Resources > Update Collection. The update collection
that contains this update is displayed.

What to do next

Although you can view the member updates in an update collection, you are
advised not to install these individual members separately. Install the entire update
collection.

Managing update groups
You can group updates to form an update group, which can then be managed as if it
were an individual update. The use of update groups can save time and limit the
complexity of the update tasks.

Update groups:

Update groups can be static or dynamic. Both types can be used in compliance
policies.

Static update groups
Contain individual updates that were explicitly chosen. Once established,
the membership changes only when you manually add or delete updates.
Static update groups can be used as a baseline for future comparison or
update deployment.

Dynamic update groups
Automatically contains updates based on selected update types. The
membership of this group changes as update information changes.

It is important to note that the membership of an update group is not resolved at
the time that a task using the group is scheduled. The membership of the update
group is resolved at the time that the task runs.

If you add a system group or an update group to an existing system group or
update group, this new, nested group will not be considered when the parent
system or update group is used for validation of compliance policies.

Viewing update groups:

It is advisable to view the individual members of an update group so that you are
aware of the updates that are being used for compliance policies.

Before you begin

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:
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To view an update group, complete the following steps:

Procedure

1. From the Update Manager summary page, click Show update groups. A table
of all defined update groups is displayed. This table shows all the update
groups in the group named Update Groups.

2. Click the name of the update group that you want to view. The members of the
group are displayed in a list.

Creating update groups:

Although there are predefined update groups, you might want to create and
manage update groups for your unique systems and their software.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To create an update group, complete the following steps:

Procedure

1. From the Resource Navigator, click Create Group. The Group Editor wizard is
displayed.

2. If the Welcome page is displayed, click Next. The Name page is displayed.
3. Type a name and description for the new group and click Next. The Type and

Location page is displayed.
4. Select a Member type of Update.
5. In the Group type field, choose either a Static or Dynamic update group. The

Define page is displayed.
6. Select group members:
v If the group type is Static, select the individual updates and update collection

and click Add to move them to the Selected column.
v If the group type is Dynamic, select the types of updates and click Add to

move them to the Selected column. These values are like those on the
Acquire Updates page.

7. Click Next. The Summary page is displayed.
8. Review the choices for the new group carefully.
v If your choices are correct, click Finish to create the update group.
v If you want to change your choices, click Back to go to the previous page, or

choose the Group Editor wizard page from the navigation area.
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Installing updates on systems
Use the Install wizard to install updates on systems or groups of systems. If you
choose to install updates that have not been downloaded or staged for installation,
these tasks will be automatically performed as part of the installation task.

Before you begin

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

Note: The installation of updates on IBM i (formerly i5/OS) systems requires a
single sign-on credential that maps an IBM Flex System Manager Web interface
user to an IBM i user ID.
v For instructions to create credentials, see “Creating single sign-on credentials”.
v For more informations about credentials, see “Managing single sign-on

credentials”.

Tip: To protect your system in the event of an unforeseen complication, ensure
that you back up your data before performing any update tasks.

About this task

To install updates, complete the following steps:

Procedure
1. From the Update Manager summary page, locate the Updates section.
2. Click Show and Install Updates. The Show and Install Updates page is

displayed.
3. Select a system or system group in the Selected systems field. Click Browse

to see a list of systems to choose from.
4. Click Show and install updates. A table of needed updates is displayed.
5. Select each update that you want to install. Whole update collections, not

individual member updates, will be installed.
6. Click Install. The Install wizard Welcome page is displayed.
7. Clear Show this welcome page next time if you do not want to see the

Welcome page next time.
8. Click Next The Systems page is displayed.
9. Click Next.

10. Optional: If you select updates that require a manual download, and this has
not already been done, you must manually download them. The Downloads
required page is displayed.
a. Click Details to perform the manual download.
b. Click Continue, the updates are now downloaded and ready when you

have completed the manual download.
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c. Click Skip the updates which must be manually downloaded if you do
not want to download these updates, or the manual download process has
failed for one or more of them.

11. Click Next.
12. Optional: The Manual Installation Required page will be displayed if a

selected update must be manually installed by the user.
a. Click View under the Installation Instructions heading to see the manual

installation instructions.
b. Read the instructions and decide to install the updates now or later.

Updates that require manual installation will be removed from the list of
selected updates. If all the selected updates require manual installation, you
cannot continue; Next will be disabled.

13. Click Next. The Restarts page is displayed. All selected systems are displayed
in the table even if they do not require a restart. For each system, the highest
restart impact is listed. The systems are sorted in this table with those of
highest restart impact listed first.

14. Automatically restart as needed during installation is selected by default.
Clear this box if you do not accept the restart requirements. If you clear the
Automatically restart as needed during installation box and updates are
installed that have pending restarts, then the installation task will complete
with errors and some update installs might not be attempted if a dependent
update requires an immediate restart.

15. Click Yes in the Restarts Required column for a system to view all updates to
be installed on the system and their individual restart requirements. This view
is specific to the selected system. It shows all the updates that will be installed
on that system and the restart value for each. You cannot change the
information on this page. If you do not accept the restart requirement, click
OK to return to the Install wizard, click Back, and then remove systems or
updates.
If you have selected system groups as the target for the update installation,
the list of individual systems in these groups is not determined until the task
runs. You are presented options only for those systems that were individually
selected. Group membership is not determined until the task runs.
The exact wizard options that are displayed vary, depending on the type of
resource that is being updated. These are some of the possible values:

Restart immediately after update is installed
The restart must be performed before other updates can be installed
or uninstalled.

Restart after all updates are installed
The restart can be performed at the end of the install or uninstall task.

None There is no restart indicated for the system or resource.
16. Click Next. The Summary page is displayed.
17. Review the information on this page.

v If it is correct, click Finish. A panel is displayed for you to specify
notification and schedule settings for the installation task.

v If some information is incorrect, click Back to go to previous pages and
correct the information, or click Cancel to cancel the entire process.
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Results

Managing single sign-on credentials:

Use IBM Flex System Manager to manage single sign-on shared credentials for the
selected system. These credentials are mapped from specific user credentials on
that system to IBM Flex System Manager Web interface users.

Before you begin

Ensure that you have the correct authorization to access the resource and its access
points.

About this task

Like other shared credentials, single sign-on credentials are those credentials that
exist in an authentication registry that is not specific to an access point. This
enables the credentials to be reused to access multiple console access points and
systems. These credentials must be of type user ID/password. After the credentials
are configured, the IBM Flex System Manager can use them to launch user
interfaces that are hosted on the selected system.

Creating single sign-on credentials:

Use the Create and Edit Single Sign-On Credentials wizard to create single sign-on
shared credentials for the selected system.

About this task

Single sign-on credentials map user credentials on the selected system to specified
IBM Flex System Manager Web interface users. To create a single sign-on credential
for a console access point on the selected system, complete the following steps:

Procedure

1. In the IBM Flex System Manager Web interface navigation area, click Resource
Explorer > group name > system name.

2. Click Actions > Security > Configure Single Sign-On Credentials. The
Configure Single Sign-On Credentials page is displayed.

3. Click a remote-service console access point. The credentials associated with
that access point are listed.

4. Click Create. The Create and Edit Single Sign-On Credentials wizard is
displayed.

Notes:

v If the Create button is disabled, all credential mappings that you have the
authority to create have been created for the configured authentication
registry on the selected system. A credential mapping can be created only
for those Web interface users who have logged in to IBM Flex System
Manager at least once. Existing credential mappings can still be edited or
deleted.

v If the Create button is unavailable, the selected console access point is on
the IBM Flex System Manager. Single sign-on credentials for these access
points can only be displayed. You cannot create or edit these credentials
because they are automatically created when Web interface users log in to
IBM Flex System Manager.
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5. From the Authentication Registry Type list, select the type of authentication
registry that you want to create.

Note: If an authentication registry has already been configured for the
selected console access point, the value for the authentication registry type
cannot be changed. It is set to the previously configured authentication
registry type for the access point.
The three authentication registry types are as follows:

Local OS
Authenticates user login requests with the local operating system of
the target system. The target system must have a corresponding user
account in the operating-system registry.

LDAP Authenticates user login requests with a Lightweight Directory Access
Protocol (LDAP) server. Ensure that the LDAP server is configured in
your environment and available to the target system.

Domain
Authenticates user login requests with a specific domain server.
Ensure that the domain server is configured in your environment and
available to the target system.

6. Enter the appropriate user ID and password for the system. If you are creating
a credential for a resource that has defined a specific user ID that must be
used when authenticating, you cannot change the value in the User ID field.

7. Click Next. The “Assign to IBM Flex System Manager User” page is
displayed.

Note: This page lists only Web interface users who have logged in to IBM
Flex System Manager. These users must log in at least once before a credential
mapping can be created.

8. Select the IBM Flex System Manager Web interface user for whom the single
sign-on credential is being created. You can use the current user or choose
another user from the table.

Remember: Only one mapping can be created for each of the users on this
page.

9. Click Next. The Summary page is displayed.
10. Click Finish. The credentials are automatically used to authenticate to the

selected console access point on the system.

What to do next

Repeat the credential creation process for other console access points you plan to
access.

Editing single sign-on credentials:

Use the Create and Edit Single Sign-On Credentials wizard to edit single sign-on
shared credentials.

About this task

To edit a single sign-on credential, complete the following steps:
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Procedure

1. In the IBM Flex System Manager Web interface navigation area, click Resource
Explorer > group name > system name.

2. Click Actions > Security > Configure Single Sign-On Credentials. The
Configure Single Sign-On Credentials page is displayed.

3. Click a remote-service console access point. The credentials associated with that
access point for the configured authentication registry are listed.

4. Select the credential that you want to edit.
5. Click Edit.

Note: If the Edit button is unavailable, the selected console access point is on
the IBM Flex System Manager. Single sign-on credentials for these access points
can only be displayed. You cannot create or edit these credentials because they
are automatically created when Web interface users log in to IBM Flex System
Manager.
The Create and Edit Single Sign-On Credentials wizard is displayed.

6. If the Welcome page is displayed, click Next. The Create Single Sign-On
Credential page is displayed.

7. Change the details that are available for changing.
8. Click Next. The Summary page is displayed.
9. Click Finish.

Deleting single sign-on credentials:

Use the Configure Single Sign-On Credentials page to delete single sign-on shared
credentials that are no longer needed.

Before you begin

If you have created any automated tasks in IBM Flex System Manager, ensure that
you check the systems that are the targets of those tasks and the credentials that
are used to log in to those systems. Some tasks might be configured to use a set of
credentials to accomplish the procedures in the task. Deleting the set of credentials
that are used by one of these automated tasks will prevent the task from accessing
targeted systems that are secured.

Note: You will not receive a warning when deleting a credential that is associated
with an automated tasks, and the task will no longer be able to access the system.

About this task

To delete a single sign-on credential, complete the following steps:

Procedure

1. In the IBM Flex System Manager Web interface navigation area, click Resource
Explorer > group name > system name.

2. Click Actions > Security > Configure Single Sign-On Credentials. The
Configure Single Sign-On Credentials page is displayed.

3. Click a console access point. The credentials associated with that access point
are listed.

4. Select the credential that you want to delete.
5. Click Delete. A confirmation message is displayed.
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6. Click OK.

Removing update files
When an update is no longer needed, you can remove its associated installable
files to save space.

Before you begin

If an update has not been downloaded, this task is not available. This task removes
the installable files for an update, but descriptive information about the update is
not removed. When this task completes, the update remains known to update
manager and is treated like any other update.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To remove the installable files from an update, complete these steps:

Procedure
1. From any page where a list of updates is present, select the updates whose files

you want to delete.
2. Click Actions > Delete files.
3. Click Yes in the verification window to confirm the removal of the files.

What to do next

To remove all information about an update, use the smcli cleanupd -am command.

Uninstalling updates
It might be necessary to remove an update from a system or group of systems. Use
the Uninstall updates task to do this. Not all updates support the uninstall task.
For updates that cannot be uninstalled, it might be possible to roll them back to an
earlier version by installing an older version on top of the current one.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:
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To uninstall updates, complete the following steps:

Procedure
1. From the Update Manager summary page, click Show installed updates. The

Show Installed Updates page is displayed.
2. Select a system or system group in the Selected systems field. Click Browse to

see a list of systems to choose from.
3. Click Show installed updates. A table of installed updates is displayed.
4. Select each update that you want to uninstall.
5. Click Uninstall updates. The Uninstall wizard Welcome page is displayed.
6. Clear Show this welcome page next time if you do not want to see the

Welcome page next time.
7. Click Next. The Updates page is displayed.
8. Select each update that you want to uninstall and click Add.
9. Click Next. The Systems page is displayed.

10. Select each system or system group from which you want to uninstall the
updates and click Add. All selected updates that are installed on these
systems will be uninstalled. If you select a system group, the updates are
uninstalled from those systems that are a member of the group at the time the
uninstallation task runs.

11. If some of the updates are for AIX systems, and you had not already specified
the necessary AIX options on the Settings page, it is displayed so that you can
choose these options.

12. Click Next.
13. Optional: The Manual Uninstall Required page might be displayed. It is

displayed only when an update selected for uninstallation must be manually
removed.
a. Click View under the Uninstallation Instructions heading to see the

manual instructions for each update to be uninstalled.
b. Read the instructions and decide to run them now or later.

14. Click Next. The Restarts page is displayed. All selected systems are displayed
in the table even if they do not require a restart. For each system, the highest
restart impact is listed. The systems are sorted in this table with those of
highest restart impact listed first.

15. Automatically restart as needed during installation is selected by default.
Clear this box if you do not accept the restart requirements. If you clear the
Automatically restart as needed during installation box and updates are
uninstalled that have pending restarts, then the uninstallation task will
complete with errors and some uninstalls might not be attempted if a
dependent update requires an immediate restart.

16. Click Yes in the Restarts Required column for a system to view all updates to
be uninstalled on the system and their individual restart requirements. This
view is specific to the selected system. It shows all the updates that will be
uninstalled on that system and the restart value for each. You cannot change
the information on this page. If you do not accept the restart requirement,
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click OK to return to the Uninstall wizard, click Back, and then remove
systems or updates. If you have selected system groups as the target for the
uninstallation task, the list of individual systems in these groups is not
determined until the task runs. You are presented options only for those
systems that were individually selected. Group membership is not determined
until the task runs.
The exact wizard options that are displayed vary, depending on the type of
resource that is being updated. These are some of the possible values:

Restart immediately after update is installed
The restart must be performed before other updates can be installed
or uninstalled.

Restart after all updates are installed
The restart can be performed at the end of the install or uninstall task.

None There is no restart indicated for the system or resource.
17. Click Next. The Summary page is displayed.
18. Review the information on this page.

v If the information is correct, click Finish. A panel is displayed for you to
specify notification and schedule settings for the task being launched by
this wizard.

v If some information is incorrect, click Back to go to previous pages and
correct the information, or click Cancel to cancel the entire process.

What to do next

If an update cannot be uninstalled, it might be possible to roll back the installed
update by installing an older version of the update. The older update can be
installed if the older update is applicable to the system.

Acquiring and installing updates with the installneeded
command

Use this alternate update method if you want to use the command line to specify
some options and then let update manager automatically obtain and install all
types of updates for IBM Flex System Manager.

About this task

You can use the installneeded command line tool to simply update IBM Flex
System Manager servers and agents, or you can add optional parameters to install
other update types. The tool performs the entire update process from beginning to
end with a single command. The basic flow consists of collecting inventory on the
target system, acquiring updates, running compliance, installing needed updates,
then running inventory and compliance again.

This topic describes several high-level uses for the installneeded command. See
the installneeded command topic for more detailed information.

Procedure
v To update IBM Flex System Manager from the FSP, issue the following

command:
smcli installneeded -v -F
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This command will use the server on which it is run as the target. It will
automatically acquire IBM Flex System Manager updates from the FSP and
install them. The -v option specifies “verbose” and is useful for tracking
progress or seeing problems. The -F option specifies “force”, without which the
command will ask for confirmation before installing each update.
The following options and operands are also useful when updating IBM Flex
System Manager:

-I Installs updates that are already in the updates repository. For example:
smcli installneeded -v -I

import_path
Installs updates after you import them from the supplied path. For
example:
smcli installneeded -v c:\dirupdates

See the installneeded command topic for more detailed information about these
options and operands.

v To update Common Agent or Platform Agent with the latest update level from
the FSP, complete the following steps from an IBM Flex System Manager server:
1. Issue the following command to determine the OID of the system:

smcli lssys -o

The output will resemble this example:

netvj165, 0xa98
netvj165.vrow.netfinity.com, 0xa39

2. Issue the following command to update the agent:
smcli installneeded -v -n {system_oid | system_name} -F

For example:
smcli installneeded -v -n 0xa39 -F
smcli installneeded -v -n netvj165.vrow.netfinity.com -F

The following options and operands are also useful when updating Common
Agent or Platform Agent:

-I Installs updates that are already in the updates repository. Use the
following format for the command:
smcli installneeded -v -n {system_oid | system_name} -I

-i Specifies an IP address or host name to identify the system instead of
the system OID or system name. This could be useful if you are
using a script to update the system after using other CLI commands
to discover and request access to the system. If both the server MEP
and operating system MEP have the same IP address, you must use
another parameter along with the command to install the updates
without user intervention. Use the following format for the
command:
smcli installneeded -v -t system_type -i ip_address -F

For example:
smcli installneeded -v -t OperatingSystem -i 10.11.9.165 -F

Note: Use the lssys -T command to determine the valid system
types.
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Note: You can use -i in combination with -I.
See the installneeded command topic for more detailed information about
these options and operands.

v To update Common Agent or Platform Agent with a specific update level,
complete the following steps from an IBM Flex System Manager server:
1. Download the desired updates from www.ibm.com/support/fixcentral/.
2. Issue the following command to import and install the updates:

smcli installneeded -v -n {system_oid | system_name} -F import_path

For example:
smcli installneeded -v -n 0xa39 -F c:\dirupdates

v To install other types of updates, complete the following steps:
1. Issue the following command to determine the update type or types to

specify:
smcli installneeded --list

2. Issue either of the following commands to install the updates:
– smcli installneeded -v -n {system_oid | system_name} -F -u

update_type

– smcli installneeded -v -t system_type -i ip_address -F -u
update_type

For example:
– Install X-Architecture compute node and IBM Flex System updates from

the FSP to the system with a system OID of 0xa39:
smcli installneeded -v -n 0xa39 -F -u systemxandbc

– Install X-Architecture compute node and IBM Flex System updates that
were already acquired from the FSP or imported previously to the system
with a system name of netvj165.netfinity.com:
smcli installneeded -v -n netvj165.netfinity.com -F -u systemxandbc -I

– Install Linux updates to the system with an IP address of 10.11.9.165:
smcli installneeded -v -t OperatingSystem -i 10.11.9.165 -F -u linux

Note: The default value for -u is “Director”, which is implied if -u is not
specified. That is why the previous command to update IBM Flex System
Manager was accurate even though the -u option was not included. The -u
option corresponds to the update ProviderType and specifies the types of
updates to acquire if -c is specified or implied when no other option is
given. The acquire updates task will only order updates using the default
criteria values that are supported by the target system or server if no target
system is provided.

To illustrate with an example, a user wants to update IBM Flex System
Manager on Linux and uses the following command to do so:
smcli installneeded -v -F

The user then discovers and accesses a Linux agent and plans to perform
Linux updates on the agent after the agent side setup is complete. There are
correct and incorrect commands to use for this action:
– Incorrect:

smcli installneeded -v -t OperatingSystem -i 10.11.9.165 -F -u linux -I
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This command would find no updates to install. Even though the smcli
installneeded -v -F command already ran the acquire updates task on a
Linux server, -u was not specified and therefore defaulted to “-u
Director”. Only IBM Flex System Manager updates were acquired from
the FSP, and no Linux updates were placed in the repository for
installation.

– Correct:
smcli installneeded -v -t OperatingSystem -i 10.11.9.165 -F -u linux

This command would complete an acquire updates task for Linux updates
from the FSP and install them.

See the installneeded command topic for more detailed information about
these options and operands.

Keeping systems in compliance
The IBM Flex System Manager uses a default compliance policy to ensure that the
most current versions of updates imported into the Flex System Manager are
applied to managed endpoints. Flex System updates are released concurrently and
it is recommended that you acquire updates for your entire Flex infrastructure
when you acquire updates for your Flex System Manager, to maintain your
environment at supported stack levels. Visit the IBM PureSystems® Centre to learn
more about the supported stack for your release, or to acquire any necessary
updates to maintain system compliance.

Before you begin

The Update Manager summary page provides a quick view of the number of
systems that are monitored by compliance policies and the number of systems that
are out of compliance. Review this information before viewing the more detailed
data that follows it.

In addition, compliance information for chassis and their components is displayed
graphically in the chassis map.

About this task

Use the Update Manager summary page to view information about compliance
policies for your systems. All compliance policy tasks are initiated from the Update
compliance section on this page.

Note: Compliance status does not change on the monitored systems until an
acquire updates task is complete and compliance has completed. This status
change can take up to ten minutes after the acquire updates task completes.

Important: When using compliance for the first time, keep in mind the following
items:
v To check compliance for , Flex System Manager an applicable IBM UpdateXpress

System Pack Installer (UXSPi) is required. The UXSPi is downloaded
automatically when you use update manager to acquire updates from the
internet. If the management server does not have an internet connection, you
must manually download and import an applicable UXSPi.

Important: For UXSPi to work correctly on 64-bit Linux operating systems, you
must install the compatibility libraries compat-libstdc++-296-2.96.
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v To efficiently balance impact on resources and improve reliability, consider
grouping your systems, for example by type or by level of operating system,
and then using a rollout or staged approach to attain currency.

v For important information about applying compliance on Flex System Manager,
see the Firmware Update Guide - IBM Flex System, at http://www.ibm.com/
support/entry/portal/docdisplay?lndocid=MIGR-5091991&brandind=5431802.

What to do next

You can create compliance policies on systems or system groups. When a policy is
created on a system group, all systems within the group inherit the compliance
policy. The group is displayed in the Inherited column when viewing the system
compliance policy.

Compliance policies
Use compliance policies to monitor your systems and inform you when systems
are missing specific updates.

The first section on the Update Manager summary page is the Update Compliance
section. This section provides a quick summary of the update health of your
systems and provides several system-related tasks.

Tips
v If you see the term Inherited Compliance Policy or an Inherited field in a table

when you are viewing this information, there is a compliance policy on the
parent group for the system. The policy can be removed from the system only
by removing it from the system parent group.

v The behavior of a compliance policy for an update group differs slightly
depending on whether the update group is static or dynamic:

Static update group
When a static update group is examined, each update contained within
the group that is applicable to the system must be found to be installed;
otherwise the compliance policy indicates an 'out of compliance'
situation. This situation is verified by examining the appliesTo
relationship on the update.

Dynamic update group
When a dynamic update group is examined, the compliance policy
indicates an 'out of compliance' situation only when updates that are
needed by the systems are not installed. This situation is verified by
examining the needs relationship on the update.

v If you add a system group or an update group to an existing system group or
update group, this new, nested group is not considered when the parent system
or update group is used for validation of compliance policies.

v If an update that is not applicable to a particular system is not installed, the
compliance policy does not indicate an 'out of compliance' situation.

Adding updates to a compliance policy
Updates can be added to a compliance policy to keep the compliance policy
current.

About this task

Note:
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This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To add an update to the compliance policy for a system, complete the following
steps:

Procedure
1. From any panel that has a list of updates displayed, click Add to >

Compliance Policy.
2. Select the system or system group to be monitored for the update.
3. Click OK. The selected update is added to the compliance policy for the

system.
4. Click Save to save the compliance policy.

Create and configure compliance policies
Use the Create and configure compliance policies page to change compliance
policies.

Before you begin

The Create and configure compliance policies task is used to configure compliance
policies on systems that are monitored for missing updates. Each compliance check
is listed on a separate line.

The target system or system group is checked against its associated compliance
policy automatically when the system or update inventory changes.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To modify compliance policies, complete the following steps:

Procedure
1. From the Update Manager summary page, click Create and configure

compliance policies. The Compliance Policy page is displayed.
2. Select a system or system group.
3. Optional: Click Browse to see a list of systems.
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a. Click Add to add a system or system group.
b. Click Remove to remove a system or system group.

4. Click Show Compliance Policies.
5. Select one of the following policies to create or, if it already exists, configure it:
v Policy to ensure that the latest released updates are always applied
v Policy to ensure that specific version levels of updates are maintained

Important: If a policy already exists and you select and configure the other
policy, the existing policy and its compliance checks are removed when you
save the new policy.
If the chosen policy already exists, the table displays all associated compliance
checks. If the chosen policy does not already exist, the table is empty.

6. Choose a task to perform on the selected compliance policy:
v Create a new compliance check. Complete the following steps:

a. In the displayed table, click Add.... The Add... page is displayed.
b. In the Show: list, select the type of updates to display in the table.

Note: If you are adding a compliance check to the “Policy to ensure that
the latest released updates are always applied” policy, you can choose
from among only dynamic update groups. If you are adding a
compliance check to the “Policy to ensure that specific version levels of
updates are maintained” policy, you can choose from among only
individual updates or static update groups.

c. Choose the updates or update groups to include in the compliance policy.
d. Click OK to add the updates or update groups to the compliance policy.

v Remove a compliance check. Select a compliance check, then select Actions >
Remove.

7. Click Save to save the changes to the compliance policy. This will activate the
selected compliance policy and any compliance checks that you set up for it,
and will remove any previously existing compliance policies and compliance
checks.

Example

If you create a static update group where some of the updates supersede others,
the compliance policy verifies that the latest superseding update is installed. The
recommendation that comes from this type of compliance policy will be to install
the latest update in the supersede chain.

As an example, consider an update group with these attributes:
v It is a static update group.
v Group members are updates named UpdateA, UpdateB, and UpdateC.
v UpdateA supersedes UpdateB.
v UpdateB supersedes UpdateC.

When a compliance policy is created with this group, the compliance policy
verifies that the latest supersede update (UpdateA in this case) is installed, and, if
it is not, the recommended action is to install the latest update in the supersede
chain (UpdateA in this case). Even if both UpdateB and UpdateC are installed, the
compliance policy indicates 'out of compliance' unless UpdateA is installed. If
UpdateB and UpdateC are not found on the system, but UpdateA is present on the
system, the compliance policy indicates that the system is in compliance.
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Identifying systems that are out of compliance
Identify systems that are out of compliance so that you can take recommended
corrective action.

Before you begin

This function does not give you information about all your systems, just those that
are monitored by compliance policies.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

The system-compliance status indicator represents the highest severity among all of
the compliance policy updates that are not installed on the system. There are five
compliance categories, represented by icons:

 

: Indicates a missing update severity of critical or high
 

: Indicates a missing update severity of medium or low
 

: Indicates a missing update severity that is not known or not
applicable
 

: Indicates systems that are in compliance; they have no missing
updates
 

: Indicates systems that are not accessible or do not have inventory
collected

To identify systems that are out of compliance according to an active compliance
policy, complete the following steps:

Procedure
1. On the Update Manager summary page, find the Update Compliance section.
2. Examine the pie chart and icons to its right. The number of systems in each

compliance category is displayed.

Note: The compliance pie chart is visible only if you have already created a
compliance policy for your system.
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3. If one or more system is in need of updates, click one of the systems links next
to the severity icons (which are next to the pie chart). This displays a table of
systems.

4. Optional: You can also click the View all issues link to the bottom right of the
pie chart to view all compliance issues for all systems that are in a policy and
are in need of updates.

5. Examine the Compliance column to find which systems are in need of updates.
The highest severity of all the missing updates is displayed.

6. Select one or more systems.
7. Click System Health > Compliance Issues The View All Issues page is

displayed.
Those systems that have the same compliance issues are grouped, and the total
number of systems is displayed.

8. Click a compliance issue to expand and filter the list of individual systems.
Otherwise, each system with each particular issue and recommendation is
listed.

Resolving compliance issues
When a compliance policy indicates that there are updates that are required on one
or more systems, examine the severity of the updates, and plan to install them
considering your system's availability, workload, and scheduling factors.

Before you begin

Use this procedure only if one or more of your systems is out of compliance, as
indicated by the Compliance column in the list of monitored systems, or as
indicated by the pie chart on the Update Manager summary page.

Note: The compliance pie chart is visible only if you have already created a
compliance policy for your system.

About this task

The Compliance column visually indicates that a system is not in compliance. The
status severity is the highest severity of all the updates needed by the system.

To correct an out-of-compliance situation, complete the following steps:

Procedure
1. Click the compliance status in the Compliance column to see the Issues and

Recommendations panel.
2. Read the recommended action. Make sure that you understand the proposed

actions.
3. Choose the issues that you want to resolve and then click either Install or

Uninstall, according to the recommendation. The appropriate wizard starts.
You can choose to resolve all issues at once instead of resolving them
individually.
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Chapter 5. Installing agents

Prepare your managed systems and IBM Flex System environment for agent and
subagent installation; then, you can install Common Agent or Platform Agent.

Note: A managed compute node might have more than one IP address (for
example, when the system contains more than one network interface card). When a
managed resource has multiple IP addresses, specify which IP address the
management software uses to manage the resource. To specify the IP address to
use, you must specify that the management software ignore (or exclude) the other
IP addresses associated with the resource.

Installing Common Agent
Prepare your systems and environment for installing Common Agent. Then, use
the Agent Installation wizard, or alternatively, use the manual instructions, to
install Common Agent.

About this task

Important:

v IBM Flex System Manager management software includes Common Agent and
Platform Agent. Therefore, it is not necessary to separately install Common
Agent or Platform Agent on the management node.

v Systems running AIX require Common Agent to be installed. These systems
cannot be managed with Platform Agent.

Note: The CIM Remote Service Access Point (RSAP), which is part of Common
Agent and Platform Agent, is not supported when requesting access to Common
Agent. Therefore, you will see the CIM RSAP when discovering AIX Common
Agent managed systems, but you cannot use it to request access to the AIX
system.
If Common Agent version 6.2.1 is installed on an Power Systems compute node
with the AIX operating system, make sure that you download and install
Common Agent version 6.3.0 or later.
A problem with Common Agent version 6.2.1 can cause a duplicate managed
endpoint (MEP) to be created for a relocated logical partition. If Common Agent
version 6.2.1 is installed on an AIX compute node and you relocate a logical
partition from that compute node to another system, two MEPs are created for
the same logical partition instead of one. The MEP on the source compute node
(or the compute node from which the logical partition was relocated) is
unnecessary and should be deleted. To delete the duplicate MEP, remove the
MEP on the source compute node in the management software web interface
after the relocation has finished and inventory collection is complete.
For more information about how to download and install Common Agent
version 6.3.0 (or upgrade from version 6.2.1), see “Installing agents using the
Agent Installation Wizard”.

v Ensure that the system clocks on the systems that contain IBM Flex System
Manager and Common Agent remain synchronized.
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Preparing for a Common Agent managed system
Before installing Common Agent on a managed system, ensure that the
requirements applicable to your system have been met.

About this task

Complete the following steps on each system to be managed with Common Agent:

Procedure

On all managed systems that use the ssh protocol to communicate with IBM Flex
System Manager, ensure that the PasswordAuthentication value in
/etc/ssh/sshd_config is set to yes. So, the corresponding line in the sshd_config
file will appear as follows:
PasswordAuthentication yes

Note: You must restart the ssh server for any changes made to sshd_config to take
effect.

Preparing to install Common Agent on AIX
Before installing Common Agent on AIX, make sure that your platform meets the
applicable requirements.

About this task

Note: If Common Agent version 6.2.1 is installed on an IBM Power Systems
compute node with the AIX operating system, make sure that you download and
install Common Agent version 6.3.0 or later.

A problem with Common Agent version 6.2.1 can cause a duplicate managed
endpoint (MEP) to be created for a relocated logical partition. If Common Agent
version 6.2.1 is installed on an AIX compute node and you relocate a logical
partition from that compute node to another system, two MEPs are created for the
same logical partition instead of one. The MEP on the source compute node (or the
compute node from which the logical partition was relocated) is unnecessary and
should be deleted. To delete the duplicate MEP, remove the MEP on the source
compute node in the management software web interface after the relocation has
finished and inventory collection is complete.

For more information about how to download and install Common Agent version
6.3.0 (or upgrade from version 6.2.1), see “Installing agents using the Agent
Installation Wizard”.

Complete the following preparatory steps before installing Common Agent on AIX:

Procedure
1. If you are running AIX server 7.1, complete the following steps to ensure that

the included version of Common Agent is completely removed before installing
the new version of Common Agent:
a. Uninstall the version of Common Agent that was included in AIX server

7.1.
b. If any of the following file sets still exist, uninstall them using the installp

-ug fileset_name command:
v DirectorCommonAgent
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v cas.agent
v Director.DirectorCimCore
v DirectorPlatformAgent
v Director.CimExtension
v Director.CimCore
v sysmgt.cim.smisproviders.hba_hdr*
v sysmgt.cim.smisproviders.hhr*
v sysmgt.cim.smisproviders.vblksrv*
v sysmgt.cim.providers.smash*
v sysmgt.cim.providers.osbase*
v sysmgt.cim.providers.metrics*
v sysmgt.cim.providers.scc*
v sysmgt.cimserver.pegasus.rte*
v tivoli.tivguid*

c. If any of the following directories still exist and are not empty, either
remove or empty them:
v /opt/ibm/director/
v /opt/ibm/icc
v /etc/ibm/director
v /etc/ibm/tivoli
v /usr/tivoli/guid
v /usr/pegasus
v /var/opt/tivoli/ep
v /var/cim/
v /opt/freeware/cimom/pegasus

d. If the installation fails with a parsing error similar to “Could not find
declaration for Qualifier named Provider”, the CIM repository is corrupt
and the cimserver cannot start. In this case, you need to remove the
following additional directories, if they still exist:
v /var/cim/rebuild_repository.lock
v /opt/freeware/cimom/pegasus/etc/repository

2. Ensure that your system meets the hardware and software requirements. To
verify the AIX operating system level, run the following command:
oslevel -s

The command should return a value such as 5300-09-00-nnn, where nnn is
irrelevant.

3. Optional: Download updates for your system, if necessary. Download AIX
updates from the "Fix Central" Web site.

Note: Select “IBM Power” or “System p” for the Product family and “AIX” for
the Product.

4. Ensure that, if they are installed, openssl and openssh are at the following
versions:
v openssl.base 0.9.8.4 or higher
v openssh.base.server 4.5.0.5301 or higher

There is a dependency between openssl and openssh versions. If openssl is not
installed, it is installed as part of the server or agent installation. However, if
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this would create an inconsistency with the openssh version on the system,
openssl is not installed and the installation fails.

Note: If you want to run the Agent Installation Wizard from the server,
openssh is required. However, the server installation does not enforce openssh
installation.

5. Ensure that the following file sets that are required for and installed with
Common Agent on AIX will not conflict with any other applications that are
installed on your system:
v sysmgt.cim.providers 1.2.9.30
v sysmgt.cim.smisproviders 1.2.2.30
v sysmgt.cimserver.pegasus 2.9.1.30
v ICU4C.rte 5.3.9.0 (only AIX 5.3 systems)
v xlC.aix50 10.1.0.2 (only AIX 5.3 systems)
v xlC.rte 10.1.0.2 (only AIX 5.3 systems)

6. Verify /etc/hosts and /etc/netsvc.conf settings to ensure the success of IP
address lookups for loopback.

7. Ensure that nofiles is set to a value other than unlimited. To specify an
appropriate value, run the following command:
chsec -f /etc/security/limits -s root -a nofiles=value

where value is a value such as 3000.
8. Ensure that the installation is set to use ports that are not already in use. By

default, Common Agent requires ports 9510, 9514, and 9515 during installation
and at runtime. If these ports are already in use when you install the agent, the
installation will fail. A situation where these ports will be already in use is if
you have a different version of the CAS agent installed, for example as part of
the Tivoli Provisioning Manager agent.
Complete the following steps to check for port use and, if any are in use,
modify the Common Agent configuration to use different ports:
a. Check if the ports are in use by running the following command:

netstat -an | grep LISTEN | egrep "951(0|4|5)"

b. On the agent system, modify the configuration to use different ports by
running the following command:
/var/opt/tivoli/ep/runtime/agent/toolkit/bin/configure.sh -unmanaged -port
not_9510 -jport not_9514 -nport not_9515 -force

where not_951x is any open port other than 951x.
c. Rerun the installation script or install the Common Agent file set manually.

9. Ensure the validity of any stored public key data for the target system in
root_SSH_data_directory/known_hosts on IBM Flex System Manager. See
“Common Agent cannot be installed on an AIX or Linux system” for more
information.

Preparing to install Common Agent on IBM i
Before installing Common Agent on IBM i (formerly i5/OS), there are several items
to consider, such as the type of media on which the installation files are saved, the
user profile that is used to install IBM Flex System Manager, and the additional
software that might be required.
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About this task

For more information about IBM i, see the IBM i Information Center at
http://publib.boulder.ibm.com/eserver/ibmi.html.

Review the following information and complete the necessary steps to prepare
your system for installation:

Procedure
v Ensure that your system meets the hardware and software requirements for

installation, as described in “Hardware and software requirements”.
v Ensure that any agentless managed systems are prepared for discovery, as

described in “Preparing agentless managed systems”.
v Ensure that your user profile has *ALLOBJ and *SECADM special authorities.

Note: Common Agent will use ports 29510 and 29511.
v Ensure that the following products and options are installed on the IBM i server

on which you plan to install IBM Flex System Manager. These products and
options are required to successfully install and securely run IBM Flex System
Manager.

Table 25. IBM i products and options required for IBM Flex System Manager

Products, options, or fix IDs IBM i 7.1 product number IBM i 6.1 product number

Latest group PTF for IBM
HTTP Server for IBM i

group PTF SF99368 group PTF SF99115

IBM Universal Manageability
Enablement for IBM i

5770UME V1R3M0
Note: PTFs SI41685 and
SI41540 are required.

5770UME V1R3M0
Note: PTFs SI41685 and
SI41540 are required.

IBM HTTP Server HTTP
Server for IBM i

5770DG1 5761DG1

OS/400® - Extended Base
Support

5770SS1 option 1 5761SS1 option 1

Extended Base Directory
Support

5770SS1 option 3 5761SS1 option 3

Extended NLS Support 5770SS1 option 21 5761SS1 option 21

TCP/IP Connectivity Utilities
for Power Systems
Note: TCP must be
configured correctly or IBM
Flex System Manager might
not start. See “IBM Flex
System Manager Fails to
Start” on the IBM i Support
Web site for a short
description of common
configuration problems.

5770TC1 5761TC1

Java SE 6 32-bit 5761JV1 option 11 5761JV1 option 11

Qshell 5770SS1 option 30 5761SS1 option 30

Digital Certificate Manager 5770SS1 option 34 5761SS1 option 34

OpenSSH 5733SC1 V7R1M0 *BASE and
option 1

5733SC1 V6R1M0 *BASE and
Option 1
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v Ensure that the Integrated File System (IFS) directory /InstallShield is
accessible on the IBM i server on which you plan to install IBM Flex System
Manager. Also, if the /InstallShield directory is linked to a directory in an
Independent Auxiliary Storage Pool (IASP), ensure that IASP is active during the
installation.

v Ensure that you have installed the latest cumulative PTF packages or Group
PTFs on the Power Systems on which you plan to install IBM Flex System
Manager.

v Ensure that the host servers are started by running the STRHOSTSVR SERVER(*ALL)
command.

v If IBM Flex System Manager 5.20.x is installed on IBM i 6.1, you must uninstall
it before you install the Common Agent. Complete the following steps to check
if IBM Flex System Manager is installed:
1. From a command prompt, type GO LICPGM and press Enter.
2. Select option 10, Display installed licensed programs, and review the list of

installed programs. If installed, IBM Flex System Manager is displayed in the
list as one of the following entries (depending on the version):
5722DR1 *BASE IBM DIRECTOR
5733VE1 30 5050 IBM Director Multiplatform, 4.2.0

v If you plan to use IBM Flex System Manager to monitor SNMP devices in your
IBM Power environment, ensure you have completed the necessary
configuration tasks for IBM Power and SNMP devices. See the "Networking"
topic in the IBM Power Systems and IBM i Information Center for more
information.

Preparing to install Common Agent on Linux on Power Systems
Before installing Common Agent on Linux on Power Systems, make sure that your
platform meets the applicable requirements.

About this task

Review the following information and complete the necessary steps to prepare
your system for installation:

Procedure
v SUSE Linux Enterprise Server 10 on IBM Power Systems and SUSE Linux

Enterprise Server 11 on IBM Power Systems only: Disable the Service Location
Protocol daemon (SLPD) before installing Common Agent. IBM Flex System
Manager does not discover a managed system with Common Agent installed
when the managed system is running SLPD.

v Ensure that the required RPMs are installed. To check for the fileset, type the
following command and press Enter:
rpm -qa | grep <filesetname>

where <filesetname> is the value in the “Required RPMs” column but without
the ppc.rpm or ppc64.rpm extension. In case of Platform Agent on Power
Systems, use the appropriate version of prerequisite RPMs. A list of required
RPMs for various releases can be found in the wiki that contains Software
requirements for IBM Flex System Manager 6.3.5 and higher on Linux on Power.

v (Red Hat Enterprise Linux only): Before you install IBM Flex System Manager,
you must ensure the SELinux policy is not being enforced.
SELinux runs in any of the following states:
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Disabled
SELinux is disabled. You can tell that SELinux is in the disabled state by
determining if any of the following conditions are true:
– No files exist in the /selinux/ directory.

Permissive (enabled)
SELinux is enabled but not enforcing any security policies. You can tell
that SELinux is in the permissive state by determining if any of the
following conditions are true:
– The SELINUX variable in /etc/sysconfig/selinux/enforce is set to

permissive or a value not equal to "1".
– When you run the getenforce command, it outputs “Permissive”.

Enforcing (enabled)
SELinux is enabled and enforcing security policies. You can tell that
SELinux is in the enforcing state by determining if any of the following
conditions are true:
– The SELINUX variable in /etc/sysconfig/selinux/enforce is set to

enforcing or "1".
– When you run the getenforce command, it outputs “Enforcing”.

v Ensure the validity of any stored public key data for the target system in
root_SSH_data_directory/known_hosts on IBM Flex System Manager. See
“Common Agent cannot be installed on an AIX or Linux system” for more
information.

Preparing to install Common Agent on X-Architecture systems
Before installing Common Agent on a managed system running Linux for
X-Architecture systems, make sure that your system meets all the applicable
requirements.

About this task

Review the following information and complete the necessary steps to prepare
your system for installation:

Procedure
v Ensure that the instance of Common Agent will be fully functional and able to

send alerts to IBM Flex System Manager. For the Common Agent to be fully
functional you might need to install service-processor device drivers or the IBM
LM78 and SMBus device drivers for Linux.

v Ensure that the required RPMs are installed.
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Table 26. Required libraries for Linux on System x

Installation scenario Management server Common agent Platform agent

Red Hat Enterprise Linux openssh
libstdc++.so.5
libm.so.6
libgcc_s.so.1
libc.so.6
libdl.so.2
libpthread.so.0
unzip
libaio
libcrypt.so.1
libnsl.so.1
libpam.so.0
librt.so.1
bind-utils
net-tools
libstdc++.so.6
libuuid.so.1
libexpat.so.0

libcrypt.so.1
libc.so.6
libdl.so.2
libstdc++.so.5
libgcc_s.so.1
libm.so.6
libnsl.so.1
libpam.so.0
libpthread.so.0
librt.so.1
unzip
bind-utils
net-tools
libstdc++.so.6
libuuid.so.1
libexpat.so.0

libstdc++.so.5
bind-utils
net-tools
libpam.so.0
libstdc++.so.6
libuuid.so.1
libcrypt.so.1
unzip
libexpat.so.0
openssl1.0.1

SUSE Linux Enterprise
Server 10

SUSE Linux Enterprise
Server 11

openssh
libstdc++.so.5
libm.so.6
libgcc_s.so.1
libc.so.6
libdl.so.2
libpthread.so.0
unzip
libaio
libcrypt.so.1
libnsl.so.1
libpam.so.0
librt.so.1
bind-utils
net-tools
libstdc++.so.6
libuuid.so.1
libexpat.so.1

libcrypt.so.1
libc.so.6
libdl.so.2
libstdc++.so.5
libgcc_s.so.1
libm.so.6
libnsl.so.1
libpam.so.0
libpthread.so.0
librt.so.1
unzip
bind-utils
net-tools
libstdc++.so.6
libuuid.so.1
libexpat.so.1

libstdc++.so.5
bind-utils
net-tools
libpam.so.0
libstdc++.so.6
libuuid.so.1
libcrypt.so.1
unzip
libexpat.so.1
openssl1.0.1

v (Red Hat Enterprise Linux only): Before you install IBM Flex System Manager,
you must ensure the SELinux policy is not being enforced.
SELinux runs in any of the following states:

Disabled
SELinux is disabled. You can tell that SELinux is in the disabled state by
determining if any of the following conditions are true:
– No files exist in the /selinux/ directory.

Permissive (enabled)
SELinux is enabled but not enforcing any security policies. You can tell
that SELinux is in the permissive state by determining if any of the
following conditions are true:
– The SELINUX variable in /etc/sysconfig/selinux/enforce is set to

permissive or a value not equal to "1".
– When you run the getenforce command, it outputs “Permissive”.

Enforcing (enabled)
SELinux is enabled and enforcing security policies. You can tell that
SELinux is in the enforcing state by determining if any of the following
conditions are true:
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– The SELINUX variable in /etc/sysconfig/selinux/enforce is set to
enforcing or "1".

– When you run the getenforce command, it outputs “Enforcing”.
v Systems with service processors: Install the supporting device drivers and

mapping layers, if they are not already installed. See “Preparing to manage
service processors with IBM Flex System Manager” for information about these
drivers and mapping layers.

v If you want to use the Remote Session task on the managed system, make sure
that the package that contains telnetd daemon is installed and configured.

v Ensure the validity of any stored public key data for the target system in
root_SSH_data_directory/known_hosts on IBM Flex System Manager. See
“Common Agent cannot be installed on an AIX or Linux system” for more
information.

Preparing VMware managed systems
You might need to configure certain VMware systems before you can install agents
on them using the Agent Installation Wizard.

About this task

Managed systems running VMware ESX require the following configuration to
ensure that agents can be installed using the Agent Installation Wizard:

Procedure
1. On the VMware managed system, open the /etc/ssh/sshd_config file in a text

editor.
2. Locate the following line:

Ciphers aes256-cbc,aes128-cbc

3. Change the line to:
Ciphers aes256-cbc,aes128-cbc,3des-cbc

4. Save and close the /etc/ssh/sshd_config file.
5. Stop and restart the ssh daemon. Type the following command:

service sshd restart

6. Use VMware vSphere Client Security Profile Properties to enable ibmsa and
ibmcim.
a. Using VMware vSphere Client, connect to a VMware ESX 4.x system.
b. Click the Configuration tab.
c. Under Software, click Security Profile.
d. Select Properties and enable ibmsa and ibmcim.

7. Ensure the validity of any stored public key data for the target system in
root_SSH_data_directory/known_hosts on IBM Flex System Manager. See
“Common Agent cannot be installed on an AIX or Linux system” for more
information.

Preparing to install Common Agent on Windows
Before installing Common Agent on a managed system running Windows, make
sure that your system meets all the applicable requirements.

About this task

Review the following information and complete the necessary steps to prepare
your system for installation:

Chapter 5. Installing agents 217



Procedure
v If there is an operating system update in progress, ensure the process is

complete and you restart the system before starting the installation process.
v Systems with service processors: Install the supporting device drivers and

mapping layers, if they are not already installed. See “Preparing to manage
service processors with IBM Flex System Manager” for information about these
drivers and mapping layers.

Installing agents using the Agent Installation Wizard
You can use the Agent Installation Wizard to install agent packages on managed
systems.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

IBM Flex System Manager requires a number of agent packages that can be
deployed to managed systems using the Agent Installation Wizard.The imported
agent packages are located in the dynamic group “Agent Package Groups” and can
be accessed by clicking Release Management > Agents in the left navigation area
(which is hidden by default in the web interface). You use the Agent Installation
Wizard to select one of these agent packages to install and one or more systems on
which to install the agent package. Then, the wizard creates an agent installation
job that can run immediately or at a scheduled time.

Important: Ensure that the following requirements are met to enable use of the
Agent Installation Wizard to install and update agents:
v The root user account was used to initially request access to the managed

system.
v IBM Flex System Manager on non-Windows systems has SSH, and a successful

SSH connection exists in both directions between the server and the agent.
v IBM Flex System Manager on Windows systems has DCOM, and a successful

DCOM connection exists in both directions between the server and the agent.
v In case of Power Systems different versions of Platform Agent require different

version of RPMs. The list of required RPMs is available at: Software
requirements for IBM Flex System Manager on Linux on Power. When you use
the Pre-Installation Utility to ensure that your system meets theIBM Flex System
Manager requirements, the RPMs are used to fulfill part of the prerequisites.

Note: If you plan to install Common Agent on an Power Systems compute node
with the AIX operating system, make sure that you download and install Common
Agent version 6.3.0 or later.

A problem with Common Agent version 6.2.1 can cause a duplicate managed
endpoint (MEP) to be created for a relocated logical partition. If you install
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Common Agent version 6.2.1 on an AIX compute node and relocate a logical
partition from that compute node to another system, you might see two managed
endpoints (MEPs) for the same logical partition instead of one. The MEP on the
source compute node (or the compute node from which the logical partition was
relocated) is unnecessary and should be deleted. To delete the duplicate MEP,
remove the MEP on the source compute node in the management software web
interface after inventory collection is complete for the source compute node.

Complete the following steps to import the agent packages:
1. Acquire the Remote Deployment installation packages for the IBM Flex System

Manager agents.
View this document for information about acquiring the installation packages:
http://www.ibm.com/support/
docview.wss?uid=nas7452a24e9851ad53f86257f8f004bce0b.

2. Copy the packages to the IBM Flex System Manager system. See Importing
updates for instructions about copying packages to the management node.

3. Import the packages with the Agent Installation Wizard.
4. Make any required changes to the diragent.rsp and or platform.rsp response

files. See the topic for your operating system under “Installing Common Agent
manually” or “Installing Platform Agent manually” for instructions about how
to change the response files.

Complete the following steps to install agents using the Agent Installation Wizard:

Procedure
1. Start the Agent Installation Wizard by right-clicking an agent package and

selecting Release Management > Install Agent.
2. In the Agent Installation Wizard Agents page, complete the following steps:

a. Select the agent or subagent package that you want to install in the
Available list.

Note: A subagent plugs in to a base agent and provides additional
capabilities to support IBM Flex System Manager plug-ins such as IBM Flex
System Manager VMControl. This documentation uses the collective term
“agents” to refer to both agents and subagents.

b. Click Add. The selected agent package is displayed in the Selected list.

Note: The Agent Installation Wizard can install only one agent package at a
time. If more than one agent package is displayed in the Selected list, you
will not be able to advance to the Systems page.

c. Click Next.
3. In the Agent Installation Wizard Systems page, complete the following steps:

a. Select the managed systems on which you want to install the agent package
in the Available list.

b. Click Add. The selected systems are displayed in the Selected list.

Note: Depending on the agent package being installed, some selected
systems might not be valid targets for installation. The wizard checks the
selected systems for some or all of the following criteria to ensure that the
systems are valid targets for installing the selected agent package before
allowing you to continue:
v operating system family
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v operating system version
v operating system distribution
v operating system name
v server architecture

c. Click Next.
4. In the Agent Installation Wizard Summary page, review the Selected Agents

and Selected Systems lists to ensure that they are correct.
v If the selections are not correct, click Back and make the necessary changes.
v If the selections are correct, click Finish.

After you click Finish, the Run - Install Agent window opens.
5. In the Run - Install Agent window, click the Schedule tab. On this page, you

can choose to run the job immediately or schedule the job to run at a later time.
a. A job name is required and the Name field provides a unique default name.

To change the default name, type a job name in the field.
b. To run the job immediately, click Run Now and go to step 6. Otherwise,

click Schedule.
c. In the Schedule list, select how frequently you want the job to run. The

default setting is Once. Other values are Hourly, Daily, Weekly, Monthly,
Yearly, or Custom. Also, you can specify whether to run the job on the
weekend.

d. Select the date and time to run the job for the first time.
e. Select the time range for the job to repeat.

6. Click the Notification tab. On this page you can customize a notification that is
sent by e-mail.
a. Select from the available criteria to customize when the mail notification is

sent. You can specify that the mail be sent when one of the following
criteria is met:
v When the job begins.
v When the job completes successfully.
v When the job fails. You can further customize this criterion by setting

either the percentage of target systems on which the job had errors or the
number of systems on which the job had errors. Therefore, if the job runs
on five systems, the job has errors on two systems, and you set the
criterion threshold to 50%, the notification is not sent.

v When the job receives any error.
b. Type your mail address, mail server, and mail server port.

Tip: You can provide only one mail address.
7. Click the Options tab. On this page you can select additional options for the

job behavior.
a. Select whether you want the job to run according to your management

server's time or the target system's time.

Tip: Make sure that you know the time and time zone to which the
respective systems' clocks are set.

b. Select whether you want the job to fail if a system is offline or if you want
the job to run when the system is online again.

8. Click OK to save the job.
Click Cancel to exit from the Launch Job window without saving the job.
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If the job is created successfully, a message is displayed on the page from
which you started the Scheduler. If the job creation fails, a message is displayed
in the Launch Job window so that you can correct the job.
The job created by the Agent Installation Wizard will transfer the agent
self-extracting script and the agent response file into the following directory,
which depends on your agent level, on the target system:

Common Agent
/tmp/commonagent_tmp

Platform Agent
/tmp/platformagent_temp

After the files are copied, the installation file sets are extracted into the /tmp
directory and installed. The files are then removed after a successful
installation. You need to ensure that there is sufficient space on the target
system to copy the self-extracting script and extract the file sets. Refer to the
space requirements as specified in “Hardware requirements for systems
running Common Agent or Platform Agent”.
If the agent deployment completes with errors, check the log file for your target
operating system for a possible root cause:
v AIX and Linux:

– Common Agent: /var/log/dirinst.log
– Platform Agent: /opt/ibm/platform/log/install.log

v Windows: %WINDIR%/diragentinst_timestamp.log or %WINDIR%/
platint_timestamp.log

Note: For more information about error log files, see “Information to provide
to the IBM Technical Support Center”.

Notes for AIX:

v Refer to “Installing Common Agent on AIX” for more detail on the
self-extracting script and the response file options.

v For AIX server and agents, it is less space consuming to remotely install
agents using NIM as explained in the IBM Flex System Manager Best
Practices wiki page “Installing IBM Flex System Manager Common Agent for
AIX using NIM” at http://www.ibm.com/developerworks/community/
wikis/home?lang=en#!/wiki/W3e8d1c956c32_416f_a604_4633cd375569/
page/
Installing+IBM+Systems+Director+Common+Agent+for+AIX+using+NIM.
Installing with NIM does not allow the use of a response file.

What to do next

You can view the status of the agent installation job by clicking Task Management
> Active and Scheduled Jobs.

If you installed Platform Agent on Linux, enable SNMP Access and Trap
Forwarding by installing and configuring Net-SNMP. For instructions and
information, see http://www.net-snmp.org/.
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Installing Common Agent manually
You can use these manual instructions to install Common Agent on a managed
system. These manual instructions provide an alternative method of installation to
using the Agent Installation Wizard.

About this task

Important:

v IBM Flex System Manager management software includes Common Agent and
Platform Agent. Therefore, it is not necessary to separately install Common
Agent or Platform Agent on the management node.

v Systems running AIX require Common Agent to be installed. These systems
cannot be managed with Platform Agent.

Note: The CIM Remote Service Access Point (RSAP), which is part of Common
Agent and Platform Agent, is not supported when requesting access to Common
Agent. Therefore, you will see the CIM RSAP when discovering AIX Common
Agent managed systems, but you cannot use it to request access to the AIX
system.
If Common Agent version 6.2.1 is installed on an Power Systems compute node
with the AIX operating system, make sure that you download and install
Common Agent version 6.3.0 or later.
A problem with Common Agent version 6.2.1 can cause a duplicate managed
endpoint (MEP) to be created for a relocated logical partition. If Common Agent
version 6.2.1 is installed on an AIX compute node and you relocate a logical
partition from that compute node to another system, two MEPs are created for
the same logical partition instead of one. The MEP on the source compute node
(or the compute node from which the logical partition was relocated) is
unnecessary and should be deleted. To delete the duplicate MEP, remove the
MEP on the source compute node in the management software web interface
after the relocation has finished and inventory collection is complete.
For more information about how to download and install Common Agent
version 6.3.0 (or upgrade from version 6.2.1), see “Installing agents using the
Agent Installation Wizard”.

v Ensure that the system clocks on the systems that contain IBM Flex System
Manager and Common Agent remain synchronized.

Installing Common Agent on AIX and VIOS
To install Common Agent on a system that is running AIX or Virtual I/O Server
(VIOS), download the installation files or, if available for this release, use the DVD.

Before you begin

For AIX, you can perform the installation manually or by using the Installation
wizard. By using both methods, you can use a response file to customize the
installation for your organization. You can alternatively perform the installation by
using installp or nim. However, in this case, you cannot use a response file.

For VIOS, you can perform the installation by using updateios or NIM.

For NIST support, you can perform the installation manually by using a
self-extracting script on VIOS.

Important:

222 Systems Management Guide

|
|
|
|

|



For AIX,
v Ensure that the system clocks on the systems that contain IBM Flex System

Manager and Common Agent remain synchronized.
v If Common Agent version 6.2.1 is installed on an IBM Power Systems compute

node with the AIX operating system, make sure that you download and install
Common Agent version 6.3.0 or later.
A problem with Common Agent version 6.2.1 can cause a duplicate managed
endpoint (MEP) to be created for a relocated logical partition. If Common Agent
version 6.2.1 is installed on an AIX compute node and you relocate a logical
partition from that compute node to another system, two MEPs are created for
the same logical partition instead of one. The MEP on the source compute node
(or the compute node from which the logical partition was relocated) is
unnecessary and should be deleted. To delete the duplicate MEP, remove the
MEP on the source compute node in the management software web interface
after the relocation has finished and inventory collection is complete.
For more information about how to download and install Common Agent
version 6.3.0 (or upgrade from version 6.2.1), see “Installing agents using the
Agent Installation Wizard”.

v By default, Common Agent is started when your system is rebooted. You can
disable this function with the steps in the “Disabling IBM Flex System Manager
agents” topic.

v Common Agent is not supported to run in an AIX workload partition (WPAR).

Important:

For VIOS,
v Ensure that the system clocks on the systems that contain IBM Flex System

Manager and Common Agent remain synchronized.
v By default, Common Agent is started when your system is rebooted.
v Common Agent and Platform Agent are now installed with Virtual I/O Server.

About this task

Table 27. Installation options for Common Agent on AIX or VIOS

Installation method Title or file name

Downloaded installation
package

v SysDir6_3_5_Common_Agent_Installp_AIX_VIOS.tar.gz
(for installp on AIX, updateios on VIOS, or NIM
installation on both)

v SysDir6_3_5_Common_Agent_AIX.tar.gz (for script
installation, as described here in AIX)

v SysDir6_3_5_Common_Agent_AIX.jar (agent package for
Agent Installation Wizard installation in AIX)

Note: To install NIST Common Agent on VIOS, you need
the package SysDir6_*_Common_Agent_AIX.tar.gz.p

For NIST support, a manual agent installation through a
self-extracting script on VIOS is required.

The following process uses a self-extracting script that requires temporary space in
the /tmp directory to extract the file sets. This is as specified in “Hardware
requirements for systems running Common Agent or Platform Agent”. If /tmp does
not have enough space to extract the files, the installation will fail. If /tmp is a JFS2
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file system, you can specify in the diragent.rsp agent response file that /tmp is
temporarily extended and should shrink back to its original size after the agent
installation is complete. The default is to not extend /tmp. The files in /tmp are
deleted after a successful installation. If the extraction or installation fails, the size
of the/tmp file system might not decrease to its original size and it might retain
files. The files are extracted into /tmp/DirectorAgentselfextract.identifier.

The self-extracting script does not offer an installation preview option.

Note: The command line option -N for specifying the NIST mode is only for the
Common Agent on AIX. To let the IBM Flex System Manager installer (for
Common Agent on AIX) know that it should use NIST mode for the agent, the
command line option -N must be used by the IBM Flex System Manager caller.

Log in as the root user and complete the following steps to install Common Agent
on AIX:

Tip: You can find the installation logs for this process in /var/log/dirinst.log
and /opt/ibm/director/agent/log/installFeatures_date.log.

Complete steps 1 to 4 for Common Agent installation on AIX. Complete steps 5 to
11 for Common Agent installation on VIOS.

Procedure
1. For AIX, start the installation from the installation source:

To start the installation from a Web download, complete the following steps:
a. View the IBM Flex System Manager downloads technote which provides

information about acquiring the agent installation packages. The technote
can be found at https://www-01.ibm.com/support/
docview.wss?uid=nas7452a24e9851ad53f86257f8f004bce0b .

b. To unzip and extract the contents of the installation package to a local
directory, type the following command:
gzip -cd SysDir6_3_3_Common_Agent_AIX.tar.gz | tar -xvf -

c. Change to the directory in which the installation script is located. Type the
following command and press Enter:
cd /install_files/repository

where install_files is the path to the extracted installation files.
2. Optional: To customize the installation, copy the response file (diragent.rsp)

to a local directory and modify the installation settings in your local copy.
a. Type the following command and press Enter:

cp diragent.rsp /directory/

where directory is a local directory.
b. Open an ASCII text editor and modify the installation settings in the copy

of the diragent.rsp file. This file is fully commented.
The following parameters are used in the diragent.rsp file to register the
Common Agent services with an agent manager. These parameters are
optional, but, if one is specified, then both must be specified.

AGENT_MANAGER_HOSTNAME
The host name or IP address for the agent manager. If the agent is
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installed in a network address translation environment, set this
parameter to ensure that the agent has the correct IP address to
contact the agent manager.

AGENT_MANAGER_PASSWORD
The password for registering with the agent manager.

The following parameters are used to set the ports that the common agent
services will use. A valid number for each port is a number that is greater
than 1024 and lesser than 65535. The values listed are the default values
for each parameter.
v AGENT_PORT=9510

v AGENT_NONSTOP_PORT_1=9514

v AGENT_NONSTOP_PORT_2=9515

Note: Before extracting the file sets, the dirinstall.agent script checks if
sufficient space is available in the /tmp file system or in the file system
specified with the -x option. If required, the dirinstall.agent script
increases the free space in the file system. After the installation, the /tmp
file system is reduced back to its original size.

c. Save the modified response file with a new name.

Tip: After installation, keep the response file for future use and reference.
3. To install Common Agent, from within the directory in which the installation

script is located, type one of the following commands, and press Enter:

v To accept the default settings:
./dir6.3.5_commonagent_aix

v To use the response file:
./dir6.3.5_commonagent_aix -r /directory/response.rsp

where directory is the local directory to which you copied the response file,
and response.rsp is the name of the response file.

Note: To extract the file sets but not install Common Agent, enter the
following command:
./dir6.3.5_commonagent_aix -x extract_directory

where extract_directory is the local directory into which you want to extract
the installation files.

The option to expand the /tmp file system cannot be combined with the -x
option.
Common Agent is started automatically when installation completes.

4. For VIOS, start the installation from the installation source:
To start the installation from a web download, complete the following steps:
a. View the IBM Flex System Manager downloads technote which provides

information about acquiring the agent installation packages. The technote
can be found at https://www-01.ibm.com/support/
docview.wss?uid=nas7452a24e9851ad53f86257f8f004bce0b .

b. To extract the contents of the installation package to a local directory, type
the following command:
gzip -cd SysDir6_3_5_Common_Agent_Installp_AIX_VIOS.tar.gz | tar -xvf -

c. Change the directory to the directory in which the installation script is
located. Type the following command and press Enter:
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cd /AIX61/installp/ppc

5. From the system that you downloaded and extracted the agent file sets, FTP
the files in the AIX61/installp/ppc path in binary mode to the VIOS by using
the padmin credentials to a location such as /home/padmin/images. Create the
images subdirectory on the VIOS and change the directory to the images
subdirectory in the FTP session because the padmin user cannot create a
subdirectory and change the directory to it by using the VIOS command line.

6. Use mput to download the file sets in the List of filesets installed with
Director Server and Common Agent on AIX website.

Note: Ensure to include the Director.install.msg file though it is marked as
optional.

7. Log in to the VIOS system as padmin user.
8. To install the agent, type the following command:

updateios -dev /home/padmin/images -accept

Note: The updateios command performs an install preview and then prompts
you to continue with the installation process. If you are prompted to commit
previous updates, run the updateios -commit command first to commit the
previous updates.

9. Issue the following commands to start and stop the Common Agent as the
padmin user:
startsvc director_agent # Start common agent
stopsvc director_agent # Stop common agent

Note:

v The Common Agent does not start automatically after you complete its
installation until VIOS version 2.2.1.4. From the VIOS version 2.2.1.4, the
Common Agent starts automatically after the installation.

v You can determine whether the Common Agent is running by using the
start and stop commands. The commands display the status of the Common
Agent.

v Issue the /opt/ibm/director/agent/bin/startagent_vios and
stopagent_vios commands to start and stop the Common Agent on a VIOS
system. You must have root permission to run these commands.

10. When the VIOS system is rebooted, run the following commands to configure
the Common Agent for automatic start:
cfgsvc director_agent -attr RESTART_ON_REBOOT=TRUE # Configure agent for automatic startup
cfgsvc director_agent -attr RESTART_ON_REBOOT=FALSE # Take away automatic startup

Note: If you configure the Common Agent for automatic start, when IBM
Flex System Manager reboots the VIOS system, IBM Flex System Manager can
continue to manage the VIOS system.

What to do next

To ensure full functionality of your new Common Agent instance, discover it with
IBM Flex System Manager.

Installing Common Agent on IBM i
With the current supported releases of IBM Flex System Manager and IBM i
(formerly i5/OS) , the common agent is no longer supported on IBM i.

226 Systems Management Guide

|

|
|
|
|
|
|

|
|

|
|

|

|

|

|
|
|
|

https://www.ibm.com/developerworks/community/wikis/home?lang=en-us#!/wiki/W3e8d1c956c32_416f_a604_4633cd375569/page/List%20of%20filesets%20installed%20with%20Director%20Server%20and%20Common%20Agent%20on%20AIX
https://www.ibm.com/developerworks/community/wikis/home?lang=en-us#!/wiki/W3e8d1c956c32_416f_a604_4633cd375569/page/List%20of%20filesets%20installed%20with%20Director%20Server%20and%20Common%20Agent%20on%20AIX


About this task

The CIM server is used to exchange the types of information for systems
management and can be obtained using the Platform Agent. The package that
contains the platform agent is referred to as 5720UME or 5722UME depending on
the version of IBM i OS installed and is the recommended Agent for use with this
operating system.

The package can be obtained by placing an MES order with your IBM
representative or on the web.

After preparing your system, you can install an Agent on a system that is running
IBM i (formerly i5/OS) (V6R1 or later) by manually installing a downloaded agent
installation package.

Note: For IBM Flex System Manager 6.3.5 and above, the only supported agent on
IBM i is the Platform Agent, as listed in the Knowledge Center topic: Operating
systems supported by IBM Flex System Manager.

Important:

v Ensure that the system clocks on the systems that contain IBM Flex System
Manager and Common Agent remain synchronized.

Determine the needs for your environment, using the information from Operating
systems supported by IBM Flex System Manager and Using IBM i resources with
an IBM Flex System Manager.

When installing IBM Flex System Manager from a Web download, no agents are
imported and the agent packages are not included. So, you must obtain an agent
installation package to install Common Agent on IBM i.

Table 28. Installation options for Common Agent on IBM i

Installation method Title or file name

Downloaded update package Fix Central package: SysDir6_3_3_CAS_i5OS
(agent update package for manual installation)

Log in as an administrator with full permissions and complete the following steps
to install Common Agent on IBM i:

Procedure
1. Use the following method to install Common Agent on IBM i:

Install manually using an agent installation package To start the manual
installation, complete the following steps:
a. Download the agent installation package from the IBM Flex System

Manager Web site.
b. Extract the agent package into a directory, for example /iCAS, in the

Integrated File System on the IBM i system. For example, issue the
following command within the directory that contains the installation
package:
jar -xvf SysDir6_3_3_Common_Agent_IBM_i.zip

c. Start the QSHELL environment and navigate to the directory into which
you extracted the agent package. For example:
cd /iCAS
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d. Issue the following command to run installAgent.sh:
./installAgent.sh

e. If prompted, provide any information requested by the command, clicking
Enter after every answer, until you have completed the installation.

Note: You might not receive any prompts. In either case, the installation
will proceed without any status indicators.

f. Wait until the task completes and the QSHELL prompt (>) is shown, then
issue F3 to exit QSHELL.

2. Issue the following commands to restart the IBM i Common Agent to make
available all the functions that were installed:
ENDTCPSVR SERVER(*HTTP) HTTPSVR(CAS)
STRTCPSVR SERVER(*HTTP) HTTPSVR(CAS)

What to do next

To ensure full functionality of your new Common Agent instance, discover it with
IBM Flex System Manager.

Use the following commands to manage the IBM i Common Agent, which is an
IBM i TCP server.
v To manually start Common Agent, type the following command on an IBM i

command line and press Enter:
STRTCPSVR SERVER(*HTTP) HTTPSVR(CAS)

v To manually stop Common Agent, type the following command on an IBM i
command line and press Enter:
ENDTCPSVR SERVER(*HTTP) HTTPSVR(CAS)

Installing Common Agent on Linux on Power Systems
After preparing your system, you can install Common Agent on Linux on Power
Systems by downloading the installation file.

About this task

Important:

v IBM Flex System Manager management software includes Common Agent and
Platform Agent. Therefore, it is not necessary to separately install Common
Agent or Platform Agent on the management node.

v Ensure that the system clocks on the systems that contain IBM Flex System
Manager and Common Agent remain synchronized.

v Discovery of Remote Supervisor Adapter (RSA) devices is no longer supported.
Therefore, you cannot use IBM Flex System Manager to manage new
installations of RSA devices.

Depending on the version of Common Agent you are installing, you can install
Common Agent on Linux on Power Systems from either installation media or from
a downloaded installation package.

Important: The IBM Flex System Manager, Common Agent, and Platform Agent
installation packages for Linux are provided in English only.

228 Systems Management Guide



Table 29. Installation options for Common Agent on Linux on Power Systems

Installation method Title or file name

Downloaded installation
package

v SysDir6_3_x_Common_Agent_Linux_Power.tar.gz (agent
package for manual installation)

v SysDir6_3_x_Common_Agent_Linux_Power.jar (agent
package for Agent Installation Wizard installation)

Note: The command line option -N for specifying the NIST mode is only for the
Common Agent on Linux. To let the IBM Flex System Manager installer (for
Common Agent on Linux) know that it should use NIST mode for the agent, the
command line option -N must be used by the IBM Flex System Manager caller.

Procedure
1. Start the installation from the installation source:

Downloaded installation files: To start the installation from a Web download,
complete the following steps:
a. Download the installation package.

1) Go to the IBM PureSystems Updates website.
2) Click the table for the version of IBM Flex System software that you are

using (for example, Flex System 1.3.1).
3) Click the link to the IBM Flex System Manager image.
4) Download the Common Agent

Note: The Common Agent will be similar to the following:

For a new or update install of the agent on a remote system:
Flex1_3_1_Common_Agent_Linux_Power

For updating the Common Agent that is already installed on a remote
system:
Flex1_3_1_CAS_Linux_Power

b. To unzip and extract the contents of the installation package to a local
directory, type one of the following commands:
gzip -cd SysDir6_3_x_Common_Agent_Linux_Power.tar.gz | tar -xvf -

or
jar -xvf agents/SysDir6_3_x_Common_Agent_Linux_Power.jar

c. Change to the directory in which the installation script is located. Type the
following command and press Enter:
cd /install_files/repository

where install_files is the path to the extracted installation files.
d. If you used the jar command, change the permission setting of the

installation script to make it accessible. Type the following command and
press Enter:
chmod u+x dir6.3.x_commonagent_linux_power

2. Optional: To customize the installation, copy the response file (diragent.rsp) to
a local directory and modify the installation settings in your local copy.
a. Type the following command and press Enter:

cp diragent.rsp /directory/
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where directory is a local directory.
b. Open an ASCII text editor and modify the installation settings in the copy

of the diragent.rsp file. This file is fully commented.
The following parameters are used in the diragent.rsp file to register the
Common Agent services with an agent manager. These parameters are
optional, but, if one is specified, then both must be specified.

AGENT_MANAGER_HOSTNAME
The host name or IP address for the agent manager. If the agent is
installed in a network address translation environment, set this
parameter to ensure that the agent has the correct IP address to
contact the agent manager.

AGENT_MANAGER_PASSWORD
The password for registering with the agent manager.

The following parameters are used to set the ports that the common agent
services will use. A valid number for each port is a number that is greater
than 1024 and lesser than 65535. The values listed are the default values for
each parameter.
v AGENT_PORT=9510

v AGENT_NONSTOP_PORT_1=9514

v AGENT_NONSTOP_PORT_2=9515

c. Save the modified response file with a new name.

Tip: After installation, keep the response file for future use and reference.
3. To install Common Agent, from within the directory in which the installation

script is located, type one of the following commands, and press Enter:

v To accept the default settings:
./dir6.3.x_commonagent_linux_power

v To accept the default settings when installing on SUSE Linux Enterprise
Server 11 on IBM Power Systems, Service Pack 2:
./dir6.3.x_commonagent_linux_power -f -y sles10_sles11

v To use the response file:
./dir6.3.x_commonagent_linux_power -r /directory/response.rsp

where directory is the local directory to which you copied the response file
and response.rsp is the name of the response file.

Note: To extract the file sets but not install Common Agent, enter the following
command:
./dir6.3.x_commonagent_linux_power -x all -p extract_directory

where extract_directory is the local directory into which you want to extract
the installation files.
Common Agent is started automatically when installation completes.

What to do next

To ensure full functionality of your new Common Agent instance, discover it with
IBM Flex System Manager.
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Installing Common Agent on Linux for X-Architecture compute
nodes
After preparing your system, you can install Common Agent on a Linux for
X-Architecture compute nodes platform, including a VMware ESX server, by
downloading the installation file .

About this task

Important:

v Ensure that the system clocks on the systems that contain IBM Flex System
Manager and Common Agent remain synchronized.

Table 30. Installation options for Common Agent on Linux for X-Architecture compute nodes

Installation method Title or file name

Downloaded installation
package 6.3.5 agents

Install the 6.3.5 agents unless you need full
support for downlevel agents that have the
previously specified hardware and software
configurations.

v SysDir6_3_x_Common_Agent_Linux_x86.tar.gz
(agent package for manual installation)

v SysDir6_3_x_Common_Agent_Linux_x86.jar
(agent package for Agent Installation Wizard
installation)

Note: The command line option -N for specifying the NIST mode is only for the
Common Agent on xLinux. To let the IBM Flex System Manager installer (for
Common Agent on xLinux) know that it should use NIST mode for the agent, the
command line option -N must be used by the IBM Flex System Manager caller.

Procedure
1. Start the installation from the installation source:

Downloaded installation files: To start the installation from a Web download,
complete the following steps:
a. View the IBM Flex System Manager downloads technote which provides

information about acquiring the agent installation packages. The technote
can be found at https://www-01.ibm.com/support/
docview.wss?uid=nas7452a24e9851ad53f86257f8f004bce0b.

b. To extract the contents of the installation package to a local directory, type
one the following commands:
tar -zxvf SysDir6_3_x_Common_Agent_Linux_x86.tar.gz

or
jar -xvf SysDir6_3_x_Common_Agent_Linux_x86.jar

c. Change to the directory in which the installation script is located. Type the
following command and press Enter:
cd /install_files/repository

where install_files is the path to the extracted installation files.
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d. If you used the jar command, change the permission setting of the
installation script to make it accessible. Type the following command and
press Enter:
chmod +x dir6.3.x_commonagent_linux_x86

2. Optional: To customize the installation, copy the response file (diragent.rsp) to
a local directory and modify the installation settings in your local copy.
a. Type the following command and press Enter:

cp diragent.rsp /directory/

where directory is a local directory.
b. Open an ASCII text editor and modify the installation settings in the copy

of the diragent.rsp file. This file is fully commented.
The following parameters are used in the diragent.rsp file to register the
Common Agent services with an agent manager. These parameters are
optional, but, if one is specified, then both must be specified.

AGENT_MANAGER_HOSTNAME
The host name or IP address for the agent manager. If the agent is
installed in a network address translation environment, set this
parameter to ensure that the agent has the correct IP address to
contact the agent manager.

AGENT_MANAGER_PASSWORD
The password for registering with the agent manager.

The following parameters are used to set the ports that the common agent
services will use. A valid number for each port is a number that is greater
than 1024 and lesser than 65535. The values listed are the default values for
each parameter.
v AGENT_PORT=9510

v AGENT_NONSTOP_PORT_1=9514

v AGENT_NONSTOP_PORT_2=9515

c. Save the modified response file with a new name.

Tip: After installation, keep the response file for future use and reference.
3. To install Common Agent, from within the directory in which the installation

script is located and type one of the following commands, then press Enter:

v To accept the default settings:
./dir6.3.x_commonagent_linux_x86

v To use the response file:
./dir6.3.x_commonagent_linux_x86 -r /directory/response.rsp

where directory is the local directory to which you copied the response file,
and response.rsp is the name of the response file.

Note: To extract the file sets but not install Common Agent, enter the following
command:
./dir6.3.x_commonagent_linux_x86 -x all -p extract_directory

where extract_directory is the local directory into which you want to extract
the installation files.
Common Agent is started automatically when installation completes.
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What to do next

To ensure full functionality of your new Common Agent instance, discover it with
IBM Flex System Manager.

Installing Common Agent on Windows
After preparing your system, you can install Common Agent on a Windows
system by downloading the installation files from the IBM Flex System Manager
support website. You can then perform a standard installation or upgrade by using
the wizard.

Installing Common Agent on Windows using the installation wizard:

After preparing your Windows system, you can use the installation wizard to
install Common Agent.

About this task

Important:

v IBM Flex System Manager management software includes Common Agent and
Platform Agent. Therefore, it is not necessary to separately install Common
Agent or Platform Agent on the management node.

v Ensure that the system clocks on the systems that contain IBM Flex System
Manager and Common Agent remain synchronized.

Note: Discovery of Remote Supervisor Adapter (RSA) devices is no longer
supported. Therefore, you cannot use IBM Flex System Manager to manage new
installations of RSA devices.

Table 31. Installation options for Common Agent on Windows

Installation method Title or file name

Downloaded installation package v
SysDir6_3_x_Common_Agent_Windows.zip
(agent package for manual installation)

v
SysDir6_3_x_Common_Agent_Windows.jar
(agent package for Agent Installation
Wizard installation)

Note: In IBM Flex System Manager 1.3.4, when you install Common Agent on
Microsoft Windows by using the National Institute of Standards and Technology
(NIST) option, Common Agent is installed in NIST mode. If you do not select the
NIST option, Common Agent is installed without the NIST mode.

Important: Platform Agent is always installed in NIST mode, even if you do not
specify the NIST option.

Note: If Microsoft Windows Installer (MSI), version 4.5 or later is not installed on
the system, it is installed during the Common Agent 6.3.5 installation. If the
upgrade is necessary, the system prompts you to restart following the installation
of Common Agent 6.3.5 without specifying that MSI was installed. Unless you
install using the response file and set the RebootIfRequired parameter to N, you are
prompted to restart whether or not the Common Agent 6.3.5 installation is
completed successfully.
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To install Common Agent on Windows using the installation wizard, log in with
an administrator account and complete the following steps:

Procedure

1. Start the installation from the Common Agent installation source:
Downloaded installation files: To start the installation from a Web download,
complete the following steps:
a. Download the installation package.

1) Go to the IBM PureSystems Updates website.
2) Click the table for the version of IBM Flex System software that you

are using (for example, Flex System 1.3.1).
3) Click the link to the IBM Flex System Manager image.
4) Download the Common Agent

Note: The Common Agent will be similar to the following:

For a new or update install of the agent on a remote system:
Flex1_3_1_Common_Agent_Windows_x86

For updating the Common Agent that is already installed on a remote
system:
Flex1_3_1_CAS_Windows_x86

b. Use the unzip command to extract the contents of the installation package
to a temporary directory.

c. Click Start > Run.
d. In the Open field, type the following command and press Enter:

\installation_directory\IBMSystemsDirectorAgentSetup.exe

where installation_directory is the path to the extracted installation
files.

Note: To install Common Agent on Windows for the NIST mode, use the
dir6.3.5_commonagent_windows.exe /a NIST command.
The Welcome to the installation wizard for IBM Flex System Manager
Common Agent window opens.

2. Click Next. The License Agreement page is displayed
3. Select I accept the terms in the license agreement and click Next. The Feature

and installation directory selection page is displayed.
4. To select an alternative location for the creation of the installation, click

Change and select another directory.
5. Click Next. The Common Agent configuration page is displayed.
6. Specify the common agent port numbers for the common agent that is

installed with the server.
7. Click Next. The Registering Common Agent Services (CAS) page is displayed.
8. If you want the agent that you are installing to register with an agent

manager that already exists in your environment, select Check only if you
want to register CAS Agent with agent manager and enter in the information
for that existing agent manager:

Agent Manager Hostname or IP Address
The host name or IP address of the existing agent manager. If the
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agent is installed in a network address translation environment, set
this parameter to ensure that the agent has the correct IP address to
contact the agent manager.

Agent Manager Registration Password
The password associated with the existing agent manager.

9. Click Next. The Ready to Install the Program window is displayed.
10. Click Install. Various windows that display the status of the installation are

displayed. When the installation is complete, the Installation complete
window is displayed.

11. Click Finish.
12. If you are prompted to restart your system, click Yes.

Note: If Microsoft Windows Installer (MSI), version 4.5 or later is not installed
on the system, it is installed during the IBM Flex System Manager installation.
If the upgrade is necessary, the system prompts you to restart following the
installation of IBM Flex System Manager without specifying that MSI was
installed. You are prompted to restart whether or not the IBM Flex System
Manager installation is completed successfully.

Results

When the installation has completed, the resource will be set up as a manageable
resource.

What to do next

To ensure full functionality of your new Common Agent instance, discover it with
IBM Flex System Manager.

Performing an unattended installation of Common Agent on Windows:

After preparing your Windows system, you can use a response file to perform an
unattended installation of Common Agent. The response file that you create can be
employed on supported systems in your environment to install Common Agent.

About this task

Important:

v IBM Flex System Manager management software includes Common Agent and
Platform Agent. Therefore, it is not necessary to separately install Common
Agent or Platform Agent on the management node.

v Ensure that the system clocks on the systems that contain IBM Flex System
Manager and Common Agent remain synchronized.

Note: Discovery of Remote Supervisor Adapter (RSA) devices is no longer
supported. Therefore, you cannot use IBM Flex System Manager to manage new
installations of RSA devices.
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Table 32. Installation options for Common Agent on Windows

Installation method Title or file name

Downloaded installation package v
SysDir6_3_x_Common_Agent_Windows.zip
(agent package for manual installation)

v
SysDir6_3_x_Common_Agent_Windows.jar
(agent package for Agent Installation
Wizard installation)

Note: In IBM Flex System Manager 1.3.4, when you install Common Agent on
Microsoft Windows by using the National Institute of Standards and Technology
(NIST) option, Common Agent is installed in NIST mode. If you do not select the
NIST option, Common Agent is installed without the NIST mode.

Important: Platform Agent is always installed in NIST mode, even if you do not
specify the NIST option.

Note: If Microsoft Windows Installer (MSI), version 4.5 or later is not installed on
the system, it is installed during the Common Agent 6.3.5 installation. If the
upgrade is necessary, the system prompts you to restart following the installation
of Common Agent 6.3.5 without specifying that MSI was installed. Unless you
install using the response file and set the RebootIfRequired parameter to N, you are
prompted to restart whether or not the Common Agent 6.3.5 installation is
completed successfully.

To use a response file to install Common Agent on Windows, log in with an
administrator account and complete the following steps:

Procedure

1. Start the installation from the installation source:
Downloaded installation files: To start the installation from a Web download,
complete the following steps:
a. View the IBM Flex System Manager downloads technote which provides

information about acquiring the agent installation packages. The technote
can be found at https://www-01.ibm.com/support/
docview.wss?uid=nas7452a24e9851ad53f86257f8f004bce0b.

b. Use the unzip command to extract the contents of the installation package
to a temporary directory.

c. Copy the diragent.rsp response file to a new location. This file is in the
\directory\FILES (5.20.31) or the \directory (6.1.x or later) directory, where
directory is the local directory into which you extracted the files.

2. Open the copy of the diragent.rsp file, which follows the Windows INI file
format, in an ASCII text editor.

3. Modify and save the response file with a new file name. For example, rename
the diragent.rsp file to myresponsefile.rsp. This file is fully commented.
The following parameters are used in the diragent.rsp file to register the
Common Agent services with an agent manager. These parameters are optional,
but, if one is specified, then both must be specified.

CASInstall.AgentManagerHostname
The host name or IP address for the agent manager.
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CASInstall.RegistrationPassword
The password for registering with the agent manager.

The following parameters are used to set the ports that the common agent
services will use. A valid number for each port is a number that is greater than
1024 and lesser than 65535. The values listed are the default values for each
parameter.
v CASInstall.AgentPort=9510

v CASInstall.NostopPort1=9514

v CASInstall.NonstopPort2=9515

4. Open a command prompt and change to the directory that contains the
Common Agent installation file. This file is in the \respository directory.

5. From the command prompt, type the following command and press Enter:
IBMSystemsDirectorAgentSetup.exe /s /a installationtype \
rsp="responsefile" option

where the variables are defined as follows:

installationtype
One of the following commands:
v unattended shows the progress of the installation but might still

require some user input.
v silent suppresses all output to the screen during installation.

responsefile
The absolute path and name of the response file that you created
previously. For example, c:\myfolder\myresponsefile.rsp. The rsp
parameter is optional. If you do not include the rsp parameter, the
installer uses the default response file in the package.

option One of the following optional parameters:

Table 33. Optional installation parameters

Optional parameter What it does

waitforme Ensures that installation processing will not end until this
installation is completed.

debug Logs all messages that are sent by the Microsoft Windows
Installer log engine, including status and information
messages.

log=logfilename Specifies the fully qualified name of an alternative log file.

verbose Enables verbose logging.

NIST In IBM Flex System Manager 6.3.5, when you install Common
Agent on Microsoft Windows by using the NIST option,
Common Agent is installed in NIST mode. If you do not select
the NIST option, Common Agent is installed without the NIST
mode.
Important: Platform Agent is always installed in NIST mode,
even if you do not specify the NIST option.

For example, type the following command:
IBMSystemsDirectorAgentSetup.exe /s /a silent
rsp="c:\myfolder\myresponsefile.rsp"

This example performs a silent installation of Common Agent on Windows
using the myresponsefile.rsp response file.
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6. If you set the RebootIfRequired parameter to Y in the response file, reboot the
system if prompted to do so.

Notes:

a. For Windows 2008, Service Pack 1 and earlier, if Microsoft Windows
Installer (MSI) 4.5 is not installed, then you are prompted to install
Microsoft Windows Installer (MSI) 4.5 and to run the installation program
again after the system restarts.

b. For Windows 2008 R2, MSI version 4.5 comes installed on the system.
c. For all other supported Windows platforms, if Microsoft Windows Installer

(MSI), version 4.5 or later is not installed on the system, it is installed
during the IBM Flex System Manager installation. If the upgrade of MSI is
necessary, the system prompts you to restart following the installation of
IBM Flex System Manager without specifying that MSI was upgraded.
Unless you install IBM Flex System Manager by using the response file and
set the RebootIfRequired parameter to N, you are prompted to restart
whether the IBM Flex System Manager installation completes successfully.

What to do next

To ensure full functionality of your new Common Agent instance, discover it with
IBM Flex System Manager.

Installing Common Agent on Virtual I/O Server
To install Common Agent on a system that is running Virtual I/O Server,
download the installation files from the IBM Flex System Manager support Web
site.

Before you begin

Important:

v Ensure that the system clocks on the systems that contain IBM Flex System
Manager and Common Agent remain synchronized.

v Common Agent and Platform Agent are now installed with Virtual I/O Server.
v You can also download Common Agent for installation on Virtual I/O Server

2.1.0.1 FP20.1 or higher using installp.

About this task

See Installing Common Agent on VIOS and IVM for instructions.

Note: You can follow the same steps to install Common Agent for systems that are
running on AIX or Virtual I/O Server.

What to do next

To ensure full functionality of your new Common Agent instance, discover it with
IBM Flex System Manager.

If you have not already merged and installed the updates as part of the
installation, then you can use update manager to update to the latest version of
IBM Flex System Manager. See “Updating IBM Flex System Manager” for
instructions.
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Duplicate MEPs appear after relocating logical partition from
AIX system

This problem affects IBM Power Systems compute nodes that are running AIX with
Common Agent 6.2.1 installed.

Problem

After you relocate a logical partition from a IBM Power Systems compute node
with AIX to another system, there two managed endpoints (MEPs) for the same
logical partition, instead of one.

Investigation

Check the version number of the Common Agent that is installed on the AIX
compute node. If the Common Agent version is 6.2.1, an unnecessary MEP was
created for the logical partition on the AIX compute node from which you
relocated.

Note: If your Power Systems compute node came installed with AIX, Common
Agent 6.2.1 might have been preinstalled with the operating system.

Explanation

A problem with Common Agent version 6.2.1 creates a duplicate MEP for a
relocated logical partition. The MEP on the source compute node (the AIX compute
node from which the logical partition was relocated) is unnecessary and should be
deleted.

Resolution

After the logical partition is relocated and you run inventory, the unnecessary MEP
is created. To remove the duplicate MEP and upgrade the Common Agent from
6.2.1 to 6.3.0 or later, complete the following steps.

Note: This topic describes how to access this task in the IBM Flex System Manager
Web user interface. If you are using the IBM FSM Explorer, use the finder at the
top of the user interface (shown here) to locate this task:

1. From the IBM Flex System Manager management software web interface, click
Resource Explorer.

2. Click All Systems.
3. Select the duplicate MEP from the table.
4. Click Actions > Remove....
5. Click OK to confirm that you want to remove the MEP.
6. Download and install Common Agent 6.3.0 or later on the AIX system.
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Installing Platform Agent
Prepare your systems and environment for Platform Agent. Then, use the Deploy
Agents wizard to deploy Platform Agent.

About this task

Important:

v It is not necessary to separately install Common Agent or Platform Agent.
v Use the Deploy Agents wizard in the management software web interface to

deploy Platform Agent. See Deploying agents for more information.
v The IBM i Platform Agent is provided with the IBM i Licensed Program Product

IBM Universal Manageability Enablement for IBM i (5770-UME or 5722-UME).
Refer to the IBM i documentation for details.

v Ensure that the system clocks on systems that contain IBM Flex System Manager
and Platform Agent remain synchronized.

v If you have BMC, IMM, or IMM2 service processors, use Platform Agent 6.1.1 or
later to help ensure full functionality and support.

v If you have RSA service processors, use Core Services 5.20.x to help ensure full
functionality and support. If you do decide to use Platform Agent 6.3.2 or later,
you must first uninstall Core Services 5.20.x before installing Platform Agent.

Restriction: Platform Agent 6.3.2 and later will block updates on Core Services
5.20.x systems and RSA service processors. You will no longer be able to manage
the RSA in-band. You can manage it out-of-band by connecting it to the network
and discovering it with IBM Flex System Manager.

v Discovery of Remote Supervisor Adapter (RSA) devices is no longer supported.
Therefore, you cannot use IBM Flex System Manager to manage new
installations of RSA devices.

v Platform Agent 6.1.1 and later uses a newer version of the LSI MR provider. This
provider will not function properly with older versions of the LSI device drivers.
In order to ensure that CIM data and alerts function properly with LSI devices,
it is important that the device drivers are at the latest levels for all Platform
Agent systems.

v See “Installing and uninstalling KVM Platform Agent” for considerations
regarding the use of Red Hat Enterprise Linux with Linux Kernel-based Virtual
Machine (KVM).

Note: If you are upgrading agents manually on a previously discovered endpoint,
you must discover the endpoint again after the upgrade. Discovering the endpoint
again allows the correct functionality to be reflected in IBM Flex System Manager.
For example if you are upgrading an endpoint from Agentless managed system to
Platform Agent through the manual agent installation script, you must then
discover the endpoint again with IBM Flex System Manager.

Preparing for a Platform Agent managed system
Before installing Platform Agent on a managed system make sure that the
requirements that are applicable to your system have been met.

About this task

Complete the following steps on each system to be managed with Platform Agent:
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Procedure

Set the clock on the managed system to match the time of the management server.
If the managed system time is earlier than that of the management server, the
management server will be unable to unlock the managed system.
To avoid the problem of system-time mismatch, you can configure managed
systems and the management server to synchronize their clocks using a common
network time protocol (NTP) server.

Note: The AIX operating system does not support a Platform Agent.

Preparing to install Platform Agent on IBM i
Before installing Platform Agent on IBM i (formerly i5/OS), ensure that your
platform meets the applicable requirements.

About this task

Platform Agent support for IBM i (formerly i5/OS) is provided with the IBM
Universal Manageability Enablement for IBM i Licensed Program Product that
ships with the base operating system. For more information about IBM i, see the
IBM i Information Center at http://publib.boulder.ibm.com/eserver/ibmi.html.

Review the following information and complete the necessary steps to prepare
your system for installation:

Procedure
v Ensure that any agentless managed systems are prepared for discovery, as

described in “Preparing agentless managed systems”.
v Ensure that the SLP service, which is provided with IBM i, is installed on the

system.
v Because the IBM i Platform Agent is provided by an IBM i Licensed Program

Product (LPP), ensure that the correct version of the IBM Universal
Manageability Enablement for IBM i (5770-UME) LPP is installed:

IBM i 7.1i 7.1 and IBM i 6.1 (formerly i5/OS, Version 6 Release 1)i 6.1
(formerly i5/OS, Version 6 Release 1)

V1R3 of the IBM Universal Manageability Enablement for IBM i
(5770-UME) LPP

IBM i 5.4 (formerly i5/OS, Version 5 Release 4)i 5.4 (formerly i5/OS, Version 5
Release 4)

V1R2 of the IBM Universal Manageability Enablement for IBM i
(5722-UME) LPP

Preparing to install Platform Agent on Linux on Power Systems
Before installing Platform Agent on Linux on Power Systems, make sure that your
platform meets the applicable requirements.

About this task

Review the following information and complete the necessary steps to prepare
your system for installation:

Procedure
v SUSE Linux Enterprise Server 10 on IBM Power Systems and SUSE Linux

Enterprise Server 11 on IBM Power Systems only: Disable the Service Location
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Protocol daemon (SLPD) before installing Platform Agent. IBM Flex System
Manager does not discover a managed system with Platform Agent installed
when the managed system is running SLPD.

v Ensure that the required RPMs are installed. To check for the fileset, type the
following command and press Enter:
rpm -qa | grep <filesetname>

where <filesetname> is the value in the “Required RPMs” column but without
the ppc.rpm or ppc64.rpm extension. In case of Platform Agent on Power
Systems, use the appropriate version of prerequisite RPMs. A list of required
RPMs for various releases can be found in the wiki that contains Software
requirements for IBM Flex System Manager 6.3.5 and higher on Linux on Power.

v Verify that the LD_LIBRARY_PATH environment variable is not exported
globally.

v Verify that no applications force the SSL libraries to be exported to the
/etc/ld.so.conf.d/ directory or the /root/.bash-profile directory.

What to do next

Preparing to install Platform Agent on Linux for X-Architecture
systems
Before installing Platform Agent on a managed system running Linux for
X-Architecture systems, make sure that your system meets all the applicable
requirements.

About this task

Review the following information and complete the necessary steps to prepare
your system for installation:

Procedure
v Ensure that the instance of Common Agent will be fully functional and able to

send alerts to IBM Flex System Manager. For the Common Agent to be fully
functional you might need to install service-processor device drivers or the IBM
LM78 and SMBus device drivers for Linux.

v Ensure that the required RPMs are installed.

Note: The Platform Agent installer checks for all of the RPMs and will notify
you if any are missing.
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Table 34. Required libraries for Linux on System x

Installation scenario Management server Common agent Platform agent

Red Hat Enterprise Linux openssh
libstdc++.so.5
libm.so.6
libgcc_s.so.1
libc.so.6
libdl.so.2
libpthread.so.0
unzip
libaio
libcrypt.so.1
libnsl.so.1
libpam.so.0
librt.so.1
bind-utils
net-tools
libstdc++.so.6
libuuid.so.1
libexpat.so.0

libcrypt.so.1
libc.so.6
libdl.so.2
libstdc++.so.5
libgcc_s.so.1
libm.so.6
libnsl.so.1
libpam.so.0
libpthread.so.0
librt.so.1
unzip
bind-utils
net-tools
libstdc++.so.6
libuuid.so.1
libexpat.so.0

libstdc++.so.5
bind-utils
net-tools
libpam.so.0
libstdc++.so.6
libuuid.so.1
libcrypt.so.1
unzip
libexpat.so.0
openssl1.0.1

SUSE Linux Enterprise
Server 10

SUSE Linux Enterprise
Server 11

openssh
libstdc++.so.5
libm.so.6
libgcc_s.so.1
libc.so.6
libdl.so.2
libpthread.so.0
unzip
libaio
libcrypt.so.1
libnsl.so.1
libpam.so.0
librt.so.1
bind-utils
net-tools
libstdc++.so.6
libuuid.so.1
libexpat.so.1

libcrypt.so.1
libc.so.6
libdl.so.2
libstdc++.so.5
libgcc_s.so.1
libm.so.6
libnsl.so.1
libpam.so.0
libpthread.so.0
librt.so.1
unzip
bind-utils
net-tools
libstdc++.so.6
libuuid.so.1
libexpat.so.1

libstdc++.so.5
bind-utils
net-tools
libpam.so.0
libstdc++.so.6
libuuid.so.1
libcrypt.so.1
unzip
libexpat.so.1
openssl1.0.1

Note: To display the currently installed minor version of openssl, use the
command openssl version.

v If you are running Red Hat Enterprise Linux 6.x, ensure that the following
RPMs are not installed because they impact network configuration support for
Platform Agent:
– NetworkManager-glib, and the following RPMs that depend on it:

- geoclue

- gimp-help-browser

- pywebkitgtk

- rhythmbox

- webkitgtk

– NetworkManager, and the following RPMs that depend on it:
- NetworkManager-openswan

- NetworkManager-gnome

- anaconda
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v Systems with service processors: Install the supporting device drivers and
mapping layers, if they are not already installed. See “Preparing to manage
service processors with IBM Flex System Manager” for information about these
drivers and mapping layers.

v Verify that the LD_LIBRARY_PATH environment variable is not exported
globally.

v If you want to use the Remote Session task on the managed system, make sure
that the package that contains telnetd daemon is installed and configured.

Preparing VMware managed systems
You might need to configure certain VMware systems before you can install agents
on them using the Agent Installation Wizard.

About this task

Managed systems running VMware ESX require the following configuration to
ensure that agents can be installed using the Agent Installation Wizard:

Procedure
1. On the VMware managed system, open the /etc/ssh/sshd_config file in a text

editor.
2. Locate the following line:

Ciphers aes256-cbc,aes128-cbc

3. Change the line to:
Ciphers aes256-cbc,aes128-cbc,3des-cbc

4. Save and close the /etc/ssh/sshd_config file.
5. Stop and restart the ssh daemon. Type the following command:

service sshd restart

6. Use VMware vSphere Client Security Profile Properties to enable ibmsa and
ibmcim.
a. Using VMware vSphere Client, connect to a VMware ESX 4.x system.
b. Click the Configuration tab.
c. Under Software, click Security Profile.
d. Select Properties and enable ibmsa and ibmcim.

7. Ensure the validity of any stored public key data for the target system in
root_SSH_data_directory/known_hosts on IBM Flex System Manager. See
“Common Agent cannot be installed on an AIX or Linux system” for more
information.

Preparing to install Platform Agent on Windows
Before installing Platform Agent on a managed system running Windows, make
sure that your system meets all the applicable requirements.

About this task

Review the following information and complete the necessary steps to prepare
your system for installation:

Procedure
v If there is an operating system update in progress, ensure the process is

complete and you restart the system before starting the Platform Agent
installation process.
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v Systems with service processors: Install the supporting device drivers and
mapping layers, if they are not already installed. See “Preparing to manage
service processors with IBM Flex System Manager” for information about these
drivers and mapping layers.

Installing Platform Agents using the Deploy Agents wizard
Use the Deploy Agents wizard from the Additional Setup tab on the IBM Flex
System Manager Home page to install Platform Agent packages that you have
downloaded and imported to the IBM Flex System Manager.

To install platform agents on a node, the operating system must be discovered on
the node. Platform agents can only be deployed to the operating system for which
they were built.

Installing Platform Agent manually
You can use these manual instructions to install Platform Agent on a managed
system. These manual instructions provide an alternative method of installation to
using the Agent Installation Wizard.

About this task

Important:

v It is not necessary to separately install Common Agent or Platform Agent.
v Use the Deploy Agents wizard in the management software web interface to

deploy Platform Agent. See Deploying agents for more information.
v The IBM i Platform Agent is provided with the IBM i Licensed Program Product

IBM Universal Manageability Enablement for IBM i (5770-UME or 5722-UME).
Refer to the IBM i documentation for details.

v Ensure that the system clocks on systems that contain IBM Flex System Manager
and Platform Agent remain synchronized.

v If you have BMC, IMM, or IMM2 service processors, use Platform Agent 6.1.1 or
later to help ensure full functionality and support.

v If you have RSA service processors, use Core Services 5.20.x to help ensure full
functionality and support. If you do decide to use Platform Agent 6.3.2 or later,
you must first uninstall Core Services 5.20.x before installing Platform Agent.

Restriction: Platform Agent 6.3.2 and later will block updates on Core Services
5.20.x systems and RSA service processors. You will no longer be able to manage
the RSA in-band. You can manage it out-of-band by connecting it to the network
and discovering it with IBM Flex System Manager.

v Discovery of Remote Supervisor Adapter (RSA) devices is no longer supported.
Therefore, you cannot use IBM Flex System Manager to manage new
installations of RSA devices.

v Platform Agent 6.1.1 and later uses a newer version of the LSI MR provider. This
provider will not function properly with older versions of the LSI device drivers.
In order to ensure that CIM data and alerts function properly with LSI devices,
it is important that the device drivers are at the latest levels for all Platform
Agent systems.

v See “Installing and uninstalling KVM Platform Agent” for considerations
regarding the use of Red Hat Enterprise Linux with Linux Kernel-based Virtual
Machine (KVM).
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Installing Platform Agent on IBM i
Platform Agent support for IBM i (formerly i5/OS) is provided with the IBM
Universal Manageability Enablement for IBM i Licensed Program Product that
ships with the base operating system. Use UME to configure Platform Agent on a
system that is running IBM i.

About this task

Platform Agent on IBM i provides agentless function, Common Information Model
(CIM) events and monitoring, inventory, and IBM Flex System Manager support
for IBM i groups and cumulative PTFs.

Complete the following steps to configure Platform Agent on IBM i:

Procedure
1. Ensure that the agentless managed server (SSH) is started. If it is not started,

run the following command to start the SSH service:
strtcpsvr *sshd

2. Run the following command to start the SLP service:
strtcpsvr *slp

3. Run the following command to start the CIM server:
strtcpsvr *cimom

4. Ensure that collection services is running so that you can monitor resources. To
start collection services, run a set of commands that is similar to the following
example commands, substituting in your own values if necessary:
CFGPFRCOL INTERVAL(5.0) CYCITV(01)
ENDPFRCOL
STRPFRCOL CYCCOL(*YES)

Results

With SSH, SLP, and CIM running, your IBM i system is ready to provide Platform
Agent functionality.

What to do next

Use IBM Flex System Manager to discover, access, and manage the IBM i system.

Installing Platform Agent on Linux on Power Systems
To install Platform Agent on a system that is running Linux on Power Systems,
download the installation files from the IBM Flex System Manager support Web
site.

Before you begin

Important:

v Platform Agent 6.3.7 for Linux on Power Systems is released as a full installer
package that you can download from the IBM Flex System Manager support
Web site. You can use the Platform Agent 6.3.7 installer package for fresh
installations or for upgrading previous versions of Platform Agent for Linux on
Power Systems to 6.3 and then updating to 6.3.7. You can install the package
manually, as described in this topic, or using the Installation Wizard, but you
cannot install the full package using update manager.
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About this task

You can install Platform Agent on Linux on Power Systems from a downloaded
installation package.

Important: The IBM Flex System Manager, Common Agent, and Platform Agent
installation packages for Linux are provided in English only.

Table 35. Installation options for Platform Agent on Linux on Power Systems

Installation method Title or file name

Downloaded installation
package

v SysDir6_3_x_Platform_Agent_Linux_Power.tar.gz (agent
package for manual installation)

v SysDir6_3_x_Platform_Agent_Linux_Power.jar (agent
package for Agent Installation Wizard installation)

Complete the following steps to install Platform Agent on Linux on Power
Systems:

Procedure
1. Start the installation from the installation source:

Downloaded installation files: To start the installation from a Web download,
complete the following steps:
a. Download the installation package.

1) Go to the IBM PureSystems Updates website.
2) Click the table for the version of IBM Flex System software that you are

using (for example, Flex System 1.3.1).
3) Click the link to the IBM Flex System Manager image.
4) Download the Platform Agent

Note: The Platform Agent will be similar to the following:

For a new or update install of the agent on a remote system:
Flex1_3_1_Platform_Agent_Linux_Power

For updating the Platform Agent that is already installed on a remote
system:
Flex1_3_1_PA_Linux_Power

b. To unzip and extract the contents of the installation package to a local
directory, type one of the following commands:
gzip -cd SysDir6_3_x_Platform_Agent_Linux_Power.tar.gz | tar -xvf -

or
jar -xvf agents/SysDir6_3_x_Platform_Agent_Linux_Power.jar

c. Change to the directory in which the installation script is located. Type the
following command and press Enter:
cd /install_files/repository

where install_files is the path to the extracted installation files.
d. If you used the jar command, change the permission setting of the

installation script to make it accessible. Type the following command and
press Enter:
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chmod u+x dir6.3.x_platform_agent_linux_power

2. Optional: To customize the installation, copy the response file to a local
directory and modify the installation settings in your local copy.
a. Type the following command and press Enter:

cp platform.rsp /directory/

where directory is a local directory.
b. Open an ASCII text editor and modify the installation settings in the copy

of the response file. This file is fully commented.
c. Save the modified response file.

Tip: After installation, keep the response file for future use and reference.
3. To install Platform Agent, from within the directory in which the installation

script is located, type one of the following commands, and press Enter:

v To accept the default settings:
./dir6.3.x_platform_agent_linux_power.sh

v To use the response file:
./dir6.3.x_platform_agent_linux_power.sh -r /directory/response.rsp

where directory is the local directory to which you copied the response file
and response.rsp is the name of the response file.

Note: To extract the file sets but not install Platform Agent, enter the following
command:
./script.sh -x distro [-p extract_directory]

where script.sh is the file name of the script depending on how you obtained
it, distro is one of rhel4_rhel5, sles10_sles11, or all, and extract_directory
is the local directory into which you want to extract the installation files.

Note: Platform Agent version 6.3.5 and earlier does not support SLES 10 for
Power Systems. You can install Platform Agent up to version 6.3.4 on SLES 10
for Power Systems.
Platform Agent is started automatically when installation completes.

What to do next

Enable SNMP Access and Trap Forwarding by installing and configuring
Net-SNMP. For instructions and information, see http://www.net-snmp.org/.

Installing Platform Agent on Linux for X-Architecture compute
nodes
To install Platform Agent on a system that is running Linux for X-Architecture
compute nodes, download the installation files from the IBM Flex System Manager
support website.

Before you begin

Important:

v Ensure that the system clocks on systems that contain IBM Flex System Manager
and Platform Agent remain synchronized.
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About this task

Note: Discovery of Remote Supervisor Adapter (RSA) devices is no longer
supported. Therefore, you cannot use IBM Flex System Manager to manage new
installations of RSA devices.

You can install Platform Agent on Linux for X-Architecture compute nodes from a
downloaded installation package.

Important: The IBM Flex System Manager, Common Agent, and Platform Agent
installation packages for Linux are provided in English only.

Table 36. Installation on Linux for X-Architecture compute nodes

Installation method Title or file name

Downloaded installation
package 6.3.7 agents

Install the 6.3.7 agents unless you need full
support for earlier agents that have the previously
specified hardware and software configurations.

v SysDir6_3_x_Platform_Agent_Linux_x86.tar.gz
(agent package for manual installation)

v SysDir6_3_x_Platform_Agent_Linux_x86.jar
(agent package for Agent Installation Wizard
installation)

Complete the following steps to install Platform Agent on Linux for X-Architecture
compute nodes:

Procedure
1. Start the installation from the installation source:

Downloaded installation files: To start the installation from a Web download,
complete the following steps:
a. View the IBM Flex System Manager downloads technote which provides

information about acquiring the agent installation packages at:
https://www-01.ibm.com/support/
docview.wss?uid=nas7452a24e9851ad53f86257f8f004bce0b.

b. To extract the contents of the installation package to a local directory, type
one the following commands:
tar -zxvf SysDir6_3_x_Platform_Agent_Linux_x86.tar.gz

or
jar -xvf SysDir6_3_x_Platform_Agent_Linux_x86.jar

c. Change to the directory in which the installation script is located. Type the
following command and press Enter:
cd /install_files/repository

where install_files is the path to the extracted installation files.
d. If you used the jar command, change the permission setting of the

installation script to make it accessible. Type the following command and
press Enter:
chmod +x dir6.3.x_platform_agent_linux_x86
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2. Optional: To customize the installation, copy the response file to a local
directory and modify the installation settings in your local copy.
a. Type the following command and press Enter:

cp platform.rsp /directory/

where directory is a local directory.
b. Save the modified response file.

Tip: After installation, keep the response file for future use and reference.
3. To install Platform Agent, from within the directory in which the installation

script is located, type one of the following commands and press Enter:

v To accept the default settings:
./dir6.3.x_platform_agent_linux_x86

v To output a usage statement that documents the command line options:
./dir6.3.x_platform_agent_linux_x86 -h

v To use the response file:
./dir6.3.x_platform_agent_linux_x86 -r /directory/response.rsp

v To start an unattended installation:
./dir6.3.x_platform_agent_linux_x86 -i

where directory is the local directory to which you copied the response file,
and response.rsp is the name of the response file. Platform Agent is started
automatically when installation completes.

What to do next

Installing Platform Agent on Windows
After preparing your system, you can install Platform Agent on a system that is
running Windows by downloading the installation files from the IBM Flex System
Manager support website. You can then perform a standard installation or upgrade
by using the wizard.
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Chapter 6. Managing agents

You can use IBM Flex System Manager to deploy and manage agents (including
Common Agent and Platform Agent).

About this task

Note: Throughout the IBM Flex System Manager documentation, the term
Common Agent (with both words capitalized) refers to the IBM Flex System
Manager Common Agent, which includes subagents that provide specific
management capabilities for IBM Flex System Manager. IBM Flex System Manager
can also discover and perform limited management on other common agents that
use the common agent services (CAS) architecture. When referring to these
common agents generically, lowercase text is used.

Common agent services
IBM Flex System Manager uses the common agent services (CAS) architecture,
which provides a shared infrastructure for managing systems. This infrastructure,
which includes resource manager, agent manager, and common agent elements, is
also used by Tivoli Provisioning Manager products.

Important: The latest version of Common Agent is 6.3.5. Therefore, for IBM Flex
System Manager, version 1.3.4, Common Agent remains at version 6.3.5.

The goal of common agent services is to reduce infrastructure cost, complexity, and
redundancy by providing a common agent that can be used by multiple
management products instead of multiple separate agents that each provide
essentially the same functionality.

To achieve this goal, one or more resource managers (such as IBM Flex System
Manager) use an agent manager to communicate with the common agents that are
installed on managed resources.

Resource manager
Installed on the management server, the resource manager is the management
application that uses the agent manager for security and credential management.
IBM Flex System Manager is the resource manager for IBM Flex System Manager.

Multiple resource managers can use the same agent manager and manage the same
common agents.
v Each common agent can use exactly one agent manager.
v Each resource manager can use exactly one agent manager.
v Each resource manager can manage many common agents.

Agent manager
The agent manager provides authentication and authorization services for installed
common agents and resource managers. It also maintains a registry of
configuration information about Common Agent managed systems.
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Note: Except for security and credential management, systems management
communications between IBM Flex System Manager and common agents do not go
through the agent manager.

IBM Flex System Manager uses only one active agent manager at a time to
communicate with common agents. If no agent manager is active, IBM Flex System
Manager is not able to manage common agents.
v Each common agent can use exactly one agent manager.
v Each agent manager can be used by many resource managers.
v Each agent manager can be used to manage many common agents.

Notes:

v The agent manager that is embedded with IBM Flex System Manager can be
used by any number of instances of IBM Flex System Manager, but it is not
configured for use with other management application products.

v If you will use the locally embedded agent manager, you need to supply
credentials when you configure it that are used if you change agent managers.
These credentials depend on your operating system:
– On AIX or Linux, you can specify any credentials. You do not need to use the

root user ID or even an operating system user ID.
– On Windows, use the same administrator credentials that you used to install

IBM Flex System Manager.

The agent manager has the following parts:

agent manager service
The agent manager utilizes http servlets or Web services to manage agents
for IBM Flex System Manager and other products. The agent manager service
provides authentication and authorization using X.509 digital certificates
and the Secure Sockets Layer (SSL) protocol. It also processes queries
against its registry of configuration information about common agents and
resource managers. Resource managers and common agents must each
register with the agent manager before they can use its services to
communicate with each other.

The agent manager service provides the core agent manager functionality
with the following services:

Service catalog
Provides information about the location of the agent manager
service.

Credential manager
Enables the agent manager to act as a certificate authority and
issue security credentials and revocation lists to managed elements.

Agent registry
Retrieves information about the common agent resources.

Querying service
Enables the resource manager to query the agent registry for the
agent and resource manager information.

agent manager registry
The agent manager registry stores the following information in a database:
v The identity, digital certificates, and communication information for each

resource manager
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v The identity, digital certificate, and status for each common agent
v Basic configuration information about each common agent including

information about the type and version of the hardware and operating
system

v The last error or, optionally, a configurable number of errors, reported by
each common agent

v Communication parameters for the common agent, including IP address,
the port or ports for which the common agent is configured, and the
supported protocol

Common agent
Installed on managed systems, the common agent reports information about the
managed system to the resource manager and performs tasks on the managed
system as directed by the resource manager.

Note: Throughout the IBM Flex System Manager documentation, the term
Common Agent (with both words capitalized) refers to the IBM Flex System
Manager Common Agent, which includes subagents that provide specific
management capabilities for IBM Flex System Manager. IBM Flex System Manager
can also discover and perform limited management on other common agents that
use the common agent services (CAS) architecture. When referring to these
common agents generically, lowercase text is used.
v Each common agent can use exactly one agent manager.
v Each common agent can be managed by one or more instances of IBM Flex

System Manager.

Note: All instances of IBM Flex System Manager must use the same agent
manager, and the common agent must be registered with that agent manager.

When you discover a system that has a common agent on it, the IBM Flex System
Manager Web interface will list the system with a protocol of 'CAS'. The system
will initially have no access, but you can register the agent with the agent manager
using one of the following two methods, depending on the mode you used to
install common agent services:

Managed mode common agent services
Common agent services registers the common agent with the agent
manager during installation.

Unmanaged mode common agent services
Requesting and gaining access to the system registers the common agent
with the default agent manager that is configured with IBM Flex System
Manager.

Logging Platform Agent
Use the PALog.INI configuration file to configure logging for Platform Agent. This
topic describes the property values and options to use with that file.

The PALog.INI file is located at the following paths:
v On Linux: PA_INSTALL_DIR/platform/data/PALog.INI
v On Windows: PA_INSTALL_DIR\cimom\data\PALog.INI

where PA_INSTALL_DIR is the Platform Agent installation path.
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Example ITA properties file
# ITA Properties file written Sat Sep 04 19:43:00 2010

[PlatformAgent.Logging]
codeset_dir =
config_type = cclog
logging_type = ita_logdefault
nlspath =
start_logdaemon = none
use_logdaemon = false

[PlatformAgent.Logging.cclog]
PlatformAgent.organization = CompanyA
PlatformAgent.logger.className = ccg_pdlogger
PlatformAgent.logger.listenerNames = PlatformAgent.loggerfl PlatformAgent.ffdc
PlatformAgent.loggerfl.className = ccg_levelfilter
PlatformAgent.loggerfl.level = ALL
PlatformAgent.loggerfl.listenerNames = PlatformAgent.loggerhd
PlatformAgent.loggerhd.className = ccg_filehandler
PlatformAgent.loggerhd.fileName = agent.log
PlatformAgent.loggerhd.formatterName = PlatformAgent.fmt
PlatformAgent.loggerhd.maxFileBytes = 4096000
PlatformAgent.loggerhd.maxFiles = 3
PlatformAgent.fmt.className = ccg_basicformatter
PlatformAgent.ffdc.className = ccg_ffdc_filecopy_handler
PlatformAgent.ffdc.baseDir = PlatformAgent-FFDC
PlatformAgent.ffdc.filesToCopy = agent.log
PlatformAgent.ffdc.triggerFilter = PlatformAgent.lf
PlatformAgent.lf.className = ccg_levelfilter
PlatformAgent.lf.level = ERROR
PlatformAgent.tracer.className = ccg_pdlogger
PlatformAgent.tracer.listenerNames = PlatformAgent.trfl
PlatformAgent.trfl.className = ccg_levelfilter
PlatformAgent.trfl.level = OFF
PlatformAgent.trfl.listenerNames = PlatformAgent.trhd
PlatformAgent.trhd.className = ccg_filehandler
PlatformAgent.trhd.fileName = agent.trace
PlatformAgent.trhd.maxFileBytes = 4096000
PlatformAgent.trhd.maxFiles = 3
PlatformAgent.trhd.formatterName = PlatformAgent.trfmt
PlatformAgent.trfmt.className = ccg_basicformatter

PlatformAgent.fmt.className
Sets the format in which messages are logged. The following values are
accepted:

ccg_basicformatter
The text format in which the messages are logged.

ccg_xmlformatter
The XML format in which the messages are logged.

PlatformAgent.logger.className
Indicates the type of logging handle to use for the logger. The following
values are accepted:

ccg_basiclogger
A basic logger class, with support for localized and non-localized
messages. Loggers of this class do not automatically add any data
to the event except for the timestamp. ccg_basiclogger does not
show the LEVEL information. The following example shows what
the output might look like:
2010-09-04 20:04:43.671+05:30 PlatformAgent.Test | This is a test

message
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ccg_pdlogger
An extended logger class with extra information for diagnosing
application problems. Loggers of this class automatically add the
names of the product, component, server, and organization to the
event, along with the timestamp. The following example shows
what the output might look like:
2010-09-24 08:14:39.663-04:00 18446744073559305104 7093 CompanyA

nettk125.trow.netfinity.com PlatformAgent | Start Logger
PlatformAgent.

Note: If the className value is set to NULL, a warning message does not
appear on the IBM Flex System Manager Web interface. It instead appears
on the agent console. A default logger with the name
PlatformAgent_default_message.log is created for logging the warning
message information.

PlatformAgent.logger.listenerNames
Specifies a list of names that procures events from the specified logger,
filter, or handler. Ensure that the names are the names of objects that are
defined in the same properties file. Separate the names in the list with
spaces. By default, Platform Agent supports two listeners: logger and
FFDC. To disable the FFDC, remove the PlatformAgent.ffdc entry.

PlatformAgent.loggerfl.className
Specifies the class name for the logging level filter. This property is not
configurable; do not change it.

PlatformAgent.loggerfl.level
Specifies the logging filters with log level values. The following values are
accepted:

ALL Enables all log levels.

FATAL
Instructs the filter to block all events that are at a level lower than
fatal.

ERROR
Instructs the filter to block all events that are at a level lower than
error.

WARNING
Instructs the filter to block all events that are at a level lower than
warning.

INFO Instructs the filter to block all events that are at a level lower than
info.

DEBUG_MIN
(Default log and trace value.) Sets the debugging log levels to the
minimum value and includes extra debugging information such as
method name, function name, and line numbers.

DEBUG_MID
Sets the debugging log levels to the median value and includes
extra debugging information such as method name, function name,
and line numbers.

DEBUG_MAX
Sets the debugging log levels to the maximum value and includes
extra debugging information such as method name, function name,
and line numbers.
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OFF Disables logging and creates a log file that contains only a message
stating that the logger initialized. No other messages are logged.

When no log level is specified, a warning message appears. A default
logger with the name PlatformAgent_default_message.log is created for
logging the warning message information.

A default tracer with the name PlatformAgent_default_trace.log is created
for logging the trace information.

PlatformAgent.loggerfl.listenerNames
Assigns the logger handler that manages the logging properties that are
related to the log file. This property is not configurable; do not change it.

PlatformAgent.loggerhd.appending
Indicates whether to append or overwrite existing file handler output files.
The following values are accepted:

TRUE (Default value.) Causes existing files to open in append mode.

FALSE
Causes existing files to be overwritten.

PlatformAgent.loggerhd.className
Indicates the type of handler to use for the logger. The following values are
accepted:

ccg_filehandler
Logs the messages to a file.

ccg_consolehandler
Logs the messages to the IBM Flex System Manager Web interface.
This option is not supported.

PlatformAgent.loggerhd.fileName
Indicates the full path of the log file. If this property is set to blank, no log
file is created, a warning message appears, and no logging takes place.

Note: If a Windows path name is specified in a properties file, you must
double the back-slashes like in the following example:
fooHandler.baseDir: C:\\temp\\myApp\\

PlatformAgent.loggerhd.formatterName
Specifies the handle to the Platform Agent formatter, which takes care of
assigning a particular format for the log file. This property is not
configurable; do not change it.

PlatformAgent.loggerhd.maxFileBytes
Indicates the maximum file handler output file size (in bytes). When that
size is reached, the log file is closed and renamed, and an empty new log
file is opened. This property has no effect unless the set value of the
maxFiles property is greater than one.

Note: For the correct behavior, set this value higher than 10 KB. If it is set
to less than 10 KB, the maxFileBytes size of the rollover files cannot be
interpreted if the log messages are high.

Example: In the following example, the first rollover file is of size
agent.log and the next rollover files is of size maxFileBytes:
Size of the rollover files = if ( sizeofagent.log > maxfileBytes )
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PlatformAgent.loggerhd.maxFiles
Indicates the maximum number of file handler output files that are created
before the oldest one is recycled. If this property is set to 1 or 0, the current
log file never closes and might grow without limit. A warning message
appears. The default value is 3.

PlatformAgent.organization
Displays the organization name as IBM in the log file.

Trace properties
The following trace properties are like their companion log properties.

Note: The default trace level is OFF.
v PlatformAgent.tracer.className
v PlatformAgent.tracer.listenerNames
v PlatformAgent.trfl.className
v PlatformAgent.trfl.level
v PlatformAgent.trfl.listenerNames
v PlatformAgent.trfmt.className
v PlatformAgent.trhd.className
v PlatformAgent.trhd.fileName
v PlatformAgent.trhd.formatterName
v PlatformAgent.trhd.maxFileBytes
v PlatformAgent.trhd.maxFiles

FFDC properties

PlatformAgent.ffdc.className
When set to ccg_ffdc_filecopy_handler, copies specified files to an
output directory whenever triggered by an event. This action
allows the creation of backup copies of files, the contents of which
might have been otherwise overwritten before examined.

PlatformAgent.ffdc.baseDir
Required value that designates the base directory into which all
FFDC output is placed. To conform to the Tivoli Serviceability
Imperative, this base directory must adhere to the following
format:
[install-Dir]/[log]/PlatformAgent-FFDC/

Whenever FFDC actions occur, daily subdirectories with the
following format are created under the base directory:
[baseDir]/[YYYY.MM.DD]/

where YYYY.MM.DD is the numeric year, month, and day from the
timestamp of the event that triggered the FFDC action.

By default, no base directory is specified, and no FFDC actions are
performed by an FFDC handler until the property is specified.
Instead, a warning is issued until the property is set.

Note: If a Windows path name is specified in a properties file, you
must double the back-slashes like in the following example:
fooHandler.baseDir: C:\\temp\\myApp\\
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PlatformAgent.ffdc.filesToCopy
Specifies the files to copy. To copy multiple files on Windows,
enclose each file name in quotations and separate each one by a
space.

If you specify to log the ERROR level, FFDC is triggered and files
are copied into the directory that is specified by the
PlatformAgent.ffdc.baseDir property.

Every time FFDC is triggered, message files are appended.

PlatformAgent.ffdc.triggerFilter

Required value that designates the name of a CCLOG or CFFDC
filter to control which events trigger an FFDC action.

By default, no trigger filter is specified, and no FFDC actions are
performed by an FFDC handler until the property is specified.
Instead, a warning is issued until the property is set.

PlatformAgent.ffdc.triggerRepeatTime
Sets the minimum amount of time, in milliseconds, that it will take
the handler to respond to more triggering events after a triggering
event. Use this property to limit how rapidly a given FFDC action
is repeated. For example, it might not make sense for a given
application to take an AutoTrace snapshot less than 10 seconds
after the previous snapshot.

PlatformAgent.ffdc.maxDiskSpace

Sets the maximum disk space, in bytes, that is allotted to the FFDC
data. When the total space used by the FFDC data exceeds the
specified limit, a warning is issued and, depending on the quota
policy, actions are taken. Those actions might include the automatic
deletion of older files or the suspension of new FFDC actions until
more space is made available by the manual removal of files. By
default, the maximum disk space is 10 megabytes (10*1024*1024).

PlatformAgent.ffdc.quotaPolicy

Designates the policy that specifies what to do when the FFDC
directory exceeds the disk space limit. The following values are
allowed:

QUOTA_AUTODELETE
(Default value.) Automatically deletes FFDC files, in a
decreasing order of age, until the directory is below the
disk space limit.

QUOTA_IGNORE
Issues warnings but do not enforce the FFDC disk space
quota.

QUOTA_SUSPEND
Halts further FFDC actions until the FFDC directory is
manually cleaned up to below the disk space limit.

PlatformAgent.ffdc.firstWarning

A percentage of maximum disk space usage for the first warning.
A first warning is issued if the disk space usages exceeds this
value. Set this value to a floating-point value between 0.0 and 1.0.
The default first warning threshold is 0.75.
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PlatformAgent.ffdc.secondWarning

Sets a maximum percentage of disk space usage for the second
warning. A second warning is issued if the disk space usages
exceeds this value. Set this value to a floating-point value between
0.0 and 1.0. The default second-warning threshold is 0.90.

PlatformAgent.lf.className
Sets the trigger filter for the FFDChandler ccg_level_filter, which
specifies that the FFDC trigger occurs, and then monitors the log
levels in the log file.

PlatformAgent.lf.level
Designates the FFDC trigger level value of the log levels in the
logging filters. The following values are accepted:

FATAL
Triggers the FFDC when a fatal error message is logged in
the log file.

ERROR
Triggers the FFDC when an error error message is logged
in the log file.

When no log level is specified, a warning message appears. A
default logger with the name PlatformAgent_default_message.log
is created for logging the warning message information.

A default tracer with the name PlatformAgent_default_trace.log is
created for logging the trace information.

PALog.INI and PALog.INI.bkp files

The PALog.INI.bkp file is created as a backup in case a process crashes while
updating the PALog.INI file.

When you modify any configuration, use PALog.INI.bkp to ensure that the
property ITA logging initialization File I/O takes place properly.

If both of these files are deleted, ITA fails to initialize the logger and throws an
error message. The location of the error file is ./tmp/italog_error.log on Linux
and %TEMP%/italog_error.log on Windows.

ITA logs only the initialization error messages in to the error log file.

If the PALog.INI is corrupted or invalid property values are assigned, no error
messages are logged to the italog_error.log file. No such error messages appear on
the IBM Flex System Manager Web interface.

PALog.INI is not recreated if it is corrupted. For every successful logger
initialization, PALog.INI.bkp is overwritten with the PALog.INI.

Importing agent packages
IBM Flex System Manager can import agent packages that have been downloaded
from the Web or obtained on physical media. These agent packages then can be
distributed to managed systems using the Agent Installation Wizard.
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Before you begin

The agent packages that IBM Flex System Manager uses are Tivoli Provisioning
Manager automation packages with a file extension of .jar.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

Use the following procedure to import one or more agent packages for distribution
using the Agent Installation Wizard.

Note: Platform Agent updates are in Update Manager format packages. Use the
importupd command to import the Platform Agent packages.

Procedure
1. Download the installation package from the IBM Systems Director agents

section of this website: http://www.ibm.com/support/
docview.wss?uid=nas7452a24e9851ad53f86257f8f004bce0b

2. Copy the package files to a directory on the management server.
3. On the Initial Setup tab of the Home page, click Chassis Manager. On the

Chassis Manager page, type Install Agent in the Find field, then click Install
Agent in the resulting list on the Tasks tab. The available agent and subagent
package groups are listed.

Note: A subagent plugs in to a base agent and provides additional capabilities
to support IBM Flex System Manager plug-ins such as IBM Flex System
Manager VMControl. This documentation uses the collective term “agents” to
refer to both agents and subagents.

4. Click Import Agent. The Import Agent window opens.
5. Type the path on the management server where you copied the package files in

step 2, and then click OK.

Results

All of the agent packages that are found in the specified path are imported, and a
confirmation message appears indicating that the packages were successfully
imported.

Note: The imported packages might not appear in the agent package groups list
immediately.
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What to do next

After the agent packages are successfully imported and appear in the agent
package groups, you can install the packages using the Agent Installation Wizard.

Installing agents using the Agent Installation Wizard
You can use the Agent Installation Wizard to install agent packages on managed
systems.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

IBM Flex System Manager requires a number of agent packages that can be
deployed to managed systems using the Agent Installation Wizard.The imported
agent packages are located in the dynamic group “Agent Package Groups” and can
be accessed by clicking Release Management > Agents in the left navigation area
(which is hidden by default in the web interface). You use the Agent Installation
Wizard to select one of these agent packages to install and one or more systems on
which to install the agent package. Then, the wizard creates an agent installation
job that can run immediately or at a scheduled time.

Important: Ensure that the following requirements are met to enable use of the
Agent Installation Wizard to install and update agents:
v The root user account was used to initially request access to the managed

system.
v IBM Flex System Manager on non-Windows systems has SSH, and a successful

SSH connection exists in both directions between the server and the agent.
v IBM Flex System Manager on Windows systems has DCOM, and a successful

DCOM connection exists in both directions between the server and the agent.
v In case of Power Systems different versions of Platform Agent require different

version of RPMs. The list of required RPMs is available at: Software
requirements for IBM Flex System Manager on Linux on Power. When you use
the Pre-Installation Utility to ensure that your system meets theIBM Flex System
Manager requirements, the RPMs are used to fulfill part of the prerequisites.

Note: If you plan to install Common Agent on an Power Systems compute node
with the AIX operating system, make sure that you download and install Common
Agent version 6.3.0 or later.

A problem with Common Agent version 6.2.1 can cause a duplicate managed
endpoint (MEP) to be created for a relocated logical partition. If you install
Common Agent version 6.2.1 on an AIX compute node and relocate a logical
partition from that compute node to another system, you might see two managed
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endpoints (MEPs) for the same logical partition instead of one. The MEP on the
source compute node (or the compute node from which the logical partition was
relocated) is unnecessary and should be deleted. To delete the duplicate MEP,
remove the MEP on the source compute node in the management software web
interface after inventory collection is complete for the source compute node.

Complete the following steps to import the agent packages:
1. Acquire the Remote Deployment installation packages for the IBM Flex System

Manager agents.
View this document for information about acquiring the installation packages:
http://www.ibm.com/support/
docview.wss?uid=nas7452a24e9851ad53f86257f8f004bce0b.

2. Copy the packages to the IBM Flex System Manager system. See Importing
updates for instructions about copying packages to the management node.

3. Import the packages with the Agent Installation Wizard.
4. Make any required changes to the diragent.rsp and or platform.rsp response

files. See the topic for your operating system under “Installing Common Agent
manually” or “Installing Platform Agent manually” for instructions about how
to change the response files.

Complete the following steps to install agents using the Agent Installation Wizard:

Procedure
1. Start the Agent Installation Wizard by right-clicking an agent package and

selecting Release Management > Install Agent.
2. In the Agent Installation Wizard Agents page, complete the following steps:

a. Select the agent or subagent package that you want to install in the
Available list.

Note: A subagent plugs in to a base agent and provides additional
capabilities to support IBM Flex System Manager plug-ins such as IBM Flex
System Manager VMControl. This documentation uses the collective term
“agents” to refer to both agents and subagents.

b. Click Add. The selected agent package is displayed in the Selected list.

Note: The Agent Installation Wizard can install only one agent package at a
time. If more than one agent package is displayed in the Selected list, you
will not be able to advance to the Systems page.

c. Click Next.
3. In the Agent Installation Wizard Systems page, complete the following steps:

a. Select the managed systems on which you want to install the agent package
in the Available list.

b. Click Add. The selected systems are displayed in the Selected list.

Note: Depending on the agent package being installed, some selected
systems might not be valid targets for installation. The wizard checks the
selected systems for some or all of the following criteria to ensure that the
systems are valid targets for installing the selected agent package before
allowing you to continue:
v operating system family
v operating system version
v operating system distribution
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v operating system name
v server architecture

c. Click Next.
4. In the Agent Installation Wizard Summary page, review the Selected Agents

and Selected Systems lists to ensure that they are correct.
v If the selections are not correct, click Back and make the necessary changes.
v If the selections are correct, click Finish.

After you click Finish, the Run - Install Agent window opens.
5. In the Run - Install Agent window, click the Schedule tab. On this page, you

can choose to run the job immediately or schedule the job to run at a later time.
a. A job name is required and the Name field provides a unique default name.

To change the default name, type a job name in the field.
b. To run the job immediately, click Run Now and go to step 6 on page 220.

Otherwise, click Schedule.
c. In the Schedule list, select how frequently you want the job to run. The

default setting is Once. Other values are Hourly, Daily, Weekly, Monthly,
Yearly, or Custom. Also, you can specify whether to run the job on the
weekend.

d. Select the date and time to run the job for the first time.
e. Select the time range for the job to repeat.

6. Click the Notification tab. On this page you can customize a notification that is
sent by e-mail.
a. Select from the available criteria to customize when the mail notification is

sent. You can specify that the mail be sent when one of the following
criteria is met:
v When the job begins.
v When the job completes successfully.
v When the job fails. You can further customize this criterion by setting

either the percentage of target systems on which the job had errors or the
number of systems on which the job had errors. Therefore, if the job runs
on five systems, the job has errors on two systems, and you set the
criterion threshold to 50%, the notification is not sent.

v When the job receives any error.
b. Type your mail address, mail server, and mail server port.

Tip: You can provide only one mail address.
7. Click the Options tab. On this page you can select additional options for the

job behavior.
a. Select whether you want the job to run according to your management

server's time or the target system's time.

Tip: Make sure that you know the time and time zone to which the
respective systems' clocks are set.

b. Select whether you want the job to fail if a system is offline or if you want
the job to run when the system is online again.

8. Click OK to save the job.
Click Cancel to exit from the Launch Job window without saving the job.
If the job is created successfully, a message is displayed on the page from
which you started the Scheduler. If the job creation fails, a message is displayed
in the Launch Job window so that you can correct the job.
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The job created by the Agent Installation Wizard will transfer the agent
self-extracting script and the agent response file into the following directory,
which depends on your agent level, on the target system:

Common Agent
/tmp/commonagent_tmp

Platform Agent
/tmp/platformagent_temp

After the files are copied, the installation file sets are extracted into the /tmp
directory and installed. The files are then removed after a successful
installation. You need to ensure that there is sufficient space on the target
system to copy the self-extracting script and extract the file sets. Refer to the
space requirements as specified in “Hardware requirements for systems
running Common Agent or Platform Agent”.
If the agent deployment completes with errors, check the log file for your target
operating system for a possible root cause:
v AIX and Linux:

– Common Agent: /var/log/dirinst.log
– Platform Agent: /opt/ibm/platform/log/install.log

v Windows: %WINDIR%/diragentinst_timestamp.log or %WINDIR%/
platint_timestamp.log

Note: For more information about error log files, see “Information to provide
to the IBM Technical Support Center”.

Notes for AIX:

v Refer to “Installing Common Agent on AIX” for more detail on the
self-extracting script and the response file options.

v For AIX server and agents, it is less space consuming to remotely install
agents using NIM as explained in the IBM Flex System Manager Best
Practices wiki page “Installing IBM Flex System Manager Common Agent for
AIX using NIM” at http://www.ibm.com/developerworks/community/
wikis/home?lang=en#!/wiki/W3e8d1c956c32_416f_a604_4633cd375569/
page/
Installing+IBM+Systems+Director+Common+Agent+for+AIX+using+NIM.
Installing with NIM does not allow the use of a response file.

What to do next

You can view the status of the agent installation job by clicking Task Management
> Active and Scheduled Jobs.

If you installed Platform Agent on Linux, enable SNMP Access and Trap
Forwarding by installing and configuring Net-SNMP. For instructions and
information, see http://www.net-snmp.org/.

Restarting agents
The following topics contain information about stopping, starting, and checking
the status of Common Agent and Platform Agent.
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Restarting Common Agent
Restarting Common Agent requires that you run a command to restart certain
processes and, for other processes, run one command to stop the processes and
then run another command to start them again.

Before you begin

Before you stop Common Agent, warn users to finish their work or stop the
processes that they are running.

About this task

To restart Common Agent, complete the following steps:

Procedure
1. Stop the Common Agent processes.
v If you are running AIX, type the following command on a command line and

press Enter:
stopsrc -s cas_agent

v If you are running IBM i, type the following command on a command line
and press Enter:
ENDTCPSVR SERVER(*HTTP) HTTPSVR(CAS)

Note: The IBM i Common Agent an IBM i TCP server.
v From the IBM Flex System Manager, type the following command on a

command line and press Enter:
/opt/ibm/director/agent/runtime/agent/bin/endpoint.sh stop

Note: Before you can access the /opt/ibm/director/agent/runtime/agent/
bin directory, you must complete the following steps:
a. Call IBM Support and obtain the password that is required to run the

pesh command.
b. From the management software command-line interface, use the lsconfig

-v command to determine the UVMID of management node.
c. Run the command pesh UVMID, where UVMID is the system ID that you

determined in the previous step. When you are prompted, enter the
password that you obtained from IBM Support. For more information
about the command, see pesh.

v If you are running the Virtual I/O Server (VIOS), run the oem_setup_env
command to enter the root environment (unrestricted shell). Type the
following command in the root environment and press Enter:
/opt/ibm/director/agent/bin/stopagent_vios

Note: This command stops the Common Agent, Platform Agent, and the SLP
service. However, it does not stop the CIM server. Stop the CIM server by
typing the following command:
cimserver -s

Note: After the Common Agent processes are stopped, two events that
announce that the agent is stopped are immediately generated and recorded in
the IBM Flex System Manager event log. However, a third event, which
announces that the agent system is offline, is also recorded in the event log, but
at a later time. This third event is generated only after IBM Flex System
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Manager next runs the Verify Connection task against the agent system. The
Verify Connection task runs according to a user-defined schedule, so the third
event is delayed and then recorded according to that same schedule.

2. Start the Common Agent processes.
v If you are running AIX, type the following command on a command line and

press Enter:
startsrc -s cas_agent

v If you are running IBM i, type the following command on a command line
and press Enter:
STRTCPSVR SERVER(*HTTP) HTTPSVR(CAS)

v From the IBM Flex System Manager, type the following command on a
command line and press Enter:
/opt/ibm/director/agent/runtime/agent/bin/endpoint.sh start

Note: Before you can access the /opt/ibm/director/agent/runtime/agent/
bin directory, you must complete the following steps:
a. Call IBM Support and obtain the password that is required to run the

pesh command.
b. From the management software command-line interface, use the lsconfig

-v command to determine the UVMID of management node.
c. Run the command pesh UVMID, where UVMID is the system ID that you

determined in the previous step. When you are prompted, enter the
password that you obtained from IBM Support. For more information
about the command, see pesh.

v If you are running the VIOS, run the oem_setup_env command to enter the
root environment (unrestricted shell). Type the following command in the
root environment and press Enter:
/opt/ibm/director/agent/bin/startagent_vios

Note: This command starts the Common Agent, Platform Agent, and the
SLP service.

3. Obtain the status of Common Agent to ensure that it started successfully.
v If you are running AIX, type the following command on a command line and

press Enter:
lssrc -s cas_agent

v From the IBM Flex System Manager, type the following command on a
command line and press Enter:
/opt/ibm/director/agent/runtime/agent/bin/endpoint.sh status

Note: Before you can access the /opt/ibm/director/agent/runtime/agent/
bin directory, you must complete the following steps:
a. Call IBM Support and obtain the password that is required to run the

pesh command.
b. From the management software command-line interface, use the lsconfig

-v command to determine the UVMID of management node.
c. Run the command pesh UVMID, where UVMID is the system ID that you

determined in the previous step. When you are prompted, enter the
password that you obtained from IBM Support. For more information
about the command, see pesh.
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v If you are running the VIOS, run the oem_setup_env command to enter the
root environment (unrestricted shell). Type the following command in the
root environment and press Enter:
/opt/ibm/director/agent/runtime/agent/bin/endpoint.sh status

Restarting Platform Agent
Restarting Platform Agent requires that you run a command to restart certain
processes and, for other processes, run one command to stop the processes and
then run another command to start them again.

Before you begin

Before you stop Platform Agent, warn users to finish their work or stop the
processes that they are running.

About this task

To restart Platform Agent, complete the following steps:

Procedure
1. Stop the Platform Agent processes.
v If you are running AIX, type the following command on a command line and

press Enter:
stopsrc -s platform_agent

Note: Stopping Platform Agent does not also stop the CIM server. If you
want to stop the CIM server, type the following command and press Enter:
stopsrc -s cimsys

v If you are running Linux, type the following command on a command line
and press Enter:
paservices stop

Note: Alternatively, you can run the following command to stop and then
automatically start the Platform Agent services on Linux:
paservices restart

v If you are running Linux with KVM platform agent, type the following
commands on a command line and press Enter after each command:
/etc/init.d/ibmpawatchdogd_x86_64 stop (Platform Agent 6.3 and later only)
/etc/init.d/tog-pegasus stop
/etc/init.d/tier1slpinst stop
/etc/init.d/cim-listener stop
/etc/init.d/gatherer stop
/etc/init.d/slpd stop

v If you are running IBM i, type the following command on a command line
and press Enter:
ENDTCPSVR SERVER(*CIMOM)

Note: The IBM i Platform Agent is an IBM i TCP server.
v If you are running Windows, run the following command:

paservices.vbs stop

Note: Alternatively, you can run the following command to stop and then
automatically start the Platform Agent services on Windows:
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paservices.vbs restart

2. Start the Platform Agent processes.
v If you are running AIX, type the following command on a command line and

press Enter:
startsrc -s platform_agent

Note: If it is not already running, the CIM server is automatically started by
Platform Agent.

v If you are running Linux, type the following command on a command line
and press Enter:
paservices start

Note: Alternatively, you can run the following command to stop and then
automatically start the Platform Agent services on Linux:
paservices restart

v If you are running Linux with KVM platform agent, type the following
commands on a command line and press Enter after each command :
/etc/init.d/slpd start
/etc/init.d/gatherer start
/etc/init.d/cim-listener start
/etc/init.d/tier1slpinst start
/etc/init.d/tog-pegasus start
/etc/init.d/ibmpawatchdogd_x86_64 start (Platform Agent 6.3 and later only)

v If you are running IBM i, type the following command on a command line
and press Enter:
STRTCPSVR SERVER(*CIMOM)

v If you are running Windows, run the following command:
paservices.vbs start

Note: Alternatively, you can run the following command to stop and then
automatically start the Platform Agent services on Windows:
paservices.vbs restart

3. Obtain the status of Platform Agent to ensure that it started successfully.
v If you are running AIX, type the following command on a command line and

press Enter:
lssrc -s platform_agent

v If you are running Windows, go to the Services panel (Start Menu > Settings
> Control Panel > Administrative Tools > Services) and ensure that the
following services are running:
– Platform Agent Cimlistener Service
– Platform Agent SLP SA
– Platform Agent SLP Attributes Service
– Platform Agent WMI+A Service
– Platform Agent Watchdog Service (Platform Agent only)

Platform Agent Watchdog
Platform Agent Watchdog monitors Platform Agent 6.3.x services, such as
cimlistener and cimserver, on Windows, Linux on x86, and Linux Kernel-based
Virtual Machine (KVM).

When Platform Agent Watchdog notices that any monitored services have crashed
or otherwise become useless, it automatically restarts those services.
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Note: If you want to stop certain services manually, ensure that you first stop the
Platform Agent Watchdog service.

Platform Agent Watchdog monitors a default set of services that depends on your
operating system:

Services monitored on Windows:

v cimlistener
v gatherwin
v ibmsa
v reposwin
v tier1slp
v wmicimserver

Services monitored on Linux on x86:

v cimlistenerd
v cimserverd
v gathererd
v paslpd
v tier1slpinst

Services monitored on Linux Kernel-based Virtual Machine (KVM):

v cim-listener
v gatherer
v slpd
v tier1slpinst
v tog-pegasus

Setting the agent manager for IBM Flex System Manager
By default, IBM Flex System Manager is configured to use its embedded agent
manager. However, you can configure IBM Flex System Manager to use a different
agent manager.

About this task

You can configure how IBM Flex System Manager interacts with the common
agent services architecture to secure your Common Agent managed systems and to
improve scalability and performance.

Important: Setting the agent manager incorrectly will prevent IBM Flex System
Manager from communicating with common agents.

Viewing the agent manager properties
Some basic properties of the agent manager can be displayed in the IBM Flex
System Manager Web interface.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
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the user interface (shown here) to locate this task:

To view information about the configured agent manager, use the following
procedure:

Procedure
1. On the Initial Setup tab of the Home page, click Chassis Manager. On the

Chassis Manager page, type Agent in the Find field, then click Agent Manager
Configuration in the resulting list on the Tasks tab. The Agent Manager
Configuration page is displayed.

2. Optional: Click the name of a listed agent manager.

Results

The following properties are displayed for agent managers in the IBM Flex System
Manager Web interface:

Active Whether the agent manager is the active agent manager for IBM Flex
System Manager.

CAS Version
The common agent services version of the agent manager.

IP Address
The IP address of the agent manager.

Name The globally unique identifier (GUID) of the system on which the agent
manager is installed.

Adding a new agent manager
You can configure IBM Flex System Manager to use additional agent managers in
addition to the default agent manager that is installed with IBM Flex System
Manager.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

IBM Flex System Manager uses only one agent manager at a time; the agent
manager in use is the active agent manager. You can add other agent managers in
the Agent Manager Configuration page, but only the active agent manager is used
for communication with Common Agents.
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Note: For descriptions of resource managers and agent managers, see “Common
agent services”.

Use the following procedure to add a new agent manager:

Procedure
1. On the Initial Setup tab of the Home page, click Chassis Manager. On the

Chassis Manager page, type Agent in the Find field, then click Agent Manager
Configuration in the resulting list on the Tasks tab. The Agent Manager
Configuration page is displayed.

2. In the Agent Manager Configuration page, click Add.
3. In the Add a New Agent Manager window, type the requested information for

the agent manager you are adding, and then click OK.

Agent Manager host name or IP address
The host name or IP address of the agent manager you are adding.

Resource Manager Registration user name
The user name that is used to register IBM Flex System Manager with
the agent manager.

Resource Manager Registration password
The password that is used to register IBM Flex System Manager with
the agent manager.

Agent Registration password
The password that is used to register common agents with the agent
manager.

Catalogue service port
The port that is used for non-secure, or public, communications.

Note: The agent recovery service listens for registration failures on this
port number in addition to port 80.

Make the new agent manager active
If selected, this check box sets the new agent manager as the active
agent manager for IBM Flex System Manager.

Important: Changing the active agent manager in IBM Flex System
Manager migrates all of the common agents that are registered with the
previously active agent manager to the new active agent manager. This
has two implications:
v Depending on the number of common agents that are registered with

the previously active agent manager, the migration process could
take some time, during which some common agents might not be
available for management by IBM Flex System Manager.

v After the common agents are migrated to the new active agent
manager, they will no longer be able to be managed by any
management applications (including other installations of IBM Flex
System Manager) that use the agent manager from which they were
migrated. In order to manage the migrated common agents with
other management applications, the management applications must
be configured to use the new active agent manager.

Setting the active agent manager
You can set the active agent manager from the Agent Manager Configuration page.
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About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

IBM Flex System Manager uses only one agent manager at a time to communicate
with common agents. This agent manager is the active agent manager. If no agent
manager is active, IBM Flex System Manager will not be able to manage common
agents.

Important: Changing the active agent manager in IBM Flex System Manager
migrates all of the common agents that are registered with the previously active
agent manager to the new active agent manager. This has two implications:
v Depending on the number of common agents that are registered with the

previously active agent manager, the migration process could take some time,
during which some common agents might not be available for management by
IBM Flex System Manager.

v After the common agents are migrated to the new active agent manager, they
will no longer be able to be managed by any management applications
(including other installations of IBM Flex System Manager) that use the agent
manager from which they were migrated. In order to manage the migrated
common agents with other management applications, the management
applications must be configured to use the new active agent manager.

To set the active agent manager, use the following procedure:

Procedure
1. On the Initial Setup tab of the Home page, click Chassis Manager. On the

Chassis Manager page, type Agent in the Find field, then click Agent Manager
Configuration in the resulting list on the Tasks tab. The Agent Manager
Configuration page is displayed.

2. In the Agent Manager Configuration page, select the agent manager that you
want to activate, and then click Make Active.

3. In the confirmation prompt, click Yes.

Deleting an agent manager
You can remove an agent manager from the Agent Manager Configuration page.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:
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Note: You cannot delete the active agent manager. If you need to delete the active
agent manager, you must first make a different agent manager active.

To delete an agent manager from the Agent Manager Configuration page, use the
following procedure:

Procedure
1. On the Initial Setup tab of the Home page, click Chassis Manager. On the

Chassis Manager page, type Agent in the Find field, then click Agent Manager
Configuration in the resulting list on the Tasks tab. The Agent Manager
Configuration page is displayed.

2. In the Agent Manager Configuration page, select the agent manager you want
to delete, and then click Delete. The Delete Selected Agent Managers window
prompts you for confirmation.

3. Click OK in the Delete Selected Agent Managers window.

Results

The agent manager is removed from the Agent Manager Configuration page, and
IBM Flex System Manager will no longer use the agent manager to communicate
with common agents.

Deleting an agent manager from the Agent Manager Configuration page does not
uninstall the agent manager or delete any agent manager data.

Using a remote agent manager with IBM Flex System Manager
There are several reasons why you might want to use an agent manager that is
remote to your IBM Flex System Manager instance instead of the agent manager
that is embedded within it.

About this task

For example, if you need to manage the same common agents with more than one
instance of IBM Flex System Manager, all of the instances of IBM Flex System
Manager must use the same agent manager.

Such situations are addressed by configuring one or more of the management
applications to use a remote agent manager, which is the agent manager embedded
in IBM Flex System Manager on a remote system.

Configure IBM Flex System Manager to use an agent manager other than the
locally embedded agent manager if you want to obtain any of the following goals:
v Manage the same common agent services agents with one or more IBM Flex

System Manager instances and one or more Tivoli applications
v Gain partial redundancy by detecting an agent manager failure condition and

then switching to a different agent manager
v Improve performance on IBM Flex System Manager by decoupling the agent

manager workload to a separate system
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The agent manager can run under one of the following types of enterprise
application server environments:

IBM WebSphere® Application Server
Agent manager can use an existing installation of a supported version of
IBM WebSphere Application Server. The agent manager applications can be
installed in the same application server as your other products, or it can be
in an application server that is dedicated to the agent manager.

lightweight runtime environment
The agent manager applications can be installed in the same lightweight
runtime instance as your other products, or it can use an instance that is
dedicated to the agent manager.

Note: The agent manager that is installed as an embedded component of
IBM Flex System Manager uses the lightweight runtime environment.

Using the embedded agent manager of a remote IBM Flex
System Manager
If your management environment uses IBM Flex System Manager exclusively, and
if your goal is to manage the same common agents with more than one instance of
IBM Flex System Manager, you can configure multiple instances of IBM Flex
System Manager to use the embedded agent manager of one of your IBM Flex
System Manager instances.

Before you begin

Ensure that you have the following information available before you configure IBM
Flex System Manager to use the agent manager:
v Host name or IP address of the agent manager that you will use
v User name and password of the IBM Flex System Manager user that you will

use to register IBM Flex System Manager with the agent manager
v Agent registration password that you will use to register common agents with

the agent manager
v Value of the public communications port that the agent manager will use

Identifying, registering, and unregistering the agent manager
used by a Common Agent

A Common Agent managed system can be managed by only one agent manager at
a time. If that agent manager is not the agent manager that IBM Flex System
Manager uses, you must unregister the Common Agent in order to manage it with
IBM Flex System Manager.

Use the following procedures to:
v Identify the agent manager that is being used by a Common Agent managed

system
v Unregister the Common Agent from an agent manager, if needed
v Register the Common Agent with the agent manager that is being used by IBM

Flex System Manager
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Identifying the agent manager for a Common Agent managed
system
About this task

A Common Agent-managed system can be managed by only one agent manager at
a time. Removing the Common Agent-managed operating system resources will
not unregister the Common Agent from the associated agent managers. If that
agent manager is not the agent manager that the IBM Flex System Manager uses,
you must unregister the Common Agent in order to manage it with IBM Flex
System Manager.

Before you unregister the current agent manager, you can query the usma service
detail information to determine the current agent manager. Issue the following
command that is applicable for the managed compute node operating system.

Note: To run the following command on a system with VIOS, you must first exit
the restricted shell. To get out of the restricted shell, run the command
oem_setup_env before you attempt to query the usma service detail information.

 
or Windows

slp_query --type=* --address=<system_IP_address>

Linux

/opt/ibm/icc/bin/slptool -u 127.0.0.1 findattrs service:management-software.IBM:usma

Unregistering the agent manager for a Common Agent managed
system
About this task

On the Common Agent-managed system, issue the following command that is
applicable for the managed compute node operating system:

 
or Linux

/opt/ibm/director/agent/runtime/agent/toolkit/bin/configure.sh -unmanaged -force

Windows

<install_root>\agent\runtime\agent\toolkit\bin\configure.bat -unmanaged -force

Procedure
1. Issue the following command:

 
or Linux

/opt/ibm/director/agent/runtime/agent/toolkit/bin/configure.sh -unmanaged -force

Windows

install_root\agent\runtime\agent\toolkit\bin\configure.bat -unmanaged -force

where install_root is the root directory of your IBM Flex System Manager
installation.

2. Check the agent manager for the Common Agent managed system using the
procedure described in “Identifying the agent manager for a Common Agent
managed system.” The agent should now be unmanaged.
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Registering a Common Agent managed system with the IBM Flex
System Manager agent manager

Before you begin

Before you register a Common Agent managed system with the IBM Flex System
Manager agent manager, ensure that the following circumstances exist:
v Ensure that no firewalls are blocking bidirectional communication between the

agent manager and the common agent.
v Ensure that the corresponding GMT times for the common agent and agent

manager are synchronized.
v Ensure that the common agent was not managed by another agent manager that

is not the default agent manager of IBM Flex System Manager.

Procedure
1. In IBM Flex System Manager Web interface, remove the Common Agent

managed system if it has not already been removed.
2. Discover the Common Agent managed system.
3. Request access, or run this command to manage the system without requesting

access:
 

or Linux

/opt/ibm/director/agent/runtime/agent/toolkit/bin/configure.sh -amhost
agentmanager_IP_address -passwd agentregistration_password -force

Windows

install_root\agent\runtime\agent\toolkit\bin\configure.bat -amhost
agentmanager_IP_address -passwd agentregistration_password -force

The Common Agent managed system is now managed by the agent manager
used by IBM Flex System Manager. To verify this, use the procedure described
here: “Identifying the agent manager for a Common Agent managed system”
on page 275.

Changing the agent manager certificate
You can change the certificate that secures the agent manager port 9511 through
Secure Sockets Layer (SSL).

About this task

Occasionally the x509 certificate that secures the agent manager SSL port 9511 must
be regenerated. Self-signed certificates expire eventually and some certificates
might be created by using the MD5 message algorithm that is less preferred than
Secure Hash Algorithm (SHA). Agent Manager communication might not work or
might work in a reduced secure capacity. You can re-create a self-signed certificate
for the agent manager port. After you change the certificate, you can verify the SSL
certificates that are currently in use.

Use the following procedure to change the certificate of the agent manager:

Procedure
1. Stop the IBM Flex System Manager processes.
2. Start the IBM Key Management program. Usually, this program is in the

<director install location>\Director\jre\bin\ path.
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3. Select the <director install location>\Director\lwi\runtime\agentmanager\
eclipse\plugins\com.ibm.tivoli.cas.manager\certs\agentManagerKeys.jks
file. Take a backup of the file from the command-line interface.

4. Log in with the agent manager password that was specified during
installation.

5. Delete the agentmanagerkey personal certificate.
6. Click New Self-Signed. The Create New Self-Signed Certificate window

displays.
7. In the Key Label field, enter the label as agentmanagerkey for the new

certificate.
8. In the Version list, select the X509 V3 value.
9. In the Key Size field, accept the default value.

10. In the Signature Algorithm field, select the default value SHA1WithRSA or
specify a stronger algorithm.

Note: If you select the MD5WithRSA value to sign in, some security scanners
display an alert.

11. In the Common Name field, enter the fully qualified host name of the server
for which you are creating the certificate.

Note: This host name must match the host name that displays in the web
address that you specify to open the IBM Flex System Manager web interface.
Specify the fully qualified host name. However, if you use a short name in the
web address, specify the short name in the Common Name field.

12. In the Organization field, type the name of your organization.
13. In the Country or region list, accept the default value. Sometimes, the default

value can be blank.
14. In the Validity Period field, enter the lifetime of the certificate in days or

accept the default value.

Note: A year is a usual time frame for a certificate to expire. However,
depending on security requirements, you might want to adjust this value.
Generate a new certificate when the certificate expires.

15. Click OK.
16. Start the IBM Flex System Manager processes by using the new certificate.

Note: You can verify the certificate by browsing to the https://<Director
Server FQDN>:9511/AgentMgr/Info website.

17. To enable Common Agent Services resources to use the new certificate,
complete the following steps:
a. Remove the Common Agent Services resources from IBM Flex System

Manager. To remove the local Common Agent Services resources from IBM
Flex System Manager, contact IBM support.

b. On each of the removed resources, run the following commands to
unmanage the system:
For AIX or Linux:
/opt/ibm/director/agent/runtime/agent/toolkit/bin/configure.sh -unmanaged -force

For Windows:
<installPath>\agent\runtime\agent\toolkit\bin\configure.bat -unmanaged -force

c. After you replace the certificate, discover and request access to the
removed resources.
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Updating the agent manager certificate
You can update the current version of the certificate the secures that secures the
agent manager.

About this task

To update the agent manager certificate, complete the following steps:

Procedure
1. Remove all of the resources from the IBM Flex System Manager. If the resource

is a Common Agent, then unmanage the system by issuing the following
command:
For AIX or Linux:
/opt/ibm/director/agent/runtime/agent/toolkit/bin/configure.sh -unmanaged -force

For Windows:
<installPath>\agent\runtime\agent\toolkit\bin\configure.bat -unmanaged -force

2. Reconfigure agent manager to generate certificates that contain the certificate
long key, by issuing the following commands in a sequence:
For AIX or Linux:
smstop
/opt/ibm/director/bin/recoverEnv.sh
/opt/ibm/director/bin/configAgtMgr.sh
smstart

For Windows:
net stop dirserver
<installPath>\bin\recoverEnv
<installPath>\bin\cfgserver -am
net start dirserver

3. Discover and request access to the resources.

Securing Common Agent managed systems
When IBM Flex System Manager discovers Common Agent managed systems,
those systems are secured by the common agent services architecture. If you
suspect a breach of security, you can re-secure your Common Agent managed
systems to protect them from unauthorized management.

Changing the agent registration password
In some cases you might want to change the agent registration password.

About this task

The agent registration password serves these purposes:
v Validating the registration of common agents
v Locking the agentTrust.jks truststore file

To change the agent registration password, you first update the agent manager,
and then redistribute the agentTrust.jks truststore file to unregistered common
agents and to IBM Flex System Manager and any other resource managers that
remotely install common agents.

Use the following procedure to change the agent registration password.
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Procedure
1. Log on to the IBM Flex System Manager as the user who runs the IBM

WebSphere Application Server processes.
2. Call IBM Support and obtain the password that is required to run the pesh

command.
3. From the management software command-line interface, use the lsconfig -v

command to determine the UVMID of management node.
4. Run the command pesh UVMID, where UVMID is the system ID that you

determined in the previous step. When you are prompted, enter the password
that you obtained from IBM Support. For more information about the
command, see pesh.

5. Run the EncryptAMProps script. Type the following command:
/opt/ibm/director/lwi/runtime/agentmanager/bin/EncryptAMProps.sh new_password

where new_password is the new agent registration password.
This script updates the value of the Registration.Agent.Access.Password
property in the AgentManager.properties file.

6. Start the IBM Key Management utility. Type the following command:
./opt/ibm/director/jre/bin/ikeyman.sh

7. Open the agentTrust.jks truststore file.
a. In the IBM Key Management window, click Key Database File > Open.
b. In the Open window, set the Key database type to JKS, specify the file

name and location of the agentTrust.jks truststore file, and click OK. The
agentTrust.jks truststore file is located in the following directory:
/opt/ibm/director/lwi/runtime/agentmanager/eclipse/plugins/cas_plugin_name/certs/

If the agentTrust.jks truststore file is missing or corrupted, you can copy
the agentTrust.jks file from a common agent or resource manager.
However, because the password for the file changes when the common
agent or resource manager registers, you must use the password that
unlocks the file on that system to open the truststore file in step 7c.

c. In the Password Prompt window, type the current agent registration
password and then click OK. The IBM Key Management window now
shows the agentTrust.jks file, which contains the signer certificate named
rootcert.

8. In the IBM Key Management window, click Key Database File > Change
Password.

9. In the Change Password window, enter and confirm the new password that
you specified in step 5, and then click OK. The agentTrust.jks truststore file
is encrypted with the new password.

10. Click Key Database File > Exit to close the IBM Key Management window.
11. Redistribute the agentTrust.jks truststore file to any common agent or

resource manager that has not yet registered. If you created a copy of the
agent installation files or created an installed image for rapidly deploying
common agents, copy the new agentTrust.jks truststore file to that location.

Note: You do not need to redistribute the truststore file to common agents
and resource managers that have successfully registered.

12. Update the agent registration password that is stored in an encrypted format
in the endpoint.properties file.
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Note: You do not need to change the endpoint.properties file on common
agents that have successfully registered.
To update the saved password, type the following command:
/opt/ibm/director/lwi/runtime/agentmanager/bin/EncryptPW.sh agent_registration_password

where agent_registration_password is the new agent registration password.
13. If necessary, redistribute the agentTrust.jks truststore file to any IBM Flex

System Manager instances and any other resource managers that have not yet
registered. Typically, you will not have resource managers that are installed
but not registered.

14. Change the saved agent registration password for any resource manager that
uses it to deploy common agents.

15. Restart IBM Flex System Manager or the agent manager to start using the new
properties file and password.

16. Run the following command on IBM Flex System Manager: smcli
changeAMRegPassword<IPAddress of Agent Manager><New Password>

Note: To obtain the IP address of the agent manager, run smcli
getAgentManagers.

Results

The agent registration password is now changed throughout your deployment.

Binding Platform Agent to specific IP addresses
Platform Agent supports multiple network interface card (multi-NIC) IP address
configurations for both Linux and Windows. However, only Windows supports the
act of binding to particular IP addresses for communication. On Linux, Platform
Agent defaults to bind to all interfaces, so there is no option to configure a
particular IP address.

About this task

Note: If you change the IP address or host name of any managed resource, either
discover and inventory the resource again or use configuration templates to update
the IP address or host name.

To specify a particular IP address on Windows and avoid binding Platform Agent
to all interfaces by default, complete the following steps:

Procedure
1. Issue the following command to stop wmicimserver:

net stop wmicimserver

2. Wait until wmicpa stops or issue the following command to force it to stop:
taskkill /F /IM wmicpa.exe

3. Open the wmia.properties file, which is in %Program Files%\Common
Files\IBM\icc\cimom\data\, for editing.

4. Edit the following IPv4 and IPv6 properties as specified:
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Table 37. Binding values to set for properties in wmia.properties

Property and value Result

httpBindAddress=IPv4_Address Will bind to IPv4_Address:5988, which is not
secure

httpsBindAddress=IPv4_Address Will bind to IPv4_Address:5989, which is
secure

httpIPV6BindAddress=IPv6_Address Will bind to IPv6_Address:5988, which is not
secure

httpsIPV6BindAddress=IPv6_Address Will bind to IPv6_Address:5989, which is
secure

5. Issue the following command to start the wmicimserver:
net start wmicimserver

Changing the Common Agent IP address
If necessary, you can change the Common Agent IP address.

About this task

Under certain circumstances, you might want or need to change a Common Agent
IP address. For example, if you change only the Common Agent host name, the
Common Agent IP address is not automatically also changed. IBM Flex System
Manager uses the new host name and old IP address until Common Agent or the
operating system next restarts. So, you must manually change the Common Agent
IP address.

Conversely, if you change only the Common Agent IP address, the Common Agent
host name is automatically also changed. In this case, IBM Flex System Manager
detects the IP address change, forces a check of the Common Agent host name,
and changes the host name accordingly.

Note: If you change the IP address or host name of any managed resource, either
discover and inventory the resource again or use configuration templates to update
the IP address or host name.

If you do change the Common Agent IP address, keep in mind the following
points:
v You need to restart Common Agent and Platform Agent after you change the

Common Agent IP address. For information about restarting the agents, see
“Restarting agents”.

v In an environment with multiple IP addresses, changing the IP address for
Common Agent might lead to some missing service access points. You can
retrieve the missing service access points by rediscovering, without first
removing, the managed server.

Critical services for monitoring Platform Agent hardware
The following services and processes are critical for monitoring Platform Agent
hardware on Windows.
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Hardware monitoring stack overview

Platform Agent provides functionality to monitor the hardware of a managed
system. If the state of a monitored hardware component changes, the Platform
Agent WMI+A Service generates an indication that contains the event. The
Windows Management Instrumentation (WMI) CIM handler, which is a component
of the WMI+A Service, forwards the event to the Platform Agent CIM Listener. It
also informs the CIM Listener about the consumers that should receive the
notification of the event. The CIM Listener routes the event to the appropriate
consumer module.

The CIM Listener can send events to the following five consumers:
v SNMP
v Tivoli
v log
v email
v IBM Flex System Manager

Critical services

Windows Management Instrumentation (winmgmt)
This service, which is part of Windows, is the CIM Object Manager for
Windows. The WMI+A Service is a wrapper for the Microsoft service and
is therefore dependent upon it. WMI+A adheres to CIM standards set forth
by the Desktop Management Task Force (DMTF) and leverages Microsoft's
CIM implementation for the Windows platforms.

If this WMI service fails, the WMI+A Service is unavailable and therefore
fails to monitor the hardware.

For more information about WMI, see the MSDN documentation at
http://msdn.microsoft.com/en-us/library/aa394582%28v=vs.85%29.aspx.

If this service needs a recovery, run net stop winmgmt to stop the service,
then run net start winmgmt to restart it.

Platform Agent WMI+A Service (wmicimsv.exe, wmicpa.exe)
The corresponding process for this service is wmicimsv.exe. The process
handles requests and delivers responses to the client. It translates CIM
requests to WMI requests and receives responses from WMI and converts
that to a CIM response.

This service will also bring up several instances of the WMI CMPI
Provider Adapter, wmicpa. The wmicpa process is a WMI provider that
interfaces with IBM Flex System Manager providers that are written to the
CMPI standard. Instances of wmicpa are the keys to monitoring the
hardware and generating the hardware events. The wmicpa process is an
interface to WMI for CMPI providers and will load CMPI indication
providers. It is these providers that are responsible for monitoring
hardware and generating indications.

Providers that run in processes other than the process in which the CIM
server runs are now supported, so multiple wmicpa processes exist. This
means that, if one wmicpa crashes, others will function. You might lose
any hardware monitoring from the providers loaded by the crashed
wmicpa process.
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If this service is stopped or fails to start, the hardware cannot be monitored
and no hardware event is generated. You might lose any hardware
monitoring from the providers that the crashed wmicpa process loaded.

If this service needs a recovery, run net stop wmicimserver to stop the
service, then run net start wmicimserver to restart it.

WMI CIM handler (wmihandl.dll)
WMI CIM handler is a part of the WMI+A Service. It listens for WMI
events and converts those events into CIM indications. Those indications
are then passed on to the CIM Listener Service based on the CIM
subscription.

The wmihandl module is loaded by wmicimsv.exe when the WMI CIM+A
Service starts. If the wmihandl module fails to load for some reason,
indications are not processed and forwarded to the CIM Listener Service.
Therefore, hardware events are not delivered to end consumers such as
IBM Flex System Manager.

If this module has a problem and needs a recovery, recover the WMI+A
Service, because the wmihandl module is loaded by wmicimsv.exe.

Platform Agent CIM Listener Service (cimlistener.exe)
This service receives the hardware event from the WMI CIM handler and
implements the code to deliver the event to end consumers.

If this service fails, the hardware event can be generated, but cannot be
delivered to end consumers.

If this service needs a recovery, run net stop cimlistener to stop the
service, then run net start cimlistener to restart it.

Recover the whole stack

In some situations, you need to recover the whole stack. This happens especially
when you cannot determine which service in the stack is the culprit of the
problem. To recover the whole stack, you need to restart all services in the stack,
and the order of stopping and starting the services matters.

Steps to stop all services

1. Run the following command to stop the Platform Agent CIM Listener
Service:
net stop cimlistener

2. Run the following command to stop the WMI CIM handler and
Platform Agent WMI+A Service:
net stop wmicimserver

3. Run the following command to stop Windows Management
Instrumentation:
net stop winmgmt

Steps to restart all services

1. Run the following command to start Windows Management
Instrumentation:
net start winmgmt

2. Run the following command to start the WMI CIM handler and
Platform Agent WMI+A Service:
net start wmicimserver
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3. Run the following command to start the Platform Agent CIM Listener
Service:
net start cimlistener

Configuring Platform Agent for SELinux policies
You can configure Platform Agent on Red Hat Enterprise Linux to work with
SELinux in permissive or enforcing mode.

About this task

IBM Flex System Manager supports the use of SELinux policies with Platform
Agent on Red Hat Enterprise Linux 6.2 or 6.3. SELinux is disabled by default, so
you need to set it to the desired mode and then configure Platform Agent to work
with it.

Complete the following steps to configure Platform Agent to work with SELinux
policies.

Procedure
1. Run the following command to enable SELinux in permissive mode.

Note: If SELinux is already set to permissive mode and you want to set it to
enforcing mode, you can skip this step.
/opt/ibm/platform/bin/selinux/./dir_pa_setup_policy -permissive

If SELinux was not already set to permissive mode, this command will set the
SELINUX variable in the /etc/selinux/config file to permissive. The system
then reboots.

2. If enforcing mode is needed, run the following command to enable SELinux in
enforcing mode.

Note: SELinux must be set to permissive mode before you can set it to
enforcing mode.
/opt/ibm/platform/bin/selinux/./dir_pa_setup_policy -enforcing

If SELinux was not already set to enforcing mode, this command will set the
SELINUX variable in the /etc/selinux/config file to enforcing. The system
then reboots.

3. Verify that the correct SELinux mode is set.
v Run the following commands to determine the current runlevel and then

verify that the service is properly enabled in it:
runlevel
chkservice

v Run the following command and ensure that the installed policy appears in
the returned list to verify that the policy was properly loaded:
semodule -l

v Run the following command to verify that the system's SELinux status is set
to enabled and that its current mode is properly set to the desired value of
either permissive or enforcing:
sestatus
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Enabling and disabling tracing on Pegasus CIM Server
You can enable and disable tracing of Platform Agent on Pegasus CIM server.

About this task

Use tracing only for debugging. By default, the tracing option is disabled on
Pegasus CIM server. You can enable the tracing mechanism by specifying the trace
level and the components that you want to trace with the traceLevel configuration
parameter.

Procedure
1. Specify trace levels. Select one of the following trace levels when you enable

tracing:

Table 38. Pegasus CIM trace levels and their descriptions

Trace level Description

Level 0 Tracing is switched off

Level 1 Severe trace and log messages (if
traceComponents is set to LogMessages)

Level 2 Basic logic flow trace messages, and minimal
data detail

Level 3 Intra function logic flow and moderate data
detail

Level 4 High data detail

Level 5 High data detail and function entry/exit

Trace data is saved in the file that is specified by the traceFilePath
configuration parameter. By default, the traceFilePath parameter is set to the
/opt/freeware/cimom/pegasus/logs/cimserver.trc file.

2. Specify the components to trace. To specify the component or the components
that you want to trace, use the traceComponents parameter. You can specify the
following components with this parameter:
v Authentication
v Authorization
v CIMExportRequestDispatcher
v CIMOMHandle
v CMPIProvider
v CMPIProviderInterface
v Config
v ControlProvider
v CQL
v DiscardedData
v Dispatcher
v ExportClient
v Http
v IndicationGeneration
v IndicationHandler
v IndicationReceipt
v IndicationService
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v L10N
v Listener
v LogMessages
v MessageQueueService
v ObjectResolution
v OsAbstraction
v ProviderAgent
v ProviderManager
v ProvManager
v Repository
v Server
v Shutdown
v SSL
v StatisticalData
v Thread
v UserManager
v WQL
v WsmServer
v Xml
v XmlIO

You can also trace all the components by using the word ALL instead of a
specific component name.

Note: If you do not set the traceComponents parameter to any component,
tracing is turned off even when you specify the traceLevel parameter.

3. Modify the trace configuration parameters. You can modify the trace
configuration parameters by using one of the following methods:
v Turn off the CIM server and modify the configuration files. Restart the CIM

Server.
v Use command line options to the cimconfig command while the CIM Server

is running.

For example, to set the trace level to trace all information with high data detail
in the Thread and ProvManager components, type the following commands:
cimconfig -s traceLevel=4
cimconfig -s traceComponents=Thread,ProvManager
Similarly, to disable all tracing, type the following command:
cimconfig -s traceComponents=

Configuring Common Agent
When you configure the Common Agent, you can modify some of the default
configuration settings.

About this task

After installing, if required, you can modify the basic configuration settings of the
Common Agent. Use the configure.properties properties file located at
<Common_Agent_Installed_Home>/runtime/agent/toolkit/config for modifying the
following default configuration settings:
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Properties and description

Tivoli Common Agent Service (TCAS) configuration file. This file is used for the
TCAS basic configuration and contains the basic information for the Common
Agent and agent manager.

agentName

The host name where the Common Agent is installed. The default value is
localhost.

agentPort

Port number for the Common Agent. The default value is 9510.

nonstopPort1

Java virtual machine (JVM) port for nonstop service. The default value is 9514.

nonstopPort2

Native port for nonstop service. The default value is 9515.

webContainerPort

HTTP transport port (use the vale -1 to disable). The default value is -1.

webContainerSSLPort

HTTPS transport port (use the value -1 to disable). The default value is -1.

unmanagedAgent

Common Agent is not managed by the agent manager. The default value is false.

agentManagerHostname

Host name of the agent manager. The default value is 127.0.0.1.

publicPort

Public port of the agent manager. The default value is 9513.

agentManagerContextRoot

Context root of the agent manager. The default value is /AgentMgr.

registrationPassword

Common Agent registration password. The default value is changeMe.
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Configuring SNMP for Platform Agent on Linux to forward traps to the
IBM Flex System Manager

You can configure Simple Network Management Protocol (SNMP) to forward traps
to the IBM Flex System Manager for Platform Agent managed systems that are
running the Linux operating system.

About this task

Procedure
1. Complete the following steps in the Platform Agent managed system that is

running the Linux operating system:
a. In the /etc/snmp directory, replace the contents in the snmpd.conf file with

the following configuration changes:
master agentx
rocommunity public
rwcommunity admin
trapcommunity public
trapsink <ip/hostname>

Where ip/hostname is the IP address of the IBM Flex System Manager to
which you want to forward the SNMP trap event.

b. Stop and start SNMP by entering the following commands:
[root@net init.d]# ./snmpd stop
Stopping snmpd: [ OK ]
[root@netinit.d]# pwd
/etc/init.d
[root@net init.d]# ./snmpd start
Starting snmpd: [ OK ]

2. Complete the following steps on the IBM Flex System Manager:
a. Create a discovery profile.

1) From the Initial Setup tab on the home page, click System discovery.
The System Discovery page is displayed.

2) Under Advanced Tasks, click Manage discovery profiles. The Manage
Discovery Profiles page is displayed.

3) Click Create to create a profile.
4) Use the Discovery Profile wizard to create and save your discovery

profile

After you exit the Discovery Profile wizard, the new discovery profile
appears in the Discovery Profiles table on the Manage Discovery Profiles
page and in the list of available profiles to run on the System Discovery
page.

b. Run the profile. The SNMP protocol that is discovered for the Platform
Agent managed system is displayed with the access state as OK.

c. If the agent generates an SNMP alert, the alert is forwarded to the IBM Flex
System Manager. You can check the event log of the IBM Flex System
Manager to view the alerts. Run a test event from the Platform Agent
managed system as shown in the following example:
[root@net snmp]# snmpwalk -v 1 -c public net.qrow.netfinity.com
.1.3.6.1.4.1.2.6.159.1.1.140
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Chapter 7. Preparing agentless managed systems

Prepare the agentless managed systems in your environment before you discover
or manage them with IBM Flex System Manager.

About this task

Note: A managed system might have more than one IP address (for example,
when the system contains more than one network interface card). When a
managed resource has multiple IP addresses, specify which IP address Flex System
Manager uses to manage the resource. To specify the IP address to use, you specify
that the management server ignore (or exclude) the other IP addresses associated
with the resource. For more information, see “Excluding IP addresses.”

Note: You must enable secure copy protocol (SCP) when you set up a Linux
resource for agentless or Platform Agent managed systems.

Complete the following steps on each system to be managed.

Procedure
1. On all managed systems that use the ssh protocol to communicate with IBM

Flex System Manager, ensure that the PasswordAuthentication value in
/etc/ssh/sshd_config is set to yes. So, the corresponding line in the
sshd_config file will appear as follows:
PasswordAuthentication yes

2. On all agentless managed systems that use the root user for request access for
the ssh protocol, ensure that the PermitRootLogin value in
/etc/ssh/sshd_config is set to yes.

What to do next

Notes:

1. You must restart the ssh server for any changes made to sshd_config to take
effect.

2. IBM Flex System Manager does not support the ssh protocol on VMware ESXi
hosts. If ssh is discovered on a VMware ESXi managed system, it might cause
problems when attempting to collect inventory.

Configuring access to agentless managed systems
Using an account other than root to access an agentless management system
enforces the appropriate security for the system while enabling more detailed audit
records for access to the system. To configure access to an agentless managed
system for a user account other than root, use the sudo utility.

About this task

The sudo utility is provided with Linux operating systems. To use the sudo utility
with AIX systems, you will need to download and install the utility from the AIX
Toolbox Download Web site.
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Before configuring access to agentless management systems for user accounts other
than root, read the following information:
v You must create and manage the sudo configuration file on each agentless

managed system that requires non-root based access.
v You must create a sudo configuration file that meets the requirements of your

security policies.
v You must create multiple credential mappings between IBM Flex System

Manager users and all of the agentless managed systems that IBM Flex System
Manager is managing using SSH.

Perform these steps to configure access to agentless management systems for user
accounts other than root:

Procedure
1. On each agentless managed system, create the sudo configuration file (called

sudoers) if it does not already exist.
On an agentless managed system, the file should be located in the
/etc/sudoers directory.

2. Ensure that each user account to be used for access to the agentless managed
system has authorization to run sudo commands. Before you can access the
/opt/ibm/director directory, you must complete the following steps:
a. Call IBM Support and obtain the password that is required to run the pesh

command.
b. From the management software command-line interface, use the lsconfig

-v command to determine the UVMID of management node.
c. Run the command pesh UVMID, where UVMID is the system ID that you

determined in the previous step. When you are prompted, enter the
password that you obtained from IBM Support. For more information about
the command, see pesh.

3. In /opt/ibm/director/lwi/conf/overrides/USMi.properties file, set the
following system variable:
com.ibm.usmi.server.security.cts.util.escalateUser=true

4. Restart the IBM Flex System Manager.
5. After discovering and requesting access to the endpoint, run the following

command:
smcli cfgcred -S <Director_User> -W <Director_User_password> -r
https://<discovery ip>:22/ -c PASSWORD -U <endpoint userid> -P
<endpoint password>

What to do next

After configuring the agentless managed system, you can then request access to
the system through either the IBM Flex System Manager Request Access page, the
Configure Access page, or the Configure Systems Credentials page.

Note: To enable use of the Agent Installation Wizard to install and update agents,
ensure that the root user account was used to initially request access to the
managed system.
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Using sudo and key-pair authentication to configure access
Using an account other than root to access an agentless management system
enforces the appropriate security for the system while enabling more detailed audit
records for access to the system.

About this task

Use this task to configure access to an agentless managed system for a user
account other than root with key-pair authentication. This process is just one
method of password authentication. Other password authentication processes are
listed in the Information Center topic "Preparing agentless managed systems."

Perform these steps to configure access to an agentless managed system for a user
account other than root with key-pair authentication:

Note: The procedure was originally created using Red Hat Linux.

Procedure
1. Set the clock on the managed system to match the time of the management

server. If the managed system time is earlier than time on the management
server, the management server will be unable to unlock the managed system.

2. Access to agentless system with SSH key-pair:
a. Log-in to the target Linux machine remotely as the sudo user, such as

dirtest.
b. Generate a key-pair on the Linux target machine: "ssh-keygen -t rsa"

-------------------------------
Generating public/private rsa key pair.
Enter file in which to save the key (/home/dirtest/.ssh/id_rsa): /home/dirtest/.ssh/dirtest_rsa
Enter passphrase (empty for no passphrase): director
Enter same passphrase again: director
Your identification has been saved in /home/dirtest/.ssh/dirtest_rsa.
Your public key has been saved in /home/dirtest/.ssh/dirtest_rsa.pub.
The key fingerprint is:
5c:c7:fb:24....
-------------------------------

Note: The passphrase can be a different one from the password for the
sudo user but the value cannot be blank.

c. Go to /home/dirtest/.ssh/ and "cat dirtest_rsa.pub >>
authorized_keys" where dirtest is the previously created sudo userid.

d. Run chmod 600 authorized_keys
e. Verify "ssh -i /home/dirtest/.ssh/dirtest_rsa dirtest@localhost" is

successful with the passphrase.
f. Click Exit to close connection to the localhost.
g. Create a new directory on the IBM Flex System Manager and copy

dirtest_rsa into the newly created directory.
h. On the IBM Flex System Manager, edit the install_root/lwi/conf/

overrides/USMi.properties file and add the following line:
com.ibm.usmi.server.security.cts.util.escalateUser=true

Note: See the "Configuring access to agentless managed systems" topic in
the Information Center for more information.

3. Restart the IBM Flex System Manager
4. Discover the target machine on the IBM Flex System Manager Web interface.
5. In the IBM Flex System Manager Web interface, configure credentials with a

right-click on OS MEP:
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a. Navigate to: OS MEP > Security > Configure Access > Access Type

b. Right-click on SSH Access Type

c. Navigate to: Credential > Configure Credentials

d. Select Key Pair :
* Private Key File: /temp/dirtest_rsa

*User ID: dirtest
Passphrase: director

Note: If the Key Pair button is not found, close all the tabs on the IBM Flex
System Manager Web interface and log out. Restart the IBM Flex System
Manager and try again.

6. Create the credential with the following command. Repeat this step for each
IBM Flex System Manager user that requires access to the target machine.
smcli cfgcred -S Director_User -W Director_User_password

-r https://IP_Address_of_Target_Machine:22/ -c RSA -U dirtest -K " /root/.ssh/dirtest_rsa" -P "director"

Example of output:
-------------------------------

RemoteServiceAccessPoint : https://10.0.230.170:22/
Source User Principal :Administrator
Source Identity ID : A933F3FE874033B8917D245F60218024
Target User Principal : dirtest
Target Identity ID : 46FA74665C4B326FA5EF08F83C521F1A
Registry ID : 975237828EFD3448914358C6584778E4
Registry Type : rsa_auth_registry

<Command Successful> Mapping Created with Mapping ID : CD57B2F464EA3655950E2B1D0F537FD5
-------------------------------

7. Target machine is now accessible.

What to do next

After configuring the agentless managed system, you can then request access to
the system through either the IBM Flex System Manager Request Access page, the
Configure Access page, or the Configure Systems Credentials page.

Sample sudo configuration file
Use the sample sudo configuration file as a basis for setting up configuration to
agentless managed systems for a user account other than root.

Note: This sample sudo configuration file is for example purposes only. Ensure
that you customize this sample file to meet the guidelines of your security policies.
Run visudo to edit the sudoers file.
# sudoers file.
#
# This file MUST be edited with the ’visudo’ command as root.
# Failure to use ’visudo’ may result in syntax or file permission errors
# that prevent sudo from running.
#
# See the sudoers man page for the details on how to write a sudoers file.
#
# Host alias specification

# User alias specification

# Cmnd alias specification

# Defaults specification

# Prevent environment variables from influencing programs in an
# unexpected or harmful way (CVE-2005-2959, CVE-2005-4158, CVE-2006-0151)
Defaults always_set_home
Defaults env_reset
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# Change env_reset to !env_reset in previous line to keep all environment variables
# Following list will no longer be necessary after this change

Defaults env_keep = "LANG LC_ADDRESS LC_CTYPE LC_COLLATE LC_IDENTIFICATION
LC_MEASUREMENT LC_MESSAGES LC_MONETARY LC_NAME LC_NUMERIC LC_PAPER LC_TELEPHONE
LC_TIME LC_ALL LANGUAGE LINGUAS XDG_SESSION_COOKIE"

# Comment out the preceding line and uncomment the following one if you need
# to use special input methods. This may allow users to compromise the root
# account if they are allowed to run commands without authentication.
#Defaults env_keep = "LANG LC_ADDRESS LC_CTYPE LC_COLLATE LC_IDENTIFICATION

LC_MEASUREMENT LC_MESSAGES LC_MONETARY LC_NAME LC_NUMERIC LC_PAPER LC_TELEPHONE
LC_TIME LC_ALL LANGUAGE LINGUAS XDG_SESSION_COOKIE XMODIFIERS GTK_IM_MODULE
QT_IM_MODULE QT_IM_SWITCHER"

# In the default (unconfigured) configuration, sudo asks for the root password.
# This allows use of an ordinary user account for administration of a freshly
# installed system. When configuring sudo, delete the two
# following lines:
Defaults targetpw # ask for the password of the target user i.e. root
ALL ALL=(ALL) ALL # WARNING! Only use this together with ’Defaults targetpw’!

# Runas alias specification

# User privilege specification
root ALL=(ALL) ALL

# Uncomment to allow people in group wheel to run all commands
# %wheel ALL=(ALL) ALL

# Same thing without a password
# %wheel ALL=(ALL) NOPASSWD: ALL

# IBM Flex System Manager provides the credentials required to establish connections
# with each system. Therefore, be sure to specify “NOPASSWD” for each user/group.

# Samples
# %users ALL=/sbin/mount /cdrom,/sbin/umount /cdrom
# %users localhost=/sbin/shutdown -h now

dirtest ALL=(ALL) NOPASSWD: ALL

Preparing AIX managed systems
You might need to configure certain AIX systems before you can discover them
with IBM Flex System Manager. Ensure that each AIX system that you want to
manage has been appropriately configured.

About this task

Typically, managed systems are first discovered using the discovery task in IBM
Flex System Manager Web interface. Then, Platform Agent or Common Agent is
installed on the managed systems directly from IBM Flex System Manager Web
interface. The configuration of some AIX managed systems, however, can prevent
discovery by IBM Flex System Manager.

Note: If an agentless system is running openssh 4.7.0.530, you cannot use the
Agent Installation Wizard to remotely install the agent on AIX.

Complete the following steps on each AIX system to enable discovery by IBM Flex
System Manager:

Procedure
1. Check if sshd is running by running the following command:

lssrc -s sshd
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2. If sshd is not running, run the following command to start it:
startsrc -s sshd

Preparing IBM i managed systems
Before you can discover IBM i managed systems as agentless, you must ensure that
SSH is running. SSH configuration varies depending on the version of the
operating system. See http://www.ibm.com/servers/enable/site/porting/tools/
openssh.html for complete documentation.

Preparing VMware managed systems
You might need to configure certain VMware systems before you can install agents
on them using the Agent Installation Wizard.

About this task

Managed systems running VMware ESX require the following configuration to
ensure that agents can be installed using the Agent Installation Wizard:

Procedure
1. On the VMware managed system, open the /etc/ssh/sshd_config file in a text

editor.
2. Locate the following line:

Ciphers aes256-cbc,aes128-cbc

3. Change the line to:
Ciphers aes256-cbc,aes128-cbc,3des-cbc

4. Save and close the /etc/ssh/sshd_config file.
5. Stop and restart the ssh daemon. Type the following command:

service sshd restart

6. Use VMware vSphere Client Security Profile Properties to enable ibmsa and
ibmcim.
a. Using VMware vSphere Client, connect to a VMware ESX 4.x system.
b. Click the Configuration tab.
c. Under Software, click Security Profile.
d. Select Properties and enable ibmsa and ibmcim.

7. Ensure the validity of any stored public key data for the target system in
root_SSH_data_directory/known_hosts on IBM Flex System Manager. See
“Common Agent cannot be installed on an AIX or Linux system” for more
information.

Preparing Windows managed systems
You might need to configure certain Windows systems before you can discover
them with IBM Flex System Manager. Ensure that each Windows system that you
want to manage has been appropriately configured.

Preparing Windows Server 2003 managed systems
You might need to configure certain Windows Server 2003 systems before you can
discover them with IBM Flex System Manager. Ensure that each Windows Server
2003 system that you want to manage has been appropriately configured.
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About this task

Typically, managed systems are first discovered using the discovery task in IBM
Flex System Manager Web interface. Then, Platform Agent or Common Agent is
installed on the managed systems directly from IBM Flex System Manager Web
interface. The configuration of some Windows Server 2003 managed systems,
however, can prevent discovery by IBM Flex System Manager.

Complete the following steps on each Windows Server 2003 system to enable
discovery by IBM Flex System Manager:

Procedure

Verify that remote registry administration is enabled. Remote registry
administration must be enabled in order for Agentless managed system discovery
to run commands and run scripts on the managed system. The default setting for
remote registry administration on Windows systems is enabled. Complete the
following steps to verify or change the remote registry administration setting:
1. Click Start > Control Panel > System and Maintenance > Administrative

Tools.
2. In the Administrative Tools window, double-click Services.
3. In the list of services in the Services window, right-click the Remote Registry

service and select Properties from the menu.
4. On the General page, set the Startup type to Automatic.
5. If the Service status is not Started, click Start to start the service.
6. Click OK to apply the new settings and close the window.

Preparing Windows Server 2008 managed systems
You might need to configure certain Windows Server 2008 systems before you can
discover them with IBM Flex System Manager. Ensure that each Windows Server
2008 system that you want to manage has been appropriately configured.

About this task

Typically, managed systems are first discovered using the discovery task in IBM
Flex System Manager Web interface. Then, Platform Agent or Common Agent is
installed on the managed systems directly from IBM Flex System Manager Web
interface. The configuration of some Windows Server 2008 managed systems,
however, can prevent discovery by IBM Flex System Manager.

Complete the following steps on each Windows Server 2008 system to enable
discovery by IBM Flex System Manager:

Procedure

Verify that remote registry administration is enabled. Remote registry
administration must be enabled in order for Agentless managed system discovery
to run commands and run scripts on the managed system. The default setting for
remote registry administration on Windows systems is enabled. Complete the
following steps to verify or change the remote registry administration setting:
1. Click Start > Control Panel > System and Maintenance > Administrative

Tools.
2. In the Administrative Tools window, double-click Services.
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3. In the list of services in the Services window, right-click the Remote Registry
service and select Properties from the menu.

4. On the General page, set the Startup type to Automatic.
5. If the Service status is not Started, click Start to start the service.
6. Click OK to apply the new settings and close the window.

Preparing Windows Vista managed systems
Some Windows Vista systems might need to be configured before you can be
discover or manage them with IBM Flex System Manager. Make sure each
Windows Vista system that you want to manage has been appropriately
configured.

About this task

Typically, managed systems are first discovered using the Discovery task in IBM
Flex System Manager Web interface. Then, Platform Agent or Common Agent is
installed on the managed systems directly from IBM Flex System Manager Web
interface. The configuration of some Windows Vista managed systems, however,
can prevent discovery by IBM Flex System Manager.

Complete the following steps on each Windows Vista system to enable
management by IBM Flex System Manager:

Preparing to manage an agentless managed system running
Windows Vista
Before IBM Flex System Manager can manage a system running Windows Vista,
you must configure a password-protected administrator account on the managed
system and enable sharing and the remote registry service.

About this task

To prepare the Windows Vista system for management by IBM Flex System
Manager, complete the following steps:

Procedure
1. Configure the user account that IBM Flex System Manager will use.

Type of account Configuration steps

Built-in
Administrator
account on the
managed system

Enable the Administrator account and set a password for the
account.

1. Click Start > Control Panel > System and Maintenance >
Administrative Tools.

2. In the Administrative Tools window, double-click Local
Security Policy.

3. Click Security Settings > Local Policies > Security Options.

4. Double-click Accounts: Administrator account status.

5. Click Enabled, and then click OK.

6. Log in to Windows Vista using the Administrator account, and
then set a password for the account.
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Type of account Configuration steps

Local user account
other than
Administrator

Disable User Account Control, create the user account, and set a
password for the account.

1. Click Start > Control Panel > System and Maintenance >
Administrative Tools.

2. In the Administrative Tools window, double-click Local
Security Policy.

3. Click Security Settings > Local Policies > Security Options.

4. Double-click User Account Control: Run all administrators in
Admin Approval Mode.

5. Click Disabled, and then click OK.

6. Create the user account you will use for IBM Flex System
Manager, if it does not already exist.

7. Set the user account type to administrator.

8. Set a password for the account.

Domain account Disable User Account Control.

1. Click Start > Control Panel > System and Maintenance >
Administrative Tools.

2. In the Administrative Tools window, double-click Local
Security Policy.

3. Click Security Settings > Local Policies > Security Options.

4. Double-click User Account Control: Run all administrators in
Admin Approval Mode.

5. Click Disabled, and then click OK.

To enable these changes, you will need to shut down and restart the managed
system.

2. Verify that remote registry administration is enabled. Remote registry
administration must be enabled in order for Agentless managed system
discovery to run commands and run scripts on the managed system. The
default setting for remote registry administration on Windows systems is
enabled. Complete the following steps to verify or change the remote registry
administration setting:
a. Click Start > Control Panel > System and Maintenance > Administrative

Tools.
b. In the Administrative Tools window, double-click Services.
c. In the list of services in the Services window, right-click the Remote

Registry service and select Properties from the menu.
d. On the General page, set the Startup type to Automatic.
e. If the Service status is not Started, click Start to start the service.
f. Click OK to apply the new settings and close the window.

3. Configure Sharing and Discovery preferences. Complete the following steps:
a. Click Start > Control Panel > Network and Internet > Network and

Sharing Center.
b. Under Sharing and Discovery, turn on each of the following items:
v Network discovery
v File sharing
v Password protected sharing

4. Click Start > Control Panel > Network and Internet > Windows Firewall.
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5. Click Allow a program through a Windows Firewall. The Windows Firewall
Settings window opens and displays the Exceptions page.

6. In the list of exceptions, select the File and Printer Sharing check box.

Note: Enabling file and printer sharing allows IBM Flex System Manager to
use Remote Execution and Access (RXA) ports 135, 137, 138, and 139, as well as
DCOM port 445, to communicate with the managed system.

7. Click OK.

Preparing a Windows Vista system for Platform Agent managed
system management
Before IBM Flex System Manager can manage Platform Agent on a system running
Windows Vista, you must configure the firewall to allow communication on the
SLP, CIM, and CIM SSL ports.

About this task

To prepare the Windows Vista system for Platform Agent managed system
management by IBM Flex System Manager, complete the following steps:

Procedure
1. Configure the system for Agentless managed system management as described

in “Preparing to manage a Agentless managed system running Windows
Vista.” Configuration for Agentless managed system management is required in
order to access the managed system.

2. Click Start > Control Panel > Network and Internet > Windows Firewall.
3. Click Allow a program through Windows Firewall.
4. Select the Remote administration check box.
5. Specify ports to allow through Windows Firewall. Complete the following steps

for each of the ports listed in Table 39.
a. Click Add port.
b. Specify the Name, Port number, and Protocol in the Add port window.
c. Click OK.

Table 39. Ports required for Platform Agent managed system management of Windows Vista
systems

Name Port number Protocol

SLP 427 TCP

SLP 427 UDP

CIM 5988 TCP

CIM SSL 5989 TCP

CIM Listener 6988 TCP

6. Click OK.

Preparing a Windows Vista system for Common Agent managed
system management
Before IBM Flex System Manager can manage Platform Agent on a system running
Windows Vista, you must configure the firewall to allow communication with
Common Agent on ports 14247 and 14248.
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About this task

To prepare the Windows Vista system for Common Agent managed system
management by IBM Flex System Manager, complete the following steps:

Procedure
1. Configure the system for Agentless managed system management as described

in “Preparing to manage a Agentless managed system running Windows
Vista.” Configuration for Agentless managed system management is required in
order to access the managed system.

2. Click Start > Control Panel > Network and Internet > Windows Firewall.
3. Click Allow a program through Windows Firewall.
4. Select the Remote administration check box.
5. Specify ports to allow through Windows Firewall. Complete the following steps

for each of the ports listed in Table 40.
a. Click Add port.
b. Specify the Name, Port number, and Protocol in the Add port window.
c. Click OK.

Table 40. Ports required for Common Agent managed system management of Windows Vista
systems

Name Port number Protocol

Director IPC 14247 TCP 14247 TCP

Director IPC 14247 UDP 14247 UDP

Director IPC 14248 TCP 14248 TCP

Director IPC 14248 UDP 14248 UDP

6. Click OK.

Preparing Windows XP managed systems
You might need to configure certain Windows XP systems before you can discover
them with IBM Flex System Manager. Ensure that each Windows XP system that
you want to manage has been appropriately configured.

About this task

Typically, managed systems are first discovered using the discovery task in IBM
Flex System Manager Web interface. Then, Platform Agent or Common Agent is
installed on the managed systems directly from IBM Flex System Manager Web
interface. The configuration of some Windows XP managed systems, however, can
prevent discovery by IBM Flex System Manager.

Complete the following steps on each Windows XP system to enable discovery by
IBM Flex System Manager:

Procedure
1. Disable Simple File Sharing. Windows XP targets must have Simple File

Sharing disabled for Agentless managed system discovery to work. Complete
the following steps to disable simple file sharing on the Windows XP system to
be managed:
a. Select Start > Control Panel > Folder Options.
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b. In the Folder Options window, click the View tab.
c. In the View panel, scroll to the bottom of the Advanced settings list; then,

clear the Use simple file sharing (Recommended) check box.
d. Click OK.

2. Configure Windows Firewall (Internet Connection Firewall) to allow access by
IBM Flex System Manager. Windows XP (before Service Pack 2) includes a
built-in firewall called Internet Connection Firewall (ICF), which is disabled by
default. Windows XP Service Pack 2 includes Windows Firewall, which is
enabled by default. Either firewall will block attempted accesses by Agentless
managed system discovery unless the firewall is disabled or an exception is
defined for the management server on which IBM Flex System Manager is
installed.
Complete the following steps to enable IBM Flex System Manager to access the
managed system:
a. Select Start > Control Panel > Network Connections > connection. The

connection is the network connection that will be used for discovery.
Typically, this is Local Area Connection.

b. In the General tab of the Connection Status window, click Properties.
c. In the Connection Properties window, click the Advanced tab.
d. In the Advanced panel, click the firewall Settings button.
e. If the firewall is turned off, no further configuration is required. Continue to

step 3.
f. If the firewall is enabled, click the Exceptions tab.
g. In the Exceptions panel, select the File and Printer Sharing check box.
h. Click OK.

Note: The network administrator can define a group policy for this
configuration.

3. Verify that remote registry administration is enabled. Remote registry
administration must be enabled in order for Agentless managed system
discovery to run commands and run scripts on the managed system. The
default setting for remote registry administration on Windows systems is
enabled. Complete the following steps to verify or change the remote registry
administration setting:
a. Click Start > Control Panel > System and Maintenance > Administrative

Tools.
b. In the Administrative Tools window, double-click Services.
c. In the list of services in the Services window, right-click the Remote

Registry service and select Properties from the menu.
d. On the General page, set the Startup type to Automatic.
e. If the Service status is not Started, click Start to start the service.
f. Click OK to apply the new settings and close the window.

4. Verify the hidden administrative disk shares such as C$, D$, and so on. The
default hidden administrative disk shares are required for correct operation of
Agentless managed system discovery.
At a command prompt, type net share and press Enter to list the shares
defined on the managed system.
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Preparing Windows Server 2012 managed systems
You might need to configure certain Windows Server 2012 systems before you can
discover them with IBM Flex System Manager. Ensure that each Windows Server
2012 system that you want to manage has been appropriately configured.

About this task

Typically, managed systems are first discovered using the discovery task in IBM
Flex System Manager Web interface. Then, Platform Agent or Common Agent is
installed on the managed systems directly from IBM Flex System Manager Web
interface. The configuration of some Windows Server 2012 managed systems,
however, can prevent discovery by IBM Flex System Manager.

Complete the following steps on each Windows Server 2012 system to enable
discovery by IBM Flex System Manager:

Procedure
1. Verify that remote registry administration is enabled. Remote registry

administration must be enabled in order for Agentless managed system
discovery to run commands and run scripts on the managed system. The
default setting for remote registry administration on Windows systems is
enabled. Complete the following steps to verify or change the remote registry
administration setting:
a. Click Server Manager > Tools > Services.
b. In the list of services in the Services window, right-click the Remote

Registry service and select Properties from the menu.
c. On the General page, set the Startup type to Automatic.
d. If the Service status is not Started, click Start to start the service.
e. Click OK to apply the new settings and close the window.

2. To ensure that Windows Server 2012 can be discovered as a Windows
Distributed Component Object Model (DCOM) protocol access end point in
IBM Flex System Manager, you must complete the following step:
a. Click Server Manager > Tools > Local Security Policy > Local Policies >

Security options > Network access: Shares that can be accessed
anonymously.

b. Right-click Network access: Shares that can be accessed anonymously and
select Properties.

c. In the Network access: Shares that can be accessed anonymously
properties window, specify Enabled in the properties field. To enable this
policy, write the word Enabled in the Properties text box and click Apply,
and then click OK.

3. To ensure that IBM Flex System Manager can correctly install Windows Server
2012 with agents, make these changes to User Account Control:

Note: You can install the agents manually in Windows Server 2012 without
following these steps. However, when IBM Flex System Manager discovers the
managed system, it is listed under Groups > Group by Agent > Systems with
no Agent.
a. Click Server Manager > Tools > Local Security Policy.
b. In the left pane, expand Security Settings > Local Policies and click

Security Options.
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c. Double click User Account Control: Run all administrators in Admin
Approval Mode.

d. Select Disable and click OK.
e. Restart the system.

Discovered systems are listed under Groups > Group by Agent.
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Chapter 8. Automating tasks

By creating event automation plans and applying them to specific systems, you can
automate tasks and other responses to situations that occur in your
systems-management environment. For example, when a specified threshold is
reached or a specified event occurs, you can be notified by e-mail or phone. Or,
you can configure an event automation plan to start a program on a system or
change a system variable when a specific event occurs.

About this task

Important: If you are using predefined IBM Flex System Manager roles, you must
have SMAdministrator authority to use the automation tasks in the IBM Flex
System Manager Web interface.

IBM Flex System Manager provides the Event Automation Plan wizard as a quick
and simple way to create event automation plans that meet most
systems-management needs. Using the Event Automation Plan wizard, you can
create plans that monitor for the most typical situations in systems-management
environments, including, but not limited to, the following examples:
v Critical hardware events from all systems in your environment
v Processor (CPU) use in a specific group of systems, such as all servers running

Linux
v All Common Agent managed systems to determine whether Common Agent

goes offline
v The status of updates that are underway
v Disk space use in systems, such as those that store database data

Then, in response to the situations that you are monitoring, you can choose to send
a page or e-mail, or you can start a program on a system. For more information
about creating event automation plans and using the Event Automation Plan
wizard, see “Creating an event automation plan.”

The Event Automation Plan wizard also provides advanced event actions and
event filter options that you can use to create event automation plans that can
meet very specific needs in your systems-management environment.

Successful implementation of event automation plans requires planning and
consideration of how you will implement them. Providing thoughtful descriptions
for your event automation plans can be particularly helpful. For more information,
see “Planning for event automation plan implementations.”
Related concepts:
 

eLearning: Automating tasks
Related tasks:
“Creating an event automation plan” on page 339
Create an event automation plan to automatically respond to a situation in your
IBM Flex System Manager environment. By creating event automation plans and
applying them to specific systems, you can be notified by e-mail or pager, for
example, when a specified threshold is reached or a specified event occurs. Or, you
can configure an event automation plan to start a program on a system in response
to the event.
Related reference:
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Planning for events

Events, filters, and actions in event automation plans
An event automation plan lets you automatically respond to a situation in your
IBM Flex System Manager environment. By creating event automation plans and
applying them to specific systems, you can be notified by e-mail, for example,
when a specified threshold is reached or a specified event occurs. Or, you can
configure an event automation plan to start a program on a system in response to
the event.

What is an event automation plan?

Event automation plans are composed of three components: a target list that
contains one or more system or group, a filter that specifies types of events; and
one or more actions, which are invoked in response to filtered events. The Event
Automation Plan wizard provides a quick and easy way to create event
automation plans for common situations. If you want to create sophisticated event
automation plans, it is important to understand the events that are generated in a
systems-management environment, the event filters that specify the triggering
events, and the event actions that can automate a response to the triggering event.

When you create an event automation plan, you include a filter and one or more
actions. Finally, you apply the event automation plan to an individual system,
several systems, or a group of systems.

How does IBM Flex System Manager use an event automation
plan?

When IBM Flex System Manager receives an event, the server determines whether
there is a plan for that type of event. If so, the server checks whether the event
source is in the list of targets in the plan. If it is in the plan, then the server
performs the action specified in the plan.

Events
An event is an occurrence of significance to a task or system, such as the
completion or failure of an operation. In a systems-management environment, IBM
Flex System Manager receives events from many sources.

These sources include, but are not limited to, the following programs and
protocols:
v Flex System Manager Program native events generated by the management

node.
v Flex System Manager native events generated by Common Agent. For more

information, see “Common Agent.”
v Common Information Model (CIM) indications from the Common Information

Model Object Manager (CIMOM) that is installed as part of Common Agent and
Platform Agent.

v Microsoft Windows event log.
v Windows Management Instrumentation (WMI).
v Platform Event Traps (PET) through out-of-band communication with systems

that support Alert Standard Format (ASF) and Intelligent Platform Management
Interface (IPMI).
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v Service processor notifications through out-of-band communication.

Alerts and resolutions

In Flex System Manager, an event can be in one of the following categories: alert
and resolution. Typically, an alert is the occurrence of a problem relating to a
system. A resolution is the occurrence of a correction or solution to a problem.
Related concepts:
“Event filters” on page 310
A filter specifies one or more events that you want your event automation plan to
process. The event automation plan ignores any event instances that do not meet
the specifications of the filter. Typically, you will use the common event filters that
are provided in the Event Automation Plan wizard. Occasionally there are
situations where you will want to create a sophisticated event filter. The event
filters described in this section are available for such implementations. Using these
filters, you can specify details for an event such that it covers very specific
problems and occurrences. To create filters quickly, default values are provided;
however, you can customize the settings.
“Event actions” on page 315
Event actions specify the action that IBM Flex System Manager takes in response to
a specific event or events. Using the Event Automation Plan wizard, you can easily
create an event automation plan that will send you an e-mail or pager notification
in response to an event. Additionally, the Event Automation Plan wizard provides
other advanced event actions that you can use in response to an event.
Related reference:
 

CIM indications in IBM Systems Director

Mapping SNMP traps to Flex System Manager events
This topic explains how to modify the rules used to map SNMP traps to Flex
System Manager events. This customization provides greater flexibility in what
information gets presented to users and increases the event action plan filter
options.

Introduction

Flex System Manager can manage SNMP traps. An SNMP trap is a notification sent
from the device acting as an SNMP agent; such as a switch, router, or printer, to
Flex System Manager. It processes incoming traps by mapping them to Flex System
Manager event format. The conversion process is called mapping. Flex System
Manager has default mappings for some traps. Users can also create mapping files
to map additional events.

Mapping SNMP traps to Flex System Manager allows you to do the following:
v Use the same event action plan tools for SNMP traps and Flex System Manager

events.
v Create homogenous information across multiple vendors supporting a trap.
v Customize information presented in the resulting Flex System Manager event.

There are two methods by which traps are converted: unmapped and mapped:

Unmapped traps
Use a generic set of rules, also called keys, to map the trap data to
properties within the Flex System Manager event. Any trap OIDs that are
not included in the mapping keys are considered unmapped and use the
default, generic keys.
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Mapped traps
Have specific conversion keys defined for an SNMP OID or OID range.

Mapping key syntax

The SNMP map file contains a series of map entries that consist of predefined
keys grouped into map entries for specific OIDs or range of OIDs. The equals sign
(=) is used to set a value and the double equals (==) is used to compare values as
equal to each other.

Predefined keys
The predefined keys describe how SNMP trap data should be converted to
Flex System Manager event format. Each key has this format:
event.index.key format.

Note: The predefined key usually does not need to be changed.

index Identifies which map the key entry belongs to. It must be unique
to the key entry in the map file. Follow these suggestions to avoid
duplication of index values:
v Use the specific trap type as a part of that index. In the

following example map entry, the trap type is 8217 and the
index was set to 18217.

v Flex System Manager uses index values through 14000, so
choose indexes above 14000. Check the existing .map files for
additional index values that are in use.

key The key property to be modified and the data associated with it.

Example:

The entry event.12000.severity=4 sets the severity to 4 for map 12000.

Map entries
A map entry contains two sections of keys. The first section, Alert
Definition, describes the organization and content of the Flex System
Manager event. The SNMP Trap Filter Section deals with how the trap
information is filtered and parsed.

Example map entry:
# - Director Alert Definition Section -
# Mappings from lsi-adaptersas.mib specific SNMP traps to the corresponding Director Event Format
# author: Author Name
# Warning! This file is case-sensitive

# SW traps
# - Alert Definition Section -
# Define the alert Family
event.18217.family=SNMP
# Define the alert Event Qualifiers
event.18217.keyword.0=Hardware
event.18217.keyword.1=Storage
event.18217.keyword.2=LSI
# Set the Severity
event.18217.severity=4
# Set the Category
event.18217.category=1
# Define the message to be displayed
event.18217.text=PD state changed on Adapter {0} Dev {1} Enc {2} Slot {3} from {4} to {5}
# - SNMP Trap Filter Section -
# OID of the trap to match
event.18217.oid=1.3.6.1.4.1.3582.4.1.8.0.8217
# Trap variable to parse for the alert message
event.18217.eventvar.0=1.3.6.1.4.1.3582.4.1.6.1001
event.18217.eventvar.1=1.3.6.1.4.1.3582.4.1.8.1201
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event.18217.eventvar.2=1.3.6.1.4.1.3582.4.1.8.1202
event.18217.eventvar.3=1.3.6.1.4.1.3582.4.1.8.1203
event.18217.eventvar.4=1.3.6.1.4.1.3582.4.1.8.1205
event.18217.eventvar.5=1.3.6.1.4.1.3582.4.1.8.1204
event.18217.proceedwithnormaltrap=false

Mapping file syntax - Map entries, Alert Definition section

This section uses a set of keys to define which information is presented in the Flex
System Manager event. The following keys are pertinent to this section:

Table 41. Keys pertinent to the Alert Definition map entry section

Key Value Description

event.index.family SNMP Top-level qualifier: the family name
of event.

event.index.keyword.0 event.qualifier.sample1 This is the top level qualifier. This
value can be translated from the
language bundle specified by
event.bundle key.

event.index.keyword.1 event.qualifier.sample2 The next level qualifier. You can
create as many keywords. These
values form the event type hierarchy
within a family.

event.index.severity 0,1,2,3,4,5 0 - Fatal, 1 - Critical, 2 - Minor, 3 -
Warning (default), 4 –
Harmless/Informational, 5 -
Unknown

event.index.category 0 or 1 0 – resolution, 1 - alert (default)

event.index.text text1 This value can be translated from
language bundle specified by
event.bundle key.

event.index.version version number Version number of this event
definition (defaults to 1)

The event.index.family and event.index.keyword keys are used to define the
event type hierarchical structure that the resulting Flex System Manager event will
belong to. This grouping can be used as part of an event action plan event filter.
The family for mapped SNMP traps is always set to SNMP, while the rest of the
keywords in the hierarchy can be set to whatever best describes the Flex System
Manager event.

Example:

The example in Mapping key syntax section uses the following entries for family
and keywords:
# - Alert Definition Section -
# Define the alert Family
event.18217.family=SNMP
# Define the alert Event Qualifiers
event.18217.keyword.0=Hardware
event.18217.keyword.1=Storage
event.18217.keyword.2=LSI

These keys will produce a Flex System Manager event with the Event Type
SNMP.Hardware.Storage.LSI. The first two keywords define the component
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category, and the last keyword becomes the component type. These are the values
as shown in the Flex System Manager event interface:
Component Type: LSI
Component Category: SNMP\Hardware\Storage

Additionally, you can select the event type on the Event Type page of the Event
Filter wizard. To see it, choose these:

Types of events to include: Custom

Show: Event Type

The next two keys in the example, event.18217.severity=4 and
event.18217.category=1, set the event severity to “Informational” and the category
to “Alert”. There are event categories:

Alert A problem has just occurred.

Resolution
A problem has been resolved.

The Alert Definition Section ends with the key that describes what event text is
produced. The example has the following entry:
# Define the message to be displayed
event.18217.text=PD state changed on Adapter {0} Dev {1} Enc {2} Slot {3} from {4} to {5}

Note: In the map file, this key is on a continuous line.
All information after event.18217.text= is in the event text as it is entered, except
the bracketed numbers such as {0}. These numbers represent the inclusion of
variable information specified in the SNMP Trap Filter Section of the map entry.
They can be assigned to any of the trap variables sent with the trap. This lets you
include trap variable data in the event text.

Mapping file syntax - Map entries, SNMP Trap Filter section

The SNMP Trap Filter Section of the map entry specifies how the SNMP trap is
filtered and parsed. The following keys are pertinent to this section:

Table 42. Keys pertinent to the SNMP trap filter map entry section

Key Value Description

event.index.oid 1.3.6.1.4.1.3582.4.1.8.0.8217 (see the
example map entry)

OID of incoming trap to be matched.
Use an asterisk (*) as a wildcard
character to support fallback rules.

event.index.eventvar.0 Event variable This value can be used as a variable
in event.index.text.

event.index.eventvar.1 Event variable Use this to add a second variable if
necessary. You can add as many
variables as are needed.

event.index.eventvar.index.0 Position based event variable. For
example, this value can be 1. (see the
example map entry)

Use this instead of
event.index.eventvar.n if you want
a specific varbind (by position) value
to be used as an event variable. The
first occurring word index is a
number and the second word index
is an actual word. In the example
map entry, the value of first varbind
will be used as event variable {0}.
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Table 42. Keys pertinent to the SNMP trap filter map entry section (continued)

Key Value Description

event.index.eventvar.index.1 Position based event variable. For
example, this value can be 2.

Use this to add a second variable if
necessary. You can add as many
variables as are needed. In this case,
the value of second varbind will be
used as event variable {1}.

event.index.proceedwithnormaltrap true/false If true, a normal SNMP trap event is
also generated. Currently, this value
is ignored.

The first key included in this section is event.index.oid. It defines the OID of the
trap that the map should be applied to. The example OID key is for the specific
trap type 8217.
# OID of the trap to match
event.18217.oid=1.3.6.1.4.1.3582.4.1.8.0.8217

Notice that the OID is in numeric format and identifies a specific trap. To indicate
a range of trap OIDs, end a branch with an asterisk (*), as shown here:
event.12000.oid=1.3.6.1.6.3.1.1.5.*

After the specified OID is found, the trap identification can be filtered further by
matching the trap variable information against predefined values. This can be done
by using one of these keys: event.index.eventvarbind or
event.index.eventvarbind.index. The primary difference between these two keys
is how the variable data is found.

After the OID and variable filters in the map entry identify a compatible trap, Flex
System Manager retrieves the variable trap information to be included in the Flex
System Manager event text. The SNMP trap variables can be parsed into the Flex
System Manager event text using the event.index.eventvar and
event.index.eventvar.index keys. In the example map entry, key entry for
event.index.event.var shows a request for the trap variable with OID
1.3.6.1.4.1.3582.4.1.6.1001 and assigns it to the Event Text variable {0}.
event.18217.eventvar.0=1.3.6.1.4.1.3582.4.1.6.1001

The event text variable {0} is replaced with the value of the trap variable’s OID in
the event.index.text key.
event.18217.text=PD state changed on Adapter {0} Dev {1} Enc {2} Slot {3} from {4} to {5}

The complete set of variables in the example is mapped as follows.
# Trap variable to parse for the alert message
event.18217.eventvar.0=1.3.6.1.4.1.3582.4.1.6.1001
event.18217.eventvar.1=1.3.6.1.4.1.3582.4.1.8.1201
event.18217.eventvar.2=1.3.6.1.4.1.3582.4.1.8.1202
event.18217.eventvar.3=1.3.6.1.4.1.3582.4.1.8.1203
event.18217.eventvar.4=1.3.6.1.4.1.3582.4.1.8.1205
event.18217.eventvar.5=1.3.6.1.4.1.3582.4.1.8.1204

Another commonly used key is event.index.proceedwithnormaltrap. For an SNMP
trap that is mapped, this key lets you decide whether Flex System Manager should
report the original SNMP trap. By default, Flex System Manager processes both the
SNMP trap and the mapped Flex System Manager event. This causes double event
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log entries and possibly multiple event action plan triggers. Setting the
event.index.proceedwithnormaltrap key to false specifies that only the mapped
event is processed.

Example:
event.18217.proceedwithnormaltrap=false

MIB trap used in the example map entry
Reference of trap from MIB used for this example.
pdtStateChange TRAP-TYPE
ENTERPRISE pdTraps
VARIABLES

{atAdpNumber,pdID,pdEncIndex,pdSlotNo, pdOldState, pdNewState}
DESCRIPTION "PD state changed on Adapter -$1 Dev -$2 Enc -$3 Slot -$4 from $5 to 6"

--#TYPE "LSI SAS Trap: PD state changed"
--#SUMMARY "PD state changed on Adapter -%d Dev -%d Enc -%d Slot -%d from %d to %d"
--#ARGUMENTS {0,1,2,3,4,5}
--#SEVERITY INFORMATIONAL
--#GENERIC 6
--#CATEGORY "Error Events"
--#STATE OPERATIONAL
::= 8217

Forwarding SNMP traps from IBM Flex System Manager to any
SNMP application
To forward SNMP trap events that come from IBM Flex System Manager to an
external SNMP application, import these Management Information Bases (MIBs) to
the external application.

MIBs:
SNMP-FRAMEWORK-MIB
IBM-REC-MIB.mib
IBM-Director-Alert-MIB.mib

The MIBs are located here: /opt/ibm/director/proddata/snmp/

Note: Before you can access the /opt/ibm/director/proddata/snmp/ directory, you
must complete the following steps:
1. Call IBM Support and obtain the password that is required to run the pesh

command.
2. From the management software command-line interface, use the lsconfig -v

command to determine the UVMID of management node.
3. Run the command pesh UVMID, where UVMID is the system ID that you

determined in the previous step. When you are prompted, enter the password
that you obtained from IBM Support. For more information about the
command, see pesh.

After the MIBs are imported, the external SNMP application’s event data displays
the correct trap information.

Event filters
A filter specifies one or more events that you want your event automation plan to
process. The event automation plan ignores any event instances that do not meet
the specifications of the filter. Typically, you will use the common event filters that
are provided in the Event Automation Plan wizard. Occasionally there are
situations where you will want to create a sophisticated event filter. The event
filters described in this section are available for such implementations. Using these

310 Systems Management Guide



filters, you can specify details for an event such that it covers very specific
problems and occurrences. To create filters quickly, default values are provided;
however, you can customize the settings.

You can use a filter to capture a single event or multiple events. When designing
an event filter, first determine whether the following criteria are met:
v Can all the target systems generate all the events that you want to filter?

If a system cannot generate the event that you want to filter, the filter will not be
effective on that system. In such instances, you can apply the event automation
plan to those systems, but it will have no effect. For example, if an event filter is
based on an event for IBM Flex System products and that event automation plan
is applied to systems that do not include IBM Flex System products, the event
filter has no events to filter, and therefore, no actions are performed. If you
understand this concept, you can create more complex event automation plans,
and you can reduce the number of event automation plans you must build and
maintain.

v Can you use the same event actions for all targeted systems to respond to the
event?

v Are the other filter options besides the event type common for all targeted
systems? These settings include the number of times the filter is active, the
severity of the event, and other attributes.

In addition to selecting the event types to filter, you also can select from four types
of event filters: Simple, Duplication, Exclusion, and Threshold. Each filter offers
different options for processing the selected event types.
Related concepts:
“Events” on page 304
An event is an occurrence of significance to a task or system, such as the
completion or failure of an operation. In a systems-management environment, IBM
Flex System Manager receives events from many sources.
“Event actions” on page 315
Event actions specify the action that IBM Flex System Manager takes in response to
a specific event or events. Using the Event Automation Plan wizard, you can easily
create an event automation plan that will send you an e-mail or pager notification
in response to an event. Additionally, the Event Automation Plan wizard provides
other advanced event actions that you can use in response to an event.
Related tasks:
“Managing event filters” on page 359
A filter specifies one or more events that you want your event automation plan to
process. The event automation plan ignores any event instances that do not meet
the specifications of the filter. You can create, copy, edit and delete event filters.

Simple event filter
Simple event filters are general-purpose filters; most event automation plans use a
simple event filter.

In addition to any simple event filters that you create, IBM Flex System Manager
provides the following predefined, read-only simple event filters in the Event
Filters page.

Note: You cannot change predefined event filters; they are read-only. However,
you can copy a predefined filter and change the copy. For more information, see
“Copying an event filter.”
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All events
Processes any events that occur on any system, except for
Windows-specific and IBM i-specific events.

Common Agent offline
Processes only those events that are generated when any managed
operating system resource goes offline.

Critical events
Processes only those events that have a Critical severity.

Disk Use
Processes only those events that are generated when the currently available
hard disk space in a system changes with respect to availability.

Environmental sensor events
Processes only those events that are associated with the condition of a
system environment, such as voltage and temperature.

Fatal events
Processes only those events that have a Fatal severity.

Hardware Predictive Failure Analysis events
Processes only those events that are generated when a Predictive Failure
Analysis is detected for a hardware component.

Informational events
Processes only those events that have a Informational severity.

Memory use
Processes only those events that are generated when the currently available
memory in a system changes with respect to availability.

Minor events
Processes only those events that have a Minor severity.

Processor use
Processes only those events that are generated when the state of a
processor (CPU) has changed.

Security events
Processes only those events that are generated by specific security
protocols, for example, log on failed due to an undefined user ID, or
incorrect or expired password.

Storage events
Processes only those events that are generated by storage components,
such as RAID configurations, for example, when creating, modifying, or
destroying a storage volume or storage pool.

Unknown events
Processes only those events that have a Unknown severity.

Warning events
Processes only those events that have a Warning severity.

Some of these predefined filters use the severity of events to determine which
events can pass through; other filters target a specific type of event. Using one of
these predefined event filters ensures that the correct event type or event severity
is selected.
Related tasks:
“Managing event filters” on page 359
A filter specifies one or more events that you want your event automation plan to
process. The event automation plan ignores any event instances that do not meet
the specifications of the filter. You can create, copy, edit and delete event filters.

Duplication event filter
In addition to the options that are available in the simple filters, duplication event
filters ignore duplicate events.
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You can use this filter in two ways: with or without specifying the number of times
to ignore an event (Count).

To specify only a time range (Interval), the Count setting must be set to zero
(Count = 0). The first occurrence of an event that meets the filter criteria triggers
associated actions and starts a countdown of the interval. For example, if you
specify a 10-second interval, a 10-second timer starts when an event meets the
filtering criteria. Because Count is set to 0, all other instances of an event that meet
the criteria do not trigger associated actions during the interval.

If you also specify a number of times to ignore an event (Count), it applies within
the specified time range (Interval). After the first occurrence of an event that meets
the filtering criteria, the Count setting specifies the number of times an event must
meet the criteria again before associated actions are triggered.

For example, if you set Count to 9, an event meeting the criteria is allowed to
occur nine times within the interval. When an event meets the criteria for a tenth
time within the interval, the associated actions are triggered, the count is reset, and
the interval is reset.

For the duplication filter to trigger the associated event actions a second time, the
count must be exceeded within the reset interval. For example, if Count = 3 and
Interval = 5 minutes, the event action is invoked for the fourth occurrence of the
event that occurs within 5 minutes. Then, the count and interval are reset. A fourth
occurrence of the event must occur in a 5-minute interval again.

This filter is useful in managing the processing of frequently generated events. For
example, you can define a duplication filter to filter on the occurrence of an offline
event and define a corresponding event action to forward the event to IBM Flex
System Manager. Depending on the criteria that you define, only the first event
announcing that the system is offline is processed, and all other instances in which
an event meets the filtering criteria are discarded until the Count value is exceeded
during the specified interval.

All events that you define in a duplicate event filter are treated as one event. For
example, if you want only event E1 to occur in the specified interval, E1 must be
the only event in the duplicate event filter. If E1 triggers events E2 and E3 and you
specify all events in one event filter, only one of them can occur in the specified
interval.
Related tasks:
“Managing event filters” on page 359
A filter specifies one or more events that you want your event automation plan to
process. The event automation plan ignores any event instances that do not meet
the specifications of the filter. You can create, copy, edit and delete event filters.

Exclusion event filter
In addition to the simple filter options, exclusion event filters exclude certain event
types. Using this filter, you define the criteria of the events to exclude. You can use
this filter to activate a group of events and then exclude some of the events in that
group. You can use this filter to exclude multiple event types.

This filter type is useful when you want to create a filter based on a severity or a
category of events, but you want to exclude some specific event types. Instead of
creating event filters for each event that you want to include, you can specify the
event types that you want to exclude. By using exclusion event filters, it is easier
to remove events that you do not want to monitor.
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Example

You can monitor server events, but exclude security alerts such as
“SSHLogin_Failed” failures from a service processor or other SSH client. To change
the event filter, complete the following steps:
1. On the Event Filters page, select the event filter that you want to edit. Click

Edit. The Edit Event Filter wizard is displayed.
2. Change the filter type from 'Simple Event filter' to 'Exclusion Event filter'.
3. Click the 'Excluded Event Type' tab on the left. Select Custom and specify the

full path of the events to be excluded. For this example, browse to Managed
Resource > Managed System Resource > Logical Resource > System >
Computer System > Hardware Control Point > Service Processor.
Under Operational Condition, select SSH Login Failed.

4. Click Add.

Result

The client no longer receives email related to “SSHLogin_Failed for Service
Processor”.
Related tasks:
“Managing event filters” on page 359
A filter specifies one or more events that you want your event automation plan to
process. The event automation plan ignores any event instances that do not meet
the specifications of the filter. You can create, copy, edit and delete event filters.

Recurring event filter
In addition to the simple filter options, a recurring event filter processes an event
after it has occurred a specified number of times within a specified interval.

An event triggers associated actions if, within the specified interval, the event
occurs the number of times specified in the Count field.

For example, you can define a recurring filter to monitor frequently occurring
heartbeat events and forward the event to IBM Flex System Manager only when
the heartbeat event is received for the 100th time during a specified amount of
time. Count is set to 100 and Interval is set to 5 minutes. When the specified event
is received for the 100th time within 5 minutes, the event actions are invoked, and
the Count and Interval settings are reset. To invoke the event actions a second
time, the specified event must be received 100 times within an interval of 5
minutes again. If only 90 events are received within the 5 minutes, the Count and
Interval settings are reset.

Another example is to create a recurring filter such that, if a user attempts to log
on with a bad password five times within five minutes, the event automation plan
will trigger associated event actions.
Related tasks:
“Managing event filters” on page 359
A filter specifies one or more events that you want your event automation plan to
process. The event automation plan ignores any event instances that do not meet
the specifications of the filter. You can create, copy, edit and delete event filters.

314 Systems Management Guide



Event actions
Event actions specify the action that IBM Flex System Manager takes in response to
a specific event or events. Using the Event Automation Plan wizard, you can easily
create an event automation plan that will send you an e-mail or pager notification
in response to an event. Additionally, the Event Automation Plan wizard provides
other advanced event actions that you can use in response to an event.

IBM Flex System Manager has several predefined types of event actions. With the
exception of “Add to the event log”, you must customize each action that you
want to use.
Related tasks:
“Creating an event action” on page 346
Create an event action to use in your event automation plans. You can create event
actions and test actions before using them in your event automation plans.
Typically, you create event actions in the Event Automation Plan wizard. However,
there might be times when you want to create an event action that you can use in
event automation plans at another time.
“Editing an event action” on page 347
Edit an event action to change settings in a preexisting event action.
“Copying an event action” on page 348
Copy an event action when you want to create an event action that is like a
preexisting event action.
“Deleting an event action” on page 349
You can delete an event action when it is no longer useful.
“Saving and not saving an event-action history” on page 350
You can save useful information about an event action by saving the event-action
history. When you no longer want to save the event-action history, you can stop
saving it. By default, the event-action history is not saved. To view an event-action
history, see “Viewing an event-action history.”
“Viewing an event-action history” on page 351
You can view an event-action history for information about how an event action
ran in your systems-management environment.
“Viewing event action properties” on page 354
You can view the properties for an event action for information about the action
settings. Also, the Properties page lists the event automation plans that include the
event action.

Log to a log file
Logs information about the triggering event to a specified text file.

Requirements
None

Result The specified text is added to the log file. Also, applicable attributes of the
event are also logged, for example, severity, event type, date, time, and IP
address of the affected system. You can specify the filename and file
extension of the log file, as well as its maximum file size. If the log file
reaches its specified maximum size, it is renamed to filename.1, where
filename is the file name that you specified. Then, a new filename.extension
file is created, where extension is the file extension that you specified for
the log file. The log file is located on the management node in the
/opt/ibm/director/logs directory.

Note: Before you can access the /opt/ibm/director/lwi/logs directory,
you must complete the following steps:
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1. Call IBM Support and obtain the password that is required to run the
pesh command.

2. From the management software command-line interface, use the
lsconfig -v command to determine the UVMID of management node.

3. Run the command pesh UVMID, where UVMID is the system ID that
you determined in the previous step. When you are prompted, enter
the password that you obtained from IBM Support. For more
information about the command, see pesh.

Example
Use this event action when you want to log information in a file after a
specified event is generated. You can log the following information:
v Standard information from the event.
v Custom information that you specify.

Tip: You can use event-data-substitution variables in the Log comment
field field. For more information, see “Event-data-substitution
variables.”

Related concepts:
“Event-data-substitution variables” on page 355
For some types of actions, you can include event-specific information as part of the
message text. Including event information is referred to as event-data substitution.
You can use event-data-substitution variables to customize the message text sent
by an action.

Modify an event and send it
Resends the event that originally triggered the event automation plan. Before
resending the event, the action modifies the event data, such as its text and
severity, to your specification.

Requirements
None

Result The triggering event and the event that this event action generates are both
logged in the Event Log. The event that this event action generates
contains the text and event type from the original triggering event.

Example
Use this event action when you want to send a secondary event that
contains information from the first event. You can change or add to the
event text. Also, you can change the event severity; for some events, this
capability is useful when you want to increase the severity level.

For example, by default an Topology Offline event has a severity of
informational. If you have created an event automation plan to filter
critical events and you want the Topology Offline event to be treated as
such, you can use this event action to change the severity of this event.
Create a simple filter for the Topology Offline event. Then, use the Modify
an event and send it event action to resend the event, but change the
severity to critical in the New event severity field. Now, the critical event
filter will catch the event and the event automation plan will perform the
prescribed action.

Note: You can use event-data-substitution variables to include event-data
information into the new event text. For more information, see
“Event-data-substitution variables.” The detail slot setting also accepts
event-data-substitution variables; however, using event-data-substitution
variables in the detail slot setting can cause errors if not done correctly.
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Related concepts:
“Event-data-substitution variables” on page 355
For some types of actions, you can include event-specific information as part of the
message text. Including event information is referred to as event-data substitution.
You can use event-data-substitution variables to customize the message text sent
by an action.

Post to a newsgroup (NNTP)
Posts a message to a newsgroup used by your organization. The newsgroup must
use Network News Transfer Protocol (NNTP) to send and receive information.

Requirements
Newsgroup service must be available.

Note: You cannot use this action to post a message to a secure news
server.

Result The specified message is posted to the newsgroup.

Example
This action can be useful as an additional logging mechanism outside of
IBM Flex System Manager. Use this event action when you want to send
information to a newsgroup after a specified event is generated. The
message might notify members of a technical support organization when a
critical server is having problems.

Note: You can use event-data-substitution variables to include event data
information into the newsgroup message. For more information, see
“Event-data-substitution variables.”

Related concepts:
“Event-data-substitution variables” on page 355
For some types of actions, you can include event-specific information as part of the
message text. Including event information is referred to as event-data substitution.
You can use event-data-substitution variables to customize the message text sent
by an action.

Send a Tivoli Enterprise Console event
If IBM Flex System Manager receives an event, you can forward that event to a
specified Tivoli Enterprise Console® event server.

Requirements
This event action requires that Tivoli Enterprise Console server is installed
on the specified system.

Result The specified Tivoli Enterprise Console server receives an IBM Flex System
Manager event in the Tivoli Enterprise Console event format.

Note: If the Tivoli Enterprise Console server is unavailable, the Tivoli
Enterprise Console events are queued and delivered when the Tivoli
Enterprise Console server becomes available.

Example
When IBM Flex System Manager receives an event, you might want to
forward the event to a Tivoli Enterprise Console server.
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Send an Internet (SMTP) e-mail
Sends a Simple Mail Transfer Protocol (SMTP) e-mail message. You also can send a
message to an e-mail enabled phone. Using this action, you can send more text
than when using Send an e-mail to a mobile phone.

Note: This event action can send e-mail messages to Lotus Notes® IDs.

Requirements
If you are concerned about the availability of the internal mail server,
consider using an outside SMTP provider.

Result The specified e-mail address receives the e-mail message.

Example
Use this event action to send a message to administrators that need to
track the status of a group of servers.

Note: You can use event-data-substitution variables to include event data
information in the subject and body of the e-mail message. For more
information, see “Event-data-substitution variables.”

Related concepts:
“Event-data-substitution variables” on page 355
For some types of actions, you can include event-specific information as part of the
message text. Including event information is referred to as event-data substitution.
You can use event-data-substitution variables to customize the message text sent
by an action.
Related tasks:
“Testing an event action” on page 348
You can test an event action to make sure that the settings perform as expected. It
is a best practice to test an event action before using it in an event automation plan
so you can avoid unexpected results.

Send an e-mail to a mobile phone
Sends an e-mail message to a mobile phone. The e-mail message is shortened to
accommodate the limited display screen of a mobile phone. Using this action, you
can send less text than when using Send an e-mail (Internet SMTP) .

Requirements
This event action has the following requirements:
v The management node must be running Windows, AIX, or Linux.
v The mobile phone must be able to receive text messages.

Result The specified mobile phone receives the e-mail message. If you specified a
message body, that is all that the mobile phone receives. If you did not
specify a message body, the mobile phone receives the text of the
triggering event.

Example
Use this event action to send an e-mail message to service personnel when
a Redundant Array of Independent Disks (RAID) configuration fails.

Note: You can use event-data-substitution variables to include event data
information in the subject and body of the e-mail message. For more
information, see “Event-data-substitution variables.”

Related concepts:
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“Event-data-substitution variables” on page 355
For some types of actions, you can include event-specific information as part of the
message text. Including event information is referred to as event-data substitution.
You can use event-data-substitution variables to customize the message text sent
by an action.
Related tasks:
“Testing an event action” on page 348
You can test an event action to make sure that the settings perform as expected. It
is a best practice to test an event action before using it in an event automation plan
so you can avoid unexpected results.

Send an event to Tivoli Event Integration Facility probe
If IBM Flex System Manager receives an event, you can forward that event to a
specified Tivoli Event Integration Facility (EIF) probe.

Requirements
This event action requires that you have Tivoli Event Integration Facility
(EIF) probe installed on the specified system.

Result The specified EIF probe receives an IBM Flex System Manager event in the
Tivoli Event Integration Facility event format. The event includes the
following extra tokens:

source_moid
This token has a value of the managed object identifier (MOID) for
the source event system. For example, an , called dirserverA,
discovers an , called diragentB. When the events from diragentB
occur, the source_moid is the MOID of diragentB.

Note: For out-of-bind events, the system that is the source of the
events has no MOID.

source_app
This token has a value of “IBM_DIRECTOR”, which means that the
source application is IBM Flex System Manager.

source_app_version
This token has a value that corresponds to the version of that is
currently installed.

managed_object_type
This token has a value that corresponds to the type of managed
object (in this case, the component type) that is associated with the
type of source event. Some examples of managed objects:
v managed_object_type="BCChassis"
v managed_object_type="UPD"
v managed_object_type="Fan"

http_port
This token has a value of an HTTP port number, such as
http_port=8421.

https_port
This token has a value of an HTTP secure port number, such as
https_port=8422.

Note: Note: If the EIF probe is unavailable, the Tivoli Event Integration
Facility events are queued and delivered when the probe becomes
available.
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Example
When IBM Flex System Manager receives an event, you can forward the
event to a Tivoli Business Service Manager (TBSM) by using the EIF probe.
The event action sends the event to the probe. Then, the probe forwards
the event to Tivoli OMNIBus, and TBSM pulls the event from OMNIBus.
Any products that work with EIF probe can process the event action, so
TBSM represents only one potential consumer of this event action.

Note: OMNIBus is a prerequisite for running TBSM. You can install
OMNIBus as part of TBSM, and TBSM customers have the option of
connecting to an existing copy of OMNIBus.

Send an SNMP INFORM request to an IP host
Sends an SNMPv2 or SNMPv3 INFORM request to a specified IP address or host
name. SNMP INFORM is a special version of an SNMP trap with a response from
a destination. Optionally, SNMPv3 traps can be authenticated (by using either the
Message Digest 5 protocol or the Secure Hash Algorithm protocol) and encrypted
(by using either the Advanced Encryption Standard or the Data Encryption
Standard).

Requirements
This event action requires that an SNMP manager that can receive an
SNMP INFORM be installed on the specified system.

Result The specified system receives an SNMP INFORM.

Note: For SNMPv1 and SNMPv2, this event action supports all
implementations that follow the associated RFCs. For SNMPv3, this event
action supports implementations that follow the associated RFCs (like the
inform listener in Net-SNMP version 5.4.2.1). Keep in mind that different
SNMPv3 implementations offer varying degrees of support that might
produce different results.

Example
An SNMP INFORM is a type of SNMP communication. You can use this
event action to send an SNMP INFORM in response to the triggering
event. Typically, an SNMP INFORM is used for manager-to-manager
communication as a means of acknowledging receipt of a notification.

If you use SNMP to monitor your systems, use this action to send specified
critical events as SNMP INFORM notifications to your SNMP monitor. If
the SNMP INFORM is not received, the action completion status is set to
Failed and IBM Flex System Manager knows whether the SNMP INFORM
was delivered successfully.

Send an SNMP trap reliably to a NetView host
Generates an SNMP trap and sends it to a specified NetView® host using a TCP/IP
connection to the host. If delivery of the SNMP trap fails, a message is posted in
the history log of the system.

Requirements
The NetView product must be installed on the specified system.

Result The specified NetView system receives the SNMP trap. If delivery of the
SNMP trap fails, a message is written to the specified system's history log.
The failure information can be retrieved from the management node
system log using the lsevtacthist command-line command. For more
information, see “lsevtacthist command.”
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Example
If you are using the NetView product to monitor your systems, use this
event action to send or reroute specific events from IBM Flex System
Manager to your NetView host. Then, you can view these specific events
on your NetView console.

Send an SNMP trap to an IP host
Generates an SNMPv1, SNMPv2, or SNMPv3 trap and sends it to a specified IP
address or host name. Optionally, SNMPv3 traps can be authenticated (by using
either the Message Digest 5 protocol or the Secure Hash Algorithm protocol) and
encrypted (by using either the Advanced Encryption Standard or the Data
Encryption Standard).

Requirements
This event action requires the availability of SNMP agent on the specified
system that is to receive the traps.

Result The specified system receives an SNMP trap.

Note: For SNMPv1 and SNMPv2, this event action supports all
implementations that follow the associated RFCs. For SNMPv3, this event
action supports implementations that follow the associated RFCs (like the
trap listeners in IBM AIX Version 6.1AIX Version 6.1 or Net-SNMP version
5.4.2.1). Keep in mind that different SNMPv3 implementations offer
varying degrees of support that might produce different results.

Example
If you use an SNMP application to monitor your systems-management
environment, you can use this action to send the events from IBM Flex
System Manager as traps to the SNMP application. If your
systems-management environment includes several installations of IBM
Flex System Manager, you can use this event action to configure each
instance of IBM Flex System Manager to send the events as traps to the
SNMP application such that the traps are consolidated in the SNMP
application. In the SNMP application, an administrator can view all of the
events from all of the IBM Flex System Manager installations.

Send events to Syslog server
When IBM Flex System Manager receives an event, you can forward that event to
a specified syslog server. To help ensure reliability, specify a secondary syslog
server that receives messages when the primary syslog server is unavailable. You
can also configure the primary and secondary syslog servers to forward messages
to another syslog server.

Requirements
This event action requires that you have a syslog server installed,
configured, and running on the specified system. When you create the
event action, you must specify the port number and the protocol used to
communicate with the syslog server. Verify that the management node can
successfully communicate with the syslog server.

Important: When using the UDP protocol, the event action handler
assumes that the port is open on the remote system if the event action does
not receive an ICMP unreachable message from the syslog server. For
example, the event action assumes that the remote UDP port is listening or
open when ICMP is disabled on a syslog server that is not pingable or
when the syslog server does not exist.

Result The specified syslog server receives the forwarded IBM Flex System
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Manager event message. Configure the event action to forward messages
from a specific type of source (or facility) and to include different levels of
detail in the forwarded messages.

Note: When the primary syslog server is not available, a specified
secondary syslog server receives the message. If you did not specify a
secondary syslog server or if the secondary syslog server is not available,
the event action fails to start.

Facilities
The event action forwards messages generated by any one of the
following facilities:

Note: Some syslog servers might support only a subset of the
facilities. Forwarded messages for unsupported facilities might
exhibit unexpected results.
v AUTH: authorization system messages (including programs that

require user IDs and passwords)
v AUTHPRIV: security or authorization system messages

(including programs that require user IDs and passwords)
v CLOCKDAEMON: clock daemon messages
v CRON: cron daemon messages
v DAEMON: system daemon messages (daemons not specified by

other facilities)
v FTP: FTP daemon messages
v KERN: kernel messages
v LOCAL0 - LOCAL7: user-defined facility messages
v LOGALERT: authorization system messages (including programs

that require user IDs and passwords)
v LOGAUDIT: authorization system messages (including programs

that require user IDs and passwords)
v LPR: line printer subsystem messages
v MAIL: mail program messages
v NEWS: news subsystem messages
v NTP: NTP subsystem messages
v SYSLOG: syslog server messages
v USER: user-level messages
v UUCP: UUCP subsystem messages

Example
When IBM Flex System Manager receives an event, details about the event
are packaged into a message that is forwarded to a syslog server. For
example, the management node receives an event with a severity of 4
(Harmless). The Send events to Syslog server event action packages the
specified event data into a message with a corresponding syslog severity of
5 (Notice) and forwards the message to the syslog server. (The event also is
logged in the appropriate IBM Flex System Manager log.) When the
primary syslog server is not listening, the event action forwards the
message to the secondary syslog server (if a secondary server is specified).
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Note: When the message sent to the syslog server is larger than 1024
bytes, the event action separates the message into two or more segments.
Each segment of the message is numbered, and the last segment is
identified.

Related reference:
 

The Syslog Protocol

Event data and severity mapping:

Select how much event data the Send events to Syslog server event action includes
in the forwarded messages. The severity level is always included in the forwarded
message. Use the severity mapping information to determine how the severity
level of the stored message on the syslog server corresponds to the severity level of
the original IBM Flex System Manager event.

Event data

Specify how much event data are included in messages forwarded to the syslog
server by selecting either Main event data or All event data.

Note: Main event data is the default selection.

Main event data
Main event data includes the following data:
v The management node IP address or host name
v The event ID
v The event message
v The name of the resource that generated the event
v The severity level of the event
v The localized date and time that represent when the event occurred
v The category of the event (Alert or Resolution)
v The fully qualified representation of the event type
v The component category
v The component instance
v The condition type
v The condition value

All event data
All event data includes the same data as main event data plus the
following data:
v The time zone of the management node
v The source application, which is IBM Flex System Manager
v The version of IBM Flex System Manager
v The name of the resource that sent the event, which might be different

from the source value when the event is forwarded or transmitted
through an intermediate system

v The unique ID of the event sender
v The unique ID of the event
v Any additional details, as available
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Severity mapping

The Send events to Syslog server event action maps received IBM Flex System
Manager events of a given severity to a corresponding syslog severity level. The
result of this mapping is that the event in the IBM Flex System Manager log has a
different severity level than event in the syslog server log. Use the following table
to determine how the severity levels of IBM Flex System Manager events
correspond to severity levels of the corresponding events in the syslog server log.

Table 43. How IBM Flex System Manager events map to corresponding syslog server
events

Severity of an IBM Flex System Manager
event

Severity of the corresponding event sent to
the syslog server

0 Fatal: The source of the event caused
the program to fail; resolve before
restarting the program

1 Alert: Take action immediately

1 Critical: The source of the event might
cause the program to fail; resolve
immediately.

2 Critical: Critical condition

2 Minor: The application that issued the
event assigned a severity level that
indicates that the source of the event
should not cause immediate program
failure; resolve

3 Error: Error condition

3 Warning: The source of the event
might not be problematic but warrants
investigation.

4 Warning: Warning condition

4 Harmless. The event was generated
only for informational purposes. Most
events of this severity do not indicate
potential problems.

5 Notice: Normal but significant
condition

5 Unknown. The application that
generated the event did not assign a
severity level; however, these events
might indicate potential problems.

6 Informational: Informational message

Additional information

IBM i message events have several keywords listed such as Message type and
Message severity. The following table lists the possible values and meanings for
the Message type keyword.

Table 44. Possible values and meanings for the Message type keyword

Value Message Type

01 Completion

02 Diagnostic

04 Informational

05 Inquiry

06 Sender's copy

08 Request

10 Request with prompting

14 Notify, exception already handled
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Table 44. Possible values and meanings for the Message type keyword (continued)

Value Message Type

15 Escape, exception already handled

16 Notify, exception not handled

17 Escape, exception not handled

21 Reply, not checked for validity

22 Reply, checked for validity

23 Reply, message default used

24 Reply, system default used

25 Reply, from system reply list

26 Reply, from exit program

The Message severity is the value of the severity code which is a number from 0 to
99. The Message severity is much like the severity of a message on the Severity
page in the Event Filter Builder window, except on the Severity page the severity
is a mapping of the number to a keyword.

Severity
IBM Flex
System Manager maps the message event. Messages of type inquiry are
WARNING.
All other types of message are mapped based on the severity of the messages.
if msg severity < 10 then HARMLESS
else msg severity < 20 then WARNING
else msg severity < 30 then MINOR
else msg severity < 80 then CRITICAL
else msg severity is FATAL
Related reference:
 

The Syslog Protocol (RFC 5424)

Set an event system variable
Sets a user-defined system variable to a new value or resets the value of an
existing system variable. IBM Flex System Manager provides user-defined system
variables to help you test and track the status of network resources according to
the needs of your organization. System variable names and values can be
referenced wherever event data substitution is allowed.

Note: This event action affects an IBM Flex System Manager-provided,
user-defined system variable, not an operating-system variable.

Requirements
None

Result The specified variable and value are added to the EventSysVar.prop file.
This file is located on the management node in the /opt/ibm/director/
data directory.

Before you can access this directory and view the EventSysVar.prop file,
you must complete the following steps:
1. Call IBM Support and obtain the password that is required to run the

pesh command.
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2. From the management software command-line interface, use the
lsconfig -v command to determine the UVMID of management node.

3. Run the command pesh UVMID, where UVMID is the system ID that
you determined in the previous step. When you are prompted, enter
the password that you obtained from IBM Support.

Note: For more information about the command, see pesh.

Example

Assume that you need to monitor a bottleneck in the network that can
cause network congestion. You can create an event automation plan to
specify an SNMP event that indicates network congestion, and initiate the
Set Event System Variable task when the event occurs. Assume that you
have specified the following settings:
v System variable name field: NetStatus
v New value field: Congested
v Reset value to use IBM Flex System Manager when restarts field:

Normal
v Time until automatic value reset field: 10

If 10 seconds elapse before IBM Flex System Manager receives the event
that triggers this action or before IBM Flex System Manager stops and
restarts, the NetStatus system variable is reset to normal.

Instead of using a specific event that signals that your NetStatus is
Normal, you have used a system variable that automatically resets to
normal when the events that cause this action to trigger are not received
within the interval. If IBM Flex System Manager continues to receive the
events before the interval expires, this action continues to trigger, signaling
that the network is congested. If the timer interval expires, NetStatus is
reset to Normal.

Note: You can use event-data-substitution variables to include event-data
information in the System variable name, New value, and the Reset value
to use IBM Flex System Manager when restarts fields of this event action.
For more information, see “Event-data-substitution variables.”

Related concepts:
“Event-data-substitution variables” on page 355
For some types of actions, you can include event-specific information as part of the
message text. Including event information is referred to as event-data substitution.
You can use event-data-substitution variables to customize the message text sent
by an action.

Start a program on a system
Starts a program on a specified system. Programs can include command-line
commands that can start or stop programs on the system.

Requirements
This event action has the following requirements:
v The specified system must have Common Agent installed.
v To work with this type of event action, the user must belong to the

smadmin group.
v Selecting the management server as the target system is not supported.

Result The program is started on the specified system.
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Example
You can create an event automation plan that detects a critical Ambient
Temperature threshold event from Active Energy Manager on a system
running Windows 2003. Using this action, you can start the shutdown.exe
program on other systems in the same location that are running operating
systems that Active Energy Manager does not support, such asWindows
Vista.

Tip: You can use event-data-substitution variables in the Program file
name field. For more information, see "Event-data-substitution variables."

Related concepts:
“Event-data-substitution variables” on page 355
For some types of actions, you can include event-specific information as part of the
message text. Including event information is referred to as event-data substitution.
You can use event-data-substitution variables to customize the message text sent
by an action.
Related tasks:
“Testing an event action” on page 348
You can test an event action to make sure that the settings perform as expected. It
is a best practice to test an event action before using it in an event automation plan
so you can avoid unexpected results.

Start a program on the system that generated the event
Starts a program on the system that generated the event that triggered the event
automation plan. Programs can include command-line commands that can start or
stop programs on the system.

Requirements
This event action has the following requirements:
v The specified system must have Common Agent installed.
v To work with this type of event action, the user must belong to the

smadmin group.
v This action will not run if the system that generated the event is the

management server.

Result The program is started on the system that generated the event.

Example
You might use the dakill.exe program that is provided with IBM Flex
System Manager, located in the support directory. You can use this
program to stop processes by providing the process name.

For example, if you want to stop the solitaire.exe program, you can create
an event automation plan using this event action and combine it with a
process monitor configured to generate an event when solitaire.exe starts
and the event automation plan will stop the solitaire.exe process on that
system.

Note: You cannot test this event action before including it in an event
automation plan. The Test menu item under the template menu is not
supported by this action.

Tip: You can use event-data-substitution variables in the Program file
name field. For more information, see “Event-data-substitution variables.”

Related concepts:
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“Event-data-substitution variables” on page 355
For some types of actions, you can include event-specific information as part of the
message text. Including event information is referred to as event-data substitution.
You can use event-data-substitution variables to customize the message text sent
by an action.

Start a task on a specified system
Starts a noninteractive IBM Flex System Manager task on a specified system.
Noninteractive tasks are tasks that do not require user input.

Requirements
This event action has the following requirements:
v The specified task must be a noninteractive task.
v The task that you want to use must be available in the IBM Flex System

Manager Web interface before you can specify the task for this action.
v To work with this type of event action, the user must belong to the

smadmin group.

Important: Some tasks have hardware or software requirements and
cannot be performed on a given system. Give careful consideration to an
event automation plan that uses this event action before associating it with
a given system or group. For example, not all power management
commands are available.

Result The task is started on the specified system.

Example
Consider an environment where you have two physical systems and one of
the physical system is running three virtual servers. You can create an
event automation plan that detects a critical Predictive Failure Analysis
(PFA) event on a physical system. Using this action, you can run a
previously created noninteractive task that migrates the running workload
of the virtual servers hosted on the affected physical server to the second
physical server.

Note: You can create noninteractive tasks using the Command Automation
task.

Related tasks:
“Testing an event action” on page 348
You can test an event action to make sure that the settings perform as expected. It
is a best practice to test an event action before using it in an event automation plan
so you can avoid unexpected results.

Start a task on the system that generated the event
Starts a noninteractive IBM Flex System Manager task on the system that
generated the event. Noninteractive tasks are tasks that do not require user input.

Requirements
This event action has the following requirements:
v The specified task must be a noninteractive task.
v The task that you want to use must be available in the IBM Flex System

Manager Web interface before you can specify the task for this action.

Important: Some tasks have hardware or software requirements and
cannot be performed on a given system. Give careful consideration to an
event automation plan that uses this event action before associating it with
a given system or group. For example, not all power management
commands are available.
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Result The task is started on the system that generated the event.

Example
You can create an event automation plan to monitor systems for hardware
problems and, when the event automation plan detects a hardware
problem, you can set the locator LED on that system to flash by using this
event action.

Note: You cannot test this event action before including it in an event
automation plan. The Test menu item under the template menu is not
supported by this action.

Static group: add or remove group members
Adds a defined set of systems to a specified static group or removes a defined set
of systems from the specified static group. Use this event action to initialize a set
of systems to process. Then the processing is triggered by an event that you
specify in your event filter.

Requirements
Both the source and target groups must be static groups.

Result The group member that generated the event is added to the specified static
group or removed from a specified static group, as applicable.

Example
Use this action to track systems that have been processed. When the
specified event is received, this event action moves a defined set of
systems to a static group. Then, as each system is processed, the system is
removed from the static group using the Static group: add or remove the
event-generating system event action.

For example, create a static group that contains all the systems that require
updating. After each system is updated, an event is generated. That event
can trigger this event action to remove the updated system from the static
group. When there are no more systems in the static group, you know all
systems have been updated.

Tip: You can use event-data-substitution variables for the target group
name or the new group name. For example, you can dynamically set the
target group to the static group that contains the system that generated the
event. For more information, see “Event-data-substitution variables.”

Related concepts:
“Event-data-substitution variables” on page 355
For some types of actions, you can include event-specific information as part of the
message text. Including event information is referred to as event-data substitution.
You can use event-data-substitution variables to customize the message text sent
by an action.

Static group: add or remove the event-generating system
Adds the system that generated the event to a specified static group or removes
the system that generated the event from a specified static group, as applicable.

Requirements
Both the source and target groups must be static groups.

Result The system that generated the event is added to the specified static group
or removed from a specified static group, as applicable.

Example
You can use this event action to track systems for which IBM Flex System
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Manager has processed an event. As a system generates the event that you
specified, that system is moved to a static group. Then, you can view the
members of that static group to see which system has generated the event.

Similarly, as a system generates the event that you specified, that system
can be removed from a static group.

Tip: You can use event-data-substitution variables for the target group
name or the new group name. For example, you can dynamically set the
target group to the static group that contains the system that generated the
event. For more information, see “Event-data-substitution variables.”

Related concepts:
“Event-data-substitution variables” on page 355
For some types of actions, you can include event-specific information as part of the
message text. Including event information is referred to as event-data substitution.
You can use event-data-substitution variables to customize the message text sent
by an action.

Timed alarm that generates an event
Generates a defined alarm event only if IBM Flex System Manager does not receive
a specified event within a specified time range. This event action is useful for
monitoring for a loss of function, much like a heartbeat monitor.

Requirements
None

Result An event triggers an event automation plan that contains this event action.
The action is invoked and it starts a timer. If another event of the same
type is received before the timer expires, nothing further happens.
However, if the timer does expire, an alarm event is generated by this
action.

Example
You can use this action to make sure that something happens repeatedly or
within a given amount of time. After the timer expires and the alarm event
is sent, the monitoring process of this event action stops.

For example, you can monitor Common Agent to go offline on a system. If
Common Agent does not return online within a given amount of time, you
can power off that system.

Note: You also can stop the monitoring process by setting the timer value
to 0. This capability is useful if you want to stop the process without
deleting the event action or the event automation plan.

Tip: You can use event-data-substitution variables in the following fields:
Timed alarm ID, Program file name, and Working directory. For more
information, see “Event-data-substitution variables.”

Related concepts:
“Event-data-substitution variables” on page 355
For some types of actions, you can include event-specific information as part of the
message text. Including event information is referred to as event-data substitution.
You can use event-data-substitution variables to customize the message text sent
by an action.
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Monitoring events that are specific to the operating system
If you want to monitor Windows-specific or IBM i-specific events in the IBM Flex
System Manager environment, you must create an event automation plan in order
for IBM Flex System Manager to process these events. The predefined active event
automation plan in IBM Flex System Manager, Log All Events, does not monitor
these events that are specific to the operating system.

Systems running Windows or IBM i can generate the following events that are
specific to the operating system.

Windows-specific event types
v Windows event log
v Windows services
v Windows registry

IBM i-specific event types
v Msgq

Even though these events are generated by their respective operating systems (or
an optional layer that is installed on the operating system), IBM Flex System
Manager does not process these events unless you create an event automation plan
to do so. When you install IBM Flex System Manager, it has one predefined active
event automation plan: Log All Events. However, this event automation plan does
not log these Windows-specific or IBM i-specific events. You must create an event
automation plan with a simple-event filter that contains the event types for one or
more of these events. Then, you must apply this event automation plan to the
systems running Windows or IBM i.

When Common Agent starts on a system running Windows, the twgescli.exe
program starts, too. This program listens for IBM Flex System Manager to send a
message to Common Agent that an event automation plan has been applied to that
system. If the event automation plan includes a simple-event filter that contains the
event types for any of the Windows-specific events, IBM Flex System Manager
appropriates these events for its own use. This process is called event subscription.
The twgescli.exe program subscribes to the event types that are specified in the
event automation plan and translates the Windows-specific events into an IBM Flex
System Manager event type. Then, the program forwards the events to the
management node from which the event automation plan was applied.

Note: If an event automation plan that subscribes to the Windows specific events
is applied to multiple Windows endpoints and some of the Windows endpoints
generate Windows specific events at a faster frequency, then it might cause an out
of memory error in IBM Flex System Manager. Out of memory error occurs when
virtual memory allocated to IBM Flex System Manager is exhausted. Out of
memory also causes IBM Flex System Manager to stop functioning. When the
Windows specific events are forwarded to IBM Flex System Manager at a faster
rate, the events are queued in memory for a later processing, and exhausts the
allocated memory of IBM Flex System Manager. You must disable the event
automation plan to stop the subscription to the Windows specific events.
Otherwise, you can also check each Windows endpoint and stop Windows from
generating the subscribed Windows event logs.
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Mapping SNMP traps to Flex System Manager events
This topic explains how to modify the rules used to map SNMP traps to Flex
System Manager events. This customization provides greater flexibility in what
information gets presented to users and increases the event action plan filter
options.

Introduction

Flex System Manager can manage SNMP traps. An SNMP trap is a notification sent
from the device acting as an SNMP agent; such as a switch, router, or printer, to
Flex System Manager. It processes incoming traps by mapping them to Flex System
Manager event format. The conversion process is called mapping. Flex System
Manager has default mappings for some traps. Users can also create mapping files
to map additional events.

Mapping SNMP traps to Flex System Manager allows you to do the following:
v Use the same event action plan tools for SNMP traps and Flex System Manager

events.
v Create homogenous information across multiple vendors supporting a trap.
v Customize information presented in the resulting Flex System Manager event.

There are two methods by which traps are converted: unmapped and mapped:

Unmapped traps
Use a generic set of rules, also called keys, to map the trap data to
properties within the Flex System Manager event. Any trap OIDs that are
not included in the mapping keys are considered unmapped and use the
default, generic keys.

Mapped traps
Have specific conversion keys defined for an SNMP OID or OID range.

Mapping key syntax

The SNMP map file contains a series of map entries that consist of predefined
keys grouped into map entries for specific OIDs or range of OIDs. The equals sign
(=) is used to set a value and the double equals (==) is used to compare values as
equal to each other.

Predefined keys
The predefined keys describe how SNMP trap data should be converted to
Flex System Manager event format. Each key has this format:
event.index.key format.

Note: The predefined key usually does not need to be changed.

index Identifies which map the key entry belongs to. It must be unique
to the key entry in the map file. Follow these suggestions to avoid
duplication of index values:
v Use the specific trap type as a part of that index. In the

following example map entry, the trap type is 8217 and the
index was set to 18217.

v Flex System Manager uses index values through 14000, so
choose indexes above 14000. Check the existing .map files for
additional index values that are in use.

key The key property to be modified and the data associated with it.
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Example:

The entry event.12000.severity=4 sets the severity to 4 for map 12000.

Map entries
A map entry contains two sections of keys. The first section, Alert
Definition, describes the organization and content of the Flex System
Manager event. The SNMP Trap Filter Section deals with how the trap
information is filtered and parsed.

Example map entry:
# - Director Alert Definition Section -
# Mappings from lsi-adaptersas.mib specific SNMP traps to the corresponding Director Event Format
# author: Author Name
# Warning! This file is case-sensitive

# SW traps
# - Alert Definition Section -
# Define the alert Family
event.18217.family=SNMP
# Define the alert Event Qualifiers
event.18217.keyword.0=Hardware
event.18217.keyword.1=Storage
event.18217.keyword.2=LSI
# Set the Severity
event.18217.severity=4
# Set the Category
event.18217.category=1
# Define the message to be displayed
event.18217.text=PD state changed on Adapter {0} Dev {1} Enc {2} Slot {3} from {4} to {5}
# - SNMP Trap Filter Section -
# OID of the trap to match
event.18217.oid=1.3.6.1.4.1.3582.4.1.8.0.8217
# Trap variable to parse for the alert message
event.18217.eventvar.0=1.3.6.1.4.1.3582.4.1.6.1001
event.18217.eventvar.1=1.3.6.1.4.1.3582.4.1.8.1201
event.18217.eventvar.2=1.3.6.1.4.1.3582.4.1.8.1202
event.18217.eventvar.3=1.3.6.1.4.1.3582.4.1.8.1203
event.18217.eventvar.4=1.3.6.1.4.1.3582.4.1.8.1205
event.18217.eventvar.5=1.3.6.1.4.1.3582.4.1.8.1204
event.18217.proceedwithnormaltrap=false

Mapping file syntax - Map entries, Alert Definition section

This section uses a set of keys to define which information is presented in the Flex
System Manager event. The following keys are pertinent to this section:

Table 45. Keys pertinent to the Alert Definition map entry section

Key Value Description

event.index.family SNMP Top-level qualifier: the family name
of event.

event.index.keyword.0 event.qualifier.sample1 This is the top level qualifier. This
value can be translated from the
language bundle specified by
event.bundle key.

event.index.keyword.1 event.qualifier.sample2 The next level qualifier. You can
create as many keywords. These
values form the event type hierarchy
within a family.

event.index.severity 0,1,2,3,4,5 0 - Fatal, 1 - Critical, 2 - Minor, 3 -
Warning (default), 4 –
Harmless/Informational, 5 -
Unknown

event.index.category 0 or 1 0 – resolution, 1 - alert (default)
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Table 45. Keys pertinent to the Alert Definition map entry section (continued)

Key Value Description

event.index.text text1 This value can be translated from
language bundle specified by
event.bundle key.

event.index.version version number Version number of this event
definition (defaults to 1)

The event.index.family and event.index.keyword keys are used to define the
event type hierarchical structure that the resulting Flex System Manager event will
belong to. This grouping can be used as part of an event action plan event filter.
The family for mapped SNMP traps is always set to SNMP, while the rest of the
keywords in the hierarchy can be set to whatever best describes the Flex System
Manager event.

Example:

The example in Mapping key syntax section uses the following entries for family
and keywords:
# - Alert Definition Section -
# Define the alert Family
event.18217.family=SNMP
# Define the alert Event Qualifiers
event.18217.keyword.0=Hardware
event.18217.keyword.1=Storage
event.18217.keyword.2=LSI

These keys will produce a Flex System Manager event with the Event Type
SNMP.Hardware.Storage.LSI. The first two keywords define the component
category, and the last keyword becomes the component type. These are the values
as shown in the Flex System Manager event interface:
Component Type: LSI
Component Category: SNMP\Hardware\Storage

Additionally, you can select the event type on the Event Type page of the Event
Filter wizard. To see it, choose these:

Types of events to include: Custom

Show: Event Type

The next two keys in the example, event.18217.severity=4 and
event.18217.category=1, set the event severity to “Informational” and the category
to “Alert”. There are event categories:

Alert A problem has just occurred.

Resolution
A problem has been resolved.

The Alert Definition Section ends with the key that describes what event text is
produced. The example has the following entry:
# Define the message to be displayed
event.18217.text=PD state changed on Adapter {0} Dev {1} Enc {2} Slot {3} from {4} to {5}

Note: In the map file, this key is on a continuous line.
All information after event.18217.text= is in the event text as it is entered, except
the bracketed numbers such as {0}. These numbers represent the inclusion of
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variable information specified in the SNMP Trap Filter Section of the map entry.
They can be assigned to any of the trap variables sent with the trap. This lets you
include trap variable data in the event text.

Mapping file syntax - Map entries, SNMP Trap Filter section

The SNMP Trap Filter Section of the map entry specifies how the SNMP trap is
filtered and parsed. The following keys are pertinent to this section:

Table 46. Keys pertinent to the SNMP trap filter map entry section

Key Value Description

event.index.oid 1.3.6.1.4.1.3582.4.1.8.0.8217 (see the
example map entry)

OID of incoming trap to be matched.
Use an asterisk (*) as a wildcard
character to support fallback rules.

event.index.eventvar.0 Event variable This value can be used as a variable
in event.index.text.

event.index.eventvar.1 Event variable Use this to add a second variable if
necessary. You can add as many
variables as are needed.

event.index.eventvar.index.0 Position based event variable. For
example, this value can be 1. (see the
example map entry)

Use this instead of
event.index.eventvar.n if you want
a specific varbind (by position) value
to be used as an event variable. The
first occurring word index is a
number and the second word index
is an actual word. In the example
map entry, the value of first varbind
will be used as event variable {0}.

event.index.eventvar.index.1 Position based event variable. For
example, this value can be 2.

Use this to add a second variable if
necessary. You can add as many
variables as are needed. In this case,
the value of second varbind will be
used as event variable {1}.

event.index.proceedwithnormaltrap true/false If true, a normal SNMP trap event is
also generated. Currently, this value
is ignored.

The first key included in this section is event.index.oid. It defines the OID of the
trap that the map should be applied to. The example OID key is for the specific
trap type 8217.
# OID of the trap to match
event.18217.oid=1.3.6.1.4.1.3582.4.1.8.0.8217

Notice that the OID is in numeric format and identifies a specific trap. To indicate
a range of trap OIDs, end a branch with an asterisk (*), as shown here:
event.12000.oid=1.3.6.1.6.3.1.1.5.*

After the specified OID is found, the trap identification can be filtered further by
matching the trap variable information against predefined values. This can be done
by using one of these keys: event.index.eventvarbind or
event.index.eventvarbind.index. The primary difference between these two keys
is how the variable data is found.

After the OID and variable filters in the map entry identify a compatible trap, Flex
System Manager retrieves the variable trap information to be included in the Flex
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System Manager event text. The SNMP trap variables can be parsed into the Flex
System Manager event text using the event.index.eventvar and
event.index.eventvar.index keys. In the example map entry, key entry for
event.index.event.var shows a request for the trap variable with OID
1.3.6.1.4.1.3582.4.1.6.1001 and assigns it to the Event Text variable {0}.
event.18217.eventvar.0=1.3.6.1.4.1.3582.4.1.6.1001

The event text variable {0} is replaced with the value of the trap variable’s OID in
the event.index.text key.
event.18217.text=PD state changed on Adapter {0} Dev {1} Enc {2} Slot {3} from {4} to {5}

The complete set of variables in the example is mapped as follows.
# Trap variable to parse for the alert message
event.18217.eventvar.0=1.3.6.1.4.1.3582.4.1.6.1001
event.18217.eventvar.1=1.3.6.1.4.1.3582.4.1.8.1201
event.18217.eventvar.2=1.3.6.1.4.1.3582.4.1.8.1202
event.18217.eventvar.3=1.3.6.1.4.1.3582.4.1.8.1203
event.18217.eventvar.4=1.3.6.1.4.1.3582.4.1.8.1205
event.18217.eventvar.5=1.3.6.1.4.1.3582.4.1.8.1204

Another commonly used key is event.index.proceedwithnormaltrap. For an SNMP
trap that is mapped, this key lets you decide whether Flex System Manager should
report the original SNMP trap. By default, Flex System Manager processes both the
SNMP trap and the mapped Flex System Manager event. This causes double event
log entries and possibly multiple event action plan triggers. Setting the
event.index.proceedwithnormaltrap key to false specifies that only the mapped
event is processed.

Example:
event.18217.proceedwithnormaltrap=false

MIB trap used in the example map entry
Reference of trap from MIB used for this example.
pdtStateChange TRAP-TYPE
ENTERPRISE pdTraps
VARIABLES

{atAdpNumber,pdID,pdEncIndex,pdSlotNo, pdOldState, pdNewState}
DESCRIPTION "PD state changed on Adapter -$1 Dev -$2 Enc -$3 Slot -$4 from $5 to 6"

--#TYPE "LSI SAS Trap: PD state changed"
--#SUMMARY "PD state changed on Adapter -%d Dev -%d Enc -%d Slot -%d from %d to %d"
--#ARGUMENTS {0,1,2,3,4,5}
--#SEVERITY INFORMATIONAL
--#GENERIC 6
--#CATEGORY "Error Events"
--#STATE OPERATIONAL
::= 8217

Viewing the automation manager summary
You can view a summary of activity within the past 30 days that is associated with
automation, including event automation plans, scheduled and run jobs, event
management and Event Log, a list of systems with the most critical and warning
events, and a list of the most frequent received critical and warning events. Note
that information on this page is refreshed automatically when there are any
changes.

About this task

Note:
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This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To view the automation summary, complete the following steps:

Procedure
1. In the IBM Flex System Manager navigation area, click Home.
2. On the Home page, click the Plug-ins tab.
3. On the Plug-ins page, scroll to the Automation portion of the page and click

the Automation Manager section heading. The Automation manager summary
for the past 30 days is displayed.

4. View the Scheduled Jobs section. This section provides the following
information:
v The number of active scheduled jobs.
v The number of job activations that have completed successfully.
v The number of job activations that have failed.
v Up to three upcoming jobs that will run next. If more than one job will run

at the same time, all affected jobs are displayed.
v Up to three of the most recently run jobs. If more than one job ran at the

same time, all affected jobs are displayed.
v In the Job management area, a link to the Active and scheduled jobs page.

Using the Active and scheduled jobs page, you can create or edit jobs, view
job information, view job instance information, suspend and resume jobs,
and more.

5. View the Systems with the Most Frequent Critical or Warning Events section.
This section provides the following information:
v The five systems that have generated the most events with the following

event severities: fatal, critical, or warning. If there are more than five systems
that have generated the same number events, an ellipse (...) displayed
indicate that there are more systems.

v In the Event management area, a link to the Event log task page. On this
page you can view events that IBM Flex System Manager has received along
with event information that can help you troubleshoot problems in your
systems-management environment.

6. View the Most Frequent Critical or Warning Events section. This section lists
the five event types that have been generated the most with the event severity
of fatal, critical, or warning. If there are more than five event types that have
been generated in the same number of severities, an ellipse (...) displayed
indicate that there are more event types.

7. View the Event Automation Plans section. This section provides the following
information:
v The number of active event automation plans.
v The number of inactive event automation plans.
v In the Plan management area, the following links are provided:

Event automation plans
Use the Event Automation Plans page to create and work with event
automation plans.
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Event actions
Use the Event Actions page to create and work with event actions
that specify the action to automate when an event automation plan is
triggered.

Event filters
Use the Event Filters page to create and work with event filters that
determine which events trigger an event automation plan.

Results

You also can reach the summary page by using Find a Task. For more information,
see “Finding a task.”

Managing event automation plans
Use event automation plans to automate tasks in your system-management
environment. These plans are composed of event filters and event actions. The
plans are triggered by events. You can create, copy, edit, deactivate, activate, and
delete event automation plans. Also, you can view the Automation summary page.

About this task
Related concepts:
 

eLearning: Creating basic event automation plans
 

eLearning: Creating advanced event automation plans

Copying an event automation plan
Copy an event automation plan when you want to create a plan that is similar to a
preexisting plan.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To copy an event automation plan, complete the following steps:

Procedure
1. On the Plug-ins tab of the Home page, click Event Automation Plans under

Automation Manager.
2. On the Event Automation Plans page, select the event automation plan that you

want to copy.
3. Click Create Like.
4. On the Name and description page, type a new descriptive name for the event

automation plan that you are creating. Optionally, you also can type a
description of the plan. Click Next.
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5. In the event automation plan wizard, navigate to the pages that you want to
edit and make your changes.

6. On the Summary page, verify the details of the event automation plan. If you
need to make changes, click < Back Make sure to specify whether you want to
apply the event automation plan as soon as you finish creating it.

7. When you are done editing the event automation plan, click Finish.

Results

The event automation plan is saved and is displayed on the Event Automation
Plans page.

Creating an event automation plan
Create an event automation plan to automatically respond to a situation in your
IBM Flex System Manager environment. By creating event automation plans and
applying them to specific systems, you can be notified by e-mail or pager, for
example, when a specified threshold is reached or a specified event occurs. Or, you
can configure an event automation plan to start a program on a system in response
to the event.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

Use this method to create an event automation plan by configuring all the possible
settings. For example, select one or more systems to apply the plan to, specify one
or more event types from the full range of available events, select or create the
associated thresholds, and so on.

Alternatively, you can follow these instructions: “Create an event automation plan
based on an existing threshold”.

Procedure
1. On the Plug-ins tab of the Home page, click Event Automation Plans under

Automation Manager.
2. On the Event Automation Plans page, click Create. The Event Automation Plan

wizard is displayed.
3. Complete the wizard, then click Finish.
Related tasks:
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“Creating an event automation plan based on an existing threshold” on page 341
Use this method to create an event automation plan that uses the target system
and the event types that are specified by an existing active threshold. When
creating an event automation plan based on an existing threshold, you need to
specify only a few settings: the threshold levels that you want to monitor, the
event actions that you want the plan to include, and the time range that
determines when the plan is active.

Selecting the events that trigger an event action
The event automation plan uses event filters to monitor for the occurrence of one
or more specified events. When these events occur, your event automation plan
responds with one or more customized event actions.

About this task

The types of events that you can select and the ways that you can filter events are
broadly divided between the following categories:
v Common event filters
v Advanced event filters

Common event filters are predefined simple filters that monitor for events of
common interest in systems management. For example, the Disks event filter is
triggered by any hard disk events and the Fans event filter is triggered by any fan
events. The Event Automation Plan wizard provides several common event filters
so you can create typically required event automation plans quickly and easily. For
more information about event filters, see “Event filters.”

If you want to monitor specific events that are not included in the common event
filters, then you must select advanced event filters. You also can create more
sophisticated event filters that are triggered when duplicates of an event are
received, when events occur a specific number times over a range of time, or when
a specific event is received but you want to exclude another event. For more
information about event filters, see “Event filters.”
Related concepts:
“Event filters” on page 310
A filter specifies one or more events that you want your event automation plan to
process. The event automation plan ignores any event instances that do not meet
the specifications of the filter. Typically, you will use the common event filters that
are provided in the Event Automation Plan wizard. Occasionally there are
situations where you will want to create a sophisticated event filter. The event
filters described in this section are available for such implementations. Using these
filters, you can specify details for an event such that it covers very specific
problems and occurrences. To create filters quickly, default values are provided;
however, you can customize the settings.
“Simple event filter” on page 311
Simple event filters are general-purpose filters; most event automation plans use a
simple event filter. 
“Duplication event filter” on page 312
In addition to the options that are available in the simple filters, duplication event
filters ignore duplicate events.
“Exclusion event filter” on page 313
In addition to the simple filter options, exclusion event filters exclude certain event
types. Using this filter, you define the criteria of the events to exclude. You can use
this filter to activate a group of events and then exclude some of the events in that
group. You can use this filter to exclude multiple event types.
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“Recurring event filter” on page 314
In addition to the simple filter options, a recurring event filter processes an event
after it has occurred a specified number of times within a specified interval.

Creating an event automation plan based on an existing
threshold
Use this method to create an event automation plan that uses the target system
and the event types that are specified by an existing active threshold. When
creating an event automation plan based on an existing threshold, you need to
specify only a few settings: the threshold levels that you want to monitor, the
event actions that you want the plan to include, and the time range that
determines when the plan is active.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

Procedure
1. From the Monitor View page or the Thresholds page in the IBM Flex System

Manager Web interface, select a monitor with an active threshold.
2. Click Create Event Automation plan. The Event Automation Plan wizard is

displayed.
3. Complete the wizard, then click Finish.
Related tasks:
“Creating an event automation plan” on page 339
Create an event automation plan to automatically respond to a situation in your
IBM Flex System Manager environment. By creating event automation plans and
applying them to specific systems, you can be notified by e-mail or pager, for
example, when a specified threshold is reached or a specified event occurs. Or, you
can configure an event automation plan to start a program on a system in response
to the event.

Deactivating and activating an event automation plan
You can deactivate an event automation plan such that the specified events do not
trigger the plan. When you want the event automation plan available for events to
trigger again, you can subsequently activate the event automation plan. By default,
event automation plans are activated.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:
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Deactivating an event automation plan can be useful if you want to temporarily
turn off an event automation plan. For example, if you have an event automation
plan that notifies you of printer problems by sending a message to your mobile
phone, you can turn off the event automation plan while you are gone on vacation,
but turn it back on when you return.

To deactivate and then activate an event automation plan, complete the following
steps:

Procedure
1. On the Plug-ins tab of the Home page, click Event Automation Plans under

Automation Manager.
2. On the Event Automation Plans page, select the event automation plan that you

want to deactivate.

Note: You can deactivate more than one event automation plan at a time.
3. Click Actions > Deactivate. The event automation plan is deactivated. On the

Event Automation Plans page in the Status column, the state is changed from
Active to Inactive. A message is displayed on the page stating that the event
automation plan was deactivated successfully.

4. When you want to activate the event automation plan, select the plan and click
Actions > Activate. The event automation plan is activated. On the Event
Automation Plans page in the Status column, the state is changed from Inactive
to Active. A message is displayed on the page stating that the event automation
plan was activated successfully.

Deleting an event automation plan
You can delete an event automation plan when it is no longer useful.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To delete an event automation plan, complete the following steps:

Procedure
1. On the Plug-ins tab of the Home page, click Event Automation Plans under

Automation Manager.
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2. On the Event Automation Plans page, select the event automation plan that you
want to delete.

Note: You can delete more than one event automation plan at a time.
3. Click Delete.
4. In the confirmation window, click Delete.

Results

The event automation plan is deleted and is no longer displayed on the Event
Automation Plans page. A message is displayed on the page stating that the event
automation plan was deleted successfully.

Editing an event automation plan
Edit an event automation plan to change settings in a preexisting event automation
plan.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To edit an event automation plan, complete the following steps:

Procedure
1. On the Plug-ins tab of the Home page, click Event Automation Plans under

Automation Manager.
2. On the Event Automation Plans page, select the event automation plan that you

want to edit.
3. Click Edit.
4. In the event automation plan wizard, navigate to the pages that you want to

edit and make your changes.
5. On the Summary page, verify the details of the event automation plan. If you

need to make changes, click < Back Make sure to specify whether you want to
apply the event automation plan as soon as you finish creating it.

6. When you are done editing the event automation plan, click Finish.

Results

The event automation plan is saved and is displayed on the Event Automation
Plans page.
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Suspending and resuming event automation plans
You can suspend all event automation plans for a system (except for the Log All
Events plan) so that the specified events do not trigger the plans. When you want
the event automation plans available for events to trigger again, you can resume
all the event automation plans.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

Suspending all event automation plans can be useful when you want to
temporarily turn off all event actions associated with the event automation plans.
For example, if you have automation plans that notify you when a server
encounters various problems, you can suspend all event automation plans while
you work on the server. After you resolve the problem, you can resume all event
automation plans for the server.

To suspend and then resume event automation plans, complete the following steps:

Procedure
1. On the Initial Setup tab of the Home page, click Chassis Manager. On the

Chassis Manager page, click Resource Explorer under General Actions.
2. Navigate to the group that contains the resource for which you want to

suspend all the event automation plans.
3. Right-click the resource, then select Automation > Suspend Event Actions.

After you suspend event actions, no event triggers any event automation plan
for the selected resource, except the Log All Events plan. In the Suspended
Action Plans column for the specified resource, the state changes from False to
True.

Note: For more information about adding the Suspended Action Plans column
to the table, see “Setting table-column preferences”.

4. When you want to resume having event actions on the resource trigger event
automation plans, right-click the resource, then select Automation > Resume
Event Actions. After you resume event actions, event actions for the resource
again trigger event automation plans. In the Suspended Action Plans column,
the state changes from True to False.

Viewing event automation plans associated with a resource
You can view the properties for a resource to determine whether that resource is
associated with any event automation plans.
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About this task

To determine whether a resource is associated with any event automation plans,
complete the following steps:

Procedure
1. Navigate to the resource and select it.
2. Click Actions > Properties.
3. On the Properties page, click the Applied Activities tab.

Results

On the Applied Activities page, you can view a list of any event automation plans
that can potentially affect the resource.

Viewing event automation plan properties
You can view the properties for an event automation plan for information about
the plan settings. This information is the same summary that you see when you
complete creating an event automation plan.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To view event automation plan properties, complete the following steps:

Procedure
1. On the Plug-ins tab of the Home page, click Event Automation Plans under

Automation Manager.
2. On the Event Automation Plans page, select the event automation plan whose

properties you want to view.
3. Click Actions > Properties.
4. On the Properties page, view the settings for the event automation plan.

Results

Note: The Actions button does not provide any event-filter specific actions
because there are none available on the Properties page.
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Managing event actions
Event actions specify the action that IBM Flex System Manager takes in response to
a specific event or events. You can create, copy, edit, test, and delete event actions
as well as view their properties. Also, you can record and view the history of an
event action.

Creating an event action
Create an event action to use in your event automation plans. You can create event
actions and test actions before using them in your event automation plans.
Typically, you create event actions in the Event Automation Plan wizard. However,
there might be times when you want to create an event action that you can use in
event automation plans at another time.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To create an event action, complete the following steps:

Procedure
1. On the Plug-ins tab of the Home page, click Automation Manager. On the

Automation Manager summary page, click Event Actions under Plan
management.

2. On the Event Actions page, click Create.
3. In the Create Actions window, select an event action. For information about

event action types, see “Event actions.”
4. Click OK.
5. Type a name for the event action in the Action name field. Use a naming

convention that ensures the entries are grouped conveniently on the Event
Actions page. For example, if you want names to begin with the associated
action, an event action that sends a message to a pager or phone might start
with Pager or Phone.

6. Complete the remaining fields for the event action that you selected. For some
event action types, you can include event-specific information as part of the
text message. Including event information is referred to as event-data
substitution. You can use event-data-substitution variables to customize event
actions. For more information, see “Event-data-substitution variables.”

7. If the event action that you selected includes the Test button, you can
determine whether your settings are correct by clicking Test.

8. Click OK to save the event action. The new event action is displayed in the
Event action page.
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Note: You can create and select more than one type of event action for your
event automation plan.

Results

The event action is saved and is displayed on the Event Actions page.
Related concepts:
“Event actions” on page 315
Event actions specify the action that IBM Flex System Manager takes in response to
a specific event or events. Using the Event Automation Plan wizard, you can easily
create an event automation plan that will send you an e-mail or pager notification
in response to an event. Additionally, the Event Automation Plan wizard provides
other advanced event actions that you can use in response to an event.

Editing an event action
Edit an event action to change settings in a preexisting event action.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To edit an event action, complete the following steps:

Procedure
1. On the Plug-ins tab of the Home page, click Automation Manager. On the

Automation Manager summary page, click Event Actions under Plan
management.

2. On the Event Actions page, select the event action that you want to edit.
3. Click Edit.
4. Edit the settings that you want to change for the event action.
5. If the event action that you selected includes the Test button, you can

determine whether your settings are correct by clicking Test.
6. Click OK to save the event action. The new event action is displayed in the

Event action page.

Note: You can create and select more than one type of event action for your
event automation plan.

Results

The event action is saved and is displayed on the Event Actions page.
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Copying an event action
Copy an event action when you want to create an event action that is like a
preexisting event action.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To copy an event action, complete the following steps:

Procedure
1. On the Plug-ins tab of the Home page, click Automation Manager. On the

Automation Manager summary page, click Event Actions under Plan
management.

2. On the Event Actions page, select the event action that you want to copy.
3. Click Create Like.
4. Edit the settings that you want to change for the event action.
5. If the event action that you selected includes the Test button, you can

determine whether your settings are correct by clicking Test.
6. Click OK to save the event action. The new event action is displayed in the

Event action page.

Note: You can create and select more than one type of event action for your
event automation plan.

Results

The event action is saved and is displayed on the Event Actions page.

Testing an event action
You can test an event action to make sure that the settings perform as expected. It
is a best practice to test an event action before using it in an event automation plan
so you can avoid unexpected results.

Before you begin

The following event actions cannot be tested because critical information is not
available until a system generates the event and triggers an event automation plan:
v Start a program on the system that generated the event
v Start a task on the system that generated the event
v Update the status of the system that generated the event
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To make sure that an event action can be tested, select the event action and click
Actions > Properties. The Properties page for the event action states whether the
event action can be tested.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To test an event action, complete the following steps:

Procedure
1. On the Plug-ins tab of the Home page, click Automation Manager. On the

Automation Manager summary page, click Event Actions under Plan
management.

2. On the Event Actions page, select the event action that you want to test.
3. Click Actions > Test.
4. In the confirmation window, click Test. A message is displayed on the page

stating whether the event action was started successfully. If the selected event
action cannot be tested, a message also is displayed.

5. To view details about the test, select the event action and click Actions >
Properties. An example of the kind of detail you might want to view is
whether the action completed successfully.

6. On the Properties page, click the History tab to view details about the test.
Related concepts:
“Send an e-mail to a mobile phone” on page 318
Sends an e-mail message to a mobile phone. The e-mail message is shortened to
accommodate the limited display screen of a mobile phone. Using this action, you
can send less text than when using Send an e-mail (Internet SMTP) .
“Send an Internet (SMTP) e-mail” on page 318
Sends a Simple Mail Transfer Protocol (SMTP) e-mail message. You also can send a
message to an e-mail enabled phone. Using this action, you can send more text
than when using Send an e-mail to a mobile phone.
“Start a program on a system” on page 326
Starts a program on a specified system. Programs can include command-line
commands that can start or stop programs on the system.
“Start a task on a specified system” on page 328
Starts a noninteractive IBM Flex System Manager task on a specified system.
Noninteractive tasks are tasks that do not require user input.

Deleting an event action
You can delete an event action when it is no longer useful.
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About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To delete an event action, complete the following steps:

Procedure
1. On the Plug-ins tab of the Home page, click Automation Manager. On the

Automation Manager summary page, click Event Actions under Plan
management.

2. On the Event Actions page, one or more event actions that you want to delete.
3. Click Delete.
4. In the confirmation window, click Delete.

Results

The event action is deleted and is no longer displayed on the Event Actions page.
A message is displayed on the page stating that the event action was deleted
successfully.

Saving and not saving an event-action history
You can save useful information about an event action by saving the event-action
history. When you no longer want to save the event-action history, you can stop
saving it. By default, the event-action history is not saved. To view an event-action
history, see “Viewing an event-action history.”

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

Saving the history of an event action can provide useful information. For example,
an event automation plan can include an event action that reduces disk-space used
by running a program to remove temporary files. When you start saving the
history for this event-action, the following information is recorded:
v The date and time when the event action ran and, later, when the cleanup

program ran
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v Whether the program ran successfully
v The event that triggered the event filter.

To start and then stop saving the history of an event action, complete the following
steps:

Procedure
1. On the Plug-ins tab of the Home page, click Automation Manager. On the

Automation Manager summary page, click Event Actions under Plan
management.

2. On the Event Actions page, select the event action with the history that you
want to start saving.

Note: You can start saving the history for more than one event action at a time.
3. Click Actions > Start Saving History. The history of the event action is now set

to be saved. On the Event Actions page in the History column, the value is
changed from Not saved to Saved. A message is displayed on the page stating
that saving of the event-action history was started successfully.

4. When you want to stop saving the history for an event action, select the event
action and click Actions > Stop Saving History. The history of the event action
is set to no longer be saved. On the Event Actions page in the History column,
the value is changed from Saved to Not saved. A message is displayed on the
page stating that saving the event-action history was stopped successfully.

Viewing an event-action history
You can view an event-action history for information about how an event action
ran in your systems-management environment.

Before you begin

Before you can view the history for an event action, you have to start saving the
history for that event action. For information, see “Saving and not saving an
event-action history.”

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

Saving the history of an event action can provide useful information. For example,
an event automation plan can include an event action that reduces disk-space used
by running a program to remove temporary files. When you start saving the
history for this event-action, the following information is recorded:
v The date and time when the event action ran and, later, when the cleanup

program ran
v Whether the program ran successfully
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v The event that triggered the event filter.

To view the history for an event action, complete the following steps:

Procedure
1. On the Plug-ins tab of the Home page, click Automation Manager. On the

Automation Manager summary page, click Event Actions under Plan
management.

2. On the Event Actions page, select the event action for which you want to view
the history.

3. Click Actions > Properties.
4. On the Properties page, click the History tab to view the event-action history.

Each log entry in the history provides the following information about each
time the event action was used:

Date The date and time on which the event was generated.

Launch Status
Event action launch status, which indicates whether the action was
launched successfully. Possible values are successful and failed.

Completion Date
The date and time when the event action completed.

Completion Status
Event action completion status indicates whether the action ran
successfully. Possible values are Successful, Failed, and Not Performed.

Note: The Successful status indicates that the automation attempted
to run the specified program on the endpoint but does not reflect
whether the program exits or completed with a good return code.

The Not Performed status indicates the following three event actions.
a. Modify an event and send it.
b. Start a program on a system,
c. Start a task on a specified system.

If you do not make any modifications to make to an incoming event,
the event is not sent again and the event action status is considered Not
Performed. For the latter two events, if the specified system cannot be
found when the event action is invoked, then the action cannot be
performed.

Managed Resource
Target system on which the event occurred.

Event Type
The type of event that was generated. The event types are categorized
by hardware, device, or software.

Category
The mode of the event. Possible categories are:

Alert A problem occurred.

Resolution
A problem was resolved and is no longer a problem.
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Event Severity
The severity level of the event, which identifies potentially urgent
problems requiring immediate attention. Possible severity levels are:

Fatal The source of the event has already caused the program to fail
and needs to be resolved before the program is restarted.

Critical
The source of the event might cause program failure and needs
to be resolved immediately.

Minor The source of the event is not likely to cause immediate
program failure, but needs to be resolved.

Warning
The source of the event is not necessarily problematic, but
might warrant investigation.

Informational
The event was generated for information only. Most events of
this severity do not indicate potential problems. However,
offline events are categorized as informational, and these events
can indicate potential problems.

Unknown
The application that generated the event did not assign a
severity level.

Sender
The system that sent the event to IBM Flex System Manager. For
example, SNMP events list the IP address of the trap source. Because
most events are generated by IBM Flex System Manager, this field
typically contains the name of the management node.

Refreshing entries in an event-action history log
You can refresh an event-action history log so that you can view the latest
available entries.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To refresh an event-action history log, complete the following steps:

Procedure
1. On the Plug-ins tab of the Home page, click Automation Manager. On the

Automation Manager summary page, click Event Actions under Plan
management.
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2. On the Event Actions page, select the event action for which you want to view
the history.

3. Click Actions > Properties.
4. On the Properties page, click the History tab to view the event-action history.
5. On the History page, click Refresh. The list of available log entries is refreshed.

Deleting entries from an event-action history log
You can delete log entries from an event-action history when the entries are no
longer useful.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To delete a log entry, complete the following steps:

Procedure
1. On the Plug-ins tab of the Home page, click Automation Manager. On the

Automation Manager summary page, click Event Actions under Plan
management.

2. On the Event Actions page, select the event action whose history-log entries
you want to delete.

3. Click Actions > Properties.
4. On the Properties page, click the History tab to view the event-action history.
5. Select one or more log entries that you want to delete.
6. Click Delete.
7. In the confirmation window, click Delete.

Results

The log entry is deleted and is no longer displayed on the History page. A
message is displayed on the page stating that the log entry was deleted
successfully.

Viewing event action properties
You can view the properties for an event action for information about the action
settings. Also, the Properties page lists the event automation plans that include the
event action.

About this task

Note:
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This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To view event-action properties, complete the following steps:

Procedure
1. On the Plug-ins tab of the Home page, click Automation Manager. On the

Automation Manager summary page, click Event Actions under Plan
management.

2. On the Event Actions page, select the event action whose properties you want
to view.

3. Click Actions > Properties.
4. On the Properties page, view the settings for the event action. The settings vary

depending on the type of the event action.

Results

Note: The Actions button does not provide any event-action specific actions
because there are none available on the Properties page.

Event-data-substitution variables
For some types of actions, you can include event-specific information as part of the
message text. Including event information is referred to as event-data substitution.
You can use event-data-substitution variables to customize the message text sent
by an action.

The following examples show how you can use event-data-substitution variables in
the message text associated with a customized event action:
v &severity - &text on &system
v Event &text received from &system at &time on &date

Tip: When you use event-data-substitution variables, do not use punctuation after
the variable, for example:
Event received from &system.

&system cannot be interpreted correctly because of the period.

You can use the following event-data-substitution variables.

Note: Any of the substitution variables can have a null value. In that case, the
localized version of the string “Not Applicable” is returned.

&date The localized date on which the event occurred.

Example: 7/23/2007
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&ipaddr
The IP address of the system on which the event was generated. This is
either the IP address of the system running Common Agent or, for an
SNMP device, the TCP/IP address.

Example: 9.45.2.69

&iphost
The IP host name of the system on which the event was generated. This is
either the name of the system running Common Agent or, for an SNMP
device, the TCP/IP host name.

Example: moonlite.mycompany.com

&time The localized time at which the event occurred.

Example: 2:32 PM CDT

&text The event details, if they are supplied by the event.

Example: System moonlite is offline with errors.

&type The event-type criteria that were used to trigger the event. For example,
the event that is generated when a system goes offline is of type Topology
> Offline. This type corresponds to the entry on the Event Type page.

Example: ComputerSystem or Processor

&severity
The severity level of the event.

Example: Informational

&system
The system name of the system on which the event was generated. This is
either the name of the system running Common Agent or, for an SNMP
device, the TCP/IP address.

Example: moonlite

&sender
The name of the system that sent the event. This can be different from the
&system value if the event was forwarded or transmitted through an
intermediate system. This variable returns a null value if the name is
unavailable.

Example: moonlite

&group
The group to which the target system belongs and that is monitoring the
system. This variable returns a null value if the group is unavailable.

Example: TestHardwareGroup

&category
The category of the event, either Alert or Resolution. For example, if the
system goes offline, the category is Alert. If the system goes online, the
category is Resolution.

Example: Alert
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&pgmtype
The fully qualified representation of the event type using internal type
strings (ComponentCategory.ComponentType).

Examples: Managed Resource > Managed System Resource > Logical
Resource > Logical Device > Processor

&timestamp
The long value timestamp of the time that the event occurred, in
milliseconds, since 1/1/1970 12:00 AM GMT.

Example: 1185219178228

&rawsev
The nonlocalized string of event severity. Non-localized string of the event
severity.

Example: Any of the following strings: “FATAL”, “CRITICAL”, “MINOR”,
“WARNING”, “INFORMATIONAL”, “UNKNOWN”.

&rawcat
The nonlocalized string of event category.

Example: Any of the following strings: “ALERT”, “RESOLUTION”.

&corr An internally generated correlation identifier for this event. This identifier
allows an alert event to be correlated with a resolution event, thereby
indicating that the problem that caused the alert has been corrected. The
length of this string can vary.

Example: 1883481972341237

&snduid
The unique ID of the event sender.

Example: 7F153619BA2D7861

&sysuid
The unique ID of the system that is associated with the event.

Example: 4309132478791324

&prop:file_name#property_name
The value of the property string property_name from property file file_name.
file_name can include the absolute directory path or the relative path to the
IBM\Director\classes directory.

Note: For IBM i, you must use the absolute directory path.

The properties file contains key=value pairs. property_name is the name of a
key in the properties file. The value of the specified property is returned.
The value can be any string, depending on the purpose and contents of the
properties file.

Examples:

&prop:logging.properties#SystemErr.level = INFO
&prop:encoding.properties#zh = UTF-8
&prop:security.properties#enableAuthentication = TRUE
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&sysvar:variable_name
The string value of a variable, variable_name, previously set in the IBM Flex
System Manager sysvar file. Variables can be set in this file using the Set
an event system variable event action. The variable name and value can
be any string. This variable returns null if a value is unavailable. For
information about the event action, see “Set an event system variable.”

Examples:

&sysvar:DEBUG_SETTING = DEBUG_ON
&sysvar:IP = 9.3.44.150

&slotid:slot_id
The nonlocalized ID slot_id is the identifier of event details contained
within the event. An event might include any number of event details. This
substitution variable is used to retrieve those details. The user must know
the identifier of the event detail that they want. The value can be any
string as defined by the component that generates the event.

Example: &slotid:Suppressions = “3 instances of this condition have been
suppressed.”

&otherstring
If any other word is preceded by an &, it is treated the same as the slot_id
in the previous &slotid:slot_id variable. The otherstring string is used as an
identifier to locate event details contained with the event.

The value of the detail slot that has a localized label that matches
otherstring. A detail slot is a record in an event detail. For example, an event
might have one event detail that has an ID of key1 and a value of value1.
You could use the substitution variable &slotid:key1 to obtain the value
value1. You also can use &key1 to obtain the value value1. In the
description above, otherstring is a placeholder for the user-defined event
detail ID. However, if the passed ID is not found, the value Not
applicable is returned.

Example: &Suppressions = “3 instances of this condition have been
suppressed.”

Tip:

When you use event-data-substitution variables, the symbol in the variable might
change according to the operating system. The characters such as single quotation
mark (‘), double quotation mark (“), or ampersand (&), or other characters can
contain special semantic meaning in the running interpreter (Power Shell in
Windows, or Bash in Linux). After the substitution, the original command line can
show different results. Evaluate the possible results after substitution, and create
correct escape sequences for the special symbols.

In the following example, a batch script file uses the first parameter as contents in
a log file and the second parameter as the target log file. The command line is set
according to the following configuration:
<script_name> "&text" "<path_to_log_file>"

One of the &text variables is shown in the following line:
System "Server 1" is started
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Then run the following command:
<script_name> "System "Server 1" is started." "< path_to_log_file >"

This scenario causes the first parameter to be System and the second parameter to
be Server. Therefore, the contents remain incomplete and the target log file can be
a file that does not exist in the system.
Related concepts:
“Log to a log file” on page 315
Logs information about the triggering event to a specified text file.
“Modify an event and send it” on page 316
Resends the event that originally triggered the event automation plan. Before
resending the event, the action modifies the event data, such as its text and
severity, to your specification.
“Post to a newsgroup (NNTP)” on page 317
Posts a message to a newsgroup used by your organization. The newsgroup must
use Network News Transfer Protocol (NNTP) to send and receive information.
“Send an e-mail to a mobile phone” on page 318
Sends an e-mail message to a mobile phone. The e-mail message is shortened to
accommodate the limited display screen of a mobile phone. Using this action, you
can send less text than when using Send an e-mail (Internet SMTP) .
“Send an Internet (SMTP) e-mail” on page 318
Sends a Simple Mail Transfer Protocol (SMTP) e-mail message. You also can send a
message to an e-mail enabled phone. Using this action, you can send more text
than when using Send an e-mail to a mobile phone.
“Set an event system variable” on page 325
Sets a user-defined system variable to a new value or resets the value of an
existing system variable. IBM Flex System Manager provides user-defined system
variables to help you test and track the status of network resources according to
the needs of your organization. System variable names and values can be
referenced wherever event data substitution is allowed. 
“Static group: add or remove group members” on page 329
Adds a defined set of systems to a specified static group or removes a defined set
of systems from the specified static group. Use this event action to initialize a set
of systems to process. Then the processing is triggered by an event that you
specify in your event filter.
“Static group: add or remove the event-generating system” on page 329
Adds the system that generated the event to a specified static group or removes
the system that generated the event from a specified static group, as applicable.
“Timed alarm that generates an event” on page 330
Generates a defined alarm event only if IBM Flex System Manager does not receive
a specified event within a specified time range. This event action is useful for
monitoring for a loss of function, much like a heartbeat monitor.

Managing event filters
A filter specifies one or more events that you want your event automation plan to
process. The event automation plan ignores any event instances that do not meet
the specifications of the filter. You can create, copy, edit and delete event filters.

Creating, editing, or copying an event filter
Create an event filter to use in your event automation plan. Typically, you create
event filters in the Event Automation Plan wizard. You can use the Event Filter
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wizard to create an event filter that you intend to use in an event automation plan
at another time. Also, you can edit an existing event filter or create one by copying
and modifying an existing filter.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

You create event filters so that you can use them in your automation plans. As you
create or edit event filters, you specify the types of events and event characteristics
that you want to include in the filter. The filter is triggered when those included
events are encountered during the processing of an automation plan.

To create an event filter, edit an existing filter, or create a filter that is based on an
existing filter, complete the following steps:

Note: The Event Filter wizard determines which panels to display based on your
choices. Different panels display depending on the type of events and event
characteristics that you choose to include.

Procedure
1. On the Plug-ins tab of the Home page, click Automation Manager. On the

Automation Manager summary page, click Event Filters under Plan
management.

2. Perform only one of the following actions.
v If you want to create an event filter, click Create.
v If you want to edit an existing event filter, select the filter you want to edit,

then click Edit.
v If you want to create an event filter that is like an existing filter, select the

existing filter, then click Create Like.
3. On the Welcome page, click Next.
4. On the Filter Name page, type a name and description for the event filter,

then click Next. Although it is not required, a description does help you sort
and manage your event filters.

5. On the Filter Type page, select the type of filter that you want to create, then
click Next. For more information about the different filter types, see “Event
Filters”.

6. On the Event Type page, complete one of the following actions to select the
type of event that you want to include, then click Next.
v Select Default to include events of all types, except for Windows-specific

events. Optionally, you can include IBM i message queue events.
v Select Common to include the most common systems-management event

types, except for Windows-specific events. Optionally, you can include IBM
i message queue events. Click the name of an event type to see a
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description and any additional settings. If an entry has additional settings,
make sure to select the event type and each setting that you want to
include.

v Select Custom to specify event types by category, type, and value.
Optionally, you can include IBM i message queue events. The Available
table is a hierarchical list of event types. Click an entry in the table or the
breadcrumbs above the table to navigate within the hierarchy. Select an
entry to include that entry and any entries in subsequent levels of the
hierarchy. (The table also lists available Windows-specific events.)

7. If the IBM i Event type page appears, specify IBM i messages that you want
to include. Otherwise, go to the next step.
a. Type each message that you want to include.

Note: Use the following format: library/message_queue.messageID, where,
for each specified event
v library is the library
v message_queue is the message queue
v messageID (optional) is the ID

The IBM i.Message Queue field automatically provides the common
message queue event prefix, which is OS/400.msgq. You type only the
unique portion of the message queue event. Consider the following
examples that assume the library is QSYS and the message queue is
QSYSOPR:
v To specify all message IDs, type QSYS/QSYSOPR.
v To specify a message ID of CPF1234, type QSYS/QSYSOPR.CPF1234.
v To specify any message ID that starts with the characters CPF:

– If the managed resource has 5770UME V1R3 and all the available
UME PTFs installed, type QSYS/QSYSOPR.CPF.

– Otherwise, type QSYS/QSYSOPR. Then, on the Event Text page of Event
Filter wizard, specify that you want to look for the characters CPF.

b. Click Add to add the message to the list of Selected IBM i event types.
c. When you are finished adding messages, click Next.

8. If the Excluded Event Type page appears, specify the event types that you
want to exclude, then click Next. Otherwise, go to the next step. Excluded
events do not trigger the filter. You specify the event types to exclude in the
same way that you specified the event types to include in step 6 on page 360
Optionally, you can exclude IBM i message queue events. To exclude available
Windows-specific events, select Custom.

9. If the Excluded IBM i Event Type page appears, specify the IBM i messages
that you want to exclude. Otherwise, go to the next step. Excluded events do
not trigger the filter. You specify the messages to exclude in the same way that
you specified the messages to include in step 7

10. On the Severity and Category page, specify the severities and categories that
you want to include, then click Next. Select Default to include events of all
severities and categories. Select Custom to specify one or more severities and
categories.

11. On the Event Sender page, you can add any specific event senders that you
want to include in the filter. The filter is triggered when a specified sender
generates an event that you included in the filter. Choosing Default includes
events sent from any managed resource.
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a. Select a sender from the Systems list, then click Add to add it to the
Selected senders list.

b. To add a sender that does not appear in the Systems list, type the name of
the sender in the Additional sender field, then click Add.

c. When you are finished adding senders, click Next.

Important: Remember to update any specified sender name if you rename
the associated resource (the sender). When a managed resource is renamed,
IBM Flex System Manager does not automatically update the associated
sender name in an event filter. Renaming the resource without updating
the event filter results in a mismatch between the sender name that is
specified in the event filter and the sender name that is specified in the
incoming event. The mismatch in sender names causes any event action
plan that includes the filter to fail.

12. On the Event Text page, specify the event text that you want to include in the
filter, then click Next.
v Select Default to include all event text.
v Select Custom to specify a word, separate words, or a phrase that you want

to include in the filter. The filter is triggered by only those events that you
include in the filter that also contain the specified text.

13. If the Frequency page appears, specify how often an event occurs before
triggering this filter. Otherwise, go to the next step.
v Select Default to trigger the filter any time an included event occurs.
v Select Custom to specify how many times an event must occur before

triggering the filter, called the matching event count. Optionally, you can
specify a time interval within which the event must occur.

14. If the System Variables page appears, specify the system variables that you
want to include, then click Next. Otherwise, go to the next step. The filter is
triggered when an included event occurs that has a specified keyword and
value pair with a given value.
v Select Default if you want to include all events, regardless of whether they

have system variables.
v Select Custom so that the filter is triggered only when included events also

contain one of the selected keyword and value pairs that has a specified
value.

15. On the Time Range page, specify when you want events to trigger the filter,
then click Next.
v Select All so that the filter is triggered any time that included events occur.
v Select Custom to specify that the filter is triggered only when included

events occur on a particular day of the week or within an identified time
range.

16. On the Summary page review your settings. If you want to modify any
settings, click Back to make changes. When you are satisfied with the event
filter, click Finish to save it.

Results

The event filter is saved and is displayed on the Event Filters page.
Related concepts:
“Simple event filter” on page 311
Simple event filters are general-purpose filters; most event automation plans use a
simple event filter. 
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“Duplication event filter” on page 312
In addition to the options that are available in the simple filters, duplication event
filters ignore duplicate events.
“Exclusion event filter” on page 313
In addition to the simple filter options, exclusion event filters exclude certain event
types. Using this filter, you define the criteria of the events to exclude. You can use
this filter to activate a group of events and then exclude some of the events in that
group. You can use this filter to exclude multiple event types.
“Recurring event filter” on page 314
In addition to the simple filter options, a recurring event filter processes an event
after it has occurred a specified number of times within a specified interval.
Related tasks:
“Creating an event automation plan” on page 339
Create an event automation plan to automatically respond to a situation in your
IBM Flex System Manager environment. By creating event automation plans and
applying them to specific systems, you can be notified by e-mail or pager, for
example, when a specified threshold is reached or a specified event occurs. Or, you
can configure an event automation plan to start a program on a system in response
to the event.
“Viewing the automation manager summary” on page 336
You can view a summary of activity within the past 30 days that is associated with
automation, including event automation plans, scheduled and run jobs, event
management and Event Log, a list of systems with the most critical and warning
events, and a list of the most frequent received critical and warning events. Note
that information on this page is refreshed automatically when there are any
changes.
Related reference:
 

Events Reference

Editing an event filter
Edit an event filter to change the settings in an event filter that you previously
created.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To edit an event filter, complete the following steps:

Procedure
1. On the Plug-ins tab of the Home page, click Automation Manager. On the

Automation Manager summary page, click Event Filters under Plan
management.
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2. On the Event Filters page, select the event filter that you want to edit.

Note: IBM Flex System Manager includes some predefined event filters that
you cannot edit. You can create an event filter that is like a predefined filter by
using Create Like, but you cannot directly edit it.

3. Click Edit. The Edit Event Filter wizard is displayed.
4. Use the Edit Event Filter wizard to edit the event filter. The Edit Event Filter

wizard uses the same panels as the Create Event Filter wizard. For more
information about using an Event Filter wizard to create or edit an event filter,
see “Creating an event filter”. After you finish using the Edit Event Filter
wizard to save the event filter, it is displayed on the Advanced Event Filters
page.

Results

The edited event filter is saved and displayed on the Event Filters page.
Related concepts:
“Simple event filter” on page 311
Simple event filters are general-purpose filters; most event automation plans use a
simple event filter. 
“Duplication event filter” on page 312
In addition to the options that are available in the simple filters, duplication event
filters ignore duplicate events.
“Exclusion event filter” on page 313
In addition to the simple filter options, exclusion event filters exclude certain event
types. Using this filter, you define the criteria of the events to exclude. You can use
this filter to activate a group of events and then exclude some of the events in that
group. You can use this filter to exclude multiple event types.
“Recurring event filter” on page 314
In addition to the simple filter options, a recurring event filter processes an event
after it has occurred a specified number of times within a specified interval.
Related tasks:
“Viewing the automation manager summary” on page 336
You can view a summary of activity within the past 30 days that is associated with
automation, including event automation plans, scheduled and run jobs, event
management and Event Log, a list of systems with the most critical and warning
events, and a list of the most frequent received critical and warning events. Note
that information on this page is refreshed automatically when there are any
changes.

Copying an event filter
Copy an event filter when you want to create an event filter that is like a
preexisting event filter.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

364 Systems Management Guide



To copy an event filter, complete the following steps:

Procedure
1. On the Plug-ins tab of the Home page, click Automation Manager. On the

Automation Manager summary page, click Event Filters under Plan
management.

2. On the Event Filters page, select the event filter that you want to copy.
3. Click Create Like. The Copy Event Filter wizard is displayed.
4. Use the Copy Event Filter wizard to create an event filter based on the one that

you selected. The Copy Event Filter wizard uses the same panels as the Create
Event Filter wizard. For more information about using an Event Filter wizard
to create or edit an event filter, see “Creating an event filter”. After you finish
using the Copy Event Filter wizard to save the event filter, the filter is
displayed on the Advanced Event Filters page.

Results

The new filter that is based on a preexisting filter is saved and displayed on the
Event Filters page.
Related concepts:
“Simple event filter” on page 311
Simple event filters are general-purpose filters; most event automation plans use a
simple event filter. 
“Duplication event filter” on page 312
In addition to the options that are available in the simple filters, duplication event
filters ignore duplicate events.
“Exclusion event filter” on page 313
In addition to the simple filter options, exclusion event filters exclude certain event
types. Using this filter, you define the criteria of the events to exclude. You can use
this filter to activate a group of events and then exclude some of the events in that
group. You can use this filter to exclude multiple event types.
“Recurring event filter” on page 314
In addition to the simple filter options, a recurring event filter processes an event
after it has occurred a specified number of times within a specified interval.
Related tasks:
“Viewing the automation manager summary” on page 336
You can view a summary of activity within the past 30 days that is associated with
automation, including event automation plans, scheduled and run jobs, event
management and Event Log, a list of systems with the most critical and warning
events, and a list of the most frequent received critical and warning events. Note
that information on this page is refreshed automatically when there are any
changes.
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Viewing event filter properties
You can view the properties for an event filter for information about the filter
settings. Also, the Properties page lists the event automation plans that include the
event filter.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To view event-filter properties, complete the following steps:

Procedure
1. On the Plug-ins tab of the Home page, click Automation Manager. On the

Automation Manager summary page, click Event Filters under Plan
management.

2. On the Event Filters page, select the event filter whose properties you want to
view.

3. Click Actions > Properties.
4. On the Properties page, view the settings for the event filter. The settings vary

depending on the type of the event filter.

Results

Note: The Actions button does not provide any event-filter specific actions
because there are none available on the Properties page.
Related tasks:
“Viewing the automation manager summary” on page 336
You can view a summary of activity within the past 30 days that is associated with
automation, including event automation plans, scheduled and run jobs, event
management and Event Log, a list of systems with the most critical and warning
events, and a list of the most frequent received critical and warning events. Note
that information on this page is refreshed automatically when there are any
changes.

Viewing predefined filter criteria
You can view the criteria used to define a predefined event filter.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:
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Note: You cannot change predefined event filters; they are read-only. However,
you can copy a predefined filter and change the copy. For more information, see
“Copying an event filter.”

If you want to see what event filter criteria are included in a predefined event
filter, complete the following steps:

Procedure
1. On the Plug-ins tab of the Home page, click Automation Manager. On the

Automation Manager summary page, click Event Filters under Plan
management.

2. On the Event Filters page, select the predefined filter that you want to view.
3. Click Actions > Properties.
Related concepts:
“Simple event filter” on page 311
Simple event filters are general-purpose filters; most event automation plans use a
simple event filter. 

Deleting an event filter
You can delete an event filter when it is no longer useful.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To delete an event filter, complete the following steps:

Procedure
1. On the Plug-ins tab of the Home page, click Automation Manager. On the

Automation Manager summary page, click Event Filters under Plan
management.

2. On the Event Filters page, select the event filter that you want to delete.

Note: You can select to delete more than one event filter at a time.
3. Click Delete.
4. In the confirmation window, click Delete.
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Results

The event filter is deleted and is no longer displayed in the Event Filters page. A
message is displayed on the page stating that the filter was deleted successfully.
Related tasks:
“Viewing the automation manager summary” on page 336
You can view a summary of activity within the past 30 days that is associated with
automation, including event automation plans, scheduled and run jobs, event
management and Event Log, a list of systems with the most critical and warning
events, and a list of the most frequent received critical and warning events. Note
that information on this page is refreshed automatically when there are any
changes.

Exporting and importing event automation plans, event filters, and
event actions

Event automation plans, event filters, and event actions can be exported and
imported as an XML file on the management node.

Before you begin

Using CLI commands to export and import event automation plans, event filters,
and event actions makes it easier and faster to use multiple instances of your
plans, filters, and events. For example, you can export a set of event filters then
import them to other systems. Or, after exporting some event automation plans to
a development environment, you can modify and test them safely, then import
them to the systems in your production environment.

Use any XML editor to create or edit an XML file. Importing the XML file creates
the event automation plan, event filter, or event action, but does not update or
replace any existing plan, filter, or action. The import process checks and compares
the event automation plans, event filters, and event actions that you are importing
with the plans, filters, and events that reside on the management node. The import
process then reports any errors and conflicts.

The schema files used for exporting and importing automation data reside in
install_directory\proddata\schema\xml, where install_directory is the location where
IBM Flex System Manager is installed.
v When exporting XML files, using the -F option with the CLI commands creates a

copy of the schema in the same directory as the exported files, if the schema
does not exist in that location.

v When importing XML files, the schema file needs to be in the same directory as
the imported file. The CLI commands create a copy of the schema in the same
directory as the one to which the XML file is imported, if the schema does not
exist in that location.
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Migrating and importing event automation data from a previous
version

When you update and migrate IBM Flex System Manager, the existing event
automation plans, event filters, and event actions are also migrated. You might also
choose to import automation data that was created by using a previous version of
Flex System Manager. A migrated or imported event automation plan that contains
certain event actions might need to be reviewed to ensure that any related
commands or tasks perform as expected.

Before you begin

In previous versions of Flex System Manager, a user could create or edit an event
action that runs a program or starts a task that might be beyond the authority
specified for that user. In Flex System Manager 6.3 and higher, the following event
actions are available only to users with SMAdministrator authority. That is, the
user must be a member of the smadmin group:
v Start a program on a system
v Start a program on the system that generated the event
v Start a task on a specified system
v Start a task on a system that generated the event

After you migrate or import an event automation plan from a previous version of
Flex System Manager, the EventActionPlanRisk.log file identifies the plans that
contain event actions that are meant to be created by a user with SMAdministrator
authority. Review the identified event actions to ensure that the actions (and the
related commands or tasks) are valid.

Starting or restarting the management server generates the
EventActionPlanRisk.log file, which resides in install_root/logs directory, where
install_root is the root directory of your IBM Flex System Manager installation.

The following example shows how the log identifies an event action and the
related commands that you might want to examine. The log also identifies the
event automation plan and event filter in which the event action occurs.

Plan Name Filter Name Action Name Action Type
*********************************************************
p123 p123-Filter apg-sys Start a program on a system
p123 p123-Filter pgm on evt-sys Start a program on the system that generated the event
p123 p123-Filter start-task Start a task on a specified system
p123 p123-Filter run-task-evt-sys Start a task on a system that generated the event

Related tasks:
“Exporting and importing event automation plans, event filters, and event actions”
on page 368
Event automation plans, event filters, and event actions can be exported and
imported as an XML file on the management node.

Using command automation
Use the Command Automation task to create, edit, copy, and delete command
definitions. A command definition specifies and configures a command-line
program that you want to run on a managed system. Anonymous command
restrictions apply to command definitions.
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Before you begin

Notes:

v Users with SMAdmin roles are given unrestricted access to target systems. These
users always have “root” or “admin” access on IBM Flex System Manager -
managed systems when running command automation through IBM Flex
System Manager. This is regardless of what command-line context access the
user has on the target. If this causes a security violation, give users SMManager
or other customized roles that prevent them from accessing command
automation.

v Selecting the management server as the target system is not supported.

Creating or editing a command definition
Use the command automation task to create and run a command definition, which
specifies the command-line program that you want to run on a managed system.
You can create a command definition, create one based on an existing command
definition, or edit an existing command definition.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

Note:

v Command automation is supported only on systems on which Common Agent
is installed.

v Remember that anything a system-account user can do from a command line
can be done to the system, regardless of the user who is logged in to the
managed system.

To create or edit a command definition, perform the following steps:

Procedure
1. On the Initial Setup tab of the Home page, click Chassis Manager. On the

Chassis Manager page, type Command Automations in the Find field, then click
Command Automations in the resulting list on the Tasks tab.

2. Determine if you want to create a command definition, create a command
definition based on an existing one, or edit an existing command definition.
v If you want to create a command definition, click Create.
v If you want to create a command definition that is based on an existing

command definition, select a command definition from the table, then click
Create Like.

v If you want to edit an existing command definition, select a command
definition from the table, then click Edit.
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3. In the Create Command Definitions window, specify information about the
command definition:
a. Accept the default name for the command definition or type a new name in

the Name field.
b. In the Command to run field, type the fully qualified file name and

command syntax. Consider the following information:
v For managed systems running IBM i, the command is run in the Qshell

environment. To run an IBM i system command (such as the call
command), specify the command similar to the following example:
system ’call mylib/myclpgm’

The command runs within the Qshell environment and enables you to
access the IBM i system commands.

v For managed systems running Windows, preface the command with the
following string to ensure that it runs in a Windows command-shell
window:
cmd /c

c. In the Timeout field, type a timeout value, in seconds. The timeout value
specifies the number of seconds to wait for the command either to return a
completion code or time out. Make sure that the timeout value is long
enough.

d. Select the Log check box if you want to log any output produced by the
command, for example, a directory listing.

e. Either accept the default user ID (or the existing user ID if you clicked Edit
or Create Like) or type a new user ID that has the required authority to
perform the command. If you want to run the process using an alternative
user account and override the default user ID, you can specify a user ID
and password in the Login group box.

Note: (Managed systems running IBM i only) Commands cannot be performed
using the default user ID that is shipped with IBM Flex System Manager. For a
command definition to run successfully on IBM i systems, the command
definition must specify a valid user ID and password, or the managed system
to which it is being run must be configured to specify a user that has the
authority to run the command definition. You can register that user in the IBM
Director Agent default user function ID on the managed system system using
Application Administration in Power Systems Navigator.

Note: You either must specify an alternative user ID or remove the default user
ID from the registered function and add a new default user ID that has the
required authority to perform the command.

4. Click OK to save the command definition.

Results

The Command Automation page displays the new command definition.

Running a command definition
After creating a command definition, you can run it on one or more specific
managed resources. Run the command definition immediately, or schedule the
command to run at a specific time or at regular intervals.

Chapter 8. Automating tasks 371



About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

As an alternative to using the Command Automation task in the IBM Flex System
Manager Web interface, you also can specify the command definition as an action
in an event automation plan.

Note:

v Command automation is supported only on systems on which Common Agent
is installed.

v Using the Command Automation task to start interactive programs, for example
notepad.exe, is not supported.

v A Command Automation task that is submitted with the log option returns the
output only after the underlying command or task is complete. There is no
intermediate periodic checking and gathering of remote command output.

Note: After submitting a Command Automation job, you cannot cancel it until
either the task completes or automation timeout occurs. However, if a process is
running on a resource, it can be listed and cancelled, if needed. Use System Status
and Health > Process Management to cancel a process.

To run a command definition, perform the following steps:

Procedure
1. On the Initial Setup tab of the Home page, click Chassis Manager. On the

Chassis Manager page, type Command Automations in the Find field, then click
Command Automations in the resulting list on the Tasks tab.

2. Select the command definition that you want to run. The Command
Automation page is displayed.

3. Click Run. The Launch Job window displays.
4. Use the Launch Job window to specify one or more target resources on which

you want to run the command and determine when you want to run the
command. You can also specify other options, including notification settings.

5. After you finish specifying the configuration for this command definition in the
Launch Job window, click OK to use your settings to run the command
definition.

Restricting anonymous command execution
By default, commands are run on the managed system as either system account
(Windows) or root (Linux). You can restrict anonymous command execution by
disabling this function and always requiring a user ID and password.
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Restricting anonymous command execution on Linux
You can restrict anonymous command execution on managed systems running
Linux.

About this task

To restrict anonymous command execution, complete the following steps:

Procedure
1. Change to the directory in which Common Agent is installed. If you installed

IBM Flex System Manager in the default directory, the directory name is
opt/ibm/director/data.

2. From a command-line prompt, type the following string, and then press Enter:
vi ProcMgr.properties

3. Change the value of RestrictAnonCmdExe to True.
4. Save the file. The change takes effect immediately.

Restricting anonymous command execution on Windows
You can restrict anonymous command execution on managed systems running
Windows.

About this task

To restrict anonymous command execution, complete the following steps:

Procedure
1. On a Windows system, type regedit at a command line and press Enter:
2. Navigate to the registry entry HKEY_LOCAL_MACHINE\SOFTWARE\Tivoli\

Director\CurrentVersion.
3. Double-click RestrictAnonCmdExec.
4. In the Value data field, change 0 to 1.
5. Click OK. The change takes effect immediately.

Chapter 8. Automating tasks 373



374 Systems Management Guide



Chapter 9. Updating firmware and software

The IBM Flex System Manager management software Update Manager has
advanced update capabilities that are not possible with the update wizards on the
Initial Setup tab (on the Home page of the management software web interface).
You can also use Update Manager to update additional components (such as
operating systems) that the Initial Setup wizards cannot update.

The management software installs and manages firmware and software updates for
every resource in your Flex System Enterprise Chassis. The information in this
section describes advanced capabilities for updating the management software and
management node firmware, as well as firmware for managed Chassis
Management Modules, compute nodes, and network devices.

Important: For a detailed summary of update procedures for all IBM Flex System
components, see the IBM Flex System Firmware Update Guides at
http://www.ibm.com/support/entry/portal/docdisplay?lndocid=MIGR-5091991.

Note: The management software cannot update the backup firmware banks for
managed resources.

During initial setup of your IBM Flex System Manager environment, use the
management software update wizards for basic update operations. See the
information for each update wizard in “Initial setup” on page 132 for more
information.

You can also configure the management software to notify you of available updates
and to select compliance policy settings for managed resources. See “Automate
checking for updates” on page 145 for more information.

Note: If you update every managed component in a chassis or management
domain at once, and one or more components are set to reboot after applying the
updates, there might be a temporary loss of network connectivity. This might cause
the pending updates that require network connectivity to fail. The updates will not
be corrupted; rather, the updates that failed will need to run again. When network
connectivity is restored, those updates should be applied.

To start updating firmware and software, click the Plug-ins tab on the Home page;
then, click Update Manager. Update Manager guides you through the following
steps. The Update Manager summary page also includes a search feature. You
search for text (for example, an APAR or tech note number) for the release notes of
all local updates.

You can use either the web interface or the command-line interface (CLI) to update
firmware and software. See http://publib.boulder.ibm.com/infocenter/flexsys/
information/topic/com.ibm.director.cli.helps.doc/fqm0_r_cli_update_cmds.htmlor
the IBM Flex System Manager Command Reference Guide document for specific CLI
commands related to updating systems.
1. Acquire updates
2. Show and install updates
3. Create and configure compliance policies
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Important: The following notes apply to Power Systems compute nodes under
management by the management software:
v IBM Flex System Manager management software version 1.1.0 is compatible

with IBM Flex System p260 and p460 Compute Nodes running 740 firmware
with 74x updates only.

v IBM Flex System Manager manages Power Systems differently than
X-Architecture compute nodes. For more information about managing Power
Systems compute nodes with the management software, see
http://publib.boulder.ibm.com/infocenter/flexsys/information/topic/
com.ibm.acc.8731.doc/managing_power_systems.html.

The Optional: Getting started link is located in the list of common tasks on the
Update Manager Summary page.

IBM PureSystems Updates

The updates for IBM PureFlex System are tested and released together. It is
essential that the updates are done in the correct sequence. For more information
about how to update the Flex System components in your PureFlex system, see
IBM Flex System Update Best Practices.
v IBM Flex System Manager management node software image: This package

contains updates for the Flex System Manager software image.
v IBM Flex System Enterprise Chassis: This package contains updates for the Flex

System Chassis Management Module and I/O modules (switches and pass thru
modules) that are installed in your Flex System Enterprise Chassis.

v IBM Flex System X-Architecture compute nodes: These packages contain
UpdateXpress System Packages (UXSP) for Flex System x compute nodes.

v IBM Flex System P-Architecture compute nodes: These packages contain
firmware packages for Flex System p compute nodes.

v IBM Storwize V7000: This package contains updates for the Storwize V7000.
v IBM Flex System V7000 Storage Node: This package contains updates for the

Flex System V7000 storage node.
v IBM RackSwitch G8264, IBM RackSwitch G8052, and Brocade RackSwitch

2498-B24: These packages contain updates for the Flex Rack Switches.

Table 47. FlexSystem 1.3.4 - IBM

Name Version Machine Type Date

Flex System Manager image 1.3.4 All 2015-10-06

Chassis firmware 2.5.3u All 2015-06-12

x222 Compute Node 2.00 All 2015-05-07

Lenovo x240 M5 Compute Node 1.20 All 2015-12-30

x240 Compute Node 2.00 All 2015-05-07

x280/x480/x880 Compute Node 1.25b All 2014-09-25

x440 Compute Node 3.00 All 2015-05-05

p24L Compute Node FW783_030 All 2015-08-26

p260 Compute Node FW783_030 All 2015-08-26

p460 Compute Node FW783_030 All 2015-08-26

Storwize V7000 7.2.0.x All 2014-07-01

Flex System V7000 Storage Node 7.2.0.x All 2014-07-01
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http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=x440%2BCompute%2BNode&product=ibm/systemx/7917&&platform=All&function=fixId&fixids=ibm_utl_uxsp_cnib*p-3.00_*_32-64,+lnvgy_utl_uxspi_10.1_*_32-64,lnvgy_utl_uxspi_10.1_*_x86-64&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/main/quickorder?productList=Compute+Node%3Aibm/power/14577FL%3AAll%3AAll%3A01AF783_030_021|null%3Aibm/io%3AAll%3AAll%3A244C7C66995FB6BB87257BDD001B968D_GRP,42742682A19818F987257BDD001A337F_GRP,6100BD8B9216B84D87257BDD0016E05F_GRP,6EB5EE43FC251A2B87257BCA00179F2D_AIX,6EB5EE43FC251A2B87257BCA00179F2D_LNX,78A52D6D160451D287257BDD001AC470_GRP,B1D576DFF9C584A587257BC500329FD7_AIX,B1D576DFF9C584A587257BC500329FD7_LNX,CB744FE0CEFEAEE487257CD20011D7C1_AIX,CB744FE0CEFEAEE487257CD20011D7C1_LNX,CCBD4417BDC8064F87257BC500300645_AIX,CCBD4417BDC8064F87257BC500300645_LNX,CEC8AF52CB16D01187257BDD00193714_AIX,CEC8AF52CB16D01187257BDD00193714_LNX,EDFFCB289FF01C8387257BC6000B459F_GRP,F69BF838DD28B5D187257BDD0018BED1_GRP&function=fixId&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/main/quickorder?productList=Compute+Node%3Aibm/power/789522X%3AAll%3AAll%3A01AF783_030_021|null%3Aibm/io%3AAll%3AAll%3A244C7C66995FB6BB87257BDD001B968D_GRP,42742682A19818F987257BDD001A337F_GRP,6100BD8B9216B84D87257BDD0016E05F_GRP,6EB5EE43FC251A2B87257BCA00179F2D_AIX,6EB5EE43FC251A2B87257BCA00179F2D_LNX,78A52D6D160451D287257BDD001AC470_GRP,B1D576DFF9C584A587257BC500329FD7_AIX,B1D576DFF9C584A587257BC500329FD7_LNX,CB744FE0CEFEAEE487257CD20011D7C1_AIX,CB744FE0CEFEAEE487257CD20011D7C1_LNX,CCBD4417BDC8064F87257BC500300645_AIX,CCBD4417BDC8064F87257BC500300645_LNX,CEC8AF52CB16D01187257BDD00193714_AIX,CEC8AF52CB16D01187257BDD00193714_LNX,EDFFCB289FF01C8387257BC6000B459F_GRP,F69BF838DD28B5D187257BDD0018BED1_GRP&function=fixId&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/main/quickorder?productList=Compute+Node%3Aibm/power/789542X%3AAll%3AAll%3A01AF783_030_021|null%3Aibm/io%3AAll%3AAll%3A244C7C66995FB6BB87257BDD001B968D_GRP,42742682A19818F987257BDD001A337F_GRP,6100BD8B9216B84D87257BDD0016E05F_GRP,6EB5EE43FC251A2B87257BCA00179F2D_AIX,6EB5EE43FC251A2B87257BCA00179F2D_LNX,78A52D6D160451D287257BDD001AC470_GRP,B1D576DFF9C584A587257BC500329FD7_AIX,B1D576DFF9C584A587257BC500329FD7_LNX,CB744FE0CEFEAEE487257CD20011D7C1_AIX,CB744FE0CEFEAEE487257CD20011D7C1_LNX,CCBD4417BDC8064F87257BC500300645_AIX,CCBD4417BDC8064F87257BC500300645_LNX,CEC8AF52CB16D01187257BDD00193714_AIX,CEC8AF52CB16D01187257BDD00193714_LNX,EDFFCB289FF01C8387257BC6000B459F_GRP,F69BF838DD28B5D187257BDD0018BED1_GRP&function=fixId&includeSupersedes=0&source=fc
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Table 47. FlexSystem 1.3.4 - IBM (continued)

Name Version Machine Type Date

RackSwitch G8264 firmware 7.8.10.0 All 2015-03-24

RackSwitch G8052 firmware 7.11.3 All 2015-05-04

RackSwitch 2498-B24 firmware 7.2.1a All 2014-06-13

Table 48. FlexSystem 1.3.3 - IBM

Name Version Machine Type Date

Flex System Manager image 1.3.3 All 2015-06-05

Chassis firmware 2.5.3t All 2015-04-28

x222 Compute Node 2.00 All 2115-05-07

Lenovo x240 M5 Compute Node 1.10 All 2015-05-06

x240 Compute Node 2.00 All 2015-05-07

x280/x480/x880 Compute Node 1.25b All 2014-09-25

x440 Compute Node 3.00 All 2015-05-05

p24L Compute Node FW783_027 All 2015-04-16

p260 Compute Node FW783_027 All 2015-04-16

p460 Compute Node FW783_027 All 2015-04-16

Storwize V7000 7.2.0.x All 2014-07-01

Flex System V7000 Storage Node 7.2.0.x All 2014-07-01

RackSwitch G8264 firmware 7.8.10.0 All 2015-03-24

RackSwitch G8052 firmware 7.11.3 All 2015-05-04

RackSwitch 2498-B24 firmware 7.2.1a All 2014-06-13

Table 49. FlexSystem 1.3.2.1 - IBM

Name Version Machine Type Date

Software Stack Definition 1.3.2.1 All 2014-12-05

Flex System Manager image 1.3.2 All 2014-06-13

Flex System Manager image Fix Pack 1.3.2.1 All 2015-12-05

Chassis firmware 2.5.2q All 2015-12-05

Lenovo x240 M5 Compute Node 1.00 All 2014-12-05

Lenovo x440 Compute Node 2.60 All 2014-12-05

x220 Compute Node 3.30 All 2014-09-25

x222 Compute Node 1.25b All 2014-09-25

x240 Compute Node 2.15b All 2014-09-25

x280/x480/x880 Compute Node 1.25b All 2014-09-25

x440 Compute Node 2.55b All 2014-09-25

p24L Compute Node FW783_022 All 2014-06-18

p260 Compute Node FW783_022 All 2014-06-18

p460 Compute Node FW783_022 All 2014-06-18

Storwize V7000 7.2.0.x All 2014-07-01

Flex System V7000 Storage Node 7.2.0.x All 2014-07-01
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http://www.ibm.com/support/fixcentral/swg/quickorder?parent=Converged%2Bswitches&product=ibm/Systems_Networking/IBM+RackSwitch+G8264CS&release=All&platform=All&function=fixId&fixids=G8264CS_SI_Fabric_Image_7.8.10.0,G8264CS_Image_7.8.10.0&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/swg/quickorder?parent=Ethernet%2BSwitches&product=ibm/Systems_Networking/IBM+BNT+RackSwitch+G8052R,F+G8264R,F&release=7.11.3.0&platform=All&function=fixId&fixids=G8052_Image_7.11.3.0&includeRequisites=1&includeSupersedes=0&source=fc
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http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=Flex%2BSystem%2BManager%2BNode&product=ibm/systemx/8731&&platform=All&function=fixId&fixids=FSMApplianceUpdate-1-3-3&includeRequisites=1&includeSupersedes=0&downloadMethod=ddp&source=fc
http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=Enterprise%2BChassis&product=ibm/systemx/7893&&platform=All&function=fixId&fixids=ibm_fw_cmm_2pet12t-2.5.3t_anyos_noarch,ibm_fw_scsw_si4093-7.8.10.0a_anyos_noarch,brcd_fw_bcsw_nos6.0.0_anyos_noarch,ibm_fw_scsw_en2092-7.8.10.0_anyos_noarch,ibm_fw_scsw_en4093r-7.8.10.0_anyos_noarch,ibm_fw_scsw_cn4093-7.8.10.0_anyos_noarch,ibm_fw_scsw_en4091-2.0.4.0_anyos_noarch,brcd_fw_bcsw_7.3.1_anyos_noarch,qlgc_fw_flex_9.1.5.02.00_anyos_noarch,mlnx_fw_ppc_m460ex-sx-3.4.1110_anyos_noarch&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=x222%2BCompute%2BNode&product=ibm/systemx/7916&&platform=All&function=fixId&fixids=ibm_utl_uxsp_ccib*p-2.00_*_32-64,+lnvgy_utl_uxspi_10.1_*_32-64,lnvgy_utl_uxspi_10.1_*_x86-64&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=Lenovo%2Bx240%2BM5%2BCompute%2BNode&product=ibm/systemx/9532&&platform=All&function=fixId&fixids=lnvgy_utl_uxsp_c4sp*p-1.10_*_32-64,lnvgy_utl_uxspi_10.1_*_32-64,lnvgy_utl_uxspi_10.1_*_x86-64&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=x240%2BCompute%2BNode&product=ibm/systemx/8737&&platform=All&function=fixId&fixids=ibm_utl_uxsp_b2ib*p-2.00_*_32-64,+lnvgy_utl_uxspi_10.1_*_32-64,lnvgy_utl_uxspi_10.1_*_x86-64&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/systemx/quickorder?product=ibm/systemx/7903&&platform=All&function=fixId&fixids=lnvgy_utl_uxspi_10.1_*_,ibm_utl_uxsp_n2ib*p-2.00_*_32-64&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=x440%2BCompute%2BNode&product=ibm/systemx/7917&&platform=All&function=fixId&fixids=ibm_utl_uxsp_cnib*p-3.00_*_32-64,+lnvgy_utl_uxspi_10.1_*_32-64,lnvgy_utl_uxspi_10.1_*_x86-64&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/main/quickorder?productList=Compute+Node%3Aibm/power/14577FL%3AAll%3AAll%3A01AF783_027_021|null%3Aibm/io%3AAll%3AAll%3A244C7C66995FB6BB87257BDD001B968D_GRP,42742682A19818F987257BDD001A337F_GRP,6100BD8B9216B84D87257BDD0016E05F_GRP,6EB5EE43FC251A2B87257BCA00179F2D_AIX,6EB5EE43FC251A2B87257BCA00179F2D_LNX,78A52D6D160451D287257BDD001AC470_GRP,B1D576DFF9C584A587257BC500329FD7_AIX,B1D576DFF9C584A587257BC500329FD7_LNX,CB744FE0CEFEAEE487257CD20011D7C1_AIX,CB744FE0CEFEAEE487257CD20011D7C1_LNX,CCBD4417BDC8064F87257BC500300645_AIX,CCBD4417BDC8064F87257BC500300645_LNX,CEC8AF52CB16D01187257BDD00193714_AIX,CEC8AF52CB16D01187257BDD00193714_LNX,EDFFCB289FF01C8387257BC6000B459F_GRP,F69BF838DD28B5D187257BDD0018BED1_GRP&function=fixId&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/main/quickorder?productList=Compute+Node%3Aibm/power/789522X%3AAll%3AAll%3A01AF783_027_021|null%3Aibm/io%3AAll%3AAll%3A244C7C66995FB6BB87257BDD001B968D_GRP,42742682A19818F987257BDD001A337F_GRP,6100BD8B9216B84D87257BDD0016E05F_GRP,6EB5EE43FC251A2B87257BCA00179F2D_AIX,6EB5EE43FC251A2B87257BCA00179F2D_LNX,78A52D6D160451D287257BDD001AC470_GRP,B1D576DFF9C584A587257BC500329FD7_AIX,B1D576DFF9C584A587257BC500329FD7_LNX,CB744FE0CEFEAEE487257CD20011D7C1_AIX,CB744FE0CEFEAEE487257CD20011D7C1_LNX,CCBD4417BDC8064F87257BC500300645_AIX,CCBD4417BDC8064F87257BC500300645_LNX,CEC8AF52CB16D01187257BDD00193714_AIX,CEC8AF52CB16D01187257BDD00193714_LNX,EDFFCB289FF01C8387257BC6000B459F_GRP,F69BF838DD28B5D187257BDD0018BED1_GRP&function=fixId&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/main/quickorder?productList=Compute+Node%3Aibm/power/789542X%3AAll%3AAll%3A01AF783_027_021|null%3Aibm/io%3AAll%3AAll%3A244C7C66995FB6BB87257BDD001B968D_GRP,42742682A19818F987257BDD001A337F_GRP,6100BD8B9216B84D87257BDD0016E05F_GRP,6EB5EE43FC251A2B87257BCA00179F2D_AIX,6EB5EE43FC251A2B87257BCA00179F2D_LNX,78A52D6D160451D287257BDD001AC470_GRP,B1D576DFF9C584A587257BC500329FD7_AIX,B1D576DFF9C584A587257BC500329FD7_LNX,CB744FE0CEFEAEE487257CD20011D7C1_AIX,CB744FE0CEFEAEE487257CD20011D7C1_LNX,CCBD4417BDC8064F87257BC500300645_AIX,CCBD4417BDC8064F87257BC500300645_LNX,CEC8AF52CB16D01187257BDD00193714_AIX,CEC8AF52CB16D01187257BDD00193714_LNX,EDFFCB289FF01C8387257BC6000B459F_GRP,F69BF838DD28B5D187257BDD0018BED1_GRP&function=fixId&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/swg/quickorder?parent=Mid-range%2Bdisk%2Bsystems&product=ibm/Storage_Disk/IBM+Storwize+V7000+(2076)&release=All&platform=All&function=fixId&fixids=StorageDisk-2076-DriveMicrocode-20131022,StorageDisk-2076-7.2.0.*,StorageDisk-2076-SwUpgradeTestUtility&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/swg/quickorder?parent=Storage%2BNode&product=ibm/Storage_Disk/Flex+System+V7000&release=All&platform=All&function=fixId&fixids=StorageDisk-4939-SwUpgradeTestUtility,StorageDisk-4939-7.2.0.*,StorageDisk-4939-DriveMicrocode-20131022&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/swg/quickorder?parent=Converged%2Bswitches&product=ibm/Systems_Networking/IBM+RackSwitch+G8264CS&release=All&platform=All&function=fixId&fixids=G8264CS_SI_Fabric_Image_7.8.10.0,G8264CS_Image_7.8.10.0&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/swg/quickorder?parent=Ethernet%2BSwitches&product=ibm/Systems_Networking/IBM+BNT+RackSwitch+G8052R,F+G8264R,F&release=7.11.3.0&platform=All&function=fixId&fixids=G8052_Image_7.11.3.0&includeRequisites=1&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/swg/quickorder?product=ibm/StorageAreaNetwork/SAN24B-4+Switch+(2498-B24)&release=7.x&platform=All&function=fixId&fixids=SAN_Systems_Networking_b_type_7.x_firmware&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=Lenovo%2Bx240%2BM5%2BCompute%2BNode&product=ibm/systemx/9532&&platform=All&function=fixId&fixids=FlexSoftwareStack_4Q&includeSupersedes=0&source=fc
http://www-933.ibm.com/support/fixcentral/systemx/selectFixes?parent=Flex%2BSystem%2BManager%2BNode&product=ibm/systemx/8731&&platform=All&function=fixId&fixids=Flex1_3_2*,FSMApplianceUpdate-1-3-2,fsmfix1.3.2.0*,FSMApplianceFixPackage-1-3-2*&includeSupersedes=0
http://www-933.ibm.com/support/fixcentral/systemx/selectFixes?parent=Flex%2BSystem%2BManager%2BNode&product=ibm/systemx/8731&&platform=All&function=fixId&fixids=FSMApplianceFixPackage-1-3-2*,fsmfix1.3.2.0_IT04332&includeSupersedes=0
http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=Enterprise%2BChassis&product=ibm/systemx/7893&&platform=All&function=fixId&fixids=ibm_fw_cmm_2pet12q-2.5.2q_anyos_noarch,ibm_fw_scsw_si4093-7.8.7.0_anyos_noarch,brcd_fw_bcsw_nos4.0.1-bbd_anyos_noarch,ibm_fw_scsw_en2092-7.8.7.0_anyos_noarch,ibm_fw_scsw_en4093r-7.8.7.0_anyos_noarch,ibm_fw_scsw_cn4093-7.8.7.0_anyos_noarch,ibm_fw_scsw_en4091-2.0.4.0_anyos_noarch,brcd_fw_bcsw_7.2.1a1_anyos_noarch,qlgc_fw_flex_9.1.3.04.00_anyos_noarch,mlnx_fw_ppc_m460ex-sx-3.3.5066_anyos_noarch&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=Lenovo%2Bx240%2BM5%2BCompute%2BNode&product=ibm/systemx/9532&&platform=All&function=fixId&fixids=lnvgy_utl_uxsp_c4sp*p-1.00_*_32-64,lnvgy_utl_uxspi_10.0_*_32-64,lnvgy_utl_uxspi_10.0_*_x86-64&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=Lenovo%2Bx440%2BCompute%2BNode&product=ibm/systemx/7167&&platform=All&function=fixId&fixids=lnvgy_utl_uxsp_cgsp*p-2.60_*_32-64,lnvgy_utl_uxspi_10.0_*_32-64,lnvgy_utl_uxspi_10.0_*_x86-64&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=x220%2BCompute%2BNode&product=ibm/systemx/2585&&platform=All&function=fixId&fixids=ibm_utl_uxsp_kssp*p-3.30_*_32-64,ibm_utl_uxspi_9.63_*_32-64,&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=x222%2BCompute%2BNode&product=ibm/systemx/7916&&platform=All&function=fixId&fixids=ibm_utl_uxsp_ccsp*p-1.25b_*_32-64,ibm_utl_uxspi_9.63_*_32-64&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=x240%2BCompute%2BNode&product=ibm/systemx/8737&&platform=All&function=fixId&fixids=ibm_utl_uxsp_b2sp*p-2.15b_*_32-64,ibm_utl_uxspi_9.63_*_32-64&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=x280%2BX6%2BCompute%2BNode&product=ibm/systemx/7903&&platform=All&function=fixId&fixids=ibm_utl_uxsp_n2sp*p-1.25b_*_32-64,ibm_utl_uxspi_9.63_*_32-64&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=x440%2BCompute%2BNode&product=ibm/systemx/7917&&platform=All&function=fixId&fixids=ibm_utl_uxsp_cnsp*p-2.55b_*_32-64,ibm_utl_uxspi_9.63_*_32-64,ibm_utl_uxspi_9.63_*_x86-64&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/main/quickorder?productList=Compute+Node%3Aibm/power/14577FL%3AAll%3AAll%3A01AF783_022_021|null%3Aibm/io%3AAll%3AAll%3A244C7C66995FB6BB87257BDD001B968D_GRP,42742682A19818F987257BDD001A337F_GRP,6100BD8B9216B84D87257BDD0016E05F_GRP,6EB5EE43FC251A2B87257BCA00179F2D_AIX,6EB5EE43FC251A2B87257BCA00179F2D_LNX,78A52D6D160451D287257BDD001AC470_GRP,B1D576DFF9C584A587257BC500329FD7_AIX,B1D576DFF9C584A587257BC500329FD7_LNX,CB744FE0CEFEAEE487257CD20011D7C1_AIX,CB744FE0CEFEAEE487257CD20011D7C1_LNX,CCBD4417BDC8064F87257BC500300645_AIX,CCBD4417BDC8064F87257BC500300645_LNX,CEC8AF52CB16D01187257BDD00193714_AIX,CEC8AF52CB16D01187257BDD00193714_LNX,EDFFCB289FF01C8387257BC6000B459F_GRP,F69BF838DD28B5D187257BDD0018BED1_GRP&function=fixId&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/main/quickorder?productList=Compute+Node%3Aibm/power/789522X%3AAll%3AAll%3A01AF783_022_021|null%3Aibm/io%3AAll%3AAll%3A244C7C66995FB6BB87257BDD001B968D_GRP,42742682A19818F987257BDD001A337F_GRP,6100BD8B9216B84D87257BDD0016E05F_GRP,6EB5EE43FC251A2B87257BCA00179F2D_AIX,6EB5EE43FC251A2B87257BCA00179F2D_LNX,78A52D6D160451D287257BDD001AC470_GRP,B1D576DFF9C584A587257BC500329FD7_AIX,B1D576DFF9C584A587257BC500329FD7_LNX,CB744FE0CEFEAEE487257CD20011D7C1_AIX,CB744FE0CEFEAEE487257CD20011D7C1_LNX,CCBD4417BDC8064F87257BC500300645_AIX,CCBD4417BDC8064F87257BC500300645_LNX,CEC8AF52CB16D01187257BDD00193714_AIX,CEC8AF52CB16D01187257BDD00193714_LNX,EDFFCB289FF01C8387257BC6000B459F_GRP,F69BF838DD28B5D187257BDD0018BED1_GRP&function=fixId&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/main/quickorder?productList=Compute+Node%3Aibm/power/789542X%3AAll%3AAll%3A01AF783_022_021|null%3Aibm/io%3AAll%3AAll%3A244C7C66995FB6BB87257BDD001B968D_GRP,42742682A19818F987257BDD001A337F_GRP,6100BD8B9216B84D87257BDD0016E05F_GRP,6EB5EE43FC251A2B87257BCA00179F2D_AIX,6EB5EE43FC251A2B87257BCA00179F2D_LNX,78A52D6D160451D287257BDD001AC470_GRP,B1D576DFF9C584A587257BC500329FD7_AIX,B1D576DFF9C584A587257BC500329FD7_LNX,CB744FE0CEFEAEE487257CD20011D7C1_AIX,CB744FE0CEFEAEE487257CD20011D7C1_LNX,CCBD4417BDC8064F87257BC500300645_AIX,CCBD4417BDC8064F87257BC500300645_LNX,CEC8AF52CB16D01187257BDD00193714_AIX,CEC8AF52CB16D01187257BDD00193714_LNX,EDFFCB289FF01C8387257BC6000B459F_GRP,F69BF838DD28B5D187257BDD0018BED1_GRP&function=fixId&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/swg/quickorder?parent=Mid-range%2Bdisk%2Bsystems&product=ibm/Storage_Disk/IBM+Storwize+V7000+(2076)&release=All&platform=All&function=fixId&fixids=StorageDisk-2076-DriveMicrocode-20131022,StorageDisk-2076-7.2.0.*,StorageDisk-2076-SwUpgradeTestUtility&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/swg/quickorder?parent=Storage%2BNode&product=ibm/Storage_Disk/Flex+System+V7000&release=All&platform=All&function=fixId&fixids=StorageDisk-4939-SwUpgradeTestUtility,StorageDisk-4939-7.2.0.*,StorageDisk-4939-DriveMicrocode-20131022&includeSupersedes=0&source=fc


Table 49. FlexSystem 1.3.2.1 - IBM (continued)

Name Version Machine Type Date

RackSwitch G8264 firmware 7.8.4 All 2014-06-13

RackSwitch G8052 firmware 7.8.1 All 2014-06-13

RackSwitch 2498-B24 firmware 7.2.1a All 2014-06-13

Table 50. FlexSystem 1.3.1.2 - IBM

Name Version Machine Type Date

Flex System Manager image 1.3.1 All 2013-12-03

Flex System Manager image Fix Pack 1.3.1.2 All 2014-06-27

Chassis firmware 1.50.1m All 2014-07-15

x220 Compute Node 2.9.21 All 2014-07-18

x222 Compute Node 1.1.21 All 2014-07-08

x240 Compute Node 1.5.21 All 2014-07-10

x440 Compute Node 2.4.21 All 2014-07-08

p24L Compute Node FW773_058 All 2014-07-07

p260 Compute Node FW773_058 All 2014-07-07

p460 Compute Node FW773_058 All 2014-07-07

Storwize V7000 7.2.0.x All 2014-07-03

Flex System V7000 Storage Node 7.2.0.x All 2014-07-03

RackSwitch G8264 firmware 7.7.8 All 2013-12-06

RackSwitch G8052 firmware 7.7.8 All 2013-12-06

RackSwitch 2498-B24 firmware 7.1.1 All 2013-05-30

Table 51. FlexSystem 1.3.0.2 - IBM

Name Version Machine Type Date

Flex System Manager image 1.3.0 All 2013-09-10

Flex System Manager image Fix Pack 1.3.0.2 All 2014-05-07

Chassis firmware 1.50.0e All 2014-05-08

x220 Compute Node 2.70 All 2013-09-10

x222 Compute Node 1.0 All 2014-05-14

x240 Compute Node 1.43 All 2014-05-13

x440 Compute Node 2.00 All 2014-05-14

p24L Compute Node FW773.35 All 2014-05-09

p260 Compute Node FW773.35 All 2014-05-09

p460 Compute Node FW773.35 All 2014-05-09

Storwize V7000 7.1.0.x All 2014-04-23

Flex System V7000 Storage Node 7.1.0.x All 2014-04-23

RackSwitch G8264 firmware 7.7.5 All 2013-09-10

RackSwitch G8052 firmware 7.7.5 All 2013-09-10

RackSwitch 2498-B24 firmware 7.0.0c All 2012-04-19
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http://www.ibm.com/support/fixcentral/swg/quickorder?parent=Converged%2Bswitches&product=ibm/Systems_Networking/IBM+RackSwitch+G8264CS&release=All&platform=All&function=fixId&fixids=G8264CS_SI_Fabric_Image_7.8.4.0,G8264CS_Image_7.8.4.0&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/swg/quickorder?parent=Ethernet%2BSwitches&product=ibm/Systems_Networking/IBM+BNT+RackSwitch+G8052R,F+G8264R,F&release=7.8.1.0&platform=All&function=fixId&fixids=G8052_Image_7.8.1.0&includeRequisites=1&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/swg/quickorder?product=ibm/StorageAreaNetwork/SAN24B-4+Switch+(2498-B24)&release=7.x&platform=All&function=fixId&fixids=SAN_Systems_Networking_b_type_7.x_firmware&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=Flex+System+Manager+Node&product=ibm/systemx/8731&&platform=All&function=fixId&fixids=Flex1_3_1*,FSMApplianceUpdate-1-3-1,fsmfix1.3.1.0*,FSMApplianceFixPackage-1-3-1*&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=Flex+System+Manager+Node&product=ibm/systemx/8731&&platform=All&function=fixId&fixids=FSMApplianceFixPackage-1-3-1*&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=Enterprise+Chassis&product=ibm/systemx/7893&&platform=All&function=fixId&fixids=ibm_fw_cmm_2pet12m-1.50.1m_anyos_noarch,ibm_fw_scsw_si4093-7.7.8.0_anyos_noarch,brcd_fw_bcsw_nos4.0.0_bbd1_anyos_noarch,ibm_fw_scsw_en2092-7.7.18.0_anyos_noarch,ibm_fw_scsw_en4093r-7.7.18.0_anyos_noarch,ibm_fw_scsw_cn4093-7.7.18.0_anyos_noarch,brcd_fw_bcsw_7.2.0b1_anyos_noarch,qlgc_fw_flex_9.1.2.09.00_anyos_noarch,mlnx_fw_ppc_m460ex-sx-3.3.4100_anyos_noarch&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=x220+Compute+Node&product=ibm/systemx/2585&&platform=All&function=fixId&fixids=ibm_utl_uxsp_kssp*p-2.9.21_*_32-64,ibm_utl_uxspi_9.61_*_32-64&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=x222+Compute+Node&product=ibm/systemx/7916&&platform=All&function=fixId&fixids=ibm_utl_uxsp_ccsp*p-1.1.21_*_32-64,ibm_utl_uxspi_9.61_*_32-64&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=x240+Compute+Node&product=ibm/systemx/8737&&platform=All&function=fixId&fixids=ibm_utl_uxsp_b2sp*p-1.5.21_*_32-64,ibm_utl_uxspi_9.61_*_32-64&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=x440+Compute+Node&product=ibm/systemx/7917&&platform=All&function=fixId&fixids=ibm_utl_uxsp_cnsp*p-2.4.21_*_32-64,ibm_utl_uxspi_9.61_*_32-64&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/main/quickorder?productList=Compute+Node%3Aibm/power/14577FL%3AAll%3AAll%3A01AF773_058_033|null%3Aibm/io%3AAll%3AAll%3A14D3A9957AC27B4E87257C0F0028BF9B_AIX,14D3A9957AC27B4E87257C0F0028BF9B_LNX,244C7C66995FB6BB87257BDD001B968D_GRP,42742682A19818F987257BDD001A337F_GRP,6100BD8B9216B84D87257BDD0016E05F_GRP,6EB5EE43FC251A2B87257BCA00179F2D_AIX,6EB5EE43FC251A2B87257BCA00179F2D_LNX,78A52D6D160451D287257BDD001AC470_GRP,B1D576DFF9C584A587257BC500329FD7_AIX,B1D576DFF9C584A587257BC500329FD7_LNX,CCBD4417BDC8064F87257BC500300645_AIX,CCBD4417BDC8064F87257BC500300645_LNX,CEC8AF52CB16D01187257BDD00193714_AIX,CEC8AF52CB16D01187257BDD00193714_LNX,EDFFCB289FF01C8387257BC6000B459F_GRP,F69BF838DD28B5D187257BDD0018BED1_GRP&function=fixId&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/main/quickorder?productList=Compute+Node%3Aibm/power/789522X%3AAll%3AAll%3A01AF773_058_033|null%3Aibm/io%3AAll%3AAll%3A14D3A9957AC27B4E87257C0F0028BF9B_AIX,14D3A9957AC27B4E87257C0F0028BF9B_LNX,244C7C66995FB6BB87257BDD001B968D_GRP,42742682A19818F987257BDD001A337F_GRP,6100BD8B9216B84D87257BDD0016E05F_GRP,6EB5EE43FC251A2B87257BCA00179F2D_AIX,6EB5EE43FC251A2B87257BCA00179F2D_LNX,78A52D6D160451D287257BDD001AC470_GRP,B1D576DFF9C584A587257BC500329FD7_AIX,B1D576DFF9C584A587257BC500329FD7_LNX,CCBD4417BDC8064F87257BC500300645_AIX,CCBD4417BDC8064F87257BC500300645_LNX,CEC8AF52CB16D01187257BDD00193714_AIX,CEC8AF52CB16D01187257BDD00193714_LNX,EDFFCB289FF01C8387257BC6000B459F_GRP,F69BF838DD28B5D187257BDD0018BED1_GRP&function=fixId&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/main/quickorder?productList=Compute+Node%3Aibm/power/789542X%3AAll%3AAll%3A01AF773_058_033|null%3Aibm/io%3AAll%3AAll%3A14D3A9957AC27B4E87257C0F0028BF9B_AIX,14D3A9957AC27B4E87257C0F0028BF9B_LNX,244C7C66995FB6BB87257BDD001B968D_GRP,42742682A19818F987257BDD001A337F_GRP,6100BD8B9216B84D87257BDD0016E05F_GRP,6EB5EE43FC251A2B87257BCA00179F2D_AIX,6EB5EE43FC251A2B87257BCA00179F2D_LNX,78A52D6D160451D287257BDD001AC470_GRP,B1D576DFF9C584A587257BC500329FD7_AIX,B1D576DFF9C584A587257BC500329FD7_LNX,CCBD4417BDC8064F87257BC500300645_AIX,CCBD4417BDC8064F87257BC500300645_LNX,CEC8AF52CB16D01187257BDD00193714_AIX,CEC8AF52CB16D01187257BDD00193714_LNX,EDFFCB289FF01C8387257BC6000B459F_GRP,F69BF838DD28B5D187257BDD0018BED1_GRP&function=fixId&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/swg/quickorder?parent=Mid-range%2Bdisk%2Bsystems&product=ibm/Storage_Disk/IBM+Storwize+V7000+(2076)&release=All&platform=All&function=fixId&fixids=StorageDisk-2076-DriveMicrocode-20131022,StorageDisk-2076-7.2.0.*,StorageDisk-2076-SwUpgradeTestUtility&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/swg/quickorder?parent=Storage+Node&product=ibm/Storage_Disk/Flex+System+V7000&release=All&platform=All&function=fixId&fixids=StorageDisk-4939-SwUpgradeTestUtility,StorageDisk-4939-7.2.0.*,StorageDisk-4939-DriveMicrocode-20131022&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/swg/quickorder?parent=Ethernet+Switches&product=ibm/Systems_Networking/IBM+BNT+RackSwitch+G8264&release=7.7.8&platform=All&function=fixId&fixids=G8264_Image_7.7.8.0&includeRequisites=1&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/swg/quickorder?parent=Ethernet+Switches&product=ibm/Systems_Networking/IBM+BNT+RackSwitch+G8052R,F+G8264R,F&release=7.7.8.0&platform=All&function=fixId&fixids=G8052_Image_7.7.8.0&includeRequisites=1&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/swg/quickorder?product=ibm/StorageAreaNetwork/SAN24B-4+Switch+(2498-B24)&release=7.x&platform=All&function=fixId&fixids=SAN_Systems_Networking_b_type_7.x_firmware&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=Flex+System+Manager+Node&product=ibm/systemx/8731&&platform=All&function=fixId&fixids=fsmfix_com.ibm.ofm.services_4.0.0086,FSMApplianceUpdate-1-3-0,fsmfix1.3.0.0*&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=Flex+System+Manager+Node&product=ibm/systemx/8731&&platform=All&function=fixId&fixids=FSMApplianceFixPackage-1-3-0*&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=Enterprise+Chassis&product=ibm/systemx/7893&&platform=All&function=fixId&fixids=ibm_fw_cmm_2pet12e-1.50.0e_anyos_noarch,mlnx_fw_ppc_m460ex-sx-3.3.3706_anyos_noarch,qlgc_fw_flex_9.1.2.08.00_anyos_noarch,ibm_fw_scsw_cn4093-7.7.5.0_anyos_noarch,ibm_fw_scsw_en4093r-7.7.5.0_anyos_noarch,ibm_fw_scsw_en2092-7.7.5.0_anyos_noarch,ibm_fw_scsw_en4091-2.0.2.0_anyos_noarch,ibm_fw_scsw_si4093-7.7.5.0_anyos_noarch,brcd_fw_bcsw_7.0.0_pha4_anyos_noarch&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=x220+Compute+Node&product=ibm/systemx/2585&&platform=All&function=fixId&fixids=ibm_utl_uxsp_kssp09p-2.70_rhel5_32-64,ibm_utl_uxspi_9.41_rhel6_32-64,ibm_utl_uxsp_kssp07p-2.70_vmware_32-64,ibm_utl_uxspi_9.41_rhel5_32-64,ibm_utl_uxsp_kssp08p-2.70_vmwesxi_32-64,ibm_utl_uxsp_kssp08p-2.70_sles10_32-64,ibm_utl_uxspi_9.41_winsrvr_32-64,ibm_utl_uxsp_kssp08p-2.70_sles11_32-64,ibm_utl_uxspi_9.41_sles10_32-64,ibm_utl_uxsp_kssp08p-2.70_vsphere5_32-64,ibm_utl_uxsp_kssp09p-2.70_windows_32-64,ibm_utl_uxspi_9.41_sles11_32-64,ibm_utl_uxsp_kssp10p-2.70_rhel6_32-64&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=x222+Compute+Node&product=ibm/systemx/7916&&platform=All&function=fixId&fixids=ibm_utl_uxsp_ccsp26p-1.00_sles_32-64,ibm_utl_uxsp_ccsp26p-1.00_virtual_32-64,ibm_utl_uxsp_ccsp27p-1.00_windows_32-64,ibm_utl_uxsp_ccsp26p-1.00_rhel_32-64,ibm_utl_uxspi_9.41_winsrvr_32-64,ibm_utl_uxspi_9.41_sles11_32-64,ibm_utl_uxspi_9.41_sles10_32-64,ibm_utl_uxspi_9.41_rhel6_32-64,ibm_utl_uxspi_9.41_rhel5_32-64&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=x240+Compute+Node&product=ibm/systemx/8737&&platform=All&function=fixId&fixids=ibm_utl_uxsp_b2sp32p-1.43_windows_32-64,ibm_utl_uxsp_b2sp33p-1.43_rhel_32-64,ibm_utl_uxsp_b2sp32p-1.43_sles_32-64,ibm_utl_uxsp_b2sp32p-1.43_virtual_32-64,ibm_utl_uxspi_9.41_sles10_32-64,ibm_utl_uxspi_9.41_rhel6_32-64,ibm_utl_uxspi_9.41_sles11_32-64,ibm_utl_uxspi_9.41_rhel5_32-64,ibm_utl_uxspi_9.41_winsrvr_32-64&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/systemx/quickorder?parent=x440+Compute+Node&product=ibm/systemx/7917&&platform=All&function=fixId&fixids=ibm_utl_uxsp_cnsp29p-2.00_rhel_32-64,ibm_utl_uxsp_cnsp29p-2.00_sles_32-64,ibm_utl_uxsp_cnsp29p-2.00_windows_32-64,ibm_utl_uxsp_cnsp29p-2.00_virtual_32-64,ibm_utl_uxspi_9.41_sles10_32-64,ibm_utl_uxspi_9.41_rhel6_32-64,ibm_utl_uxspi_9.41_sles11_32-64,ibm_utl_uxspi_9.41_rhel5_32-64,ibm_utl_uxspi_9.41_winsrvr_32-64&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/main/quickorder?productList=Compute+Node%3Aibm/power/14577FL%3AAll%3AAll%3A01AF773_035_033|null%3Aibm/io%3AAll%3AAll%3A1F3A5122F2E8B91A87257BC90018978C_AIX,1F3A5122F2E8B91A87257BC90018978C_LNX,244C7C66995FB6BB87257BDD001B968D_GRP,42742682A19818F987257BDD001A337F_GRP,6100BD8B9216B84D87257BDD0016E05F_GRP,78A52D6D160451D287257BDD001AC470_GRP,CEC8AF52CB16D01187257BDD00193714_AIX,CEC8AF52CB16D01187257BDD00193714_LNX,F69BF838DD28B5D187257BDD0018BED1_GRP&function=fixId&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/main/quickorder?productList=Compute+Node%3Aibm/power/789522X%3AAll%3AAll%3A01AF773_035_033|null%3Aibm/io%3AAll%3AAll%3A1F3A5122F2E8B91A87257BC90018978C_AIX,1F3A5122F2E8B91A87257BC90018978C_LNX,244C7C66995FB6BB87257BDD001B968D_GRP,42742682A19818F987257BDD001A337F_GRP,6100BD8B9216B84D87257BDD0016E05F_GRP,78A52D6D160451D287257BDD001AC470_GRP,CEC8AF52CB16D01187257BDD00193714_AIX,CEC8AF52CB16D01187257BDD00193714_LNX,F69BF838DD28B5D187257BDD0018BED1_GRP&function=fixId&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/main/quickorder?productList=Compute+Node%3Aibm/power/789542X%3AAll%3AAll%3A01AF773_035_033|null%3Aibm/io%3AAll%3AAll%3A1F3A5122F2E8B91A87257BC90018978C_AIX,1F3A5122F2E8B91A87257BC90018978C_LNX,244C7C66995FB6BB87257BDD001B968D_GRP,42742682A19818F987257BDD001A337F_GRP,6100BD8B9216B84D87257BDD0016E05F_GRP,78A52D6D160451D287257BDD001AC470_GRP,CEC8AF52CB16D01187257BDD00193714_AIX,CEC8AF52CB16D01187257BDD00193714_LNX,F69BF838DD28B5D187257BDD0018BED1_GRP&function=fixId&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/swg/quickorder?parent=Mid-range+disk+systems&product=ibm/Storage_Disk/IBM+Storwize+V7000+(2076)&release=All&platform=All&function=fixId&fixids=StorageDisk-2076-DriveMicrocode-20130702,StorageDisk-2076-7.1.0.*,StorageDisk-2076-SwUpgradeTestUtility&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/swg/quickorder?parent=Storage+Node&product=ibm/Storage_Disk/Flex+System+V7000&release=All&platform=All&function=fixId&fixids=StorageDisk-4939-SwUpgradeTestUtility,StorageDisk-4939-7.1.0.*,StorageDisk-4939-DriveMicrocode-20130702&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/swg/quickorder?parent=Ethernet+Switches&product=ibm/Systems_Networking/IBM+BNT+RackSwitch+G8264&release=7.7.5&platform=All&function=fixId&fixids=G8264_Image_7.7.5.0&includeRequisites=1&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/swg/quickorder?parent=Ethernet+Switches&product=ibm/Systems_Networking/IBM+BNT+RackSwitch+G8052R,F+G8264R,F&release=7.7.5.0&platform=All&function=fixId&fixids=G8052_Image_7.7.5.0&includeRequisites=1&includeSupersedes=0&source=fc
http://www.ibm.com/support/fixcentral/swg/quickorder?product=ibm/StorageAreaNetwork/SAN24B-4+Switch+(2498-B24)&release=7.x&platform=All&function=fixId&fixids=SAN_Systems_Networking_b_type_7.x_firmware&includeSupersedes=0&source=fc


Chapter 10. Updating systems

Use the IBM Flex System Manager update manager to complete advanced updates
to managed resources. Update manager enables you to acquire, install, and manage
updates, as well as to monitor your systems to ensure that they remain current.

About this task

Update manager enables you to keep your systems at desired software or firmware
update levels by automatically checking for available updates and identifying
which systems need attention. It also provides you with the ability to monitor your
systems for needed updates and schedule the installation of updates at times that
are convenient for your network and users.

For a detailed summary of update procedures for all IBM Flex System components,
see the IBM Flex System Firmware Update Guides at http://www.ibm.com/
support/entry/portal/docdisplay?lndocid=MIGR-5091991.

Note: If you are setting up your IBM Flex System environment for the first time,
or if you need only to complete basic update operations for managed resources,
use the management software update wizards. For more information about each
update wizard, see the documentation in Initial Setup.

Update manager compares update information that is loaded into it with the
inventories of specified systems to determine whether updates are needed. To load
current information about available updates into update manager, you can use the
update manager Acquire updates task. Within that task, you can use either of the
following functions, both of which supply the same exact source for update
manager:
v Acquire updates: If an Internet connection is available, the acquire updates task

automatically contacts the update repository and downloads information about
the latest available updates into update manager.

Note: To acquire updates, the IBM Flex System Manager must have Internet
access. If a connection is unavailable, you can instead import the updates
manually. See Acquiring and installing updates for more information.

v Import updates from the file system: If no Internet connection is available, you
can manually download supported updates and then import them into update
manager.

Update manager then enables you to examine recently acquired updates and install
any that are needed.

Note: Because update manager determines needed updates by comparing
information about available updates with system inventories, the update
information must be current. To help keep update manager up to date, schedule a
recurring Acquire updates task that will regularly download update information
since the last acquire updates was run. Alternatively, you can regularly monitor
www.ibm.com/support/fixcentral/ and import updates that your systems might
need into update manager.

If your systems need updates, you can use update manager to manage the
installation.
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Important:

v For update manager to determine which updates are needed, you must ensure
that the software inventory for monitored systems is collected and current. Most
update manager methods cannot determine the applicability of updates to a
system unless inventory was previously collected on the system.

v The LAN over USB interface must be enabled on an X-Architecture compute
node before you can update the firmware on that compute node. For more
information, see Update considerations for X-Architecture compute nodes.

To view a table of the updates needed by your systems, you can use the update
manager Show and install updates task. From this table, you can select which
updates to install.

Notes:

v Before update manager installs updates, it displays information about whether
system restarts are required. You can allow or disable automatic restarts. If
automatic restarts are allowed, update manager calculates the installation
sequence that minimizes the number of restarts. Alternatively, you can manually
control the restarts.

v During installation, update manager automatically downloads the update
installation files and distributes them across your network to complete the
installation. As with restarts, you can also manually control these steps to
minimize disruption.

To receive an automatic notification when updates are required to keep your
systems current or at a specified update level, you can use update manager to set
up compliance policies. These policies specify which systems are monitored and
which updates you must install to keep the systems in compliance. Update
manager uses these policies to check the status of your systems and notifies you
when systems need updates, and which updates are needed. To set up compliance
policies, you can use the update manager Create and configure compliance
policies task. After a compliance policy is set up, the compliance pie chart then
appears on the Update Manager summary page and you can use that to monitor
compliance status and take any necessary corrective action.

Note: As a best practice, plan to update to the latest update or patch for your
release of IBM Flex System Manager at least twice a year. Maintaining this
schedule will help to eliminate unnecessary exposure to problems that are already
resolved in more current updates and patches. Staying farther back on
maintenance can also inhibit the ability of your service representative to provide a
formal fix without first requiring the application of a more current update or
patch.

Planning to update systems
Complete these planning steps before starting the actual update process to ensure
that the update process that you follow is successful and meets your needs.

About this task

For a detailed summary of update procedures for all IBM Flex System components,
see the IBM Flex System Firmware Update Guides at http://www.ibm.com/
support/entry/portal/docdisplay?lndocid=MIGR-5091991.
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Supported update tasks
You can use update manager to complete various update tasks, including
downloading and installing updates to existing software and setting up compliance
policies to monitor your systems. You can also use update manager to manage
individual updates or sets of updates that are known as update collections.

Update manager performs the following tasks:
v Manage and install updates to existing software products and firmware, external

network and storage switches, and external storage servers.
v Install updates to IBM Flex System Manager.
v Install updates to IBM Flex System Manager agents that have already been

installed.
v Acquire and install an individual update or update collection with the following

sequence of tasks:
1. Downloading, which copies the installable files for an update to the

management server.
2. Installation staging, which copies the installable files for an update to an

appropriate location for eventual installation.
3. Installing, which installs an update.
4. Uninstalling, which removes an update.

Note: Not all updates support the uninstallation task.
v Manage compliance policies, which provide notification of when systems are in

need of updates and which updates are needed.
v Schedule a check for updates, which is a search for new updates of which

update manager is not currently aware. If any new updates are found, update
manager obtains the necessary information that is required to include these
updates.

v Provide details about a specific update, such as its documentation and
prerequisite requirements (requisite updates).

v Display information about updates that were installed by IBM Flex System
Manager.

Note: Updates installed by other means are not displayed.

Update manager does not perform the following tasks:
v Install new software products.
v Install IBM Flex System Manager agents on systems that currently do not have

an agent.
Instead, install IBM Flex System Manager agents with the agent manager plug-in
of IBM Flex System Manager.

v Perform actions on systems that are not accessible. You can perform update
actions on only those systems that are accessible.

Notes:

– If a system is not accessible, the update menu actions are not displayed for it.
You cannot select a system that is not accessible in any of the system selection
actions, for example on the System page in the Installation wizard, on the
Installation staging wizard, and so on.

– If you want to monitor update management and compliance status on any
systems that are not accessible, you must first run inventory collection on
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them. Most update manager methods cannot determine the applicability of
updates to a system unless inventory was previously collected on the system.

v Update another, different instance of IBM Flex System Manager.

Update considerations for specific operating systems and
platforms

When you are installing updates for certain hardware and operating systems, there
are unique tasks to be performed and restrictions to consider.

Predefined update groups can be used to facilitate working with updates for a
particular platform or operating system.

Update considerations for AIX systems
Updating AIX systems with IBM Flex System Manager requires the use of Network
Installation Management (NIM) software and a Common Agent. IBM Flex System
Manager supports updating AIX 6.1 and later releases.

Terms used for updating AIX

These are terms you will encounter when you are working with AIX updates:

Network Installation Manager (NIM) master
An AIX system that has been designated as a focal point to receive updates
and install them on other AIX systems, known as NIM clients.

Network Installation Manager (NIM) client
An AIX system that is installed from a NIM master.

Technology Level
The twice yearly AIX releases, which contain new hardware and software
features and service updates. The first of the twice yearly technology levels
is restricted to hardware features and enablement, as well as software
service. The second of the twice yearly technology levels includes
hardware features and enablement, software service, and new software
features.

Make sure that you install all parts of a technology level. Back up your
system before installing a technology level.

Service Pack
A collection of service-only updates (also known as PTFs) that are released
between Technology Levels to be grouped for easier identification. These
fixes address highly pervasive, critical, or security-related issues.

Maintenance Level 
The service updates (fixes and enhancements) that are necessary to
upgrade the Base Operating System (BOS) or an optional software product
to the current release level.

Recommended level
The level of a service pack that is recommended for a given AIX
technology level. Not all technology levels have a recommended service
pack level.

Latest level
The most recent level of service pack or technology level.
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Tips for updating AIX

Be aware of these tips and restrictions when you are working with AIX updates:
v Do not upgrade the AIX host operating system that IBM Flex System Manager is

running on. Doing so would break the connection between IBM Flex System
Manager agent and IBM Flex System Manager.

v Back up your system before installing a technology level.
v Updates can be installed only within a release of AIX. You cannot perform a

migration to a new version of AIX with update manager.
v You cannot perform a new overwrite installation of AIX with update manager.
v AIX 6.1 and later releases are supported.
v To perform an installation or installation staging for AIX updates, your system

must adhere to the following requirements:
– Ensure that your AIX has a NIM master.

Note: During installation, IBM Flex System Manager automatically adds the
target AIX system as a NIM client of the NIM master.

– Ensure that your AIX has a NIM environment.
– Ensure that the AIX NIM master and the AIX managed systems (NIM clients)

contain Common Agent.
– Ensure that the NIM master is correctly initialized and configured.
– If you are updating an agentless or Platform Agent system, ensure that the

/tmp directory has full public read/write/execute permissions and enough
allotted disk space to accommodate the staged update.

v The updates will always be staged to a NIM master. IBM Flex System Manager
update manager creates a separate file system named /export/um_lpp_source if
it does not exist. The size is initially set to 1G, but IBM Flex System Manager
update manager will increase the size if the available space is not large enough
to hold the update files.

v Installation of an update that requires a license acceptance must be done
manually on the AIX target system. There are cases in which an update
contained in a technology level or a service pack can require license acceptance.
The ability to accept a license is not supported from the user interface and must
be performed by installing the file set through the System Management Interface
Tool (SMIT) interface and responding yes to the query ACCEPT new license
agreements?.

v If you plan to import updates on an AIX system, note that you can import only
those updates that contain descriptor files. Fix Central is typically the only
location from which you can obtain updates with descriptor files, so updates
obtained from the DVD might not properly import.

v Update manager cannot install AIX iFixes in the .EPKG.Z format. IBM Flex
System Manager can import and apply fixes on AIX only when the fix packages
are published on ECC (Electronic Customer Care) and include all supported files
such as the .sdd file. When such a fix package is available, you can install it with
the following command:
emgr -i -C package_name.epkg.Z

For more information about the emgr command and installing iFixes on AIX, see
emgr Command.
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Update considerations for Hardware Management Console
systems
Hardware Management Console systems can have these items installed: updates,
upgrades, and interim fixes.

Note these restrictions and hints for working with Hardware Management Console
updates:
v Only Hardware Management Console Version 7 Release 3.3 SP2, and later

versions and releases, are supported.
v Only Virtual I/O Server Version 1.5.2.1 and later fix packs are supported.
v Hardware Management Console upgrades are not supported for the installation

staging task. If installation staging is attempted, a message is displayed with
instructions for creating and using a CD to manually perform this task.

v An ISO image is a disk image for an ISO 9660 file system, and contains the
installable files for a particular update or upgrade. A download is automatically
performed for the ISO image, and the files that are downloaded can be used for
installation on the management server. You must manually create a CD with this
ISO image and then install the update from the CD.

v Hardware Management Console upgrades are not supported for the installation
task. If you attempt an installation task, after having successfully performed a
manual installation staging task, a message is displayed with instructions for
installing the upgrades on each Hardware Management Console system. If you
attempt an installation task and installation staging has not been performed
manually, a message is displayed with the installation staging instructions using
CDs mentioned above.

v Uninstalling and rolling back Hardware Management Console updates,
upgrades, or interim fixes is not supported.

v Updating a Hardware Management Console system might remove existing CIM
indication subscriptions. To ensure that IBM Flex System Manager correctly
registers the CIM indication subscriptions and continues to accurately display
the status of the updated Hardware Management Console system, revoke and
then reinstate access to the system.

v Extended discovery or inventory discovery must be performed for the target
Hardware Management Console before using any Hardware Management
Console functions in update manager.

v When you update the Hardware Management Console by using IBM Flex
System Manager Update Manager, select the Latest option as the update type.
To use this option, complete the following steps:
1. From the Acquire Updates page, select Check for updates (Internet

connection required option).
2. In Available update types, select HMC > Update > Latest.
3. Click Add to move the Latest option in the Selected update types list.

Attention: If the Latest option is not used, then IBM Flex System Manager
Update Manager cannot create a relationship between the acquired Hardware
Management Console updates. Therefore, higher version in the Hardware
Management Console shows as Applies To while the lower version Hardware
Management Console updates show as Needed Updates. To show the
appropriate updates in the Show and install updates page, do not use the HMC
> Update > Recommended option.

Update considerations for IBM i systems
Consider these factors when updating IBM i (formerly i5/OS) systems.
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v IBM Flex System Manager must support the IBM i version that you want to
update.

v To distribute and apply IBM i PTFs, a credential must be created authorizing the
user after IBM Flex System Manager has obtained access to the IBM i system.
The IBM i system must be an agentless-managed, platform-managed, or
common agent services managed system with access granted. Refer to the topic
“Creating single sign-on credentials” on page 61 for instructions to create the
credentials.

v IBM i PTFs are first installed with the apply type *IMMDLY. PTFs that cannot be
installed as *IMMDLY are installed as *DLYIPL. You cannot configure the PTF
apply type that IBM Flex System Manager uses.

v Updates that are permanently installed on the system cannot be uninstalled.
v If an update requires a system restart, the administrator must perform the restart

manually. No automatic system restarts are performed for IBM i systems.
v You can also designate an IBM i network install server as a focal point to receive

updates and to install them on the other IBM i systems. To designate an IBM i
network install server, go to the Update Manager summary page and click
Configure settings. On the IBM i tab, select an IBM i system from the list.

For more information about updating IBM i systems, see Best practices for working
with updates for IBM i.

Update considerations for Linux systems
Each Linux Distribution Partner provides updates for its specific Linux
distribution. To download updates and install them, you must have an Internet
connection and be registered with the Linux Distribution Partner.

Consider these factors when updating Linux systems.
v IBM Flex System Manager supports the application of updates only to Red Hat

Enterprise Linux versions 5.x and 6.x, SUSE Linux Enterprise Server 10 with any
of the applicable service packs, and SUSE Linux Enterprise Server 11.

v Only users with administrative authority can manage Common Agents.
v On 64-bit Linux, the 32-bit compatibility libraries are required.
v The target system must have network connectivity with the management server

and either direct or proxy connectivity with the Internet. The Internet connection
is needed to obtain the updates from the Linux Distribution Partner.

v Update manager for Linux systems does not support repositories that are
registered multiple times. Before you update the Linux system, the target system
must clean all registered repositories and then register one repository for the
updating process.

v If the target system has a dependency issue when you update a Linux system,
copy the dependent packages to the repository that is registered. You can also
register a repository that contains dependent packages and then complete the
update operation.

Note: If you register multiple repositories for a target system that has a
dependency issue, do not collect inventory on the target system again. Later,
remove the repositories when the update operation completes.

v To apply Linux updates, each system must be registered with the update server
for the appropriate Linux distribution's update service.
See these websites for more information:
– For Red Hat Enterprise Linux distributions, https://www.redhat.com or

https://rhn.redhat.com
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– For SUSE Linux distributions, http://www.novell.com or
http://www.novell.com/customercenter

v Ensure that the following commands are installed on each system that is to
receive an update:
– zip
– gunzip
– rug (for SUSE Linux Enterprise Server 10 with the service pack)
– zypper (for SUSE Linux Enterprise Server 11)
– yum (for Red Hat Enterprise Linux versions 5.x and 6.x)

v Uninstalling updates and rolling back updates are not supported.
v To receive updates, the Linux system must either be an Agentless managed

system, a Platform Agent managed system, or a Common Agent managed
system.

v If you are updating an agentless or Platform Agent system, ensure that the /tmp
directory has full public read/write/execute permissions and enough allotted
disk space to accommodate the staged update.

Update considerations for IBM Power I/O firmware
Consider these factors when updating IBM Power I/O firmware.
v AIX is required on the target system to update IBM Power I/O firmware.

Updates to network devices in Power Systems compute nodes that run Linux
are not supported.

v Common Agent is required on the target system to install IBM Power I/O
firmware.

v You must perform extended discovery or inventory collection for the target
system before working with IBM Power I/O firmware updates.

v If you will update a shared device, ensure that it is not used on other partitions.
v You cannot use update manager to downgrade or roll back an IBM Power I/O

firmware level.
v The IBM Flex System Manager Web interface allows you to select multiple

criteria values at the same time. If you select the criteria value of All, other
selected criteria values are ignored.

Update considerations for Power Systems firmware
Consider these factors when updating Power Systems firmware.

The following list contains general considerations for updating Power Systems
firmware. See Managing host updates for more specific information.
v You must perform extended discovery or inventory collection for the target

system before working with Power Systems firmware updates.
v IBM Flex System p260 and p460 Compute Nodes that come with management

software 1.1.0 are compatible with 740 firmware and 74x updates only.
v Uninstalling and rolling back Power Systems firmware updates or upgrades is

not supported.

Update considerations for X-Architecture compute nodes
Consider these factors when updating X-Architecture compute nodes.
v Before you attempt to update the firmware for an X-Architecture compute node,

make sure that the LAN over USB interface is enabled on the compute node.
To check if the interface is enabled, and to enable the LAN over USB interface if
necessary, complete the following steps:
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1. Log in to the Chassis Management Module (CMM) web interface (see for
more information).

2. From the CMM web interface home page, click Chassis Management >
Compute Nodes.

3. Click the compute node name.
4. Click the General tab.
5. Select Enable Ethernet Over USB to enable the LAN over USB interface.

v You can use update manager to install updates to X-Architecture compute nodes,
but you cannot use update manager to uninstall or roll back X-Architecture
compute node updates.

v X-Architecture compute node and IBM Flex System firmware updates for UEFI
and IMMv2, and PBDSA firmware updates on IMMv2 systems, are available in
an operating system agnostic format. This means that you can install any of
these types of updates on any operating system that resides on a system with
the applicable machine type. To install these updates, which are not
self-executable binary files, you must use IBM UpdateXpress System Pack
Installer (UXSPi). In IBM Flex System Manager, ensure that the latest version of
UXSPi is imported, then use the UXSPi settings tab to view obtained operating
system agnostic updates and manually import new ones. When you use the
UXSPi update for the new System x hardware, you must use the Lenovo UXSPi
package name that starts with lnvgy_utl_ instead of the older hardware that
belongs to IBM USXPi package and starts with ibm_utl_.

Note: You must also use UXSPi to run compliance checks on such
X-Architecture compute node and IBM Flex System firmware updates. Ensure
that the latest version of UXSPi is imported before running compliance.

v The designated severity levels of X-Architecture compute node updates can
dynamically change depending on the updates that are already installed on the
system. For example, if no previous versions of an update exist on a system, the
current version of the update might have a higher level of severity than it would
if a previous version of the update existed.

Note:

v To install updates by using UXSPi on a Windows system, ensure that either
common agent services (CAS) or a DCOM Service Access Point (SAP) is
discovered on the system.

v IBM Flex System Manager update manager does not support UXSPi update on
Hyper-V type systems. This configuration is not supported for the UXSPi and
you must perform the update independent of IBM Flex System Manager. To
update the UXSPi package on Hyper-V type systems, you must update the
firmware by using the UXSPi tool on the Windows system that is hosting the
Hyper-V system.

Update considerations for Virtual I/O Server systems
Updating Virtual I/O Server systems with IBM Flex System Manager by using a
migration image requires the use of Network Installation Management (NIM)
software. The NIM server must be running AIX 6.1 or later.

A NIM master is not required when updating Virtual I/O Server systems with fix
pack, service pack, or interim fix updates.
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Terms used for updating Virtual I/O Server

These are terms you will encounter when you are working with Virtual I/O Server
updates:

Network Installation Manager (NIM) master
An AIX system that has been designated as a focal point to receive updates
and install them on other Virtual I/O Server systems, known as NIM
clients.

Network Installation Manager (NIM) client
A Virtual I/O Server system that will use a NIM master for migration.

Fix pack
A fix pack updates your Virtual I/O Server release to the latest level. A fix
pack update can contain product enhancements, new functions, and fixes.

Service Pack
A Service Pack applies to only one Virtual I/O Server level. A Service Pack
contains critical fixes for issues found between fix pack releases. A Service
Pack does not update Virtual I/O Server to a new level, and it can only be
applied to the fix pack release for which it is specified.

Interim fix (iFix)
An interim fix (iFix) applies to only one Virtual I/O Server level and
provides a fix for a specific issue.

Migration image
A Migration image supports the upgrade from a Virtual I/O Server version
to a newer version.

Tips for updating Virtual I/O Server

Be aware of these tips and restrictions when you are working with Virtual I/O
Server updates:
v Only Virtual I/O Server 1.5.2.1-FP11.1 and later releases are supported.
v You cannot use IBM Flex System Manager update manager to perform a fresh

installation of Virtual I/O Server.
v To perform an installation or installation staging for the Virtual I/O Server

migration image, your system must meet the following requirements:
– A NIM environment is required.
– An AIX NIM master is required to migrate Virtual I/O Server to higher

release, such as from Virtual I/O Server 1.5.2.1-FP11.1 to 2.1.0.0.
– Do not update the NIM master when you are migrating Virtual I/O Server

using that NIM master.
– The operating system level for the NIM master must be AIX 6.1 or later.

v Do not migrate to Virtual I/O Server 2.1.0.0 directly from a lower version such
as 1.5.2.1-FP11.1 because Virtual I/O Server 2.1.0.0 is not officially supported by
IBM Flex System Manager. Install the fix pack or Service Pack for Virtual I/O
Server 2.1.0.0 directly when you are migrating from a version earlier than Virtual
I/O Server 2.1.0.0. The update manager for Virtual I/O Server extension will
automatically install Virtual I/O Server 2.1.0.0 and the selected fix pack or
service pack for you.

Note: You also need a NIM environment because migrating to Virtual I/O
Server 2.1.0.0 is based on NIM operation

388 Systems Management Guide



v If there are any LPARs managed by the Virtual I/O Server system, you must
close them before installing updates on the Virtual I/O Server system.

v Back up your system before migrating it to a higher release.
v When performing migration, the migration image will always be staged to a

NIM master. The image requires 16G of available space and will be put into a
separate file system named /export/um_lpp_source. If the file system does not
exist on the NIM master, IBM Flex System Manager update manager will create
it. If the file system does not have enough available space, IBM Flex System
Manager update manager will increase the size of the file system.

v For the installation of a fix pack, service pack, or iFix, 5G of available space is
required on the /opt file system of the target Virtual I/O Server system.

v The update manager for IBM Flex System Manager extension will automatically
accept the license if the update requires it.

v IBM Flex System Manager update manager does not support rollback for Virtual
I/O Server extensions.

v The size of some updates might exceed the file size limit of the system on which
IBM Flex System Manager is installed. Therefore, you should set the file size
limit to unlimited before proceeding. Refer to the system documentation for
information about checking and setting file size limits.

v If you distribute an update that is a migration image, the progress bar will reach
100% complete while the status is still running. The task will actually be
complete when the status is changed to Complete.

v Although the IBM Flex System Manager Web interface allows you to select
multiple criteria values at same time, only one of them will take effect:
– When the criteria value All is selected, other selected criteria values will be

ignored.
– When the criteria value All is not selected and the criteria value Latest

Upgrade is selected, only the latest upgrade takes effect. All other selected
criteria values will be ignored.

v Only migration tasks are staged to the NIM master. All other update tasks, such
as for firmware or fix packs, are staged directly to the managed server.

Update considerations for VMware ESXi systems
Consider these factors when updating VMware ESXi systems.
v The following firmware update types are supported when updating version 5.5

update 1 of either the standard VMware ESXi (vSphere) product or an IBM
customized version of VMware ESXi (vSphere):

Table 52. VMware ESXi supported firmware

Firmware update type
Standard VMware ESXi
(vSphere)

IBM customized version of
VMware ESXi (vSphere)

Brocade N Y

Broadcom N N

DSA Y Y

Emulex N Y

FPGA Y Y

IMM Y Y

QLogic CNA N Y

QLogic FC N Y

uEFI Y Y
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v Updates are not supported on IBM customized VMware ESXi (vSphere) versions
4.0 or 4.1.

v To manage firmware updates for systems running standard VMware ESXi, you
must first discover and access both the OperatingSystem resource and the
related Server resource, which is, for example, an IMM.

Note: Discovering and accessing only the VMware ESXi OperatingSystem
resource will not create the correct Server resource because the OperatingSystem
resource and the Server resource are typically assigned different IP addresses.
See Viewing system discovery results for more information.

v To manage firmware updates for systems running the IBM customized version
of VMware ESXi, the OperatingSystem resource must be discovered; this
discovery occurs automatically in an IBM Flex System environment.

v For updates to management modules, the management software enables SSH
File Transfer Protocol (SFTP) automatically. You can also install updates to
management modules from a server with Trivial File Transfer Protocol (TFTP) or
File Transfer Protocol (FTP). If necessary, use the Settings function to specify
TFTP or FTP server properties.

Notes:

– If you are updating the IBM customized version of VMware ESXi, SFTP is the
only supported protocol.

Note: IBM UXSPi is applicable to IBM systems, whereas Lenovo UXSPi is
applicable to Lenovo systems. Therefore, use the correct UXSPi on the respective
systems. As IBM UXSPi has stopped release of new versions after 9.63, newer
operating systems on IBM systems cannot be supported by IBM UXSPi. For
example, IBM UXSPi does not support SUSE Linux Enterprise Server 12 on IBM
manufactured systems. For more information, refer to UXSPi release documents.

v IBM UXSPi cannot be used to update agents on Hyper-V systems.
v Use IBM ToolsCenter Bootable Media Creator (BoMC) or UpdateXpress System

Pack Installer (UXSPI) to update VMware ESXi versions that IBM Flex System
Manager does not support.

v Before updating firmware on an IBM customized version of VMware ESXi
(vSphere), ensure that you apply the latest VMware ESXi drivers and the latest
VMware ESXi IBM customized image patches to the ESXi system.

Update considerations for multi-node systems
Consider these items before updating system firmware on multi-node systems.

In a multi-node system, also called a scalable system, update manager is
responsible for keeping the following four types of system firmware at the same
level on all physical servers across the system:
v DSA
v IMM
v UEFI

To achieve this, if any system firmware update is needed on the physical server,
update manager marks the needed relationship on the top level system, also called
the cluster system. Then, during installation, the update is applied to all the
physical servers in the multi-node system.
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Note: Update manager does not support multi-node systems that have ESXi
installed on them.

Consider the following items when updating the system firmware on multi-node
systems:
v Before starting any system firmware update processes, ensure that the

multi-node systems are discovered with both inband mode and OOB mode. See
Discovering a scalable BladeCenter system with multiple nodes for more
information about how to discover multi-node systems.

v Ensure that all inventory has been collected on the scalable partition systems
and cluster systems.

v When checking compliance, the system firmware listed above is shown on the
cluster manageable endpoint of the multi-node system instead of on the physical
server system.

v The systems firmware updates are installed to all the physical server systems
when you install the update on the multi-node system. All the partition systems
are then rebooted after the installation.

v If you are installing multiple update packages, install the DSA, IMM, and UEFI
updates first. After these updates have completed successfully you can begin
installing the remaining updates to each system.

Update considerations for Nimitz firmware
Consider these factors before you update system firmware on Nimitz systems.

Prerequisites

Make sure that the following prerequisites are met before you install the update:
v Discover and unlock the storage cluster.
v Complete the system inventory collection.
v Download the most recent upgrade test utility and update the storage Integrated

Technology Element (ITE) with Check for update or Import update options.

To install the storage ITE update, complete the following steps:
1. Run the installupd command to install the storage ITE update.
2. Use IBM Flex System Manager web console or run the following command:

smcli installupd

smcli installupd -i [ip_address | host_name] -u [update_oid | update_fix_id] -V [ignore_check_setting]
Option:

-V [ignore_check_setting]
ignore_check_setting: IGNORE_CHECK=true | IGNORE_CHECK=false (default)

The following examples show the usage of the command:
v Installation of the Nimitz firmware update without taking into account the

result of a central control unit (CCU) check.
smcli installupd -i x.x.x.x -u StorageDisk-x-x.x.x.x -V IGNORE_CHECK=true

v Installation of the Nimitz firmware update according to the result of a CCU
check.
smcli installupd -i x.x.x.x -u StorageDisk-x-x.x.x.x -V IGNORE_CHECK=false

Determining the installed IBM Flex System Manager version
Before you update an installation of IBM Flex System Manager, determine the
version of the IBM Flex System Manager or agent that is installed.
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About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To determine the installed version of IBM Flex System Manager:
v Web interface: From the Home page, click the Plug-ins tab. The current version

number of the management software is displayed beside IBM Flex System
Manager, at the top of the list of plug-ins.

v CLI: Run the command smcli lsconfig.

To determine the installed version of IBM Flex System Manager agent:
v From IBM Flex System Manager:

– Web interface: Open the navigation area (hidden by default) by clicking the
tab with the arrow on the left side of the screen. Expand Release
Management; then, click Agents. Click All Agent Packages. The version
numbers for the installed agents are displayed in the Version column.

– CLI: Run the lssys command, with the ManagementSoftware attribute. For
example: smcli lssys -A ManagementSoftware -i 9.22.103.245.

Note: Maintenance is not delivered for every manager at each update or patch. For
example, the update for a particular version might be released for automation
manager without the release of a corresponding update for configuration manager.

Starting to monitor and update systems
To monitor and update systems, you must set up update manager correctly,
including choosing the systems to monitor. You must also ensure that an Acquire
updates task is run on a recurring basis, and that someone is periodically checking
systems that have compliance issues. Lastly, you must install needed updates.

Before you begin

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

For systems that are to be monitored for update management and compliance
status, you must:
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v Make sure that the systems are discovered and accessible.
v Collect inventory on the systems. Most update manager methods cannot

determine the applicability of updates to a system unless inventory was
previously collected on the system.

Tip: To protect your system in the event of an unforeseen complication, ensure
that you back up your data before performing any update tasks.

Procedure
1. From the Plug-ins tab on the IBM Flex System Manager Web interface Home

page, click Update Manager. The update manager summary page is displayed.
2. Click the Optional: Getting started link and complete the Getting Started

wizard. See “Getting started with updates” for more information.
3. Click the Configure settings link and complete the Settings task. See

“Changing update settings” for more information.
4. Optional: Create additional update groups to facilitate update management. See

“Managing update groups” for more information.
5. Acquire and install updates for the product or system that you want to update:

Update IBM Flex System Manager
If you want to simply update IBM Flex System Manager, use “Update
IBM Flex System Manager” to let update manager take most defaults
and run most update tasks for you automatically. See “Updating IBM
Flex System Manager” for more information.

Update other systems
If you want to update other systems, or if you want to update IBM Flex
System Manager but have full control over the whole process, use the
various update manager tasks in the IBM Flex System Manager Web
interface or the installneeded command to update your systems. See
“Acquiring and installing updates” for more information.

6. Schedule an Acquire updates task to run periodically, at least once a week. See
“Acquiring new updates” for more information.

7. Review the Update Compliance section of the update manager summary page
to check if your systems meet your update specifications. See “Keeping systems
in compliance” for more information.

8. If some systems need updates, review the exact compliance issues and address
them by planning to install the needed updates.

9. Periodically, perform Steps 7 and 8, or create an Event Automation Plan to
perform this task and notify you of any systems that are in need of updates.
See “Creating an event automation plan” for more information.

Configuring update manager
Before starting to manage updates, run the Settings function and the optional
Getting Started With Updates wizard to customize your configuration.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:
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To specify settings, go to the Update Manager summary page, click Configure
settings and complete the various tabs for your configuration.

Then, use the optional Getting Started With Updates wizard to accomplish the
following tasks:
v Select a set of systems to monitor with compliance policies
v Create update groups for updates that are appropriate to the selected systems
v Configure Internet connectivity
v Run or schedule a check for updates

To run the Getting Started With Updates wizard, complete the following steps:

Procedure
1. From the Home page in the web interface, click the Plug-ins tab; then, click

Update Manager.
2. On the Update Manager summary page, click Optional: Getting started. The

Getting Started With Updates wizard displays a welcome panel.
3. Optional: If you do not want to see the Welcome page next time, clear Show

the welcome page next time.
4. Click Next. The Name and Description page is displayed.
5. Type a name and optional description for the update group that is to be

created. This group is initially empty but will acquire the updates for the
systems that were selected. It is also attached to these systems through a
compliance policy. Update manager will monitor the systems and indicate
when a system is missing a needed update from the group.

6. Click Next. The Systems page is displayed.
7. Optional: The IBM Flex System Manager is selected by default. Select it and

click Remove if you do not want monitoring of this system.
8. Select at least one system, which must be accessible, and click Add. These

systems will be automatically associated with an update group through
system compliance policies. If a selected system cannot be monitored, an error
message is displayed.

9. Click Next. The Connection page is displayed.
10. Indicate how the Internet is to be accessed to acquire updates:

v Click Use direct connection if a direct Internet connection exists and you
want it used.

v Click Use Proxy server if your proxy server requires authentication. A
proxy can be an HTTP proxy or a Hypertext Transfer Protocol Secure
(HTTPS) proxy, and must be configured and made available by your
organization.
a. Type the host name and port number of the proxy server.
b. Click Authenticate using the following credentials if you want to

access the proxy server with a user ID and password. Type the user ID
and password for the proxy server.
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Note: To acquire updates, the IBM Flex System Manager must have Internet
access. This access can be through a direct connection or through a Hypertext
Transfer Protocol (HTTP) proxy. If a connection is unavailable, updates can be
imported.

11. Optional: Click Test Connection if you want to test the connection settings
that you have specified.

12. Click Next. The Summary page is displayed.
13. This page lists the types of updates that will be added to the update group to

monitor the selected systems, and when a check for updates is run. Verify the
information on this page:
v If the information is correct, click Finish. The common launch-task window

is displayed to schedule an acquire updates for the selected systems.
Schedule this task to run on a recurring basis, not just once.

v If the information is incorrect, click Back to return to previous pages and
correct the information.

14. Specify notification and schedule settings for the task that is being launched.
In addition to launching a check for updates task, the wizard creates an
update group using the default update criteria for the systems that were
selected. A compliance check is created for each selected system to ensure that
it complies with this newly created group.

Updating IBM Flex System Manager
Use Check and Update Flex System Manager on the Initial setup tab in the IBM
Flex System Manager Web interface to automatically obtain and install all types of
updates for IBM Flex System Manager.

Before you begin

Consider these points when updating IBM Flex System Manager:
v If Update Manager fails to acquire the version 1.2.0 updates, run the following

CLI command before you import the updates with the management software
CLI:
smcli cleanupd -mva

After you run the preceding command, compliance policies indicate that all
systems are in compliance because there are no longer any updates in the
library. After you upgrade the management software to version 1.2.0, you must
acquire updates for your compliance policies before the management software
will show needed updates. See cleanupd command for more information about
the command.

v IBM periodically makes UEFI code, IMM2 firmware, diagnostic firmware
updates, and device driver updates available for the management node. Follow
the instructions in the readme file that comes with the firmware update.

v Most update manager methods cannot determine the applicability of updates to
a system unless inventory was previously collected on the system.

v You must restart IBM Flex System Manager to activate installed updates.
v You can use either the web interface or the command-line interface (CLI) to

update firmware and software. See Update commandsor the IBM Flex System
Manager Command Reference Guide document for specific CLI commands related
to updating firmware and software.

v When a hardware component in the management node is replaced, make sure
that the firmware of the new component is up to date. To update the firmware
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for the new hardware component, you must acquire an IBM Flex System
Manager update bundle; then, from the command-line interface, run the
following command
smcli installupd update_bundle_file_name -F

where update_bundle_file_name is the file name of the update bundle that you
downloaded.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To instruct update manager to take most defaults and update IBM Flex System
Manager almost automatically, complete the following steps.

Procedure
1. From the Initial setup tab on the Home page, click Check and Update Flex

System Manager; then, click Update IBM Flex System Manager. When the
acquire updates task completes, the updates needed by the IBM Flex System
Manager are displayed in the table.

Note: If the management node is not connected to the Internet, the update
action will fail.

2. Optional: If your management node does not have a connection to the Internet,
you can download IBM Flex System Manager updates and copy the updates to
the management node.
Find the update package on the Fix Central web site and download it:
a. Go to Fix Central at http://www.ibm.com/support/fixcentral/.
b. From the Product Group list, select PureSystems. The Product list is

displayed.
c. From the Select from PureSystems list, select PureFlex System.
d. From the Select from PureFlex System list, select Management devices and

solutions.
e. From the Management devices and solutions list, select Flex System

Manager Node.
f. Select the machine type for your management node; then, click Continue.

The Installed Version list is displayed.

Note: You can ignore the operating system list.
g. From the Installed Version list, select the version of IBM Flex System

Manager that is currently installed.
h. Select the fix group that you want to download and click Continue. The

Download options page is displayed.
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i. Select the Download using Download Director and Include prerequisites
and corequisite fixes (you can deselect the ones you don't need later)
options, and then click Continue. The Terms and conditions page is
displayed.

j. After you agree to the terms and conditions, the Download files using
Download Director page is displayed.

k. Click Download now to start the download of the update package. The
update package downloads to the designated location.

3. From the management software web interface, install the update or schedule
the update installation.

4. After the installation is complete, restart IBM Flex System Manager to activate
the updates.

Updating without an Internet connection
If the management node does not have an Internet connection, you can manually
download IBM Flex System Manager update packages. After an update package
has been downloaded and extracted, you can use update manager to schedule
when to import and install the updates.

About this task

Procedure
1. Download the necessary fix files from Fix Central. See “Getting fixes from Fix

Central” for more information.
2. Use one of the following methods to copy all of the downloaded update files to

the /home/USERID directory on the management node:
a. Use a Secure Copy (SCP) tool on a laptop or workstation attached to the

management or data network.

Important: Make sure that the SCP tool transfers the files to the
management node in a binary format. If the files are transferred as text, the
transfer process might modify the readme files and corrupt them.

b. Use the scp command in the management software CLI to retrieve the fix
package from an SSH server on the management or data network. See the
following examples. From a management software console, logged in as
USERID:
scp USERID @<remote_host_name>:/directory/* /home/*

From a remote server or workstation:
scp * USERID@<management_node_host_name>:/home/USERID/*

c. Copy the update files from a USB storage device that is formatted for
FAT16, FAT32, ext2, or ext3 file systems.

Note: The maximum file size that is supported by FAT16 is 2 GB; the
maximum for FAT32 is 4 GB. If your update files are larger, format your
USB storage device for the ext2 or ext3 file system.
1) Insert a USB storage device into the USB port on the front of the

management node.
2) SSH to the management node.
3) Log in with the default USERID and password.
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4) Use the lsmediadev command to list the storage media devices that are
available for use on the system and identify the USB storage device. The
resulting output will be similar to the following, where vdi1 is the USB
storage device:
device=/dev/cdrom,mount_point=/media/cdrom,
type=1,description=CD/DVD
device=/dev/vdi1,mount_point=/media/vdi1,
type=3,description=USB flash memory device

5) Type mount /dev/vdi1 and press Enter.
6) Use the command cp to copy the files. For example:

cp /media/vdi1/<file_name> /home/USERID

7) Type umount /dev/vdi1 and press Enter to unmount the USB storage
device.

3. Import and install the updates using either the command line or the IBM Flex
System Manager Web interface:

Command line
Run the following command to import and install the updates:
smcli installneeded -v -F /home/USERID

IBM Flex System Manager Web interface
Complete the following steps to import and install the updates:
a. From the IBM Flex System Manager Web interface Home page, click

Update IBM Flex System Manager.
b. On the Update IBM Flex System Manager page, click Stop to stop

the task that checks for new updates and instead display options for
downloading and importing updates.

c. In the Path field, either type the full local directory path and file
name of the downloaded update package zip file, or click Browse...
to manually search for and locate the file and then have the path
information entered into the field for you.

d. Click Import and Install to run or schedule the import and
installation of the updates.

4. After the installation is complete, restart IBM Flex System Manager to activate
the updates.

Acquiring and installing updates
The information in this section describes how to acquire and install updates with
the management software web interface and command-line interface when the
management node is connected to the Internet. If your management nodes is not
connected to the Internet, use the procedure in this topic to download updates,
import the updates to the management node, and install the updates.

About this task

If you are setting up your IBM Flex System environment for the first time, or if
you need only basic update capabilities, use the update wizards on the Initial
Setup tab on the Home page for basic update operations. For more information
about each update wizard, see Initial Setup for more information.

If you are setting up your IBM Flex System environment for the first time, or if
you need only basic update capabilities, use the update wizards on the Initial
Setup tab on the Home page for basic update operations. For more information
about each update wizard, see Initial Setup for more information.
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You can also configure the management software to notify you of available updates
and to select compliance policy settings for managed resources. See Using the
automated updates wizard for more information.

You can also configure the management software to notify you of available updates
and to select compliance policy settings for managed resources. See Using the
automated updates wizard for more information.

Note: If you are updating IBM Flex System Manager itself, see Updating IBM Flex
System Manager.

To manually download and import updates, complete the following steps:

Procedure
1. Go to Fix Central at http://www.ibm.com/support/fixcentral/.
2. Log on with your IBM user ID and password.

Tip: If you do not currently have an IBM user account, you can obtain one
from https://www.ibm.com/account/profile/us?page=reg.

3. Complete the following steps on the Fix Central page to locate and download
the needed update package:
a. From the Product Group list, select PureSystems. The Product list is

displayed.
b. From the Select from PureSystems list, select PureFlex System.
c. From the Select from PureFlex System list, select Management devices and

solutions.
d. From the Management devices and solutions list, select Flex System

Manager Node.
e. Select the machine type for your management node; then, click Continue.

The Installed Version list is displayed.

Note: You can ignore the operating system list.
f. From the Installed Version list, select the version of IBM Flex System

Manager that is currently installed.

Note: To find the current IBM Flex System Manager version number, from
the Home page, click the Plug-ins tab. The version number (for example,
1.1.0) is displayed beside IBM Flex System Manager.

g. Click Continue. The Select fixes page is displayed.
h. Select the fix group that you want to download and then click Continue.

The Download options page is displayed.
i. Select the Download using Download Director and Include prerequisites

and corequisite fixes (you can deselect the ones you don't need later)
options, and then click Continue. The Terms and conditions page is
displayed.

j. Select I agree if you agree to the terms and conditions. The Download files
using Download Director page is displayed.

k. Click Download now to start the download of the update package. The
update package downloads to the designated location.

4. Use one of the following methods to copy all of the downloaded update files to
the /home/USERID directory on the management node.
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Important: Do not to copy update files to the /tmp directory.
a. Use a Secure Copy (SCP) tool on a laptop or workstation attached to the

management or data network.

Important: Make sure that the SCP tool transfers the files to the
management node in a binary format. If the files are transferred as text, the
transfer process might modify the readme files and corrupt them.

b. Use the scp command in the management software CLI to retrieve the fix
package from an SSH server on the management or data network. See the
following examples. From a management software console, logged in as
USERID:
scp USERID @<remote_host_name>:/directory/* /home/*

From a remote server or workstation:
scp * USERID@<management_node_host_name>:/home/USERID/*

c. Copy the update files from a USB storage device that is formatted for
FAT16, FAT32, ext2, or ext3 file systems.

Note: The maximum file size that is supported by FAT16 is 2 GB; the
maximum for FAT32 is 4 GB. If your update files are larger, format your
USB storage device for the ext2 or ext3 file system.
1) Insert a USB storage device into the USB port on the front of the

management node.
2) SSH to the management node.
3) Log in with the default USERID and password.
4) Use the lsmediadev command to list the storage media devices that are

available for use on the system and identify the USB storage device. The
resulting output will be similar to the following, where vdi1 is the USB
storage device:
device=/dev/cdrom,mount_point=/media/cdrom,type=1,description=CD/DVD
device=/dev/vdi1,mount_point=/media/vdi1,type=3,description=USB flash
memory device

5) Type mount /dev/vdi1 and press Enter.
6) Use the command cp to copy the files. For example:

cp /media/vdi1/<file_name> /home/USERID

7) Type umount /dev/vdi1 and press Enter to unmount the USB storage
device.

5. Import and install the updates using either the command line or the IBM Flex
System Manager Web interface:

Command line
Run the following command to import and install the updates:
smcli installneeded -v -F /home/USERID

IBM Flex System Manager Web interface
Complete the following steps to import and install the updates:
a. From the IBM Flex System Manager Web interface Home page, click

Update IBM Flex System Manager.
b. On the Update IBM Flex System Manager page, click Stop to stop

the task that checks for new updates and instead displays options
for downloading and importing updates.

c. In the Path field, type the full local directory path and file name of
the downloaded update package zip file.
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d. Click Import and Install to run or schedule the import and
installation of the updates.

6. After the installation is complete, restart IBM Flex System Manager to activate
the updates.

Acquiring and installing updates with the IBM Flex System
Manager Web interface

Use the update manager tasks in the IBM Flex System Manager Web interface to
acquire updates, stage your installation, manage update groups, and install
updates on your systems.

Showing needed updates
Use the Show and install updates function to identify updates that are needed by
your systems.

Before you begin

This function does not show information for systems for which you have not
collected inventory.

This function can be used on systems or system groups. If you select a system
group, this task will display only those systems within the group that are in need
of updates.

The list of needed updates is produced by comparing the updates that IBM Flex
System Manager has knowledge of to the inventory on your systems. This task
does not list as needed any update that IBM Flex System Manager does not know
about. An important part of keeping your systems up-to-date is running the Show
needed updates function and reviewing the results.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To see a list of updates needed by a system, complete the following steps:

Procedure
1. From the Update Manager summary page, locate the Updates section.
2. Click Show and install updates. The Show and install updates page is

displayed.
3. Select a system or system group in the Selected systems field. Click Browse to

see a list of systems to choose from.
4. Click Show and install updates. A table of needed updates is displayed.
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5. Examine the table. There is one line for each update and details about the
update.

Notes:

v If you do not see an update that you expected to see, you can view all
updates that are available for installation on a system by selecting Show all
installable updates.

v Certain listed updates, for example UpdateXpress System Pack updates for a
IBM Flex System compute node or chassis, are actually update collections
that contain one or more member updates that are combined into one
installable image. To view the member updates within the update collection,
right-click on the update collection and select “Update”. For more
information, see your product documentation.

What to do next

Update tasks such as Install can be done from this page by clicking Actions and
selecting an available task.

Showing all installable updates
Use the Show all installable updates function to identify all updates that are
available for installation on your systems.

Before you begin

This function does not show information for systems for which you have not
collected inventory.

This function can be used on systems or system groups. If you select a system
group, this task will display only those systems within the group that have
updates that are available for installation.

The list of all installable updates is produced by comparing the updates that IBM
Flex System Manager has knowledge of to the inventory on your systems. This
task does not list as installable any update that IBM Flex System Manager does not
know about.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To see a list of all updates that are available for installation on a system, complete
the following steps:

Procedure
1. From the Update Manager summary page, locate the Updates section.
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2. Click Show and install updates. The Show and install updates page is
displayed.

3. From the Show and install updates page, click Show all installable updates.
The Show All Installable Updates page is displayed.

4. Examine the table. There is one line for each update and details about the
update.

What to do next

Update tasks such as Install can be done from this page by clicking Actions and
selecting an available task.

Showing installed updates
Use the Show installed updates function to determine which updates are installed
on a particular system. This task shows those updates that were installed by IBM
Flex System Manager. Updates installed by other means are not displayed.

Before you begin

This function does not show information for systems whose inventory you have
not collected.

Update tasks such as Uninstall can be done from this page by clicking Actions and
selecting an available task.

To change which update properties are displayed on the table, their position in the
table, or the field sizes, click Actions > Columns.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To see a list of updates installed on a particular system, complete the following
steps:

Procedure
1. From the Update Manager summary page, click Show installed updates. The

Show Installed Updates page is displayed.
2. Select a system or system group in the Selected systems field. Click Browse to

see a list of systems to choose from.
3. Click Show Installed Updates. A table of installed updates is displayed.
4. Examine the table. There is one line for each update and details about the

update.
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Checking for new updates
Use the Acquire updates task to periodically load new updates into update
manager. Schedule a check for updates task to run frequently, at least once a week.

Before you begin

Note: To check for updates, the IBM Flex System Manager must have Internet
access. This access can be through a direct connection or through a Hypertext
Transfer Protocol (HTTP) proxy. If a connection is unavailable, updates can be
imported.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To check for new updates, complete the following steps:

Procedure
1. Select Acquire updates from the Updates section of the Update Manager

summary page. The Acquire updates page is displayed.
2. Select the option to check for new updates.
3. Optional: Click Remove to remove any entries that have been selected in

error.
4. Click OK. A scheduling task is displayed
5. Optional: Type a job name.
6. Choose when to run the job:
v Click Run Now to run the job right away.
v Click Schedule and choose a date and time for the check for updates, as

well as the Repeat Options for running the task.
You are advised to schedule a repeating task, because it ensures that you
are aware of new updates as they become available. You are also advised to
choose a time when system load is light, so that the job will complete
quickly.

7. Click Notifications and enter notification options.
8. Click Options and enter other options.
9. Click OK.

10. If any new updates are found, update manager will be automatically made
aware of them. Examine any static update groups that you have created to see
if the new updates must be added.
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What to do next

This is an alternative, system-based approach. Go to the Resource Explorer area
and select a system or system group. Click Actions > Release Management >
Acquire Updates. This will scope the check for updates to just that type of system
or systems in the group.

Downloading updates
While the download of updates happens automatically as needed, you might want
to download updates when it is most convenient for your network, and to ensure
that the updates are available at the time of installation.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

You can choose to download the installable files for the update to the management
server if you have interest in installing the update, and want to make the
installation process run faster when it is scheduled. Downloading the updates
ahead of installation ensures that the valuable time allocated for system
maintenance (when typically systems are not available to the users) is not spent on
tasks such as downloading, which does not require exclusive system access.

You are not required to run the download task. If the installable files for the
update have not been downloaded when the installation task is scheduled, the
download task is automatically be invoked before the installation task.

It is important to note that the membership of an update group is not resolved at
the time that a task using the groups is scheduled. The membership of the update
group is resolved at the time that the task runs.

To download updates, complete the following steps:

Procedure
1. From any panel where a list of updates is present, click Actions > Download.
2. You will see a summary panel explaining which updates are to be downloaded

to the management server. Click OK.
3. The task scheduler is displayed. Choose to either run the download now or

schedule it for later.
4. When the download task is used on a selection of updates that must be

manually downloaded, a message is issued stating that not all the updates can
be automatically downloaded. You can click Download manually to display
the manual download page. Follow the instructions on that page to complete
this process.
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Downloading manual updates:

Some updates must be downloaded manually. An example of an update that
requires a manual download is an update that requires a licensing agreement.

Before you begin

There might be some updates that cannot be automatically downloaded due to
licensing restrictions. In this case, the downloaded column for the update will
contain the text No, manual download. When you try to download this type of
update, you will see instructions for a manual download.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

When you select the download task on an update menu, a panel is displayed to
guide you through visiting the appropriate Web site, downloading the update, and
then copying the installable files for the update.

To perform a manual download of an update, complete the following steps:

Procedure

1. From the update menu page, select Actions > Download. A panel with
instructions for each manual download is displayed.

2. Select one update and click Actions > Download. This launches a Web browser
to the appropriate Web site for downloading the installable files for the update.

3. If a licensing agreement is displayed, read it and any other information
presented to you. Accept the licensing agreement if you want to continue.

4. The download retrieves the installable files for the update. Make a note of their
location.

5. Close the browser for the download link. You will return to the Download
Updates page.

6. Put the location of the update installable files (from Step 4) in the Files to
import field.

7. Optional: Click Browse to browse the directory.
8. Repeat this step for each update that requires a manual download.
9. Click OK to import the updates you have downloaded.

What to do next

After an update has been manually downloaded, it can be managed the same way
as any other update.

406 Systems Management Guide



Importing updates
There are multiple methods that you can use to import updates and install them.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To import updates, complete the following steps:

Procedure
1. Use one of the following methods to copy all of the downloaded update files to

the /home/USERID directory on the management node:
a. Use a Secure Copy (SCP) tool on a laptop or workstation attached to the

management or data network.

Important: Make sure that the SCP tool transfers the files to the
management node in a binary format. If the files are transferred as text, the
transfer process might modify the readme files and corrupt them.

b. Use the scp command in the management software CLI to retrieve the fix
package from an SSH server on the management or data network. See the
following examples. From a management software console, logged in as
USERID:
scp USERID @<remote_host_name>:/directory/* /home/*

From a remote server or workstation:
scp * USERID@<management_node_host_name>:/home/USERID/*

c. Copy the update files from a USB storage device that is formatted for
FAT16, FAT32, ext2, or ext3 file systems.

Note: The maximum file size that is supported by FAT16 is 2 GB; the
maximum for FAT32 is 4 GB. If your update files are larger, format your
USB storage device for the ext2 or ext3 file system.
1) Insert a USB storage device into the USB port on the front of the

management node.
2) SSH to the management node.
3) Log in with the default USERID and password.
4) Use the lsmediadev command to list the storage media devices that are

available for use on the system and identify the USB storage device. The
resulting output will be similar to the following, where vdi1 is the USB
storage device:
device=/dev/cdrom,mount_point=/media/cdrom,type=1,description=CD/DVD
device=/dev/vdi1,mount_point=/media/vdi1,type=3,description=USB flash
memory device

5) Type mount /dev/vdi1 and press Enter.
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6) Use the command cp to copy the files. For example:
cp /media/vdi1/<file_name> /home/USERID

7) Type umount /dev/vdi1 and press Enter to unmount the USB storage
device.

2. Import and install the updates using either the command line or the IBM Flex
System Manager Web interface:

Command line
Run the following command to import and install the updates:
smcli installneeded -v -F /home/USERID

IBM Flex System Manager Web interface
Complete the following steps to import and install the updates:
a. From the IBM Flex System Manager Web interface Home page, click

Update IBM Flex System Manager.
b. On the Update IBM Flex System Manager page, click Stop to stop

the task that checks for new updates and instead displays options
for downloading and importing updates.

c. In the Path field, type the full local directory path and file name of
the downloaded update package zip file.

d. Click Import and Install to run or schedule the import and
installation of the updates.

3. After the installation is complete, restart IBM Flex System Manager to activate
the updates.

Exporting updates
Use the Export function to copy updates from the update library to a target
directory on the management server. The target directory must be accessible to the
management server.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To export updates, complete these steps:

Procedure
1. From any list of updates, select the ones that you want to export.
2. Click Actions > Export updates.
3. Specify a location for the update files by typing or browsing for the path name

on the management server in the Path field.
4. Click OK. The scheduler is displayed. You can then choose to run the task now

or schedule it to run in the future.
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Installation staging
Use installation staging to copy the files that comprise an update to an appropriate
location for eventual installation. That location might not be the system that the
update is to be installed on. This task is not required. If you skip this step, the
update is staged when it is needed. This task is provided to save time during
installation maintenance windows, in order to minimize system downtime and
unavailability.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

The task of installation staging is accomplished by running the Installation staging
wizard on an update. The Installation staging wizard guides you through the task
of copying the installable files for an update from the management server to an
appropriate location for eventual installation.

If the installable files for an update have not been previously downloaded, a
download is run before the installation staging is performed.

It is important to note that the membership of an update group is not resolved at
the time that a task using the group is scheduled. The membership of the update
group is resolved at the time that the task runs.

To perform an installation staging for an update, complete the following steps:

Procedure
1. Click Actions > Installation staging on the menus for an update or update

group. The page of the Installation staging wizard is displayed.
2. Clear the Show this welcome page next time box if you do not want to see

the Welcome page again.
3. Click Next. The Updates page is displayed. The Updates page is skipped if

the Installation staging wizard was invoked from an update or update group.
In this case, proceed to Step 5.

4. Select each update that you want. If an update that is part of an update
collection is chosen, a warning is issued because it is advisable to install the
update collection as a whole.

5. If you select updates that require a manual download, these updates cannot
be staged until you manually download them. The Downloads required panel
will be displayed.
a. Click Details to manually download updates.
b. Click Continue, the updates are now downloaded and ready when you

have completed the manual download.
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c. Click Skip the updates which must be manually downloaded if you do
not want to manually download these updates, or the process has failed
for one or more of them. Those updates will be removed from the list and
will not be staged.

d. Click Next The Systems page is displayed.
6. You can stage updates for installation by selecting the systems or system

groups that the updates are to be installed on. Select the system or system
group name and click Add

Be aware that if you selected system groups, the list of individual systems in
these groups is not determined until the task runs. You are presented options
only for those systems that were individually selected. Group membership is
not determined until the task runs.

7. If some of the updates are for AIX or IBM BladeCenter systems, and you had
not already specified the necessary AIX or IBM BladeCenter options on the
Settings page, it is displayed so that you can choose these options.

8. Click Next. The Options page is displayed.
9. If you do not want updates that are required for the installation of the

selected updates to also be staged for installation, clear Automatically stage
missing required updates. Clearing this box is not advised. Missing
mandatory updates will cause the installation task to fail.

10. A table of the known update requirements for each selected update is
displayed.
a. Select a system from the list of systems to see its update requirements.
b. Review the required updates that will be installed when Automatically

stage missing required updates is selected. You cannot edit the required
updates here.

11. Click Next. The Summary page is displayed.
12. Review the information on this page.

v If it is correct, click Finish. A panel is displayed for you to specify
notification and schedule settings for the installation staging task being
launched by this wizard.

v If some information is incorrect, click Back to go to previous pages and
correct the information, or click Cancel to cancel the entire process.

Results

After the installation staging task completes, the updates are staged in the
following locations:
v When staging to AIX, IBM i, and Linux systems, updates are staged to

/tmp/updatemanager/staging in all cases.
v When staging to Windows systems, updates are usually staged to

TEMP\updatemanager\staging, where TEMP usually resolves to C:\WINDOWS\TEMP
but can change depending on the resource type to which you are staging.

Note: To ensure that updates are staged to the Windows TEMP directory, specify
RELOAD_STAGING_LOCATION=true in the install_path\IBM\Director\lwi\
runtime\core\workspace\.metadata\.plugins\
com.ibm.director.mgr.updates.server\update.properties file.

To determine the exact staging path for a particular system, see the related entry in
the job log. To verify that the path has sufficient space, explicitly stage an update
to the target system and then verify the staging at that path.
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Viewing information about updates
Information about updates and updates groups is often needed to decide whether
to install the update.

The update topology perspective:

The Updates topology perspective displays a topology view tailored to the
system's update-related resources.

From any place within update manager where you can display a system, click
Actions > Topology Perspectives.

By default, a topology perspective contains all resources related to the system. The
Updates perspective limits the resource types to update-related resources that are
installed on, needed by, or applicable to the system. The following resources types
are included in the Updates perspective:
v systems
v updates
v update collections

Click the displayed resources to see the relationships displayed in the Properties
table.

Relationships for updates and update collections:

Update relationships indicate how an update relates to other updates and target
systems. The Topology view is a good way to illustrate update relationships.

This is a list of all update relationships. To simplify this discussion, the term
'update' refers to either an individual update or an update collection, unless
otherwise noted.

appliesTo
Indicates systems that an update can be installed on at this time. You can
view updates that can be installed on a system by navigating the appliesTo
relationship from the system's Related Resources submenu.

federates
Specifies the individual updates that are contained in an update collection.

installedOn
Indicates systems where the update is currently installed. You can view
where a specific update is installed by following the installedOn
relationship from the update's context menu.

This displays the systems where the update is installed using a table view.

This table view can be switched to a topology map to display a graphical
layout instead of a topology. In the topology map, the installed on
relationships between the updates and the systems are displayed.

needs Indicates updates that a system needs.

Several updates might applyTo a system, but the system might only need
one of those updates. An example is the situation where one update
supersedes another.

You can see where an update is needed for installation by following its
needs relationship using the resource navigator.
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When an update is acquired, the needs and appliesTo relationships for the
update and affected systems are automatically synchronized so that the
new update can be properly managed, and compliance policies remain
accurate.

This table view can be switched to a topology map to display a graphical
layout instead of a topology. In the topology map, the needs relationships
between the updates and the systems are displayed.

requires
Indicates that this update requires another update to be installed.

supersedes
Indicates that this update supersedes another update, meaning that the
other update is not needed if this one is installed.

Viewing properties, documentation, requirements, and other details for an
update:

You can obtain details about an update, such as general properties, installation
requirements, installable files, and documentation.

Before you begin

If an update has not been downloaded and you attempt to view the contents of an
associated documentation file, the download task will be run so that the files can
be read.

About this task

To view properties and documentation for an update, complete the following steps:

Procedure

1. From any place where an update is displayed, click the update name. A page of
general information about the update is displayed, including: name, ID, size,
version, and so on.

2. Click the General tab to see general information about the update.
In this list, the term 'update' is used to refer to an update or update group.

Note: Certain listed updates, for example UpdateXpress System Pack updates
for a IBM Flex System compute node or chassis, are actually update collections
that contain one or more member updates that are combined into one
installable image. To view the member updates within the update collection,
right-click on the update collection and select “Update”. For more information,
see your product documentation.

Name The name of the update.

Description
A description of the update.

Acquired Date
The date that this update was acquired by update manager.

Build Date
The date that the update was built. An example is the date that the
source for the update was compiled.
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Build Number
The build number of the update.

Category
The category of update.

Downloaded
Whether the update has been downloaded to the management server.

Filenames
The names of the files for the update.

Package Type
The package type of the update.

Platform
The hardware platform that the update applies to.

Product
The name of the product that the update applies to.

Restart Type
Whether a restart is required when the update is installed or
uninstalled, and what type of restart is required.

The exact wizard options that are displayed vary, depending on the
type of resource that is being updated. These are some of the possible
values:

Restart immediately after update is installed
The restart must be performed before other updates can be
installed or uninstalled.

Restart after all updates are installed
The restart can be performed at the end of the install or
uninstall task.

None There is no restart indicated for the system or resource.

Severity

The severity of the update is one of the following values:
v Critical
v High
v Normal
v Low
v Not Applicable

Note: The designated severity levels of X-Architecture compute node
updates can dynamically change depending on the updates that are
already installed on the system. For example, if no previous versions of
an update exist on a system, the current version of the update might
have a higher level of severity than it would if a previous version of
the update existed.

Software ID
A character string or value that identifies the software or firmware that
needs the update.

Superseded
Whether this update has been superseded by another.
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Total Size
The total size of all the update's files.

Uninstallable
Whether the update can be uninstalled.

Update ID
A unique identifier for the update.

Update Type
Whether the update is an individual update or an update collection.

Vendor
The manufacturer of the update.

Version
The software or firmware version that the update applies to.

3. Click the Documentation tab. A page of documentation files is displayed. Some
updates might not have documentation files.

4. Click the Requirements tab. A page of requirements that must be met in order
for the update to be installed is displayed. The type of information depends on
which software component is being updated, such as applicable operating
systems and levels.

5. Close this page by clicking the X on the page tab.

Searching update documentation:

If there is a specific area of concern or detail that you are looking for, searching
update documentation can point you to the updates that you are most interested
in.

Before you begin

Only the latest documentation for an update in its supersede chain is displayed. If
you have a situation where update A supersedes update B, the documentation for
update A is displayed rather than the documentation for update B, since update A
is the most recent update in the supersede chain.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

The Update Manager summary page contains a search field that searches the
documentation files of updates that are available for management. The search is
limited to updates that have been downloaded to the management server. For each
update, only those files that are human readable are available for searching.

To search update documentation, complete the following steps:
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Procedure

1. From the Update Manager summary page, locate the Search section.
2. In the Search local updates field, type the terms you want to search for.
3. Click Search. Search results are displayed in a separate table, sorted by

closeness to the search terms. Search results are not case-sensitive.
4. Optional: You can do various tasks from the search results page, such as

installing an update, viewing the properties, or adding it to an update group.
5. If you do not find what you are looking for, perform a check for updates to

ensure that you have all the most recent updates.

Example

You can use operators in your searches to obtain more accurate search results. Here
are examples of the supported search operators and their meanings:

Linux Matches anything that contains Linux.

Linux*
Matches anything that begins with Linux.

Linux server
Matches anything that contains either Linux or server or both.

Linux OR server
Same as Linux server.

+Linux +server
Matches anything that contains both Linux and server.

Linux AND server
Same as +Linux +server.

+Linux -Blade
Matches anything that contains Linux and does not contain Blade.

clock~ Matches anything like clock, such as block, click, clocks, and so on.

(Linux OR server) AND Blade
Matches anything that contains Blade and also contains Linux or server or
both.

"Issues and Recommendations"
Matches anything with the exact phrase 'Issues and Recommendations'.

Viewing required updates:

When preparing to install an update, it might be necessary to first install another
update on a given system. These updates are called required updates or requisite
updates.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:
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You can view the updates required by an update by navigating the requires
relationship on the update menu. The requires relationship navigation will display
the updates required by the currently selected update. The updates are displayed
in a navigator table view.

This table view can be switched by the user to a topology map to display a
graphical layout instead of a table. In the topology map, the required relationships
between the updates are displayed.

To view the required updates for a specific update, complete the following steps:

Procedure

1. From any list of updates, select the update whose required updates you want
to display.

2. Click Actions > Related Resources > Needed Updates. A table of the needed
updates is displayed.

Viewing the contents of update collections:

An update collection is an update that contains other updates, such as a service
pack. They can be managed as a single unit, just like an individual update.

Before you begin

To determine if an update is a collection or an individual update, from any table
where a list of updates is displayed, view the Update Types field. A value of
'Collection' indicates that the update is an update collection. A value of 'Individual'
indicates that the update is not a collection, but an individual update.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To view update collections, complete the following steps:

Procedure

1. From any list of updates, select an update collection.
2. Click Actions > Related Resources > Updates. A table of the member updates

is displayed.
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What to do next

Although you can view the member updates in an update collection, you are
advised not to install these individual members separately. Instead, install the
entire update collection.

Viewing the supersede relationships for an update:

One update supersedes another if installation of the one update will make the
other no longer needed.

About this task

The concept of supersede can be explained by this example. UpdateA supersedes
UpdateB if UpdateA contains all the information in UpdateB, or installing
UpdateA creates a situation where UpdateB is not needed. UpdateA can be said to
supersede UpdateB or be a supersede of UpdateB. UpdateB can be said to be
superseded by UpdateA.

You can see the updates that are superseded by a given update by selecting
supersedes on the Related Resources submenu at the top of the update menu. It is
possible that an update does not supersede any other. It is also possible that an
update is not superseded by any other

This table view can be switched by the user to a topology map to display a
graphical layout instead of a table. In the topology map, the superseded
relationships between the updates are displayed.

Viewing parent update collections:

For a given update, a parent update collection is an update collection that contains
this update, as well as possibly others. Not all updates will have a parent update
collection.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

Parent update collections are updates themselves, and can be installed as an
update. These are similar in concept to service packs.

To view update collections, complete the following steps:

Procedure

1. From any list of updates, select an update whose parent update collection you
want to view.
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2. Click Actions > Related Resources > Update Collection. The update collection
that contains this update is displayed.

What to do next

Although you can view the member updates in an update collection, you are
advised not to install these individual members separately. Install the entire update
collection.

Managing update groups
You can group updates to form an update group, which can then be managed as if it
were an individual update. The use of update groups can save time and limit the
complexity of the update tasks.

Update groups:

Update groups can be static or dynamic. Both types can be used in compliance
policies.

Static update groups
Contain individual updates that were explicitly chosen. Once established,
the membership changes only when you manually add or delete updates.
Static update groups can be used as a baseline for future comparison or
update deployment.

Dynamic update groups
Automatically contains updates based on selected update types. The
membership of this group changes as update information changes.

It is important to note that the membership of an update group is not resolved at
the time that a task using the group is scheduled. The membership of the update
group is resolved at the time that the task runs.

If you add a system group or an update group to an existing system group or
update group, this new, nested group will not be considered when the parent
system or update group is used for validation of compliance policies.

Viewing update groups:

It is advisable to view the individual members of an update group so that you are
aware of the updates that are being used for compliance policies.

Before you begin

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:
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To view an update group, complete the following steps:

Procedure

1. From the Update Manager summary page, click Show update groups. A table
of all defined update groups is displayed. This table shows all the update
groups in the group named Update Groups.

2. Click the name of the update group that you want to view. The members of the
group are displayed in a list.

Creating update groups:

Although there are predefined update groups, you might want to create and
manage update groups for your unique systems and their software.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To create an update group, complete the following steps:

Procedure

1. From the Resource Navigator, click Create Group. The Group Editor wizard is
displayed.

2. If the Welcome page is displayed, click Next. The Name page is displayed.
3. Type a name and description for the new group and click Next. The Type and

Location page is displayed.
4. Select a Member type of Update.
5. In the Group type field, choose either a Static or Dynamic update group. The

Define page is displayed.
6. Select group members:
v If the group type is Static, select the individual updates and update collection

and click Add to move them to the Selected column.
v If the group type is Dynamic, select the types of updates and click Add to

move them to the Selected column. These values are like those on the
Acquire Updates page.

7. Click Next. The Summary page is displayed.
8. Review the choices for the new group carefully.
v If your choices are correct, click Finish to create the update group.
v If you want to change your choices, click Back to go to the previous page, or

choose the Group Editor wizard page from the navigation area.
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Installing updates on systems
Use the Install wizard to install updates on systems or groups of systems. If you
choose to install updates that have not been downloaded or staged for installation,
these tasks will be automatically performed as part of the installation task.

Before you begin

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

Note: The installation of updates on IBM i (formerly i5/OS) systems requires a
single sign-on credential that maps an IBM Flex System Manager Web interface
user to an IBM i user ID.
v For instructions to create credentials, see “Creating single sign-on credentials”.
v For more informations about credentials, see “Managing single sign-on

credentials”.

Tip: To protect your system in the event of an unforeseen complication, ensure
that you back up your data before performing any update tasks.

About this task

To install updates, complete the following steps:

Procedure
1. From the Update Manager summary page, locate the Updates section.
2. Click Show and Install Updates. The Show and Install Updates page is

displayed.
3. Select a system or system group in the Selected systems field. Click Browse

to see a list of systems to choose from.
4. Click Show and install updates. A table of needed updates is displayed.
5. Select each update that you want to install. Whole update collections, not

individual member updates, will be installed.
6. Click Install. The Install wizard Welcome page is displayed.
7. Clear Show this welcome page next time if you do not want to see the

Welcome page next time.
8. Click Next The Systems page is displayed.
9. Click Next.

10. Optional: If you select updates that require a manual download, and this has
not already been done, you must manually download them. The Downloads
required page is displayed.
a. Click Details to perform the manual download.
b. Click Continue, the updates are now downloaded and ready when you

have completed the manual download.
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c. Click Skip the updates which must be manually downloaded if you do
not want to download these updates, or the manual download process has
failed for one or more of them.

11. Click Next.
12. Optional: The Manual Installation Required page will be displayed if a

selected update must be manually installed by the user.
a. Click View under the Installation Instructions heading to see the manual

installation instructions.
b. Read the instructions and decide to install the updates now or later.

Updates that require manual installation will be removed from the list of
selected updates. If all the selected updates require manual installation, you
cannot continue; Next will be disabled.

13. Click Next. The Restarts page is displayed. All selected systems are displayed
in the table even if they do not require a restart. For each system, the highest
restart impact is listed. The systems are sorted in this table with those of
highest restart impact listed first.

14. Automatically restart as needed during installation is selected by default.
Clear this box if you do not accept the restart requirements. If you clear the
Automatically restart as needed during installation box and updates are
installed that have pending restarts, then the installation task will complete
with errors and some update installs might not be attempted if a dependent
update requires an immediate restart.

15. Click Yes in the Restarts Required column for a system to view all updates to
be installed on the system and their individual restart requirements. This view
is specific to the selected system. It shows all the updates that will be installed
on that system and the restart value for each. You cannot change the
information on this page. If you do not accept the restart requirement, click
OK to return to the Install wizard, click Back, and then remove systems or
updates.
If you have selected system groups as the target for the update installation,
the list of individual systems in these groups is not determined until the task
runs. You are presented options only for those systems that were individually
selected. Group membership is not determined until the task runs.
The exact wizard options that are displayed vary, depending on the type of
resource that is being updated. These are some of the possible values:

Restart immediately after update is installed
The restart must be performed before other updates can be installed
or uninstalled.

Restart after all updates are installed
The restart can be performed at the end of the install or uninstall task.

None There is no restart indicated for the system or resource.
16. Click Next. The Summary page is displayed.
17. Review the information on this page.

v If it is correct, click Finish. A panel is displayed for you to specify
notification and schedule settings for the installation task.

v If some information is incorrect, click Back to go to previous pages and
correct the information, or click Cancel to cancel the entire process.
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Results

Managing single sign-on credentials:

Use IBM Flex System Manager to manage single sign-on shared credentials for the
selected system. These credentials are mapped from specific user credentials on
that system to IBM Flex System Manager Web interface users.

Before you begin

Ensure that you have the correct authorization to access the resource and its access
points.

About this task

Like other shared credentials, single sign-on credentials are those credentials that
exist in an authentication registry that is not specific to an access point. This
enables the credentials to be reused to access multiple console access points and
systems. These credentials must be of type user ID/password. After the credentials
are configured, the IBM Flex System Manager can use them to launch user
interfaces that are hosted on the selected system.

Creating single sign-on credentials:

Use the Create and Edit Single Sign-On Credentials wizard to create single sign-on
shared credentials for the selected system.

About this task

Single sign-on credentials map user credentials on the selected system to specified
IBM Flex System Manager Web interface users. To create a single sign-on credential
for a console access point on the selected system, complete the following steps:

Procedure

1. In the IBM Flex System Manager Web interface navigation area, click Resource
Explorer > group name > system name.

2. Click Actions > Security > Configure Single Sign-On Credentials. The
Configure Single Sign-On Credentials page is displayed.

3. Click a remote-service console access point. The credentials associated with
that access point are listed.

4. Click Create. The Create and Edit Single Sign-On Credentials wizard is
displayed.

Notes:

v If the Create button is disabled, all credential mappings that you have the
authority to create have been created for the configured authentication
registry on the selected system. A credential mapping can be created only
for those Web interface users who have logged in to IBM Flex System
Manager at least once. Existing credential mappings can still be edited or
deleted.

v If the Create button is unavailable, the selected console access point is on
the IBM Flex System Manager. Single sign-on credentials for these access
points can only be displayed. You cannot create or edit these credentials
because they are automatically created when Web interface users log in to
IBM Flex System Manager.
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5. From the Authentication Registry Type list, select the type of authentication
registry that you want to create.

Note: If an authentication registry has already been configured for the
selected console access point, the value for the authentication registry type
cannot be changed. It is set to the previously configured authentication
registry type for the access point.
The three authentication registry types are as follows:

Local OS
Authenticates user login requests with the local operating system of
the target system. The target system must have a corresponding user
account in the operating-system registry.

LDAP Authenticates user login requests with a Lightweight Directory Access
Protocol (LDAP) server. Ensure that the LDAP server is configured in
your environment and available to the target system.

Domain
Authenticates user login requests with a specific domain server.
Ensure that the domain server is configured in your environment and
available to the target system.

6. Enter the appropriate user ID and password for the system. If you are creating
a credential for a resource that has defined a specific user ID that must be
used when authenticating, you cannot change the value in the User ID field.

7. Click Next. The “Assign to IBM Flex System Manager User” page is
displayed.

Note: This page lists only Web interface users who have logged in to IBM
Flex System Manager. These users must log in at least once before a credential
mapping can be created.

8. Select the IBM Flex System Manager Web interface user for whom the single
sign-on credential is being created. You can use the current user or choose
another user from the table.

Remember: Only one mapping can be created for each of the users on this
page.

9. Click Next. The Summary page is displayed.
10. Click Finish. The credentials are automatically used to authenticate to the

selected console access point on the system.

What to do next

Repeat the credential creation process for other console access points you plan to
access.

Editing single sign-on credentials:

Use the Create and Edit Single Sign-On Credentials wizard to edit single sign-on
shared credentials.

About this task

To edit a single sign-on credential, complete the following steps:
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Procedure

1. In the IBM Flex System Manager Web interface navigation area, click Resource
Explorer > group name > system name.

2. Click Actions > Security > Configure Single Sign-On Credentials. The
Configure Single Sign-On Credentials page is displayed.

3. Click a remote-service console access point. The credentials associated with that
access point for the configured authentication registry are listed.

4. Select the credential that you want to edit.
5. Click Edit.

Note: If the Edit button is unavailable, the selected console access point is on
the IBM Flex System Manager. Single sign-on credentials for these access points
can only be displayed. You cannot create or edit these credentials because they
are automatically created when Web interface users log in to IBM Flex System
Manager.
The Create and Edit Single Sign-On Credentials wizard is displayed.

6. If the Welcome page is displayed, click Next. The Create Single Sign-On
Credential page is displayed.

7. Change the details that are available for changing.
8. Click Next. The Summary page is displayed.
9. Click Finish.

Deleting single sign-on credentials:

Use the Configure Single Sign-On Credentials page to delete single sign-on shared
credentials that are no longer needed.

Before you begin

If you have created any automated tasks in IBM Flex System Manager, ensure that
you check the systems that are the targets of those tasks and the credentials that
are used to log in to those systems. Some tasks might be configured to use a set of
credentials to accomplish the procedures in the task. Deleting the set of credentials
that are used by one of these automated tasks will prevent the task from accessing
targeted systems that are secured.

Note: You will not receive a warning when deleting a credential that is associated
with an automated tasks, and the task will no longer be able to access the system.

About this task

To delete a single sign-on credential, complete the following steps:

Procedure

1. In the IBM Flex System Manager Web interface navigation area, click Resource
Explorer > group name > system name.

2. Click Actions > Security > Configure Single Sign-On Credentials. The
Configure Single Sign-On Credentials page is displayed.

3. Click a console access point. The credentials associated with that access point
are listed.

4. Select the credential that you want to delete.
5. Click Delete. A confirmation message is displayed.
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6. Click OK.

Removing update files
When an update is no longer needed, you can remove its associated installable
files to save space.

Before you begin

If an update has not been downloaded, this task is not available. This task removes
the installable files for an update, but descriptive information about the update is
not removed. When this task completes, the update remains known to update
manager and is treated like any other update.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To remove the installable files from an update, complete these steps:

Procedure
1. From any page where a list of updates is present, select the updates whose files

you want to delete.
2. Click Actions > Delete files.
3. Click Yes in the verification window to confirm the removal of the files.

What to do next

To remove all information about an update, use the smcli cleanupd -am command.

Uninstalling updates
It might be necessary to remove an update from a system or group of systems. Use
the Uninstall updates task to do this. Not all updates support the uninstall task.
For updates that cannot be uninstalled, it might be possible to roll them back to an
earlier version by installing an older version on top of the current one.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:
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To uninstall updates, complete the following steps:

Procedure
1. From the Update Manager summary page, click Show installed updates. The

Show Installed Updates page is displayed.
2. Select a system or system group in the Selected systems field. Click Browse to

see a list of systems to choose from.
3. Click Show installed updates. A table of installed updates is displayed.
4. Select each update that you want to uninstall.
5. Click Uninstall updates. The Uninstall wizard Welcome page is displayed.
6. Clear Show this welcome page next time if you do not want to see the

Welcome page next time.
7. Click Next. The Updates page is displayed.
8. Select each update that you want to uninstall and click Add.
9. Click Next. The Systems page is displayed.

10. Select each system or system group from which you want to uninstall the
updates and click Add. All selected updates that are installed on these
systems will be uninstalled. If you select a system group, the updates are
uninstalled from those systems that are a member of the group at the time the
uninstallation task runs.

11. If some of the updates are for AIX systems, and you had not already specified
the necessary AIX options on the Settings page, it is displayed so that you can
choose these options.

12. Click Next.
13. Optional: The Manual Uninstall Required page might be displayed. It is

displayed only when an update selected for uninstallation must be manually
removed.
a. Click View under the Uninstallation Instructions heading to see the

manual instructions for each update to be uninstalled.
b. Read the instructions and decide to run them now or later.

14. Click Next. The Restarts page is displayed. All selected systems are displayed
in the table even if they do not require a restart. For each system, the highest
restart impact is listed. The systems are sorted in this table with those of
highest restart impact listed first.

15. Automatically restart as needed during installation is selected by default.
Clear this box if you do not accept the restart requirements. If you clear the
Automatically restart as needed during installation box and updates are
uninstalled that have pending restarts, then the uninstallation task will
complete with errors and some uninstalls might not be attempted if a
dependent update requires an immediate restart.

16. Click Yes in the Restarts Required column for a system to view all updates to
be uninstalled on the system and their individual restart requirements. This
view is specific to the selected system. It shows all the updates that will be
uninstalled on that system and the restart value for each. You cannot change
the information on this page. If you do not accept the restart requirement,
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click OK to return to the Uninstall wizard, click Back, and then remove
systems or updates. If you have selected system groups as the target for the
uninstallation task, the list of individual systems in these groups is not
determined until the task runs. You are presented options only for those
systems that were individually selected. Group membership is not determined
until the task runs.
The exact wizard options that are displayed vary, depending on the type of
resource that is being updated. These are some of the possible values:

Restart immediately after update is installed
The restart must be performed before other updates can be installed
or uninstalled.

Restart after all updates are installed
The restart can be performed at the end of the install or uninstall task.

None There is no restart indicated for the system or resource.
17. Click Next. The Summary page is displayed.
18. Review the information on this page.

v If the information is correct, click Finish. A panel is displayed for you to
specify notification and schedule settings for the task being launched by
this wizard.

v If some information is incorrect, click Back to go to previous pages and
correct the information, or click Cancel to cancel the entire process.

What to do next

If an update cannot be uninstalled, it might be possible to roll back the installed
update by installing an older version of the update. The older update can be
installed if the older update is applicable to the system.

Acquiring and installing updates with the installneeded
command

Use this alternate update method if you want to use the command line to specify
some options and then let update manager automatically obtain and install all
types of updates for IBM Flex System Manager.

About this task

You can use the installneeded command line tool to simply update IBM Flex
System Manager servers and agents, or you can add optional parameters to install
other update types. The tool performs the entire update process from beginning to
end with a single command. The basic flow consists of collecting inventory on the
target system, acquiring updates, running compliance, installing needed updates,
then running inventory and compliance again.

This topic describes several high-level uses for the installneeded command. See
the installneeded command topic for more detailed information.

Procedure
v To update IBM Flex System Manager from the FSP, issue the following

command:
smcli installneeded -v -F
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This command will use the server on which it is run as the target. It will
automatically acquire IBM Flex System Manager updates from the FSP and
install them. The -v option specifies “verbose” and is useful for tracking
progress or seeing problems. The -F option specifies “force”, without which the
command will ask for confirmation before installing each update.
The following options and operands are also useful when updating IBM Flex
System Manager:

-I Installs updates that are already in the updates repository. For example:
smcli installneeded -v -I

import_path
Installs updates after you import them from the supplied path. For
example:
smcli installneeded -v c:\dirupdates

See the installneeded command topic for more detailed information about these
options and operands.

v To update Common Agent or Platform Agent with the latest update level from
the FSP, complete the following steps from an IBM Flex System Manager server:
1. Issue the following command to determine the OID of the system:

smcli lssys -o

The output will resemble this example:

netvj165, 0xa98
netvj165.vrow.netfinity.com, 0xa39

2. Issue the following command to update the agent:
smcli installneeded -v -n {system_oid | system_name} -F

For example:
smcli installneeded -v -n 0xa39 -F
smcli installneeded -v -n netvj165.vrow.netfinity.com -F

The following options and operands are also useful when updating Common
Agent or Platform Agent:

-I Installs updates that are already in the updates repository. Use the
following format for the command:
smcli installneeded -v -n {system_oid | system_name} -I

-i Specifies an IP address or host name to identify the system instead of
the system OID or system name. This could be useful if you are
using a script to update the system after using other CLI commands
to discover and request access to the system. If both the server MEP
and operating system MEP have the same IP address, you must use
another parameter along with the command to install the updates
without user intervention. Use the following format for the
command:
smcli installneeded -v -t system_type -i ip_address -F

For example:
smcli installneeded -v -t OperatingSystem -i 10.11.9.165 -F

Note: Use the lssys -T command to determine the valid system
types.
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Note: You can use -i in combination with -I.
See the installneeded command topic for more detailed information about
these options and operands.

v To update Common Agent or Platform Agent with a specific update level,
complete the following steps from an IBM Flex System Manager server:
1. Download the desired updates from www.ibm.com/support/fixcentral/.
2. Issue the following command to import and install the updates:

smcli installneeded -v -n {system_oid | system_name} -F import_path

For example:
smcli installneeded -v -n 0xa39 -F c:\dirupdates

v To install other types of updates, complete the following steps:
1. Issue the following command to determine the update type or types to

specify:
smcli installneeded --list

2. Issue either of the following commands to install the updates:
– smcli installneeded -v -n {system_oid | system_name} -F -u

update_type

– smcli installneeded -v -t system_type -i ip_address -F -u
update_type

For example:
– Install X-Architecture compute node and IBM Flex System updates from

the FSP to the system with a system OID of 0xa39:
smcli installneeded -v -n 0xa39 -F -u systemxandbc

– Install X-Architecture compute node and IBM Flex System updates that
were already acquired from the FSP or imported previously to the system
with a system name of netvj165.netfinity.com:
smcli installneeded -v -n netvj165.netfinity.com -F -u systemxandbc -I

– Install Linux updates to the system with an IP address of 10.11.9.165:
smcli installneeded -v -t OperatingSystem -i 10.11.9.165 -F -u linux

Note: The default value for -u is “Director”, which is implied if -u is not
specified. That is why the previous command to update IBM Flex System
Manager was accurate even though the -u option was not included. The -u
option corresponds to the update ProviderType and specifies the types of
updates to acquire if -c is specified or implied when no other option is
given. The acquire updates task will only order updates using the default
criteria values that are supported by the target system or server if no target
system is provided.

To illustrate with an example, a user wants to update IBM Flex System
Manager on Linux and uses the following command to do so:
smcli installneeded -v -F

The user then discovers and accesses a Linux agent and plans to perform
Linux updates on the agent after the agent side setup is complete. There are
correct and incorrect commands to use for this action:
– Incorrect:

smcli installneeded -v -t OperatingSystem -i 10.11.9.165 -F -u linux -I
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This command would find no updates to install. Even though the smcli
installneeded -v -F command already ran the acquire updates task on a
Linux server, -u was not specified and therefore defaulted to “-u
Director”. Only IBM Flex System Manager updates were acquired from
the FSP, and no Linux updates were placed in the repository for
installation.

– Correct:
smcli installneeded -v -t OperatingSystem -i 10.11.9.165 -F -u linux

This command would complete an acquire updates task for Linux updates
from the FSP and install them.

See the installneeded command topic for more detailed information about
these options and operands.

Keeping systems in compliance
The IBM Flex System Manager uses a default compliance policy to ensure that the
most current versions of updates imported into the Flex System Manager are
applied to managed endpoints. Flex System updates are released concurrently and
it is recommended that you acquire updates for your entire Flex infrastructure
when you acquire updates for your Flex System Manager, to maintain your
environment at supported stack levels. Visit the IBM PureSystems Centre to learn
more about the supported stack for your release, or to acquire any necessary
updates to maintain system compliance.

Before you begin

The Update Manager summary page provides a quick view of the number of
systems that are monitored by compliance policies and the number of systems that
are out of compliance. Review this information before viewing the more detailed
data that follows it.

In addition, compliance information for chassis and their components is displayed
graphically in the chassis map.

About this task

Use the Update Manager summary page to view information about compliance
policies for your systems. All compliance policy tasks are initiated from the Update
compliance section on this page.

Note: Compliance status does not change on the monitored systems until an
acquire updates task is complete and compliance has completed. This status
change can take up to ten minutes after the acquire updates task completes.

Important: When using compliance for the first time, keep in mind the following
items:
v To check compliance for , Flex System Manager an applicable IBM UpdateXpress

System Pack Installer (UXSPi) is required. The UXSPi is downloaded
automatically when you use update manager to acquire updates from the
internet. If the management server does not have an internet connection, you
must manually download and import an applicable UXSPi.

Important: For UXSPi to work correctly on 64-bit Linux operating systems, you
must install the compatibility libraries compat-libstdc++-296-2.96.
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v To efficiently balance impact on resources and improve reliability, consider
grouping your systems, for example by type or by level of operating system,
and then using a rollout or staged approach to attain currency.

v For important information about applying compliance on Flex System Manager,
see the Firmware Update Guide - IBM Flex System, at http://www.ibm.com/
support/entry/portal/docdisplay?lndocid=MIGR-5091991&brandind=5431802.

What to do next

You can create compliance policies on systems or system groups. When a policy is
created on a system group, all systems within the group inherit the compliance
policy. The group is displayed in the Inherited column when viewing the system
compliance policy.

Compliance policies
Use compliance policies to monitor your systems and inform you when systems
are missing specific updates.

The first section on the Update Manager summary page is the Update Compliance
section. This section provides a quick summary of the update health of your
systems and provides several system-related tasks.

Tips
v If you see the term Inherited Compliance Policy or an Inherited field in a table

when you are viewing this information, there is a compliance policy on the
parent group for the system. The policy can be removed from the system only
by removing it from the system parent group.

v The behavior of a compliance policy for an update group differs slightly
depending on whether the update group is static or dynamic:

Static update group
When a static update group is examined, each update contained within
the group that is applicable to the system must be found to be installed;
otherwise the compliance policy indicates an 'out of compliance'
situation. This situation is verified by examining the appliesTo
relationship on the update.

Dynamic update group
When a dynamic update group is examined, the compliance policy
indicates an 'out of compliance' situation only when updates that are
needed by the systems are not installed. This situation is verified by
examining the needs relationship on the update.

v If you add a system group or an update group to an existing system group or
update group, this new, nested group is not considered when the parent system
or update group is used for validation of compliance policies.

v If an update that is not applicable to a particular system is not installed, the
compliance policy does not indicate an 'out of compliance' situation.

Adding updates to a compliance policy
Updates can be added to a compliance policy to keep the compliance policy
current.

About this task

Note:
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This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To add an update to the compliance policy for a system, complete the following
steps:

Procedure
1. From any panel that has a list of updates displayed, click Add to >

Compliance Policy.
2. Select the system or system group to be monitored for the update.
3. Click OK. The selected update is added to the compliance policy for the

system.
4. Click Save to save the compliance policy.

Create and configure compliance policies
Use the Create and configure compliance policies page to change compliance
policies.

Before you begin

The Create and configure compliance policies task is used to configure compliance
policies on systems that are monitored for missing updates. Each compliance check
is listed on a separate line.

The target system or system group is checked against its associated compliance
policy automatically when the system or update inventory changes.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To modify compliance policies, complete the following steps:

Procedure
1. From the Update Manager summary page, click Create and configure

compliance policies. The Compliance Policy page is displayed.
2. Select a system or system group.
3. Optional: Click Browse to see a list of systems.
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a. Click Add to add a system or system group.
b. Click Remove to remove a system or system group.

4. Click Show Compliance Policies.
5. Select one of the following policies to create or, if it already exists, configure it:
v Policy to ensure that the latest released updates are always applied
v Policy to ensure that specific version levels of updates are maintained

Important: If a policy already exists and you select and configure the other
policy, the existing policy and its compliance checks are removed when you
save the new policy.
If the chosen policy already exists, the table displays all associated compliance
checks. If the chosen policy does not already exist, the table is empty.

6. Choose a task to perform on the selected compliance policy:
v Create a new compliance check. Complete the following steps:

a. In the displayed table, click Add.... The Add... page is displayed.
b. In the Show: list, select the type of updates to display in the table.

Note: If you are adding a compliance check to the “Policy to ensure that
the latest released updates are always applied” policy, you can choose
from among only dynamic update groups. If you are adding a
compliance check to the “Policy to ensure that specific version levels of
updates are maintained” policy, you can choose from among only
individual updates or static update groups.

c. Choose the updates or update groups to include in the compliance policy.
d. Click OK to add the updates or update groups to the compliance policy.

v Remove a compliance check. Select a compliance check, then select Actions >
Remove.

7. Click Save to save the changes to the compliance policy. This will activate the
selected compliance policy and any compliance checks that you set up for it,
and will remove any previously existing compliance policies and compliance
checks.

Example

If you create a static update group where some of the updates supersede others,
the compliance policy verifies that the latest superseding update is installed. The
recommendation that comes from this type of compliance policy will be to install
the latest update in the supersede chain.

As an example, consider an update group with these attributes:
v It is a static update group.
v Group members are updates named UpdateA, UpdateB, and UpdateC.
v UpdateA supersedes UpdateB.
v UpdateB supersedes UpdateC.

When a compliance policy is created with this group, the compliance policy
verifies that the latest supersede update (UpdateA in this case) is installed, and, if
it is not, the recommended action is to install the latest update in the supersede
chain (UpdateA in this case). Even if both UpdateB and UpdateC are installed, the
compliance policy indicates 'out of compliance' unless UpdateA is installed. If
UpdateB and UpdateC are not found on the system, but UpdateA is present on the
system, the compliance policy indicates that the system is in compliance.

Chapter 10. Updating systems 433



Identifying systems that are out of compliance
Identify systems that are out of compliance so that you can take recommended
corrective action.

Before you begin

This function does not give you information about all your systems, just those that
are monitored by compliance policies.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

The system-compliance status indicator represents the highest severity among all of
the compliance policy updates that are not installed on the system. There are five
compliance categories, represented by icons:

 

: Indicates a missing update severity of critical or high
 

: Indicates a missing update severity of medium or low
 

: Indicates a missing update severity that is not known or not
applicable
 

: Indicates systems that are in compliance; they have no missing
updates
 

: Indicates systems that are not accessible or do not have inventory
collected

To identify systems that are out of compliance according to an active compliance
policy, complete the following steps:

Procedure
1. On the Update Manager summary page, find the Update Compliance section.
2. Examine the pie chart and icons to its right. The number of systems in each

compliance category is displayed.

Note: The compliance pie chart is visible only if you have already created a
compliance policy for your system.
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3. If one or more system is in need of updates, click one of the systems links next
to the severity icons (which are next to the pie chart). This displays a table of
systems.

4. Optional: You can also click the View all issues link to the bottom right of the
pie chart to view all compliance issues for all systems that are in a policy and
are in need of updates.

5. Examine the Compliance column to find which systems are in need of updates.
The highest severity of all the missing updates is displayed.

6. Select one or more systems.
7. Click System Health > Compliance Issues The View All Issues page is

displayed.
Those systems that have the same compliance issues are grouped, and the total
number of systems is displayed.

8. Click a compliance issue to expand and filter the list of individual systems.
Otherwise, each system with each particular issue and recommendation is
listed.

Resolving compliance issues
When a compliance policy indicates that there are updates that are required on one
or more systems, examine the severity of the updates, and plan to install them
considering your system's availability, workload, and scheduling factors.

Before you begin

Use this procedure only if one or more of your systems is out of compliance, as
indicated by the Compliance column in the list of monitored systems, or as
indicated by the pie chart on the Update Manager summary page.

Note: The compliance pie chart is visible only if you have already created a
compliance policy for your system.

About this task

The Compliance column visually indicates that a system is not in compliance. The
status severity is the highest severity of all the updates needed by the system.

To correct an out-of-compliance situation, complete the following steps:

Procedure
1. Click the compliance status in the Compliance column to see the Issues and

Recommendations panel.
2. Read the recommended action. Make sure that you understand the proposed

actions.
3. Choose the issues that you want to resolve and then click either Install or

Uninstall, according to the recommendation. The appropriate wizard starts.
You can choose to resolve all issues at once instead of resolving them
individually.
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Chapter 11. Monitoring system status and health

IBM Flex System Manager provides a set of tools that you can use to monitor and
manage the status and health of resources in your environment from a single
interface.

About this task

Note: The Chassis Manager view in the management software web interface is the
primary interface for selecting managed resources and performing management
tasks on those resources. However, some of the procedures in this section include
steps that instruct you to use the navigation area, which is hidden by default in the
web interface.

The navigation area provides links to tasks and task categories such as Resource
Explorer, Inventory, and Health Summary. To open the navigation area, click the
tab with the arrow icon on the left side of the screen.
Related tasks:
Automating tasks
By creating event automation plans and applying them to specific systems, you can
automate tasks and other responses to situations that occur in your
systems-management environment. For example, when a specified threshold is
reached or a specified event occurs, you can be notified by e-mail or phone. Or,
you can configure an event automation plan to start a program on a system or
change a system variable when a specific event occurs.

System status and health
IBM Flex System Manager automatically retrieves and displays the status of
systems that have been discovered. You can display this information using one of
the System Status and Health tasks, by navigating to a specific resource in IBM
Flex System Manager, or by using the command-line interface.

Use this topic to learn about the following:
v “About system status and health”
v “Working with system status and health” on page 438
v “System status and health summary” on page 438
v “System status and health tasks” on page 439

About system status and health

Before you can view the status of any resources, IBM Flex System Manager must
first discover and be able to access those resources. After a system has been
discovered, IBM Flex System Manager automatically monitors the system and its
resources.

The status of an entire system reflects the status of the component on the system
that has the most severe status. For example, if a component within a system has a
status of critical, the entire system will have a status of critical, even if the critically
impacted component is not critical to the system.
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IBM Flex System Manager provides several tools and views to monitor and
manage the resources within your environment. See the section ““System status
and health summary” for details.”

Working with system status and health

The approach you use to manage resources depends on how you prefer to view
them and what you are looking for when checking their statuses. Examples of
approaches that you can use for different situations are as follows:
v After connecting a new hardware device to your network, you might want to

check the status of the hardware. Rather than navigate to the Health Summary
page, you can drill down from the Resource Explorer page and navigate directly
to the new hardware to view its status.

v If there is a problem with your network and you do not know the resource that
is causing the problem, it might be quickest to navigate to the Health Summary
page to identify the problem areas and drill down to the resources that are
causing the problem.

System status and health summary

There are several ways to view the system status and health summary:

Banner
The banner on the upper-right of the IBM Flex System Manager web
interface displays this information for all Flex System Manager managed
systems:
v The total number of “critical”, “warning”, or “minor” health status

issues
v The total number of “out of compliance” issues

System Status and Health > Scoreboard
The scoreboard displays the total number of endpoints with active problem
reported. This total includes the following:
v The number of Flex System Manager managed systems with active

problems reported.
v The number of Flex System Manager managed systems that are not in

compliance with their configured compliance policies.

System Status and Health > Active Status
The 'Active Status' page displays all active events reported on Flex System
Manager managed systems. The table lists “information” events and
compliance events as well as “critical” and “warning” issues. Therefore, the
number of entries in the Active Status table can be greater than the number
of problems listed on the banner count.

Problems (Active Status)
The Problems (Active Status) table lists all active “critical”, “warning”, or
“minor” events reported on Flex System Manager managed systems. The
banner count should match this count.

Power Systems Management 
This page lists the number of Flex System Manager managed IBM Power
resources with “critical”, “warning”, or “informational” events. This
number includes the endpoints on which all or some alerts have been
ignored.
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System status and health tasks

The System Status and Health tasks simplify your work as a system administrator
by providing consolidated views of the health and status of your entire
environment. Specifically, the Health Summary task displays information about the
resources that IBM Flex System Manager has discovered. You can customize the
content that is displayed on the System Status and Health pages with information
that is specific to your business processes and organizational structure. In addition,
you can view detailed real-time data by adding monitors to the dashboard.

Use the System Status and Health tasks to perform the following functions:
v Determine the health and performance of resources in your environment.
v Identify the causes behind changes in the health of a resource.
v Display charts that indicate real-time usage data for resources.
v Set thresholds to quickly determine whether the resources are in an abnormal

state.
v Run tasks on resources in response to status changes or system management

needs.
v Take action to resolve issues for resources.
v Launch the event log viewer.

Use the following System Status and Health tasks to view the system's status:

Performance Summary
The Performance Summary task displays available monitors with which
you can examine the servers, virtual servers, or operating systems that you
specify. Use this page to dynamically view, monitor, and work with
processor pools, memory pools, networks, and other critical areas of your
environment.

Health Summary
The Health Summary task displays several resource-monitoring tools on a
single page. Together, these tools provide a single, consolidated interface
with which you can quickly view the status of important areas of your
environment, monitor critical resources, and view the contents of
user-defined health summary groups.

Monitors
The Monitors task provides the tools that you need to retrieve real-time
status and quantitative data for specific properties and attributes of
resources in your environment. You can also set thresholds for the
monitors, graph the data that monitors retrieve, and drill down to quickly
view the status of resources for each system and the name of the monitor
so that you can view its properties.

Thresholds
The Thresholds task offers a consolidated view of all the thresholds that
you have created to monitor the dynamic properties of your resource. This
task saves you from searching for them all in the Monitors task.

Problems
The Problems task lists only those elevated status set entries that are
problem status set entries that have been reported to IBM Flex System
Manager. The data listed here is a subset of what is listed on the Active
Status page. From the Problems page, you can navigate to, display, and
manage these status set entries. You can also ignore entries to prevent IBM
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Flex System Manager from collecting them or delete the entries to remove
them from the list until they occur again.

Active Status
The Active Status task lists all of the status set entries, including problems
and compliance issues, that have been reported to IBM Flex System
Manager. From the Active Status page, you can navigate to, display, and
manage these status set entries. You can also ignore entries to prevent IBM
Flex System Manager from collecting them or delete the entries to remove
them from the list until they occur again.

Event Log
An event is an occurrence of significance to a task or resource. Examples of
events include operation completion, hardware component failure, or a
processor threshold being exceeded. The Event Log task displays all events
that the management server receives from any resource for which you can
view events.

SNMP Browser
The SNMP Browser task enables you to display, inspect, and perform
certain actions on SNMP-compliant resources, including selecting the
targets on which an SNMP job will run.

Viewing the status manager summary
You can view a summary of the current activity that is associated with status,
including the status of the systems in your environment, the number of recordings
and thresholds, and detailed status. The information on the summary page
refreshes automatically when there are any changes.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To view the status manager summary, complete the following steps:

Procedure
1. On the Home page, click the Plug-ins tab. A list of available summary pages is

displayed.
2. On the Plug-ins tab, select Status manager. The status manager summary is

displayed.
3. View the Status section. This section provides the following information:

There are four status categories, represented by icons:
v A pie chart and corresponding list that indicates the number of systems that

fall into each of the following four status categories:
Critical
Warning
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Informational
OK

Click any of the category list items to see a breakdown of the systems in that
category.

v In the Status tasks area, the following links are provided:
Health summary

Use the Health Summary page to quickly view the status of
important areas of your environment, monitor critical resources, and
view the contents of user-defined health summary groups.

View problems
Use the Problems page to view the elevated status for categories that
are part of the problems composite category and ignore or delete the
entries. The problems composite category includes all categories,
such as hardware status and threshold status, except compliance and
LED.

View active and ignored status
Use the Active Status page to view all status set entries for resources
in your environment and ignore or delete the entries.

Groups by status
Use the Groups by status page to view a list of groups that represent
resources grouped by status.

4. View the Management section. This section provides the following information:
v The number of thresholds that are active and not active. Click the link to

view the Thresholds page
v In the Common tasks area, the following links are provided:

Monitors
Use the Monitors page to create and work with monitors.

Thresholds
Use the Thresholds page to work with thresholds.

Event log
Use the Event Log page to view events according to filters that you
select.

Viewing the performance summary
Use the Performance Summary task to examine performance information selected
from available monitors for the resources that you specify.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

Selecting the target resources populates the rows of Performance Summary table.
The available monitors for each target resource determine the columns (attributes)
that you can display.
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The Performance Summary page displays multiple pages. Which pages display
depends on your IBM Flex System Manager installation. A base installation
displays at least a Processor page and a Memory page.

To view performance information for a target resource, complete the following
steps:

Procedure
1. On the Initial Setup tab of the Home page, click Chassis Manager.
2. On the Chassis Manager page, type Performance Summary in the Find field.
3. Specify one or more target resources (servers, virtual servers, or operating

systems) for which you want to examine the performance information. Click
Browse if you want to search for a resource. The Performance Summary table
is created and populated with the targets that you specified.

4. Specify the type of performance information that you want to display in each
column. Each column represents an attribute reported by an available monitor.
a. Click Select Column Monitors

b. In the Columns window, select one or more entries from the Available
Columns list, then click Add to move them to the Selected Columns list.

c. If you want, select one or more entries from the Selected Columns list, then
click Remove to remove them from the list.

d. Click OK to save your changes.

The updated table displays performance data in the columns that you specified.
5. One way to work with the table entries is to right-click a target, then select

Column Monitors to choose a monitor that you want to use.
6. Select the performance data that you want to examine, then select how you

want to interact with the data:
a. Select Activate Threshold to display the Threshold page, where you specify

how to activate the threshold.
b. Select Graph to display the Graph page, where you can view a graphical

rendering of the data.
c. Select Add To Dashboard to add a graphical rendering of the data to your

dashboard. Specify a name for the monitor view and select the type of
graph that you want to display.

Related concepts:
Dashboard
The Dashboard section of the Health Summary page displays a real-time, graphical
representation of resource status based on the measurable properties for the
resource that you have set. You can display this data in various formats to help
monitor resources. Use the Monitors task to add items to the dashboard.
Related tasks:
Managing monitors
The Monitors task provides the tools that you need to retrieve real-time status and
quantitative data for specific properties and attributes of resources in your
environment. You can also set thresholds for the monitors, graph the data that
monitors retrieve, and drill down to quickly view the status of resources for each
system and the name of the monitor so that you can view its properties.
Activating a threshold
You can activate thresholds that have been previously deactivated.
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Using the Health Summary task to view the status of your environment
The Health Summary task displays several resource-monitoring tools on a single
page. Together, these tools provide a single, consolidated interface with which you
can quickly view the status of important areas of your environment, monitor
critical resources, and view the contents of user-defined health summary groups.

Before you begin

Before you can view the status of any resources, IBM Flex System Manager must
first discover and be able to access those resources.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

IBM Flex System Manager provides multiple ways to check the status of a specific
resource in your environment. Use the Health Summary page to see a consolidated
view of the health and status of your system resources, storage resources, and
thresholds. These indicators help to identify areas within your environment that
might have problems or issues that you need to resolve. You can view the status of
several resources and quickly view details for those resources that are causing a
problem.

The Health Summary page contains the following sections:
v Scoreboard
v Dashboard
v Health Summary

By displaying a consolidated view of the health of your systems, storage resources,
and thresholds, these panels provide the information and tools that you can use to
monitor and manage systems and resources across multiple platforms from a
single interface.

Note: You are not required to first collect inventory for a resource for it to be
displayed on the Health Summary page.

The health summary task provides the following functions:
v Retrieves and displays the status and health of resources that you specify.
v Displays charts that indicate real-time data for resources and thresholds.

To view the status and health of your environment resources from the centralized
location of the Health Summary page, complete the following steps:
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Procedure
1. On the Home page, click the Plug-ins tab. A list of available summary pages is

displayed.
2. On the Plug-ins tab, click Health Summary under Status manager.
3. Choose an item and drill down to view its details.

Scoreboard
The scoreboard displays a table in which each row represents an area or category
of information. Each element of the table, including column headers, row headers,
and cell data, is potentially clickable and displays specific data. Each column
header in the scoreboard identifies a severity status associated with the
corresponding categories. At the intersection of each row and column is a number
that represents the number of resources that adhere to the conditions of both the
row and the column that intersect. Each resource is counted only once, regardless
of the number of issues it has. Clicking the number displays the resources. Only
the systems to which you have access are displayed on the scoreboard.

The scoreboard displays the status of important areas of your environment by
using three severity levels; critical, warning, and informational. A system that
reports multiple severities is always grouped under the highest severity. For
example, if a system has both critical and warning events, it is shown under
critical and is not listed under warning. From the totals, icons, and category names
in the scoreboard, you can drill down to view various details about the systems
that are reporting system health and performance issues.

In order for IBM Flex System Manager to monitor the vital signs related to the
health and performance of a target system, the target system must have Common
Agent or Platform Agent installed on it. Agentless managed systems are also
counted if they are configured to report performance issues and if they have one of
the following protocols installed:
v Secure shell (ssh)
v Distributed Component Object Model (DCOM), an extension of the Microsoft

Component Object Model (COM) to support objects distributed across a
network.

v Simple Network Management Protocol (SNMP)

Examples of agentless-managed systems are management modules and Remote
Supervisor Adapters (RSAs).

By default, IBM Flex System Manager counts and displays the totals for the
following status categories:

Compliance
Identifies software-update and compliance-related status issues. The
compliance status category is populated only when a compliance policy is
re-validated due to a variety of different events.

Problems
Includes all types of issues including hardware, software, inventory, and
power-related status issues.

LED Status
Identifies the aggregate state of all hardware LEDs. Each LED identifies the
state of a related hardware component. LED status is updated when any
hardware LED changes. For example, if there is a CPU LED fault, then the
CPU LED is lit and LED status is “Critical”.
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Dashboard
The Dashboard section of the Health Summary page displays a real-time, graphical
representation of resource status based on the measurable properties for the
resource that you have set. You can display this data in various formats to help
monitor resources. Use the Monitors task to add items to the dashboard.

To display information in the dashboard, you must first set up and configure the
monitors to indicate the information that you want retrieved. By default, the
dashboard is initially empty. To add charts to the dashboard, you must use the
Monitors task to display existing monitors and target systems. From the Monitors
page, you can find the appropriate monitors and then add them to the dashboard.

You can add only one monitor to the dashboard for each graph. Additionally, you
can add only bar and line graphs for group monitor thumbnails in the dashboard.

Health summary
The Health Summary section of the Health Summary page displays selected
resources that you have chosen to watch closely. With this section, you can quickly
view and monitor the resources that are most important to you. You can perform
actions on a resource by using the Actions menu. You can also drill down to
display the properties and other details for each resource. To display information
in the health summary, you must first set up and configure the groups that you
want to display.

To view the health summary, expand System Status and Health in the IBM Flex
System Manager Web interface navigation pane and click Health Summary. The
scoreboard, dashboard, and health summary display the status and health of your
environment.

The Favorites group and the Systems with Problems group both appear in the
health summary by default. You can add or remove groups of resources from the
health summary. You can also create new health summary groups.

After you have discovered applicable resources, use the Health Summary Group
Editor wizard to add the most important or critical systems in your environment to
a health summary group. After a health summary group has been created, you can
add the group to the health summary.

Using the scoreboard to identify issues
From the Health Summary page, you can select items in the scoreboard and drill
down to details that help locate and identify issues within your environment.

Before you begin

The scoreboard counts and then displays only those systems that have been
discovered and are accessible, and have reached a critical, warning, or
informational level. Before you can view the status of any resources, IBM Flex
System Manager must first discover and be able to access those resources.

About this task

Note:
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This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

The scoreboard is a table that comprises columns, rows, and individual totals in
cells. You can drill down from the icons (column headers), category names (row
headers), or totals (in the cells) to view various details about the systems that are
reporting system health and performance issues.

Totals If you click a totals number in the scoreboard, you are presented with a list
of entries that contains the number of systems in the list equal to the
number on which you clicked. For example, if two systems in your
environment have a combined total of five critical problems, the number 2
is displayed in the scoreboard to represent those two systems. When you
click the 2, you see all five critical problems.

Icons When there is a number in the scoreboard, the severity icon above that
number becomes a clickable link. When selected, the link displays all the
entries with that severity from every category. For example, if two systems
in your environment have five critical problems and three critical
compliance issues between them, the number 2 is displayed under the
Critical icon for the Problems category and the number 2 is displayed
under the Critical icon for the Compliance category. The Critical icon at the
top of the scoreboard is enabled. If you click the Critical icon, you are
presented with a list of eight items: five critical problems and three critical
updates.

Categories
When there is a number in the scoreboard for a category, that category
name in the scoreboard becomes a clickable link. When selected, the link
brings up all the entries for all severities for that category. For example, if
two systems have five critical problems, four other systems have a total of
four warning problems, and one other system has one informational
problem, then there are three numbers in the scoreboard for the Problems
category: 2, 4, and 1, which represent numbers of systems with each type
of problem. When you click the Problems category, you see a list of ten
items, which are all the problems across all the systems.

Note: If there are no resources with a particular status for a category, the
intersecting cell will display a hyphen (-) instead of a number.

To use the scoreboard to identify problems, complete the following steps:

Procedure
1. On the Home page, click the Plug-ins tab. A list of available summary pages is

displayed.
2. On the Plug-ins tab, click Health Summary under Status manager. The

scoreboard, dashboard, and health summary display the status and health of
your environment.

3. In the scoreboard, select one of the following filtering methods:
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Table 53. Filtering methods

To do this task: Complete these steps:

Filter based on severity status In the scoreboard, click the icon for one of
the following severity status values:

Critical A system that has generated an
event with a severity of 0 or 1 is
the most severe and is identified in
IBM Flex System Manager as being
in a critical state. These systems
have already lost or will
imminently lose data, have had
system downtime, or are on the
verge of losing some other services.
Leaving the problem uncorrected
might have an impact on system
operation.

Warning
A system that has generated an
event with a severity of 2 or 3 is
identified in IBM Flex System
Manager as being in a warning
state. These systems can escalate to
a critical state if left uncorrected.
Leaving the problem uncorrected
might not have an impact on
system operation, so normal use of
the system can probably continue.

Informational
A system that has generated an
event with a severity of 4 is
identified in IBM Flex System
Manager as being in an
informational state. These systems
are operating normally and
typically, so no action is required.

Note: A system that has generated an event
with a severity of 5 is in an unknown state.
The unknown state is not included in most
IBM Flex System Manager tasks.

The resources with the selected severity
level are displayed in the Resource Explorer
table.

Filter based on type of issue In the scoreboard, click one of the listed
categories. The resources with the selected
issue type are displayed in the Resource
Explorer table.

Filter based on both status and issue Click the number in the scoreboard that
corresponds to the severity level and the
type of issue that you want to be displayed.
For example, if two systems have critical
problems, the number 2 would be displayed
under the critical icon on the Problems
category. If you click that number, those
resources with a critical severity level for the
problems type of issue are displayed.
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4. Navigate to the resource that you want to view and click it to view its
subsystems or related resources. The number of pages and the types of
information that these subsystems or related resources include vary depending
on the resource.

5. Click through the pages until you find the resource that has caused the
problem.

Adding a graphical monitor to the dashboard
Monitors are dynamic in nature and can be easily monitored graphically by
configuring IBM Flex System Manager to display the information. When you select
Add to Dashboard for an individual monitor on the Monitors page, a graphical
representation of that monitor is added to the dashboard.

Before you begin

Before you can display any graphical monitors on the dashboard, IBM Flex System
Manager must first discover the systems that you want to monitor. After you have
discovered the applicable systems, you can add them to a group. You can then add
individual monitors to the dashboard.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To configure the dashboard to display the monitors you want, complete the
following steps:

Procedure
1. On the Home page, click the Plug-ins tab. A list of available summary pages is

displayed.
2. On the Plug-ins tab, click Health Summary under Status manager.
3. In the dashboard, click Show Monitors. The Monitors page is displayed.
4. To select one or more target resources, click Browse. The Context Chooser is

displayed.
5. Use the Context Chooser to add one or more resources or groups of resources

as a target:
a. To add a group, select the group that you want to add as a target. To add a

single resource, drill down from the group that includes the resource that
you want to add and select the resource.

b. Click Add.
c. Continue selecting groups or resources as needed.
d. When you are finished adding targets, click OK.
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6. From the Monitor selection page, select the monitor view that you want to be
displayed for the targets that you selected.

7. Click Show Monitors. The Monitor View page listing monitors for the targets
that you selected is displayed.

8. Right-click the monitor that you want to be displayed on the dashboard and
select Add to dashboard.

What to do next

After adding a monitor to the health summary, navigate to the Health Summary
page to verify that the monitor is displayed in the dashboard.

Removing a graphical monitor from the dashboard
From the Health Summary page, you can remove charts from the dashboard.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To remove a chart from the dashboard, complete the following steps:

Procedure
1. On the Home page, click the Plug-ins tab. A list of available summary pages is

displayed.
2. On the Plug-ins tab, click Health Summary under Status manager.
3. In the dashboard, right-click the title of the chart that you want to remove and

click Remove.

Adding systems to the health summary
The health summary displays selected systems that you have chosen to watch
closely. Use this panel to quickly view and monitor the systems that are most
important to you.

About this task

By default, the health summary displays the status of systems that belong to the
health summary favorites group and the Systems with Problems group. To add
additional systems to the health summary, choose one of the following methods:
v Add additional systems to the health summary favorites group.
v Add additional systems to another group and add that group to the health

summary using either the Resource Explorer task or the Actions menu in the
health summary.
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Using the health summary favorites group to add and remove
systems in the health summary
Use the Health Summary task to add and remove systems in the favorites group
and display them in the health summary.

Before you begin

Before you can add or remove a system from the health summary favorites group,
IBM Flex System Manager must discover that system.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

By default, the health summary displays the status of systems that belong to the
health summary favorites group.

Note: The health summary also displays the Systems with Problems group by
default.
To add or remove systems in the health summary favorites group to be displayed
in the health summary, complete the following steps:

Procedure
1. On the Home page, click the Plug-ins tab. A list of available summary pages is

displayed.
2. On the Plug-ins tab, click Health Summary under Status manager. The

scoreboard, dashboard, and health summary display the status and health of
your environment.

3. In the health summary, right-click Favorites and select Edit. The Group Editor
Wizard opens and the Welcome page is displayed.

4. Click Next. The Name page is displayed and the Name and Description fields
are filled out for your favorites group.

5. Leave the Name and Description fields as they are and click Next. The Type
page is displayed. You cannot change any values on this page.

6. Click Next. The Define page is displayed.
7. To add systems to the group, select the systems or criteria in the list on the

left and click Add.
8. To remove systems from the group, select the systems or criteria in the list on

the right and click Remove.
9. Continue modifying resources or criteria as needed.

10. Click Next. The Summary page is displayed.
11. Click Finish.

450 Systems Management Guide



Using the Actions menu to add systems to the health summary
Use the Actions menu on the health summary to add any group to the health
summary.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To add a group to the health summary using the Actions menu on the health
summary, complete the following steps:

Procedure
1. On the Home page, click the Plug-ins tab. A list of available summary pages is

displayed.
2. On the Plug-ins tab, click Health Summary under Status manager. The

scoreboard, dashboard, and health summary display the status and health of
your environment.

3. In the health summary, click Actions > Edit. The Group Editor wizard opens.
4. In the Name field, type a descriptive name of the health summary group that

you want to create.
5. In the Description field, type a brief description for the group.
6. Click Next. The Type page is displayed.
7. In the Type list, select one of the following options:

Static Static groups contain a specified list of systems. The members of a
static group are fixed unless you change them.

Dynamic
Dynamic groups are based on specified system criteria. IBM Flex
System Manager prompts you to specify the criteria that the system
attributes and properties must match. Then, when system attributes or
system properties change, its match to the group criteria changes and
IBM Flex System Manager automatically adds or removes the system
to or from the group.

8. In the Member list, select the type of members to add to the group.
9. Click Next.

10. In the left area, select the resources or criteria to use for the group, and click
Add.

11. Continue adding resources or criteria as needed.
12. Click Finish.
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What to do next

After adding a group to the health summary, navigate to the Health Summary
page to verify that the group is displayed. You can configure the columns that are
displayed in the health summary to make it easy to quickly identify the status of
the resources that you are monitoring. As a best practice, ensure that the columns
that are related to health and status are always displayed in the health summary.

Using Resource Explorer to add systems to the health summary
Use the Resource Explorer task to select the resource groups that you want to be
displayed on the health summary.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To add a resource group to the health summary, complete the following steps:

Procedure
1. On the Initial Setup tab of the Home page, click Chassis Manager. Under

General Actions on the Chassis Manager page, click Resource Explorer.
2. Navigate to the group that you want to add to the health summary.

Note: If the group that you want to add does not exist, create it.
3. From the Resource Explorer table, right-click the group that you want to add to

the Health Summary page and select Add to > Health Summary. The Navigate
Resources table is displayed.

Note: If you right-click a system instead of a group, you can add that system
to either the Favorites group or another group of your choosing. Adding the
system to the favorites group will automatically add it to the health summary.
However, if you add the system to another group of your choosing, ensure that
that group is added to the health summary if you want the system to appear
there.

What to do next

After adding a group to the health summary, navigate to the Health Summary
page to verify that the group is displayed.

Removing a group from the health summary
The health summary displays the status of systems that belong to the health
summary favorites group and other groups that you have added to it. You can use
the Health Summary task to remove a group from the health summary.

452 Systems Management Guide



About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To remove a group from the health summary, complete the following steps:

Procedure
1. On the Home page, click the Plug-ins tab. A list of available summary pages is

displayed.
2. On the Plug-ins tab, click Health Summary under Status manager. The

scoreboard, dashboard, and health summary display the status and health of
your environment.

3. In the health summary, right-click the group that you want to remove and click
Remove. A confirmation message is displayed.

4. Click Remove. The group is removed.

Using Resource Explorer to view the status of a specific resource
Use Resource Explorer when you want to view the status of only one resource and
you know exactly which resource it is. Using the Resource Explorer task, you can
navigate to a specific resource and drill down to view detailed status information.

Before you begin

Before you can view the status of any resources, IBM Flex System Manager must
first discover and be able to access those resources.

About this task

If you are using IBM FSM Explorer, you can view the status of your resources by
hovering over and clicking on the resource groups and specific resources within
the interface. Use the finder at the top of the user interface (shown here) to find
specific groups, resources, and tasks:

To view the status of a specific resource using the Resource Explorer task in IBM
Flex System Manager, complete the following steps:

Procedure
1. On the Initial Setup tab of the Home page, click Chassis Manager. Under

General Actions on the Chassis Manager page, click Resource Explorer.
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2. In the Groups column, click the type of resource that you want to find.
3. Click the name of the resource you want to view. The table displays the state,

problems, and compliance status of the resource.

Scenarios: Using custom monitor views, thresholds, and event
automation plans

These example scenarios illustrate ways to use monitors, thresholds, and event
automation plans to report when important or critical disk drive conditions occur.
Each scenario creates a custom a monitor view, activates thresholds for the
monitors in the view, and uses the view and thresholds in an event automation
plan. When reported by the automation plan, the results from each example
indicate the affected disk drives by the letter name given to them on the system.

The scenarios do not specify which action the automation plan automatically
performs, but possible actions include notifying an administrator by phone or
email or running a remote command to correct the reported condition.

Scenario: Using a custom monitor view in an event
automation plan to report disk data by using drive letter
names

This example scenario describes how to create a monitor view and use that
monitor view in an event automation plan. The scenario assumes that you want to
create an event automation plan that monitors the percentage of disk drive space
used by specific disk drives. Additionally, the event automation plan must report
information about the disk drives by using the letter names given to the drives on
the system.

Before you begin

Note: You can monitor only the local drives. You cannot monitor the network
storage drives. For example, the IBM System Storage DS3950.

All tasks for this scenario occur within the IBM Flex System Manager Web
interface, so the scenario assumes some familiarity with browsing the interface and
using it to perform tasks. Also, each of the following steps describes only one way
to perform the action, even if an alternative method exists.

For this scenario, the letter names for the disk drives to monitor are drive c, drive
d, and drive e.

About this task

To create a custom monitor view for disk drives and use it within an event
automation plan, perform the following steps:

Procedure
1. Select the resources that you want to monitor:

a. In the IBM Flex System Manager Web interface navigation area, click
Navigate Resources.

b. Drill down to select the resources that you want to monitor, and select
them.
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c. Click Actions > System Status and Health > Monitors. If System Status
and Health > Monitors is not a choice available to you, one or more of the
resources you selected are not eligible for monitoring. Make sure to select
only resources that can be monitored.

The Monitors task is displayed with the systems that you specified in step 1b
on page 454 already selected.

2. Start creating a monitor view by clicking Actions > Create. The Create View
page is displayed.

3. On the Create View page, in the Name field, type a name for the monitor
group that you are creating.

4. From the Show list, select Selected Resources.
5. Select the monitors for the individual disk drives that you want to monitor:

a. In the Selected Resources table, select SystemName > Director Agent >
Disk Monitors, where SystemName is the name of the system that contains
disk drives that you want to monitor. Monitor information for the disk
drives is displayed.

b. In the Selected Resources table, select the monitors that you want to
include in this monitor group. For example, select Drive C: % Space Used,
Drive D: % Space Used, and Drive E: % Space Used.

c. After selecting the monitors, click Add to add them to the monitor group,
then click OK.

Note: If you want to monitor drives on more than one system, for each system
that contains drives that you want to monitor, repeat step 5a through step 5c.
The Monitors page is displayed, and the Monitor Views table includes the
monitor view that you created.

6. Click the name of the monitor view that you created. The Monitor View page is
displayed.

7. Activate thresholds for the monitors. For each monitor for which you want to
create a threshold, perform the following actions:
a. Right-click the name of the monitor, then select Activate Threshold. The

Threshold page is displayed.
a. On the Threshold page, specify the threshold values and options that you

want to use, then click OK. The Monitor View page is displayed, and the
table shows that the new thresholds are active.

8. Create an event filter to be activated by the thresholds that you created
previously:
a. In the IBM Flex System Manager Web interface navigation area, click

Automation > Event Filters. The Event Filters page is displayed.
b. Click Create to create the filter. The Create Event Filter wizard is displayed.
c. On the Welcome page, click Next. The Filter Name page is displayed.
d. On the Filter Name page, type the name you want to give this event filter,

then click Next. The Filter Type page is displayed.
e. On the Filter Type page, select a filter type of Threshold event filter, then

click Next. The Event Type page is displayed.
f. On the Event Type page, select an event type of Custom. This scenario

assumes that the event filter does not include IBM i message queue events.
g. In the Event Types table, click Director > Director Agent (Component

Category) > Disk Monitors. The Event Types table displays the disk drive
event types.
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h. Click the appropriate disk drive event component category, for example,
Drive C: % Space Used (Component Category). The Event Types table
displays thresholds for the specified disk drive.

i. Select the thresholds that you want to activate the event filter, click Add.
j. After you add all the necessary thresholds, click Next.
k. On all subsequent pages (until the Summary page is displayed), accept the

default values or specify the values that you want to use, then click Next.
l. On the Summary page, review the settings for the event filter. Click Back if

you want to change any settings. When you are satisfied with the settings,
click Finish to create the event filter.

9. Create the event automation plan that uses the event filter you created in the
previous step:
a. In the IBM Flex System Manager Web interface navigation area, click

Automation > Event Automation Plans. The Event Automation Plans page
is displayed.

b. Click Create to create the event automation plan. The Create Event
Automation Plan wizard is displayed.

c. On the Welcome page, click Next. The Name and Description page is
displayed.

d. On the Name and Description page, type a name for the event automation
plan, then click Next. The Targets page is displayed.

e. On the Targets page, use the Show list and the Available table to select the
target systems that you want to be affected by the event automation plan.
For each target system that you select, click Add.

f. After you add all the targets, click Next. The Events page is displayed.
g. On the Events page, from the Events list, select Advanced Event Filters.

The Event Filters table is displayed.
h. From the Event Filters table, select the event filter that you created

previously, then click Next. The Event Actions page is displayed.
i. On the Event Actions page, select one or more event actions that you want

to occur when this event automation plan is triggered, then click Next. The
Time Range page is displayed.

j. On the Time Range page, specify the time range that determines when the
event automation plan is active, then click Next. The Summary page is
displayed.

k. On the Summary page, review the settings for the event automation plan.
Click Back if you want to change any settings. When you are satisfied with
the settings, click Finish to create the event automation plan.

Results

When triggered, the event automation plan reports the percentage of space used on
the disk drives, which it identifies by the associated letter names.

Scenario: Using a custom monitor view in an event
automation plan to report cluster drive data using drive letter
names

This example scenario describes how to create a monitor view and use that
monitor view in an event automation plan. The scenario assumes that you want to
create an event automation plan that monitors the percentage of disk drive space
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used on specific cluster drives. Additionally, the event automation plan must
report information about the disk drives by using the letter names given to the
drives on the system.

Before you begin

All tasks for this scenario occur within the IBM Flex System Manager Web
interface, so the scenario assumes some familiarity with browsing the interface and
using it to perform tasks. Also, each of the following steps describes only one way
to perform the action, even if an alternative method exists.

For this scenario, the letter names for the cluster drives to monitor are drive m and
drive n.

About this task

To create a custom monitor view for cluster drives and use it within an event
automation plan, perform the following steps:

Procedure
1. Select the resources that you want to monitor:

a. In the IBM Flex System Manager Web interface navigation area, click
Resource Explorer.

b. Drill down to select the resources that have the cluster drives that you want
to monitor, and select them.

c. Click Actions > System Status and Health > Monitors. If System Status
and Health > Monitors is not a choice available to you, one or more of the
resources you selected are not eligible for monitoring. Make sure to select
only resources that can be monitored.

The Monitors task is displayed with the systems that you specified in step 1b
already selected.

2. Start creating a monitor view by clicking Actions > Create. The Create View
page is displayed.

3. On the Create View page, in the Name field, type a name for the monitor
group that you are creating.

4. From the Show list, select Selected Resources.
5. Select the monitors for the individual cluster drives that you want to monitor:

a. In the Selected Resources table, select SystemName > Director Agent >
Windows Performance Monitors > LogicalDisk > DriveName, where
v SystemName is the name of the system that contains the cluster drives
v DriveName is the letter name of the cluster drive that you want to

monitor

Monitor information for the cluster drive is displayed.
b. In the Selected Resources table, select the monitors that you want to

include in this monitor group. In this scenario, the monitor must report the
percentage of disk space used, but no available monitor for that
measurement exists. Select % Free Space, for which a threshold can be set
to report the percentage used.

c. After selecting the monitor, click Add to add it to the monitor group, then
click OK.
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Note: If you want to monitor drives on more than one system, for each system
that contains drives that you want to monitor, repeat step 5a on page 457
through step 5c on page 457.
The Monitors page is displayed, and the Monitor Views table includes the
monitor view that you created.

6. Click the name of the monitor view that you created. The Monitor View page is
displayed.

7. Activate thresholds for the monitors. For each monitor for which you want to
create a threshold, perform the following actions:
a. Right-click the name of the monitor, then select Activate Threshold. The

Threshold page is displayed.
b. On the Threshold page, specify the threshold values and options that you

want to use, then click OK.

Tip: In this scenario, the maximum threshold value must be a high value of
75% or more disk space used. The monitor reports only the percentage of
free space. To report when the disk has 75% or more disk space used, the
threshold must be set for a low value of 25% or less free disk space.
The Monitor View page is displayed, and the table shows that the new
thresholds are active.

8. Create an event filter to be activated by the thresholds that you created
previously:
a. In the IBM Flex System Manager Web interface navigation area, click

Automation > Event Filters. The Event Filters page is displayed.
b. Click Create to create the filter. The Create Event Filter wizard is displayed.
c. On the Welcome page, click Next. The Filter Name page is displayed.
d. On the Filter Name page, type the name you want to give this event filter,

then click Next. The Filter Type page is displayed.
e. On the Filter Type page, select a filter type of Threshold event filter, then

click Next. The Event Type page is displayed.
f. On the Event Type page, select an event type of Custom. This scenario

assumes that the event filter does not include IBM i message queue events.
g. In the Event Types table, click Director > Director Agent (Component

Category) > Windows Performance Monitors > Logicaldisk > DriveName
> % Free Space (Component Category), where DriveName is the name of
the cluster drive that you want to monitor. The Event Types table displays
the cluster drive event types.

h. Click Low Warning, then click Add.

Remember: To report a high value for the percentage of disk space used,
the threshold is set to report a low value for the percentage of disk space
free.
The selected event type is added to the Selected list.

i. After you add all the necessary thresholds, click Next.
j. On all subsequent pages (until the Summary page is displayed), accept the

default values or specify the values that you want to use, then click Next.
k. On the Summary page, review the settings for the event filter. Click Back if

you want to change any settings. When you are satisfied with the settings,
click Finish to create the event filter.

9. Create the event automation plan that uses the event filter you created in the
previous step:
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a. In the IBM Flex System Manager Web interface navigation area, click
Automation > Event Automation Plans. The Event Automation Plans page
is displayed.

b. Click Create to create the event automation plan. The Create Event
Automation Plan wizard is displayed.

c. On the Welcome page, click Next. The Name and Description page is
displayed.

d. On the Name and Description page, type a name for the event automation
plan, then click Next. The Targets page is displayed.

e. On the Targets page, use the Show list and the Available table to select the
target systems that you want to be affected by the event automation plan.
For each target system that you select, click Add.

f. After you add all the targets, click Next. The Events page is displayed.
g. On the Events page, from the Events list, select Advanced Event Filters.

The Event Filters table is displayed.
h. From the Event Filters table, select the event filter that you created

previously, then click Next. The Event Actions page is displayed.
i. On the Event Actions page, select one or more event actions that you want

to occur when this event automation plan is triggered, then click Next. The
Time Range page is displayed.

j. On the Time Range page, specify the time range that determines when the
event automation plan is active, then click Next. The Summary page is
displayed.

k. On the Summary page, review the settings for the event automation plan.
Click Back if you want to change any settings. When you are satisfied with
the settings, click Finish to create the event automation plan.

Results

When triggered, the event automation plan reports the percentage of free space on
the cluster drives. (In this case, the measurement desired is the percentage of space
used on the cluster drives, which you have to manually compute from the known
free space.) The data reported by the event automation plan identifies the cluster
drives by their associated letter names.

Monitors and thresholds
Monitors provide the means to retrieve and visually observe real-time changes in
system resources. Activating thresholds on monitors offers a way to trigger events
or report problems when the monitored resource exceeds the threshold. IBM Flex
System Manager includes monitor views, which are groups of monitors that belong
to a specific category. Examples of monitor views are AIX monitors and SNMP
monitors. Create custom monitor views that contain collections of monitors that
you find useful. Combine monitors, thresholds, and automation plans to automate
troubleshooting or corrective actions in response to reported warnings or critical
situations.

Monitors

Use monitors to observe changes in system resources on physical servers, virtual
servers, supported operating systems and hardware, and Virtual I/O Servers
(VIOS). The IBM Flex System Manager Web interface offers various locations where
you can use monitors. For example, on the Health Summary page, display one or
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more specified monitors as graphs on the dashboard. View lists of monitors on the
Monitor page or see real-time data in columns on the Virtual Servers and Hosts
page. The Performance Summary page has a number of tabs, each of which offers
a selection of monitor columns. Additionally, some other resource tables offer the
ability to add or remove monitor columns, which provides an easy way to visually
monitor a variety of system resources within the table.

Monitor views are groups of commonly supported monitors. Some monitors that
are included in a monitor view might be unavailable to you because the managed
resource does not support them. Several factors determine which monitors are
available to use. Determining factors might include the operating system, hardware
configuration, and software configuration of the managed resource. Creating a
custom monitor view might make available to you additional monitors not
included in the default monitor views.

Thresholds

A threshold is a high or low limit that you do not want the monitored system
resource to exceed. For both the high threshold and the low threshold, you have
the option of specifying a warning value and a critical value. For example, the
high threshold for a monitor that measures the percentage of used space on a disk
drive might have a warning value of 80 and a critical value of 90.

Activating a threshold includes setting options that include specifying whether to
generate an event when the threshold is exceeded and determining the amount of
time the threshold waits before resending the information. When the monitored
resource exceeds the specified value for any threshold limit, the monitor displays
the appropriate icon for a warning or critical notification.

The next step in using monitors and thresholds is to combine them with one or
more event actions in an event action plan, making it possible to automate
troubleshooting and corrective responses to predetermined events. For more
information, see “Events, filters, and actions in event automation plans.”
Related concepts:
Events, filters, and actions in event automation plans
An event automation plan lets you automatically respond to a situation in your
IBM Flex System Manager environment. By creating event automation plans and
applying them to specific systems, you can be notified by e-mail, for example,
when a specified threshold is reached or a specified event occurs. Or, you can
configure an event automation plan to start a program on a system in response to
the event.
Related tasks:
Managing monitors
The Monitors task provides the tools that you need to retrieve real-time status and
quantitative data for specific properties and attributes of resources in your
environment. You can also set thresholds for the monitors, graph the data that
monitors retrieve, and drill down to quickly view the status of resources for each
system and the name of the monitor so that you can view its properties.
Managing thresholds
The Thresholds task offers a consolidated view of all the thresholds that you have
created to monitor the dynamic properties of your resource. This task saves you
from searching for them all in the Monitors task.
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Monitor views
Use the Monitors task to monitor critical system resources on your managed
systems. IBM Flex System Manager arranges available monitors in groups called
monitor views. Each view represents a list of the most commonly available
monitors in a category, for example, monitors that are supported by AIX. Use
existing monitor views or create your own views that contain the selections of
individual monitors that you find useful.

Several factors determine the availability of individual monitors in a monitor view.
Determining factors might include the operating system, hardware configuration,
or software configuration of the managed resource. Depending on those factors,
some monitors included in a view might be unavailable in your environment.

Note: The following topics describe only some of the available monitor views. The
optional features that are purchased with the management node determine which
preconfigured monitor views are available in the Flex System Manager. For more
information about the monitors that are associated with a particular plug-in, see
the documentation for that plug-in.

When you create a monitor view, the Create View page presents all the available
monitors in each category, not just the most common monitors. Creating your own
monitor view makes available additional monitors that are not in the commonly
used sets of monitors included in the default monitor views.

Polling intervals (or how often data collection is performed) for monitors depend
on the managed system or device. In general, using the default settings, data
collections occur every 5 - 10 seconds, and the display refreshes every 10 - 20
seconds. Polling intervals affect the minimum granularity and timeliness of any
thresholds applied to a monitor.

AIX Monitors view
The AIX Monitors view contains some of the monitors most commonly reported by
installed versions of AIX as being available to IBM Flex System Manager. When
you create your own monitor view, additional individual AIX monitors might be
available.

The following table lists some of the most commonly available monitors from the
AIX Monitors view and the data that each monitor retrieves.

Note: Several factors determine the availability of the individual monitors listed in
the following table. Determining factors might include the operating system,
hardware configuration, or software configuration of the managed resource.
Depending on those factors, some monitors listed in the following table might be
unavailable to you, and some monitors that are not listed might be available.

Table 54. Monitors commonly available in the AIX Monitors view

Monitor name Data retrieved

Active Memory™ Sharing Enabled Whether memory sharing is enabled.
Possible values are:
v TRUE
v FALSE
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Table 54. Monitors commonly available in the AIX Monitors view (continued)

Monitor name Data retrieved

Active Time of /dev/hdisk0 for processing
request (%)

The percentage of time that the physical disk
is active (bandwidth utilization for the
drive) or, in other words, the total time disk
requests are outstanding.

Active Virtual Memory (4K Pages) Active virtual memory in (4K page units)

Available Space of /dev/hdisk0 (MB) Amount of available space (in megabytes)
on the specified disk drive

Available Space of Filesystem / (MB) Amount of available disk space (in
megabytes) for the specified filesystem

Available Space of Filesystem /home (MB) Amount of available disk space (in
megabytes) for the specified filesystem

Available Space of Filesystem /opt (MB) Amount of available disk space (in
megabytes) for the specified filesystem

Available Space of Filesystem /tmp (MB) Amount of available disk space (in
megabytes) for the specified filesystem

Available Space of Filesystem /usr (MB) Amount of available disk space (in
megabytes) for the specified filesystem

Available Space of Filesystem /var (MB) Amount of available disk space (in
megabytes) for the specified filesystem

Capacity of /dev/hdisk0 (MB) Total capacity (in megabytes) of the specified
disk drive

CPU Computing Unit (%) A percentage that represents the average
time that the processor spends in the user
mode, system mode, idle state, and wait
state divided by the length of time being
measured

CPU Utilization The percentage of CPU capacity being used.
For uncapped partitions, this can be larger
than 100%, potentially much larger.
Uncapped partitions use all available
capacity in the shared processor pool.

Ethernet Kilobytes Received Rate of en0
(KB/sec)

Rate of data received (in kilobytes per
second) by way of Ethernet connection

Ethernet Kilobytes Received Rate of lo0
(KB/sec)

Rate of data received (in kilobytes per
second) by way of Ethernet connection

Ethernet Kilobytes Throughout Rate of en0
(KB/sec)

Rate of successful data communication
(receipt and transmission, in kilobytes per
second) by way of Ethernet connection

Ethernet Kilobytes Throughout Rate of lo0
(KB/sec)

Rate of successful data communication
(receipt and transmission, in kilobytes per
second) by way of Ethernet connection

Ethernet Kilobytes Transmitted Rate of en0
(KB/sec)

Rate of data transmitted (in kilobytes per
second) by way of Ethernet connection

Ethernet Kilobytes Transmitted Rate of lo0
(KB/sec)

Rate of data transmitted (in kilobytes per
second) by way of Ethernet connection

Ethernet Packets Received Rate of en0
(Packets/sec)

Rate of data received (in kilobytes per
second) by way of Ethernet connection

Ethernet Packets Received Rate of lo0
(Packets/sec)

Rate of data received (in packets per second)
by way of Ethernet connection
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Table 54. Monitors commonly available in the AIX Monitors view (continued)

Monitor name Data retrieved

Ethernet Packets Transmitted Rate of en0
(KB/sec)

Rate of data transmitted (in packets per
second) by way of Ethernet connection

Ethernet Packets Transmitted Rate of lo0
(KB/sec)

Rate of data transmitted (in packets per
second) by way of Ethernet connection

Memory Mode The memory mode

Memory Page Fault (Pages/sec) Rate of page faults (in pages per second)

Memory Page Steal (Pages/sec) Rate of page steals (in pages per second)

Memory Usage Memory being used (in megabytes)

Paging Space Remaining (MB) Amount of remaining paging space (in
megabytes)

Paging Space Reserved (MB) Amount of reserved paging space (in
megabytes)

Paging Space Total (MB) Total amount of paging space (in megabytes)

Paging Space Used (MB) Amount of used paging space (in
megabytes)

Time for Servicing Transfers in relation to
Active Time of /dev/hdisk0 (%)

The percentage of time that the physical disk
is busy servicing a transfer request
compared to the time the disk is active (the
time when transfer requests are outstanding)

Total Space of Filesystem / (MB) Amount of total disk space (in megabytes)
for the specified filesystem

Total Space of Filesystem /home (MB) Amount of total disk space (in megabytes)
for the specified filesystem

Total Space of Filesystem /opt (MB) Amount of total disk space (in megabytes)
for the specified filesystem

Total Space of Filesystem /tmp (MB) Amount of total disk space (in megabytes)
for the specified filesystem

Total Space of Filesystem /usr (MB) Amount of total disk space (in megabytes)
for the specified filesystem

Total Space of Filesystem /var (MB) Amount of total disk space (in megabytes)
for the specified filesystem

Used Space of Filesystem / (MB) Amount of disk space used (in megabytes)
for the specified filesystem

Used Space of Filesystem /home (MB) Amount of disk space used (in megabytes)
for the specified filesystem

Used Space of Filesystem /opt (MB) Amount of disk space used (in megabytes)
for the specified filesystem

Used Space of Filesystem /tmp (MB) Amount of disk space used (in megabytes)
for the specified filesystem

Used Space of Filesystem /usr (MB) Amount of disk space used (in megabytes)
for the specified filesystem

Used Space of Filesystem /var (MB) Amount of disk space used (in megabytes)
for the specified filesystem
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Table 54. Monitors commonly available in the AIX Monitors view (continued)

Monitor name Data retrieved

Note:

v These monitors gather data that is supplied by the agent.

v IBM Flex System Manager monitor and threshold memory values are measured in
megabytes (1024*1024 bytes). Some applications measure memory in millions of bytes.
For example, the memory value for 2 GB is the number of megabytes, or 2048 (1024*2).

All Monitors view
The All Monitors view contains all of the available individual monitors from the
other predefined views that ship with IBM Flex System Manager. Also, any
individual monitor not in the All Monitors view that is encountered while creating
a monitor view is added to the All Monitors view.

Note: Deleting a custom monitor view does not remove the individual monitors
from the All Monitors view.

When you create a monitor view, the Create View page presents all the available
monitors in each category, not just the most common monitors. Creating your own
monitor view makes available additional monitors that are not in the commonly
used sets of monitors included in the default monitor views.

For more information about available monitors, look at the information for the
specific view in which you are interested.

Column Management Monitors view
The Column Management Monitors view contains a selection of monitors offered
as resource table columns by the installed plug-ins. This monitor view is the only
view that ships with IBM Flex System Manager that you can edit, which means
you can add monitors that you want to use as columns in resource tables.

For example, when viewing a list of resources (not groups) on the Resource
Explorer page, click Actions > Columns to add columns to or remove columns
from the table. Some of the available columns to add or remove are monitors that
are included in the Column Management Monitors view.

Common CIM Monitors view
The Common CIM (Common Information Model) Monitors view contains some of
the most common CIM monitors. When you create your own monitor view,
additional individual CIM monitors might be available.

The following table lists some of the most commonly available monitors from the
Common CIM Monitors view and the data that each monitor retrieves.

Notes:

v Linux for Power does not provide CIM-based metric profile metrics.
v Several factors determine the availability of the individual monitors listed in the

following table. Determining factors might include the operating system,
hardware configuration, or software configuration of the managed resource.
Depending on those factors, some monitors listed in the following table might
be unavailable to you, and some monitors that are not listed might be available.
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Table 55. Monitors commonly available in the CIM Monitors view

Monitor name Data retrieved

CPU Utilization Rate at which the CPU is running

Disk % Space Available Percentage of available disk space

Disk Space Remaining (MB) Amount of remaining (available) disk space
(in megabytes)

Memory Usage (MB) Memory being used (in megabytes)

Packet received rate Number of IP packets received/second

Packet transmitted rate Number of IP Packets sent/second

Note:

v Linux for Power does not provide CIM Base Metrics Profile (DMTF Standard DSP1053)
based metrics.

v Several factors determine the availability of the individual monitors listed in the
following table. Determining factors might include the operating system, hardware
configuration, or software configuration of the managed resource. Depending on those
factors, some monitors listed in the following table might be unavailable to you, and
some monitors that are not listed might be available.

v These monitors gather data that is supplied by the agent.

v IBM Flex System Manager monitor and threshold memory values are measured in
megabytes (1024*1024 bytes). Some applications measure memory in millions of bytes.
For example, the memory value for 2 GB is the number of megabytes, or 2048 (1024*2).

Common Monitors view
The Common Monitors view contains some of the most common monitors for
operating systems that are supported by IBM Flex System Manager. When you
create your own monitor view, additional individual operating systems monitors
might be available.

The following table lists some of the most commonly available monitors from the
Common Monitors view and the data that each monitor retrieves.

Note:

v Several factors determine the availability of the individual monitors listed in the
following table. Determining factors might include the operating system,
hardware configuration, or software configuration of the managed resource.
Depending on those factors, some monitors listed in the following table might
be unavailable to you, and some monitors that are not listed might be available.

v The “CPU % Utilization monitor” is different from the “CPU Utilization %”
virtualization monitor. For more information about the “CPU Utilization %”
monitor, see the topic: “Virtualization Monitors view”.

Table 56. Monitors commonly available in the Common Monitors view

Monitor name Data retrieved

Active Processors Number of available processors

CPU Utilization Rate at which the CPU is running

Disk 0 Workload Workload managed by disk 0

Disk % Space Used Percentage of space used on the disk

Disk Space Used (MB) Amount of space used on the disk (in
megabytes)
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Table 56. Monitors commonly available in the Common Monitors view (continued)

Monitor name Data retrieved

Locked Memory (MB) Amount of memory locked (in megabytes)

Memory Usage (MB) Memory being used (in megabytes)

Paging Space Remaining (MB) Amount of remaining paging space (in
megabytes)

Paging Space Reserved (MB) Amount of reserved paging space (in
megabytes)

Paging Space Total (MB) Total amount of paging space (in megabytes)

Paging Space Used (MB) Amount of used paging space (in
megabytes)

Time for Servicing Transfers in relation to
Active Time of /dev/hdisk0 (%)

The percentage of time that the physical disk
is busy servicing a transfer request
compared to the time the disk is active (the
time when transfer requests are outstanding)

Total Space of Filesystem / (MB) Amount of total disk space (in megabytes)
for the specified filesystem

Total Space of Filesystem /home (MB) Amount of total disk space (in megabytes)
for the specified filesystem

Total Space of Filesystem /opt (MB) Amount of total disk space (in megabytes)
for the specified filesystem

Total Space of Filesystem /tmp (MB) Amount of total disk space (in megabytes)
for the specified filesystem

Total Space of Filesystem /usr (MB) Amount of total disk space (in megabytes)
for the specified filesystem

Total Space of Filesystem /var (MB) Amount of total disk space (in megabytes)
for the specified filesystem

Used Space of Filesystem / (MB) Amount of disk space used (in megabytes)
for the specified filesystem

Used Space of Filesystem /home (MB) Amount of disk space used (in megabytes)
for the specified filesystem

Used Space of Filesystem /opt (MB) Amount of disk space used (in megabytes)
for the specified filesystem

Used Space of Filesystem /tmp (MB) Amount of disk space used (in megabytes)
for the specified filesystem

Used Space of Filesystem /usr (MB) Amount of disk space used (in megabytes)
for the specified filesystem

Used Space of Filesystem /var (MB) Amount of disk space used (in megabytes)
for the specified filesystem

Note:

v These monitors gather data that is supplied by the agent.

v IBM Flex System Manager monitor and threshold memory values are measured in
megabytes (1024*1024 bytes). Some applications measure memory in millions of bytes.
For example, the memory value for 2 GB is the number of megabytes, or 2048 (1024*2).

Network Monitors view
The Network Monitors view contains network monitors that are supported by
virtual switches.
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The Network Monitors view contains several monitors, such as the Network Bytes
Transferred monitor that retrieves the total number of bytes that are transmitted or
received by the resource.

Important: Network Monitors will not return data for physical switches. Use
SNMP monitors instead for physical switches.

Note: In some instances, Network Monitors data will not be available for a
device. The capabilities of a virtual switch determine which monitors will display
data in the Network Monitors view.

SNMP Monitors view
The SNMP (Simple Network Management Protocol) Monitors view contains
monitors supported by SNMP devices.

The SNMP (Simple Network Management Protocol) Monitors view contains
several monitors, such as the Network Bytes Transferred monitor, which retrieves
the total number of bytes (using SNMP) transmitted or received by the resource,
and monitors that require data collection from Remote Network MONitoring
(RMON).

Note: In some instances, SNMP monitors data will not be available for a
device. The capabilities of the SNMP device determine which monitors will
display data in the SNMP Monitors view.

IBM i Monitors view
Use these instructions to view and configure available IBM i CIM monitors. Doing
so helps you quickly start monitoring IBM i systems. Before starting, ensure that
you followed the instructions in the CIM section in the topic “Using IBM i
resources with an IBM Flex System Manager”.

About this task

The IBM i Monitors view shows some of the most common monitors reported by
installed versions of platform agent on IBM i as being available to IBM Flex
System Manager. When you create your own monitor view, more individual IBM i
monitors might be available.

To view IBM i monitors, follow these steps:

Procedure
1. From the navigation pane, expand System Status and Health, then select

Monitors.
2. From the Monitors window, select IBM i Monitors and click Show Monitors.

Results

Available Monitors

Following are some of the most commonly available monitors from the IBM i
Monitors view and the data that each monitor retrieves.
v For a more complete list of monitors that can be added to a custom view, see “

IBM i resource-monitor attributes”.
v For more information about CIM, see “Common Information Model”.
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v For more information about monitors, see “IBM i System Metrics Providers”.

Note: Several factors determine monitor availability. Some factors include the
operating system, hardware configuration, and software configuration of the
managed resource. Depending on those factors, some monitors might not retrieve
the appropriate data and would then display “No Data Available”.

Table 57. Commonly available monitors in the IBM i Monitors view

Monitor name Data retrieved

Active Virtual Processors of Computer
System

Average number of active virtual processors

Average disk active time percentage Average disk active time percentage

Average disk space utilization Average disk space utilization

Average interactive jobs transaction rate Average transaction rate of interactive jobs

Average interactive response time Average transaction response time of
interactive jobs

Average jobs transaction rate Average transaction rate of jobs

Average user pool faults Average user pool faults

Batch jobs logical database IO rate Database IO operations rate of all batch jobs

CPU % Utilization Percentage of defined CPU capacity that is
used by this system

CPU Consumption Index CPU time used, divided by the available
CPU time for this operating system

CPU External View Total of Operating
System (%)

External view CPU percentage. This is the
percentage of this partition CPU time used.

CPU External View User Mode of Operating
System (%)

External view user mode percentage

CPU Internal View Idle of Operating System
(%)

Idle percentage, as seen from within the
operating system

CPU Internal View Total of Operating
System (%)

User mode percentage from the perspective
of the operating system

CPU Internal View User Mode of Operating
System (%)

User mode percentage as seen from within
the operating system

Free Physical Memory of Operating System
(Kilobytes)

Kilobytes of unused, available physical
memory

Free Space in Page Files of Operating
System (Kilobytes)

Kilobytes of memory that can be mapped
into the operating systems’ paging files

Free Virtual Memory of Operating System
(Kilobytes)

Kilobytes of unused, available virtual
memory

Interactive jobs CPU percentage Percentage of CPU used for interactive jobs

Maximum disk active time percentage Maximum disk active time percentage

Maximum disk space utilization Maximum disk space utilization

Maximum interactive response time Maximum transaction response time of
interactive jobs

Maximum user pool faults Maximum user pool faults

Number of Users of Operating System Number of user sessions for which the
operating system is storing state information

Page In Rate of Operating System/sec Number of pages that are paged in per
second
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Table 57. Commonly available monitors in the IBM i Monitors view (continued)

Monitor name Data retrieved

Process Count Number of processes that are currently
loaded on the operating system

Total CPU Time of Operating System
(Milliseconds)

Total CPU time, sum of KernelModeTime
and UserModeTime, on operating system
level

Unused Global CPU Capacity of Computer
System (Milliseconds)

Milliseconds of CPU time that are not used
on the global server level

Unused Partition CPU Capacity of
Computer System (Milliseconds)

Reserved but unused capacity for this
operating system container

User Mode Time of Operating System
(Milliseconds)

Time in user mode, in milliseconds, on
operating system level

Related reference:
 

Common information Model
 

IBM i System Metrics Providers

IBM i resource-monitor attributes
These are some of the most commonly used resource-monitor attributes for the
IBM i operating system.

Resource
monitor Attributes

File Notes:

1. File-monitor attributes can be files or directories.

2. For compatible file system types, the “Directory exists” or “File exists”
attribute (depending on which is applicable) is always valid data.

3. If there are more directories, additional subelements are displayed.

4. A directory can contain hundreds of subelements. If it does, a directory
might take 5 seconds or longer to open.

5. QSYS.LIB can contain thousands of subelements. If a timeout occurs,
reopening the directory after a timeout increases the timeout value, and
might increase the timeout value sufficiently for the operation to
complete.

v Directory
– Directory exists
– Last modified
– Directory attributes
– Directory owner
– Directory size (bytes)
– Object type

v File
– Checksum
– File exists
– Last modified
– File attributes
– File owner
– File size (bytes)
– Object type
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Resource
monitor Attributes

File system Note: The file system monitor attributes for specific directories are provided
for typical IBM i directories. If one of these directories does not exist, the
attribute is not displayed.
v /
v /bin
v /dev
v /etc
v /home
v /lib
v /tmp
v /usr
v /var

List of
directory
contents

v Directory attributes
v Directory exists
v Directory owner
v Directory size (bytes)
v Last modified
v Object type

Process Note: The number of applications or executable files that a process monitor
checks can vary. The IBM Flex System Manager user configures the
processes that are monitored using the Process Monitor task in the IBM Flex
System Manager Web interface. Each of the process-monitor attributes is
displayed for each executable file that is monitored.
v Current active processes
v Maximum running at once
v Maximum running yesterday
v New executions counted
v Times failed to start
v Time started
v Time stopped
v Total execution time
v Execution time yesterday

I/O
processors

v Auxiliary IOP Use %
v IOP All Comm. Use %
v IOP Disk Use %
v IOP LAN Use %
v IOP Memory Free (KB)
v IOP Operational Status

0 = The status field does not apply to this resource or could not be
determined.
1 = Operational; the resource is operational.
2 = Inoperative; the resource is not operational.
3 = Not detected; the presence of the resource could not be detected.

v IOP Optical Use %
v IOP SDLC Use %
v IOP System Function Use %
v IOP Tape Use %
v IOP Twinaxial Use %
v IOP X.25 Use %
v Primary IOP Use %

Job queues v Job Queue Status
0 = Released; the queue is released.
1 = Held; the queue is held.

v Jobs in Queue
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Resource
monitor Attributes

Job statistics v Batch Jobs Ended, Output Waiting
v Batch Jobs Ending
v Batch Jobs Held on Job Queue
v Batch Jobs Held while Running
v Batch Jobs on Held Job Queue
v Batch Jobs on Unassigned Job Queue
v Batch Jobs Running
v Batch Jobs Waiting for Messages
v Batch Jobs Waiting to Run
v Jobs on System

NetServer
statistics

v Average Response Time (Milliseconds)
v File Opens/Minute
v Kbytes Received per Minute
v Kbytes Sent per Minute
v Password Violations
v Print Jobs Queued/Minute
v Session Starts/Minute

Physical
disks

v Disk Arm Utilization %
v Disk Average Queue Length
v Disk Mirroring Status

0 = Not mirrored
1 = Active
2 = Resuming
3 = Suspended

v Disk Operational Status
0 = The status field does not apply to this resource or could not be
determined.
1 = Operational; the resource is operational.
2 = Inoperative; the resource is not operational.
3 = Not detected; the presence of the resource could not be detected.

v Disk Processor Utilization %
v Disk Read Commands/Minute
v Disk Read Kbytes/Minute
v Disk Space Free (MB)
v Disk Space Used %
v Disk Write Commands/Minute
v Disk Write Kbytes/Minute

Storage
pools

v Active to Ineligible (Transitions/Minute)
v Active to Wait (Transitions/Minute)
v Database Faults per Second
v Database Pages per Second
v Non-database Faults per Second
v Non-database Pages per Second
v Wait to Ineligible (Transitions/Minute)

Subsystems v Subsystem % of Job Limit
v Subsystem Active Jobs
v Subsystem Status

0 = Inactive; the subsystem is not running.
1 = Active; the subsystem is running.

System
statistics

v CPU Utilization %
v Current Temp Storage Used (MB)
v Max Temp Storage Used (MB)
v Permanent Addresses Used %
v System ASP Used %
v Temporary Addresses Used %
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Resource
monitor Attributes

User
statistics

v Users Disconnected
v Users Signed Off, Output Waiting
v Users Signed On
v Users Suspended by Group Jobs
v Users Suspended by System Request

VIOS Monitors view
The VIOS (Virtual I/O Server) Monitors view contains the most common monitors
reported by VIOS as being available to IBM Flex System Manager. When you
create your own monitor view, additional individual VIOS monitors might be
available.

The following table lists the monitors included in the VIOS Monitors view and the
data that each monitor retrieves.

Note: Several factors determine the availability of the individual monitors listed in
the following table. Determining factors might include the operating system,
hardware configuration, or software configuration of the managed resource.
Depending on those factors, some monitors listed in the following table might be
unavailable to you, and some monitors that are not listed might be available.

Table 58. Monitors commonly available in the VIOS Monitors view

Monitor name Data retrieved

Active Memory Sharing Enabled Whether memory sharing is enabled.
Possible values are:
v TRUE
v FALSE

Active Time of /dev/hdisk0 for processing
request (%)

The percentage of time that the physical disk
is active (bandwidth utilization for the
drive) or, in other words, the total time disk
requests are outstanding.

Active Virtual Memory (4 K Pages) Active virtual memory (in 4 K page units)

Available Space of /dev/hdisk0 (MB) Amount of available space (in megabytes)
on the specified disk drive

Available Space of Filesystem / (MB) Amount of available disk space (in
megabytes) for the specified filesystem

Available Space of Filesystem /home (MB) Amount of available disk space (in
megabytes) for the specified filesystem

Available Space of Filesystem /opt (MB) Amount of available disk space (in
megabytes) for the specified filesystem

Available Space of Filesystem /tmp (MB) Amount of available disk space (in
megabytes) for the specified filesystem

Available Space of Filesystem /usr (MB) Amount of available disk space (in
megabytes) for the specified filesystem

Available Space of Filesystem /var (MB) Amount of available disk space (in
megabytes) for the specified filesystem

Capacity of /dev/hdisk0 (MB) Total capacity (in megabytes) of the specified
disk drive

472 Systems Management Guide



Table 58. Monitors commonly available in the VIOS Monitors view (continued)

Monitor name Data retrieved

CPU Computing Unit (%) A percentage that represents the average
time that the processor spends in the user
mode, system mode, idle state, and wait
state divided by the length of time being
measured

CPU Utilization Rate at which the processor is running

Ethernet Kilobytes Received Rate of en0
(KB/sec)

Rate of data received (in kilobytes per
second) by way of ethernet connection

Ethernet Kilobytes Received Rate of lo0
(KB/sec)

Rate of data received (in kilobytes per
second) by way of ethernet connection

Ethernet Kilobytes Throughout Rate of en0
(KB/sec)

Rate of successful data communication
(receipt and transmission, in kilobytes per
second) by way of Ethernet connection

Ethernet Kilobytes Throughout Rate of lo0
(KB/sec)

Rate of successful data communication
(receipt and transmission, in kilobytes per
second) by way of Ethernet connection

Ethernet Kilobytes Transmitted Rate of en0
(KB/sec)

Rate of data transmitted (in kilobytes per
second) by way of Ethernet connection

Ethernet Kilobytes Transmitted Rate of lo0
(KB/sec)

Rate of data transmitted (in kilobytes per
second) by way of Ethernet connection

Ethernet Packets Received Rate of en0
(Packets/sec)

Rate of data received (in packets per second)
by way of Ethernet connection

Ethernet Packets Received Rate of lo0
(Packets/sec)

Rate of data received (in packets per second)
by way of Ethernet connection

Ethernet Packets Transmitted Rate of en0
(Packets/sec)

Rate of ethernet data transmitted (in packets
per second)

Ethernet Packets Transmitted Rate of lo0
(Packets/sec)

Rate of data transmitted (in packets per
second) by way of Ethernet connection

Memory Mode The memory mode

Memory Page Fault (Pages/sec) Rate of page faults (in pages per second)

Memory Page Steal (Pages/sec) Rate of page steals (in pages per second)

Memory Usage (MB) Memory being used (in megabytes)

Paging Space Remaining (MB) Amount of remaining paging space (in
megabytes)

Paging Space Reserved (MB) Amount of reserved paging space (in
megabytes)

Paging Space Total (MB) Total amount of paging space (in megabytes)

Paging Space Used (MB) Amount of used paging space (in
megabytes)

Shared Ethernet Adapter ent4 Byte In Rate
(Kilobytes/sec)

Rate at which the adapter is receiving data
(in kilobytes per second)

Shared Ethernet Adapter ent4 Byte Out Rate
(Kilobytes/sec)

Rate at which the adapter is transmitting
data (in kilobytes per second)

Shared Ethernet Adapter ent4 Packet In/sec Rate at which the adapter is receiving data
(in packets per second)

Shared Ethernet Adapter ent4 Packet
Out/sec

Rate at which the adapter is transmitting
data (in packets per second)
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Table 58. Monitors commonly available in the VIOS Monitors view (continued)

Monitor name Data retrieved

Time for Servicing Transfers in relation to
Active Time of /dev/hdisk0 (%)

The percentage of time that the physical disk
is busy servicing a transfer request
compared to the time the disk is active (the
time when transfer requests are outstanding)

Total Space of Filesystem / (MB) Amount of total disk space (in megabytes)
for the specified filesystem

Total Space of Filesystem /home (MB) Amount of total disk space (in megabytes)
for the specified filesystem

Total Space of Filesystem /opt (MB) Amount of total disk space (in megabytes)
for the specified filesystem

Total Space of Filesystem /tmp (MB) Amount of total disk space (in megabytes)
for the specified filesystem

Total Space of Filesystem /usr (MB) Amount of total disk space (in megabytes)
for the specified filesystem

Total Space of Filesystem /var (MB) Amount of total disk space (in megabytes)
for the specified filesystem

Used Space of Filesystem / (MB) Amount of disk space used (in megabytes)
for the specified filesystem

Used Space of Filesystem /home (MB) Amount of disk space used (in megabytes)
for the specified filesystem

Used Space of Filesystem /opt (MB) Amount of disk space used (in megabytes)
for the specified filesystem

Used Space of Filesystem /tmp (MB) Amount of disk space used (in megabytes)
for the specified filesystem

Used Space of Filesystem /usr (MB) Amount of disk space used (in megabytes)
for the specified filesystem

Used Space of Filesystem /var (MB) Amount of disk space used (in megabytes)
for the specified filesystem

Virtual Target Device vtscsi0 Read Rate
(Kilobytes/sec)

Rate at which the specified device is reading
data (in kilobytes per second)

Virtual Target Device vtscsi0 Transfer Rate
(Count for transmission/sec)

Rate at which the specified device is
transferring data (in count for transmission
per second)

Virtual Target Device vtscsi0 Write Rate
(Kilobytes/sec)

Rate at which the specified device is writing
data (in kilobytes per second)

Virtual Target Device vtscsi1 Read Rate
(Kilobytes/sec)

Rate at which the specified device is reading
data (in kilobytes per second)

Virtual Target Device vtscsi1 Transfer Rate
(Count for transmission/sec)

Rate at which the specified device is
transferring data (in count for transmission
per second)

Virtual Target Device vtscsi1 Write Rate
(Kilobytes/sec)

Rate at which the specified device is writing
data (in kilobytes per second)

Virtual Target Device vtscsi2 Read Rate
(Kilobytes/sec)

Rate at which the specified device is reading
data (in kilobytes per second)

Virtual Target Device vtscsi2 Transfer Rate
(Count for transmission/sec)

Rate at which the specified device is
transferring data (in count for transmission
per second)
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Table 58. Monitors commonly available in the VIOS Monitors view (continued)

Monitor name Data retrieved

Virtual Target Device vtscsi2 Write Rate
(Kilobytes/sec)

Rate at which the specified device is writing
data (in kilobytes per second)

Note:

v These monitors gather data that is supplied by the agent.

v IBM Flex System Manager monitor and threshold memory values are measured in
megabytes (1024*1024 bytes). Some applications measure memory in millions of bytes.
For example, the memory value for 2 GB is the number of megabytes, or 2048 (1024*2).

Managing monitors
The Monitors task provides the tools that you need to retrieve real-time status and
quantitative data for specific properties and attributes of resources in your
environment. You can also set thresholds for the monitors, graph the data that
monitors retrieve, and drill down to quickly view the status of resources for each
system and the name of the monitor so that you can view its properties.

About this task

Note: For a list of items that you should consider while working with resource
monitors and event automation plans, see “Resource-monitor threshold settings
change unexpectedly”.

Viewing a monitor
Use the Monitors task to view the monitors you have set for your resource.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To view a monitor, complete the following steps:

Procedure
1. Open the Monitors task as follows:

a. On the Initial Setup tab of the Home page, click Chassis Manager. Under
General Actions on the Chassis Manager page, click Resource Explorer.

b. Either select a group or drill down to select a resource within a group.
c. Click Actions > System Status and Health > Monitors.

The Monitors task with a table listing applicable monitor views and
information about each monitor view is displayed.
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2. To select one or more target resources, click Browse. The Context Chooser is
displayed.

3. Use the Context Chooser to add one or more resources or groups of resources
as a target:
a. To add a group, select the group that you want to add as a target. To add a

single resource, drill down from the group that includes the resource that
you want to add and select the resource.

b. Click Add.
c. Continue selecting groups or resources as needed.
d. When you are finished adding targets, click OK.

4. From the Monitor selection page, select the monitor view that you want to be
displayed for the targets that you selected.

5. Click Show Monitors. The Monitor View page listing monitors for the targets
that you selected is displayed.

6. View the properties for the monitor in the table or click the monitor to view
additional properties and details.

Creating a monitor view
Use the Monitors task to create views of monitors.

Before you begin

Ensure that the resources on which you create the monitor views have the
appropriate level of agent running on them. Agent level requirements for creating
monitors are as follows:
v Common monitors are available only for systems running Common Agent or .
v Common CIM monitors are available for all Common Agent managed systems

(except for Linux on System x Common Agent managed systems), all Windows
Platform Agent managed systems, and Linux on System z Platform Agent
managed systems.

v No common monitors or common CIM monitors are available for Agentless
managed systems.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To create a monitor view, complete the following steps:

Procedure
1. Open the Monitors task as follows:

a. On the Initial Setup tab of the Home page, click Chassis Manager. Under
General Actions on the Chassis Manager page, click Resource Explorer.
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b. Either select a group or drill down to select a resource within a group.
c. Click Actions > System Status and Health > Monitors.

The Monitors task with a table listing applicable monitor views and
information about each monitor view is displayed.

2. Click Create. The Create View page is displayed.
3. In the Name field, specify a name for the new monitor view.
4. Specify an optional description for the monitor view.
5. In the Show field, select Selected Resources to choose from existing monitored

resources or Monitor Views to choose from existing monitor views. For more
information about monitors that are shipped with Flex System Manager, see
“Monitor views.”

6. In the Available table, double-click a monitor to view and select all the
monitored resources that you want to add to your new monitor view.
For example, double-click Disk Monitors to view monitors that are available
for each hard disk drive present in a system.

7. Click Add.

Note: Add is activated only when an item that can be monitored, such as CPU
Utilization, is selected. If you select any items that cannot be monitored, Add
remains deactivated.

8. Click OK.

Results

The new monitor view appears in the Monitor Views table.

Editing a monitor view
Use the Monitors task to edit monitor views.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To edit a monitor view, complete the following steps:

Procedure
1. Open the Monitors task as follows:

a. On the Initial Setup tab of the Home page, click Chassis Manager. Under
General Actions on the Chassis Manager page, click Resource Explorer.

b. Either select a group or drill down to select a resource within a group.
c. Click Actions > System Status and Health > Monitors.
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The Monitors task with a table listing applicable monitor views and
information about each monitor view is displayed.

2. Select the monitor view that you want to edit.
3. Click Actions > Edit.
4. Modify the monitor view values as needed.
5. Click OK.

Deleting a monitor view
You can delete monitor views that you no longer need.

Before you begin

A monitor view must exist before you can delete it.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To delete a monitor view, complete the following steps:

Procedure
1. Open the Monitors task as follows:

a. On the Initial Setup tab of the Home page, click Chassis Manager. Under
General Actions on the Chassis Manager page, click Resource Explorer.

b. Either select a group or drill down to select a resource within a group.
c. Click Actions > System Status and Health > Monitors.

The Monitors task with a table listing applicable monitor views and
information about each monitor view is displayed.

2. Select the monitor view that you want to delete.
3. Click Actions > Delete.
4. Click Delete.

Results

The monitor view will no longer appear in the Monitors Views table.

Graphing a monitor
Use the Monitor View task to view graphical representations of the monitors on
your resource.
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About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To graph a monitor, complete the following steps:

Procedure
1. Open the Monitors task as follows:

a. On the Initial Setup tab of the Home page, click Chassis Manager. Under
General Actions on the Chassis Manager page, click Resource Explorer.

b. Either select a group or drill down to select a resource within a group.
c. Click Actions > System Status and Health > Monitors.

The Monitors task with a table listing applicable monitor views and
information about each monitor view is displayed.

2. Select the monitor for which you want to create a graph.
3. Click Actions > Graph. The Graph page is displayed.
4. Modify the options of the graph, including graph type and zoom level, as

needed.

Managing thresholds
The Thresholds task offers a consolidated view of all the thresholds that you have
created to monitor the dynamic properties of your resource. This task saves you
from searching for them all in the Monitors task.

About this task

Note: Although there are smcli resource-monitor thresholds commands, you must
use the user interface to manage thresholds for advanced managers.

Viewing a threshold
Use the Thresholds task to view thresholds that are set for the monitors on your
resources or use the Resource Explorer task to view thresholds for a specific
resource.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:
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To view a threshold, complete the following steps that apply to the method that
you want to use:

Procedure
1. View thresholds that are set for the monitors on your resources:

a. On the Initial Setup tab of the Home page, click Chassis Manager. On the
Chassis Manager page, type Thresholds in the Find field, then click
Thresholds in the resulting list on the Tasks tab. The Thresholds page with
a table listing applicable thresholds and information about each threshold is
displayed.

b. View the properties for the threshold in the table or click the threshold to
view additional properties and details.

2. View thresholds for a specific resource:
a. On the Initial Setup tab of the Home page, click Chassis Manager. On the

Chassis Manager page, select Resource Explorer under General Actions.
b. Navigate to the resource for which you want to view the threshold.
c. From the Resource Explorer table, right-click the resource and select System

Status and Health > Thresholds. The Thresholds page is displayed.

Creating a threshold
You can create a threshold by activating a threshold on a specific monitor.

Before you begin

A monitor must have a threshold status of None before you can create a threshold
for it.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

Tip: You can configure an event automation plan to send an e-mail notification
when a specified resource reaches a predefined threshold.

To create a threshold for a specific monitor, complete the following steps:

Procedure
1. Open the Monitors task as follows:
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a. On the Initial Setup tab of the Home page, click Chassis Manager. Under
General Actions on the Chassis Manager page, click Resource Explorer.

b. Either select a group or drill down to select a resource within a group.
c. Click Actions > System Status and Health > Monitors.

The Monitors task with a table listing applicable monitor views and
information about each monitor view is displayed.

2. From the Monitor selection page, select the monitor view that you want to be
displayed for the targets that you selected.

3. Click Show Monitors. The Monitor View page listing monitors for the targets
that you selected is displayed.

4. Select the monitor for which you want to create a threshold.
5. Click Actions > Activate Threshold. The Threshold page is displayed.
6. Enter your inputs and modify the settings for the threshold as needed. Modify

the following parameters:
v Maximum queued events: Specifies the event queue depth for this threshold.

Value must be a positive integer. The default value is 0.
v Minimum duration: Specifies the time in seconds that the threshold condition

must continuously exist before an event is generated. The default value is 0.
v Resend delay: Specifies the time in seconds between the generations of

events for this threshold. The default value is 300 seconds.
7. Click OK.

Results

The threshold status value in the Monitor View table will change from None to
Activated and the threshold settings will be displayed

Editing a threshold
Use the Thresholds task to edit thresholds that are set for the monitors on your
resource.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To edit a threshold, complete the following steps:

Procedure
1. On the Initial Setup tab of the Home page, click Chassis Manager. On the

Chassis Manager page, type Thresholds in the Find field, then click Thresholds
in the resulting list on the Tasks tab. The Thresholds page with a table listing
applicable thresholds and information about each threshold is displayed.
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2. Select the threshold that you want to edit.
3. Click Actions > Edit Threshold. The Threshold page is displayed.
4. Modify the settings for the threshold as needed. The few of these parameters

are described here.
v Maximum queued events: Specifies the event queue depth for this threshold.

Value must be a positive integer. The default value is 0.
v Minimum duration: Specifies the time in seconds that the threshold condition

must continuously exist before an event is generated. The default value is 0.
v Resend delay: Specifies the time in seconds between the generations of

events for this threshold. The default value is 300 seconds.
5. Click OK.

Activating a threshold
You can activate thresholds that have been previously deactivated.

Before you begin

A threshold must be in the deactivated (disabled) state before you can activate it.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To activate a threshold, complete the following steps:

Procedure
1. On the Initial Setup tab of the Home page, click Chassis Manager. On the

Chassis Manager page, type Thresholds in the Find field, then click Thresholds
in the resulting list on the Tasks tab. The Thresholds page with a table listing
applicable thresholds and information about each threshold is displayed.

2. Select the deactivated threshold that you want to activate.
3. Click Activate Threshold. The Threshold page is displayed.
4. Modify any settings for the threshold that you want to change. Modify the

following parameters:
v Maximum queued events: Specifies the event queue depth for this threshold.

Value must be a positive integer. The default value is 0.
v Minimum duration: Specifies the time in seconds that the threshold condition

must continuously exist before an event is generated. The default value is 0.
v Resend delay: Specifies the time in seconds between the generations of

events for this threshold. The default value is 300 seconds.
The details on other parameters are available in the mkresmonthresh command
topic.
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5. Click OK.

Results

The threshold status value in the thresholds table will change from deactivated to
activated.

Deactivating a threshold
You can deactivate thresholds that have been previously activated.

Before you begin

A threshold must be in the activated (enabled) state before you can deactivate it.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To deactivate a threshold, complete the following steps:

Procedure
1. On the Initial Setup tab of the Home page, click Chassis Manager. On the

Chassis Manager page, type Thresholds in the Find field, then click Thresholds
in the resulting list on the Tasks tab. The Thresholds page with a table listing
applicable thresholds and information about each threshold is displayed.

2. Select the deactivated threshold that you want to activate.
3. Click Actions > Deactivate Threshold.
4. Click OK.

Results

The threshold status value in the thresholds table will change from Activated to
Deactivated.

Deleting a threshold
You can delete thresholds that you no longer want associated with your monitors.

Before you begin

A threshold must exist before you can delete it.

About this task

Note:
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This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To delete a threshold, complete the following steps:

Procedure
1. On the Initial Setup tab of the Home page, click Chassis Manager. On the

Chassis Manager page, type Thresholds in the Find field, then click Thresholds
in the resulting list on the Tasks tab. The Thresholds page with a table listing
applicable thresholds and information about each threshold is displayed.

2. Select the threshold that you want to delete.
3. Click Actions > Delete Threshold.
4. Click Delete.

Results

The threshold will no longer appear in the thresholds table.

Managing status set entries
The status set entries that are reported by resources that are managed by IBM Flex
System Manager help to indicate the overall health of your environment. By
managing and monitoring status set entries, which include problems and
compliance issues, you can help prevent undetected failures that cause network
interruptions and data loss.

About this task

Status set entries that are reported by resources in your environment are tracked
by IBM Flex System Manager. You can use IBM Flex System Manager to quickly
navigate to and display these entries. You can also control the entries that are
displayed and collected by IBM Flex System Manager.

The Health Summary task displays several resource-monitoring tools on a single
page. Together, these tools provide a single, consolidated interface with which you
can quickly view the status of important areas of your environment, monitor
critical resources, and view the contents of user-defined health summary groups.
You can also use other tasks in IBM Flex System Manager Web interface, such as
Resource Explorer and Find a Resource to quickly navigate to specific resources.
After you have located a specific resource, you can use the Actions menu to view
its status.

You can perform the following actions on status set entries that are tracked by IBM
Flex System Manager:

Delete Clears a status set entry. When a status set entry is deleted, the individual
status set entry is removed from IBM Flex System Manager tasks that
might display it; however, future occurrences of the entry are still tracked
and counted by IBM Flex System Manager.
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Ignore Deactivates a status set entry. When a status set entry is deactivated for a
system or a specific entry type, the systems continues to generate that
entry and the entry still occurs. However, IBM Flex System Manager tracks
its status in only the event log. Future occurrences of the entry that occur
for the specified system are not displayed or counted by IBM Flex System
Manager unless you reactivate the status set entry.

Activate
Activates a status set entry that has been deactivated. When a status set
entry is activated, the individual status set entry and all future occurrences
of the entry are tracked and counted by IBM Flex System Manager.

Viewing a specific status set entry
Status set entries that are reported by resources in your environment are tracked
by IBM Flex System Manager and displayed in the applicable health summary
tasks and panels. Use the System Status and Health tasks to view status set entries
that have been collected by IBM Flex System Manager.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

You can view status set entries for only those resources to which you have access.

To view a specific status set entry, complete the following steps:

Procedure
1. In the IBM Flex System Manager Web interface navigation area, expand System

Status and Health and navigate to the type of status set entry that you want to
view:
v To navigate to a hardware or power-related status set entry, click Problems.

The Problems task lists only those elevated status set entries that are problem
status set entries that have been reported to IBM Flex System Manager. The
data listed here is a subset of what is listed on the Active Status page. From
the Problems page, you can navigate to, display, and manage these status set
entries. You can also ignore entries to prevent IBM Flex System Manager
from collecting them or delete the entries to remove them from the list until
they occur again.

v To navigate to all status set entries, including problems, click Active Status.
The Active Status task lists all of the status set entries, including problems
and compliance issues, that have been reported to IBM Flex System Manager.
From the Active Status page, you can navigate to, display, and manage these
status set entries. You can also ignore entries to prevent IBM Flex System
Manager from collecting them or delete the entries to remove them from the
list until they occur again.
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A table listing applicable status set entries and information about each entry is
displayed.

2. View the properties for the status set entry in the table or click the status set
entry to view additional properties and details.

What to do next

You can use the Ignore, Activate, and Delete actions to control the entries that are
displayed and collected.

Viewing status set entries for a specific resource
Status set entries that are reported by resources in your environment are tracked
by IBM Flex System Manager and displayed in the applicable health summary
tasks and panels. Use the Resource Explorer task to view status set entries for
specific resources.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

You can view status set entries for only those resources to which you have access.

To view the status information for a specific resource, complete the following steps:

Procedure
1. On the Initial Setup tab of the Home page, click Chassis Manager. Under

General Actions on the Chassis Manager page, click Resource Explorer.
2. In the table view, drill down to the resource that you want to view within the

group that contains that resource.
3. Select the resource that you want to view.
4. Click Actions > System Status and Health > Active Status. The active status

set entries are listed for the resource.

Note: In a targeted launch scenario, only status that applies to the target is
displayed.

What to do next

You can use the Ignore, Activate, and Delete actions to control the entries that are
displayed and collected.
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Viewing status set entries for a group of resources
Status set entries that are reported by resources in your environment are tracked
by IBM Flex System Manager and displayed in the applicable health summary
tasks and panels. Use the Navigate Resources task to view status set entries for the
resources that belong to a specific group.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

You can view status set entries for only those resources to which you have access.

To view status set entries for a group of resources, complete the following steps:

Procedure
1. On the Initial Setup tab of the Home page, click Chassis Manager. Under

General Actions on the Chassis Manager page, click Resource Explorer.
2. In the table view, select one or more groups from the list.
3. Click Actions > System Status and Health > Active Status. The active status

set entries are listed for the resources that belong to the selected group.

Note: In a targeted launch scenario, only status that applies to the targets is
displayed.

What to do next

You can use the Ignore, Activate, and Delete actions to control the entries that are
displayed and collected.

Activating a status set entry
You can activate (un-ignore) individual status set entries that have been
deactivated (ignored). Status set entries that are activated are tracked by IBM Flex
System Manager and are displayed in the applicable Health Summary tasks and
panels.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:
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When status set entries are activated for a system or a specific entry type, IBM Flex
System Manager tracks them.

To activate a status set entry, complete the following steps:

Procedure
1. In the IBM Flex System Manager Web interface navigation area, expand System

Status and Health and navigate to the type of status set entry that you want to
view:
v To navigate to a hardware or power-related status set entry, click Problems.

The Problems task lists only those elevated status set entries that are problem
status set entries that have been reported to IBM Flex System Manager. The
data listed here is a subset of what is listed on the Active Status page. From
the Problems page, you can navigate to, display, and manage these status set
entries. You can also ignore entries to prevent IBM Flex System Manager
from collecting them or delete the entries to remove them from the list until
they occur again.

v To navigate to all status set entries, including problems, click Active Status.
The Active Status task lists all of the status set entries, including problems
and compliance issues, that have been reported to IBM Flex System Manager.
From the Active Status page, you can navigate to, display, and manage these
status set entries. You can also ignore entries to prevent IBM Flex System
Manager from collecting them or delete the entries to remove them from the
list until they occur again.

A table listing applicable status set entries and information about each entry is
displayed.

2. Click Ignored Status.
3. Select the entry that you want to activate.
4. Click Activate.

Deactivating a status set entry
You can deactivate (ignore) individual status set entries that you do not want IBM
Flex System Manager to collect. Status set entries that are deactivated are ignored
by IBM Flex System Manager and are not displayed in the health summary tasks
and panels.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

488 Systems Management Guide



When a status set entry is deactivated for a system or a specific entry type, the
systems continue to generate that entry and the entry still occurs. However, IBM
Flex System Manager does not track its status. Future occurrences of the entry on
the specified system will not be displayed or counted.

To deactivate a status set entry, complete the following steps:

Procedure
1. In the IBM Flex System Manager Web interface navigation area, expand System

Status and Health and navigate to the type of status set entry that you want to
view:
v To navigate to a hardware or power-related status set entry, click Problems.

The Problems task lists only those elevated status set entries that are problem
status set entries that have been reported to IBM Flex System Manager. The
data listed here is a subset of what is listed on the Active Status page. From
the Problems page, you can navigate to, display, and manage these status set
entries. You can also ignore entries to prevent IBM Flex System Manager
from collecting them or delete the entries to remove them from the list until
they occur again.

v To navigate to all status set entries, including problems, click Active Status.
The Active Status task lists all of the status set entries, including problems
and compliance issues, that have been reported to IBM Flex System Manager.
From the Active Status page, you can navigate to, display, and manage these
status set entries. You can also ignore entries to prevent IBM Flex System
Manager from collecting them or delete the entries to remove them from the
list until they occur again.

A table listing applicable status set entries and information about each entry is
displayed.

2. Select the entry that you want to deactivate.
3. Click Ignore.
4. In the Ignore Confirmation window, select the option that represents the

desired scope for the ignore operation:
v Selected resources only
v All resources

5. Click OK.

What to do next

You can display entries that have been deactivated and then reactivate them. You
can also delete individual entries to clear the specific occurrence of the entry but
not future occurrences.

Deleting a status set entry
You can delete individual status set entries that you do not want IBM Flex System
Manager to collect. Status set entries that are deleted are not displayed in the
health summary tasks and panels.
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About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

When a status set entry is deleted, the individual status set entry is removed from
IBM Flex System Manager tasks that might display it; however, future occurrences
of the entry are still tracked and counted by IBM Flex System Manager.

To delete a status set entry, complete the following steps:

Procedure
1. In the IBM Flex System Manager Web interface navigation area, expand System

Status and Health and navigate to the type of status set entry that you want to
view:
v To navigate to a hardware or power-related status set entry, click Problems.

The Problems task lists only those elevated status set entries that are problem
status set entries that have been reported to IBM Flex System Manager. The
data listed here is a subset of what is listed on the Active Status page. From
the Problems page, you can navigate to, display, and manage these status set
entries. You can also ignore entries to prevent IBM Flex System Manager
from collecting them or delete the entries to remove them from the list until
they occur again.

v To navigate to all status set entries, including problems, click Active Status.
The Active Status task lists all of the status set entries, including problems
and compliance issues, that have been reported to IBM Flex System Manager.
From the Active Status page, you can navigate to, display, and manage these
status set entries. You can also ignore entries to prevent IBM Flex System
Manager from collecting them or delete the entries to remove them from the
list until they occur again.

A table listing applicable status set entries and information about each entry is
displayed.

2. Select the entry that you want to delete.
3. Click Delete.
4. In the Delete Confirmation window, click Yes.

What to do next

An entry is deleted for only that instance. If the entry occurs again in the future,
IBM Flex System Manager will collect it.

Note: To hide an IBM Flex System Manager status entry that is showing as active
for a condition reported by the CMM, use the Ignore action on the IBM Flex
System Manager from the Problems/Active Status view. If the status entry is
deleted (rather than ignored) on the IBM Flex System Manager and the condition
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remains active on the CMM, the next resynchronization with the CMM will cause
the status entry to be reasserted on the IBM Flex System Manager.

Deleting a Power Systems status set entry
When IBM Flex System Manager receives an event that needs to be listed as a
problem , it creates a status set entry for the event. Some Power Systems status set
entries are not automatically cleared. Follow the steps in this topic to manually
close and delete Power Systems status set entries.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

You might have two different types of Power Systems status set entries:

Service status entries
For instructions to close and delete service status entries, see this topic:
“Manage Service and Support Manager events”

Hardware status entries
Hardware status entries are not deleted automatically. If you want to delete
them, follow these instructions:

Procedure
1. In the IBM Flex System Manager left navigation pane, expand System Status

and Health and navigate to the Problems view or the Active Status view.
2. Select the entry that you want to delete and click delete. When you delete a

Power Systems status set entry, Flex System Manager removes the entry from
every view where it was visible.

3. In the confirmation window, click Yes.

Results

Flex System Manager deletes only that instance. If the entry recurs, Flex System
Manager collects it again.
Related tasks:
Manage Service and Support Manager events

Managing the event log
An event is an occurrence of significance to a task or resource. Examples of events
include operation completion, hardware component failure, or a processor
threshold being exceeded. The Event Log task displays all events that the
management server receives from any resource for which you can view events.
Related concepts:
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Events
An event is an occurrence of significance to a task or system, such as the
completion or failure of an operation. In a systems-management environment, IBM
Flex System Manager receives events from many sources.

Creating an event log file
You can create an event log file for specific events to check on the standard and
custom notification that you set in the events.

About this task

To create an event log file, first create an event action for generating an event log.
Complete the following instructions to create an event action:
1. On the IBM Flex System Manager console, click Automation on the left panel

and select Event Actions.
2. On the Event Actions panel, click Create.
3. On the Create Action page, select Log to a log file. Click OK.
4. Enter the details for the action and click OK.

After you create an event action, complete the following instructions to create an
event automation plan for the event action.

Procedure
1. On the left panel, select Automation > Event Automation Plan Wizard.
2. Click Create. The Event Automation Plan Wizard opens.
3. Enter the details in the wizard.
4. Click Finish.
5. On the left panel, select Automation > Event Actions.
6. Select the event log file and select Actions > Start Saving History.
7. On the left panel, select Automation > Event Actions.
8. Select the event log file, and select Actions > Test. The event log file is

generated in the /opt/ibm/director/log folder.
9. To export this file to your computer, click the event log file in the event actions

list. On the History tab, select the log file that you want to see. Select Actions >
Export.

Changing event log preferences
The Event Log Preferences task is used to configure the options for the events that
are retrieved and displayed in the event log. You can set the number of events that
are retrieved and the duration of time over which those events are retrieved (time
range).

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:
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Note: Use the server preferences settings page to set the maximum number of
events that are stored in the management node log file.

To change the event log preferences, complete the following steps:

Procedure
1. On the Initial Setup tab of the Home page, click Chassis Manager. On the

Chassis Manager page, type Event Log Preferences in the Find field.
2. On the Event Log Preferences page, make the desired changes.
3. Click OK.

Creating an event filter from an event
You can create a simple event filter for use in an event automation plan from an
event in the Event Log.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To create an event filter, complete the following steps:

Procedure
1. On the Initial Setup tab of the Home page, click Chassis Manager. On the

Chassis Manager page, type Event Log in the Find field. Click Event Log in the
resulting list on the Tasks tab.

2. In the Events table, select the event that you want to use for an event filter.
3. Click Create Filter. The Create Filter window is displayed. At the bottom of the

window, the selected event type is displayed.
4. In the Event filter name field, type the name for the event filter.
5. Optional: In the Description field, type a description to help you identify this

event filter. The description is displayed in the Event Filter window.
6. Click OK.

Results

When you create an event automation plan in the Event Automation Plan wizard,
on the Events page select Advanced Event Filters from the Events list. the Event

Chapter 11. Monitoring system status and health 493



Filters table displays all available event filters, including the one created from the
event log.
Related concepts:
Event filters
A filter specifies one or more events that you want your event automation plan to
process. The event automation plan ignores any event instances that do not meet
the specifications of the filter. Typically, you will use the common event filters that
are provided in the Event Automation Plan wizard. Occasionally there are
situations where you will want to create a sophisticated event filter. The event
filters described in this section are available for such implementations. Using these
filters, you can specify details for an event such that it covers very specific
problems and occurrences. To create filters quickly, default values are provided;
however, you can customize the settings.
Related tasks:
Managing event automation plans
Use event automation plans to automate tasks in your system-management
environment. These plans are composed of event filters and event actions. The
plans are triggered by events. You can create, copy, edit, deactivate, activate, and
delete event automation plans. Also, you can view the Automation summary page.

Deleting an event
You can delete individual events that you do not want IBM Flex System Manager
to display in the event log.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To delete an event, complete the following steps:

Procedure
1. Open the event log as follows:

a. On the Initial Setup tab of the Home page, click Chassis Manager. Under
General Actions on the Chassis Manager page, click Resource Explorer.

b. Either select a group or drill down to select a resource within a group.
c. Click Actions > System Status and Health > Event Log.

The event log table is displayed.
2. Select the event that you want to delete.
3. Click Delete.
4. In the Delete Confirmation window, click OK.
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Note: To hide an IBM Flex System Manager status entry that is showing as
active for a condition reported by the CMM, use the Ignore action on the IBM
Flex System Manager from the Problems/Active Status view. If the status entry
is deleted (rather than ignored) on the IBM Flex System Manager and the
condition remains active on the CMM, the next resynchronization with the
CMM will cause the status entry to be reasserted on the IBM Flex System
Manager.

Replying to an IBM i inquiry message event
Follow these to reply to an individual IBM i inquiry message event displayed in
the event log.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

Procedure
1. On the Initial Setup tab of the Home page, click Chassis Manager. On the

Chassis Manager page, type Event Log in the Find field, then click Event Log
in the resulting list on the Tasks tab.

2. Select the single inquiry message event that you want to reply to.
3. Click Reply. The Reply to Message window opens.
4. In the Reply field, enter your message.
5. Click OK.

Viewing events
Use the Event Log task to view events that are stored in the event log. The event
log includes all events that are received by the management node from any
resource to which you have authorization to view events.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:
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You can view all events, events for a specific managed resource or group, or events
that are filtered using a specific criteria.

Note: The event log does not automatically refresh. To refresh the information in
the table, change the event filter or click Refresh.

To view events in the event log, complete the following steps:

Procedure
1. Open the event log as follows:

a. On the Initial Setup tab of the Home page, click Chassis Manager. Under
General Actions on the Chassis Manager page, click Resource Explorer.

b. Either select a group or drill down to select a resource within a group.
c. Click Actions > System Status and Health > Event Log.

The event log table is displayed.
2. Click Event Filter and select the filter criteria that you want to use. The default

filter is All Events. The event log displays the events that have been received
by IBM Flex System Manager and that match the filter criteria.

Note: The number of events that are displayed is limited by the event-log
preferences settings. By default, the event log displays the last 500 events that
occurred over the last 24 hours. Use the Event Log Preferences page to change
the event log preferences.

3. View the properties for the event in the table or click the event to view
additional properties and details.

What to do next

You can use the Delete action to control the events that are displayed.

Viewing SNMP device attributes
You can use the SNMP Browser task to view the attributes of SNMP devices, for
example, hubs, routers, or other management devices that are compliant with
SNMP. You can use the SNMP Browser for management based on SNMP,
troubleshooting, or monitoring the performance of SNMP devices.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To view SNMP devices, complete the following steps:
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Procedure
1. In the IBM Flex System Manager Web interface navigation area, expand System

Status and Health, then click SNMP Browser. In the IBM Flex System Manager
interface, the navigation area is closed by default. Click the triangle on the
left-hand side of the window to show the navigation.

2. In the SNMP Browser window, use the Target field or click Browse to select an
available target. The SNMP Systems table displays entries that represent the
collection of managed objects in the Management Information Base (MIB)
module.

3. To perform an action on an entry in the table, right-click the entry and select an
action.

Results

The SNMP Systems table displays information about the SNMP resource,
including all the managed objects defined in the MIB module and the MIB itself.
You can inspect the objects or perform actions on them.

Note: To configure your SNMP devices, see “Accessing a secured system with
configure access”.
Related tasks:
Accessing a secured system with configure access
Use the Configure Access page to configure credentials for the agent access points
on a managed system. These credentials provide access to basic system
management functions on the target system for all authorized IBM Flex System
Manager users.

Managing MIB files
You can import, remove, and compile Management Information Base (MIB) files
for SNMP-compliant resources.

Compiling a MIB file
You can compile Management Information Base (MIB) files that are located on the
IBM Flex System Manager.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

The MIB files are located in the /opt/ibm/director/proddata/snmp directory.

When IBM Flex System Manager starts, it loads a default set of compiled MIB files
that are commonly used. If you have updated the list of MIB files to load, your
most recent selections are loaded.
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MIB data is stored in its own persistent-storage file, name.mibdata, where name is
the MIB definition name. These files are located in the /opt/ibm/director/
proddata/snmp directory. By deleting these files and loadedmibs.dat, you can
remove all MIB data in IBM Flex System Manager but retain other
persistent-storage data.

To compile a MIB file, complete the following steps:

Procedure
1. Call IBM Support and obtain the password that is required to run the pesh

command.
2. From the management software command-line interface, use the lsconfig -v

command to determine the UVMID of management node.
3. Run the command pesh UVMID, where UVMID is the system ID that you

determined in the previous step. When you are prompted, enter the password
that you obtained from IBM Support. For more information about the
command, see pesh.

4. On the Initial Setup tab of the Home page in the management software web
interface, click Chassis Manager. On the Chassis Manager page, type Manage
MIBs in the Find field, then click Manage MIBs in the resulting list on the Tasks
tab.

5. On the Manage MIBs page, click Import MIB File.
6. On the Import MIB file page, click the File name field or click Browse to search

for an MIB file. (To compile successfully, the MIB file must be located on the
IBM Flex System Manager.)

7. Select the MIB file that you want to import, then click OK. Click Cancel to
close the page without importing a MIB file.

Results

A message displays that indicates whether the compilation was successful. The
message provides a link to view logs.

Loading MIB files into memory
You can load Management Information Base (MIB) files into memory.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To load MIB files into memory, complete the following steps:
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Procedure
1. On the Initial Setup tab of the Home page, click Chassis Manager. On the

Chassis Manager page, type Manage MIBs in the Find field, then click Manage
MIBs in the resulting list on the Tasks tab.

2. On the Manage MIB files page, in the Available MIB files list, select the MIB
files that you want to load into memory.

3. Click Add to transfer the selected MIB files to the Loaded MIB files list.
4. When you are satisfied with your settings, click OK to save the settings and

close the page. To save the setting but not close the page, click Apply. To close
the page without saving the settings, click Cancel. To reset the selected MIB
files to the server default MIB installation, click Restore Defaults. You still
must click OK or Apply to save the restored settings.

Managing process monitors
You can use process monitors to generate events when an application process
starts, stops, or fails to start.

Viewing process monitors
You can view a list of the process monitors that exist on a managed system.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To view a list of the process monitors that exist on a managed system, complete
the following steps:

Procedure
1. On the Initial Setup tab of the Home page, click Chassis Manager. Under

General Actions on the Chassis Manager page, click Resource Explorer.
2. Navigate to the resource for which you want to view the process monitors.
3. Right-click the resource and select System Status and Health > Process

Monitors.

Note: The Process Monitors selection item displays for only those resources
that are operating systems.
The Process Monitors page, which lists all the process monitors created for the
selected resource, is displayed.

Creating and configuring a process monitor
To monitor a process, you must create and configure a monitor. This is supported
only on systems that have Common Agent installed.
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About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To create and configure a process monitor, complete the following steps:

Procedure
1. On the Initial Setup tab of the Home page, click Chassis Manager. Under

General Actions on the Chassis Manager page, click Resource Explorer.
2. Navigate to the resource for which you want to create a process monitor.
3. Right-click the resource and select System Status and Health > Process

Monitors.

Note: The Process Monitors selection item displays for only those resources
that are operating systems.
The Process Monitors page, which lists all the process monitors created for the
selected resource, is displayed.

4. On the Process Monitors page, click Create. The Create window is displayed.
5. In the Create window, type the executable file name of the application process

that you want to monitor.
6. Select any combination of the Start, Terminate, and Fail to start after reboot

check boxes, to specify the actions that you want to monitor. Selecting one or
more actions activates the process monitor. A process monitor does nothing
unless you select at least one action.

7. If you select Fail to start after reboot, type a timeout value. This value is the
number of seconds that the process monitor waits for the application process to
start before generating a fail event.

8. Click OK to save the process monitor.

Results

The new process monitor is displayed in the Process Monitors table on the Process
Monitors page.

Removing process monitors
You can remove any number of existing process monitors from a managed
resource.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
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the user interface (shown here) to locate this task:

To remove one or more process monitors from a managed resource, complete the
following steps:

Procedure
1. On the Initial Setup tab of the Home page, click Chassis Manager. Under

General Actions on the Chassis Manager page, click Resource Explorer.
2. Navigate to the resource from which you want to remove one or more process

monitors.
3. Right-click the resource and select System Status and Health > Process

Monitors.

Note: The Process Monitors selection item displays for only those resources
that are operating systems.
The Process Monitors page, which lists all the process monitors created for the
selected resource, is displayed.

4. Select one or more process monitors that you want to remove.
5. Click Delete to remove the selected process monitors and any associated

thresholds. A confirmation dialog displays.
6. Click OK. The selected process monitors and any associated thresholds are

removed and no longer appear in the Process Monitors table.

Recording resource-monitor statistics
You can view statistics about critical system resources, such as processor, disk, and
memory by recording resource-monitor statistics. Record resource-monitor statistics
for an individual managed system, multiple systems specified by IP addresses or
host names, or system groups by using the smcli resource-monitor recording
commands.

Use the commands to start or stop recording statistics (resource-monitor values),
and to export recordings to archive or review the statistics. You can export
recordings to a file in text, comma separated values (CSV), HTML, or XML
formats. You can also delete resource-monitor recordings.

Note: Because IBM Flex System Manager stores the recordings in binary format,
you must use the smcli resource-monitor recording commands to work with the
recordings.
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Chapter 12. Managing a chassis

The IBM Flex System Manager management software web interface provides
several ways to view chassis properties, configure chassis settings, and view
chassis events and problems.

For information about how to prepare a chassis to be removed from management,
see Chapter 13, “Unmanaging a chassis,” on page 517.

Note:
v The Chassis Manager view in the management software is the primary interface

for selecting managed resources and performing management tasks on those
resources. However, some of the procedures in this section include steps that
instruct you to use the navigation area, which is hidden, by default, in the web
interface.

v Managing a chassis queues discovery and inventory jobs on the chassis and its
components. The action to manage the chassis completes without waiting for the
jobs to complete. This means the chassis view and inventory for the chassis may
not be complete even though the action to manage the chassis completes. The
length of time required for discovery and inventory jobs to complete varies
based on the workload of the Flex System Manager and the number and type of
resources in the chassis. For chassis that are populated with compute nodes
using multi-node architecture, the jobs can require as long as 45 minutes from
the time they reach the head of the queue to complete. Additional inventories
running at the same time could cause the chassis inventories to run longer. You
can monitor the progress of discovery and inventory jobs by using the Active
and Scheduled Jobs view.

Using management domains
Use the Management Domain page in the IBM Flex System Manager management
software web interface to establish or change your chassis-management
configuration.

Note: This topic describes how to access this task in the IBM Flex System Manager
Web user interface. If you are using the IBM FSM Explorer, use the finder at the
top of the user interface (shown here) to locate this task:

A management domain consists of the Flex System Enterprise Chassis hardware
and resources that are under management by the management software.

Access the Management Domain page by using one of the following methods:
v From the Home page, click the Initial setup tab; then, click Select Chassis to be

Managed.
v From the Home page, click the Plug-ins tab; then, click the Management

Domain link under IBM Flex System Manager.
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You can use the Management Domain page in the management software web
interface to perform the following chassis-management actions:
v Manage or unmanage a chassis

Notes:

1. Before you unmanage a chassis, make sure that you complete the procedures
that are described in Chapter 13, “Unmanaging a chassis,” on page 517.
Otherwise, the compute nodes in that chassis will not be removed from the
management software.

2. A CMM can be managed only by one management node at a time.
Additionally, if a CMM is managed by one management node, and you want
to manage it with another management node, you must first unmanage the
CMM on the initial management node Management Domain page. After you
click Unmanage, you might have to use the lschassisind command to clear
the settings that link that CMM to the initial management node. After you
clear the settings, you can click Unmanage for the initial management node;
then, you are able to manage the CMM with the new management node.

v View a list of all chassis (including those that are unmanaged and those that are
managed by another management node in your environment)

Note: After initial discovery, if a chassis is unmanaged from another
management node and added to the management network of your management
node, click the Discover New Chassis button to refresh the list of chassis.

v Go to the Chassis Manager page for another management node
v Go to the Chassis Map view for a chassis, regardless of which management

software manages it

Important: The Management Domain page displays only the Flex System
Enterprise Chassis that are on the same local subnet as the management node. To
manage a chassis on the local subnet, make sure that the IP address that is
assigned to Eth0 is on the same IPv4 subnet or IPv6 network as the IP address that
is assigned to the CMM. To manage a chassis on another subnet, you must first
discover the chassis manually. After the chassis is discovered, it appears in the
chassis list on the Management Domain page.

To discover a chassis manually, complete the following steps:
1. From the Home page, click the Plug-ins tab.
2. Under Discovery Manager, click System Discovery.

Adding or removing a chassis
The Management Domain page in the management software web interface enables
you to add and remove an Flex System Enterprise Chassis from a management
domain.

Note: This topic describes how to access this task in the IBM Flex System Manager
Web user interface. If you are using the IBM FSM Explorer, use the finder at the
top of the user interface (shown here) to locate this task:
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To add or remove a chassis from the Chassis Manager view in the web interface,
click the General Actions menu in the Common Actions area; then, click Add or
Remove a Chassis. The Management Domain page opens, where you can discover
and manage a new chassis or remove an existing chassis.

Note: The Common Actions area (beside the table or graphical view) is not labeled
unless a managed resource has been selected. The General Actions menu is
displayed regardless of whether a resource is selected.

Important:

v Before you unmanage a chassis, make sure that you complete the procedures
that are described in Chapter 13, “Unmanaging a chassis,” on page 517.
Otherwise, the compute nodes in that chassis will not be removed from the
management software.

v If you have to remove a Flex System Manager Types 7955, 8731, and 8734
management node from a chassis, be sure to unmanage the chassis (or remove
the chassis) from the management node management domain before you remove
the node.

Using centralized user management
Use the IBM Flex System Manager management software to change centralized
management settings for a chassis.

When you use the management software to place a chassis under centralized
management, the Chassis Management Module (CMM) is configured to use the
registry that is stored on the management node. The local user accounts in the
CMM registry are disabled, and the new user account RECOVERY_ID is created on
the CMM for future authentication to the CMM (as long as it is configured to use
the centralized user registry on the management node).

If you make changes to the disabled local CMM accounts (for example, if you
change a password), the changes have no effect on the RECOVERY_ID account. In
centralized user management mode, the RECOVERY_ID account is the only CMM
account that is activated and operational.

Note: The first time you log in to the CMM with the RECOVERY_ID account, you
are prompted to change the password. The RECOVERY_ID password can be
changed only on the CMM.

After the CMM detects the management node user registry, it uses the
management node registry configuration to provision all of the managed resources
in the chassis (except for network switches) so that they also use the central
management node user registry.

After a chassis is managed in centralized user management mode, the management
node becomes the account manager for the chassis; you can log in to the CMM
using accounts from the management node user registry. If a chassis is in
centralized management mode, and the management node fails, you can use the
RECOVERY_ID account to log in to the CMM to take recovery actions to restore
account-management functions on the CMM until the management node is
restored or replaced.

Important: After you centrally manage a chassis that contains an IBM Flex System
V7000 Storage Node, you must create a new user group on the IBM Flex System
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V7000 Storage Node for users with operator access. Otherwise, those users will not
be able to log in to the IBM Flex System V7000 Storage Node.

For example, to create a new user group on the IBM Flex System V7000 Storage
node, log in to the storage node and use the command-line interface to enter the
following command:
mkusergrp -name smdefault -role CopyOperator -remote

For information about creating user groups on the IBM Flex System V7000 Storage
Node through the command-line interface, see http://publib.boulder.ibm.com/
infocenter/flexsys/information/topic/com.ibm.acc.4939.doc/
svc_createworkwithusergroupscli_07051433.html

Changing the user management mode of a managed chassis
If an Flex System Enterprise Chassis is already managed by the management
software, you can change the user management configuration from decentralized
to centralized, or centralized to decentralized.

Changing a managed chassis from decentralized to centralized
user management

A centralized management configuration uses a single user authentication
repository for all of the Chassis Management Modules (CMMs) in a management
domain. For more information about centralized management, see “Centralized
user management” on page 20.

You can use the command-line interface (CLI) to update a managed chassis from
decentralized to centralized user management mode.

Attention: You cannot change a chassis from decentralized to centralized user
management mode in the management software web interface; you must use the
CLI. The web interface enables you to unmanage a chassis, and re-manage the
chassis in centralized user management mode. However, unmanaging a chassis
deletes all of the chassis settings, and is more complicated than using the
manageChassis command and its options to change the chassis user management
mode to centralized.

To update the chassis from decentralized to centralized user management mode in
the management software CLI, run the following command:
manageChassis --Uc -c <userid:password@1.1.1.1> --Cu <centralized user ID> --Cp <centralized password> --Rp <RECOVERY_ID password>

where the variables in the command are:
v userid:password@1.1.1.1 represents the administrator credentials and IP address

for the target chassis
v centralized user ID is an administrator user ID with supervisor authority on the

management node. This account is used to request access to the CMM on behalf
of the management node and managed nodes after the CMM is centrally
managed.

v centralized password is the password for the centralized user ID
v RECOVERY_ID password is the password for the CMM recovery account, which

has the user ID RECOVERY_ID.

For more information about the command and its options, see manageChassis in
the IBM Flex System Manager Commands Reference Guide document, or use the -h |
–help command option, for more information about the manageChassis command.
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Changing a managed chassis from centralized to decentralized
user management

User management is decentralized when a CMM uses its own user registry (and
not that of the management node) or uses an external user registry such as an
external LDAP server. For more information about decentralized management, see
“Decentralized user management” on page 21.

Attention: You cannot change a chassis from centralized to decentralized user
management mode in the management software web interface; you must use the
CLI. The web interface enables you to unmanage a chassis, and re-manage the
chassis in decentralized user management mode. However, unmanaging a chassis
deletes all of the chassis settings, and is more complicated than using the
rmCentrallyManagedChassis command and its options to change the chassis user
management mode to decentralized.

To change the chassis to decentralized user management mode from the
management software CLI, run the rmCentrallyManagedChassis command. See the
IBM Flex System Manager Commands Reference Guide document, or use the -h |
–help command option, for more information about the
rmCentrallyManagedChassis command.

Note: The rmCentrallyManagedChassis command does not unmanage the chassis.

Recovering chassis management with a CMM after a
management node failure

If a chassis is in centralized management mode, and the IBM Flex System Manager
management node fails, you can restore the management functions and the local
user accounts for a Chassis Management Module (CMM) until the management
node is restored or replaced.

Use the following procedure to restore account management on a CMM until the
management node is restored or replaced:
1. Through an SSH session, open a CMM command-line interface and log in with

the RECOVERY_ID account.

Note: The password for the RECOVERY_ID account was set when you selected
the chassis for management on the Management Domain page.
If this is the first time that you have used the RECOVERY_ID account to log in
to the CMM, you must change the password.

2. If you are prompted, type the new password for the RECOVERY_ID account.
3. Run the following five commands, in the order shown:

a. env -T mm[p]

b. sslcfg -client disabled -tc1 remove

c. accseccfg -am local

d. ldapcfg -i1 -p1 -rd "" -usa "" -gsa "" -lpa ""

e. fsmcm -off

This command disables centralized user account management from the IBM
Flex System Manager management software, and allows you to use local
CMM user accounts to authenticate to the CMM and any management
processor that is installed in the chassis.
After you run the fsmcm -off command, the RECOVERY_ID account is
removed from the CMM user registry. When you run the fsmcm -off

Chapter 12. Managing a chassis 507



command from the management software CLI, the CMM CLI session
terminates. You can now authenticate to the CMM and other chassis
components with local CMM credentials, and use local CMM credentials to
access the CMM web interface or CLI until centralized user management is
restored.

Important: If the management node that failed is restored you might have to
re-manage any chassis that were previously managed:
1. From the Home page in the management software web interface, click Select

Chassis to be Managed. The Management Domain page opens; in the table on
the Management Domain page, look for the chassis name. If the chassis name is
listed and its status is Unmanaged, you do not have to change the management
software settings.

2. If chassis name is listed is in the table and its status is Managed, select the box
for the chassis; then, click Unmanage. The unmanage operation completes, and
the management software displays messages that explain that the CMM user
registry cannot be reconfigured.

After the Management Domain page shows that the chassis is unmanaged, and the
invalid management software configuration settings have been cleared, you can
manage the chassis again.

Managing a remote chassis
The IBM Flex System Manager management software can manage an Flex System
Enterprise Chassis that is in a different geographic location than the management
node, if the remote chassis is on the same management network. However, the
procedure that is required to manage a remote chassis differs from the procedure
required to manage a chassis that is on the same network subnet as the
management node.

Note: This topic describes how to access this task in the IBM Flex System Manager
Web user interface. If you are using the IBM FSM Explorer, use the finder at the
top of the user interface (shown here) to locate this task:

The Management Domain page displays only the chassis and Chassis Management
Modules (CMMs) that are on the same local subnet as the management node,
unless you have enabled multicast SLP forwarding on the router or routers in your
environment. If you have not enabled multicast SLP forwarding, a remote chassis
cannot be discovered automatically and managed from the Management Domain
page.

If you have not enabled multicast SLP forwarding on the routers in your
environment, and you want to discover, access, and manage a remote chassis on
another subnet, complete the following steps in the management software web
interface.

Note: To complete this procedure, you must first configure the network router to
enable communications between the management node subnet and the CMM
subnet.
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1. From the Home page, click the Plug-ins tab.
2. Click Discovery Manager. The Discovery Manager summary page is

displayed.
3. In the Discovery and Inventory area, under Common tasks, click System

Discovery. The System Discovery page is displayed.
4. Select the discovery options in the list and type the IP address of the remote

CMM; then, click Discover Now.
5. After the discovery process is complete, click the Discovery Manager tab to

return to the Discovery Manager summary page.
6. In the Discovery and Inventory area, under Common tasks, click Resource

Explorer. The Resource Explorer page is displayed.
7. In the table, find and select the box for the remote chassis.
8. Click Actions > Security > Request Access. The Request Access page opens.
9. Enter or verify the values in the User ID and Password fields; then, click

Request Access.
10. After access to the remote chassis is granted, the chassis is managed by the

management software.

Note: If you want to unmanage the remote chassis, you can use the Unmanage
button on the Management Domain page. For information about how to prepare a
chassis to be removed from management, see Chapter 13, “Unmanaging a chassis,”
on page 517.

Managing and deleting event subscriptions
When the IBM Flex System Manager management software discovers a Chassis
Management Module (CMM), System-Management Processor, or a compute node
Platform Agent, it automatically creates an event subscription (or CIM
subscription) to that managed resource. If you replace your management node
with another management node, you might need to clear existing CIM
subscriptions.

CIM subscriptions are used by the CMM to notify the management node that
receives the subscription about events occurring in the CMM. Typically, these
subscriptions are deleted by the management software when the CMM or other
resource is no longer managed, or when the resource is removed from a Flex
System Enterprise Chassis. However, if a management node is removed from the
chassis, and replaced by another management node before the chassis or resource
is unmanaged, the management software does not automatically delete the existing
event subscriptions; you must manually delete the subscriptions in the
management software command-line interface (CLI).

If you must replace a management node with a new management node, make sure
that you unmanage all managed resources before you remove the old management
node from the chassis. You can unmanage a chassis or other managed resource
from the Management Domain page in the management software web interface.
For more information about management domains and unmanaging resources, see
“Using management domains” on page 503.

If you use a third-party CIM tool, it might also set CIM subscriptions to a CMM. If
you want to clear subscriptions that were established with a CIM tool, use that
CIM tool to clear them.
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If you replace a management node with a new management node without first
unmanaging all resources, use the lschassisind command to target a managed
resource and clear the existing event subscriptions. See lschassind in the IBM Flex
System Manager Command Reference Guide PDF document for more information.

Configuring a chassis
This topic lists the chassis-configuration capabilities of IBM Flex System Manager
management software.

The Chassis Manager view provides several ways to configure a managed chassis.
For more information about configuring a chassis and its components during initial
setup, see “Configuring chassis components” on page 137.

Configuring a chassis with Configuration Patterns

Configuration Patterns enables you to provision or pre-provision managed
resources by configuring local storage, network adapters, boot order, and
Integrated Management Module (IMM) and Unified Extensible Firmware Interface
(UEFI) settings. For more information about Configuration Patterns, see
“Modifying firmware and hardware configuration settings” on page 532.

Note: A valid IPv6 address must be assigned to a managed resource before you
can use Configuration Patterns to configure settings for the resource.

Configuring a chassis from the Chassis Manager view

You can also use the Chassis Manager to manage the following settings and
configurations in an Flex System Enterprise Chassis.

Note: To configure a chassis, you must have full access, and the IPMI and CIM
status of the chassis must be OK.
v Chassis Management Module power status
v Service requests
v Network IP configuration (IPv4, IPV6, advanced failover, host name, and DNS)
v Backup and restore
v User management (global setting, local user registry, user login, security level,

user registry client, security policy, LDAP security, and trusted certificate)
v Date, time, and NTP
v Feature activation (Features on Demand, or FoD)
v Dynamic UEFI
v Boot setting
v Switch module protocol configuration
v Switch module VLAN configuration

Configuring chassis with Configuration Patterns
Use Configuration Patterns to define and manage the chassis patterns, chassis
profiles, and placeholders for chassis that you install in the future.

You can use Configuration Patterns to provision or pre-provision Chassis
Management Modules (CMMs) using a common configuration pattern that can be
deployed to multiple CMMs. Configuration Patterns enable you to configure CMM
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network settings, power and acoustic settings, users and security settings, and
basic network device and node configuration settings.

Getting started with Configuration Patterns
Before you create a new chassis pattern on the Configuration Patterns page in the
IBM Flex System Manager web interface, consider the following suggestions.

About this task
v Identify chassis for configuration that have a common hardware configuration.
v If you want to create a chassis pattern starting from an existing chassis, make

sure that the chassis is discovered and unlocked.
v Identify the aspects of configuration that you want to customize for the chassis

pattern (for example, management interface, users and security, power and
acoustics, and basic network device and compute node configuration).

You can access the Configuration Patterns page in the management software web
interface from either the IBM FSM Explorer interface or the Home page.

To access Configuration Patterns from the IBM FSM Explorer, click Systems >
Configuration Patterns.

To access Configuration Patterns from the Home page, complete the following
steps:

Procedure
1. Click the Chassis Manager tab.
2. From the Chassis Manager view, click General Actions > Configuration

Patterns. IBM FSM Explorer opens in a new browser tab, and the Configuration
Patterns page is displayed.

3. From the Suggested Tasks tab, click the applicable link to get started with
Configuration Patterns.

Chassis patterns
A chassis pattern represents a Chassis Management Module (CMM) configuration,
including network settings, power and acoustic settings, users and security
settings, and basic network device and node configuration settings.

When you define a chassis pattern, select applicable category patterns and address
pools to construct the configuration for a specific group of chassis. You can define
multiple chassis patterns to represent the different configurations that are used in
your data center.

Note: To ensure that your configuration patterns are not lost if the management
node fails, back up the management software after you create or modify
configuration patterns.

When a chassis pattern is deployed to multiple chassis, multiple chassis profiles
are automatically generated (one profile for each chassis). Each profile inherits
settings from the parent chassis pattern, which allow you to control a common
configuration pattern from a single place.

Working with chassis pattern settings
The category patterns within a chassis pattern correspond with the Chassis
Management Module (CMM) firmware settings. Some of the firmware settings that
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you might configure directly in the CMM web interface or command-line interface
can also be configured through Configuration Patterns. However, some settings are
not supported by Configuration Patterns, and other settings are not yet available.

If you create a chassis pattern from an existing chassis, the category settings for
that chassis pattern are learned automatically from the current settings of the
compute node. If you want to change the category settings, you can edit them
directly from the chassis patterns menu in the web interface.

If you create a new chassis pattern, the New Chassis Pattern Wizard enables you to
configure general chassis information, CMM firmware settings, I/O module
settings, and settings for compute nodes and storage nodes in the chassis.

Notes:

v For more information about the network adapter settings that Configuration
Patterns supports, see “Server pattern settings for network devices” on page 535.

v The settings that are contained in Node patterns are never learned. They can be
created only from scratch. Node patterns that are deployed to Flex System V7000
storage enclosure nodes apply to the IP assignment for the node's service IP
address only, not the canister IP addresses.

The following category patterns are shown in the Management Modules step of the
New Chassis Pattern Wizard:

System Information
Settings include chassis name, contact person, and chassis location.

Management interface
Settings include hostname customization, IP address configuration, DNS
preferences, and port assignments.

Note: Interface speed settings are not supported by Configuration Patterns.

Power and acoustics
Settings include power management policy and acoustic attenuation.

Security
Settings include CMM overall security policy and login settings.

Chassis profiles
Chassis profiles are generated automatically when a chassis pattern is deployed.
One profile is created for each target chassis. Each chassis profile represents the
specific configuration of a single chassis and contains system-unique information
(for example, assigned IP addresses).

Chassis profile management

When a pattern is deployed, an individual chassis profile is generated for each
target chassis. You can edit a pattern and save changes, and any dependent chassis
profiles are automatically updated and redeployed to their associated chassis. You
can move an existing profile from one chassis to another by unassigning the
profile, and then redeploying the profile to another chassis.

Important: Chassis retain their identification information (for example, hostname,
IP address) when a profile is unassigned. To avoid name and address conflicts, any
identification information on the original chassis should be cleared before the
unassigned profile is deployed to a different chassis.
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To ensure that your configuration patterns are not lost if the management node
fails, back up the management software after you create or modify configuration
patterns.

Using a chassis placeholder
You can pre-provision chassis and compute nodes by defining a placeholder
chassis to act as a target. After a new chassis and its components are installed, you
can apply the configuration by deploying the placeholder chassis to the new
hardware.

Deploy a chassis pattern to a placeholder chassis to pre-provision Chassis
Management Modules (CMMs) and other chassis components. Deploy a server
pattern to placeholder chassis bays to pre-provision compute nodes.

After the new hardware is installed, you can deploy the configurations to the new
hardware with the Deploy Placeholder Chassis button on the Placeholder Chassis
page.

Viewing firmware levels of managed resources
The IBM Flex System Manager management software web interface enables you to
view data, including version levels, about firmware that is installed on managed
resources. After you select the installed firmware view, you can use the Inventory
page to identify firmware for a specific resource, and export firmware data for
recordkeeping in an external application.

About this task

Use the Resource Explorer and Inventory pages in the management software web
interface to view the firmware levels of components that are installed in a
managed chassis:

Procedure
1. From the Chassis Manager page, click General Actions > Resource Explorer.

The Resource Explorer page opens.
2. In the Resource Explorer table, click FSM Groups.
3. Right-click FSM Element List Group; then, click Inventory > View and collect

inventory. The View and Collect Inventory page opens.

Note: The FSM Element List Group includes the chassis, every component
installed in the chassis, and other external network devices (like a top-of-rack
switch) that the management software is managing.

4. After inventory is collected, under Collected Items, expand Systems Software
and click Installed Firmware. The firmware levels for the managed resources
are displayed.

5. (Optional) Click Export All to export the displayed data in CSV, HTML, or
XML file formats.

Tip: You can import the exported data in an external application, such as a
spreadsheet, for recordkeeping and future reference.
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What to do next

Use the Installed Firmware table to sort and filter the resources that are displayed.
The following actions in the table can help you find the firmware information for a
particular resource:
v Sort by Name to list the resource names in alphabetical order.
v Sort by System name to group the displayed resources by system data.
v Use the search field to find specific firmware quickly. For example, if you type

imm and click Search, the table displays only the IMM firmware information.

Naming managed resources in a chassis
Use the IBM Flex System Manager management software web interface to change
the name of a managed resource (for example, a compute node) in a chassis, after
the management software discovers the chassis.

After a chassis is managed and its compute nodes are discovered, the management
software automatically assigns names for the compute nodes. To determine a
compute node name, the management software searches these values during the
discovery process, and displays the value of the first field that has a value:
1. The text ID of the service processor as configured on the service processor
2. The host name of the service processor, as determined by DNS lookup
3. The IP address of the service processor
4. The Machine Type and Model Serial information of the service processor
5. The Universally Unique Identifier (UUID) of the service processor

To rename any managed resource (chassis, compute node, or network device) that
is displayed in the management software web interface, complete the following
steps:
1. From the Chassis Manager page, click the chassis that contains the managed

resource that you want to rename. The Chassis Map view opens.
2. In the Chassis Map, click the managed resource to select it; then, click Actions

> Rename. The Rename window opens.
3. Type the new name for the managed resource and click OK.

Using the Chassis Manager to manage a chassis
View chassis properties and manage a chassis with the Chassis Manager and
Chassis Map in the IBM Flex System Manager management software web interface.

Click Chassis Manager in the management software web interface to open a list of
chassis that are under management. Click the name of the chassis that you want to
manage to open the Chassis Map.

The Chassis Manager Chassis Map has two types of views: graphical and table.
After you click the name of the chassis that contains the compute node that you
want to manage, the graphical Chassis Map opens. From the graphical view, click
the image to select it. A selected chassis is shown in the following illustration.
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Alternatively, click Table View. From the table view, right-click the compute node
name in the table. The Actions menu for the compute node opens, as shown in the
following illustration. To perform an action to multiple compute nodes at once,
you can select the compute nodes in the table view; then, right-click one of the
selected compute nodes or click the Actions menu to choose the action that you
want to perform.

Regardless of how you select the chassis, the Details tabs for the selected chassis
and the Actions menu are displayed below the Chassis Map. Click an action
category, and then click the action, as shown in the following illustration.
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For more information about how to use the Chassis Manager to manage individual
compute nodes, see “Chassis Manager” on page 523.

Viewing chassis events and problems
Multiple views of chassis events and problems are available in the IBM Flex
System Manager management software web interface. The Chassis Manager view
enables you to identify problems with both the managed resources that are
contained by the chassis and problems with the chassis itself.

An event is a user or system activity that is logged with a message. Two types of
events are displayed by management software: events for the Flex System Manager
Types 7955, 8731, and 8734 management node and events for the compute nodes
and other resources that are managed by the management software.

A problem is an actionable event that can either be resolved or be submitted for
resolution through the management software Electronic Service Agent (ESA) and
Service and Support Manager.

For more information about how to address problems with Service and Support
Manager, see Chapter 23, “Solving problems,” on page 675.

You can use Chassis Manager in the management software to view events and
problems for a chassis or for a resource within a chassis. Use the Chassis Manager
page, the Events page, or the Problems page to see a high-level view of all events
or problems. Use the Chassis Map view in Chassis Manager to view events and
problems for a resource that is under management.
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Chapter 13. Unmanaging a chassis

The IBM Flex System Manager management software web interface enables you to
remove a chassis from management. However, to remove managed compute nodes
in a chassis, you should first make sure that you remove all operating systems and
virtual servers that are associated with those compute nodes.

Before you unmanage a chassis that is under management software management,
complete the process in the following list. Detailed information about each of these
actions is provided in this section.

Important: If you do not complete the following steps before you unmanage the
chassis, the compute nodes in the chassis will not be removed from the
management software, and removing the compute nodes will be more complicated.
1. Remove the operating system instances for the operating systems that are

running on each compute node.
2. Remove guest operating system instances on the virtual servers that are

managed by the hypervisor on each compute node.
3. Remove the instances for the virtual servers that are managed by the

hypervisor on each compute node.
4. (Optional) Remanage the chassis after the unmanage operation is complete.

When you unmanage a chassis, the management software deletes information
related to the chassis and its virtual and physical managed endpoints. Any data
related to these endpoints that was manually entered and existed only in the
management software might need to be re-entered after remanaging the chassis.
Data that is external to the management software is not deleted during an
unmanage operation, but the management software might not display it after the
initial remanage.

Notes:

v You can temporarily unmanage and then remanage a chassis or compute node
without affecting assigned Configuration Patterns profiles. If a compute node or
chassis is removed from management by the management software, the
configuration profiles assigned to those systems remain. You can unassign the
profiles and deploy them to other systems, or you can unassign and delete the
profiles.

v When a chassis is unmanaged, the IBM Service and Support Manager
component of the management software no longer monitors chassis errors and
reports serviceable problems directly to IBM Support through Electronic Service
Agent (ESA). To enable call home and IBM Support for the unmanaged chassis,
you must configure the Service and Support settings on the Chassis
Management Module (CMM).
To configure service and support for the chassis on the CMM, complete the
following steps:
1. Log in to the CMM.
2. Click Service and Support > Settings.
3. Select the Enable IBM Support box; then, complete the other fields on the

page.
4. Click Apply IBM Support Settings.
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After you complete the procedures in this section, and the compute node operating
systems, compute node guest operating systems, and virtual servers for the
compute nodes have been removed from management, you can unmanage the
chassis. See “Using management domains” on page 503 for more information
about unmanaging a chassis.

Removing operating system instances for each compute node
Before you unmanage a chassis that is under IBM Flex System Manager
management software management, you should remove the operating system
instances for the operating systems that are running on each compute node.

Note: This topic describes how to access this task in the IBM Flex System Manager
Web user interface. If you are using the IBM FSM Explorer, use the finder at the
top of the user interface (shown here) to locate this task:

To remove the operating system instances for each compute node in the chassis
that you want to unmanage, complete the following steps:
1. From the management software web interface, click the Chassis Manager tab.

The Chassis Manager page opens.
2. Select the box for the chassis that you want to unmanage; then, click Actions >

Related Resources > Server.

Note: You can also right-click the name of the chassis to open the Actions
menu.
The Resource Explorer page opens, which displays a list of the compute nodes
in the chassis.

3. Click Actions > Select All to select all of the compute nodes in the table.
4. Click Actions > Inventory > View and Collect Inventory. The View and

Collect Inventory page opens. The Target systems field is pre-populated with
the compute nodes in the chassis.

5. In the navigation tree in the Collected Items box, expand Related Systems;
then, click Operating System. The inventory table changes to display the
operating systems that are related to the compute nodes.

Note: If there are no operating systems displayed in the inventory table, there
are no operating systems for the compute nodes. Skip to “Removing guest
operating system instances on virtual servers” on page 519.

6. Click Actions > Select All to select all of the operating system instances.
7. Click Actions > Remove... to remove the operating system instances.

Proceed to “Removing guest operating system instances on virtual servers” on
page 519 for information about how to remove guest operating system instances on
the virtual machines that are managed by the hypervisor on each compute node.
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Removing guest operating system instances on virtual servers
If your compute nodes have virtual servers with guest operating systems, remove
guest operating system instances on the virtual servers that are managed by the
hypervisor on each compute node before you unmanage a chassis that is under
IBM Flex System Manager management software management.

If none of the compute nodes in the chassis have virtual servers, you can skip the
process that is described in this topic and unmanage the chassis. See “Using
management domains” on page 503 for more information about how to unmanage
a chassis.

Note: This topic describes how to access this task in the IBM Flex System Manager
Web user interface. If you are using the IBM FSM Explorer, use the finder at the
top of the user interface (shown here) to locate this task:

To remove the guest operating system instances for each compute node in the
chassis that you want to unmanage, complete the following steps.

Note: If you just completed the procedure in “Removing operating system
instances for each compute node” on page 518, the inventory for the compute
nodes is already displayed in the management software web interface. Skip to step
5.
1. From the management software web interface, click the Chassis Manager tab.

The Chassis Manager page opens.
2. Select the box for the chassis that you want to unmanage; then, click Actions >

Related Resources > Server.

Note: You can also right-click the name of the chassis to open the Actions
menu.
The Resource Explorer page opens, which displays a list of the compute nodes
in the chassis.

3. Click Actions > Select All to select all of the compute nodes in the table.
4. Click Actions > Inventory > View and Collect Inventory. The View and

Collect Inventory page opens. The Target systems field is pre-populated with
the compute nodes in the chassis.

5. In the navigation tree in the Collected Items box, expand Related Systems;
then, click Server. The inventory table changes to display the servers and
virtual servers that are related to the compute nodes.

6. In the table, select the boxes for all of the virtual servers.

Note: To reorganize the table so that all of the virtual servers are listed
together, sort the table by clicking the arrows in the heading for the Type
column.

7. Click Actions > Inventory > View and Collect Inventory. The page refreshes,
and the virtual servers are now listed in the Target systems field at the top of
the page.
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8. In the navigation tree in the Collected Items box, expand Related Systems;
then, click Operating System. The virtual machine operating systems are
displayed in the table.

Note: If the Operating System option is not displayed as an option in the
View by field, there are no operating systems for the compute nodes. Skip to
“Removing virtual servers.”

9. Select the boxes for all of the operating systems; then, click Actions >
Remove.... The virtual machine operating systems are deleted.

Proceed to “Removing virtual servers” for information about how to remove guest
operating system instances on the virtual servers that are managed by the
hypervisor on each compute node.

Removing virtual servers
Before you unmanage a chassis that is under IBM Flex System Manager
management software management, you should remove all of the virtual servers
that are associated with the compute nodes.

Note: This topic describes how to access this task in the IBM Flex System Manager
Web user interface. If you are using the IBM FSM Explorer, use the finder at the
top of the user interface (shown here) to locate this task:

To remove the virtual server instances for each compute node in the chassis that
you want to unmanage, complete the following steps.

Note: If you just completed the procedure in “Removing guest operating system
instances on virtual servers” on page 519, the inventory for the virtual servers is
already displayed in the management software web interface. Skip to step 5.
1. From the management software web interface, click the Chassis Manager tab.

The Chassis Manager page opens.
2. Select the box for the chassis that you want to unmanage; then, click Actions >

Related Resources > Server.

Note: You can also right-click the name of the chassis to open the Actions
menu.
The Resource Explorer page opens, which displays a list of the compute nodes
in the chassis.

3. Click Actions > Select All to select all of the compute nodes in the table.
4. Click Actions > Inventory > View and Collect Inventory. The View and

Collect Inventory page opens. The Target systems field is pre-populated with
the compute nodes in the chassis.

5. In the navigation tree in the Collected Items box, expand Related Systems;
then, click Server. The inventory table changes to display the servers and
virtual servers that are related to the compute nodes.

6. In the table, select the boxes for all of the virtual servers.
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Note: To reorganize the table so that all of the virtual servers are listed
together, sort the table by clicking the arrows in the heading for the Type
column.

7. Select the boxes for all of the virtual servers; then, click Actions > Chassis >
Remove.... The virtual machine operating systems are deleted.

Note: For Power Systems compute nodes, you must first remove the host
server from the IBM Flex System Manager management before removing the
virtual servers and their associated Operating System managed endpoints (if
any). To remove the host, complete the following steps:
a. Select the Virtual Server to be removed.
b. Click Actions > Remove Resources > Server.
c. Select the host Power Systems compute node.
d. Click Actions > Remove....
e. Click OK when you see the removal confirmation. The Power Systems

compute node, associated virtual servers, and associated operating system
managed endpoints will be removed from the IBM Flex System Manager
interface.

After you complete the preceding procedures, and the compute node operating
systems, compute node guest operating systems, and virtual servers for the
compute nodes have been removed from management, you can unmanage the
chassis. See “Using management domains” on page 503 for more information
about unmanaging a chassis.

Remanaging a chassis after unmanaging
When the unmanage operation completes, managed endpoints and IBM Flex
System Manager management software information about the endpoints are
removed, but endpoint data external to the management node (like the images in
the image repository) remain. After you unmanage a chassis, use this information
to remanage it and restore remaining endpoint data in the management software.

When you unmanage a chassis, the management software deletes information
related to the chassis and its virtual and physical managed endpoints. Any data
related to these endpoints that was manually entered and existed only in the
management software might need to be re-entered after remanaging the chassis.
For example, if you changed the names of endpoints prior to unmanaging the
chassis, those names are removed after the chassis is unmanaged.

However, data that is external to the management software is not deleted during
an unmanage operation, but the management software might not display it after
the initial remanage. If you set up an image repository, then unmanaged and
remanaged the chassis, the management software might not recognize the image
repository initially, but the actual repository on disk and the images it contains still
exist. You can configure the management software to recognize them again.

To remanage the chassis and restore chassis endpoint data that was not deleted
during the unmanage operation, use the following information that is applicable to
your environment:
1. Select the chassis and manage it from the Management Domain page. See

“Selecting chassis for management” on page 136 for more information.
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2. After the chassis is managed on the Management Domain page, allow the
management software to finish discovering the components in the remanaged
chassis.

Note: Even after the chassis endpoints are discovered, some endpoints might
not be fully accessed or configured, and some endpoints might not be
displayed at all. See “Configuring chassis components” on page 137 for a
description of the component-configuration options that are available in the
management software.

3. Resolve error or warning conditions for managed endpoints, if applicable. See
the “Troubleshooting the management software” section in the IBM Flex System
Manager Troubleshooting Guide document (PDF).

Important: All error or warning conditions must be resolved before you
proceed to the next step.

4. If you created an image repository for use with VMControl prior to
unmanaging the chassis, and it is not displayed in the management software,
see “Image repository problems” in the IBM Flex System Manager Troubleshooting
Guide document (PDF) or at http://publib.boulder.ibm.com/infocenter/flexsys/
information/topic/com.ibm.acc.8731.doc/
troubleshooting_image_repository_problems.html.

Note: If you complete the corrective action that is described in “Image
repository problems”, IBM Power Systems virtual server endpoints are also
restored, if applicable.

5. If you use VMware vCenter, you must discover and collect inventory for the
vCenter operating system endpoint; then, the VMware virtual servers that
existed before the chassis was unmanaged are restored.
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Chapter 14. Managing compute nodes

IBM Flex System Manager management software can manage both types of IBM
Flex System compute nodes: X-Architecture compute nodes and Power Systems
compute nodes.

Much of the information in this section applies to both IBM X-Architecture and
IBM Power Systems compute nodes. The general descriptions of the tasks that are
available in the Chassis Manager and Chassis Map views in the management
software web interface are the same for both types of compute node.

Other management software functionality (and related documentation) is pertinent
to only one of the two compute node types. For example, Remote Control is
available only for X-Architecture compute nodes (see “Using FSM Remote Control
with X-Architecture compute nodes” on page 557 for more information).

See http://publib.boulder.ibm.com/infocenter/flexsys/information/topic/
com.ibm.director.systemx_bc.helps.doc/fqm0_t_managing_systemx_bc.html for
management functions that are specific to IBM X-Architecture compute nodes.

See http://publib.boulder.ibm.com/infocenter/flexsys/information/topic/
com.ibm.acc.8731.doc/managing_power_systems.html for management functions
that are specific to IBM Power Systems compute nodes.

For educational information about node management in IBM Flex System Manager
management software, see http://publib.boulder.ibm.com/infocenter/flexsys/
information/topic/com.ibm.acc.common.nav.doc/
learning_blade_management.html.

Note: The Chassis Manager view in the management software is the primary
interface for selecting managed resources and performing management tasks on
those resources. However, some of the procedures in this section include steps that
instruct you to use the navigation area, which is hidden, by default, in the web
interface.

The navigation area provides links to tasks and task categories such as Resource
Explorer, Inventory, and Health Summary. To open the navigation area, click the
arrow icon on the left side of the window.

Chassis Manager
The Chassis Manager is a feature of the IBM Flex System Manager management
software web interface that enables you to view and control all of the managed
resources in a selected Flex System Enterprise Chassis.

The Chassis Manager shows high-level inventory and aggregated status
information about managed resources within a chassis. In addition, the chassis
map for the IBM Flex System shows information from additional resources, such as
system agents, FSP, and hardware VPD. This can create a situation where the IBM
Flex System chassis map displays errors that are not reported by the Chassis
Management Module. The Chassis Manager also enables you to configure certain
resource actions and settings.
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The initial view of the Chassis Manager shows information about chassis that are
under management by the management software in a table. Select a chassis to see
a graphical representation of the IBM Flex System hardware.

The following illustration shows the Chassis Map view in the Chassis Manager.

If you click a resource that is represented in the Chassis Map, the details for that
resource are displayed.

Using the Chassis Manager to manage compute nodes
Use the Chassis Manager and Chassis Map in the IBM Flex System Manager
management software web interface to edit compute node details, view server
properties, and manage compute node actions.

The Chassis Manager has two types of views: graphical and table. After you click
the name of the chassis that contains the compute node that you want to manage,
the graphical Chassis Map opens. From the graphical view, click the image for a
compute node to select it.

Alternatively, click Table View. From the table view, right-click the compute node
name in the table. The Actions menu for the compute node opens.

Regardless of how you select the compute node, the Details tabs for the selected
compute node and the Actions menu are displayed below the Chassis Map. Click
an action category, and then click the action, as shown in the following illustration.
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Using the global find function
You can use the global find function in the IBM Flex System Manager management
software Chassis Manager to identify and select a managed resource in an Flex
System Enterprise Chassis.

Note: This topic describes how to access this task in the IBM Flex System Manager
Web user interface. If you are using the IBM FSM Explorer, use the finder at the
top of the user interface (shown here) to locate this task:

Global find also returns results for tasks that relate to the text that you enter in the
Find field.

Using common actions
In the IBM Flex System Manager management software Chassis Manager and
Chassis Map views, a list of common actions is available for a selected managed
resource.

Common actions enable you to manage and control settings for a managed
resource after you select it in Chassis Manager.

After you select a chassis in the table view of Chassis Manager, the Chassis Map
for that chassis is displayed. When you click a managed resource in the Chassis
Map view, a list of common actions is displayed beside the Chassis Map.

The common actions that are listed are determined by the managed resource that
you selected. For example, the common actions for a compute node include
settings (boot sequence and network configuration), power control (restart and
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power off), service and support (service request), release management (updates),
and remote control. The global find field, which you can use to search for tasks, is
also displayed.

Under the common actions for the managed resource, a General Actions menu
lists chassis-level tasks and access to management software plug-ins.

Using overlays in the Chassis Manager
Use the overlays in the IBM Flex System Manager management software Chassis
Manager to display basic information about a managed resource without selecting
the resource.

Chassis Manager provides you with overlays that show hardware status and other
information. The following table shows the overlay categories that are available in
the Chassis Map view of Chassis Manager.

Table 59. Overlay categories in Chassis Manager

Icon Description Filter options

Problem information v Critical

v Warning

v Informational

v Normal

Compliance, firmware, and
notifications

Hardware access states v Full Access Online

v Full Access Offline

v Partial Access Online

v Partial Access Offline

v No Access Online

v No Access Offline

v Unknown

v Not Applicable

Note: The
management software
does not support the
front panel LEDs
overlay for the IBM
Flex System V7000
Storage Node.

Highlight front panel LEDs v Power LED

v Event Log LED

v Location LED

v Fault LED

v Only Show ON

Component names and
properties

v Name

v IP Address

v FRU

v Serial number

Configuration Patterns (status,
server profiles, and server
templates) and IBM Fabric
Manager status for each
managed resource, if applicable
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Move the mouse pointer over a chassis resource to display information about that
resource that corresponds with the selected category. Select a different category to
change the type of information that is displayed in the overlays.

Some overlays have filters (indicated by the arrow next to the overlay icon). The
filters enable you to further customize the type of overlay information that is
shown in the Chassis Map. The Hardware access states overlay filter menu is
shown in the following illustration.

Example

For example, the following illustration shows Chassis Manager with the Highlight
front panel LEDs button selected and an informational overlay for a compute
node in the chassis.
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Configuring compute nodes
The IBM Flex System Manager management software provides different methods
for configuring a compute node. The right configuration method for your compute
nodes depends on the type of compute nodes that you want to configure.

Configuring X-Architecture compute nodes

The management software function Configuration Patterns is the easiest and fastest
method for configuring local storage, network adapters, boot order, and Integrated
Management Module (IMM) and Unified Extensible Firmware Interface (UEFI)
settings.

With Configuration Patterns, you can either create and deploy server templates to
managed X-Architecture compute nodes. The server template is used as an group
of defined settings that configures multiple compute nodes quickly and
simultaneously. When a server template is deployed to compute nodes, a server
profile is created for each compute node. Each server profile captures the
configuration details for that compute node, and contains server-unique
information like assigned IP addresses and MAC addresses.

To open the Configuration Patterns page, in the Chassis Manager page, click
General Actions > Configuration Patterns.

For more information about using Configuration Patterns, see “Modifying
firmware and hardware configuration settings” on page 532.

Configuring IBM Power Systems compute nodes

Use the Chassis Manager page in the management software web interface to
configure one or multiple Power Systems compute nodes. Configuration templates
and configuration plans enable you to deploy configuration settings to managed
Power Systems compute nodes.

Configuration templates deploy individual settings to operating systems, service
processors, or network switches. A configuration template stores your setting
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choices, which enables you to deploy the same settings multiple times. The settings
that you can deploy include IP address, boot device order, and user accounts.

Configuration plans deploy multiple settings as a group to a managed resource in a
single operation. A configuration plan consists of multiple configuration templates.
For example, you can group configuration templates for UEFI, power scheduling,
and network IP address configuration into a single configuration plan, and deploy
them in a single operation.

To select a configuration option for a Power Systems compute node, including
configuration templates and plans, complete the following steps:
1. From the Chassis Manager page, click the chassis that contains the Power

Systems compute node that you want to configure.
2. From the Chassis Map view, click the Power Systems compute node to select it.

The details for the compute node are displayed under the Chassis Map.
3. Click Actions > System Configuration to open a list of configuration functions.

Turning off compute node power
You can use the IBM Flex System Manager management software web interface to
turn off power to a compute node.

About this task

To turn off power to a compute node in the management software, complete the
following steps.

Note: This topic describes how to access this task in the IBM Flex System Manager
Web user interface. If you are using the IBM FSM Explorer, use the finder at the
top of the user interface (shown here) to locate this task:

Procedure
1. From the Chassis Manager page in the management software web interface,

click the chassis that contains the compute node for which you want to turn off
power.

2. From the Chassis Map view in the Chassis Manager, click the applicable
compute node.

3. Under Common Actions in the Chassis Map, click Power Off Now.

What to do next

For information about restarting a compute node, see “Restarting a compute
node.”

Restarting a compute node
You can use the IBM Flex System Manager management software web interface to
restart a compute node.
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About this task

To restart a compute node in the management software, complete the following
steps.

Note: This topic describes how to access this task in the IBM Flex System Manager
Web user interface. If you are using the IBM FSM Explorer, use the finder at the
top of the user interface (shown here) to locate this task:

Procedure
1. From the Chassis Manager page in the management software web interface,

click the chassis that contains the compute node that you want to restart.
2. From the Chassis Map view in Chassis Manager, click the applicable compute

node.

Note: If the compute node is connected to an IBM Flex System V7000 Storage
Node, make sure that the storage node is powered on before you restart the
compute node.

3. Under Common Actions, click Restart Now.

What to do next

For information about turning off power to a compute node, see “Turning off
compute node power” on page 529.

Resetting a compute node with the management software
You can use the IBM Flex System Manager management software web interface to
reset a compute node with either a hard restart of the compute node service
processor or a virtual reseat of the compute node.

Before you begin

Note: This topic describes how to access this task in the IBM Flex System Manager
Web user interface. If you are using the IBM FSM Explorer, use the finder at the
top of the user interface (shown here) to locate this task:

You can use the management software to command the Chassis Management
Module (CMM) to remotely recover a compute node that has a Comm Error or Init
Failed state. Otherwise, the only way to reset the compute node is to remove and
replace the failed node hardware in the chassis.

Note: You can also use the CMM command-line interface or web interface to
remotely reset the compute node. See the CMM documentation for more
information.
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There are two remote reset operations that you can perform in the management
software web interface:

Hard restart of the service processor
This action restarts the compute node IMM (for an X-Architecture compute
node) or FSP (for a Power Systems compute node). Unlike the soft restart,
it does not require the IMM or FSP to be responsive. The hard restart does
not affect the compute node operating system. Additionally, you can
perform hard service processor restart on the management node through
the management software without disrupting the management software;
management node communication to the management network does not
go through its IMM.

Note: The hard service processor restart might not work on all compute
node types. If the action does not work, attempt a virtual reseat or reseat
the hardware manually.

To perform a hard restart of the service processor on a compute node or
the management node, complete the following steps:
1. From the Chassis Manager view in the management software web

interface, click the node in the chassis that you want to restart.
2. Click Actions > Power On/Off > Hard Restart System Management

Processor.

Virtual reseat
This action simulates the physical removal and replacement of the compute
or management node by momentarily disconnecting standby power. A
virtual reseat forces the operating system on the node to shut down. You
must manually start the operating system after the IMM is restarted.

Note: The management software does not support the virtual reseat
function for the IBM Flex System V7000 Storage Node.

To perform a virtual reseat of the service processor on a compute node or
the management node, complete the following steps:
1. From the Chassis Manager view in the management software web

interface, click the node in the chassis that you want to restart.
2. Click Actions > Power On/Off > Virtual Reseat.

Provisioning compute nodes
Before IBM Flex System Manager management software can manage a compute
node, the compute node must be provisioned. The information in this section
describes how to use the management software to modify firmware and hardware
configuration settings for X-Architecture compute nodes, and how to deploy
operating systems to X-Architecture and IBM Power Systems compute nodes.

Before you begin

Note: Some management software functionality, such as Configuration Patterns and
the Deploy compute node images task, is limited to X-Architecture compute nodes.

For information about updating firmware on a Power Systems compute node, see
Chapter 9, “Updating firmware and software,” on page 375. For more information
about installing an operating system on a Power Systems compute node, see
“Installing the operating system” in the documentation for that compute node.
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About this task

Provisioning a compute node means updating the firmware, installing the
operating system, and updating device drivers. IBM provides tools to help with
the provisioning process.

In addition to the tools and methods listed here, see the documentation for your
compute node for other methods that apply to provisioning a single compute
node.

Modifying firmware and hardware configuration settings
You can use IBM Flex System Manager Configuration Patterns to provision or
pre-provision X-Architecture compute nodes by configuring local storage, network
adapters, boot order, and Integrated Management Module (IMM) and Unified
Extensible Firmware Interface (UEFI) settings.

About this task

Use Configuration Patterns in the management software web interface or the IBM
FSM Explorer interface to provision multiple compute nodes before you deploy
operating system or virtual images to them.

Important:

1. Before you can use Configuration Patterns, you must first update the firmware
for all managed components. For a detailed summary of update procedures for
all IBM Flex System components, see the IBM Flex System Firmware Update
Guides at http://www-947.ibm.com/support/entry/portal/
docdisplay?lndocid=MIGR-5091991.

2. After you update the firmware for a system, you must restart the system before
you can perform Configuration Pattern operations.

The Configuration Patterns function also integrates support for IBM Fabric
Manager so that you can virtualize fabric connections, and failover or re-purpose
compute nodes without disrupting the fabric. You can also initiate fabric-change
requests through your change-management process before your hardware is
installed by pre-configuring host interconnect addresses.

You can temporarily unmanage and then re-manage a chassis or compute node
without affecting profiles or their assignments. If a compute node or chassis is
removed from management by the management software, the configuration
profiles assigned to those systems remain. You can unassign the profiles and
deploy them to other systems, or you can unassign and delete the profiles.

Configuration Patterns can be applied to any X-Architecture compute node, and to
any IBM Flex System network device that is installed in an X-Architecture compute
node.

Note: Although Configuration Patterns can be applied to any X-Architecture
compute or network device, some Configuration Patterns functionality is limited to
certain network devices. For the following network devices, Configuration Patterns
can learn existing configuration data and settings, and can change configuration
settings through pattern deployment:
v Embedded 10Gb Virtual Fabric Ethernet Controller
v IBM Flex System CN4054 10Gb Virtual Fabric Adapter
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The information in this section explains Configuration Patterns tasks and concepts.

Configuring compute nodes with Configuration Patterns
Use Configuration Patterns to define and manage the server patterns, server
profiles, policies, and standby server pools.

You can use Configuration Patterns to provision or pre-provision X-Architecture
compute nodes using a common configuration pattern that can be deployed to
multiple compute nodes. Configuration Patterns enable you to configure local
storage, network adapters, boot order, and Integrated Management Module (IMM)
and Unified Extensible Firmware Interface (UEFI) settings.

Getting started with Configuration Patterns:

Before you create a new server pattern on the Configuration Patterns page in the
IBM Flex System Manager web interface, consider the following suggestions.

About this task

v Identify compute nodes for configuration that have a common hardware
configuration. A server pattern is used to apply the same configuration settings
to compute nodes with the same hardware.

v If you want to create a server pattern from an existing compute node, make sure
that the compute node is discovered and unlocked.

v Identify the aspects of configuration that you want to customize for the server
pattern (for example, local storage, network adapters, boot settings, IMM
settings, UEFI settings).

You can access the Configuration Patterns page in the management software web
interface from either the IBM FSM Explorer interface or the Home page.

To access Configuration Patterns from the IBM FSM Explorer, click Systems >
Configuration Patterns.

To access Configuration Patterns from the Home page, complete the following
steps:

Procedure

1. Click the Chassis Manager tab.
2. From the Chassis Manager view, click General Actions > Configuration

Patterns. IBM FSM Explorer opens in a new browser tab, and the Configuration
Patterns page is displayed.

3. From the Suggested Tasks tab, click the applicable link to get started with
Configuration Patterns.

Server patterns:

A server pattern represents a compute node configuration that is deployed before
an operating system is installed. It includes local storage configuration, network
adapter configuration, boot settings, and other IMM and UEFI firmware settings.

When you define a server pattern, select the category patterns and address pools
that you need for the desired configuration for a specific group of compute nodes.
You can define multiple server patterns to represent different configurations in
your data center. When a server pattern is deployed to multiple compute nodes,
multiple server profiles are generated automatically (one profile for each compute
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node). Each profile inherits settings from the parent server pattern, which enables
you to control a common configuration pattern from a single place.

Attention: When you create a new server pattern from scratch, you are required
to define the boot settings for compute nodes. If you deploy the new server
pattern to compute nodes, the existing boot order on the compute nodes is
overwritten with the default boot order settings in the new server pattern.

If you have deployed a server pattern to compute nodes, and the compute nodes
will not start, the problem might be that the original boot settings were
overwritten by the default boot order settings in the new server pattern. To restore
the original boot settings on the compute nodes, follow the procedure described in
Recovering compute node boot settings after server pattern deployment.

Important: When you create server patterns, make sure that you create them for
each compute node type. For example, create a server pattern for all Flex System
x240 compute nodes and a server pattern for all Flex System x440 compute nodes.
Do not apply a server pattern created for one compute node type to a different
compute node type.

To ensure that your configuration patterns are not lost if the management node
fails, back up the management software after you create or modify configuration
patterns.

Working with server pattern settings:

The category patterns within a server pattern correspond with the firmware
settings for a compute node type. Most of the firmware settings that you might
configure directly on the compute node IMM and UEFI can also be configured
through Configuration Patterns in the management software web interface.
However, some settings are not supported by Configuration Patterns, and other
settings are not yet available.

If you create a server pattern from an existing compute node, the category settings
for that server pattern are learned automatically from the current settings of the
compute node. If you want to change the category settings, you can edit them
directly from the server patterns menu in the web interface.

If you create a new server pattern, the category patterns are shown in the
Firmware step of the New Server Pattern Wizard.

Attention: When you create a new server pattern from scratch, you are required to
define the boot settings for compute nodes. If you deploy the new server pattern
to compute nodes, the existing boot order on the compute nodes is overwritten
with the default boot order settings in the new server pattern.

If you have deployed a server pattern to compute nodes, and the compute nodes
will not start, the problem might be that the original boot settings were
overwritten by the default boot order settings in the new server pattern. To restore
the original boot settings on the compute nodes, follow the procedure described in
Recovering compute node boot settings after server pattern deployment.

Note: The settings contained in the Extended IMM and Extended UEFI category
patterns can only be learned from a compute node; these category patterns cannot
be created from scratch.
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You can also create category patterns separately from server patterns. One category
pattern can be associated with multiple server patterns.

The firmware settings that are available in a server pattern depend on the compute
node, your IBM Flex System environment, and the scope of the Configuration
Patterns functionality. Configuration Patterns has the following firmware-setting
limitations:

Management network interface
Duplex settings are not supported by Configuration Patterns.

Device and IO ports
You can use Configuration Patterns to enable serial over LAN in the
Console Redirection area. However, when serial over LAN is enabled, the
only serial port access mode setting that is supported by Configuration
Patterns is Dedicated; the Shared and Pre-Boot IPMI settings for serial port
access mode are not available in Configuration Patterns.

Important: If you create a server pattern from an existing compute node,
and that compute node has the serial port access mode setting Shared or
Pre-Boot, the Device and IO Ports pattern that is learned from the compute
has the serial port access mode setting Dedicated.

Server pattern settings for network devices:

Some IBM Flex System network devices offer more configuration options in
Configuration Patterns than others.

Although Configuration Patterns can be applied to any network device, some
Configuration Patterns functionality is limited to certain network adapters.
Additionally, some advanced settings for Ethernet network adapters (such as
adapter and port compatibility preferences) are not supported with the current
management software release.

Configuration Patterns can learn existing configuration data and settings for
supported network adapters, and can change configuration settings through
pattern deployment. When you add one of the following fully-supported adapters
to a server pattern, you can configure the operational mode and protocols for the
adapter:
v Embedded 10Gb Virtual Fabric Ethernet Controller (LOM)
v IBM Flex System CN4054 10Gb Virtual Fabric Adapter

Server profiles:

Server profiles are generated automatically when a server pattern is deployed. One
profile is created for each target compute node. Each server profile represents the
specific configuration of a single compute node and contains system-unique
information (for example, assigned IP addresses and MAC addresses).

System profile management

When a pattern is deployed, an individual system profile is generated for each
target system. You can edit a pattern and save changes, and any dependent system
profiles are automatically updated and redeployed to their associated systems. You
can move an existing profile from one system to another by unassigning the
profile, and then redeploying the profile to another system.
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Important: Systems retain their identification information (for example, hostname,
IP address, virtual MAC address) when a profile is unassigned. To avoid name and
address conflicts, any identification information on the original system should be
cleared before the unassigned profile is deployed to a different system.

Server profiles

Each server profile represents the specific configuration of a single compute node
and contains information that is unique to a compute node. The server profile is
activated as part of the IMM startup process. Once a server profile is activated for
a compute node, any subsequent configuration changes are done by editing the
appropriate server pattern or category pattern associated with the profile. This
enables you to control a common configuration pattern from a single place.

If a compute node needs to be moved or re-purposed, you can reassign a server
profile from one compute node to another.

You can deploy a server pattern to a compute node or to an empty chassis bay. In
either case, the profile is associated with the chassis bay. If you replace an existing
compute node, you must redeploy the server profile associated with that bay to
activate the profile on the new compute node. If you first deploy a server pattern
to an empty bay, then you must redeploy the server profile associated with that
bay after a compute node is installed.

Note: To ensure that your configuration patterns are not lost if the management
node fails, back up the management software after you create or modify
configuration patterns.

Scenario: Configuring two sets of compute nodes:

You can use Configuration Patterns to configure two groups of compute nodes: one
group that you use for qualification and test and another group for production.
This scenario describes how to share a category pattern between two server
patterns and how to use different IP address ranges to help identify different
groups of compute nodes.
1. Create a server pattern (server pattern A) for the test compute nodes with the

following settings in the New Server Pattern Wizard:
a. For the Local Storage step, specify a RAID 1 configuration so that the

compute nodes boot from local storage.
b. For the I/O adapters step, keep the default I/O adapter addressing setting

Burned in (because you are not using IBM Fabric Manager).
c. For the Boot step, update the boot order list to boot from Hard Disk 0.

2. Create a system information pattern for your test compute nodes. Specify a
naming scheme and the contact information for your test compute nodes.

3. Create a Management Interface pattern for the test compute nodes. Specify a
naming scheme for your test compute nodes and choose to obtain a static IP
address from an IP address pool.

4. Create an IP Address pool with a specific subrange to use for assigning
addresses to the test compute nodes.

5. Create a Devices and I/O Ports pattern for the test compute nodes. Specify
Console Redirection and enable Serial over LAN.
The following diagram shows the Configuration Patterns for the test compute
nodes.
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6. Copy server pattern A that you created for the test compute nodes and save it
as another server pattern (server pattern B) for the production compute nodes.
a. For the Local Storage step, specify Disable local disk because your

production compute nodes will boot from an embedded hypervisor.
b. For the Boot step, update the boot order list to boot from the embedded

hypervisor.
7. Edit and save a new System Information pattern for the production compute

nodes (because a different team will manage your production compute nodes).
Specify a naming scheme and the contact information for your production
compute nodes.

8. Edit and save a new Management Interface pattern for the production
compute nodes. Specify a naming scheme for your production compute nodes
and choose to obtain a static IP address from the same IP address pool that
you used for the test compute nodes.

9. Edit the IP Address pool and add another subrange that is specific to the
production compute nodes. This can help identify test from production, and
enables you to manage access and firewall rules differently.

10. Keep the same Console Redirection and Serial over LAN settings for the
production compute nodes by using the same Devices and I/O Ports pattern
that you used for the test compute nodes.
The following diagram shows the Configuration Patterns for both groups of
servers (test and production compute nodes).
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11. To ensure that your configuration patterns are not lost if the management
node fails, back up the management software after you create or modify
configuration patterns.

Configuration Patterns and IBM Fabric Manager (IFM)
The Configuration Patterns function of the IBM Flex System Manager management
software integrates IBM Fabric Manager (IFM) functionality.

Beginning with IBM Flex System Manager management software version 1.2.0, the
management software offers integrated IFM capabilities for X-Architecture compute
nodes through Configuration Patterns.

If you have been using stand-alone IFM with X-Architecture compute nodes in
your IBM Flex System environment, see Transitioning from stand-alone IFM to
Configuration Patterns for important guidelines and conditions.

Important: For IBM Power Systems compute nodes, continue to use stand-alone
IFM (through the CMM).

For more information about using IFM as an integrated part of Configuration
Patterns, see Using integrated IFM in Configuration Patterns.
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Transitioning from stand-alone IFM to Configuration Patterns:

Beginning with IBM Flex System Manager version 1.2.0, the management software
offers IFM capabilities for X-Architecture compute nodes through Configuration
Patterns. If you have used stand-alone IFM, and will now use Configuration
Patterns with integrated IFM, be aware of the Configuration Patterns conditions for
use.

Note: For IBM Power Systems compute nodes, continue to use stand-alone IFM
(through the Chassis Management Module).

The following conditions apply to Configuration Patterns with integrated IFM:
v You cannot migrate or use stand-alone IFM profiles and deployments (through

the CMM) with Configuration Patterns.
v Make sure that you avoid address conflicts with Configuration Patterns.

Configuration Patterns uses the same I/O adapter virtual address space as
stand-alone IBM Fabric Manager (IFM).

v Once a server pattern is deployed to an X-Architecture compute node and a
server profile is generated, any I/O adapter virtual addressing from that server
profile is assigned to the compute node. Virtual addresses from stand-alone IFM
deployments (through the CMM) are no longer used.

v Configuration Patterns provides predefined I/O address pools with predefined
address subranges that can be used to help prevent address conflicts. When you
create server patterns with I/O adapter virtual addressing, make sure that you
select a predefined address subrange that does not conflict with existing IFM
deployments or other IBM Flex System Manager management domains.
See Predefined I/O address pool subranges.

Using integrated IFM in Configuration Patterns:

The virtual I/O address management capabilities of IBM Fabric Manager (IFM) are
integrated with Configuration Patterns in version 1.2.0 of the IBM Flex System
Manager. You can use virtual addressing to simplify the management of compute
node LAN and SAN connections, to enable faster deployment, and to enable
automatic failover by virtualizing WWN and MAC addresses.

Note: You must purchase and install an IBM Fabric Manager (IFM) upgrade
license for the chassis that contains the compute nodes that you want to configure
for virtual addressing through Configuration Patterns. You can use the
management software to install IFM Features on Demand options. See Using
Features on Demand keys for more information.

The following sections describe the Configuration Patterns capabilities and
conditions for virtual addressing, SAN boot targets, and failover monitoring.

Enabling virtual addressing

When you create a server pattern, you can enable virtual addressing when you
define I/O adapter configuration. When virtual addressing is enabled, Ethernet
addresses are assigned from the IBM MAC Addresses pool. You can choose to
allocate Fibre Channel addresses from one of four pools:
v IBM WWN Addresses
v Brocade WWN Addresses
v Emulex WWN Addresses
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v QLogic WWN Addresses

Use the IBM WWN Addresses pool, unless you have a specific need to use one of
the other pools.

Predefined I/O address subranges are provided that you can use to prevent
address conflicts. The scope of an I/O address pool and subrange is the IBM Flex
System Manager management domain, or all chassis and chassis components that
are managed by a single management node. In an environment with multiple
management nodes, or if you are using stand-alone IFM, select a predefined
address subrange that does not conflict with existing IFM deployments or other
IBM Flex System Manager management domains.

For a list of the predefined I/O address subranges, see Predefined I/O address
pool subranges.

SAN boot targets

You can create SAN boot target patterns to define specific primary and secondary
Fibre Channel WWN boot targets. When you create a server pattern, you can
define the boot target pattern during the boot order configuration step. After it is
defined, you can assign the boot target pattern to specific HBAs.

Failover monitoring

After a compute node is configured with a server pattern, and is assigned a server
profile, you can monitor the compute node for specific failure conditions. If a
failover condition is detected, the assigned server profile will be moved
automatically to a standby compute node, allowing for quicker recovery from
compute node failures.

Failover policies specify the failover conditions that are monitored, and are used in
conjunction with standby server pools to choose an available standby compute
node. If the standby compute node is powered off during failover, the profile is
assigned and the compute node is started automatically; the result is full profile
activation.

If the standby compute node is powered on, the profile is assigned but the
compute node is not restarted. The result is a partial profile activation, and the
standby compute node must be restarted manually before the profile is fully
activated.

After the server profile is migrated to a standby compute node, the failed compute
node is automatically powered off and the IMM is reset to factory defaults.
Compute node UEFI information, including any I/O adapter virtual addresses, is
not reset and must be cleared manually if the failed compute node is put back into
service. When you use a standby compute node as a failover target, it is removed
from the standby server pool. After the failed compute node is repaired or
replaced, you can add it to the standby server pool to be used as a new failover
target.

VLAN settings on attached switches are not copied automatically; in the case of
failover, they must be migrated manually.
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Predefined I/O address pool subranges:

Configuration Patterns provides predefined I/O address pools with predefined
address subranges that can be used to help prevent address conflicts. When you
create server patterns with I/O adapter virtual addressing, make sure that you
select a predefined address subrange that does not conflict with existing IFM
deployments or other IBM Flex System Manager management domains.

Predefined I/O address domains for Ethernet adapters

Table 60. IBM MAC Addresses pool.
Note: Each IBM MAC domain contains 7,281 addresses.

Predefined subrange Starting address Ending address

Domain 1 00:1A:64:76:00:00 00:1A:64:76:1C:71

Domain 2 00:1A:64:76:1C:71 00:1A:64:76:38:E3

Domain 3 00:1A:64:76: 38:E4 00:1A:64:76:55:55

Domain 4 00:1A:64:76:55:56 00:1A:64:76:71:C7

Domain 5 00:1A:64:76:71:C8 00:1A:64:76:8E:39

Domain 6 00:1A:64:76:8E:40 00:1A:64:76:9F:B1

Domain 7 00:1A:64:76:9F:B2 00:1A:64:76:BC:23

Domain 8 00:1A:64:76:BC:24 00:1A:64:76:D8:95

Domain 9 00:1A:64:76:D8:96 00:1A:64:76:F5:07

Predefined I/O address domains for Fibre Channel adapters

Table 61. Brocade WWN Addresses pool.
Note: Each Brocade domain contains 1,864,135 addresses.
Predefined subrange WWNN starting address WWNN ending address WWPN starting address WWPN ending address

Fabric A

Domain 1 2B:FA:00:05:1E:00:00:00 2B:FA:00:05:1E:1C:71:C7 2B:FC:00:05:1E:00:00:00 2B:FC:00:05:1E:1C:71:C7

Domain 2 2B:FA:00:05:1E:1C:71:C8 2B:FA:00:05:1E:38:E3:8F 2B:FC:00:05:1E:1C:71:C8 2B:FC:00:05:1E:38:E3:8F

Domain 3 2B:FA:00:05:1E:38:E3:90 2B:FA:00:05:1E:55:55:57 2B:FC:00:05:1E:38:E3:90 2B:FC:00:05:1E:55:55:57

Domain 4 2B:FA:00:05:1E:55:55:58 2B:FA:00:05:1E:71:C7:1F 2B:FC:00:05:1E:55:55:58 2B:FC:00:05:1E:71:C7:1F

Domain 5 2B:FA:00:05:1E:71:C7:20 2B:FA:00:05:1E:8E:38:E7 2B:FC:00:05:1E:71:C7:20 2B:FC:00:05:1E:8E:38:E7

Domain 6 2B:FA:00:05:1E:8E:38:E8 2B:FA:00:05:1E:AA:AA:AF 2B:FC:00:05:1E:8E:38:E8 2B:FC:00:05:1E:AA:AA:AF

Domain 7 2B:FA:00:05:1E:AA:AA:B0 2B:FA:00:05:1E:C7:1C:77 2B:FC:00:05:1E:AA:AA:B0 2B:FC:00:05:1E:C7:1C:77

Domain 8 2B:FA:00:05:1E:C7:1C:78 2B:FA:00:05:1E:E3:8E:3F 2B:FC:00:05:1E:C7:1C:78 2B:FC:00:05:1E:E3:8E:3F

Domain 9 2B:FA:00:05:1E:E3:8E:40 2B:FA:00:05:1E:FF:FF:FF 2B:FC:00:05:1E:E3:8E:40 2B:FC:00:05:1E:FF:FF:FF

Fabric B

Domain 1 2B:FB:00:05:1E:00:00:00 2B:FB:00:05:1E:1C:71:C7 2B:FD:00:05:1E:00:00:00 2B:FD:00:05:1E:1C:71:C7

Domain 2 2B:FB:00:05:1E:1C:71:C8 2B:FB:00:05:1E:38:E3:8F 2B:FD:00:05:1E:1C:71:C8 2B:FD:00:05:1E:38:E3:8F

Domain 3 2B:FB:00:05:1E:38:E3:90 2B:FB:00:05:1E:55:55:57 2B:FD:00:05:1E:38:E3:90 2B:FD:00:05:1E:55:55:57

Domain 4 2B:FB:00:05:1E:55:55:58 2B:FB:00:05:1E:71:C7:1F 2B:FD:00:05:1E:55:55:58 2B:FD:00:05:1E:71:C7:1F

Domain 5 2B:FB:00:05:1E:71:C7:20 2B:FB:00:05:1E:8E:38:E7 2B:FD:00:05:1E:71:C7:20 2B:FD:00:05:1E:8E:38:E7

Domain 6 2B:FB:00:05:1E:8E:38:E8 2B:FB:00:05:1E:AA:AA:AF 2B:FD:00:05:1E:8E:38:E8 2B:FD:00:05:1E:AA:AA:AF

Domain 7 2B:FB:00:05:1E:AA:AA:B0 2B:FB:00:05:1E:C7:1C:77 2B:FD:00:05:1E:AA:AA:B0 2B:FD:00:05:1E:C7:1C:77

Domain 8 2B:FB:00:05:1E:C7:1C:78 2B:FB:00:05:1E:E3:8E:3F 2B:FD:00:05:1E:C7:1C:78 2B:FD:00:05:1E:E3:8E:3F

Domain 9 2B:FB:00:05:1E:E3:8E:40 2B:FB:00:05:1E:FF:FF:FF 2B:FD:00:05:1E:E3:8E:40 2B:FD:00:05:1E:FF:FF:FF
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Table 62. Emulex WWN Addresses pool.
Note: Each Emulex domain contains 1,864,135 addresses.
Predefined subrange WWNN starting address WWNN ending address WWPN starting address WWPN ending address

Fabric A

Domain 1 2F:FE:00:00:C9:00:00:00 2F:FE:00:00:C9:1C:71:C7 2F:FC:00:00:C9:00:00:00 2F:FC:00:00:C9:1C:71:C7

Domain 2 2F:FE:00:00:C9:1C:71:C8 2F:FE:00:00:C9:38:E3:8F 2F:FC:00:00:C9:1C:71:C8 2F:FC:00:00:C9:38:E3:8F

Domain 3 2F:FE:00:00:C9:38:E3:90 2F:FE:00:00:C9:55:55:57 2F:FC:00:00:C9:38:E3:90 2F:FC:00:00:C9:55:55:57

Domain 4 2F:FE:00:00:C9:55:55:58 2F:FE:00:00:C9:71:C7:1F 2F:FC:00:00:C9:55:55:58 2F:FC:00:00:C9:71:C7:1F

Domain 5 2F:FE:00:00:C9:71:C7:20 2F:FE:00:00:C9:8E:38:E7 2F:FC:00:00:C9:71:C7:20 2F:FC:00:00:C9:8E:38:E7

Domain 6 2F:FE:00:00:C9:8E:38:E8 2F:FE:00:00:C9:AA:AA:AF 2F:FC:00:00:C9:8E:38:E8 2F:FC:00:00:C9:AA:AA:AF

Domain 7 2F:FE:00:00:C9:AA:AA:B0 2F:FE:00:00:C9:C7:1C:77 2F:FC:00:00:C9:AA:AA:B0 2F:FC:00:00:C9:C7:1C:77

Domain 8 2F:FE:00:00:C9:C7:1C:78 2F:FE:00:00:C9:E3:8E:3F 2F:FC:00:00:C9:C7:1C:78 2F:FC:00:00:C9:E3:8E:3F

Domain 9 2F:FE:00:00:C9:E3:8E:40 2F:FE:00:00:C9:FF:FF:FF 2F:FC:00:00:C9:E3:8E:40 2F:FC:00:00:C9:FF:FF:FF

Fabric B

Domain 1 2F:FF:00:00:C9:00:00:00 2F:FF:00:00:C9:1C:71:C7 2F:FD:00:00:C9:00:00:00 2F:FD:00:00:C9:1C:71:C7

Domain 2 2F:FF:00:00:C9:1C:71:C8 2F:FF:00:00:C9:38:E3:8F 2F:FD:00:00:C9:1C:71:C8 2F:FD:00:00:C9:38:E3:8F

Domain 3 2F:FF:00:00:C9:38:E3:90 2F:FF:00:00:C9:55:55:57 2F:FD:00:00:C9:38:E3:90 2F:FD:00:00:C9:55:55:57

Domain 4 2F:FF:00:00:C9:55:55:58 2F:FF:00:00:C9:71:C7:1F 2F:FD:00:00:C9:55:55:58 2F:FD:00:00:C9:71:C7:1F

Domain 5 2F:FF:00:00:C9:71:C7:20 2F:FF:00:00:C9:8E:38:E7 2F:FD:00:00:C9:71:C7:20 2F:FD:00:00:C9:8E:38:E7

Domain 6 2F:FF:00:00:C9:8E:38:E8 2F:FF:00:00:C9:AA:AA:AF 2F:FD:00:00:C9:8E:38:E8 2F:FD:00:00:C9:AA:AA:AF

Domain 7 2F:FF:00:00:C9:AA:AA:B0 2F:FF:00:00:C9:C7:1C:77 2F:FD:00:00:C9:AA:AA:B0 2F:FD:00:00:C9:C7:1C:77

Domain 8 2F:FF:00:00:C9:C7:1C:78 2F:FF:00:00:C9:E3:8E:3F 2F:FD:00:00:C9:C7:1C:78 2F:FD:00:00:C9:E3:8E:3F

Domain 9 2F:FF:00:00:C9:E3:8E:40 2F:FF:00:00:C9:FF:FF:FF 2F:FD:00:00:C9:E3:8E:40 2F:FD:00:00:C9:FF:FF:FF

Table 63. IBM WWN Addresses pool.
Note: Each IBM WWN domain contains 116,508 addresses.
Predefined subrange WWNN starting address WWNN ending address WWPN starting address WWPN ending address

Fabric A

Domain 1 20:80:00:50:76:00:00:00 20:80:00:50:76:01:C7:1C 21:80:00:50:76:00:00:00 21:80:00:50:76:01:C7:1C

Domain 2 20:80:00:50:76:01:C7:1D 20:80:00:50:76:03:8E:39 21:80:00:50:76:01:C7:1D 21:80:00:50:76:03:8E:39

Domain 3 20:80:00:50:76:03:8E:40 20:80:00:50:76:05:55:56 21:80:00:50:76:03:8E:40 21:80:00:50:76:05:55:56

Domain 4 20:80:00:50:76:05:55:57 20:80:00:50:76:07:1C:73 21:80:00:50:76:05:55:57 21:80:00:50:76:07:1C:73

Domain 5 20:80:00:50:76:07:1C:74 20:80:00:50:76:08:E3:90 21:80:00:50:76:07:1C:74 21:80:00:50:76:08:E3:90

Domain 6 20:80:00:50:76:08:E3:91 20:80:00:50:76:0A:AA:AD 21:80:00:50:76:08:E3:91 21:80:00:50:76:0A:AA:AD

Domain 7 20:80:00:50:76:0A:AA:AE 20:80:00:50:76:0C:71:CA 21:80:00:50:76:0A:AA:AE 21:80:00:50:76:0C:71:CA

Domain 8 20:80:00:50:76:0C:71:CB 20:80:00:50:76:0E:38:37 21:80:00:50:76:0C:71:CB 21:80:00:50:76:0E:38:37

Domain 9 20:80:00:50:76:0E:38:38 20:80:00:50:76:0F:FF:54 20:80:00:50:76:0E:38:38 20:80:00:50:76:0F:FF:54

Fabric B

Domain 1 20:81:00:50:76:20:00:00 20:81:00:50:76:21:C7:1C 21:81:00:50:76:20:00:00 21:81:00:50:76:21:C7:1C

Domain 2 20:81:00:50:76:21:C7:1D 20:81:00:50:76:23:8E:39 21:81:00:50:76:21:C7:1D 21:81:00:50:76:23:8E:39

Domain 3 20:81:00:50:76:23:8E:40 20:81:00:50:76:25:55:56 21:81:00:50:76:23:8E:40 21:81:00:50:76:25:55:56

Domain 4 20:81:00:50:76:25:55:57 20:81:00:50:76:27:1C:73 21:81:00:50:76:25:55:57 21:81:00:50:76:27:1C:73

Domain 5 20:81:00:50:76:27:1C:74 20:81:00:50:76:28:E3:90 21:81:00:50:76:27:1C:74 21:81:00:50:76:28:E3:90

Domain 6 20:81:00:50:76:28:E3:91 20:81:00:50:76:2A:AA:AD 21:81:00:50:76:28:E3:91 21:81:00:50:76:2A:AA:AD

Domain 7 20:81:00:50:76:2A:AA:AE 20:81:00:50:76:2C:71:CA 21:81:00:50:76:2A:AA:AE 21:81:00:50:76:2C:71:CA

Domain 8 20:81:00:50:76:2C:71:CB 20:81:00:50:76:2E:38:37 21:81:00:50:76:2C:71:CB 21:81:00:50:76:2E:38:37

Domain 9 20:81:00:50:76:2E:38:38 20:81:00:50:76:2F:FF:54 21:81:00:50:76:2E:38:38 21:81:00:50:76:2F:FF:54
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Table 64. QLogic WWN Addresses pool.
Note:

1. QLogic does not support Worldwide Node Names (WWNN), so only WWPN values are listed in the following
table.

2. Each QLogic WWN domain contains 116,508 addresses.

Predefined subrange WWPN starting address WWPN ending address

Fabric A

Domain 1 21:80:00:E0:8B:00:00:00 21:80:00:E0:8B:01:C7:1C

Domain 2 21:80:00:E0:8B:01:C7:1D 21:80:00:E0:8B:03:8E:39

Domain 3 21:80:00:E0:8B:03:8E:40 21:80:00:E0:8B:05:55:56

Domain 4 21:80:00:E0:8B:05:55:57 21:80:00:E0:8B:07:1C:73

Domain 5 21:80:00:E0:8B:07:1C:74 21:80:00:E0:8B:08:E3:90

Domain 6 21:80:00:E0:8B:08:E3:91 21:80:00:E0:8B:0A:AA:AD

Domain 7 21:80:00:E0:8B:0A:AA:AE 21:80:00:E0:8B:0C:71:CA

Domain 8 21:80:00:E0:8B:0C:71:CB 21:80:00:E0:8B:0E:38:37

Domain 9 21:80:00:E0:8B:0E:38:38 21:80:00:E0:8B:0F:FF:54

Fabric B

Domain 1 21:81:00:E0:8B:20:00:00 21:81:00:E0:8B:21:C7:1C

Domain 2 21:81:00:E0:8B:21:C7:1D 21:81:00:E0:8B:23:8E:39

Domain 3 21:81:00:E0:8B:23:8E:40 21:81:00:E0:8B:25:55:56

Domain 4 21:81:00:E0:8B:25:55:57 21:81:00:E0:8B:27:1C:73

Domain 5 21:81:00:E0:8B:27:1C:74 21:81:00:E0:8B:28:E3:90

Domain 6 21:81:00:E0:8B:28:E3:91 21:81:00:E0:8B:2A:AA:AD

Domain 7 21:81:00:E0:8B:2A:AA:AE 21:81:00:E0:8B:2C:71:CA

Domain 8 21:81:00:E0:8B:2C:71:CB 21:81:00:E0:8B:2E:38:37

Domain 9 21:81:00:E0:8B:2E:38:38 21:81:00:E0:8B:2F:FF:54

Methods for operating-system deployment to X-Architecture
compute nodes

Before you deploy an operating-system image to an X-Architecture compute node,
choose the right deployment method for the operating system your compute
nodes.

Before you begin

Determine which of the following methods you will use to install an operating
system on the X-Architecture compute node:

ServerGuide deployment
For information about using ServerGuide for Microsoft Windows, see the
Installing Microsoft Windows using IBM ServerGuide quick start guide PDF in
the Quick start guides section of the IBM Flex System Information Center
at http://publib.boulder.ibm.com/infocenter/flexsys/information/topic/
com.ibm.acc.commontasks.doc/commontasks_install_os.html.
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ServerGuide Scripting Toolkit deployment
For information about using the ServerGuide Scripting Toolkit, see the
Installing Linux using IBM ServerGuide Scripting Toolkit quick start guide
PDF in the Quick start guides section of the IBM Flex System Information
Center at http://publib.boulder.ibm.com/infocenter/flexsys/information/
topic/com.ibm.acc.commontasks.doc/commontasks_install_os.html.

Operating system vendor deployment
If you want to deploy VMware ESXi, RHEL, or RHEL Kernel-based Virtual
Machine (KVM), you can use the Deploy compute node images task to
import the operating system to the management node and then deploy it
to multiple X-Architecture compute nodes.

About this task

In addition to the preceding deployment methods, you can find installation
instructions for some operating systems and compute nodes on the IBM website.
For instructions related to the installation procedure for a specific operating system
running on a specific compute node, complete the following steps.

Note: The specific instructions for the operating systems also contain information
about installing those operating systems on a virtual machine.

Procedure
1. Go to www.ibm.com.
2. In the search field, type the machine type for the compute node, followed by

operating system installation instructions. For example, to find the
operating system installation instructions for the IBM Flex System x240
Compute Node Types 7863, 8737, and 8738, type the following:
8737 operating system installation instructions

Alternatively, you can type the name of the operating system, as in the
following example:
RHEL5.7 x86_64 Install Instructions

What to do next

The IBM Flex System Manager requires that you discover and inventory an
operating system after it is deployed to a compute node, unless you use the
Deploy compute node images task (in which case the discovery and inventory
occurs automatically).

Using the Deploy compute node images task to deploy
operating systems

You can use the IBM Flex System Manager web interface to deploy operating
system and virtual images to multiple compute nodes quickly and easily.

About this task

The management software provides a simple way to deploy operating systems
images to bare metal systems, or systems that do not already have an operating
system installed. This function is limited to deploying the VMware ESXi and Red
Hat Enterprise Linux (RHEL) to X-Architecture compute nodes.
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The Deploy compute node images task is capable of mass operating-system
deployment; the management software supports up to 56 X-Architecture compute
nodes for concurrent deployment. You can launch the task from the Chassis Map
view, the Home page, or the IBM FSM Explorer console in the management
software web interface.

Note: You can use Configuration Patterns to assign firmware and boot order
settings for the X-Architecture compute nodes before you deploy operating systems
or virtual images to them.

Supported operating systems for the Deploy compute node
images task
Use this information to determine which operating systems can be deployed to one
or more X-Architecture computes nodes with the Deploy Compute Node Images
page in the IBM Flex System Manager web interface.

Note: You can use the Deploy Compute Node Image task to install operating
systems on X-Architecture compute nodes only.

The following operating systems are supported:

VMware vSphere Hypervisor (ESXi) with IBM customization
A version of the IBM-customized VMware vSphere Hypervisor is
preloaded on the IBM Flex System Manager management node.

Red Hat Enterprise Linux 
When you import the Red Hat Enterprise Linux ISO image, it will generate
three different OS image profiles: Minimal, Basic and Virtualization. You
can deploy any of these images to X-Architecture compute nodes.

Red Hat Enterprise Linux:

You can use the Deploy images to compute nodes task to install Red Hat
Enterprise Linux. When you import the Red Hat Enterprise Linux ISO image, it
will generate three different OS image profiles: Minimal, Basic and Virtualization.
You can deploy any of these images to X-Architecture compute nodes.

Table 65. Red Hat Enterprise Linux (RHEL) compatibility with Deploying compute node images task

RHEL version Available profiles1 FSM version
compatibility

Deployment information

RHEL 6.2 Minimal

Basic

Virtualization2

1.2.0 and later3 No support for System x880 model 7903

RHEL 6.3 Minimal

Basic

Virtualization2

1.2.0 and later3 No support for System x880 model 7903

RHEL 6.4 Minimal

Basic

Virtualization2

1.3.0 and later No support for System x880 model 7903

RHEL 6.5 Minimal

Basic

Virtualization2

1.3.2 and later
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Table 65. Red Hat Enterprise Linux (RHEL) compatibility with Deploying compute node images task (continued)

RHEL version Available profiles1 FSM version
compatibility

Deployment information

1: See “Port availability for deployed operating systems” on page 551 for a list of specific ports that are not blocked by each of the
RHEL profiles.

2: See “Deploying RHEL Virtualization profiles” for deployment information that is specific to this profile.

Deploying RHEL Virtualization profiles:

Make sure that you understand the IBM Flex System Manager management
software conditions for the Red Hat Enterprise Linux Virtualization profile before
you attempt to deploy this type of operating system image.

When you import the Red Hat Enterprise Linux ISO image, the management
software generates three different OS image profiles: Minimal, Basic and
Virtualization. The RHEL Virtualization profile configures Linux Kernel-based
Virtual Machine (KVM) Platform Agent and other VMControl integration steps.

Note: If VMControl is not activated before you deploy the image and you want to
manage the virtual server/host through VMControl, you must activate the
VMControl plug-in and then collect inventory on the virtual server/host manually
for the deployed operating system.

Accessing deployed virtual machines through Remote Control

The KVM QEMU virtualization technology supports VNC pass-through
connections from the hypervisor host to deployed virtual machines. To enable this
support, you must modify the iptables or ip6tables on the host to allow
connections to the ports that are used for the VNC pass-through. Typically, the port
that corresponds to the first VM is 5900, the port for the second VM is 5901, and so
on. After the ports are opened in the firewall, you can use VNC and the
management software Remote Control application to access the VM.

The following example shows iptables calls from the KVM host to open 50 ports
on the host for VNC access:
iptables -I INPUT -p tcp --dport 5900:5950 -j ACCEPT

service iptables save

service iptables restart

VMware vSphere Hypervisor (ESXi) with IBM customization:

A version of the IBM-customized VMware vSphere Hypervisor is preloaded on the
IBM Flex System Manager management node.

Table 66. VMware vSphere Hypervisor (ESXi) compatibility with Deploying compute node images task

ESXi version
FSM version
compatibility

Deployment information

ESXi 5.1 1.2.0 and later No support for System x880 model 7903.

See “Port availability for deployed operating systems” for a list of specific
ports that are not blocked by VMware ESXi 5.1.
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Table 66. VMware vSphere Hypervisor (ESXi) compatibility with Deploying compute node images task (continued)

ESXi version
FSM version
compatibility

Deployment information

ESXi 5.1 U1, U2 1.3.2 and later See “Port availability for deployed operating systems” for a list of specific
ports that are not blocked by VMware ESXi 5.1.U1.

To download VMware vSphere Hypervisor (ESXi) 5.1.U1 with IBM
customization, go to https://www14.software.ibm.com/webapp/iwm/
web/preLogin.do?source=stg-esxi5.

ESXi 5.5 U1 1.3.2 and later VMware vSphere Hypervisor (ESXi) 5.1 with IBM customization deploys
with the IBM System Networking Distributed Switch 5000V vDS host
module. The vDS host module implements a vDS portset and acts as a
virtual network switch.

See “Port availability for deployed operating systems” for a list of specific
ports that are not blocked by VMware ESXi 5.1.U1.

No support for System x880 model 7903.

To download VMware vSphere Hypervisor (ESXi) 5.1.U1 with IBM
customization, go to https://www14.software.ibm.com/webapp/iwm/
web/preLogin.do?source=stg-esxi5.

Note: In TLS1.2 and NIST-Strict modes, only ESXi 5.5 is supported for
deployment. You can deploy older versions of ESXi by using the command: 'smcli
enabledeployosoverride' to enable less secure protocols and allow older ESXi
versions to deploy. To disable the less secure protocols, run 'smcli
disabledeployosoverride'.

Preparing to import and deploy compute node images
Before you import and deploy compute node images, make sure that the compute
nodes and operating systems are ready for the deployment.

Verify that the following conditions are met before you deploy operating systems
to compute nodes:
v The IBM Flex System Manager network port that is used for the data network

(typically eth1) must be on the same network as the network ports on the
compute nodes where the operating systems will be installed. Otherwise, you
cannot deploy operating systems to those compute nodes.

v For the operating systems that you want to deploy, obtain the licenses directly
from the operating system manufacturer.

v A password must be set in the Global settings window before you can deploy an
operating system.

v The chassis that contains the compute nodes is unlocked and online.
v The compute nodes are unlocked and online.
v If Configuration Patterns profiles have been partially deployed, you might have

to restart the compute node to apply all of the settings. Make sure that you
restart the compute node so that the pattern settings that require a restart (for
example, I/O adapter changes) are applied.

v A MAC address is assigned for the network interface that will be used for OS
deployment to each compute node. A default MAC address is recognized
automatically; typically, it will default to the host network interface card
(LAN-on-motherboard) for the compute node. If the MAC addresses that are
listed do not match the MAC address information that you expect, or do not
match the information listed in UEFI, collect inventory on the compute node to
refresh the listed MAC addresses.
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If the preceding conditions are met, Ready is displayed in the Deploy Status
column for each chassis and compute node on the Deploy Compute Node Images
page.

Before you deploy an operating system for the first time, you must import the
operating system image.

Note: The import process for an operating system image is a one-time
requirement; you do not need to import a separate operating system image for
each compute node.

Importing operating system images
Before you can view operating systems in the IBM Flex System Manager
management software and deploy a licensed operating system to compute nodes,
you must first copy the image to a management node directory and import it to
the management software.

Before you begin

The IBM Flex System Manager management node supports a maximum of five
operating system images in local storage. A version of the VMware vSphere
Hypervisor (ESXi) 5.1 with IBM customization is preloaded on the management
node; therefore, you can import four additional operating system image on the
management node and then deploy those images to the X-Architecture compute
nodes.

The import process for an operating system image is a one-time requirement; you
do not need to import a separate operating system image for each compute node.

Note: If you already have five images loaded on the IBM Flex System Manager
management node, you will need to first delete one of those images before
attempting to import another image. For example, you can delete the VMware
vSphere Hypervisor (ESXi) 5.1 image if needed. Complete the following steps to
delete an operating system image from the management node:
1. Access the management node using SSH.
2. Log in to the IBM Flex System Manager user interface using a user account

with administrator privileges (such as USERID).
3. Use the command smcli lsosimages to list all images stored on the IBM Flex

System Manager management node.
4. Use the command smcli deleteosimage to delete one or more of the images.

About this task

Complete the following steps to import an operating system to the IBM Flex
System Manager management node:

Procedure
1. Obtain a licensed ISO image of the operating system.
2. Use one of the following methods to copy the ISO image to an accessible

directory on the management node, such as /home/USERID:

Use Secure Copy (SCP):

v Use an SCP tool on a laptop or workstation attached to the management
or data network to send the ISO image to the management node.
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v Use the scp command in the management software command-line
interface to retrieve the ISO image from an SSH server on the
management or data network. See the following examples:
From the IBM Flex System Manager management node where you are
logged in using a user account with administrator privileges (such as
USERID):
scp USERID @<remote_host_name>:/directory/* /home/*

From a remote server or workstation:
scp * USERID@<management_node_host_name>:/home/USERID/*

Copy the ISO image from a USB storage device:

a. Insert a USB storage device into the USB port on the front of the
management node.

b. Access the management node using SSH.
c. Log in using a user account with administrator privileges (such as

USERID).
d. Use the command lsmediadev to list the storage media devices that are

available for use on the system and identify the USB storage device.
The resulting output will be similar to the following, where vdi1 is the
USB storage device:
device=/dev/vdi1,mount_point=/media/vdi1,type=3,description=USB flash memory device

e. Type mount /dev/vdi1 and press Enter.
f. Use the command cp to copy the files. For example:

cp /media/vdi1/<file_name> /home/USERID/.

3. Import the ISO image using the command smcli importosimage. For example:
smcli importosimage /home/USERID/RHEL6.4-2012.0-Server-x86_64.iso

Results

After you import the image, it will be displayed in the Image to Deploy column.

Operating-system settings during and after deployment
Use this information to understand the conditions and settings that are active after
you deploy operating systems.

To deploy an image, select the compute node to which the image will be deployed
and then select the operating system image to be deployed. If you deploy an
image to a compute node that already has an operating system installed, the
existing operating system will be overwritten.

The following settings and conditions apply to operating-system deployment:

Target installation device
You must use a local hard disk drive as the target storage device for
operating-system deployment to a compute node. Storage devices that are
connected to the compute node and that are not a local hard disk drive
(for example, USB and SAN devices) are not supported for use with
deployment.

Important: Legacy boot mode (non-UEFI) is not supported. Make sure that
the target compute node has at least one local hard disk drive and that the
hard disk drive is recognized by the compute node firmware in the UEFI
boot device list.
Both RAID and non-RAID configurations are supported.
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IP address settings
To determine IP address settings from the Deploy Compute Node Images
page, click Global settings. The Global settings window provides two
choices for the IP settings that will be used for all image deployments:
v Let IBM Flex System Manager automatically assign the addresses

The addresses are configured automatically, using IPv6. Use this option
when there is no DHCP infrastructure on the network and when the
management node is on the same subnet as the target compute nodes.

Important:

– You cannot deploy operating systems to compute nodes in a remote
chassis, or a chassis in a different geographic location than the
management node, when the auto-assign setting is enabled.

– VMware ESXi 5.1 does not support SLP over IPv6. If you are
deploying VMware ESXi, and you selected the option Let IBM Flex
System Manager automatically assign the addresses, the
management software is unable to discover and manage the operating
system. To establish management, you must assign an IPv4 address to
the operating system manually and discover the operating system
manually.
If you deploy the ESXi operating system with the Use Dynamic Host
Configuration Protocol (DHCP) to create the addresses option,
manual IP address configuration and discovery are not necessary.

v Use Dynamic Host Configuration Protocol (DHCP) to create the
addresses

The DHCP server assigns addresses that are appropriate for the target
system. Use this option when there is an existing DHCPv4 infrastructure
on the network that the target compute nodes can use. Use this method
if your environment does not support IPv6 network traffic on the data
network.

Selecting MAC addresses

In the table on the Deploy Compute Node Images page, the MAC Address
column displays the MAC address for the network interface that will be
used for OS deployment to each compute node. A default MAC address is
recognized automatically; typically, it will default to the host network
interface card (LAN-on-motherboard) for the compute node. If the compute
node does not have a host network interface card installed, it will use any
other network interfaces in the compute node, such as an Ethernet
mezzanine card.

Note: If the value in the MAC Address column for a compute node is No
valid MAC, and your compute node does not have a host network interface
card installed, you might have to install and configure network interface
controller for the compute node.

If you want to change the MAC address setting for OS deployment, click
the MAC address link in the table. The Select MAC Address window
opens, which enables you to select a different compute node network
interface.

Important:

v Make sure that the IBM Flex System Manager network port that is used
for the data network (typically, eth1) is on the same network as the
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network ports (associated with the MAC addresses that you selected) on
the compute nodes where the operating systems will be installed.
Otherwise, you cannot deploy operating systems to those compute
nodes.

v If you do not see a MAC address listed, collect inventory on that
compute node. Additionally, if the deployment times out, or fails to
proceed, the cause might be that it cannot use the specified MAC
address to communicate over the data network to the management
node. Make sure that your switch is configured to allow data traffic over
that port. For example, this may require VLAN configuration for the
ports.

Login credentials
You must specify the password that is authorized to deploy an operating
system. To change the login credentials from the Deploy Compute Node
Images page, click Global settings to open the Global settings window.
The Credentials section of the Global settings window enables you to do
the following:
v You can set the password for OS deployments. The user id is the default

that is listed in the Global settings window.
v Once the password is set, you can view the current password.

Important: The login password must be set before you can deploy an
operating system.

OS discovery and inventory
After deployment is complete, the operating system is discovered,
unlocked, and inventoried automatically by the management software.

Port availability for deployed operating systems:

Use this information to understand which ports are not blocked by deployed
operating systems.

RHEL Virtualization profile

By default, the RHEL Virtualization profile blocks all ports except for those that are
listed in the following table.

Table 67. Port availability for the RHEL Virtualization profile

Port
TCP or
UDP Direction Communication description

22 TCP Inbound SSH communication

53 TCP, UDP Outbound/Inbound Communication with RHEL KVM networking devices

67 TCP, UDP Outbound/Inbound Communication with RHEL KVM networking devices

161 UDP Outbound Communication with SNMP agents

162 UDP Inbound Communication with SNMP agents

427 TCP, UDP Outbound/Inbound Communication with SLP service agent, SLP directory agent

3001 TCP Outbound/Inbound Communication with management software image-deployment
service

15988 TCP Outbound CIM-XML over HTTP communication

15989 TCP Outbound CIM-XML over HTTP communication
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Table 67. Port availability for the RHEL Virtualization profile (continued)

Port
TCP or
UDP Direction Communication description

49152 -
49215

TCP Outbound/Inbound KVM Virtual Server communication

RHEL Basic and Minimal profiles

By default, the RHEL Basic and Minimal profiles block all ports except for those
that are listed in the following table.

Table 68. Port availability for the RHEL Basic and Minimal profiles

Port
TCP or
UDP Direction Communication description

22 TCP Inbound SSH communication

3001 TCP Outbound and Inbound Management software image-deployment service
communication

VMware ESXi 5.1 Virtualization profile

For a complete list of open ports for VMware vSphere Hypervisor (ESXi) 5.1 with
IBM customization, see the VMware documentation for ESXi 5.1.

Assigning and discovering IPv4 addresses for VMware ESXi after deployment:

If you deploy VMware ESXi, and you selected the option Let IBM Flex System
Manager automatically assign the addresses in the Global Settings window on the
Deploy Compute Node Images page, you must assign an IPv4 address to the
operating system manually and discover the operating system manually.

When you choose to have the management software assign IP addresses during
ESXi operating system deployment, the operating systems are assigned IPv6
Unique Local Addresses (ULAs). However, VMware ESXi 5.1 does not support SLP
over IPv6, and the management software is unable to discover and manage the
operating system.

Note: If you choose the Use Dynamic Host Configuration Protocol (DHCP) to
create the addresses option in the Global Settings window, the IPv4 address that is
assigned to the operating system is fully supported for ESXi, and the operating
system is discovered and inventoried automatically.

To establish management of an ESXi operating system that was deployed with the
Let IBM Flex System Manager automatically assign the addresses option in the
Global Settings window, complete the following steps in the management software
web interface for every compute node to which the operating system was
deployed.

Note: The following steps describe discovering, unlocking, and collecting
inventory for the operating system. These steps must be completed before you can
use the management software to update the compute node firmware.
1. From the table on the Deploy Compute Node Images page, right-click the

compute node and click Remote Control.
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Note: You do not have to repeat the preceding step for every compute node.
After the Remote Control is started for one compute node, you can open new
sessions in the same Remote Control application page for additional compute
nodes that have ESXi installed.

2. From the Remote Control session, launch the Direct Console ESXi User
Interface.

Note: The direct console interface opens after the ESXi auto-configuration
completes; it might already be open after you log in to the operating system.

3. Select Configure Management Network and press Enter.
4. Select IP Configuration and press Enter.
5. In the IP Configuration window, enter the settings for the IPv4 address; then,

press Enter.
6. Press Escape to apply the IP address change and restart ESXi.
7. From the Home page in the management software web interface, click the

Plug-ins tab.
8. From the Plug-ins tab, under Discovery Manager, click System Discovery.
9. From the System Discovery page, complete the fields for the IPv4 address that

you assigned to the ESXi operating system.
10. Click Discover Now.
11. From the Chassis Manager page, click All Compute Nodes.
12. Find the compute node in the table; then, in the Access column, click No

Access to unlock the compute node.
13. After the operating system is discovered and unlocked, go back to the

Plug-ins tab and click View and Collect Inventory.
14. From the View and Collect Inventory page, select the operating system; then,

click Collect Inventory.

Using FSM Remote Control to deploy operating systems
You can use IBM Flex System Manager Remote Control to install operating systems
on X-Architecture compute nodes, whether you access the management software
remotely or locally.

Remotely installing an operating system on an X-Architecture
compute node
There are several ways to install an operating system on an X-Architecture
compute node. Use this procedure to install an operating system on an
X-Architecture compute node while you are accessing the management software
from a remote client, such as a laptop.
1. From your laptop, open a web browser and access the IBM Flex System

Manager management software.
2. From the Chassis Manager, select the compute node and start a Remote Control

session.
3. In the Remote Control session, click the Mount remote media button in the

toolbar.
4. Select the image from the media containing your operating system image. For

example, click Select a file and select the ISO image. Then click Add.
5. Click Mount all to mount the image to the compute node.
6. Restart the compute node by clicking Restart from the Power drop down

menu.
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When the compute node restarts it will boot from the image and install the
operating system on the compute node.
If the compute node does not boot to the image, ensure that the boot options
on the node are set to use the mounted device. You can change the boot
options on the node using the Setup Utility on the compute node.

Note: The compute node might be restarted automatically during the
installation.

7. When the installation is complete, unmount the image from the compute node
by clicking Unmount all.

8. Close the Remote Media dialog to unmount the image media from the IBM
Flex System Manager file system.

Installing an operating system on an X-Architecture compute
node
There are several ways to install an operating system on an X-Architecture
compute node. Use this procedure to install an operating system on an
X-Architecture compute node while you are accessing the management software
locally. The management software does not need to be connected to the data
network.

Note: Before you begin, load an ISO image of the operating system on an external
or portable storage device, such as a USB device.
1. Insert the USB device in the USB connector on the front of the Flex System

Manager Types 7955, 8731, and 8734 management node.
2. From the Chassis Manager in the management software console, select

Compute node and start a Remote Control session.
3. From the Remote Control session, click Mount remote media. If the USB device

is inserted in the USB connector, it will be mounted to the management
software file system.

4. Click Select a file and then click Add.
5. Navigate to the /media/vdXN directory (where X is any letter from A - Z, and N

is any number from 1 - 9) and select the ISO image of an operating system.
6. Click Mount all to mount the ISO image to the compute node.
7. Restart the compute node by clicking Restart from the Power menu. When the

compute node restarts, it boots from the ISO image and installs the operating
system on the compute node. If the compute node does not boot to the ISO
image, make sure that the boot options on the compute node are set to include
the mounted USB device. You can change the boot options for the compute
node through the Setup Utility (Alt+Ctrl+F1) on the compute node.

Note: During the installation of the operating system, the compute node might
restart automatically. Make sure that you unmount the ISO image by clicking
Unmount all.

8. Close the Remote Media session to unmount the USB device from the
management software file system.

Viewing and installing compute node updates
You can find and install all available compute node updates from the IBM Flex
System Manager management software web interface.
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About this task

The management software provides features and tools that help you manage
firmware and software updates.

Update Manager enables you to keep your systems at selected software or
firmware update levels by automatically checking for available updates and
identifying which systems need attention. It also provides you with the ability to
monitor your systems for needed updates and schedule the installation of updates
at times that are convenient for your network and users. See the Updating systems
chapter in this document for more information about updating compute nodes
with management software and Update Manager.

The Automated Updates wizard in the web interface enables you to configure the
management software to notify you of available updates. It does not set up an
automatic installation of updates. See “Automate checking for updates” on page
145 for more information about configuring the management software for update
management.

Viewing firmware levels of managed resources
The IBM Flex System Manager management software web interface enables you to
view data, including version levels, about firmware that is installed on managed
resources. After you select the installed firmware view, you can use the Inventory
page to identify firmware for a specific resource, and export firmware data for
recordkeeping in an external application.

About this task

Use the Resource Explorer and Inventory pages in the management software web
interface to view the firmware levels of components that are installed in a
managed chassis:

Procedure
1. From the Chassis Manager page, click General Actions > Resource Explorer.

The Resource Explorer page opens.
2. In the Resource Explorer table, click FSM Groups.
3. Right-click FSM Element List Group; then, click Inventory > View and collect

inventory. The View and Collect Inventory page opens.

Note: The FSM Element List Group includes the chassis, every component
installed in the chassis, and other external network devices (like a top-of-rack
switch) that the management software is managing.

4. After inventory is collected, under Collected Items, expand Systems Software
and click Installed Firmware. The firmware levels for the managed resources
are displayed.

5. (Optional) Click Export All to export the displayed data in CSV, HTML, or
XML file formats.

Tip: You can import the exported data in an external application, such as a
spreadsheet, for recordkeeping and future reference.
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What to do next

Use the Installed Firmware table to sort and filter the resources that are displayed.
The following actions in the table can help you find the firmware information for a
particular resource:
v Sort by Name to list the resource names in alphabetical order.
v Sort by System name to group the displayed resources by system data.
v Use the search field to find specific firmware quickly. For example, if you type

imm and click Search, the table displays only the IMM firmware information.

Viewing compute node events and problems
There are several ways to view compute node events and problems in the IBM
Flex System Manager management software web interface.

About this task

An event is a user or system activity that is logged with a message. Two types of
events are displayed in the management software: events for the Flex System
Manager Types 7955, 8731, and 8734 hardware and events for the compute nodes
and other resources managed by the management software.

A problem is an actionable event that can either be resolved or be submitted for
resolution through the management software Electronic Service Agent (ESA) and
Service and Support Manager.

For more information about how to address problems with Service and Support
Manager, see Chapter 23, “Solving problems,” on page 675. For more information
about configuring ESA, see “Setting up Electronic Service Agent (ESA)” on page
140.

You can use the Chassis Manager in the management software to view events and
problems for a chassis or for a resource within a chassis. Use the Chassis Manager
page, the Events page, or the Problems page to see a high-level view of all events
or problems. Use the Chassis Map view in Chassis Manager to view events and
problems for a resource that is under management.

Note: If you are using NIST-800-131A-Strict cryptography mode, the management
software will not be able to receive event notifications from nodes running
VMware ESXi, as VMware ESXi does not support the required secure notification
via HTTPS.

Viewing PCIe expansion node details
If a Flex System PCIe Expansion Node is connected to an X-Architecture compute
node that is managed by the management software, you can view details for the
PCIe expansion node in the management software web interface.

You can use one of the following methods to view the details for the PCIe
expansion node in the management software web interface:
v Discover and request access to a Chassis Management Module (CMM) in the

chassis where the X-Architecture compute node and connected PCIe expansion
node are installed. The X-Architecture compute node is discovered automatically.
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When the inventory for the X-Architecture compute node is collected, you can
view the PCIe expansion node details on the Inventory page of the management
software web interface.

v Discover and request access directly to the X-Architecture compute node that is
connected to the PCIe expansion node. When the inventory for the
X-Architecture compute is collected, you can view the PCIe expansion node
details on the Inventory page of the management software web interface.

Note: If a PCIe expansion node is connected to an X-Architecture compute node
that is running a Linux, Windows, or VMware ESXi operating system, and you
cannot view the PCIe expansion node details on the Inventory page of the
management software, make sure that you have discovered and collected inventory
on the compute node before you discover the compute node operating system.

For troubleshooting information about the PCIe expansion node and the
management software, see the IBM Flex System Manager Management Software
Troubleshooting Guide.

Viewing storage expansion node details
If an Flex System Storage Expansion Node is connected to an X-Architecture
compute node that is managed by the management software, you can view details
for the Storage expansion node in the management software web interface.

You can use one of the following methods to view the details for the Storage
expansion node in the management software web interface:
v Discover and request access to a Chassis Management Module (CMM) in the

chassis where the X-Architecture compute node and connected Storage
expansion node are installed. The X-Architecture compute node is discovered
automatically. When the inventory for the X-Architecture compute node is
collected, you can view the Storage expansion node details on the Inventory
page of the management software web interface.

v Discover and request access directly to the X-Architecture compute node that is
connected to the Storage expansion node. When the inventory for the
X-Architecture compute is collected, you can view the Storage expansion node
details on the Inventory page of the management software web interface.

Note: If a Storage expansion node is connected to an X-Architecture compute node
that is running a Linux, Windows, or VMware ESXi operating system, and you
cannot view the PCIe expansion node details on the Inventory page of the
management software, make sure that you have discovered and collected inventory
on the compute node before you discover the compute node operating system.

For troubleshooting information about the Storage expansion node and the
management software, see the IBM Flex System Manager Management Software
Troubleshooting Guide document.

For more information about the Storage expansion node and supported operating
systems, see the Flex System Storage Expansion Node Installation and Service Guide.

Using FSM Remote Control with X-Architecture compute nodes
With the Remote Control application in IBM Flex System Manager management
software, you can manage X-Architecture compute nodes as if you were at a local
console.
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IBM Flex System Manager Remote Control is a Java Web Start application that
requires the IBM or Oracle/Sun Java Runtime Environment (JRE) plug-in, version
6.0, update 18 or later. You must obtain and install the JRE plug-in before you can
use the Remote Control application.

Note:

v Remote Control in the management software is available only for X-Architecture
compute nodes. You cannot access IBM Power Systems compute nodes with
Remote Control. Instead, you can open a terminal console to any virtual server
on a Power Systems compute node.
First, make sure that Serial over LAN (SOL) is disabled for the Power Systems
compute node. You can disable SOL from the Chassis Management Module
(CMM) using the sol command. For more information about the SOL command,
see the IBM Flex System Chassis Management Module Command-Line Interface
Reference Guide document.
Then, to open a terminal console, complete the following steps:
1. Under General Actions on the Chassis Manager page, click Manage Power

Systems Resources to display the Manage Power Systems Resources page.
2. Under Hosts (on the left), select the Power Systems compute node. The

virtual servers for that host are displayed to the right of the host.
3. Right-click the virtual server; then, click Operations > Console Window >

Open Terminal Window.
v An internet connection is required for you to download the JRE if the Java

Plug-in is not already installed. Get Java Web Start and the latest Java Runtime
from the Java download web site.

When you start the Remote Control application from management software, you
are prompted to save a shortcut to the application on your system. You can then
use this shortcut to open the Remote Control session to the specified compute
node without having to launch it from the management software user interface.
However, your computer must have access to management software because the
application validates the user ID with the management software user registry.

The shortcut contains a link that opens an empty Remote Control interface that
you can use to manually add compute nodes.

If you have configured the compute node for serial access, you can also launch a
remote serial console to a compute node. To launch a remote serial console, select
the compute node from the Chassis Manager and search for Serial in the task
finder (located in the Common Actions area).

Important: You must make sure that the Serial Port Sharing for the X-Architecture
compute node is enabled. You can enable it from the compute node Setup Utility
(Alt+Ctrl+F1). Select System Settings > Devices and I/O ports > Console
Redirection Settings to enable the port. You must also make sure that console
redirection is enabled for the operating system. If redirection is not set up properly,
the terminal session displays a black screen.

Note: Like Remote Control, the Serial Console functionality in the management
software is available only for X-Architecture compute nodes. You cannot access
IBM Power Systems compute nodes with Serial Console.
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Accessing compute nodes with Remote Control
Be aware of security and performance considerations related to accessing compute
nodes with the Remote Control application.

You can start multiple Remote Control sessions, and each session can be used to
manage multiple compute nodes.

When you start a session with a compute node, you can choose one of the
following connection modes to be used for that session:
v Single-user mode. Use this connection type to establish an exclusive session

with the compute node. All other Remote Control sessions to that compute node
will be blocked until you disconnect from the compute node. This option is
available only if there are no other Remote Control sessions established to the
compute node.

v Multi-user mode. Use this connection type to enable multiple Remote Control
sessions to be established with the compute node. Each compute node supports
up to six concurrent Remote Control sessions.

The size of the Remote Control window and the number of active sessions might
affect workstation resources, such as memory and network bandwidth, which can
influence performance.

The Remote Control application is supported on systems running the following
operating systems (either 32-bit or 64-bit):
v Microsoft Windows XP
v Microsoft Windows Vista
v Microsoft Windows 7
v SUSE Linux Enterprise (SLES)
v Red Hat Enterprise Linux (RHEL)

Note: On Linux operating systems, uploading images to the IMM local storage
and mounting an ISO image is supported. However, mounting devices such as
disk drives, CDs, DVDs, and USB devices, or mounting multiple ISO images from
a Linux client is not supported.

Security considerations

The user ID used to start the Remote Control application must be a valid user ID
that has been defined in the management software user registry. The user ID must
also have sufficient user authority to access and manage a compute node. You can
assign the role of SMAdministrator to the user ID, or you can define a custom role
for compute node access and management and assign that role to the user ID. If
you define a custom role, it must include the following permissions, at a
minimum:
v Authority to connect to a compute node remotely: Remote Access > Remote

Control

This action establishes full-screen access to a remote system.
v Authority to power on a compute node: Power On/Off > Power On

This action powers on a managed resource.
v Authority to power off a compute node: Power On/Off > Power Off Now

This action powers off a managed resource immediately, typically enabled by
out-of-band communication.
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v Authority to restart a compute node: Power On/Off > Restart Now

This action resets a managed resource immediately, typically enabled by
out-of-band communication.

v Authority to display resource groups: General > Resource Explorer

This action displays resources and groups in your systems-management
environment.

Additional permissions might be required, depending on the type of management
activities that you are going to perform on the compute node.

By default, multiple Remote Control sessions can be established to a compute
node. However, when you start a Remote Control session, you have the option to
start the session in single-user mode, which establishes an exclusive session with
the compute node. All other Remote Control sessions to that compute node will be
blocked until you disconnect from the compute node.

Note: This option is available only if there are currently no other Remote Control
sessions established to the compute node.

Performance considerations

If remote sessions become slow or unresponsive, close all video and remote media
sessions that you have established with the selected compute node to reduce the
number of open compute node connections. In addition, by changing the following
settings in Preferences, you might increase performance:
v On the KVM page:

– Decrease the percentage of video bandwidth that is used by the application.
The image quality of the Remote Control session will be reduced.

– Decrease the percentage of frames that are refreshed by the application. The
refresh rate of the remote session will be reduced.

v On the Thumbnails page:
– Increase the thumbnail refresh interval rate. The application will refresh

thumbnails at a slower rate.
– Turn off the display of thumbnails completely.

The size of the Remote Control window and the number of active sessions might
affect workstation resources, such as memory and network bandwidth, which can
influence performance.

Keyboard considerations

The Remote Control application supports the following keyboard types:
v US 104-key
v Japanese 109-key
v UK 105-key
v Spanish 105-key
v Italian 105-key
v German 105-key
v French 105-key
v Swiss 105-key
v Belgian 105-key
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v Chinese
v Brazilian
v Korean

Using the Remote Control page
The Remote Control page is displayed when you log in to a compute node.

The Remote Control page is divided into the thumbnail, toolbar, and video session
areas. From the Remote Control page, you can display or hide the toolbar and the
thumbnail area. You can also resize the thumbnail area.

Thumbnail area
The thumbnail area of the Remote Control panel displays thumbnails of all
compute node sessions that are currently managed through the Remote Control.

You can display multiple compute node sessions and move between compute node
sessions by clicking a thumbnail, which displays the compute node console in the
video session area. If you are accessing more compute nodes than will fit in the

thumbnail area, click the right arrow ( ) to scroll to additional compute node

thumbnails. Click the down arrow ( ) to see a list of all open compute node
sessions.

From the thumbnail area, click 

 

to add a new compute node to the list of
nodes that you are managing. See the New Session section in “Toolbar” for more
information about adding a session. You can control whether the thumbnail area is
displayed and how often the thumbnails are refreshed from the Thumbnail page
(see the Preferences section in “Toolbar” for more information).

Toolbar
The functions described in the following sections are available in the Remote
Control toolbar.

New session

Click 

 

to add a compute node to the list of nodes that you are managing.

When you click , a window with a list of available chassis and nodes opens.
The list of available chassis and compute nodes is based on all chassis and
compute nodes that have been discovered and are under management by the
management software and that your user ID has permission to manage.

In addition, you can choose to connect in single-user mode. Select single-user
mode to establish an exclusive session with the selected compute nodes. All other
Remote Control sessions to the selected compute nodes will be blocked until you
disconnect from the selected compute nodes. This option is available only if there
are no other Remote Control sessions established to the selected compute nodes.

Select the chassis in which the compute node is installed and the compute nodes
that are to be managed, and click Connect.
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Tip: If no compute nodes are shown in the list of compute nodes to select, see
“Solving Remote Control problems” on page 567 for procedures to potentially
resolve the issue.

Toggle thumbnail

Click 

 

to toggle between displaying and hiding the thumbnail area.

Video

Click 

 

to perform one of the following tasks:

Toggle on full screen
The application window is displayed at a maximum size on your system.

Screenshot
You can click Screenshot to take a screen capture of the currently selected
compute node session and save that screen capture in a variety of formats.

Power

The power icon is green if the selected compute node session is currently powered

on. Click 

 

to perform the following power-management functions for the
compute node:
v Power on the compute node
v Hard power off the compute node, which is the equivalent of pressing and

holding the power button on the nodes
v Shut down the operating system and power off the compute node
v Restart the compute node

Note: The specific functions that are displayed in the list depend on the
permissions defined for the user ID that was used to start the Remote Control
application.

Softkey programmer

You can define your own custom key sequences, which are called softkeys. Click
Add softkey > New to add a softkey.

Softkey definitions are stored on the system from which you started the Remote
Control session. Therefore, if you run the Remote Control application from another
system, you will have to define the softkeys again.

You can also choose to export user settings, which includes softkeys from the User
Settings page (see the Preferences section in this topic for more information).

Click 

 

to display a list of softkeys that are currently defined.

Sticky keys

Some operating systems intercept certain keys instead of passing them to the
remote system. Use the sticky key buttons to send keystrokes directly to the
compute node that you are managing. To send a Ctrl or Alt key combinations, click
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the Ctrl or Alt button, place the cursor in the video session area, and press a key
on the keyboard. For example, to send a Ctrl+Alt+Del key combination, complete
the following steps:
1. Click the Ctrl key button.
2. Click the Alt key button.
3. Left-click anywhere inside the video session area.
4. Press the Delete key on the keyboard.

Note: If mouse-capture mode is enabled, press the left Alt key to move the cursor
outside of the video session area. Although mouse-capture mode is disabled by
default, you can enable it from the Toolbar page (see the Preferences section for
more information).

When you click the Ctrl, Alt, or Shift button to make it active, it will remain active
until you press a keyboard key or click the button again.

Keyboard keys

Click 

 

to use the keyboard keys.

Remote media

Use the remote media feature to mount a CD, DVD, or USB device that is on the
client system to the selected compute node. You can also specify to mount a disk
image or CD image (ISO). In addition, you can choose to upload an image to the
local storage that is available on the IMM.

Click 

 

to perform the following actions for remote media:

Mount remote media
This action makes local media resources available to the currently selected
compute node. A media resource can be mounted to only one compute
node at a time within a single Remote Control session.

Move remote media
This action moves a previously mounted media resource between compute
nodes.

Limitations:

v Only one user at a time can mount and upload data to the local storage on the
IMM. Other users are prevented from accessing the local storage on the IMM
while it is being mounted or data is being uploaded to the local storage.

v From a Linux client, mounting a CD, DVD, or USB device is not supported. An
ISO image can be mounted, but mounting multiple ISO images is not supported.

v On a compute node running the Linux operating system, mounting more than
one ISO image is not supported.

v From the local KVM on the IBM Flex System Manager, mounting a CD, DVD, or
USB device is no supported. An ISO image can be mounted, but mounting
multiple ISO images is not supported.

When you click Mount remote media, the following options are available:
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v Select an image to be mounted. The image will be available for the currently
selected compute node until you unmount the device or close the Remote
Control session.
Multiple images can be mounted to a single compute node, but each image can
be mounted to only one compute node at a time.

v Select a drive, such as a CD, DVD, or USB device, that is to be mounted. The
device will be available to the currently selected compute node until you
unmount the drive or close the Remote Control session. Multiple devices can be
mounted to a single compute node, but each device can be mounted to only one
compute node at a time.

Note: If you select a drive, be sure to unmount the drive before you remove
media from the drive.

v Upload the image to the IMM. Use this option to store an image in local storage
on the IMM for the selected compute node. The image will remain on the IMM
even if you end the Remote Control session, or if the compute node is restarted.
You can store approximately 50 MB of data on the IMM.
You can upload multiple images to the IMM provided that the total space that is
used for all images is less than 50 MB. Each image that is uploaded to the IMM
is automatically mounted to the compute node. After you have uploaded an
image to the IMM, you can also move that uploaded image to the IMM for a
different compute node. When you move the image, the previously uploaded
image is removed from the compute node and uploaded to a selected compute
node.

To make a resource available to a compute node, select one or more resources and
click the Add button to move the resources to the Selected Resources list. Then,
click Mount to mount the resources for use by the compute node. When you click
Mount, the Remote Control application defines a device for the resource and maps
that device to a mount point for the currently selected compute node. You have the
option to write-protect the mounted media.

Preferences

Click 

 

to modify the preferences for your Remote Control session. You can
modify the following settings.

Note: Any changes that you make in Remote Control Preferences take effect
immediately.
v On the KVM page, the following settings are available:

– Percentage of Video Bandwidth. Increasing the bandwidth improves the
quality in the appearance of the Remote Control session, but can potentially
affect the performance of the Remote Control session.

– Percentage of Frames Refreshed. Increasing the frame-refresh percentage
increases how often the Remote Control session is updated but can potentially
affect the performance of the Remote Control session.

– Keyboard type. Select the type of keyboard that you are using for the Remote
Control session.

Note: If you select an international keyboard and you need to enter key
combinations that require the Alternate Graphics key (AltGr), make sure that
the operating system on the workstation that you use to invoke the Remote
Control application is the same type of operating system as the one on the
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compute node that you will remotely access. For example, if the compute
node is running Linux, make sure that you invoke the Remote Control
application from a workstation that is running Linux.

– Scale image to window. Select this option to scale the video image received
from the compute node to the size of the video session area.

– Enable FSM tunneling. Select this option to access a compute node through
the management node. You can use this option to access a compute node
from a client that is not on the same network as the compute node.

Note: The Remote Control application will always attempt to connect directly
to the compute node from the client workstation. If you select this option, the
Remote Control application will access the compute node through the FSM if
the client workstation cannot access the compute node directly.

v On the Security tab, the following settings are available:
– Prefer single-user mode connections. Specify whether single-user mode

connections should be the default choice when connecting to a compute node.
When a connection is made in single-user mode, only one user can be
connected to a compute node at a time. If this box is not selected, the default
function is to connect to the compute node in multi-user mode.

– Require (secure) tunneling connections. Select this option to access a
compute node through the management node. You can use this option to
access a compute node from a client that is not on the same network as the
compute node.

Note: The Remote Control application will always attempt to connect directly
to the compute node from the client workstation. If you select this option, the
Remote Control application will access the compute node through the
management node if the client workstation cannot access the compute node
directly.

v On the Toolbar page, the following settings are available:

Note: Click Restore defaults to restore all settings on this page to the default
settings.
– Pin the toolbar to the window. By default, the toolbar is hidden above the

FSM Remote Control session screen; it appears only when you move your
mouse pointer over it. If you select this option, the toolbar is pinned to the
window and is always displayed between the thumbnail panel and the
Remote Control session screen.

– Show keyboard buttons. Specify whether to show the keyboard button icons
(CapsLock, NumLock, and ScrollLock) on the toolbar.

– Show power control. Specify whether to show the power control options on
the toolbar.

– Show sticky key buttons. Specify whether to show the sticky key button
icons (Ctrl, Alt, and Delete) on the toolbar.

– Hide local mouse pointer. Specify whether or not to show the local mouse
pointer when you position the cursor in the compute node session that is
currently displayed in the video session area.

– Enable mouse-capture mode. By default, mouse-capture mode is disabled.
This means that you can freely move the cursor into and out of the video
session area. If you enable mouse-capture mode, you must press the left Alt
key before you can move the cursor out of the video session area.
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If mouse-capture mode is enabled, you can specify whether to use the
Ctrl+Alt keys to exit mouse-capture mode. The default is to use the left Alt
key.

– Specify toolbar background opacity. Lowering the opacity percentage
enables more of the video session area to show through the toolbar
background.

v On the Thumbnails page, the following settings are available:
– Show thumbnails. Select this option to show the thumbnail area in the

Remote Control session.
– Specify thumbnail refresh interval. Decreasing the interval for refreshing

thumbnails increases how often the compute node thumbnails are updated.
v On the Softkey Programmer page, any defined softkeys are listed. You can also

click New to create additional softkeys.

Note: If you use an international keyboard, and you set up softkeys that require
the Alternate Graphics key (AltGr), make sure that the operating system on the
workstation that you use to invoke the Remote Control application is the same
type of operating system as the one on the compute node that you will remotely
access. For example, if the compute node is running Linux, make sure that you
invoke the Remote Control application from a workstation that is running Linux.
Softkey definitions are stored on the system from which you started the Remote
Control session. Therefore, if you run the Remote Control application from
another system, you will have to define the softkeys again.
You can also choose to export user settings, which includes softkeys from the
User Settings page.

v From the User Settings page, you can choose to import or export user settings.
When you export user settings, all user settings for the current Remote Control
session are stored in a properties file on your system. You can copy this
properties file to another system and import those settings into the Remote
Control application to use the settings.

v On the General page, the following settings are available:
– Debug mode. Specify whether to set debug mode for the Remote Control

application. The settings determine the granularity of events that are logged
in the log files. By default, only severe events are logged. See “Logs and
traces” on page 567 for more information about log file locations.

– Inherit system appearance settings. This setting changes the appearance to
match color schemes that are configured for the client system (running
Windows). You must restart the Remote Console application for these settings
to take effect.

– Create desktop icon. This setting creates a desktop icon on your system so
that you can start the Remote Control application directly from your system.
You must still have access to the management software from your system.

– Synchronize with management software. This setting ensures that the
compute node data that is displayed in the Remote Control application
matches compute node data that is displayed from management software.

Video session area
The video session area displays the compute node that is selected from the
thumbnail area.
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Logs and traces
When you start the Remote Control application, log files are created, and you can
use these files to resolve issues. The types of events that are logged in these files
are based on the debug mode, which is set from Preferences on the General page.

On Linux clients, run the command cat /var/log/messages | grep IBM >
rmtConsole.log. This command creates the log file rmtConsole.log in the directory
where the command is run.

Note: Make sure that the logging level in the /etc/syslog.conf is set to debug.
For example:
user.debug /val/log/messages

Log files are stored in the following locations:

Operating system Log directory

Linux (SLES and RHEL) /%HOME%/IBM/itme/remoteaccess

For example: /root/IBM/itme/remoteaccess

Windows 7 %USERPROFILE%\IBM\itme\remoteaccess

For example: C:\Users\win_user\IBM\itme\
remoteaccess

Windows Vista %USERPROFILE%\IBM\itme\remoteaccess

For example: C:\Users\win_user\IBM\itme\
remoteaccess

Windows XP %USERPROFILE%\IBM\itme\remoteaccess

For example: C:\Documents and
Settings\win_user\IBM\itme\remoteaccess

Collecting server logs
You can collect server logs for the IBM Flex System Manager management node
from the IBM Flex System Manager web interface.

To collect logs, complete the following steps:
1. From the Home page, click the Plug-ins tab; then, click Service and Support

Manager to open the Service and Support Manager summary page.
2. From the Service and Support Manager summary page, click Manage support

files under Common Tasks. The Manage Support Files page opens.
3. Click Collect Support Files.... The Collect Support Files page opens.
4. On the System tab, select the operating system for the IBM Flex System

Manager management node and click Add.
5. Click the Support Files tab; then, select PEDBG.
6. Select the Basic option; then, click Collect.
7. After the logs are collected, they are shown on the Manage support files tab.

From there, you can download the logs and send them to IBM.

Solving Remote Control problems
Use the procedures in this section to solve problems that might occur when you
use the Remote Control application.
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Remote Control application will not start
You attempt to start the Remote Control application from the management
software web interface or from the shortcut on your system, but it will not start.

About this task

If the Remote Control application will not start, complete the following steps:

Procedure
1. Make sure that the compute node to which you are connecting is managed by

the IBM Flex System Manager management node. The state of the compute
node must be set to at least "Partial Access" and be accessing from the IBM Flex
System Manager management node. To determine the state of the compute
node, use the Chassis Manager.

2. Make sure that pop-ups are not disabled in your browser for the session.
3. Make sure that your browser has accepted security certificates from the

management software node. Typically, you will be prompted to access the
certificate the first time you access the management software from your
browser.

4. Make sure that you are using the supported JRE to start the application.
v In Internet Explorer, click Tools > Internet Options > Advanced. Make sure

that the correct JRE is selected (JRE version 6.0, update 18 or later).
v In Firefox, click Tools > Options > Applications. Make sure that Java Web

Start Launcher is associated with the JNLP content type.
5. If you are starting the application from the shortcut on your desktop, make

sure that your system has connectivity to management software. The
application validates your user ID with the management software user registry.

6. Clear the Java Web Start cache on the local system. To clear the Java Web Start
cache on a system running a Windows operating system, run the command
javaws -uninstall.

Remote Control application hangs after login
If you are not using one of the supported JREs, Remote Control might hang after
login.

About this task

If the Remote Control application appears to hang after you log in, make sure that
you are using one of the supported JREs to start the application:
v IBM JRE version 6.18 or later
v Sun JRE version 6.18 or later

Remote Control cannot connect to a compute node
About this task

If you cannot connect to a compute node with the Remote Control application,
complete the following steps:

Procedure
1. Make sure that your system has network connectivity, and that it can connect

to management software.
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2. From the management software user interface, use the Chassis Manager or the
Resource Explorer to verify that the compute node is under management
software management.

3. If a firewall is installed on your system, make sure that it allows connections to
the IP address for the compute node.

4. Ping the IP address of the compute node to ensure that you have connectivity
to the node. If you are attempting to access a compute node from a system that
has an IP address from an external network, the compute node must also have
an IP address that can be accessed externally.

5. Make sure that management software tunneling has not been disabled so that
the management software can tunnel your remote control requests to the
compute node that is network addressable only on the private management
network. Tunneling is enabled by default. You can enable management software
tunneling from Preferences on the KVM page.

You cannot connect to a compute node in single-user mode
About this task

When you connect to a compute node in single-user mode, only one Remote
Control session can be established to the compute node at a time. To solve this
problem, complete the following steps:

Procedure
1. Attempt to connect to the compute node in multi-user mode (if allowed, based

on security requirements).
2. Contact other users to determine if anyone else has already established a

Remote Control session with the compute node. If so, wait until the user ends
the Remote Control session with the compute node.

3. Attempt to connect to the compute node in single-user mode again.

Remote Control can connect to a compute node, but no video is
available
About this task

If you are connected to a compute node with the Remote Control application, but
it shows No video available, make sure that the compute node is powered on and
that the operating system is running a supported resolution and refresh rate.

The following resolutions and refresh rates are supported:

Table 69. Supported resolutions and refresh rates

Resolution Refresh rates

640 x 480 60, 72, 75, and 85 Hz

800 x 600 60, 72, 75, and 85 Hz

1024 x 768 60, 72, 75, and 85 Hz

1440 x 900 60 Hz

1280 x 1024 60 and 75 Hz

1680 x 1050 60 Hz

1600 x 1200 60 and 75 Hz
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A compute node does not appear in Remote Control
About this task

If a compute node does not appear in the list for adding a new session, or a
compute node no longer appears in the thumbnail area, complete the following
steps:

Procedure
1. From the management software web interface, use the Chassis Manager or the

Resource Explorer to verify that the compute node is under management
software management.

2. Make sure that the user ID that is being used to manage the compute node has
sufficient authority to access the compute node. From the management software
web interface, click Security > Users to view and modify permissions for a
user.

Note: The user ID that is used to access the management software must have
sufficient authority to modify user permissions.

3. From the management software web interface, use the Chassis Manager to
select the compute node and verify that the compute node is communicating
with management software, and that the compute node is accessible from
management software.

State of compute node in Remote Control does not match state
in management software
About this task

If you can access the compute node, but the data for the compute node (such as
the compute node name or available power options) does not match the data that
is displayed from the management software, complete the following steps:

Procedure
1. Unmount any media that you have mounted in the Remote Control session.

Then, restart the Remote Control application.
2. From the management software web interface, use the Chassis Manager or the

Resource Explorer to verify that the compute node is under management
software management.

A drive or image cannot be mounted to a compute node
About this task

If you attempt to mount a drive or image by using remote media, but the drive or
image cannot be mounted, complete the following steps:

Procedure
1. Stop and restart the Remote Control application.
2. Set the debug mode to Full for the Remote Control application. You can set the

debug mode from Preferences on the General page. When you set debug mode
to Full, the Remote Control application will generate log files. See “Logs and
traces” on page 567 for the location of the log files. See “Logs and traces” on
page 567 for the location of the log files.

3. Contact IBM Support and provide the log files.
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Storage media option is not shown in the list of remote media
devices available for mounting
About this task

If a CD, DVD, or USB device does not appear in the list of available remote media
devices to be mounted to a compute node, contact IBM support.
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Chapter 15. Managing X-Architecture compute nodes

IBM Flex System Manager provides specific tasks that can help you manage
X-Architecture compute nodes.

Before you begin

Note: The Chassis Manager view in the IBM Flex System Manager is the primary
interface for selecting managed resources and performing management tasks on
those resources. However, some of the procedures in this section include steps that
instruct you to use the navigation area, which is hidden by default in the web
interface.

The navigation area provides links to tasks and task categories such as Resource
Explorer, Inventory, and Health Summary. To open the navigation area, click the
arrow icon on the left side of the screen.

Service processor communication
Hardware-based service processors, also known as management processors, work
with hardware instrumentation and systems management software and are
important for problem notification and resolution. You also can use them to
remotely manage your system. In an IBM Flex System Manager environment,
service processors send alerts to IBM Flex System Manager when error conditions
occur in a specific system; these alerts help you to managed your environment
effectively.

There are two pathways along which communication between IBM Flex System
Manager and the service processors present in scalable System x and xSeries
servers takes place: in-band communication and out-of-band communication.

In-band communication requirements
IBM Flex System Manager can communicate in-band with service processors in
systems that are running the required IBM Flex System Manager agent.

To enable in-band communication between IBM Flex System Manager and a
system that contains a service processor, the system must meet the following
criteria:
v One of the following agents must be installed:

– For Integrated Systems Management Processor
- Agent, version 5.20.3

– For all other Service Processors:
- Common Agent version 6.x or Level 2: Agent, version 5.20.3
- Platform Agent 6.1.x (or later).

Note: Common Agent 6.1.1 supports systems running Platform Agent 6.1.x.

For more information, see “Installing.”
v The service-processor device driver must be installed, and possibly a shared

library to access the device driver. For more information, see “Preparing to
manage service processors with IBM Flex System Manager.” These agents use a
device driver to pass data to and from the service processor.
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After these criteria are met, IBM Flex System Manager can discover the system and
you can request access to the system.

IBM Flex System Manager supports in-band communication for these service
processors:
v IPMI baseboard management controller (BMC)
v Integrated Management Module II (IMM2)

Note: You can use only out-of-band communication with chassis management
modules.
Related concepts:
Out-of-band communication requirements
Data is transmitted between the service processor and IBM Flex System Manager
over a shared connection. The type of service processor present in a server
determines which paths out-of-band communication can take. These types of
communication are known as out-of-band communication because they take place
independent of an operating system.
Service processors and resource types
Any IBM Flex System Manager chassis or X-architecture compute node that has a
supported service processor or management module can forward events to IBM
Flex System Manager. When IBM Flex System Manager generates event types in
response to an event, the target system of the specific event type can vary.
Related tasks:
Out-of-band alert-forwarding strategies
X-Architecture service processors provide out-of-band support for alert-forwarding
strategies. The type of service processor determines the type of alert-forwarding
strategy that is available.

Out-of-band communication requirements
Data is transmitted between the service processor and IBM Flex System Manager
over a shared connection. The type of service processor present in a server
determines which paths out-of-band communication can take. These types of
communication are known as out-of-band communication because they take place
independent of an operating system.

Data is transmitted between the service processor and IBM Flex System Manager
over a shared connection. The following shared connections can be used:
v A local area network (LAN), if the service processor has an integrated network

interface card (NIC) or access to a NIC shared with the server.
v An interconnect gateway. With this type of connection, data is passed from the

service processor to a second service processor. The second service processor
serves as a gateway between IBM Flex System Manager and the first service
processor.
Chassis Management Modules (CMMs) communicate with the Integrated
Management Modules (IMMs) on compute nodes.

The following table lists the pathways that are available for out-of-band
communication:

Table 70. Out-of-band communication pathways

Type of service processor
Pathways for out-of-band
communication

Possible gateway service processors if an
interconnect network is chosen

Chassis management module LAN Not applicable
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Table 70. Out-of-band communication pathways (continued)

Type of service processor
Pathways for out-of-band
communication

Possible gateway service processors if an
interconnect network is chosen

Integrated management module II LAN Integrated management module II

See the documentation that came with the compute node for information about
configuring your service processor and interconnect network to ensure that IBM
Flex System Manager receives system alerts.
Related concepts:
In-band communication requirements
IBM Flex System Manager can communicate in-band with service processors in
systems that are running the required IBM Flex System Manager agent.
Service processors and resource types
Any IBM Flex System Manager chassis or X-architecture compute node that has a
supported service processor or management module can forward events to IBM
Flex System Manager. When IBM Flex System Manager generates event types in
response to an event, the target system of the specific event type can vary.
Related reference:
Out-of-band alert-forwarding strategies
X-Architecture service processors provide out-of-band support for alert-forwarding
strategies. The type of service processor determines the type of alert-forwarding
strategy that is available.
 

Out-of-band events are not configured correctly

Out-of-band communication and the standard CIM protocol
IBM Flex System Manager can use the DMTF standard CIM-XML protocol to
communicate with integrated management modules.

Other IBM programs, such as these, also use the standard CIM-XML protocol to
communicate with integrated management modules:
v UpdateXpress
v Cluster Systems Management

By default, service processors are enabled to use the standard CIM protocol. When
connecting to the service processors through CIM, the ID used to connect to the
service processors is the same ID that was used to discover and unlock the system.
To change the ID used to connect to the system, follow these steps:
1. Revoke access to the system.
2. Use the other user ID to request access to the system.

When IBM Flex System Manager cannot communicate with the service processor,
you might have problems with that system, for example, access requests might fail.

Out-of-band alert-forwarding strategies
X-Architecture service processors provide out-of-band support for alert-forwarding
strategies. The type of service processor determines the type of alert-forwarding
strategy that is available.

The following table contains information about possible alert-forwarding strategies.
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Table 71. Out-of-band alert-forwarding strategies

Type of service processor Possible alert-forwarding strategies

Intelligent Peripheral Management Interface
(IPMI) baseboard management controller
(BMC)

IPMI Platform Event Traps

Integrated system management processor
(ISMP)

Not applicable

Chassis management module v IBM Flex System Manager comprehensive
v IBM Flex System Manager over modem

Integrated management module II CIM Indications

Related concepts:
In-band communication requirements
IBM Flex System Manager can communicate in-band with service processors in
systems that are running the required IBM Flex System Manager agent.
Out-of-band communication requirements
Data is transmitted between the service processor and IBM Flex System Manager
over a shared connection. The type of service processor present in a server
determines which paths out-of-band communication can take. These types of
communication are known as out-of-band communication because they take place
independent of an operating system.
Service processors and resource types
Any IBM Flex System Manager chassis or X-architecture compute node that has a
supported service processor or management module can forward events to IBM
Flex System Manager. When IBM Flex System Manager generates event types in
response to an event, the target system of the specific event type can vary.

Out-of-band event monitoring in a redundant environment
A redundant environment helps you minimize enterprise downtime. If you are
using a redundant environment with IBM Flex System Manager, you can have two
Flex System Manager servers monitoring Out-of-Band IMM events.

Service processors and resource types
Any IBM Flex System Manager chassis or X-architecture compute node that has a
supported service processor or management module can forward events to IBM
Flex System Manager. When IBM Flex System Manager generates event types in
response to an event, the target system of the specific event type can vary.

Note: If IBM Flex System Manager cannot determine the system type for any
service processor notification, IBM Flex System Manager identifies the source of the
notification using the IP address of the service processor that sent the notification
to IBM Flex System Manager. For example, this method might be used if a system
is configured to send notifications to IBM Flex System Manager, but IBM Flex
System Manager currently does not have a system type representing that system.

The following table lists the service processor type and its associated target
resource type.

Service processor type Target resource type

v Chassis management module BladeCenter chassis
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Service processor type Target resource type

Systems with one of the following service
processors:
v Intelligent Peripheral Management

Interface (IPMI) baseboard management
controller (BMC)

v Integrated management module II

Compute node

Note: Discovery of Remote Supervisor Adapter (RSA) devices is no longer
supported. Therefore, you cannot use IBM Flex System Manager to manage new
installations of RSA devices.
Related concepts:
In-band communication requirements
IBM Flex System Manager can communicate in-band with service processors in
systems that are running the required IBM Flex System Manager agent.
Out-of-band communication requirements
Data is transmitted between the service processor and IBM Flex System Manager
over a shared connection. The type of service processor present in a server
determines which paths out-of-band communication can take. These types of
communication are known as out-of-band communication because they take place
independent of an operating system.
Related reference:
Out-of-band alert-forwarding strategies
X-Architecture service processors provide out-of-band support for alert-forwarding
strategies. The type of service processor determines the type of alert-forwarding
strategy that is available.

Viewing the management summary
You can view a summary of all management and configuration activity that is
associated with X-Architecture compute nodes, including the number of systems
that are already discovered, have problems, and require updates. It also provides
information about required I/O module plug-ins. Information on the summary
page is refreshed automatically when there are any changes.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To view the summary, complete the following steps:

Procedure
1. In the IBM Flex System Manager navigation area, click Home.
2. Click the Plug-ins tab.
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3. On the Plug-ins tab, scroll to the Chassis or System x section of the page and
click the section heading. The Chassis or System x management summary is
displayed.

4. Click the question mark (?) for help in understanding the information and links
provided.

Results

You also can reach the summary page by using Find a Task. For more information,
see “Finding a task.”

Downloading and activating I/O module plug-ins
Obtain available plug-ins for chassis I/O modules to manage your device
configuration in IBM Flex System Manager.

About this task

Note: Before you complete this task, verify that the plug-in is available. For details
on acquiring a plug-in package see the support statement. For a complete list of
available IBM Systems Director plug-ins and for links to the documentation for
each plug-in, see the IBM Flex System Manager Community Web site. If the
plug-in is not available, do not complete this task. Contact IBM software support.

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To download and activate I/O module plug-ins, complete the following steps:

Procedure
1. In the IBM Flex System Manager navigation area, click Home.
2. Click the Plug-ins tab.
3. On the Plug-ins tab, scroll to the Chassis section of the page and click the

section heading. The Chassis management summary is displayed.
4. In the Setup Additional Configuration Plug-ins section, click View I/O

module plug-ins. The I/O Module Plug-ins page is displayed.
5. View the I/O module plug-ins status in the table and determine which plug-ins

you want for your environment. The following values are available for the
Status column:

Not required
An I/O module plug-in is installed, but there currently is no
discovered switch that requires the plug-in.

Required – Not installed
An I/O module plug-in that is required by a discovered switch is not
installed.
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Required – Installed with Errors
An I/O module plug-in that is required by a discovered switch is
installed, but the plug-in code cannot be loaded by the I/O module.

Required – Activation required
An I/O module plug-in that is required by a discovered switch is
installed without any error, but it is not registered with the
configuration manager plug-in. Registration activates the corresponding
switch features in configuration manager.

Active An I/O module plug-in that is required by a discovered switch is
installed without any error and is registered with the configuration
manager plug-in. Registration activates the corresponding switch
features in configuration manager.

6. View this document for information about acquiring plug-in packages:
http://www.ibm.com/support/
docview.wss?uid=nas7452a24e9851ad53f86257f8f004bce0b.

7. Install the packages as written in the documentation link for the plug-in found
in the IBM Flex System Manager Community Web site.

8. Click Activate Installed Plug-ins. IBM Flex System Manager scans the newly
installed files for the I/O module plug-ins and activates the plug-ins. The
status for each plug-in is updated in the Status column.

Changing the password for the chassis management module
You can change the password that you use to access a management module.

Before you begin

Note: Integrated management module II does not support changing passwords.

You must have access to the system to change the password. For information about
requesting access to a system, see “Requesting access to a secured system.”

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To change the password, complete the following steps:

Procedure
1. On the Chassis Manager page, click Resource Explorer under General Actions.
2. Navigate to the system that contains the Remote Supervisor Adapter, Remote

Supervisor Adapter II, or management module on which you want to change
the password.
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3. Select the system. To change the password, you must select the system resource
representation of type Server, not Operating System.

4. Click Actions > Change Password.
5. In the Change Password window, type your user name, the old password, the

new password, and then confirm the new password.
6. Click OK.

Results

The password is changed and a confirmation message is displayed.

Managing power state settings on X-architecture compute nodes
Support for the Power On/Off task is provided by service processors and chassis
management modules that can communicate out-of-band. The available power
settings vary, depending on the feature that IBM Flex System Manager uses on the
affected system.

Power On/Off task support using out-of-band communication
These service processors support Power On/Off by using out-of-band
communication on System x servers.
v Intelligent Platform Management Interface (IPMI) baseboard management

controller (BMC)
v Integrated Management Module II (IMM2)

You can use the Power On/Off task to power on and power off scalable partitions
on scalable X-Architecture compute nodes. Scalable partitions are systems that are
the logical equivalent of a physical platform. For example, when you choose to
power on a scalable partition, you do so through out-of-band communication with
the service processor in the primary node. Then, all the nodes (servers) that are
part of the scalable partition are powered on and the operating system is started
on the scalable partition. If Common Agent or Platform Agent is installed on the
scalable partition, it is started also.

Note: On scalable partitions, the service processors provide support for Power On,
Power Off Now, and Restart.

Table 72. Service processor support for power settings

Service processor Supported power settings

Compute nodes that have an IPMI
baseboard management controller

Power On, Restart Now, and Power Off
Now

Compute nodes that have an H8 controller Power On and Power Off Now

IMM2 Power On, Restart Now, Power Off Now,
Restart, and Shut Down and Power Off

For information about enabling out-of-band communication, see “Out-of-band
communication requirements.”
Related concepts:
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Out-of-band communication requirements
Data is transmitted between the service processor and IBM Flex System Manager
over a shared connection. The type of service processor present in a server
determines which paths out-of-band communication can take. These types of
communication are known as out-of-band communication because they take place
independent of an operating system.
Wake on LAN support
X-Architecture compute nodes provide support for the Power On/Off task using
Wake on LAN technology. Wake on LAN technology provides Power On only.
Operating system support
Support for the Power On/Off task can be provided by the operating system on
X-Architecture compute nodes. Either Platform Agent or Common Agent must be
installed on the system also.
Accessing a secured system with request access
Use the Request Access page to request access to a secured system if the
management server to which you are connected has not yet authenticated to the
system. You must be able to access the system before you can perform tasks or
remotely access the system.

Power On/Off task support using Wake on LAN technology on
X-Architecture compute nodes

X-Architecture compute nodes provide support for the Power On/Off task using
Wake on LAN technology. Wake on LAN technology provides Power On only.

In order to use power management provided by Wake on LAN technology, the
following criteria must be met:
v The system must include a network interface card (NIC) that can use Wake on

LAN technology.
v The system must be running an operating system that supports the Wake on

LAN feature. Wake on LAN is supported on 32-bit and 64-bit versions of
Windows and Linux, but not by VMware ESX Server or Microsoft Virtual Server.

v The Wake on LAN feature must be enabled.
v IBM Flex System Manager must be able to detect the MAC address of the

managed system.
v The system data (including the MAC address) must be included in IBM Flex

System Manager inventory tables.

Note: The Wake on LAN Power On command does not report failure or success.
To determine whether this command worked, you must verify that the affected
system was powered on as expected.
Related concepts:
Out-of-band support
These service processors support Power On/Off by using out-of-band
communication on System x servers.
Operating system support
Support for the Power On/Off task can be provided by the operating system on
X-Architecture compute nodes. Either Platform Agent or Common Agent must be
installed on the system also.
Accessing a secured system with request access
Use the Request Access page to request access to a secured system if the
management server to which you are connected has not yet authenticated to the
system. You must be able to access the system before you can perform tasks or
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remotely access the system.

Power On/Off task support by way of the operating system on
X-Architecture compute nodes

Support for the Power On/Off task can be provided by the operating system on
X-Architecture compute nodes. Either Platform Agent or Common Agent must be
installed on the system also.

See the following table for more information.

Table 73. Power-state-setting support by operating systems running on X-Architecture
compute nodes

Operating system Supported power settings

Windows (32-bit and 64-bit versions)1 Restart and Shutdown

Linux (32-bit and 64-bit versions)1 Restart

VMware GSX Server, versions 3.1 and 3.2,
guest operating systems

v (For Linux) Restart
v (For Windows) Restart and Shutdown

Microsoft Virtual Server (guest operating
system)

Restart and Shutdown

1: If the server that the operating system runs on is also discovered and managed by OOB
means, the servers power tasks are mapped in the operating systems managed endpoint.
Therefore, more power tasks are supported for such operating systems.

Related concepts:
Out-of-band support
These service processors support Power On/Off by using out-of-band
communication on System x servers.
Wake on LAN support
X-Architecture compute nodes provide support for the Power On/Off task using
Wake on LAN technology. Wake on LAN technology provides Power On only.
Accessing a secured system with request access
Use the Request Access page to request access to a secured system if the
management server to which you are connected has not yet authenticated to the
system. You must be able to access the system before you can perform tasks or
remotely access the system.

Changing the power state on X-Architecture compute nodes
Use the Power On/Off tasks to remotely restart, power on, power off, or shutdown
a compute node in your systems-management environment. The available power
states vary depending on the feature that IBM Flex System Manager uses on the
affected server. For more information, see “Power On/Off tasks support using
out-of-band communication” and “Power On/Off task support by way of the
operating system.”

Before you begin

You must have access to the system to change the power state. For information
about requesting access to a system, see “Accessing a secured system with request
access.”
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About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To change the power state, complete the following steps:

Procedure
1. On the Chassis Manager page, click Resource Explorer under General Actions.
2. Navigate to the system on which you want to change the power state.
3. View the Access column to make sure that you can access the system. If Access

is set to No Access, you must request access to the system.
4. Right-click the system and click Power On/Off. Then, click the power state that

you want to apply. Depending on the feature that IBM Flex System Manager
uses for power management on the affected system, you can set the power to
Power On, Power Off, Restart, Restart Now, or Shutdown.

5. In the Launch Job window, click OK to change the power state immediately.
You also can schedule this task to run later. For more information, see
“Scheduling tasks.”

Using locator LED settings on IBM Flex System Managercompute
nodes

IBM Flex System Managercompute nodes provide a hardware feature called the
locator LED. Use the locator LED to identify one server within a rack of servers or
other large group of servers, or one compute node within a chassis. You also can
use the locator LED to identify a server for a service representative when you are
viewing the compute node remotely in your systems-management environment.
You can change the locator-LED settings using the IBM Flex System Manager Web
interface.

Locator LEDs and out-of-band and in-band communication
IBM Flex System Manager compute nodes provide a hardware feature that is called
the locator LED. Support is provided by using either out-of-band and in-band
communication.

Support for changing the locator-LED setting is provided by the following IBM
Flex System Manager compute nodes hardware:
v Intelligent Peripheral Management Interface (IPMI) baseboard management

controller (BMC)

Note: Not all BMCs support the locator LED. If it is not supported, the locator
LED settings are not displayed when you right-click the system and click
System Identification.

v Chassis management module
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v Integrated management module II

Support is available for both in-band communication and out-of-band
communication. For information about enabling in-band communication, see
“In-band communication requirements.” For information about enabling
out-of-band communication, see “Out-of-band communication requirements.”
Related concepts:
In-band communication requirements
IBM Flex System Manager can communicate in-band with service processors in
systems that are running the required IBM Flex System Manager agent.
Out-of-band communication requirements
Data is transmitted between the service processor and IBM Flex System Manager
over a shared connection. The type of service processor present in a server
determines which paths out-of-band communication can take. These types of
communication are known as out-of-band communication because they take place
independent of an operating system.
Related tasks:
Identifying hardware with the locator LED
Use the locator LED to identify one server within a rack of servers or other large
group of servers, or one compute node within a chassis. You also can use the
locator LED to identify a server for a service representative when you are viewing
the compute node remotely in your systems-management environment. You can
turn on or off the locator LED or set it to flash.

Identifying hardware with the locator LED
Use the locator LED to identify one server within a rack of servers or other large
group of servers, or one compute node within a chassis. You also can use the
locator LED to identify a server for a service representative when you are viewing
the compute node remotely in your systems-management environment. You can
turn on or off the locator LED or set it to flash.

Before you begin

You must have access to the system to change the locator-LED setting. For
information about requesting access to a system, see “Requesting access to a
secured system.”

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To set the locator LED to flash, complete the following steps:
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Procedure
1. On the Chassis Manager page, click Resource Explorer under General Actions.
2. Navigate to the system on which you want to change the locator-LED setting.
3. View the Access column to make sure that you can access the system. If Access

is set to None, you must request access to the system.
4. Right-click the system and click System Status and Health > System

Identification > LED Flash. You also can select LED On to identify the system.
5. In the Scheduler window, click OK to flash the locator LED immediately. You

also can schedule this task to run later. For more information, see “Scheduling
tasks.”

Related concepts:
Out-of-band and in-band communication
IBM Flex System Manager compute nodes provide a hardware feature that is called
the locator LED. Support is provided by using either out-of-band and in-band
communication.
Related tasks:
Accessing a secured system with request access
Use the Request Access page to request access to a secured system if the
management server to which you are connected has not yet authenticated to the
system. You must be able to access the system before you can perform tasks or
remotely access the system.
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Chapter 16. Managing Power Systems compute nodes

IBM Flex System Manager management software manages Power Systems compute
nodes differently than X-Architecture compute nodes. The information in this
section is specific to managing Power Systems compute nodes with management
software.

The IBM Flex System Manager management software requires direct access to
Power Systems compute node Flexible Service Processors (FSPs). Therefore, Power
Systems compute node FSPs must be discovered for the management software to
provide management functionality. If you are using an HMC or IVM to manage a
Power Systems compute node in your IBM Flex System environment, do not
discover the HMC or IVM endpoint with the management software. An IBM Flex
System Manager with a discovered HMC or IVM is an unsupported configuration.

Important: Some VIOS-related functionality in the management software is not
available unless VMControl is activated. See the IBM Flex System Manager
VMControl document for more information about VMControl and how to activate
it.

Power Systems Host Management
To use the management software web interface to perform management tasks for
your Power Systems compute nodes (hosts), select the host in the Manage Power
Systems Resources table. Click Actions or right-click the host name to view the
list of the management tasks that you can perform.

Tasks

Almost all of the management software host management tasks are organized
under the following categories:
v Automation
v Hardware Information
v Inventory
v Operations
v Release Management
v Security
v System Configuration
v System Status and Health
v Service and Support

CMM requirements for Power Systems compute nodes
For the IBM Flex System Manager management software to manage Power
Systems compute nodes, certain Chassis Management Module (CMM) conditions
must be met.

When you discover and request access to a Power Systems compute node, you are
prompted to enter a user ID and password; the Power Systems compute node
account that you create is stored in the Chassis Management Module (CMM) user
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registry. The IBM Flex System Manager requires this user ID and password to
access the Flexible Service Processor (FSP) and other managed endpoints on the
Power Systems compute nodes in the managed chassis.

If you change the password for one or more Power Systems compute node
accounts on the CMM in a chassis that is not managed, you must request access
again for all of the Power Systems compute nodes in the chassis. In managed
mode, this access request is done automatically when the passwords for the Power
Systems compute node accounts on the CMM are changed.

Planning for Power Systems compute node updates
Use this information to plan for Power Systems compute node firmware updates.

Before you update the firmware for Power Systems compute nodes, make sure that
the passwords for the Power Systems compute node accounts on the CMM will
not expire before the update is complete. If the passwords expire during a code
update, the compute nodes might not reconnect to the management software, and
each Power Systems compute node might have to be updated with a new
password.

Note: The management software supports updates to IBM Power Systems network
devices only for compute nodes that run AIX. Updates to network devices in
Power Systems compute nodes that run Linux are not supported.

Updating firmware on Power Systems compute nodes
The procedures for using the IBM Flex System Manager management software to
update IBM Power Systems compute node firmware differs from the procedure for
updating X-Architecture compute nodes.

With the management software, you can install updates by either selecting the
updates and applying them to compute nodes or selecting the compute node and
installing the updates for that compute node. Regardless of whether you select the
update package first or the compute nodes to update first, you can use two
different methods to install updates:

Check for updates
Use this method to download and import updates from
http://www.ibm.com/support/fixcentral automatically.

Import updates from the file system
Use this method to copy the updates to the management node, import the
updates manually, and install the updates on compute nodes.

Additionally, the Power Systems Management summary page in the web interface
enables you to perform other update-related actions.

Check for updates

When you check for updates, the management software uses an Internet
connection to download information about the latest available updates. After the
updates are loaded, the update manager automatically compares this information
to system inventories to determine whether your systems need updates.
1. From the Chassis Manager page in the management software web interface,

click the chassis name for the chassis that contains the compute nodes that you
want to update.
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2. Click General Actions > Manage Power Systems Resources.
3. Select the Power Systems compute nodes that you want to update; then, click

Actions > Release Management > Acquire Updates. The Acquire Updates
window opens.

4. Select Check for updates; then, click OK. The Launch Job window opens.
5. Click OK to run the job immediately, or schedule the job for later.
6. Click Display Properties to see details and progress information.
7. After the job is complete, click Show and Install Updates.
8. Select the updates that you want to install; then, click Install....

Import updates from the file system

To import and install updates manually, you must acquire the updates from
http://www.ibm.com/support/fixcentral, copy them to the management node,
and apply them to the Power Systems compute nodes.
1. Copy the update files to the management node local directory (for example,

/home/USERID/fw/).
2. Import the update files from the local directory to the compute node:

a. From the Chassis Manager page in the management software web interface,
click the chassis name for the chassis that contains the compute nodes that
you want to update.

b. Click General Actions > Manage Power Systems Resources.
c. Select the Power Systems compute nodes that you want to update; then,

click Actions > Release Management > Acquire Updates.
d. Select Import updates from the file system. Type the path for the local

directory; then, click OK.
e. When you are prompted, select Run now and click OK to import the files

immediately.
f. Click Display Properties to see the completion percentage for the file-import

process. After the files are imported, and the status is Complete.
3. Install the updates:

a. From the Manage Power Systems Resources page, select the compute node
that you want to update; then click Actions > Release Management >
Show and Install Updates.

b. Select the box beside each update file that you want to install; then, click
Install.... The Install wizard opens.

c. Click All Systems.
d. Select the box for each system to which you want to apply the updates;

then, click Add >.
e. Click Next.
f. If the update is disruptive, and requires a reboot, you can choose to either

defer activation of the update or continue with the disruptive update. If the
update does not require reboot, the update is concurrent.

Note: If you choose to defer the update installation (or the concurrent
installation), you have the option to auto-accept the running firmware image
as part of the installation operation. Select the check box to enable
auto-accept.

g. Click Next. The installation summary page is displayed.
h. Click Finish.
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i. To see the status of the update installation, click Display Properties.

The Power Systems Management summary page

You can use the Power Systems Management summary page to perform the
following update-related actions:
v Accept
v Reject
v Disruptive Activate
v Synchronize
v Remove and Activate
v Set Next IPL Side

To perform one of these actions, complete the following steps:
1. From the Home page in the management software web interface, click the

Plug-ins tab.
2. From the list of plug-ins, click Power Systems Management.
3. Under Manage Resources, click the applicable link for the Power Systems

compute nodes.
4. Select the compute node that has the firmware that you want to manage; then,

from the Actions menu, click Release Management > Power Firmware
Management.

5. Click Gather Target Information.
6. Click the Actions menu; then, click the action that you want to perform.
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Chapter 17. Using CLI commands for Power Systems
compute nodes

Power Systems compute nodes have specific commands that you can use in the
IBM Flex System Manager management software command-line interface (CLI).

To view the Power Systems CLI commands, you can SSH into the management
node, and enter the following command:
smcli lsbundle | grep psm

All of the CLI commands for Power Systems compute nodes, including
descriptions and command options, are listed in the IBM Flex System Information
Center at http://ralfss21.raleigh.ibm.com:8099/help/topic/
com.ibm.acc.psm.reference.doc/dpsm_reference_kickoff.html.
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Chapter 18. Managing storage nodes

In addition to the IBM Flex System V7000 Storage Node management GUI, you
can use the IBM Flex System Manager management software to perform
management tasks on a Flex System V7000.

The Flex System V7000 provides virtualized storage within an IBM Flex System
environment, and provides shared storage capacity to compute nodes by
virtualizing internal disk drives and external Fibre Channel storage system
capacity.

After a new IBM Flex System V7000 Storage Node is installed in an Flex System
Enterprise Chassis, the Chassis Map in the management software web interface
shows the installed Flex System V7000 and provides a link to the Launch IBM
Flex System V7000 EZSetup task in the menu that enables you to set up the
storage node.

After you complete the EZSetup wizard, the management software discovers the
Flex System V7000 and collects inventory automatically.

After the Flex System V7000 is managed by the management software, you can use
the management software to perform management tasks, including monitoring,
configuring, virtualizing, and troubleshooting the storage node.

Important: Consider using static IP addresses for the Flex System V7000 storage
nodes and the Fibre Channel I/O modules in the chassis (outside the range of
192.168.70.121 - 192.168.70.124). If you use a DHCP server, it is possible that a
situation can occur where a storage node and a Fibre Channel I/O module in the
same chassis default to the same IP address if the DHCP server is unreachable for
some reason. If that situation occurs, resolve the issue by setting a static IP address
for either the storage node or the Fibre Channel I/O module that is outside the
range of 192.168.70.121 - 192.168.70.124.

Note: This documentation is specific to managing the Flex System V7000 system
with IBM Flex System Manager management software in a Flex System
environment.

For more information about the Flex System V7000, see http://
publib.boulder.ibm.com/infocenter/flexsys/information/topic/
com.ibm.acc.4939.doc/site_product_page.html. For more information about
working with external storage resources, see Chapter 19, “Managing external
storage resources,” on page 599.

Managing a Flex System V7000 manually
If an IBM Flex System V7000 Storage Node is not discovered and inventoried
automatically, use the IBM Flex System Manager management software to discover,
inventory, and manage the Flex System V7000 manually.

About this task

After a new IBM Flex System V7000 Storage Node is installed in an Flex System
Enterprise Chassis, the Chassis Map in the management software web interface
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shows the installed Flex System V7000 and provides a link to the Launch IBM
Flex System V7000 EZSetup task. Use the Flex System V7000 EZSetup wizard to
complete the initial setup the storage node.

After you complete the EZSetup wizard, the management software discovers the
Flex System V7000 and collects inventory automatically.

Important: When the management software discovers and manages a Flex System
V7000, the management software overwrites the preexisting SSH key for the user
ID superuser. After the management process is complete, you can reapply the
previous SSH key.

However, you might need to use the Manage Storage Systems page in the
management software web interface and the command-line interface (CLI) to
manually discover the Flex System V7000 for the following scenarios:
v The Flex System V7000 is not discovered and inventoried automatically.
v If a canister is removed or inserted after the Flex System V7000 has been

discovered and inventoried.
v The Flex System V7000 was previously configured in another cluster, and the

Flex System V7000 was moved from one chassis to another.

Note: If the Flex System V7000 was previously configured in another cluster, an
SSH key already exists for your user credentials. If the existing key is detected,
the management software is not able to access and unlock the Flex System
V7000.

To solve this problem, you might have to use a different user ID (one that does
not have an SSH key configured) or delete the SSH key from the user ID and
request access again. See “Cannot unlock IBM Flex System V7000 Storage Node”
in the chapter “IBM Flex System Manager Storage Control” for information
about solving Flex System V7000 access problems.

v An IBM Flex System Manager management node is installed in a chassis that
already has a Flex System V7000 installed.

Note: This documentation is specific to using the Flex System V7000 storage node
with IBM Flex System Manager management software in a Flex System
environment. For more information about working with external storage resources,
see Chapter 19, “Managing external storage resources,” on page 599.

Procedure

To manage a Flex System V7000 from the management software CLI, use the
command smcli manageV7000. For example, you could use the following command
to manage a Flex System V7000 from the management software CLI.
smcli manageV7000 -p <password_for_superuser> -i <Flex_System_V7000_IP_address>

To manage and discover the Flex System V7000 with the Discover storage task in
the web interface, complete the following steps:
1. From the Home page, click the Additional Setup tab.
2. Click Manage System Storage. The Manage System Storage page is displayed.
3. Click Discover Storage.
4. From the Select storage device type list, select IBM Flex System V7000 and

Storwize V7000.
5. Specify the IP address or host name for the storage node.
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6. Upload the SSH private key for the storage node. If you do not already have an
SSH private key, complete the following steps to generate the key on the
management node:
a. Log in to the IBM Flex System Manager management software CLI interface

with the default systems-administrator credentials (USERID is the default
user name).

b. Run the following command to create the key v7000_rsa.pub in the
directory /home/USERID:
ssh-keygen -t rsa -f $HOME/v7000_rsa

c. When you are prompted, enter a key passphrase. If you prefer not to have a
key passphrase, type nothing and press Enter. The name and directory of
the SSH key are confirmed.

7. From the Manage System Storage page in the web interface, click Browse and
select the SSH key from the directory where you saved it.

Important: The Discover storage task in the web interface does not generate a
user with the same user name as the IBM Flex System Manager management
software account that you are using to complete the Discover storage task on
the Flex System V7000. If the task fails, you might need to create a user on the
Flex System V7000 with the same user name as the IBM Flex System Manager
management software account that you are using to complete the Discover
storage task. To create this user on the Flex System V7000, see Working with
remote and local users in the Flex System V7000 documentation.

8. If applicable, type your passphrase in the Key passphrase field.

Note: The Automatically run inventory when discovering devices box is
selected by default. Unless you deselect the box, the management software will
collect inventory for the Flex System V7000 after it is discovered.

9. Click Discover.

Management software user interfaces and the Flex System V7000
storage node

Use this information as a starting point for managing an IBM Flex System V7000
Storage Node with the IBM Flex System Manager management software user
interfaces.

After an IBM Flex System V7000 Storage Node is installed in an Flex System
Enterprise Chassis and managed by the management software, you can use the
management software user interfaces (web interface and command-line interface)
to perform management tasks. Use the IBM Flex System Manager management
software user interfaces to manage and monitor storage performance, mappings,
and virtualization. For general information about the IBM Flex System Manager
management software web interface and CLI, see Chapter 2, “User interfaces,” on
page 109.

Use the Flex System V7000 user interfaces (web interface and command-line
interface) to manage Flex System V7000 settings and view system status. For
information about the Flex System V7000 user interfaces, see Flex System V7000
Storage Node user interfaces for servicing your system.

Note: This documentation is specific to using the Flex System V7000 system with
IBM Flex System Manager management software in a Flex System environment.
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For more information about the Flex System V7000, see http://
publib.boulder.ibm.com/infocenter/flexsys/information/topic/
com.ibm.acc.4939.doc/site_product_page.html. For more information about
working with external storage resources, see Chapter 19, “Managing external
storage resources,” on page 599.

Creating storage volumes
Use the Create Storage Volume wizard to create storage volumes from your storage
pools through Fibre Channel and Fibre Channel over Ethernet. You can use the
IBM Flex System Manager management software to create volumes from storage
pools that are internal or external to your IBM Flex System chassis. (The
management software supports the IBM Flex System V7000 Storage Node and
external SAN-attached storage.)

About this task

The Create Storage Volume wizard guides you through the steps that are required
to create storage volumes, including selecting a storage pool from which the
storage volumes are allocated and attached to the selected servers. The wizard also
provides the capability to create new zones and zone sets, if the zones or zone sets
were not configured previously.

Note: To create new zones or zone sets, the user must belong to a role that has the
fabric/zoning permission. (The option to create new zones is presented only when
the selected storage pool or additional server has a value of Available in the Zone
access column.) Otherwise, before you use the wizard, configure zoning so that the
associated storage pools are available for selection. (These storage pools have a
value of Zoned in the Zone access column.) Use the native switch control utility
(not the IBM Flex System Manager Web interface) to configure hard zoning on any
switch that is a member of the fabric.

Prerequisites for using the wizard include discovering and collecting inventory for
the server, switches, and storage devices. More information is available in the
Create Storage Volume wizard and in the IBM Flex System Information Center at
http://publib.boulder.ibm.com/infocenter/flexsys/information/index.jsp.

Note: If you prefer to use a command-line interface or if you must use scripting,
use the smcli commands mkstvol, lsstpool, and lsstvol. To detach and remove a
SAN volume, use the rmstvol command, a function that is not available by using
the IBM Flex System Manager Web interface.

To start the Create Storage Volume wizard, right-click the server for which you
want to allocate SAN storage volumes, the select System Configuration > Create
Storage Volumes.

Viewing and managing a Flex System V7000 storage node
Use this information as a starting point for managing an IBM Flex System V7000
Storage Node with the IBM Flex System Manager management software web
interface.

You can use the IBM Flex System Manager management software web interface to
manage and monitor storage performance.
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The Chassis Manager page and Chassis Map view provide hardware and table
views of all discovered resources in a managed chassis. Use the Chassis Manager
view in the management software web interface to view Flex System V7000 details
and perform management tasks.

To access a Flex System V7000 from the Chassis Manager page, complete the
following steps:
1. From the Home page, click the Chassis Manager tab.
2. From the Chassis Manager page, click the chassis that contains the Flex System

V7000 storage node. The Chassis Map view opens.
3. From the Chassis Map, click the Flex System V7000 storage node to select it.

The details for the storage node are displayed.

Note: If you moved a Flex System V7000 storage node from one node bay in
the chassis to another, it is possible that the Flex System V7000 storage node
will not appear in the Chassis Map. If that occurs, complete the following steps:
a. From the Chassis Map, click General Actions > Resource Explorer.
b. Remove the storage managed endpoints from the chassis manager:

1) From the Resource Explorer page, search for "storage."
2) Click the group containing the Flex System V7000 storage node to

display all managed endpoints.
3) Right click each managed endpoint and select Remove.. to remove it

from the list.
c. Collect inventory on the chassis (CMM):

1) From the Chassis Map, select the chassis.
2) Make sure that Show advanced properties is selected at the bottom of

the page.
3) Click the Inventory tab; then click Collect Inventory.

d. After inventory is collected, the Flex System V7000 storage node is
displayed in the Chassis Map.

4. Click the Actions menu for a list of storage viewing and management options.

Note: You can launch the Flex System V7000 management GUI from the
Chassis Map view. After you select the storage node in the Chassis Map view,
click Launch IBM Flex System V7000.

The Storage Management summary page in the management software web
interface enables you to view storage capacity details and provides links to storage
monitoring tasks.

To access the Storage Management summary page, complete the following steps:
1. From the Home page, click the Plug-ins tab.
2. Click Storage Management. The Storage Management summary page opens.

The following links are available under Storage Tasks:
v Discover Storage
v Storage to Server Mapping View
v Server to Storage Mapping View
v View Current® Configuration
v View and Apply Storage Templates
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Note: This documentation is specific to using the Flex System V7000 system with
IBM Flex System Manager management software in a Flex System environment.

For more information about the Flex System V7000, see http://
publib.boulder.ibm.com/infocenter/flexsys/information/topic/
com.ibm.acc.4939.doc/site_product_page.html. For more information about
working with external storage resources, see Chapter 19, “Managing external
storage resources,” on page 599.
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Chapter 19. Managing external storage resources

In addition to the internal IBM Flex System V7000 Storage Node storage, the IBM
Flex System Manager management software is capable of managing several other
storage systems and storage network devices.

Storage management with the management software involves two software
components: Storage Manager and Storage Control. Both components are included
with the management software. Storage Manager is a standard management
software capability that provides basic storage lifecycle management (Discovery,
Inventory, Health and Alerts). Storage Control is a preinstalled plug-in for the
management software that expands storage support to mid-range and high-end
storage devices. It is based on technology from Tivoli Storage Productivity Center.

Flex System Enterprise Chassis and the management software offer many
storage-management capabilities:
v Discovery of physical and virtual storage devices
v Support for virtual images on local storage across multiple chassis
v Inventory of physical storage configuration
v Health status and alerts
v Storage pool configuration
v Disk sparing and redundancy management
v Virtual volume management
v Support for virtual volume discovery, inventory, creation, modification, and

deletion

Note: The Chassis Manager view in the management software is the primary
interface for selecting managed resources and performing management tasks on
those resources. However, some of the procedures in this section include steps that
instruct you to use the navigation area, which is hidden by default in the web
interface.

Supported storage systems and storage-network devices
Use this information to determine which storage and storage-network products are
supported for use with the IBM Flex System Manager management software. The
management software supports a variety of storage-management tasks; the specific
tasks available depend on your storage systems, network switches, and network
adapters.

Table 74. Supported storage devices and storage-management tasks

Task

IBM Flex
System
V7000

Storage
Node

IBM Storwize Family

IBM SAN
Volume

Controller

IBM
System
Storage
DS8000®

IBM XIV®

Storage
System
Gen3

V3500/
V3700/
V5000

V7000/
V7000
Gen2

Discovery Yes Yes Yes Yes Yes Yes

Inventory
collection

Yes Yes Yes Yes Yes Yes
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Table 74. Supported storage devices and storage-management tasks (continued)

Task

IBM Flex
System
V7000

Storage
Node

IBM Storwize Family

IBM SAN
Volume

Controller

IBM
System
Storage
DS8000®

IBM XIV®

Storage
System
Gen3

V3500/
V3700/
V5000

V7000/
V7000
Gen2

Monitoring
(alerts and
status)

Yes Yes Yes Yes Yes Yes7

Server-to-storage
mapping1

Yes Yes Yes Yes Yes Yes

Physical
topology

Yes2 Yes Yes Yes Yes Yes

Logical topology Yes Yes Yes Yes Yes Yes

Streamlined
storage-to-server
provisioning

Yes Yes Yes Yes Yes Yes

VMControl
provisioning3

Yes Yes Yes Yes Yes Yes

NPIV support Yes Yes Yes Yes Yes4

Monitor
virtualized
storage capacity5

Yes Yes Yes

IBM Flex System
Manager Chassis
Map6

Yes Yes
(PureFlex

only)

IBM Flex System
Manager-based
updating

Yes

IBM Flex System
Manager-based
problem
reporting to IBM

Yes
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Table 74. Supported storage devices and storage-management tasks (continued)

Task

IBM Flex
System
V7000

Storage
Node

IBM Storwize Family

IBM SAN
Volume

Controller

IBM
System
Storage
DS8000®

IBM XIV®

Storage
System
Gen3

V3500/
V3700/
V5000

V7000/
V7000
Gen2

1. Applies only to compute nodes running AIX, KVM, RHEL, and VMWare ESX.

2. Physical network topology only.

3. Applies to PowerVM® and KVM hosts when deploying a new virtual appliance that
involves allocating a new storage volume from the storage device. This requires NPIV,
although NPIV for IBM i-hosted workload is not supported.

4. In IBM Flex System Manager versions 1.2.0 and later, VMControl provides limited
support for IBM XIV storage that is connected through the NPIV protocol to Power
Systems compute nodes. NPIV support is provided for AIX and IBM i operating
systems, but the necessary MPIO device drivers and host attachment kits that are
needed to support NPIV must be installed on the client virtual servers.
Important: VMControl cannot remove host definitions for virtual servers on the XIV
storage system. When you deprovision NPIV-attached storage volumes, you must
delete associated host definitions on the XIV storage system, either manually or by
using a script to periodically delete unused host definitions. If you do not delete
unused host definitions, VMControl storage provisioning might fail because there are
not enough available host definitions on the XIV storage system.

5. Ability to view and monitor capacity of IBM or non-IBM storage that is virtualized
behind a V7000 array or the IBM SAN Volume Controller.

6. Flex System V7000 storage nodes, which are installed in IBM Flex System chassis, are
discovered and displayed automatically by the management software. Storage systems
that are external to the chassis are not.

7. IBM XIV Storage System disk failure alerts are not shown in the IBM Flex System
Manager management software.

Table 75. Supported storage-network switches and storage-management tasks

Task

IBM Flex System network switches

External
network
switches

IBM Flex
System

FC5022 16Gb
SAN Switch

IBM Flex
System

FC3171 8Gb
SAN Switch

Flex System
CN4093 10Gb

Converged
Scalable Switch

IBM System
Storage

SAN24B-4
Express®

Switch

Discovery Yes Yes Yes Yes

Inventory collection Yes Yes Yes Yes

Monitoring (alerts and
status)

Yes Yes Yes Yes

Server-to-storage
mapping1

Yes Yes Yes Yes

Physical topology

Logical topology Yes Yes Yes Yes

NPIV support Yes Yes2 Yes

IBM Flex System
Manager Chassis Map2

Yes Yes Yes
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Table 75. Supported storage-network switches and storage-management tasks (continued)

Task

IBM Flex System network switches

External
network
switches

IBM Flex
System

FC5022 16Gb
SAN Switch

IBM Flex
System

FC3171 8Gb
SAN Switch

Flex System
CN4093 10Gb

Converged
Scalable Switch

IBM System
Storage

SAN24B-4
Express®

Switch

IBM Flex System
Manager-based
updating

Yes Yes Yes

IBM Flex System
Manager-based problem
reporting to IBM

Yes Yes Yes

1. Applies only to compute nodes running AIX, KVM, RHEL, and VMWare ESX.

2. VMControl only supports NPIV for the FC3171 when the switch is in transparent mode
and connected to an FC5022.

3. IBM Flex System network switches, which are installed in IBM Flex System chassis, are
discovered and displayed automatically by the management software. Network
switches that are external to the chassis are not.

Table 76. Supported network adapters and storage-management tasks

Task

IBM Flex System Fibre Channel
network adapters

IBM Flex System Fibre
Channel over Ethernet

(FCoE) network adapters

IBM Flex
System
FC3052

2-port 8Gb
FC Adapter

IBM Flex
System
FC3172

2-port 8Gb
FC Adapter

IBM Flex
System

FC5022 2-port
16Gb FC
Adapter

IBM Flex
System
CN4054

10Gb
Virtual
Fabric

Adapter

IBM Flex
System
CN4058

8-Port 10Gb
Converged

Adapter

Discovery Yes Yes Yes Yes Yes

Inventory collection Yes Yes Yes Yes Yes

Monitoring Yes Yes Yes Yes Yes

Managing and configuring the IBM Storwize V7000
Use the information in this section to manage and configure a Storwize V7000
system with IBM Flex System Manager management software in a Flex System
environment.

The IBM Storwize V7000 is an external storage system with a set of drive
enclosures that can be connected to the Flex System Enterprise Chassis. Control
enclosures contain disk drives and two node canisters. A collection of control
enclosures that are managed as a single system is a clustered system. Expansion
enclosures contain drives and are attached to control enclosures. Expansion
canisters include the serial-attached SCSI (SAS) interface hardware that enables the
node canisters to use the drives of the expansion enclosures.
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The Storwize V7000 comes with storage-management software that integrates with
the IBM Flex System Manager management software to perform the following
functions for the host systems that attach to a storage system:
v Storage pool creation
v Logical unit virtualization
v Logical volume management and mirroring
v Large scalable cache
v Copy Services
v Space management

This documentation is specific to using the Storwize V7000 system with IBM Flex
System Manager management software in a Flex System environment. For
additional information about the Storwize V7000, see IBM Storwize V7000
Knowledge Center.

For more information about working with other storage resources, see Chapter 19,
“Managing external storage resources,” on page 599.

Note: Information on this topic may be available elsewhere on the internet. Please
use your preferred search engine to search for this topic.

Managing an IBM Storwize V7000
You can discover and collect inventory for an IBM Storwize V7000 in the IBM Flex
System Manager management software web interface or command-line interface
(CLI).

About this task

Procedure

Important: When you use the management software to manage a Storwize V7000,
the management software overwrites the preexisting SSH key for the user ID
superuser. After the management process is complete, you can reapply the previous
SSH key.
To manage a Storwize V7000 from the management software CLI, use the
command smcli manageV7000. For example, you could use the following command
to manage a Storwize V7000 from the management software CLI.
smcli manageV7000 -p <password_for_superuser> -i <Flex_System_V7000_IP_address>

To manage a Storwize V7000 from the management software web interface,
complete the following steps:
1. From the Home page, click the Additional Setup tab.
2. Click Manage System Storage. The Manage System Storage page is displayed.
3. Click Discover Storage.
4. From the Select storage device type list, select IBM Flex System V7000 and

Storwize V7000.
5. Specify the IP address or host name for the Storwize V7000.
6. Upload the SSH private key for the Storwize V7000. If you do not already

have an SSH private key, complete the following steps to generate the key on
the management node:
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a. Log in to the IBM Flex System Manager management software CLI
interface with the default systems-administrator credentials (USERID is the
default user name).

b. Run the following command to create the key v7000_rsa.pub in the
directory /home/USERID:
ssh-keygen -t rsa -f $HOME/v7000_rsa

c. When you are prompted, enter a key passphrase. If you prefer not to have
a key passphrase, type nothing and press Enter. The name and directory of
the SSH key are confirmed.

7. Make sure that the public key file from the SSH key pair is uploaded to the
Storwize V7000 storage subsystem. If you need to upload the public key, use
the Storwize V7000 web interface to authorize the key for the desired user. For
more information about using the Storwize V7000 web interface, see
http://publib.boulder.ibm.com/infocenter/storwize/ic/index.jsp.

Important: The Discover storage task in the web interface does not generate a
user with the same user name as the IBM Flex System Manager management
software account that you are using to complete the Discover storage task on
the Storwize V7000. If the task fails, you might need to create a user on the
Storwize V7000 with the same user name as the IBM Flex System Manager
management software account that you are using to complete the Discover
storage task. To create this user on the Storwize V7000, see Creating users in
the IBM Storwize V7000 Information Center.

8. From the Manage System Storage page in the web interface, click Browse and
select the SSH key from the directory where you saved it.

9. If applicable, type your passphrase in the Key passphrase field.

Note: The Automatically run inventory when discovering devices box is
selected by default. Unless you deselect the box, the management software
will collect inventory for the Flex System V7000 after it is discovered.

10. Click Discover.

Managing and configuring storage network devices
Use the information in this section to manage and configure Fibre Channel and
Fibre Channel over Ethernet storage network devices with IBM Flex System
Manager management software in a Flex System environment.

This documentation is specific to using Fibre Channel (FC) and Fibre Channel over
Ethernet (FCoE) network devices with storage systems IBM Flex System Manager
management software in a Flex System environment.

Important: Consider using static IP addresses for the Flex System V7000 storage
nodes and the Fibre Channel I/O modules in the chassis (outside the range of
192.168.70.121 - 192.168.70.124). If you use a DHCP server, it is possible that a
situation can occur where a storage node and a Fibre Channel I/O module in the
same chassis default to the same IP address if the DHCP server is unreachable for
some reason. If that situation occurs, resolve the issue by setting a static IP address
for either the storage node or the Fibre Channel I/O module that is outside the
range of 192.168.70.121 - 192.168.70.124.

For more information about working with other storage resources, see Chapter 19,
“Managing external storage resources,” on page 599.
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Configuring the IBM Flex System FC3171 8Gb SAN Switch
Use the information in this section to configure the IBM Flex System FC3171 8Gb
SAN Switch for management by the IBM Flex System Manager management
software.

For more information about the FC3171 switch, see the documentation that came
with the device.

Running discovery and inventory for an IBM Flex System
Manager chassis-mounted Fibre Channel switch
You must run discovery for your storage and switch devices before you can view
or change them. This is a basic discovery procedure that uses CMM auto discovery.
Follow these steps to discover chassis-mounted Fibre Channel switches, including
the FC3171 8Gb SAN switch.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

Note: For instructions to discover a FC5022 16Gb SAN switch, see this topic:
“Discovering a Flex System FC5022 16 Gb SAN switch with the management
software” on page 610.

To discover and run inventory for the FC3171 switch, use the management
software web interface to complete the following steps:

Procedure
1. From the Home page, click the Additional Setup tab.
2. Click Manage System Storage. The Manage System Storage page opens.
3. Click Discover Storage Network Switches. The Discover Storage page opens.
4. From the Select storage device type list, select FC Switch. The applicable

settings fields for a Fibre Channel switch are displayed.
5. Complete the fields for the switch settings, including the IP address of the

switch; then, click Discover. The Automatically run inventory when
discovering devices box is selected by default. Unless you deselect it, the
management software will collect inventory for the switch automatically after it
has been discovered.

What to do next

After the FC3171 switch is discovered, you can configure it for operating-system
deployment. See the PDF document for Configuring the IBM Flex System FC3171
8Gb SAN switch in Configuring hardware before installing operating systems.
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Configuring the IBM Flex System FC5022 16Gb SAN Switch
Use the information in this section to configure the IBM Flex System FC5022 16Gb
SAN Switch for management by the IBM Flex System Manager management
software.

To set up an FC5022 switch for management by the IBM Flex System Manager
management software, you must complete the procedures that are described in the
following three topics:
1. “Setting SNMP credentials for the Flex System FC5022 16Gb SAN Switch”
2. Discovering an IBM Flex System FC5022 16Gb SAN switch with the SMIA

Configuration Tool
3. Discovering an IBM Flex System FC5022 16 Gb SAN switch with the

management software

Setting SNMP credentials for the Flex System FC5022 16Gb SAN
Switch
Before you can use the SMIA Configuration Tool to discover a Flex System FC5022
16Gb SAN Switch, an SNMPv3 credential with write authority must be configured
for the switch.

IBM Flex System Manager management software version 1.2 or later attempts to
configure the SNMPv3 credential on the switch using the default snmpadmin3 user
account with SHA/DES authentication and privacy protocols, and default
password admin3. For a management software version that is earlier than 1.2, or if
the automatic SNMPv3 switch device configuration by the management node fails
(for example, if the default SNMP configuration was changed on the switch or
there are no trap recipients slots left on the device) you must manually configure
SNMPv3 on the switch and configure a corresponding SNMPv3 access credential
on the management node.

Important:

1. When the SNMP credentials are set in the FC5022 switch, do not modify the
snmpadmin1 user. The snmpadmin1 user is reserved for the IBM Flex System
Manager to install the switch firmware update.

2. For the firmware level v7.2.0b1, use MD5 for the Authentication protocol when
the SNMP credentials are set in the FC5022 switch. The default value for
Authentication and Privacy protocol is SHA / DES for later releases.

3. Ensure the Authentication / Privacy password has at least 8 characters or
performance data collection will fail.

To configure SNMP for the FC5022 switch, complete the following steps:
1. Open an SSH session for the FC5022 switch.
2. Run the following command:

snmpconfig --show snmpv3

After you run the command, the output will be similar to the following
example.
SNMP Informs = 0 (OFF)

SNMPv3 USM configuration:
User 1 (rw): mmv3_mgr

Auth Protocol: MD5
Priv Protocol: DES
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User 2 (rw): snmpadmin2
Auth Protocol: MD5
Priv Protocol: AES128

User 3 (rw): snmpadmin3
Auth Protocol: SHA
Priv Protocol: DES

User 4 (ro): DirectorServerSNMPv3User
Auth Protocol: MD5
Priv Protocol: DES

User 5 (ro): snmpuser2
Auth Protocol: SHA
Priv Protocol: AES128

User 6 (ro): snmpuser3
Auth Protocol: SHA
Priv Protocol: AES128

SNMPv3 Trap configuration:
Trap Entry 1: FE80::0211:25FF:FEC3:5AF6

Trap Port: 162
Trap User: mmv3_mgr
Trap recipient Severity level: 0

Trap Entry 2: No trap recipient configured yet
Trap Entry 3: No trap recipient configured yet
Trap Entry 4: No trap recipient configured yet
Trap Entry 5: No trap recipient configured yet
Trap Entry 6: No trap recipient configured yet

3. To set the user name and passwords, issue the following command:
snmpconfig --set snmpv3

Note: The selections for the Authentication and Privacy protocol differ,
depending on the firmware level of the switch. Select the value SHA and DES
for these protocols unless otherwise instructed.

4. When you are prompted SNMP Informs Enabled (true, t, false, f): [false],
press Enter to keep the Informs Enabled value false.

5. When you are prompted User (rw): [snmpadmin2], press Enter repeatedly until
you are prompted User (rw): [snmpadmin3]

6. When you are prompted User (rw): [snmpadmin3], press Enter; then, complete
the following steps:
a. When you are prompted Auth Protocol [MD5(1)/SHA(2)/noAuth(3)]:

(3..3) [2], press Enter.
b. When you are prompted New Auth Passwd:, type an authentication

password; then, press Enter.
c. When you are prompted Verify Auth Passwd:, type the authentication

password again; then, press Enter.
d. When you are prompted Priv Protocol [DES(1)/noPriv(2)/3DES(3)/

DES(4)/AES192(5)/AES256(6)]): (2..2) [1], press Enter.
e. When you are prompted New Priv Passwd:, type a privacy password; then,

press Enter.
f. When you are prompted Verify Priv Passwd:, type the privacy password

again; then, press Enter.
7. When you are prompted User (ro): [DirectorServerSNMPv3User], press Enter

repeatedly until you are prompted SNMPv3 trap recipient configuration:
8. When you are prompted SNMPv3 trap recipient configuration:, complete the

following steps:
a. When you are prompted Trap Recipient’s IP address : [0.0.0.0], either

modify an existing no longer used trap destination or add a new trap
destination by entering your management node IP address.
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b. When you are prompted UserIndex: (1..6) [3], enter the UserIndex for
the modified snmpadmin3 user that is shown in the output for the
snmpconfig --show snmpv3 command that you ran in step 2.

c. When you are prompted Trap recipient Severity level : (0..5) [5],
type the severity level number that you want for receiving SNMP
notifications from the device on the management node and press Enter.

d. When you are prompted Trap recipient Port : (0..65535) [10162], type
162 for the default SNMP notification port used by the management node
and press Enter.

e. Press Enter repeatedly until the message Committing configuration...done.
and the command prompt are displayed.

9. Complete the steps described in Discovering an IBM Flex System FC5022 16Gb
SAN switch with the SMIA Configuration Tool to discover and activate the
switch.

Note: Documents listed on this page and other information on this topic may be
available elsewhere on the internet. Please use your preferred search engine to
search for this topic.

Discovering a Flex System FC5022 16Gb SAN switch with the
SMIA Configuration Tool
For VMControl and Storage Control to work with the FC5022 16Gb SAN switch,
you must start the SMIA Configuration Tool application so that the management
software can access the required SMI-S agent for the FC5022 switch. You can also
use this information to add a System Storage SAN24B-4 Express switch as a
top-of-rack Fibre Channel switch in your environment.

The SMIA Configuration Tool application is preinstalled with the management
software, and you can start it, stop it, and launch its administration console from
the management software web interface.

Important:

v Before you complete the following steps, make sure that you have completed the
procedure that is described in Setting SNMP credentials for the Flex System
FC5022 16Gb SAN Switch.

v You can also use the following procedure to discover and add the System
Storage SAN24B-4 Express switch to your environment.

v The SMIA Configuration Tool requires Oracle JRE. Refer to the table that lists the
JRE versions required for the various SMIA Configuration Tool versions for your
FSM installation, on the following page: Troubleshooting the SMIA
Configuration Tool

To start the SMIA Configuration Tool, launch the tool, and configure the tool for
the FC5022 switch, complete the following steps:
1. Start the SMIA Configuration Tool:

a. Log in to the management software web interface.
b. From the Home page, click the Applications tab.
c. Under SMIA Configuration Tool, click Start.

Note: The tool should begin running in less than 10 minutes. You must
refresh the browser to see the updated status Running.

2. Launch and configure the SMIA Configuration Tool administration console:
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a. After the status displayed for the tool is Running, click Launch
administration console. The SMIA Configuration Tool Log In window
opens, and displays the IP address and hostname of the management node.

Note: Make sure that the hostname for the computer on which the SMIA
tool client is running (in the hosts file) matches the hostname of the
management node. If you must change the hostname that is stored in the
local hosts file, see for more information.

b. Log in with your management software user ID and password. The SMIA
Configuration Tool administration console opens, and the Home tab is
displayed.

c. From the Home tab in the console, click Options.
d. In the Category box, click Software Configuration > Product

Communication.
e. Set the communication protocol to match the one being used by the Flex

System FC5022 16Gb SAN Switch.

Important: The Flex System FC5022 16Gb SAN Switch and IBM Network
Advisor support both HTTP and HTTP Secure (HTTPS). The SMIA
Configuration Tool setting must match the protocol being used by the Flex
System FC5022 16Gb SAN Switch. If the protocols do not match, you might
receive a 403 authentication failure message when you attempt a fabric
discovery of the switch.

f. Click Apply; then, click OK.
g. Return to the Applications tab in the management software web interface,

and click Stop under SMIA Configuration Tool.

Note: The SMIA Configuration Tool console window closes when the tool is
stopped from the management software.

h. Click Start to restart the SMIA Configuration Tool.
3. Discover the switch with the SMIA Configuration Tool:

a. After the status displayed for the tool is Running, click Launch
administration console. The SMIA Configuration Tool Log In window is
displayed.

b. Log in with your management software user ID and password. The SMIA
Configuration Tool administration console opens, and the Home tab is
displayed.

c. From the Home tab in the console, click Fabric Discovery. The Discover
Fabrics window is displayed.

d. Click Add. The Add Fabric Discovery window is displayed.
e. On the IP Address tab of the Add Fabric Discovery window, complete the

following steps:
1) For the SNMP Configuration setting, select Manual.
2) In the Fabric Name field, type a name.
3) In the IP Address field, type the IPv6 address of the switch.
4) In the User ID and Password fields, type the user ID and password of

the switch.
f. Click the SNMP tab; then enter the parameters that you set when you

completed the procedure in Setting SNMP credentials for the Flex System
FC5022 16Gb SAN Switch:
1) In the User Name field, type the user name (for example, snmpadmin3).
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2) Leave the Context Name field empty.
3) For the Auth Protocol setting, select SHA.
4) In the Auth Password field, type the authentication password.
5) For the Priv Protocol setting, select DES.
6) In the Priv Password field, type the privacy password.

g. Click OK. If the switch is discovered, the Discover Fabrics window displays
a check beside FC5022.

4. Follow the steps in Discovering a IBM Flex System FC5022 16Gb SAN switch
with the management software to discover and manage the switch with the
management software.

For troubleshooting information for the SMIA Configuration Tool, see
Troubleshooting the SMIA Configuration Tool.

If you need to change the administrative user ID and password for the SMIA
Configuration Tool, see Changing the SMIA Configuration Tool user ID and
password.

For more information about configuring zones for switch, see the PDF document
for Configuring the Flex System FC5022 16Gb SAN switch in Configuring hardware
before installing operating systems.

Discovering a Flex System FC5022 16 Gb SAN switch with the
management software
Before you can integrate and manage an FC5022 16 Gb SAN switch with the
management software in an IBM Flex System environment, the FC5022 switch
must be discovered and inventoried by the IBM Flex System Manager management
software.

For VMControl and Storage Control to work with the FC5022 switch, you must
launch the SMIA Configuration Tool application so that the management software
can access the required SMI-S agent for the FC5022 switch. The SMIA
Configuration Tool application is preinstalled with the management software, and
you can start it and stop it from the management software web interface.

Important: Before the FC5022 switch can be discovered and inventoried it must be
zoned, and then configured with the SMIA Configuration Tool, as described in
Setting SNMP credentials for the Flex System FC5022 16Gb SAN Switch and
Discovering an IBM Flex System FC5022 16Gb SAN switch with the SMIA
Configuration Tool.

After the switch is zoned and configured, you can use the Discover storage
network switches task on the Manage System Storage page to discover and
inventory the switch. To discover and run inventory for the FC5022 switch, use the
management software web interface to complete the following steps:
1. From the Home page in the management software web interface, click the

Plug-ins tab.
2. From the Plug-ins tab, under Storage Management, click Discover Storage. The

Discover Storage page opens.
3. From the Select storage device type list, select FC Switch.
4. Specify the settings for the switch:

a. In the SMI-S address or host name field, type the IPv6 address for your
management node farm.
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Note: You can find this IPv6 address from multiple places in the web
interface. From the Chassis Manager page, under General Actions, click
Resource Explorer > All Systems; then, find the resource with the fsm host
name and Farm in the Type column. The IP address for the farm is
displayed.

b. In the Port field, delete the default value 5989, and type 25989.
c. In the Username and Password fields, type your management software user

ID and password.
d. Click Discover.

5. After discovery is complete, you must collect inventory for the management
node farm:
a. From the Chassis Manager page, under General Actions, click Resource

Explorer. The Resource Explorer page is displayed.
b. Click All Systems.
c. Click the resource with the management node hostname and Farm in the

Type column. The properties page for the farm is displayed.
d. Click the Inventory tab; then, click Collect Inventory. The Launch Job

window opens.
e. Click OK to collect inventory immediately, or schedule the job for later.

After the FC5022 switch is discovered, you can configure it for operating-system
deployment. See the PDF document for Configuring the Flex System FC5022 16 Gb
SAN switch in Configuring hardware before installing operating systems.

For more information about discovery and inventory for other Fibre Channel
switches, see Running discovery and inventory for an IBM Flex System Manager
chassis-mounted Fibre Channel switch.

Changing the SMIA Configuration Tool user ID and password
The SMIA Configuration Tool application provides the SMI-S agent that is required
by the Flex System FC5022 16Gb SAN switch. SMIA comes preinstalled with the
management software, and is configured to use the management software system
user ID and password that were set during the initial setup of the management
node. Use this information to change the SMIA user ID and password after the
initial management node setup.

Important:

v The Flex System FC5022 16Gb SAN Switch supports only HTTP Secure (HTTPS),
but the default protocol for the SMIA Configuration Tool is HTTP. After you
launch and log in to the SMIA Configuration Tool, change the default protocol
setting from HTTP to HTTPS.

v Sometime after initial setup of the management node, the management software
system password must be changed. However, the SMIA user ID and password
will not be changed automatically with the system ID and password.

To change the SMIA user ID and password, complete the following steps:
1. Open a management software CLI prompt and log in.
2. Use the lsdatasource command to list the datasources from Storage Control

management, as shown in the following example.
smcli lsdatasource

3. Use the rmdatasource command to remove the switch from Storage Control
management, as shown in the following example.
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Note: This example does not show all of the possible options for the
rmdatasource command. For more information about the command, see
rmdatasource.
smcli rmdatasource -t https -i <IP_address> -p <port_number>

where <IP_address> and <port_number> are the IP address and port of the
switch.

4. Log in to the management software web interface.
5. From the Home page, click the Applications tab.
6. Under SMIA Configuration Tool, click Launch administration console. The

SMIA administration console window opens.

Note:

a. If this is the first time you launch the tool, you must download it before
you can use it. If necessary, confirm the browser security exceptions, and
the application downloads.

b. The SMIA Configuration Tool is a component of IBM Network Advisor. The
download progress window and other interface elements might be labeled
as IBM Network Advisor, but the SMIA Configuration Tool provides only a
subset of full Network Advisor functionality.

7. Log in to the console; then, use the console to change the administrator user ID
and password.

Important: If this is the first time you launch the tool, you must change the
default protocol setting from HTTP to HTTPS after you log in. The Flex System
FC5022 16Gb SAN Switch supports only HTTP Secure (HTTPS), but the default
protocol for the SMIA Configuration Tool is HTTP.

Note: If you cannot log in to the SMIA Configuration Tool, see .
8. From the management software CLI prompt, use the mkdatasource command to

reestablish management of the switch, as shown in the following example.

Note: This example does not show all of the possible options for the
mkdatasource command. For more information about the command, see
mkdatasource.
smcli -user USERID -pw Passw0rd mkdatasource -c fabric -i <IP_address>
-t https -p 25989 -u USERID -w Passw0rd -n /interop

where <IP_address> is the IP address of the management node.

Note: Port 25989 is the default port number of the SMIA Configuration Tool.

For more information about discovering and collecting inventory for the FC5022
switch, see Running discovery and inventory for an IBM Flex System FC5022 16Gb
SAN switch.

For more information about configuring zones for switch, see the PDF document
for Configuring the Flex System FC5022 16Gb SAN switch in Configuring hardware
before installing operating systems.

Troubleshooting the SMIA Configuration Tool
If you are unable to launch the tool, or if you cannot complete a fabric discovery of
a switch because you receive a 403 authentication failure message, use this
information to solve the problem.
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You are unable to launch the SMIA Configuration Tool

If you are unable to launch the SMIA Configuration Tool, and the log in window
displays a Server not available message and the Login button is grayed out, use the
following information to resolve the problem.

For VMControl and Storage Control to access the required SMI-S agent for the
FC5022 16Gb SAN switch, the SMIA Configuration Tool client must be operational.
The SMIA Configuration Tool client, which runs on the computer that is accessing
the management software web interface, uses the hostname of the management
node to connect to the SMIA application that runs on the management node. If you
do not have a Domain Name System (DNS) on your network that can resolve the
hostname of the management node, the application will not allow you to log in. If
you have a DNS, but cannot log in to the SMIA Configuration Tool, the DNS might
be mapping hostnames and IP address incorrectly.

Regardless of whether you have a DNS on your network, you can modify the local
hosts file on the computer that is running the SMIA Configuration Tool client by
adding an entry that maps the management node IP address to the management
node hostname. To modify the hosts file, complete the following steps.

Note: If you do not want to modify the hosts file, you can also resolve the
problem by either configuring the DNS settings so that IP addresses and
hostnames are mapped correctly (if you have a DNS on your network), or adding
a DNS server to your network (if you don’t already have one).
1. Open the local hosts file on the computer that is running the SMIA

Configuration Tool client. For example, on a computer with Windows XP, the
location of the hosts file is:
C:\WINDOWS\system32\drivers\etc\hosts

2. Add an entry that maps the management node IP address to the management
node hostname. The entry might be similar to the following:
172.16.254.1 fsmhost

where 172.16.254.1 and fsmhost are the IP address and hostname of your
management node.

3. Save and close the hosts file.
4. If the SMIA Configuration Tool has already been started and is running, you

must complete the following steps before the updates to the local hosts file take
effect:
a. Close the SMIA Configuration Tool administration console.
b. From the Applications tab in the management software web interface, under

SMIA Configuration Tool, click Stop.
c. After the SMIA Configuration Tool is stopped, click Start to restart the tool.

For more information about configuring the FC5022 switch and the management
software, begin with Discovering a Flex System FC5022 16Gb SAN switch with the
SMIA Configuration Tool.

If you need to change the administrative user ID and password for the SMIA
Configuration Tool, see Changing the SMIA Configuration Tool user ID and
password.
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A 403 authentication failure message is displayed during fabric
discovery of a switch

If the SMIA Configuration Tool setting is not changed from the default protocol
HTTP to HTTPS, you might receive a 403 authentication failure message when you
attempt a fabric discovery of the switch. To change the setting, complete the
following steps from the SMIA Configuration Tool console:
1. From the Home tab in the console, click Options.
2. In the Category box, click Software Configuration > Product Communication.
3. Select Connect using HTTPS (HTTP over SSL) only.

Important: The IBM Flex System FC5022 16Gb SAN Switch supports only
HTTP Secure (HTTPS), but the default protocol for the SMIA Configuration
Tool is HTTP. After you launch and log in to the SMIA Configuration Tool,
change the default protocol setting from HTTP to HTTPS.

4. Click Apply; then, click OK.
5. Stop, then restart the SMIA Configuration Tool:

a. From the Home page in the management software web interface, click the
Applications tab.

b. From the Applications tab, under SMIA Configuration Tool, click Stop.
c. After the SMIA Configuration Tool is stopped, click Start to restart the tool.

The links on the SMIA Configuration Tool Home page do not work

This can occur if the version of the SMIA Configuration Tool and the current JRE
are not compatible. The following table shows the required JRE versions for the
SMIA Configuration Tool.

FSM INA JRE Version

1.3.2 12.1.5 Oracle Java JRE 1.7.0 update
51 or later

1.3.3 12.3.4 Oracle Java JRE 1.8.0

1.3.4 12.4.2 Oracle Java JRE 1.8.0

To download the FSM Network Advisor 12.4.2,

https://www-945.ibm.com/support/fixcentral/systemx/
downloadFixes?parent=Flex%2BSystem%2BManager%2BNode&product=ibm/
systemx/8731&&platform=All&includeZip=false&function=fixId
&fixids=fsmfix_network_advisor_12.4.2_1.3.4&includeRequisites=1
&includeSupersedes=0&downloadMethod=http

Note: The IBM Flex System Manager uses the IBM JRE, which is not supported by
any version of the SMIA Configuration Tool. You cannot launch the SMIA
Configuration Tool on the IBM Flex System Manger itself.

Disable / Stop SMIA Configuration Tool

SMIA Configuration Tool is an application integrated into the FSM which is used
to manage the network and storage end points on a Storage Area Network (SAN)
environment. However, the older release of SMIA Configuration Tool (12.1.5) tend
to consume excessive resources to run and store the log files. There are situations
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when these resources are not released and can cause the FSM to hang or crash
suddenly. To avoid this behavior, it is recommended to follow the instructions
below to Disable or Stop the SMIA Configuration Tool on the FSM if it is not used
to manage the SAN environment.

Disable SMIA

v Login to FSM CLI using USERID
v Run the command ‘smcli uninstallNetworkAdvisor’
v Wait till the successful completion of the command
v Restart the FSM using the command ‘smshutdown -t now -r’

The SMIA Configuration Tool will no longer appear in the FSM Home ->
Applications tab.

Stop SMIA

v Login to FSM GUI interface
v Go to Home -> Applications
v Click on Stop button under the SMIA Configuration Tool.

Configuring the Flex System CN4093 10Gb Converged
Scalable Switch

The Flex System CN4093 10Gb Ethernet, 8 Gb Fibre Channel (FC) converged
scalable switch provides features that meet the demands of a highly-virtualized
environment.

Note:

You can use either the Discover storage task in the management software web
interface or the mkdatasource command in the command-line interface to discover
a Flex System CN4093 10Gb Converged Scalable Switch. If you use the
mkdatasource command, you must register the switch using the /root/interop
namespace. Registrations using the /interop namespace will fail.

Whichever method you use, make sure that you use the IPv4 address of the switch
to discover it. If you use the IPv6 address, it might cause timeouts or failures when
attempting to connect.

For more information about configuring the CN4093 10Gb Converged Scalable
Switch, see the documentation that came with the device.

Discovering and managing a network switch
After you have completed the configuration and zoning of the switches, you must
discover and manage them with the Discover storage task in the IBM Flex System
Manager management software web interface.

About this task

Procedure

To manage and discover a network switch with the Discover storage task in the
web interface, complete the following steps:
1. From the Home page, click the Additional Setup tab.
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2. Click Manage System Storage. The Manage System Storage page is displayed.
3. Click Discover Storage Network Switches.
4. From the Select storage device type list, select FC Switch.
5. Specify the settings for the switch.

Note:

a. If you want to discover and manage a Flex System CN4093 10Gb
Converged Scalable Switch, make sure that you use the IPv4 address of the
switch to discover it. If you use the IPv6 address, it might cause timeouts or
failures when attempting to connect.

b. For SMI-S managed devices, use the IP address or host name of the SMI-S
provider. If you specify an SMI-S provider that manages multiple storage
components, all of the supported storage devices that the provider manages
are discovered.

c. The Automatically run inventory when discovering devices box is selected
by default. Unless you deselect the box, the management software will
collect inventory for the network switch after it is discovered.

6. Click Discover.
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Chapter 20. Managing and configuring storage

IBM Flex System Manager provides facilities to manage and configure storage
devices, such as disks, switches, internal RAID controllers, and RAID subsystems.
This includes the use of IBM Flex System Manager features, SMI-S providers, and
external storage applications.

Planning for storage management
To manage a few storage systems with IBM Flex System Manager, you must install
a piece of management software, or SMI-S agent, from a third party. Third-party
agents are not required for the following storage systems and devices: IBM Flex
System V7000, IBM DS8000, IBM XIV Storage System, IBM SAN Volume
Controller, IBM Storwize V7000, Storwize V3700, and Storwize V3500, and Flex
System FC3171 8Gb SAN Switch.

About this task

The management software has many different names: SMI-S CIM provider, storage
proxy, storage provider, or storage agent. It might also be referred to as the provider or
agent as well.

If your storage system requires an SMI-S CIM provider, print out this table and fill
out the information, then use it when installing the SMI-S CIM provider:

Table 77. Information to gather before installing an SMI-S CIM provider

Information needed Your information

Operating systems the SMI-S CIM provider can
run on, such as AIX or Windows

Review the storage system product information to
determine this.

Ports for the SMI-S CIM provider to use

Determine whether the default CIM ports are in use.
The default ports are 5988 (HTTP) and 5989
(HTTPS).

v If the default ports are available, use default ports
when installing the SMI-S CIM provider.

v If the default ports are not available, use
non-default ports when you install the SMI-S-CIM
provider. Typically, a second CIMOM installs on
port 15988 or 15989.

Storage management in real time and using configuration templates
Storage is managed in two ways: in real time and with the use of configuration
templates. When managing storage in real time, changes become effective
immediately, or in some cases at the next restart if a restart is required to have the
changes take effect. When managing storage using configuration templates, you are
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creating configuration templates that contain storage device definitions, but no
storage device is configured or altered. A configuration template must be deployed
in order to have its definitions take effect.

Many of the panels and their fields used to manage storage are similar whether
you are working with an actual storage device or a configuration template. When
providing detailed information about storage devices, you must be aware whether
you are changing a configuration template that can be used to deploy to the
storage device, or a making changes to the device itself in real time.

When working with a storage device in real time, the storage device is active and
connectivity to the device has been established. Also, the device has been
discovered and the system that the device is attached to is not locked or otherwise
unavailable. Changes made to the storage device, as it is displayed in the various
IBM Flex System Manager panels, become effective immediately when you click
Apply or Deploy. The device definitions are called configuration settings.

When working with configuration templates, you are providing definitions that
can be deployed on a storage device at some point in the future. Changes made in
the various IBM Flex System Manager panels, are really made to a configuration
template that contains the device definitions. When you click Save, the
configuration template is updated with your changes, but no storage device is
affected. If you want a configuration template to be deployed to a storage device,
you must do one of these things:
v Set up a configuration template or configuration plan to be automatically deploy,

which will then deploy when a device that matches it is discovered by IBM Flex
System Manager.

v Deploy the configuration template by selecting it from any panel that displays it,
and click Actions > Deploy.

Managing SMI-S providers
To use SMI-S providers with IBM Flex System Manager, you must install and
configure them. They are needed only for some devices.

SMI-S providers for IBM Flex System Manager
SMI-S providers must be installed and configured before IBM Flex System
Manager can manage certain storage devices.

Note: You cannot install the SMI-S providers on systems where the IBM Flex
System Manager or any agents are installed if the providers use ports that IBM
Flex System Manager uses. The default ports are 5988 and 5989 (http and https).

An SMI-S provider is a vendor-specific module that is used so that independent
management software, such as IBM Flex System Manager, can manage a vendor
device by using a standard interface that is based on the Common Information
Model (CIM) protocol.

IBM Flex System Manager recognizes certain storage devices that comply with the
Storage Management Initiative Specification (SMI-S). SMI-S is an industry standard
that was developed by the Storage Networking Industry Association (SNIA).

IBM Flex System Manager communicates with the storage devices through their
respective SMI-S providers. Their Service Location Protocol (SLPv2) component
enables the devices to be discovered by IBM Flex System Manager, which looks for
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SNIA-defined SLP service types. When the environment includes Chassis
Management Modules (CMM) or Integrated Management Modules (IMM), the
associated SMI-S providers are discovered by first discovering and collecting
inventory on the management modules. IBM Flex System Manager obtains
information about storage devices through the Common Information Model Object
Manager (CIMOM) component of the SMI-S provider. Communication occurs by
using the Distributed Management Task Force (DMTF) standard for Web-Based
Enterprise Management (WBEM) as required by SNIA. The information is
organized according to the DMTF standard for the Common Information Model
(CIM), using the profiles that are defined by SNIA.

When multiple SMI-S providers are installed on the same system, only one can use
the default port number. The other providers must be configured during
installation or be set up to use an alternative port number. When you add a
storage device whose provider is using an alternative port number to the IBM Flex
System Manager environment, you must specify the port number.

A storage provider is a module that performs the same tasks as an SMI-S provider,
but is not SMI-S compliant.

Storage devices that require an SMI-S provider
These storage devices require an SMI-S provider to work with IBM Flex System
Manager.
v IBM System Storage DS3000 devices
v IBM System Storage DS4000® devices
v IBM System Storage DS5000 devices

Note: The Flex System FC5022 16 Gb SAN Scalable Switch requires an SMI-S
provider, but the SMI-S provider is included as a preinstalled application with the
management software. See Running discovery and inventory for an IBM Flex
System FC5022 16 Gb SAN switch for more information.

For the Flex System Fabric CN4093 10 GB Converged Scalable switch, the storage
provider is embedded in the switch. There is no need to install anything. When
asked for the IP address of the SMI-S provider, use the IP address of the switch
itself.

Integrated RAID Controller devices use the IBM Flex System Manager Platform
Agent managed system. Run Inventory Collection on the Agent to get the
Integrated RAID Controller.

Applicable standards

For information about the previously mentioned standards, see these websites:

SMI-S http://www.snia.org/forums/smi/tech_programs/smis_home

SNIA https://www.snia.org

DMTF
www.dmtf.org

WBEM
www.dmtf.org/standards/wbem/

CIM www.dmtf.org/standards/cim
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Where to obtain SMI-S providers
Use the following information to obtain SMI-S providers for any IBM System
Storage DS3000, DS4000, or DS5000 devices, and IBM System Storage N series
N3600 devices. You can also use the information to obtain providers for various
switches used to manage storage devices.

IBM System Storage DS3000, DS4000, or DS5000

The SANtricity SMI Provider from NetApp that complies with SMI-S
version 1.4 is required to enable discovery of IBM System Storage DS3000,
DS4000, or DS5000 devices. You can obtain this provider from the NetApp
SMI-S and VDS/VSS Providers for E-Series OEM Storage Systems website
at http://support.netapp.com/apbu/oemcp/protcd/ (registration
required). It is recommended to use the 10.19.GG.xx version of this
provider for this version of IBM Flex System Manager. Any other version
might not function as well.

Note:

v To access the previously specified NetApp web page, you must first
register as a Guest User on the NetApp site. After successfully
registering or signing in as a NetApp Guest User, click the previously
specified link to access the download page.

v You can manually add an IBM System Storage DS3000, DS4000, or
DS5000 device by using IBM Flex System Manager. To manually add
those devices, specify the IP address of the system where you installed
the SANtricity SMI Provider, not the IP address of the IBM System
Storage DS3000, DS4000, or DS5000 device itself.

IBM System Storage N series N3600
You can obtain the ONTAP SMI-S provider for the IBM System Storage N
series N3600 from NetApp Data ONTAP SMI-S Agent website at
http://www.netapp.com/us/company/leadership/industry-standards/
smi-s-agent.html. It is recommended to use the 3.0.2 version of this
provider for this version of IBM Flex System Manager. Any other version
might not function as well.

Note: To download the provider, you must first register as a Guest User
on the NetApp site. The NetApp Data ONTAP SMI-S Agent website
provides the necessary instructions.

Use of IP addresses with SMI-S providers
When you use IP addresses with SMI-S providers, consult this table to determine if
both IPV4 format and IPV6 format addresses are acceptable, or if only IPV4 format
can be used.

Table 78. IP address formats used with SMI-S providers

SMI-S provider Devices controlled IP address format accepted

NetApp ESC SMI-S
providers 10.10.G5.02,
10.19.GG.xx

IBM System Storage
DS4000
IBM System Storage
DS3200
IBM System Storage
DS3300
IBM System Storage
DS3400

IPV4 and IPV6
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Configuring SMI-S providers
SMI-S providers must be configured in order to work with your storage systems.
SMI-S providers are used to add or remove devices associated with the SMI-S
provider, from within IBM Flex System Manager.

Before you begin

Configuration information and requirements for specific SMI-S providers vary by
provider and release. They are found in the 'Readme' or similar files that ship with
the SMI-S provider. Read these files and set up your environment according to the
instructions. It is crucial for all of the specified requirements to be met, so that IBM
Flex System Manager can properly manage the storage devices.

Configuring the SMI-S provider for IBM System Storage DS3000,
DS4000, and DS5000
The SMI-S provider for the IBM System Storage DS3000, DS4000, and DS5000 must
be configured before it can be used.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

To configure this SMI-S provider, follow these steps:

Procedure
1. Click Resource Explorer > Groups > Groups by System Type > Storage

Systems. A table of storage groups is displayed.
2. Select the group named SMI-S Providers.
3. Click Actions > View Members. A list of systems is displayed.
4. Select a system that hosts an SMI-S provider for the IBM System Storage

DS3000, DS4000, and DS5000 Controller Module.
5. Click Actions > System Configuration > SMI-S Provider Configuration > IBM

DS3000/4000/5000. The SMI-S Provider Configuration page is displayed.
6. Click Actions > Add Storage System.
7. Choose one of these options:
v Click Select a Storage System that has already been discovered, then click

Browse to see a list of existing, discovered IBM System Storage DS3000,
DS4000, and DS5000 storage systems.

v Click Enter storage system information manually and enter the IP addresses
for the primary and secondary controllers.

8. Specify the user ID and password for the management port. The user ID and
password were specified when you enabled authentication for the provider.

9. Click OK to save the changes.
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Enabling Authentication for the NetApp SMI-S provider
After this SMI-S provider is installed, review your authentication settings and
make any necessary changes.

Before you begin

This SMI-S provider is shipped with authentication disabled. It is available to be
enabled only if the SMI-S provider and CIMOM packages were installed together.
If you install the SMI-S provider into an existing CIMOM, this CIMOM is
responsible for authentication.

About this task

For authentication instructions, see the installation manual that is downloaded
with the provider.

What to do next

Now that the authentication is enabled, you must verify this SMI-S provider.

Verifying the NetApp SMI-S provider:

Once you have enabled authentication, verify the installation and configuration of
this SMI-S provider.

About this task

To verify the NetApp SMI-S provider, complete the following steps:

Procedure

1. Open a command window.
2. Issue this command: cd C:\program files\EngenioProvider\wbemservices\

bin.
3. Issue this command: cimworkshop. The Login page is displayed.
4. Authentication is not enabled by default, so enter anything for the user ID

and password. A page with the /interop directory tree is displayed.
5. Change /interop to Isissi11:
6. Click Actions > Find Class. An Input pop-up is displayed requesting the

name of the class to find.
7. Type the name CIM_ComputerSystem.
8. Click OK.
9. Wait for the search to complete. A directory tree with the

CIM_ComputerSystem entry is displayed.
10. Right click on the entry LSISSI_StorageManagementSystem.
11. Click Show Instance. A list of instances is displayed.
12. If you see a list of instances, then the NetApp SMI-S provider has been

successfully installed and configured.
13. Optional: If you do not see any instances:

a. First retry the steps in this task carefully.
b. Check the IP addresses inside the arrayhosts.txt file in the

..\EngenioProvider\SMI_SProvider\bin directory, and make sure that
they are the IP addresses of the storage subsystem controllers.
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c. If that does not resolve the problem, contact your service provider.

Enabling Authentication for the NetApp SMI-S provider (Version
10.19.GG.xx)
After this SMI-S provider is installed, review your authentication settings and
make any necessary changes.

About this task

To enable authentication, follow the procedure indicated in the documents that are
included with the provider. To download the provider, use the instructions listed
for IBM System Storage DS3000, DS4000, or DS5000 in Where to obtain SMI-S
providers.

Discovering and collecting inventory for storage devices
Storage devices including disks, switches and storage controllers must be
discovered. The systems that these devices are attached to must have inventory
collection run. For IBM Flex System Manager chassis-mounted Fibre Channel
switch discovery, use CMM auto discovery.

Running Discovery and unlocking storage devices using
SMI-S providers

Run Discovery for your storage devices before you can view or make changes to
them. This topic describes a basic discovery procedure.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

Note: Before you run discovery for your storage devices by using an SMI-S
provider, you must install and configure the provider. For more information about
storage devices that require SMI-S providers and for instructions about how to
install and configure the providers, see the related reference topic, Managing SMI-S
providers.

The procedure works by using an IP address for an SMI-S Provider, under the
assumption that systems that have access to the SMI-S Provider are those systems
that have the storage that the SMI-S Provider controls. To run System Discovery
for systems that have an SMI-S Provider, complete the following steps:

Note: If your environment includes Chassis Management Modules (CMM) or
Integrated Management Modules (IMM), before you discover storage devices that
have SMI-S providers, you must discover, request access to, and collect inventory
for the management modules. For more information, see “Discovering IMMs for
managing and updating physical servers.”
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Procedure
1. From the Initial Setup tab of the Home page click System Discovery. The

System Discovery page is displayed.
2. Click Single system (IP address).
3. Type the IP address of the storage provider in the IP address field.
4. Click Discover.
5. Wait for the task to complete. A table of systems that have this SMI-S Provider

is displayed.
6. Select a system. An entry for this system is displayed.
7. If the Access field indicates No Access:

a. Click the No Access link.
b. Type a user ID and password for the system. (The user ID and password

that are needed are most likely the same as the operating system user ID
and password.)

c. Click Request Access.

Access to the system is established.
8. From the Resource Navigator, a list of storage devices is displayed along with

the system that was discovered.

Running Direct Connection discovery and unlocking storage
devices using SMI-S providers

Discover storage devices by searching for systems that have the SMI-S provider for
that type of storage. This topic describes an advanced discovery procedure.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

Note: Before you run discovery for your storage devices by using an SMI-S
provider, you must install and configure the provider. For information about
storage devices that require SMI-S providers and for instructions about how to
install and configure the providers, see the related topic, “Managing SMI-S
providers”.

The procedure works by using an IP address for an SMI-S provider, under the
assumption that systems that have access to the SMI-S provider are those systems
that have the storage that the SMI-S provider will access.

To run system discovery for systems that have an SMI-S provider, follow these
steps:
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Procedure
1. From the Discovery Manager summary page, click System Discovery. The

System Discovery page opens.
2. Under Advanced Tasks, click Create new profile. The Discovery Profile wizard

starts. Specify the following values:
v On the Profile Properties page, for Resource type, select Operating System.

SMI-S providers are viewed as if they were operating systems.
v On the SMI-S Configuration page, specify these values:

– Select Direct Connection as the type of SMI-S discovery.
– Accept the default port number unless it is already in use. .

3. The new profile is listed on the Discovery Profiles table.
4. Select the new profile and click Run. The Launch Job window opens. You can

run the task now or schedule it for later.
5. When you run the task, monitor its status. It could take a long time.
6. If you selected Request access later on the Access Request page in step 2,

access the systems after the task completes.
a. Open the SMI-S Providers storage group by clicking Resource Explorer >

Groups by System Type > Storage Systems > SMI-S Providers.
b. Select a system. The Access field indicates No Access. Click No Access.
c. Enter a user ID and password for the system.
d. Click Request Access.

Access to the system is established.
7. From the Resource Navigator, a list of storage devices is displayed along with

the system that was discovered.

Running System Discovery for multiple SMI-S providers using
multicast and broadcast

Using multicast and broadcast, multiple SMI-S providers can be discovered at the
same time.

Before you begin

The Service Location Protocol (SLP) is used for SMI-S multicast and broadcast
discovery. SLP is used for clients to locate servers and other services on the
network. This procedure uses two advanced SLP methods (multicast and
broadcast) to find all SMI-S providers, and it performs the following actions:
v Sends an SLP request to the default multicast group
v Sends an SLP request to the broadcast group
v Using these two functions, trys to find all your SMI-S providers

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:
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To run system discovery for multiple SMI-S providers by using multicast and
broadcast, complete the following steps:

Procedure
1. From the Initial Setup tab of the Home page, click System discovery. The

System Discovery page is displayed.
2. In the Advanced Tasks area, click Create new profile. The Discovery Profile

wizard is displayed.
3. If you see the Welcome page:

a. Clear Show this Welcome page next time if you do not want to see the
Welcome page next time.

b. Click Next.

The Profile Properties page is displayed.
4. Type a name for the Discovery profile that you are creating.
5. Select a resource type of Operating System. SMI-S providers are viewed as if

they were operating systems.
6. Select a resource subtype of All.
7. Type a description of the new profile.
8. Click Next. The Protocol selection page is displayed.
9. Click Storage Management Initiative Specification (SMI-S) Discovery.

10. Click Next. The SMI-S Configuration page is displayed.
11. Select the type of discovery. Click Multicast and broadcast.
12. Click Enable multicast.
13. Click Enable general broadcast.
14. Choose a timeout period of 60 seconds.
15. Click Next. The Access Request page is displayed.
16. Optional: Click Request access later. Because multiple SMI-S providers are

discovered, it is not advisable to automatically request access to the
discovered systems. Unless all discovered SMI-S providers have the exact
same user ID and password, the access request fails.

17. Click Next. The Inventory Discovery page is displayed.
18. Click Discover (collect) inventory later.
19. Click Next. The Summary page is displayed.
20. Carefully examine the discovery information that is on the Summary page.

v If everything is correct, click Finish to create the profile.
v If something must be corrected, click Back or select the page to return to

from the navigation area.

A table of discovery profiles is displayed, with an entry for the new profile
that you created.

21. Select this profile and click Run. A scheduler window is displayed below the
table of profiles.

22. Choose to run the task now, or specify options for running later.
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23. Click OK.
24. Monitor the status of this job. It could potentially take a long time.
25. To see the systems with SMI-S Providers as they are discovered, click

Resource Explorer > Groups > All Systems. As the systems with SMI-S
providers are discovered, they are added to the All Systems group.

Collecting inventory for devices managed by IBM Tivoli
Storage Productivity Center

Using IBM Tivoli Storage Productivity Center with IBM Flex System Manager
makes it easy to retrieve the latest inventory data for all devices that are managed
by IBM Tivoli Storage Productivity Center.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

Discovering and running inventory against a Storage Farm (which represents the
IBM Tivoli Storage Productivity Center server) causes Flex System Manager to
fully populate all of the devices that are managed by IBM Tivoli Storage
Productivity Center, including Fibre Channel switches and storage subsystems.
Running inventory against the Storage Farm retrieves only the existing inventory
information from the IBM Tivoli Storage Productivity Center server. Collecting
inventory also discovers new devices after the data sources are added and removes
devices after the data sources are deleted.

Running inventory against a specific device uses an IBM Tivoli Storage
Productivity Center probe to retrieve the most current configuration changes for
the device. In this case, running inventory also updates both the associated Flex
System Manager inventory data and the IBM Tivoli Storage Productivity Center
server.

Any time configuration changes are made to managed devices outside of Flex
System Manager, you must run inventory on a specific device to update the
associated inventory.

Note: You can collect inventory for only one device in a Storage Farm at a time.
Collecting inventory at the same time for multiple devices that are managed by
IBM Tivoli Storage Productivity Center is not supported.
After a modifying the configuration for a device that is managed by IBM Tivoli
Storage Productivity Center, running inventory against that device causes the IBM
Tivoli Storage Productivity Center server to update the device configuration. (For
example, configuration modifications might be modifying a zoning configuration
on a fabric switch or creating a storage volume on a storage subsystem.) After that
process completes, Flex System Manager retrieves and displays the updated
inventory data.
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Procedure
1. Navigate to the device managed by IBM Tivoli Storage Productivity Center for

which you want to collect inventory.
2. Right-click the name of the device, then select Inventory > View and Collect

Inventory. The View and Collect Inventory page is displayed.
3. On the View and Collect Inventory page, make sure that the selected profile is

All Inventory, then click Collect Inventory. The View and Collect Inventory
page dynamically updates the information for the device.

Running discovery and inventory for an IBM Flex System
Manager chassis-mounted Fibre Channel switch

You must run discovery for your storage and switch devices before you can view
or change them. This is a basic discovery procedure that uses CMM auto discovery.
Follow these steps to discover chassis-mounted Fibre Channel switches, including
the FC3171 8Gb SAN switch.

About this task

Note:

This topic describes how to access this task in the IBM Flex System Manager Web
user interface. If you are using the IBM FSM Explorer, use the finder at the top of
the user interface (shown here) to locate this task:

Note: For instructions to discover a FC5022 16Gb SAN switch, see this topic:
“Discovering a Flex System FC5022 16 Gb SAN switch with the management
software” on page 610.

To discover and run inventory for the FC3171 switch, use the management
software web interface to complete the following steps:

Procedure
1. From the Home page, click the Additional Setup tab.
2. Click Manage System Storage. The Manage System Storage page opens.
3. Click Discover Storage Network Switches. The Discover Storage page opens.
4. From the Select storage device type list, select FC Switch. The applicable

settings fields for a Fibre Channel switch are displayed.
5. Complete the fields for the switch settings, including the IP address of the

switch; then, click Discover. The Automatically run inventory when
discovering devices box is selected by default. Unless you deselect it, the
management software will collect inventory for the switch automatically after it
has been discovered.

What to do next

After the FC3171 switch is discovered, you can configure it for operating-system
deployment. See the PDF document for Configuring the IBM Flex System FC3171
8Gb SAN switch in Configuring hardware before installing operating systems.
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Discovering a Flex System FC5022 16 Gb SAN switch with the
management software

Before you can integrate and manage an FC5022 16 Gb SAN switch with the
management software in an IBM Flex System environment, the FC5022 switch
must be discovered and inventoried by the IBM Flex System Manager management
software.

For VMControl and Storage Control to work with the FC5022 switch, you must
launch the SMIA Configuration Tool application so that the management software
can access the required SMI-S agent for the FC5022 switch. The SMIA
Configuration Tool application is preinstalled with the management software, and
you can start it and stop it from the management software web interface.

Important: Before the FC5022 switch can be discovered and inventoried it must be
zoned, and then configured with the SMIA Configuration Tool, as described in
Setting SNMP credentials for the Flex System FC5022 16Gb SAN Switch and
Discovering an IBM Flex System FC5022 16Gb SAN switch with the SMIA
Configuration Tool.

After the switch is zoned and configured, you can use the Discover storage
network switches task on the Manage System Storage page to discover and
inventory the switch. To discover and run inventory for the FC5022 switch, use the
management software web interface to complete the following steps:
1. From the Home page in the management software web interface, click the

Plug-ins tab.
2. From the Plug-ins tab, under Storage Management, click Discover Storage. The

Discover Storage page opens.
3. From the Select storage device type list, select FC Switch.
4. Specify the settings for the switch:

a. In the SMI-S address or host name field, type the IPv6 address for your
management node farm.

Note: You can find this IPv6 address from multiple places in the web
interface. From the Chassis Manager page, under General Actions, click
Resource Explorer > All Systems; then, find the resource with the fsm host
name and Farm in the Type column. The IP address for the farm is
displayed.

b. In the Port field, delete the default value 5989, and type 25989.
c. In the Username and Password fields, type your management software user

ID and password.
d. Click Discover.

5. After discovery is complete, you must collect inventory for the management
node farm:
a. From the Chassis Manager page, under General Actions, click Resource

Explorer. The Resource Explorer page is displayed.
b. Click All Systems.
c. Click the resource with the management node hostname and Farm in the

Type column. The properties page for the farm is displayed.
d. Click the Inventory tab; then, click Collect Inventory. The Launch Job

window opens.
e. Click OK to collect inventory immediately, or schedule the job for later.
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After the FC5022 switch is discovered, you can configure it for operating-system
deployment. See the PDF document for Configuring the Flex System FC5022 16 Gb
SAN switch in Configuring hardware before installing operating systems.

For more information about discovery and inventory for other Fibre Channel
switches, see Running discovery and inventory for an IBM Flex System Manager
chassis-mounted Fibre Channel switch.

Working with external storage applications
Use an external storage management application to configure, control, and
maintain certain storage devices and their connectivity to your network. If the
necessary external storage management applications are not already installed,
consult the appropriate documentation to acquire and install them.

Before you begin

The external storage management application to be run must be installed or
accessible. You must run inventory collection on the storage devices before you can
launch an external storage management application for those storage devices.

About this task

The management software uses IBM Tivoli Storage Productivity Center for
SAN-attached devices.

The External Storage Applications page is built based on the inventory of your
storage devices. The applications are displayed only if your inventory has storage
devices that can be managed by these applications.

All of the external storage applications except IBM Tivoli Storage Productivity
Center can be launched after you select a target resource.

Installing and configuring external storage applications
Storage systems management uses some storage applications, which must be
installed and configured prior to managing storage devices.

Installing and configuring IBM Tivoli Storage Productivity Center
If you want to use IBM Tivoli Storage Productivity Center with IBM Flex System
Manager, IBM Tivoli Storage Productivity Center must be installed and properly
configured. You can either use an existing installation of IBM Tivoli Storage
Productivity Center or you can download IBM Tivoli Storage Productivity Center
Limited Edition.

Before you begin

About this task

Note: When you are running IBM Flex System Manager 6.3.2, it is recommended
to use IBM Tivoli Storage Productivity Center 4.2.2.143. A lower version is not
recommended, although any higher 4.2 version is compatible with Flex System
Manager.

To install and configure IBM Tivoli Storage Productivity Center, complete the
following steps:
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Procedure
1. Download IBM Tivoli Storage Productivity Center Limited Edition from the

Passport Advantage® web page.

Note: Your company must have a Passport Advantage contract to download
from Passport Advantage. If you are not enrolled, see this web page for
instructions: How to enroll.

2. For instructions on how to install IBM Tivoli Storage Productivity Center, see
the IBM TotalStorage Productivity Center Installation and Configuration Guide.

Notes:

v The directory to which you extract the IBM Tivoli Storage Productivity
Center code for installation and the directory where you choose to install
IBM Tivoli Storage Productivity Center both have a limit of 60 characters in
the path name.

v The source directory from which IBM Tivoli Storage Productivity Center is
installed cannot have a hyphen character (-) anywhere in the path name.

3. If IBM Tivoli Storage Productivity Center is installed on the same system as
IBM Flex System Manager, you must configure SNMP trap forwarding between
IBM Flex System Manager and IBM Tivoli Storage Productivity Center.

Configuring SNMP trap forwarding for IBM Tivoli Storage
Productivity Center
If IBM Tivoli Storage Productivity Center is installed on the same system as IBM
Flex System Manager, you must configure SNMP trap forwarding between IBM
Flex System Manager and IBM Tivoli Storage Productivity Center.

About this task

You do not need to configure SNMP trap forwarding if IBM Flex System Manager
and IBM Tivoli Storage Productivity Center are installed on different systems.

Complete the following steps to forward SNMP traps without modification:

Procedure
1. Using a text editor, edit a file named SNMPServer.properties in the

IBM\Director\data\snmp directory.
2. To forward SNMPv1 traps:

a. Remove the # character at the beginning of this line:
#snmp.trap.v1.forward.address.1=

b. Type the IP address of the SNMPv1 trap destination after the equal sign (=).
This is the IP address of the local system where IBM Flex System Manager
and IBM Tivoli Storage Productivity Center are installed.

c. Remove the # character at the beginning of this line:
#snmp.trap.v1.forward.port.1=

d. Type the port number of the SNMPv1 trap destination after the equal sign
(=). It is recommended that you use port 22162.

3. To forward SNMPv2 traps:
a. Remove the # character at the beginning of this line:

#snmp.trap.v2.forward.address.1=
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b. Type the IP address of the SNMPv2 trap destination after the equal sign (=).
This is the IP address of the local system where IBM Flex System Manager
and IBM Tivoli Storage Productivity Center server are installed.

c. Remove the # character at the beginning of this line:
#snmp.trap.v2.forward.port.1=

d. Type the port number of the SNMPv2 trap destination after the equal sign
(=). It is recommended that you use port 22162.

4. Save the file.
5. Stop and restart IBM Flex System Manager.
6. Using the tpctool command line, type the following command:

setdscfg -user id -pwd pw -url hostname:9550 -property SnmpTrapPort port

where hostname is the fully qualified host name of the system where the IBM
Tivoli Storage Productivity Center server is installed, id is a valid user name on
that system, pw is the password for that user, and port is the same port number
to which you configured IBM Flex System Manager to forward traps. It is
recommended that you use port 22162.

7. Stop and restart the IBM Tivoli Storage Productivity Center server.

Installing and configuring IBM DS Storage Manager for DS4000
To use the IBM System Storage DS4000 devices, you must obtain the latest version
of IBM DS Storage Manager for DS4000. This application can also be used for IBM
DS3000 and DS5000 devices.

About this task

To install and configure the IBM DS Storage Manager for DS4000, complete the
following steps:

Procedure
1. Go to the DS4000 Storage Manager product Web site and select System Storage

> Disk systems > Mid-range Disk systems to download the IBM DS Storage
Manager for DS4000.

2. Configure IBM DS Storage Manager for DS4000 according to the instructions
found on the Web site, and any Readme or similar files that you find.

Discovering a Flex System FC5022 16Gb SAN switch with the
SMIA Configuration Tool
For VMControl and Storage Control to work with the FC5022 16Gb SAN switch,
you must start the SMIA Configuration Tool application so that the management
software can access the required SMI-S agent for the FC5022 switch. You can also
use this information to add a System Storage SAN24B-4 Express switch as a
top-of-rack Fibre Channel switch in your environment.

The SMIA Configuration Tool application is preinstalled with the management
software, and you can start it, stop it, and launch its administration console from
the management software web interface.

Important:

v Before you complete the following steps, make sure that you have completed the
procedure that is described in Setting SNMP credentials for the Flex System
FC5022 16Gb SAN Switch.
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v You can also use the following procedure to discover and add the System
Storage SAN24B-4 Express switch to your environment.

v The SMIA Configuration Tool requires Oracle JRE. Refer to the table that lists the
JRE versions required for the various SMIA Configuration Tool versions for your
FSM installation, on the following page: Troubleshooting the SMIA
Configuration Tool

To start the SMIA Configuration Tool, launch the tool, and configure the tool for
the FC5022 switch, complete the following steps:
1. Start the SMIA Configuration Tool:

a. Log in to the management software web interface.
b. From the Home page, click the Applications tab.
c. Under SMIA Configuration Tool, click Start.

Note: The tool should begin running in less than 10 minutes. You must
refresh the browser to see the updated status Running.

2. Launch and configure the SMIA Configuration Tool administration console:
a. After the status displayed for the tool is Running, click Launch

administration console. The SMIA Configuration Tool Log In window
opens, and displays the IP address and hostname of the management node.

Note: Make sure that the hostname for the computer on which the SMIA
tool client is running (in the hosts file) matches the hostname of the
management node. If you must change the hostname that is stored in the
local hosts file, see for more information.

b. Log in with your management software user ID and password. The SMIA
Configuration Tool administration console opens, and the Home tab is
displayed.

c. From the Home tab in the console, click Options.
d. In the Category box, click Software Configuration > Product

Communication.
e. Set the communication protocol to match the one being used by the Flex

System FC5022 16Gb SAN Switch.

Important: The Flex System FC5022 16Gb SAN Switch and IBM Network
Advisor support both HTTP and HTTP Secure (HTTPS). The SMIA
Configuration Tool setting must match the protocol being used by the Flex
System FC5022 16Gb SAN Switch. If the protocols do not match, you might
receive a 403 authentication failure message when you attempt a fabric
discovery of the switch.

f. Click Apply; then, click OK.
g. Return to the Applications tab in the management software web interface,

and click Stop under SMIA Configuration Tool.

Note: The SMIA Configuration Tool console window closes when the tool is
stopped from the management software.

h. Click Start to restart the SMIA Configuration Tool.
3. Discover the switch with the SMIA Configuration Tool:

a. After the status displayed for the tool is Running, click Launch
administration console. The SMIA Configuration Tool Log In window is
displayed.
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b. Log in with your management software user ID and password. The SMIA
Configuration Tool administration console opens, and the Home tab is
displayed.

c. From the Home tab in the console, click Fabric Discovery. The Discover
Fabrics window is displayed.

d. Click Add. The Add Fabric Discovery window is displayed.
e. On the IP Address tab of the Add Fabric Discovery window, complete the

following steps:
1) For the SNMP Configuration setting, select Manual.
2) In the Fabric Name field, type a name.
3) In the IP Address field, type the IPv6 address of the switch.
4) In the User ID and Password fields, type the user ID and password of

the switch.
f. Click the SNMP tab; then enter the parameters that you set when you

completed the procedure in Setting SNMP credentials for the Flex System
FC5022 16Gb SAN Switch:
1) In the User Name field, type the user name (for example, snmpadmin3).
2) Leave the Context Name field empty.
3) For the Auth Protocol setting, select SHA.
4) In the Auth Password field, type the authentication password.
5) For the Priv Protocol setting, select DES.
6) In the Priv Password field, type the privacy password.

g. Click OK. If the switch is discovered, the Discover Fabrics window displays
a check beside FC5022.

4. Follow the steps in Discovering a IBM Flex System FC5022 16Gb SAN switch
with the management software to discover and manage the switch with the
management software.

For troubleshooting information for the SMIA Configuration Tool, see
Troubleshooting the SMIA Configuration Tool.

If you need to change the administrative user ID and password for the SMIA
Configuration Tool, see Changing the SMIA Configuration Tool user ID and
password.

For more information about configuring zones for switch, see the PDF document
for Configuring the Flex System FC5022 16Gb SAN switch in Configuring hardware
before installing operating systems.

Changing the SMIA Configuration Tool user ID and password
The SMIA Configuration Tool application provides the SMI-S agent that is required
by the Flex System FC5022 16Gb SAN switch. SMIA comes preinstalled with the
management software, and is configured to use the management software system
user ID and password that were set during the initial setup of the management
node. Use this information to change the SMIA user ID and password after the
initial management node setup.

Important:

v The Flex System FC5022 16Gb SAN Switch supports only HTTP Secure (HTTPS),
but the default protocol for the SMIA Configuration Tool is HTTP. After you
launch and log in to the SMIA Configuration Tool, change the default protocol
setting from HTTP to HTTPS.
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v Sometime after initial setup of the management node, the management software
system password must be changed. However, the SMIA user ID and password
will not be changed automatically with the system ID and password.

To change the SMIA user ID and password, complete the following steps:
1. Open a management software CLI prompt and log in.
2. Use the lsdatasource command to list the datasources from Storage Control

management, as shown in the following example.
smcli lsdatasource

3. Use the rmdatasource command to remove the switch from Storage Control
management, as shown in the following example.

Note: This example does not show all of the possible options for the
rmdatasource command. For more information about the command, see
rmdatasource.
smcli rmdatasource -t https -i <IP_address> -p <port_number>

where <IP_address> and <port_number> are the IP address and port of the
switch.

4. Log in to the management software web interface.
5. From the Home page, click the Applications tab.
6. Under SMIA Configuration Tool, click Launch administration console. The

SMIA administration console window opens.

Note:

a. If this is the first time you launch the tool, you must download it before
you can use it. If necessary, confirm the browser security exceptions, and
the application downloads.

b. The SMIA Configuration Tool is a component of IBM Network Advisor. The
download progress window and other interface elements might be labeled
as IBM Network Advisor, but the SMIA Configuration Tool provides only a
subset of full Network Advisor functionality.

7. Log in to the console; then, use the console to change the administrator user ID
and password.

Important: If this is the first time you launch the tool, you must change the
default protocol setting from HTTP to HTTPS after you log in. The Flex System
FC5022 16Gb SAN Switch supports only HTTP Secure (HTTPS), but the default
protocol for the SMIA Configuration Tool is HTTP.

Note: If you cannot log in to the SMIA Configuration Tool, see .
8. From the management software CLI prompt, use the mkdatasource command to

reestablish management of the switch, as shown in the following example.

Note: This example does not show all of the possible options for the
mkdatasource command. For more information about the command, see
mkdatasource.
smcli -user USERID -pw Passw0rd mkdatasource -c fabric -i <IP_address>
-t https -p 25989 -u USERID -w Passw0rd -n /interop

where <IP_address> is the IP address of the management node.

Note: Port 25989 is the default port number of the SMIA Configuration Tool.
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For more information about discovering and collecting inventory for the FC5022
switch, see Running discovery and inventory for an IBM Flex System FC5022 16Gb
SAN switch.

For more information about configuring zones for switch, see the PDF document
for Configuring the Flex System FC5022 16Gb SAN switch in Configuring hardware
before installing operating systems.

Re-discovering the Flex System FC5022 16Gb SAN switch after
changing the switch IP address
Use this procedure to re-discover the FC5022 after you change the IP address for a
Flex System FC5022 16Gb SAN switch.

Important: The Flex System FC5022 16Gb SAN Switch supports only HTTP Secure
(HTTPS), but the default protocol for the SMIA Configuration Tool is HTTP. After
you launch and log in to the SMIA Configuration Tool, change the default protocol
setting from HTTP to HTTPS.

To re-discover an FC5022 switch after you have changed the switch IP address,
complete the following steps:
1. Log in to the management software web interface.
2. From the Home page, click the Applications tab.
3. Under SMIA Configuration Tool, click Launch administration console. The

SMIA administration console window opens.
4. Log in to the console.

Note: If you cannot log in to the SMIA Configuration Tool, see .
5. From the Home tab, click Fabric Discovery.
6. From the Discovered Fabrics table, select the FC5022 switch; then, click Delete.
7. To confirm that the switch you selected is the switch that you want to delete,

click Yes. The switch is deleted.
8. Click Add.
9. When you are prompted, enter the name, new IP address, user ID, and

password for the switch. The switch is now configured in SMIA with the new
IP address.

If you need to change the administrative user ID and password for the SMIA
Configuration Tool, see Changing an SMIA Configuration Tool user ID and
password.

For more information about configuring zones for switch, see the PDF document
for Configuring the Flex System FC5022 16Gb SAN switch in Configuring hardware
before installing operating systems.

Launching an external storage management application
Use an external storage management application to configure, control, and
maintain certain auxiliary storage devices and their connectivity to your network.

About this task

To launch an external storage management application for a specific resource,
complete the following steps:
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Procedure
1. Select a storage resource from the Resource Navigator.
2. Depending on the type of device, choose the correct external storage

application:
v Click Actions > Launch IBM Storwize V7000 Element Manager for IBM

Storwize V7000 devices.

Note: Before you start the IBM Tivoli Storage Productivity Center managed
IBM Storwize V7000, run the smcli mksvcsshrsap -s <device name> -u
<user> -f <ssh key> -r <passphrase> command and collect inventory to
establish an ssh RSAP connection. For more information, see the
mksvcsshrsap command.

v Click Actions > Launch IBM SAN Volume Controller for IBM SAN Volume
Controller devices.

v Click Actions > Launch IBM DS4000 Storage Manager for IBM DS3000,
DS4000, and DS5000 devices.

v Click Actions > Launch IBM N Series Data ONTAP.

The external storage application starts, but you can perform only those tasks
that are related to the chosen resource.

Note: If you are trying to launch these tasks from the Mozilla Firefox web
browser and the task does not start, you might need to enable pop-up
windows.
a. Look for a message toward the top of the window that says “Firefox

prevented this site from opening a pop-up window.”
b. Click Options at the end of the message line.
c. Select Allow pop-ups for ip_address.
d. Launch the task again.

3. Log in to the application and complete all necessary tasks.
4. When you are finished with the application, close the application window.

What to do next

As an alternative, you can launch the external storage applications without
selecting a target resource. From the IBM Flex System Manager Web interface,
select System Configuration > External Storage Applications. The External
Storage Applications page is displayed. Select the application from this page. This
alternative method is the only way to launch the IBM Tivoli Storage Productivity
Center.

Requirements for IBM Tivoli Storage Productivity Center
These requirements must be met when using IBM Tivoli Storage Productivity
Center with IBM Flex System Manager.

IBM Tivoli Storage Productivity Center must be:
1. Version 4.1 or later
2. Launched from one of these operating systems: Windows, AIX, or Linux

Automatic installation is not supported.

For launching IBM Tivoli Storage Productivity Center in an untargeted fashion (for
example, from the External Storage Application page), IBM Tivoli Storage
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Productivity Center must be installed on the same system that the user is running
the client browser session (the browser they are using to connect to IBM Flex
System Manager).

For more information, see the IBM Tivoli Storage Productivity Center Web site:
www-03.ibm.com/systems/storage/software/center/.

Requirements for IBM DS Storage Manager
These requirements must be met when using IBM DS Storage Manager with IBM
Flex System Manager.

IBM DS Storage Manager must meet these requirements:
v It must be launched from one of these operating systems: Windows, AIX, or

Linux.
v Only version 10.60.g5.16 or earlier is supported. To determine the recommended

version for each disk system, see the documentation for DS Storage Manager.

IBM DS Storage Manager must be installed on the same system that is running the
client browser session (the browser used to connect to IBM Flex System Manager).

Automatic installation is not supported.

IBM DS Storage Manager is used for DS5000, DS4000, and DS3000 disk systems.

If you try to invoke IBM DS Storage Manager and it is not found, you will see a
page with installation instructions.

For IBM DS Storage Manager, only version 10.60.g5.16 or earlier is supported. If
you have trouble launching a later version, refer to the appropriate troubleshooting
topic.

For more information, see the IBM Support Portal. Use the Quick find feature to
specify your disk system, then click the Documentation tab.

Viewing storage devices
You can view storage devices from a number of different perspectives, such as
storage groups, the devices attached to a given system, a list of storage volumes, a
list of discovered storage devices, System status and health of storage systems, and
a topology view for a particular device.

Storage Management Summary
Your storage devices can be viewed and managed in one central location. The
Storage Management Summary page provides an introduction to your storage
systems. The Storage Management Summary is invoked from the Plug-ins tab of
the Home page.

The Storage Management Summary page gives high-level details about your
storage systems, and links to the tasks that provide more detail and administer the
storage devices. You can also install a trial version of IBM Flex System Manager
Storage Control by following a link on this page.

Discovery and inventory collection must be run before you can display storage
systems. The Storage Management Summary page is divided into these areas:

638 Systems Management Guide

http://www-03.ibm.com/systems/storage/software/center/
http://www-947.ibm.com/support/entry/portal/!ut/p/c5/


Try IBM Flex System Manager Storage Control 
For more information about Storage Control, see the IBM Flex System
Manager Storage Control information center.

Capacity Summary
A pie chart represents your disk capacity in each of these categories.

Total configured capacity (to volumes)
Number of GB of the volumes that are assigned.

Total available capacity (for volumes)
Number of GB of disk pool size that is unassigned to volumes, but
are available for creating future new volumes.

This the space available for creating future new volumes. Total
available capacity represents the remaining total storage array or
storage pool space that could be used to create volumes. Initially,
when creating a storage array or pool, the configured capacity is
zero and the available capacity is the pool size. Creating additional
volumes decreases the amount of available capacity. Available
capacity is a measurement of the current quantity of usable
storage.

The capacity measurement is a snapshot created when inventory is
collected on the storage arrays. Inventory collection can be
configured to run on a schedule to periodically update the capacity
information if storage volumes and pools are created after the
initial inventory collection.

For Local Storage, capacity information collected for storage devices
attached to systems that are running 5.20 is limited to the Total raw
capacity. The Total configured capacity and Total available capacity are not
included in the Capacity Summary for these storage devices.

Storage tasks

Server to Storage Mapping View
Display a table that shows what storage resources are associated
with your virtual servers. After selecting this task, you will choose
the servers to view.

Storage to Server Mapping view
Display a table that shows the virtual server disks and which
storage pools contain them. After selecting this task, you will
choose the storage resources to view.

View and Manage Storage Volumes
Work with your currently-defined storage volumes to make
changes, add or delete them. Details about status and capacity are
also available.

This task is managing the assignment of network storage to
individual systems, from the context of a specific host system. You
can create a new volume from network storage to be assigned to a
selected host system, or delete a volume that is currently assigned
to a selected host system. The create volumes function simplifies
the allocation process by determining the best fit storage system,
and creating any necessary RAID arrays automatically.

View and Apply Storage Templates
Work with storage templates, which are predefined images for
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certain storage devices. Storage templates are used to ensure
uniformity among common storage elements, as well as save time
and effort on repetitive tasks.

Storage templates can be used:
1. To clone the storage configuration of a system - save a storage

volume template from an existing server, and then later
applying a saved template to another system. This can be used
for duplication (clustering, or virtual server hosts) or for saving
the storage configuration for backup or disaster recovery
purposes.

2. As a starting point for creating additional volumes - start with
a base template and make changes as needed.

Capacity Details
For each type of storage, this table indicates the available capacity, usable
capacity, total capacity, number of systems, and number of disk drives. The
entries in this list correspond to storage groups having the same name. If
you select an entry, a table of storage subsystems that are members of the
selected group is displayed.

Local Storage
Storage that is local to only one system, and therefore dedicated to
only that system.

For the Local Storage row, capacity information collected for
storage devices attached to systems that are running 5.20 is limited
to the Total raw capacity. The Total usable capacity and Total
available capacity is not displayed for these storage devices.

Compute node Storage
Storage accessible to all of your Compute node systems.

From IBM Flex System Manager, Compute node Integrated storage
can be access through several paths: View and Manage Storage
Volumes from the Storage Management Summary page, the
Configuration tab of the Properties page of a host system, or by
configuration templates.

Network storage
Storage accessed with switches, adapters, and protocols such as
Fibre Channel, SAS, and iSCSI. Network storage (and Compute
node Integrated storage) is managed by IBM Flex System Manager
(for supported storage devices) and by native management
applications provided with the network storage device.

From IBM Flex System Manager, network storage management can
be access through several paths: View and Manage Storage
Volumes from the Storage Management Summary page, the
Configuration tab of the Properties page of a host system, or by
configuration templates.

Total Provides totals of all the columns.

Viewing storage systems using storage groups
Display a hierarchical view of the volumes mapped to each system, and from
which storage subsystem each volume is allocated.
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Before you begin

Predefined storage groups are in these categories: Compute nodes, Network, Local
storage, SMI-S providers, Storage Subsystems and Volumes, Systems and Volumes.
Ensure that you have run Discovery for all systems that have storage attached, that
these systems are not locked, and that you have run inventory collection for these
systems.

About this task

To view your storage systems using storage groups.

Procedure
1. Click Resource Explorer. The Resource Explorer page is displayed.
2. Select Groups by System Type. A table of groups is displayed.
3. Select Storage Systems. A table listing the different categories of storage

systems is displayed.
4. Select Systems and Volumes.
v To view a table of systems and their associated volumes, select Systems and

Volumes. Note that the associated volumes for each system are displayed
directly below the row for the system.

v To view a table of storage subsystems and their volumes, select Storage
Subsystems and Volumes.

5. Choose and display other storage groups, depending on which ones are of
interest.

Viewing storage volumes
This topic displays of a table of all storage volumes accessible to IBM Flex System
Manager.

Before you begin

Note that a storage volume is similar to a logical volume.

About this task

To view detailed information about storage volumes, complete the following steps:

Procedure
1. From the Storage Management Summary page, locate the Capacity Summary

area, and the Storage Tasks pane on the right.
2. Click View and Manage Storage Volumes. The Current Configuration page is

displayed.
3. Select a system. Storage details for the system are displayed.
4. Select Storage Provisioning Configuration. A list of storage volumes associated

with the selected system is displayed. For storage devices such as SAN Volume
Controller or Storwize, that are managed by IBM Tivoli Storage Productivity
Center version 5 and later, the Real Size property of a storage volume indicates
the portion of allocated space that is used. For other storage devices, SAN
Volume Controller, or Storwize® which are managed by IBM Tivoli Storage
Productivity Center version 4, the Real Size property of a storage volume
indicates the total space allocated.
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5. If you have not yet run inventory discovery, this table might be empty. Return
to the Storage Management Summary page and click Storage system not being
discovered? Learn more so that you can plan and run the necessary discovery
task.

Viewing the health and status of storage devices
Use the System Status and Health summary of IBM Flex System Manager to view
the health and status of storage devices.

Before you begin

The following areas in the System Status and Health summary concern storage
devices and characteristics that are unique to storage systems:

Active status
The status for storage devices must be cleared manually if the cause of the
status change is resolved outside of IBM Flex System Manager. In this case,
either ignore, deactivate, or delete the status set to reset the status of a
storage system.

Event log
Storage events are recorded in this log.

Health summary
You can add storage systems for health summary, the same way that you
add other resources to be monitored.

About this task

To view the system status and health for storage devices, complete the following
steps:

Procedure
1. In the IBM Flex System Manager navigation area, click Home. The Home page

is displayed.
2. On the Home page, click the Plug-ins tab. A list of available summary pages

is displayed.
3. On the Plug-ins tab, scroll to the Status Manager section heading and click it.

The Status Manager Summary page is displayed.
4. In the Status tasks area, click Health summary. The Health Summary page is

displayed.
5. Examine the storage systems, or if no storage system is present, use the

Health Summary Favorites Group to add them.
6. Click Cancel. The Status Manager Summary page is displayed.
7. In the Status tasks area, click View active and ignored status. The Active

status page is displayed.
8. Search this page for status information for your storage systems. If you do not

find a system that you want to be monitored, add it.
9. Click Cancel. The Status Manager Summary page is displayed.

10. In the Management Section, view the Common Tasks area.
11. Click Event Log. A list of event logs is displayed.
12. Choose an event log and view its contents, searching for storage-related

entries.
13. Click Cancel until you exit the status manager.
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Storage topology perspective
The Storage topology perspective displays a topology view tailored to the
storage-related resources for a system or device.

Make sure that discovery has been run, inventory has been collected, and the
system that the storage devices are attached to is unlocked before trying to view
their topology map.

By default, a topology perspective contains all resources related to the device. The
Storage perspective limits the resource types to storage-related resources.

The topology view can be invoked wherever there is a table listing a particular
storage device. An example is to select a device, and then click Actions > Topology
Perspectives. Then, choose one of these storage-related views:
v Storage- Provides a topology map that shows logical relationships between

resources that are related to the selected resource, including hosts, host volumes,
storage systems, storage volumes, storage pools, and disk drives.

v Storage Area Network - Provides a topology map that shows physical
connections between resources that are related to the selected resource, including
hosts, switches, ports, physical connectors, and storage systems.

The topology view shows the devices and their connectivity. Arrows connect the
devices. The name of each device is listed whenever possible. Connectors are
represented by a connector icon.

The Depth option can be used to see a deeper view of the device connections, by
clicking Actions > Depth and then selecting a number.

You can display the graph in one of two layouts. Click Actions > Layout to choose
one of these layouts:

Radial Presents the display in a radial layout, having the display fan out from left
to right and top to bottom, as needed.

Tree Presents the display in a tree layout. The selected resource is on the first
level. The second level is the devices immediately attached to the selected
resource. The third level is attachments to the second level devices and so
forth, to the depth that has been selected with the Depth option.

The Overview area shows the graph without the details, and is used to zoom in to
see specific areas.

Managing storage in real-time
You can manage storage systems in real-time, without the use of configuration
templates.

Managing storage volumes in real time
You can create and delete storage volumes in real time. These changes are applied
immediately.

Creating storage volumes
Use the Create Storage Volume wizard to create storage volumes from your storage
pools through Fibre Channel and Fibre Channel over Ethernet. You can use the
IBM Flex System Manager management software to create volumes from storage
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pools that are internal or external to your IBM Flex System chassis. (The
management software supports the IBM Flex System V7000 Storage Node and
external SAN-attached storage.)

About this task

The Create Storage Volume wizard guides you through the steps that are required
to create storage volumes, including selecting a storage pool from which the
storage volumes are allocated and attached to the selected servers. The wizard also
provides the capability to create new zones and zone sets, if the zones or zone sets
were not configured previously.

Note: To create new zones or zone sets, the user must belong to a role that has the
fabric/zoning permission. (The option to create new zones is presented only when
the selected storage pool or additional server has a value of Available in the Zone
access column.) Otherwise, before you use the wizard, configure zoning so that the
associated storage pools are available for selection. (These storage pools have a
value of Zoned in the Zone access column.) Use the native switch control utility
(not the IBM Flex System Manager Web interface) to configure hard zoning on any
switch that is a member of the fabric.

Prerequisites for using the wizard include discovering and collecting inventory for
the server, switches, and storage devices. More information is available in the
Create Storage Volume wizard and in the IBM Flex System Information Center at
http://publib.boulder.ibm.com/infocenter/flexsys/information/index.jsp.

Note: If you prefer to use a command-line interface or if you must use scripting,
use the smcli commands mkstvol, lsstpool, and lsstvol. To detach and remove a
SAN volume, use the rmstvol command, a function that is not available by using
the IBM Flex System Manager Web interface.

To start the Create Storage Volume wizard, right-click the server for which you
want to allocate SAN storage volumes, the select System Configuration > Create
Storage Volumes.

Creating a storage volume in real-time
For a specific active server, you can create storage volumes using the Resource
Navigator in real-time.

Before you begin

Make sure that the server and its storage devices must have been discovered and
unlocked.

Note that a storage volume is similar to a logical volume.

About this task

You can use these definitions for IBM Flex System installations that include
management modules or advanced management modules. The settings provided
might be made by way of the management module, but actually might affect other
components in the IBM Flex System environment, such as a compute node. All
settings might not be applicable for the supported components.

To create a storage volume for a server, complete the following steps:
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Procedure
1. From the Resource Navigator, click System Configuration > Current

Configuration. A table with the current configuration is displayed.
2. Click Storage Provisioning Configuration. The Storage Volumes page is

displayed. If this server already has some storage volumes, they are displayed.
3. Click Actions > Create Volumes. The Create Volumes wizard is displayed.
4. Optional: If the Welcome page is displayed, click Do not show this Welcome

page next time if you do not want to see the Welcome page again.
5. Choose a method for creating the new storage volume:
v Click Create volume from scratch to create a new storage volume by

manually specifying all necessary parameters.
v Click Create volume from a template and then choose a configuration

template to create a storage volume that will have the same definitions as
those that are stored in the configuration template. You will be able to
change some but not all of these definitions.

6. Follow the instructions for the task that you have selected in the previous step.
7. After the new volumes have been created, click Deploy in the Storage Volume

page. A job scheduler is displayed.
8. Enter job information, then click OK.
9. Wait for the process to complete and review all messages.

Creating a storage volume from scratch:

When creating a storage volume for a IBM Flex System server from scratch, you
must enter all necessary information about the storage volume.

About this task

To create a storage volume for an IBM Flex System compute node from scratch,
complete the following steps:

Procedure

1. If you have not already done so, click Create volume from scratch from the
Choose Methods page. The Create from Scratch page is displayed.

2. Optional: Type a Volume name prefix. The volume name will be made by
appending a unique number to this prefix. This field must be ten or fewer
characters consisting only of letters, numbers, and the underscore character. If
this field is not specified, the first ten characters of the host name are used.

3. Click Identify this volume as the boot volume if you want this volume to be
the one that will be examined for the bootstrap code when a restart is
performed. You can choose this option only if the server currently has no
designated boot volume.

4. Specify the capacity of the storage volume in Gigabytes.
5. Specify the Volume RAID level:
v RAID 0
v RAID 1
v RAID 5
v RAID 0+1

6. Choose the Host operating system:
v AIX
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v Linux
v Windows

7. Select a Storage type:
v Any
v Network - Serial-Attached SCSI (SAS)
v Network - Fibre Channel (FC)
v SAS

8. Select a Storage system:
v Click Let system choose to have IBM Flex System Manager choose the

storage system
v Click I will choose myself to choose from a table of storage systems that is

displayed. You can choose one or more entries from this table.
9. Click Next The Summary page is displayed.

10. Review the information on this page. If it is correct, click Finish. The Storage
Volume page is displayed, and the new volume is added into the volumes
table.

Creating a storage volume from a configuration template:

When creating a storage volume for a IBM Flex System compute node from a
configuration template, the definitions stored in the configuration template are
displayed, and you will be able to change some but not all of the attributes.

About this task

To create a storage volume for a IBM Flex System compute node from a
configuration template, complete the following steps:

Procedure

1. If you have not already done so, navigate to the Create Volumes page.
2. Click Create volume from a template and then choose a configuration

template. The Create from Template page is displayed. The Base Template
name field is the name of configuration template that you have chosen.

3. Optional: The host operating system can be changed by clicking on one of
these choices:
v AIX
v Linux
v Windows

4. Examine the Table of Volumes Definitions that have been retrieved from the
configuration template. You will be creating one storage volume with the
same definition as each entry in this table, unless you delete or alter the table
entries.

5. Decide what changes to make to these storage volume definitions:
v To remove one or more storage volumes, click Remove Volume.
v To change a storage volume, click Edit Volume. Repeat if you want to

change more than one.
v To add a storage volume, click Add Volume. Repeat if you want to add

more than one.
6. Optional: If you did not select to Add Volume or Edit Volume for one or

more storage volumes, proceed to Step 12 on page 647.
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7. Change or specify the Volume name prefix. The volume name will be made
by appending a unique number to this prefix. This field must be ten or fewer
characters consisting only of letters, numbers, and the underscore character. If
this field is not specified, the first ten characters of the host name are used.

8. Specify the capacity of the storage volume in Gigabytes.
9. Specify the Volume RAID level.

10. Select a Storage type.
11. Select a Storage system.

v Click Let system choose to have IBM Flex System Manager choose the
storage system

v Click I will choose myself to choose from a table of storage systems that is
displayed. You can choose one or more entries from this table.

12. Click Finish. The Storage Volume page is displayed, and the new volumes are
added into the volumes table.

Deleting a storage volume in real time:

For a specific active server, you can delete a storage volume using the Resource
Navigator.

Before you begin

Make sure that the server and its storage devices have been discovered and
unlocked.

Note that a storage volume is similar to a logical volume.

About this task

To delete a storage volume from a server, complete the following steps:

Procedure

1. Click Resource Explorer. The Resource Explorer page is displayed.
2. Select All Systems. A list of discovered systems is displayed.
3. Select an IBM Flex System compute node.
4. Click Actions > System Configuration > Current Configuration. A table of all

the configuration settings for this system is displayed.
5. Click Storage Provisioning Configuration. The Storage Volumes page is

displayed.
6. Select one or more storage volumes to be deleted.
7. Click Actions > Delete Volumes. A confirmation popup is displayed.
8. Examine your choices carefully, then click OK. The selected storage volumes

are deleted from the volumes table.
9. Click Deploy. A job scheduler is displayed.

10. Enter job information, then click OK.
11. Monitor the job to ensure that it completes and review any error messages.
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Managing storage with configuration templates
Storage configuration templates are used to specify storage definitions, such as
storage volume definitions and SAS zoning. These configuration templates are
stored by IBM Flex System Manager and can then be deployed to the associated
storage devices. The configuration manager is used to create and manage these
configuration templates.

Before you begin

Storage configuration templates can be created only for certain storage devices and
functions. When you create a storage configuration template, a list of choices is
displayed.

Viewing storage configuration templates
You can view the details of a storage configuration template from the configuration
manager.

Procedure
1. From the Configuration Summary page, locate the Configuration Tasks pane

and click View Configuration Templates. A table of configuration templates is
displayed.

2. Locate the storage configuration templates, which have one of these
configuration types:
v Storage Provisioning Configuration for storage volumes
v iSCSI Configuration for iSCSI devices
v SAN Configuration for SAN configuration mapping
v SAS Module Zone Configuration for SAS zoning

3. Select a configuration template.
4. Click Actions > Edit to see details.
5. Click Cancel when you are finished.

Changing storage configuration templates
You can change the information in a storage configuration template from the
configuration manager.

Procedure
1. From the Configuration Manager Summary page, locate the Configuration

Tasks pane and click View Configuration Templates. A table of configuration
templates is displayed.

2. Select the storage configuration template that you are going to change.
3. To see details, click Actions > Edit

4. Make changes to the configuration template, and click Save when you are
finished.

Creating a configuration template for a storage volume
A configuration template containing the definitions for a storage volume defined
on a chassis is created using the configuration manager. One configuration
template can be used to define more than one storage volume.
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Before you begin

Note that a storage volume is similar to a logical volume.

About this task

To create a configuration template for a storage volume, complete the following
steps:

Procedure
1. From the Configuration Summary page, locate the Configuration Tasks pane

and click Create a Template.
2. Choose the appropriate target type.
3. Enter a Name and Description for the new configuration template.
4. In the Configuration to create a template list, choose Storage provisioning.
5. Choose whether you want the Automatically Deploy feature.
6. Click Continue. The Storage Provisioning Configuration page is displayed.
7. Click Add Volume. The Create Storage Volumes page is displayed.
8. Fill in all necessary volume information.
9. When you are finished, click OK. The Storage Provisioning Configuration

page is displayed, with the new storage volume in the table.
10. Click Save to save this newly created template.

Chapter 20. Managing and configuring storage 649



650 Systems Management Guide



Chapter 21. IBM Flex System Manager Storage Control

Use these topics to learn about Storage Control.

IBM Flex System Manager Storage Control overview
With the Storage Control plug-in, you can manage an expanded set of storage
subsystems and Fibre Channel switches.

You can use Storage Control to discover, collect inventory, and monitor the health
of your storage devices. For a complete list of supported storage devices and the
tasks that are supported for each device, see Supported storage devices and tasks.

Depending on the firmware levels of these devices, Storage Control supports
native interfaces to the device, which simplifies configuration setup and improves
device management reliability. These interfaces use Secure Shell (ssh) credentials.
For information about configuring these credentials, see the Storage Control
commands topic.

After the devices are discovered, they are listed as being managed by Storage
Manager in Flex System Manager.

Storage Control uses IBM Tivoli Storage Productivity Center technology. As such,
several of the device support and operating environment conditions are related to
IBM Tivoli Storage Productivity Center. When you use IBM Tivoli Storage
Productivity Center with IBM Flex System Manager Storage Control, IBM Tivoli
Storage Productivity Center version 4.2.3 is recommended.

Supported SMI-S providers for DS3000, DS4000, and DS5000
IBM Flex System Manager VMControl and IBM Tivoli Storage Productivity Center
support different versions of DS3000, DS4000, and DS5000 SMI-S providers.

The following table shows the levels of SMI-S providers for DS3000, DS4000, and
DS5000 storage systems that IBM Flex System Manager VMControl and IBM Tivoli
Storage Productivity Center support. For more information, see "Managing storage
using IBM Flex System Manager VMControl."

Table 79. Levels of SMI-S providers required for DS3000, DS4000, and DS5000 storage
systems

SMI-S provider
Supported storage
devices

Support in IBM Flex
System Manager
VMControl

Support in IBM
Tivoli Storage
Productivity Center

IBM Network
AdvisorV11

IBM Flex System
FC5022 16 GB SAN
Scalable Switch

Yes Yes

SANtricity SMI
Provider10.19.GG.xx

DS3XXX
DS4XXX
DS5XXX

Yes Yes

SANtricity SMI
Provider10.10.G5.02

DS3XXX
DS4XXX
DS5XXX

Yes —
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Updating Storage Control
When there are Storage Control software quality updates or feature function
updates, an update is made available.

Before you begin

Storage Control updates must be applied to an existing Storage Control
installation. Installing Storage Control 4.2.1.1. To apply Storage Control updates,
use the following directions.

IBM Flex System Manager update manager plug-in enables you to acquire, install,
and manage updates, and to monitor your systems to ensure that they remain
current.

Use the IBM Flex System Manager update manager plug-in to update your system.

Managing storage with IBM Flex System Manager Storage Control
Use the information in this section to learn how to use Storage Control to manage
storage.

Using Storage Control with IBM Tivoli Storage Productivity
Center

It is possible to use both the Storage Control plug-in and a IBM Tivoli Storage
Productivity Center server for storage management. However, they cannot be
installed on the same system. The difference in these environments is where you
perform the device discovery.

About this task

For example, you can use Storage Control to manage an IBM Storwize V7000 and
use IBM Tivoli Storage Productivity Center to manage a Cisco MDS 9124 Fibre
Channel switch.

If both Storage Control and IBM Tivoli Storage Productivity Center are configured
to manage the same device, IBM Flex System Manager lists the device once. It will
be managed by IBM Tivoli Storage Productivity Center.

Note: When you use Storage Control or IBM Tivoli Storage Productivity Center to
manage a DS8000 series device, unconfigured disks are not collected when you
collect inventory. The disk capacity for these unconfigured disks is not calculated
with the raw capacity of the device.

Changing from Storage Control to IBM Tivoli Storage Productivity Center

In this scenario, assume that you are currently using Storage Control to manage a
device and want to use IBM Tivoli Storage Productivity Center instead. Follow
these steps to start using IBM Tivoli Storage Productivity Center:
1. From Flex System Manager, run the rmdatasource command, specifying the

appropriate data source.
2. Collect inventory against the Storage Control Farm.
3. Open the IBM Tivoli Storage Productivity Center interface on the other system

and add the data source.
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4. From Flex System Manager, use the Advanced Discovery task to discover,
request access, and collect inventory against IBM Tivoli Storage Productivity
Center.

5. IBM Tivoli Storage Productivity Center starts managing the device.

Adding a device to IBM Flex System Manager Storage Control
To use Storage Control to begin managing a device or subsystem, use the Discover
Storage task. Using Discover Storage makes it easy and straightforward to discover
the data sources for your storage devices and subsystems so Storage Control can
communicate with them. You also have the option to automatically collect
inventory on the discovered devices.

About this task

The term data source describes how the storage device is managed. Some data
sources are the location of the SMI-S provider for the device. Other data sources
are the device itself. For example, for the current firmware levels of the SAN
Volume Controller and IBM Storwize V7000, the device is the data source.

If you prefer to use a command-line interface or if you need to use scripting, use
the smcli mkdatasource command. The default behavior for the mkdatasource
command is to automatically collect inventory.

To discover your storage devices, complete the following tasks:

Procedure
1. On the Storage Management summary page, in the Storage Tasks area, click

Discover Storage. The Discover Storage page displays.
2. Select the type of device that you want to discover, complete the required

information, then click Discover.

Note: To discover any of the supported devices in the Storwize family, select
the option that includes the IBM Flex System V7000.
Discover Storage automatically collects inventory for any discovered devices,
although you can choose not to collect inventory.

Note:

a. If a device configuration changes and you want to collect inventory again,
use one of the following methods:
v Select the device and click Actions > Inventory > Collect Inventory

v Right-click the device name and select Inventory > Collect Inventory

b. When you run an inventory, inactive zone members that were created by
using a zone alias instead of WWPN are not shown.

c. When you run inventory on Fibre Channel switches, inventory can detect
only the zone members that were added through hard zoning (specifying
WWPN). Inactive zone members that use an alias, port index, or were
created with soft zoning are not detected.

Removing a device from IBM Flex System Manager Storage
Control

To stop using Storage Control to manage a storage device, use the Show Discovery
Details page to delete the associated data source.
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About this task

Usually, you delete a data source only if you also physically remove the associated
storage device.

Note: If you prefer to use a command-line interface or if you need to use scripting,
use the smcli rmdatasource command.

To remove a storage device or subsystem (by deleting the associated data source),
complete the following tasks:

Procedure
1. In any table that lists the resource that you want to remove, right-click the

resource, then select Show Discovery Details. The Show Discovery Details page
displays.

2. In the Data Source table, select the data source that you want to delete, then
click Delete. Storage Control can no longer communicate with the data source,
and the data source is removed from IBM Flex System Manager.

Note: Deleting a data source by using Show Discover Details automatically
collects inventory after the deletion completes. Collecting inventory is a
necessary step to ensure the complete cleanup of devices and information that
is associated with the deleted data source. If you use the rmdatasource
command, you need to manually collect inventory.

Monitoring health with IBM Flex System Manager Storage
Control

You can use Storage Control to monitor the health of storage subsystems, storage
pools, storage volumes, and fabric switches. Run the inventory against the Storage
Control farm to see updated health status.

About this task

Follow these steps to retrieve the health and alert status for the devices that are
managed by Storage Control.

Procedure
1. Select Resource Explorer > All Systems. Select the managed device for which

you want to get the latest health and alert status.
2. Discover and then unlock the device.

Note: At this point, TPC alerts are received from the farm, but not alerts
specific to any devices under this farm.

3. Select the farm that covers the selected device and collect inventory against it.
4. For DS3000, DS4000, and DS5000 TPC devices only: Under the farm,

right-click the DSnnnn device, and select Collect inventory.

Important: You must repeat this step each time you want to check for an event
on these devices.

5. TPC alerts for devices under the farm are now received.
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Results

The managed device has one of these alert levels:

Note: IBMXIV Storage System disk failure alerts are not shown in the Flex System
Manager management software.

Normal
The device is running normally. The Problems column shows a green
square and says “OK”.

Warning
The device has an issue that must be fixed. For example, the SAN Volume
Controller cluster might be turned off. The Problems column shows a
yellow triangle with an exclamation point and says “Warning”.

Critical
The device is not working. The Storage Control and storage system
administrators need to work together to resolve the issue. The Problems
column shows a red circle with an “x” in it, and says “Critical”.

If your device is not running normally, access its management interface for more
details about the error. You can launch the management interface for some devices
from the Flex System Manager user interface. For instructions, see the topic
“Launching an external storage management application.”

For example, assume that you are monitoring the status of a IBM Storwize V7000
system. If the system is working normally, the cluster nodes and storage volumes
are functioning and the health and alert status would be Normal. If you shut
down one of the cluster nodes, the health status of the IBM Storwize V7000 system
would be Critical.

Troubleshooting IBM Flex System Manager Storage Control
Use the information in this section if you have problems with IBM Flex System
Manager Storage Control.

Access type for remote service access point is wrong
This problem might occur after performing an upgrade of the IBM Flex System
Manager management software.

Problem

After performing an upgrade as described, the access type for the remote service
access point (RSAP) of a switch or storage device does not have the correct value
of TPC.

Resolution

To return the access type of the switch or storage device to TPC, complete the
following steps:
1. Remove the farm by right-clicking the resource and selecting Remove.
2. Run the following command:

opt/ibm/director/StorageControl/bin/SCDiscoverUnlock.sh
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3. Collect inventory on the associated farm. From the Plug-ins tab on the Home
page, under Discovery Manager, click View and Collect Inventory. Complete
the fields on the View and Collect Inventory page to collect the farm inventory.

Cannot communicate with Storage Control after changing the
IBM DB2 password

If you changed the password that IBM Flex System Manager uses to access IBM
DB2®, but Storage Control can no longer access IBM DB2, use this information to
solve the problem.

Problem

After the IBM DB2 password that is used by IBM Flex System Manager is changed,
Storage Control cannot access the Storage Control Farm. In this case, the
information that is stored in the Farm contains the old credentials, but the Farm
still has an access state of unlocked.

Resolution

Complete the following steps to refresh credential information for the farm:
1. Remove the farm by right-clicking the resource and selecting Remove.

Note: The farm that you want to remove has the same host name as the
management node and has a Type of StorageEnsemble.

2. Rediscover and unlock the farm that you removed in the first step:
v For AIX and Linux, run the following command, where install_root is the root

directory of your IBM Flex System Manager installation. :
install_root/StorageControl/bin/SCDiscoverUnlock.sh

v For Windows, create and run a discovery profile to discover and request
access to the farm. When you create the profile, be sure to specify the
following settings:
– TPC DB Configuration:

- IP Address: The management node address
- Port: 50010
- Database Name: TPCDB
- Database UserId: The Windows administrator user name
- Database Password: The password for the specified Windows

administrator user name
– TPC Server Configuration:

- TPC UserId: The Windows administrator user name
- TPC Password: The password for the specified Windows administrator

user name
– TPC Storage Resource Group Selection: Select ALL
– Access Request: Specify the Windows administrator user name and

password

Cannot communicate with Storage Control after changing the
management node IP address

If you changed the IP address of the management node and you can no longer
communicate with Storage Control, use this information to solve the problem.
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Problem

The host IP address of IBM Flex System Manager was changed and now you
cannot communicate with Storage Control. Storage Control and IBM DB2 both
must be updated with the new IP address.

Resolution

After a change to IP address of the management node breaks communication
between IBM Flex System Manager and Storage Control, complete the following
steps to restore communication:
1. Remove the farm by right-clicking the resource and selecting Remove.

Note: The farm that you want to remove has the same host name as the
management node and has a Type of StorageEnsemble.

2. Restart the IBM Flex System Manager management node.
3. After you log back in to the management software web interface, click the

Plug-ins tab on the Home page.
4. From the Plug-ins tab, under Discovery Manager, click View and Collect

Inventory. Complete the fields on the View and Collect Inventory page to
collect the farm inventory.

Discovering (or adding) a SAN Volume Controller or a
Storwize family device in large configurations fails due to
timeout

This problem might occur when you discover (or add) a SAN Volume Controller
or a device from the IBM Storwize family, when the device is part of a
configuration that contains more than 1,000 items (including mDisks, vDisks,
volumes, and mDiskExtents).

Problem

When you use the Discover storage task or the smcli command mkdatasource to
discover (or add) a SAN Volume Controller or a device from the Storwize family,
the task or command fails with the message “Complete with errors.” This problem
might occur when the number of items in the storage area network totals 1,000 or
more, including mDisks, vDisks, volumes, and mDiskExtents.

Resolution

To successfully discover and request inventory to a SAN Volume Controller or a
device from the IBM Storwize family that is an item in such a large configuration,
you must reconfigure certain properties for IBM Tivoli Storage Productivity Center
and IBM Flex System Manager.

Note: To complete the following tasks, you must have root authority to the
management node.

To configure the IBM Tivoli Storage Productivity Center and IBM Flex System
Manager properties to successfully discover and collect inventory on a SAN
Volume Controller or a Storwize family device, complete the following steps.
1. Configure the timeout value for the IBM Tivoli Storage Productivity Center

device probe to 8 hours by running the following command-line command on
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the management node (where TPC_install_dir is the directory where you
installed IBM Tivoli Storage Productivity Center):
v On AIX and Linux: TPC_install_dir/cli/tpctool.sh setdscfg -user

<tpcuser> -pwd <tpcpassword> -url localhost:9550 -property
NAPI.Timeout.probe 28800000

v On Windows: TPC_install_dir\cli\tpctool.bat setdscfg -user <tpcuser>
-pwd <tpcpassword> -url localhost:9550 -property NAPI.Timeout.probe
28800000

2. Verify the IBM Tivoli Storage Productivity Center device probe time by running
the following command-line command on the management server:
v On AIX and Linux: TPC_install_dir/cli/tpctool.sh getdscfg -user

<tpcuser> -pwd <tpcpassword> -url localhost:9550 -property
NAPI.Timeout.probe

v On Windows: TPC_install_dir\cli\tpctool.bat getdscfg -user <tpcuser>
-pwd <tpcpassword> -url localhost:9550 -property NAPI.Timeout.probe

Note: For more information about configuring and verifying the IBM Tivoli
Storage Productivity Center device probe, see the following IBM Tivoli Storage
Productivity Center information center topic: “Setting timeout values for the
Device server.”

3. Stop and then restart Storage Control by running the following command-line
commands, where install_root is the root directory of your IBM Flex System
Manager installation.
v On AIX and Linux:

install_root/StorageControl/bin/stopStorageControl.sh
install_root/StorageControl/bin/startStorageControl.sh

v On Windows:
install_root\StorageControl\bin\stopStorageControl.bat
install_root\StorageControl\bin\startStorageControl.bat

Note: To verify that Storage Control stopped running, run the following
command-line commands (from the previously specified directory). On AIX
and Linux, run scstatus.sh. On Windows, run scstatus.bat.

4. Configure Flex System Manager to timeout after 8 hours when Flex System
Manager calls the IBM Tivoli Storage Productivity Center API. Open the
following file with a plain text editor:
v On AIX and Linux: install_root/data/

DefaultTpcConnectionSettings.properties

v On Windows: install_root\data\DefaultTpcConnectionSettings.properties

If the tpc.config.timeout entry exists, change the corresponding value to
28800000. Otherwise, add the following line to the file:
tpc.config.timeout=28800000

Note: For more information, see the following topic: “Changing the default
time limit for inventory collection.”

5. Change the Flex System Manager extended discovery timeout to 2 hours. Open
the following file with a plain text editor:
v On AIX and Linux: install_root/lwi/conf/overrides/

USMIKernel.properties

v On Windows: install_root\lwi\conf\overrides\USMIKernel.properties
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If the perf.extended.discovery.timeout entry exists, change the corresponding
value to 120. Otherwise, add the following line to the file:
perf.extended.discovery.timeout=120

6. For the changes to the properties files to take effect, you must restart the
management node. For more information, see Restarting IBM Flex System
Manager.

If you continue to encounter inventory timeout errors after completing the
preceding steps, increase the extended discovery timeout by using the procedure
that is described in step 5, then restart the management node.

Cannot manage an IBM Flex System V7000 Storage Node with
the manageV7000 command

This problem might occur when you attempt to manage and configure an IBM Flex
System V7000 Storage Node an IBM Flex System V7000 Storage Node in an
environment with multiple chassis.

Problem

You attempt to use the manageV7000 command to manage a Flex System V7000, but
the command fails.

Note: You might also discover that you cannot establish a Secure Shell (SSH)
connection to the Flex System V7000 IPv6 address from the management software.

Resolution

The problem is caused by duplicate IP addresses on the IPv6 network. You must
change the network settings so that each managed resource has a unique IPv6
address.

To change the network settings so that the Flex System V7000 has the correct IPv6
address, complete the following steps:
1. Log in to the Chassis Management Module (CMM) command-line interface

(CLI).
2. Run the list command to display a list of all devices in the chassis, as shown

in the following example:
list -l a

3. Find the Flex System V7000 storage node that you want to manage and
configure. In the output from the list command, the storage node is
designated by the target name bladeenclosure[x], where x is the bay number
where the storage node is installed.

4. Run the ifconfig command to see the network interface settings for the storage
node, as shown in the following example:
ifconfig -T bladeenclosure[x]:blade[1]

where x is the bay number where the storage node is installed.
5. In the output from the ifconfig command, check for duplicate IPv6 addresses.

The output is displayed in two parts: the settings for eth0 are shown at the top
of the output, and the settings for MANAGEMENT1. For eth0, the IPv6 address
is displayed beside -i6. For MANAGEMENT1, the IPv6 address is displayed
beside Static IPv6 address:.
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6. To determine the correct IPv6 address for the V7000 storage node IMM,
complete the following steps:
a. Take the prefix from the IPv6 address on the IMM or Management1. This

prefix is the same on all IBM Flex System devices:
fd8c:215d:178e:c0de:

b. Take the suffix of the LLA address for the IMM (eth0):
5ef3:fcff:fe6f:1df4

c. Combine the prefix and suffix to determine the correct IPv6 address:
fd8c:215d:178e:c0de:5ef3:fcff:fe6f:1df4

7. Use the ifconfig command to set the correct address for the storage node:
ifconfig -T bladeenclosure[7]:blade[1] -eth0 -i6 fd8c:215d:178e:c0de:5ef3:fcff:fe6f:1df4 -p6 64 -id 3

Cannot SSH to IBM Flex System V7000 Storage Node from the
management software

This problem might occur when you attempt to manage and configure an IBM Flex
System V7000 Storage Node an IBM Flex System V7000 Storage Node in an
environment with multiple chassis.

Problem

You are unable to establish a Secure Shell (SSH) connection to the Flex System
V7000 IPv6 address from the management software.

Note: You might also discover that if you attempt to use the manageV7000
command to manage a Flex System V7000, the command fails.

Resolution

The problem is caused by duplicate IP addresses on the IPv6 network. You must
change the network settings so that each managed resource has a unique IPv6
address.

To change the network settings so that the Flex System V7000 has the correct IPv6
address, complete the following steps:
1. Log in to the Chassis Management Module (CMM) command-line interface

(CLI).
2. Run the list command to display a list of all devices in the chassis, as shown

in the following example:
list -l a

3. Find the Flex System V7000 storage node that you want to manage and
configure. In the output from the list command, the storage node is
designated by the target name bladeenclosure[x], where x is the bay number
where the storage node is installed.

4. Run the ifconfig command to see the network interface settings for the storage
node, as shown in the following example:
ifconfig -T bladeenclosure[x]:blade[1]

where x is the bay number where the storage node is installed.
5. In the output from the ifconfig command, check for duplicate IPv6 addresses.

The output is displayed in two parts: the settings for eth0 are shown at the top
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of the output, and the settings for MANAGEMENT1. For eth0, the IPv6 address
is displayed beside -i6. For MANAGEMENT1, the IPv6 address is displayed
beside Static IPv6 address:.

6. To determine the correct IPv6 address for the V7000 storage node IMM,
complete the following steps:
a. Take the prefix from the IPv6 address on the IMM or Management1. This

prefix is the same on all IBM Flex System devices:
fd8c:215d:178e:c0de:

b. Take the suffix of the LLA address for the IMM (eth0):
5ef3:fcff:fe6f:1df4

c. Combine the prefix and suffix to determine the correct IPv6 address:
fd8c:215d:178e:c0de:5ef3:fcff:fe6f:1df4

7. Use the ifconfig command to set the correct address for the storage node:
ifconfig -T bladeenclosure[7]:blade[1] -eth0 -i6 fd8c:215d:178e:c0de:5ef3:fcff:fe6f:1df4 -p6 64 -id 3

Cannot unlock IBM Flex System V7000 Storage Node
This problem might occur when you request access to (unlock) the IBM Flex
System V7000 Storage Node.

Problem

After you request access to the IBM Flex System V7000, the device remains
inaccessible.

Resolution

Log in to the management software command-line interface (CLI) and use the
manageV7000 CLI command to access and manage an IBM Flex System V7000.

smcli mkdatasource hangs after a date change
The IBM Flex System Manager command smcli mkdatasource -c fabric hangs if
the operating system time was set forward.

Resolution

Restart the server to synchronize the time between IBM Flex System Manager
Storage Control and IBM Flex System Manager.

Run smcli mkdatasource for a storage device or a switch
results in an unexpected error

Running the smcli mkdatasource command for a storage device, a storage
subsystem, or a Fibre Channel switch results in an unexpected error.

Possible failures

Error might occur because of one or a few of the following reasons:
v Storage Control is not running.
v The farm object is not discovered or has no access.
v The TPC or eTPC database is not running.
v TPC and TPCDB RASP are removed from the IBM Flex System Manager farm.
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Resolution

To prevent this error from occurring, perform one or a few of the following tasks
as applicable:
v Ensure that Storage Control and TPC database are running.
v Ensure that the farm object is discovered and has OK access.
v If either TPC or TPCDB RASP is missing from the IBM Flex System Manager

farm, remove the invalid farm object and rediscover the farm object that has
TPC and TPCDB RASP.

Column values for virtual server volumes in server-to-storage
and storage-to-server reports might not match the volumes
expected on the AIX virtual server

Problem

The column value for the virtual server volume is the storage volume (or the
logical volume) that the virtual server uses. The column lists the used storage area
network (SAN) storage volumes for that virtual server, which is the backup device
to the vSCSI (virtual small computer systems interface) on the Virtual I/O Server
(VIOS). Also, the value of the storage volume in the virtual server volume column
gets replaced with the logical volume that is based on the corresponding storage
volume.

Resolution

This behavior is working as designed.

Storage Control operations fail with SEVERE TPC Exception:
OutOfMemoryError

This problem might occur when you use Storage Control to manage a large SAN
environment or a high number of storage devices.

Problem

The time that is required to complete Storage Control operations, including
inventory collection, is uncommonly long and some operations fail with a SEVERE
TPC Exception: OutOfMemoryError in the associated job log.

Resolution

To prevent this error from occurring, increase the RAM that Storage Controluses by
completing the following steps:
1. Navigate to the server.xml file, which has the following default path:
v On AIX or Linux: /opt/IBM/TPC/device/apps/was/profiles/deviceServer/

config/cells/DefaultNode/nodes/DefaultNode/servers/server1/server.xml
v On Windows: \Program Files\IBM\TPC\device\apps\was\profiles\

deviceServer\config\cellsDefaultNode\nodes\DefaultNode\servers\
server1\server.xml

2. Open the server.xml file in a plain text editor.
3. Find the entry that begins with genericJvmArguments. The associated default

value is -Xmx512m, which represents the maximum size of the execution heap
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for Storage Control, in megabytes. Change the value to include a higher
number, for example 1536, which would make the value -Xmx1586m, or about
1.5 GB.

4. Save and close the file.
5. Restart IBM Flex System Manager for the change to take effect.

Rediscovering a storage farm that was deleted
If a storage farm was deleted inadvertently, use the IBM Flex System Manager web
interface to remove the devices that were managed by the storage farm so that you
can create a new farm; then, rediscover the farm and its managed devices.

Problem

After a storage farm is discovered and unlocked in the management software, and
the managed devices for that farm are inventoried, the Access status for the farm
and its managed devices is OK. If you delete the storage farm, the farm is removed
from the list of system resources, and the Access status for the devices that were
managed by the farm is Unknown (and they are not recognized by the management
software).

Resolution

Follow these steps to remove the devices that were previously managed by the
farm from inventory, and rediscover the farm and its inventory so that they are
recognized by IBM Flex System Manager:
1. From the Home page in the management software web interface, click the

Plug-ins tab.
2. Under Storage Management, click Storage subsystems and volumes. A table

that contains storage system names, types, and access states is displayed.
3. Select the box for each of the devices that were previously managed by the

farm, and click Actions > Remove....
4. Click OK to confirm the removal of the devices.
5. Restart the IBM Flex System Manager management node.
6. After you log back in to the management software web interface, click the

Plug-ins tab on the Home page.
7. From the Plug-ins tab, under Discovery Manager, click View and Collect

Inventory. Complete the fields on the View and Collect Inventory page to
collect the farm inventory.

When SSH is removed or disabled, information on physical
disks of IBM Flex System V7000 (nimitz) or IBM Storwize
V7000 cannot be retrieved

Physical disk information of IBM Flex System V7000 (nimitz) or IBM Storwize
V7000 cannot be retrieved without SSH remote service access point (RSAP).

Problem

Information on physical disks cannot be retrieved in the following two situations:
1. When you manage IBM Flex System V7000 (nimitz) or IBM Storwize V7000 by

using stand alone TPC, and then discover the TPC in IBM Flex System
Manager because by default there is no SSH RSAP.
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2. When you manage IBM Flex System V7000 (nimitz) or IBM Storwize V7000 by
Storage Control and remove the SSH RSAP manually.

Resolution

To resolve this problem, complete the following steps:
1. Add the SSH RSAP connection for IBM Flex System V7000 (nimitz) or IBM

Storwize V7000 by using the mksvcsshrsap command.
2. Collect inventory information from the resources.

When you use Storage Control to manage a switch, the state
of the switch is shown as Unknown

The state of Storage Control managed switches is displayed as “Unkown”, when
you look at the details of managed devices in a farm.

Problem

When you select a farm and look at the details of a managed device, the state of
Storage Control managed switches is shown as “Unknown”.

Description

State represents the operating state of the system and is a required property for all
type of resources. However, for Storage Control managed devices, the property is
only meaningful for storage resources and not for switches. Therefore, default
value for State is displayed as “Unknown”. But this does not mean that the switch
is not working or will have any impact on other functions.

Resolution

Ignore the “Unkown” value for State as there is no impact on other functions.

Zone members are not discovered after changing the SNMP
settings of switch

After you manage a switch in Storage Control and collect inventory from a farm
resource, zone members are not discovered for the switch.

Problem

After you change the SNMP community names for a switch and manage it in
Storage Control, zone member information is not available for the switch.

Description

Zone members are connected to the switch port. Each zone member has a unique
worldwide port name (WWPN). On the switch, you can define a node (device)
with a worldwide node name (WWNN) in the zone. When you retrieve
information on zone members, Storage Control uses the WWNN to retrieve the
ports (WWPN). However, to get such information, you must configure the SNMP
settings of the switch correctly. If you change the SNMP community names, some
zone members are not discovered for the nodes defined in the zone.
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Resolution

Complete the following steps to resolve the issue:
1. Telnet to the switch and run the snmpconfig --show snmpv1 command to check

the SNMP community names. Two types of community names must be
available: a private one with read-write access and a public name with read-only
access.

2. If such node names do not exist, go to Switch Administration > SNMP
Settings, select a read-write community name and change the type to public.
Next select a read-only community name and change it to private.

3. Save the changes and run the smcli rmdatasource -c fabric -i <providerIP>
-p <port> -t <protocol> command to remove the switch provider and the
managed switch resources from the IBM Flex System Manager user interface.

4. Run the smcli mkdatasource -c fabric -i <providerIP> -p <port> -t
<protocol> -u <userid> -w <password> -n <namespace> command to manage
the switches again.

Zone members are not retrieved if SNMP is disabled for
failover on FC5022 switches

If SNMP is disabled as part of the changes to enable failover on FC5022 type
switches, zone members are not retrieved.

Problem

If SNMP is disabled as part of the changes to enable failover on FC5022 SAN
switches, zone members are not retrieved. FC5022 switches show a tilt sign and an
SNMP communication error is displayed in the Fabric Discovery page of the
Storage Management Initiative Agent (SMIA) configuration tool.

Description

Servers cannot discover the storage containers if retrieval of zone members fails.

Resolution

Complete the following steps to resolve the issue:
1. Telnet to the switch and run the snmpconfig --show snmpv1 command.
2. Run the snmpconfig --enable snmpv1 command.
3. Go to FSM > Applications > SMIA Configuration tool and login to the SMIA

Configuration tool.
4. Go to Add Fabric Discovery section.

a. Remove both the fabric switches (by using the Delete option).
b. Select snmp v1 from the SNMP Version section to manually rediscover the

switches.
5. Run the smcli rmdatasource -c fabric -i <providerIP> -p <port> -t

<protocol> command to remove the switch provider and the managed switch
resources from the IBM Flex System Manager user interface.

6. Run the smcli mkdatasource -c fabric -i <providerIP> -p <port> -t
<protocol> -u <userid> -w <password> -n <namespace> command to manage
the switches again.
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Chapter 22. Management software recovery and reinstallation

If a hard drive fails, or if the management software is configured incorrectly or
becomes corrupted, you might need to reinstall all or part of the management
software on the management node.

The IBM Flex System Manager management node comes with three drives: one
hard disk drive and two solid state drives. Each of the management node drives
comes pre-configured with components of the IBM Flex System Manager
management software. The hard disk drive contains the following:
v The recovery partition, which is used to install the management software
v The spare virtual disk images, which are used to perform upgrades
v Storage space for backup images

The solid state drives are mirrored (RAID 1), and contain the following:
v The management software virtual machine
v The host operating system

A fully functional management node requires that all three hard drives, and the
software components on each one, be operational. If the hard disk drive fails, or if
both solid state drives fail, you must reconfigure the RAID boot settings through
the LSI Corp Configuration Utility before you can reinstall the management
software.

If a hard drive fails, or if the management software is configured incorrectly or
becomes corrupted, you might need to reinstall all or part of the management
software on the management node. The type of reinstallation that is required
depends on the type of management node or management software problem.

Before you reinstall all or part of the management software, determine whether the
hard drives and other management node hardware components are functional.
Then, determine which of the following procedures is necessary for your
management node. For more information about troubleshooting hard drives, see
the Flex System Manager Types 7955, 8731, and 8734 Installation and Service Guide
at http://publib.boulder.ibm.com/infocenter/flexsys/information/topic/
com.ibm.acc.8731.doc/printable_doc.html.

Reinstalling the management software from the recovery partition
Use this recovery method if the management software is inoperable because of
misconfiguration or corruption, but the management node hardware is operational
and the hard drives have not failed.

About this task

This procedure returns the management node and management software to factory
defaults, and destroys data on the system (but not backups stored on the hard disk
drive). After the recovery process is complete, you must configure the system with
the Management Server Setup wizard or restore the system from a backup image.
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Procedure
1. Restart the management node.
2. When the firmware splash screen is displayed, press F12. The setup menu is

displayed. The screen displays confirmation that F12 has been pressed.
3. Select Recovery partition.
4. When the boot options screen is displayed, select Full system recovery. After

approximately 30 to 45 minutes, the recovery process ends and the
Management Server Setup wizard opens.

Note: The system displays Loading Bootloader, but no additional messages are
displayed during the recovery process. If the screen saver is activated and the
screen goes blank during this stage, press the Shift key to deactivate the screen
saver.

5. Either complete the Management Server Setup wizard or restore a previous
configuration from a backup.

What to do next

Important: If your recovery partition is an earlier version of the management
software than the version before the recovery procedure, update the management
software to the same version as before the recovery operation after you complete
the Management Server Setup wizard. If you do not update the management
software in this situation, the management software is older than other
components in your environment, which might cause compatibility problems.

For more information about setting up the management node with the wizard, see
the configuration section in the IBM Flex System Manager Systems Management
Guide.

For more information about restoring a backup image, see the backup and restore
section in the IBM Flex System Manager Systems Management Guide.

Reinstalling management software components from optical media
after replacing the hard disk drive

If the management node fails and only the hard disk drive has been replaced (and
not a solid state drive), use the following information to recover the IBM Flex
System Manager management software image.

About this task

Note: If a management node solid state drive has also failed and been replaced,
use the procedure that is described in “Reinstalling the management software from
optical media after replacing an SSD” on page 670.

If the Flex System Manager Types 7955, 8731, and 8734 hardware fails, a solid state
drive, the hard disk drive, or both might have to be replaced, and the management
software might have to be recovered from the IBM Flex System Manager
management software Recovery DVDs.

If the hard disk drive has failed but the solid state drives have not, the
management software image might still be operational. The recovery process boots
the management node from the Recovery DVDs.
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To complete the management software recovery process, you need the following
items:
v Flex System Manager Types 7955, 8731, and 8734 console breakout cable
v External DVD-ROM drive with a USB connection and an external power adapter

Note: Some DVD-ROM drives (and most USB-powered DVD-ROM drives)
might not be compatible.

v USB cable
v IBM Flex System Manager management software Recovery DVDs (from IBM

Support)

Note: Before you request the Recovery DVDs from IBM Support, see “Obtaining
the IBM Flex System Manager Recovery DVDs” on page 672 to determine the
FRU part number for your version of the management software.

For more information about removing and replacing hard disk drives, see the
relevant topics in the Flex System Manager Types 7955, 8731, and 8734 Installation and
Service Guide document.

Important: The RAID reconfiguration that is described in step 1 is necessary only
if you have replaced a failed hard disk drive or both of the SSDs. If only one SSD
has failed and been replaced, the RAID is restored automatically.

Procedure
1. During the restart of the management node (after the splash screen), start the

LSI Corp Configuration Utility and reconfigure the RAID settings:
a. When the following message is displayed on your screen, press Ctrl+C.

Please wait, initializing legacy usb devices...Done

LSI Corporation MPT SAS2 BIOS
MPT2BIOS-7.19.00.00 (2011.05.16)
Copyright 2000-2011 LSI Corporation.

Press Ctrl-C to start LSI Corp Configuration Utility...

b. Select the adapter and press Enter.
c. Select SAS Topology and press Enter.
d. Expand Direct Attach Devices so that the hard disk is displayed.
e. Make sure that the hard disk is set as the alternate boot device, or Alt, and

that the RAID is set to Boot. If Alt and Boot are not displayed, use the
following key combinations to modify the configuration:
v Alt+B: Select or deselect a device as the preferred boot device.
v Alt+A: Select or deselect a device as the alternate boot device.

f. Press Escape; then, select Save changes then exit this menu and press Enter.
g. Press Escape; then, select Exit the Configuration Utility and Reboot and

press Enter. The management node restarts.
2. Use the Recovery DVDs to reinstall the management software partitions:

a. Install the console breakout cable in the front of the management node.
b. Connect the external optical media drive to the console breakout cable.
c. Insert the Recovery DVD 1 in the external optical drive.
d. Power on the management node.
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e. From the splash screen, press F12 to select the Recovery DVD for the next
node boot. After the management node boots, the Recovery menu is
displayed.

3. Use the Recovery menu to destroy the corrupted partitions and reinstall the
management software image:
a. After the management node boots, select Recover the management node;

then, press Y.
b. From the menu, select the third option in the list: Recover HDD (use if the

HDD failed, but neither SSD failed) for management software version
1.2.1 or later,or Reinstall HDD image only for versions 1.2.0 and earlier.
After you make the selection, press Y. The node begins copying data from
the Recovery DVD 1.

c. When you are prompted, remove the Recovery DVD 1 and insert the
Recovery DVD 2 in the external optical drive.

Note: After you insert Recovery DVD 2, wait approximately one minute
before you press Enter. If you press Enter and the DVD is ejected, reinsert
the DVD and wait two minutes before you press Enter again.
Depending on the version of IBM Flex System Manager management
software you are recovering, you might have more than 2 DVDs to insert. If
so, continue with this step for each of the DVDs.

d. To complete the process of recovering the IBM Flex System Manager
management software, you must import the ISO files again. For more
information about importing ISO files, see “Importing operating system
images” on page 548.

4. After the recovery process is complete, disconnect the external optical drive
and restart the management node.

Note: After all of the DVDs have been copied, you might receive an "unknown
error." If that occurs, press Enter. Then, select Exit and allow the system to
restart.

Reinstalling the management software from optical media after
replacing an SSD

Use this recovery method if your management node experienced hardware failures
that required you to replace a solid state drive (SSD) or an SSD and the hard disk
drive.

Before you begin

Before you perform the following management software reinstallation procedure,
make sure that you have replaced the failed SSD (and hard disk drive, if
applicable) and returned the management node to its default configuration.

For more information about removing and replacing solid state drives and hard
disk drives, see the relevant topics in the Flex System Manager Types 7955, 8731, and
8734 Installation and Service Guide document.

To complete the management software recovery process, you need the following
items:
v Flex System Manager Types 7955, 8731, and 8734 console breakout cable
v External DVD-ROM drive with a USB connection and an external power adapter
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Note: Some DVD-ROM drives (and most USB-powered DVD-ROM drives)
might not be compatible.

v USB cable
v IBM Flex System Manager management software Recovery DVDs (from IBM

Support)

Note: Before you request the Recovery DVDs from IBM Support, see “Obtaining
the IBM Flex System Manager Recovery DVDs” on page 672 to determine the
FRU part number for your version of the management software.

About this task

This procedure returns the management node and management software to factory
defaults, and destroys all of your data on the management node. Therefore, you
must complete the initial setup again after the recovery is complete.

Note: If the hot-swap SAS drive has failed, but the solid state drives have not, the
IBM Flex System Manager management software image might still be operational.

Important: The RAID reconfiguration that is described in step 1 is necessary only
if you have replaced a failed hard disk drive or both of the SSDs. If only one SSD
has failed and been replaced, the RAID is restored automatically.

Procedure
1. If you replaced only one SSD, skip to step 2. If you replaced both SSDs, a

hard disk drive, or all three, you must reconfigure the RAID. During the
restart of the management node (after the splash screen), start the LSI Corp
Configuration Utility and reconfigure the RAID settings:
a. When the following message is displayed on your screen, press Ctrl+C.

Please wait, initializing legacy usb devices...Done

LSI Corporation MPT SAS2 BIOS
MPT2BIOS-7.19.00.00 (2011.05.16)
Copyright 2000-2011 LSI Corporation.

Press Ctrl-C to start LSI Corp Configuration Utility...

b. Select the adapter and press Enter.
c. Select SAS Topology and press Enter.
d. Expand Direct Attach Devices so that the hard disk is displayed.
e. Make sure that the hard disk is set as the alternate boot device, or Alt, and

that the RAID is set to Boot. If Alt and Boot are not displayed, use the
following key combinations to modify the configuration:
v Alt+B: Select or deselect a device as the preferred boot device.
v Alt+A: Select or deselect a device as the alternate boot device.

f. Press Escape; then, select Save changes then exit this menu and press
Enter.

g. Press Escape; then, select Exit the Configuration Utility and Reboot and
press Enter. The management node restarts.

2. Install the console breakout cable in the front of the management node.
3. Connect the external optical media drive to the console breakout cable.
4. Insert Recovery DVD 1 in the external DVD drive; then, start the management

node.
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5. After the management node boots, select Recover the management node;
then, press Y.

6. From the menu, select the second option in the list: Recover complete system
(use if both SSDs failed, or to update a down-level recovery partition) for
management software version 1.2.1 or later,or Destroy and remake all
partitions for versions 1.2.0 and earlier. After you make the selection, press Y.

7. When you are prompted, select Yes to confirm that you want to reinstall the
management software.
Attention: After you confirm that you want to proceed with the
reinstallation, all of your data on the management node will be destroyed.

8. When you are prompted, remove the Recovery DVD 1 and insert the
Recovery DVD 2 in the external optical drive.

Note: After you insert Recovery DVD 2, wait approximately one minute
before you press Enter. If you press Enter and the DVD is ejected, reinsert the
DVD and wait two minutes before you press Enter again.
Depending on the version of IBM Flex System Manager management software
you are recovering, you might have more than 2 DVDs to insert. If so,
continue with this step for each of the DVDs.

9. When you are prompted, disconnect the external DVD drive.

Note: After all of the DVDs have been copied, you might receive an
"unknown error." If that occurs, press Enter. Then, select Exit and allow the
system to restart.

10. The management node reboots. When the firmware splash screen is displayed,
press F12. The setup menu is displayed. The screen displays confirmation that
F12 has been pressed.

11. Select Full system recovery. After approximately 30 to 45 minutes, the
recovery process ends and the Management Server Setup wizard opens.

Note: The system displays Loading Bootloader, but no additional messages
are displayed during the recovery process. If the screen saver is activated and
the screen goes blank during this stage, press the Shift key to deactivate the
screen saver.

12. Either complete the Management Server Setup wizard or restore a previous
configuration from a backup.

Note: To restore from backup, you must have previously saved the backup on
either a USB drive or secure FTP server.

What to do next

For more information about setting up the management node with the wizard, see
the configuration section in the IBM Flex System Manager Systems Management
Guide.

For more information about restoring a backup image, see the backup and restore
section in the IBM Flex System Manager Systems Management Guide.

Obtaining the IBM Flex System Manager Recovery DVDs
Before you contact IBM Support, use this information to determine the part
number of the IBM Flex System Manager Recovery DVD package for your
management software version.
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About this task

The following table shows the Recovery DVD package part number for each IBM
Flex System Manager management software version.

To order the Recovery DVDs, provide the applicable part number for your
management software version to IBM Support. You can also contact IBM Support
for information on where and how to obtain the Recovery DVD image by
download.

Note: For more information about determining the installed version number, see
“Determining the installed IBM Flex System Manager version” in the IBM Flex
System Manager Systems Management Guide (PDF).

Table 80. IBM Flex System Manager Recovery DVDs

FSM version number Recovery DVD package part number

1.3.4 01CV500

1.3.3 00WA653

1.3.2 00FH545

1.3.1 00FH622

1.3.0 No longer available

1.2.1 No longer available

1.2.0 No longer available

1.1.1 No longer available

1.1.0 No longer available
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Chapter 23. Solving problems

In the IBM Flex System Manager management software web interface, use the
Chassis Map in Chassis Manager to see events and problems for a device. To see
events and problems at a higher, chassis level, use the Active Status or Problems
page.

Use the information in this section to relate a problem to a managed resource (and
a serviceable part, if applicable) with the Active Status and Problems pages by
using the Chassis Manager in the management software web interface.

Important: The management software Service and Support Manager is a key
software component for solving problems and getting support for your IBM Flex
System hardware and software. Service and Support Manager automatically detects
serviceable hardware problems and collects supporting data for serviceable
hardware problems that occur on your monitored endpoint systems. The Electronic
Service Agent™ tool is integrated with Service and Support Manager and transmits
serviceable hardware problems and associated support files to IBM Support. See
the IBM Flex System Manager Service and Support Manager (Electronic Service Agent)
document for detailed information about Service and Support Manager and
Electronic Service Agent.

If configured and activated in the management software, IBM Electronic Service
Agent (ESA) automatically reports hardware problems to IBM Support and collects
system service information for monitored systems. For more information about
setting up ESA, see the IBM Flex System Manager Systems Management Guide
document.

For educational information about getting service and support for management
software, see http://publib.boulder.ibm.com/infocenter/flexsys/information/
topic/com.ibm.acc.common.nav.doc/learning_resource_management.html.

Viewing problems
Use the Chassis Manager and Chassis Map to view problems with chassis,
compute nodes, or other resources that are managed by IBM Flex System Manager
management software.

Note: This topic describes how to access this task in the IBM Flex System Manager
Web user interface. If you are using the IBM FSM Explorer, use the finder at the
top of the user interface (shown here) to locate this task:

There are three primary ways to view problems by using the management software
web interface:
v To view the problems for a chassis, open the Chassis Manager page and click the

linked number for the chassis in the Problems column of the table.
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v To view the problems for a compute node or other resource, open the Chassis
Manager page and click the linked name of the chassis that contains the
compute node. After the Chassis Map opens, click the compute node that has
the problem that you want to view.

v To view all problems that are detected by management software, click the linked
number beside Problems in the Scoreboard.

After you click a problem from the Active Status or Problems view, more
information about the problem is displayed on one or more pages. The tabs that
are displayed are determined by the nature of the problem. One or more of the
following tabs might be displayed:
v General (info from Status Manager)
v Service (service transmission summary and service log)
v Details (everything associated with that event and affected resources)
v Recommendation (including a link to problem-related documentation)
v Support Files (submission of support files to IBM)

Note: To view only serviceable problems, use the Service and Support Manager
page:
1. From the Home page, click the Plug-ins tab.
2. Click Service and Support Manager. The Service and Support Manager page

opens.
3. In the Problem Reporting area, click Serviceable Problems. An Active Status

page with a table showing serviceable problems opens.

For more information about solving a problem, see “Finding problem-resolution
information through the management software web interface” on page 677 or the
IBM Flex System Manager Management Software Troubleshooting Guide document.
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For information about service requests, see “Submitting a service request” on page
678.

Filtering problems
To determine the nature of a problem on the Active Status and Problems pages,
filter the Category column in the table view.

The following table shows the category names, which software or hardware
component reports the problems in each category, and whether the problem
appears on the Active Status page, Problems page, or both.

Table 81. Problem categories on Active Status and Problems pages

Category name
Reporting software or
hardware component

Page where problems
appear

Hardware Status Status Manager Active Status and Problems

Service Status Service and Support
Manager

Active Status and Problems

LED Status LEDs Active Status

Compliance Update Manager Active Status

DPSM Status (System p
compute notes only)

Update Manager Active Status and Problems

Local Health Problems specific to the Flex
System Manager Types 7955,
8731, and 8734

Active Status and Problems

Threshold Status Status Manager Active Status and Problems

Finding problem-resolution information through the management
software web interface

Use the IBM Flex System Manager management software web interface to guide
you to problem-resolution recommendations in the IBM Flex System
documentation.

Note: This topic describes how to access this task in the IBM Flex System Manager
Web user interface. If you are using the IBM FSM Explorer, use the finder at the
top of the user interface (shown here) to locate this task:

To find documentation for a problem or error in the management software web
interface, complete the following steps:
1. From the Problems (Active Status) view, click the name of the problem. Active

status information about the problem is displayed on one or more pages.
2. Click the Recommendation tab. If there is a documented description of the

problem, a link to the problem in the IBM Flex System information center is
displayed, as shown in the following illustration.
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3. Click the link. The information center page for the problem opens in your
browser.

Submitting a service request
This topic describes how to submit a service request from Chassis Manager in IBM
Flex System Manager management software.

About this task

Note: This topic describes how to access this task in the IBM Flex System Manager
Web user interface. If you are using the IBM FSM Explorer, use the finder at the
top of the user interface (shown here) to locate this task:

To submit a service request for a managed resource in Chassis Manager, use one of
the following methods:
v Click Submit service request in the list of common actions for a selected

managed resource.
v From the table view, right-click the name of the managed resource. Click Service

and Support > Submit service request.

Recovering a Chassis Management Module (CMM) after removing the
management node

Use the following procedure to recover and configure a Chassis Management
Module (CMM) only if you removed the Flex System Manager Types 7955, 8731,
and 8734 hardware without first unmanaging the Chassis Management Module
(CMM) on the Management Domain page.
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Procedure
1. Through an SSH session, open a CMM command-line interface and log in with

the RECOVERY_ID account.

Note: The password for the RECOVERY_ID account was set when you selected
the chassis for management on the Management Domain page. If this is the
first time that you have used the RECOVERY_ID account to log in to the CMM,
you must change the password.

2. If you are prompted, type the new password for the RECOVERY_ID account.
3. Run the following five commands, in the order shown:

a. env -T mm[p]

b. sslcfg -client disabled -tc1 remove

c. accseccfg -am local

d. ldapcfg -i1 -p1 -rd "" -usa "" -gsa "" -lpa ""

e. fsmcm -off

This command disables centralized user account management from the IBM
Flex System Manager management software, and allows you to use local
CMM user accounts to authenticate to the CMM and any management
processor that is installed in the chassis.
After you run the fsmcm -off command, the RECOVERY_ID account is
removed from the CMM user registry. You can now authenticate to the
CMM and other chassis components with local CMM credentials.

4. Make sure that local registry is included in the CMM user authentication
options by using the CMM users command (see the IBM Flex System Manager
Systems Management Guide document for more information about user
registries). You can choose remote, local, remote then local, or local then
remote. After the management node is removed, you must log in to the CMM
using one of the IDs from the CMM local registry; then, either set the user
authentication to use local or point to another external or remote user
repository.

5. Verify that Electronic Service Agent (ESA) is configured properly. The CMM
will not allow service requests to be made if it is being managed by the
management software. After the management node is removed, the CMM will
initiate the service request.

6. Check the location settings of the NTP server. If you removed the management
node without first unmanaging the CMM, you must access the CMM and
specify a different NTP server by using either the CMM web interface or the
ntp CLI command (see http://publib.boulder.ibm.com/infocenter/flexsys/
information/topic/com.ibm.acc.cmm.doc/cli_command_ntp.html for more
information).

7. Verify the security policy on the CMM. There are several security settings on
the CMM (for example, secured servers and account authentication). The
security policy that was implemented on the management node remains on the
CMM after the management node is removed. If necessary, you can log in to
the CMM and change the security settings by using either the CMM web
interface or the security CLI command (see http://publib.boulder.ibm.com/
infocenter/flexsys/information/topic/com.ibm.acc.cmm.doc/
cli_command_security.html for more information).
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Recovering management software access after an external user
registry failure

If you are using an external user registry, and that registry fails, use the following
procedure to recover access to the IBM Flex System Manager management software
by using the local user registry on the management node.

About this task

If you cannot log in to the management software because your external user
registry is not available, you can log in with the default administrator account and
use the management software web interface to change the user registry setting to
the local IBM Flex System Manager user registry. After your external user registry
is restored, you can change the setting back.

See the IBM Flex System Manager Systems Management Guide document for more
information about user registries).

To log in to the management software and change the user registry setting,
complete the following steps:

Procedure
1. Log in to the management software web interface with the original

administrator account that was used for IBM Flex System Manager setup. The
default administrator account user ID is USERID.

2. From the Home page, click the Administration tab.
3. From the Administration tab, under Configuration tasks, click Configure Flex

System Manager User Registry. The User Registry Configuration wizard
opens.

4. Select Use Flex System Manager predefined user registry values and click
Next.

5. Click Finish. The user accounts in the local management node user registry can
now be used to access the management software. After your external user
registry is restored and available to the management node, you can change the
user registry setting back to the external user registry.

Recovering compute node boot settings after server pattern
deployment

If one or more compute nodes will not start after you deployed a new server
pattern to those compute nodes, the problem might be that the compute node boot
settings were overwritten with the server pattern default boot settings. You can
manually restore the original boot settings for each compute node.

About this task

Complete the following manual recovery process for each affected compute node
to restore the original boot settings.

Note: The following procedure shows the steps for a compute node with Red Hat
Enterprise Linux installed.
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Procedure
1. From the IBM Flex System Manager management software web interface,

open a Remote Control session for the compute node.

Note: For more information about the Remote Control application, see “Using
FSM Remote Control with X-Architecture compute nodes” on page 557.

2. Restart the compute node; then, when the UEFI splash screen for the compute
node is displayed in the Remote Control session, press F1. The Setup Utility is
displayed.

3. Select Boot Manager and press Enter.
4. Select Add Boot Option and press Enter.
5. Select UEFI Full Path Option and press Enter.
6. From the list that is displayed, select the entry that includes SAS and press

Enter.
7. Select EFI and press Enter.
8. Select redhat and press Enter.
9. Select grub.efi and press Enter.

10. Select the Input the Description field and press Enter.
11. Type Red Hat Enterprise Linux and press Enter.
12. Select Commit Changes and press Enter.
13. Make Red Hat Enterprise Linux the first option in the Boot Order, and remove

all other options in the Boot Order.
14. Press Escape; then, select Save changes then exit this menu and press Enter.
15. Press Escape; then, select Exit the Configuration Utility and Reboot and press

Enter. The compute node restarts.
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Appendix. Getting help and technical assistance

If you need help, service, or technical assistance or just want more information
about IBM products, you will find a wide variety of sources available from IBM to
assist you.

Use this information to obtain additional information about IBM and IBM
products, determine what to do if you experience a problem with your IBM system
or optional device, and determine whom to call for service, if it is necessary.

Before you call
Before you call, make sure that you have taken these steps to try to solve the
problem yourself.

If you believe that you require IBM to perform warranty service on your IBM
product, the IBM service technicians will be able to assist you more efficiently if
you prepare before you call.
v Check for updated firmware and operating-system device drivers for your IBM

product. The IBM Warranty terms and conditions state that you, the owner of
the IBM product, are responsible for maintaining and updating all software and
firmware for the product (unless it is covered by an additional maintenance
contract). Your IBM service technician will request that you upgrade your
software and firmware if the problem has a documented solution within a
software upgrade.
You can obtain the latest downloads for your IBM product from
http://www.ibm.com/support/fixcentral/systemx/
groupView?query.productGroup=ibm%2FBladeCenter .

v If you have installed new hardware or software in your environment, check
http://www.ibm.com/systems/info/x86servers/serverproven/compat/us/ to
make sure that the hardware and software is supported by your IBM product.

v Use the troubleshooting information in your system documentation, and use the
diagnostic tools that come with your IBM product. Information about diagnostic
tools is in the Problem Determination and Service Guide on the IBM Documentation
CD that comes with your product.

v Go to http://www.ibm.com/supportportal/ to check for information to help
you solve the problem.

v Gather the following information to provide to IBM service. This data will help
IBM service quickly provide a solution to your problem and ensure that you
receive the level of service for which you might have contracted.
– Hardware and Software Maintenance agreement contract numbers, if

applicable
– Machine type number (IBM 4-digit machine identifier)
– Model number
– Serial number
– Current system UEFI (or BIOS) and firmware levels
– Other pertinent information such as error messages and logs

v Go to http://www.ibm.com/support/electronic/portal/ to submit an Electronic
Service Request. Submitting an Electronic Service Request will start the process
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of determining a solution to your problem by making the pertinent information
available to IBM service quickly and efficiently. IBM service technicians can start
working on your solution as soon as you have completed and submitted an
Electronic Service Request.

Using the documentation
Information about your IBM system and preinstalled software, if any, or optional
device is available in the documentation that comes with the product. That
documentation can include printed documents, online documents, readme files,
and help files.

See the troubleshooting information in your system documentation for instructions
for using the diagnostic programs. The troubleshooting information or the
diagnostic programs might tell you that you need additional or updated device
drivers or other software. IBM maintains pages on the World Wide Web where you
can get the latest technical information and download device drivers and updates.
To access these pages, go to http://www.ibm.com/supportportal/ .

You can find the most up-to-date information for BladeCenter products at
http://publib.boulder.ibm.com/infocenter/bladectr/documentation/index.jsp .

Getting help and information from the World Wide Web
Put your short description here; used for first paragraph and abstract.

On the World Wide Web, up-to-date information about IBM systems, optional
devices, services, and support is available at http://www.ibm.com/supportportal/
.

You can find the most up-to-date product information for BladeCenter products at
http://publib.boulder.ibm.com/infocenter/bladectr/documentation/index.jsp .

Software service and support
Through IBM Support Line, you can get telephone assistance, for a fee, with usage,
configuration, and software problems with your IBM products.

For information about which products are supported by Support Line in your
country or region, see http://publib.boulder.ibm.com/infocenter/bladectr/
documentation/index.jsp .

For more information about Support Line and other IBM services, see
http://www.ibm.com/services/ or see http://www.ibm.com/planetwide/ for
support telephone numbers. In the U.S. and Canada, call 1-800-IBM-SERV
(1-800-426-7378).

Hardware service and support
You can receive hardware service through your IBM reseller or IBM Services.

To locate a reseller authorized by IBM to provide warranty service, go to
http://www.ibm.com/partnerworld/ and click Find Business Partners on the
right side of the page. For IBM support telephone numbers, see
http://www.ibm.com/planetwide/ . In the U.S. and Canada, call 1-800-IBM-SERV
(1-800-426-7378).
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In the U.S. and Canada, hardware service and support is available 24 hours a day,
7 days a week. In the U.K., these services are available Monday through Friday,
from 9 a.m. to 6 p.m.

IBM Taiwan product service
Use this information to contact IBM Taiwan product service.

IBM Taiwan product service contact information:

IBM Taiwan Corporation
3F, No 7, Song Ren Rd.
Taipei, Taiwan
Telephone: 0800-016-888
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for
convenience only and do not in any manner serve as an endorsement of those
websites. The materials at those websites are not part of the materials for this IBM
product, and use of those websites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Trademarks
IBM, the IBM logo, and ibm.com® are trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide. Other product and
service names might be trademarks of IBM or other companies.

A current list of IBM trademarks is available on the web at “Copyright and
trademark information” at http://www.ibm.com/legal/copytrade.shtml .
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Adobe and PostScript are either registered trademarks or trademarks of Adobe
Systems Incorporated in the United States and/or other countries.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc., in
the United States, other countries, or both and is used under license therefrom.

Intel, Intel Xeon, Itanium, and Pentium are trademarks or registered trademarks of
Intel Corporation or its subsidiaries in the United States and other countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in
the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Important notes
Processor speed indicates the internal clock speed of the microprocessor; other
factors also affect application performance.

CD or DVD drive speed is the variable read rate. Actual speeds vary and are often
less than the possible maximum.

When referring to processor storage, real and virtual storage, or channel volume,
KB stands for 1024 bytes, MB stands for 1,048,576 bytes, and GB stands for
1,073,741,824 bytes.

When referring to hard disk drive capacity or communications volume, MB stands
for 1,000,000 bytes, and GB stands for 1,000,000,000 bytes. Total user-accessible
capacity can vary depending on operating environments.

Maximum internal hard disk drive capacities assume the replacement of any
standard hard disk drives and population of all hard disk drive bays with the
largest currently supported drives that are available from IBM.

Maximum memory might require replacement of the standard memory with an
optional memory module.

IBM makes no representation or warranties regarding non-IBM products and
services that are ServerProven, including but not limited to the implied warranties
of merchantability and fitness for a particular purpose. These products are offered
and warranted solely by third parties.

IBM makes no representations or warranties with respect to non-IBM products.
Support (if any) for the non-IBM products is provided by the third party, not IBM.

Some software might differ from its retail version (if available) and might not
include user manuals or all program functionality.
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Particulate contamination
Attention: Airborne particulates (including metal flakes or particles) and reactive
gases acting alone or in combination with other environmental factors such as
humidity or temperature might pose a risk to the device that is described in this
document.

Risks that are posed by the presence of excessive particulate levels or
concentrations of harmful gases include damage that might cause the device to
malfunction or cease functioning altogether. This specification sets forth limits for
particulates and gases that are intended to avoid such damage. The limits must not
be viewed or used as definitive limits, because numerous other factors, such as
temperature or moisture content of the air, can influence the impact of particulates
or environmental corrosives and gaseous contaminant transfer. In the absence of
specific limits that are set forth in this document, you must implement practices
that maintain particulate and gas levels that are consistent with the protection of
human health and safety. If IBM determines that the levels of particulates or gases
in your environment have caused damage to the device, IBM may condition
provision of repair or replacement of devices or parts on implementation of
appropriate remedial measures to mitigate such environmental contamination.
Implementation of such remedial measures is a customer responsibility.

Table 82. Limits for particulates and gases

Contaminant Limits

Particulate v The room air must be continuously filtered with 40% atmospheric
dust spot efficiency (MERV 9) according to ASHRAE Standard 52.21.

v Air that enters a data center must be filtered to 99.97% efficiency or
greater, using high-efficiency particulate air (HEPA) filters that meet
MIL-STD-282.

v The deliquescent relative humidity of the particulate contamination
must be more than 60%2.

v The room must be free of conductive contamination such as zinc
whiskers.

Gaseous v Copper: Class G1 as per ANSI/ISA 71.04-19853

v Silver: Corrosion rate of less than 300 Å in 30 days

1 ASHRAE 52.2-2008 - Method of Testing General Ventilation Air-Cleaning Devices for
Removal Efficiency by Particle Size. Atlanta: American Society of Heating, Refrigerating
and Air-Conditioning Engineers, Inc.

2 The deliquescent relative humidity of particulate contamination is the relative humidity
at which the dust absorbs enough water to become wet and promote ionic conduction.

3 ANSI/ISA-71.04-1985. Environmental conditions for process measurement and control
systems: Airborne contaminants. Instrument Society of America, Research Triangle Park,
North Carolina, U.S.A.

Documentation format
The publications for this product are in Adobe Portable Document Format (PDF)
and should be compliant with accessibility standards. If you experience difficulties
when you use the PDF files and want to request a web-based format or accessible
PDF document for a publication, direct your mail to the following address:

Information Development
IBM Corporation
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205/A015
3039 E. Cornwallis Road
P.O. Box 12195
Research Triangle Park, North Carolina 27709-2195
U.S.A.

In the request, be sure to include the publication part number and title.

When you send information to IBM, you grant IBM a nonexclusive right to use or
distribute the information in any way it believes appropriate without incurring any
obligation to you.

Telecommunication regulatory statement

This product is not intended to be connected directly or indirectly by any means
whatsoever to interfaces of public telecommunications networks, nor is it intended
to be used in a public services network.

Electronic emission notices
When you attach a monitor to the equipment, you must use the designated
monitor cable and any interference suppression devices that are supplied with the
monitor.

Federal Communications Commission (FCC) statement
Note: This equipment has been tested and found to comply with the limits for a
Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference when the
equipment is operated in a commercial environment. This equipment generates,
uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instruction manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential area is likely to cause
harmful interference, in which case the user will be required to correct the
interference at his own expense.

Properly shielded and grounded cables and connectors must be used in order to
meet FCC emission limits. IBM is not responsible for any radio or television
interference caused by using other than recommended cables and connectors or by
unauthorized changes or modifications to this equipment. Unauthorized changes
or modifications could void the user's authority to operate the equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) this device may not cause harmful interference, and
(2) this device must accept any interference received, including interference that
might cause undesired operation.

Industry Canada Class A emission compliance statement
This Class A digital apparatus complies with Canadian ICES-003.

Avis de conformité à la réglementation d'Industrie Canada
Cet appareil numérique de la classe A est conforme à la norme NMB-003 du
Canada.
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Australia and New Zealand Class A statement
Attention: This is a Class A product. In a domestic environment this product may
cause radio interference in which case the user may be required to take adequate
measures.

European Union EMC Directive conformance statement
This product is in conformity with the protection requirements of EU Council
Directive 2004/108/EC on the approximation of the laws of the Member States
relating to electromagnetic compatibility. IBM cannot accept responsibility for any
failure to satisfy the protection requirements resulting from a nonrecommended
modification of the product, including the fitting of non-IBM option cards.

Attention: This is an EN 55022 Class A product. In a domestic environment this
product may cause radio interference in which case the user may be required to
take adequate measures.

Responsible manufacturer:

International Business Machines Corp.
New Orchard Road
Armonk, New York 10504
914-499-1900

European Community contact:

IBM Technical Regulations, Department M456
IBM-Allee 1, 71137 Ehningen, Germany
Telephone: +49 7032 15-2937
Email: tjahn@de.ibm.com

Germany Class A statement
Deutschsprachiger EU Hinweis: Hinweis für Geräte der Klasse A EU-Richtlinie
zur Elektromagnetischen Verträglichkeit

Dieses Produkt entspricht den Schutzanforderungen der EU-Richtlinie
2004/108/EG zur Angleichung der Rechtsvorschriften über die elektromagnetische
Verträglichkeit in den EU-Mitgliedsstaaten und hält die Grenzwerte der EN 55022
Klasse A ein.

Um dieses sicherzustellen, sind die Geräte wie in den Handbüchern beschrieben zu
installieren und zu betreiben. Des Weiteren dürfen auch nur von der IBM
empfohlene Kabel angeschlossen werden. IBM übernimmt keine Verantwortung für
die Einhaltung der Schutzanforderungen, wenn das Produkt ohne Zustimmung der
IBM verändert bzw. wenn Erweiterungskomponenten von Fremdherstellern ohne
Empfehlung der IBM gesteckt/eingebaut werden.

EN 55022 Klasse A Geräte müssen mit folgendem Warnhinweis versehen werden:
“Warnung: Dieses ist eine Einrichtung der Klasse A. Diese Einrichtung kann im
Wohnbereich Funk-Störungen verursachen; in diesem Fall kann vom Betreiber
verlangt werden, angemessene Maßnahmen zu ergreifen und dafür
aufzukommen.”
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Deutschland: Einhaltung des Gesetzes über die
elektromagnetische Verträglichkeit von Geräten

Dieses Produkt entspricht dem “Gesetz über die elektromagnetische Verträglichkeit
von Geräten (EMVG)”. Dies ist die Umsetzung der EU-Richtlinie 2004/108/EG in
der Bundesrepublik Deutschland.

Zulassungsbescheinigung laut dem Deutschen Gesetz über die
elektromagnetische Verträglichkeit von Geräten (EMVG) (bzw. der
EMC EG Richtlinie 2004/108/EG) für Geräte der Klasse A

Dieses Gerät ist berechtigt, in Übereinstimmung mit dem Deutschen EMVG das
EG-Konformitätszeichen - CE - zu führen.

Verantwortlich für die Einhaltung der EMV Vorschriften ist der Hersteller:

International Business Machines Corp.
New Orchard Road
Armonk, New York 10504
914-499-1900

Der verantwortliche Ansprechpartner des Herstellers in der EU ist:

IBM Deutschland
Technical Regulations, Department M456
IBM-Allee 1, 71137 Ehningen, Germany
Telephone: +49 7032 15-2937
Email: tjahn@de.ibm.com

Generelle Informationen:

Das Gerät erfüllt die Schutzanforderungen nach EN 55024 und EN 55022 Klasse
A.

Japan VCCI Class A statement

This is a Class A product based on the standard of the Voluntary Control Council
for Interference (VCCI). If this equipment is used in a domestic environment, radio
interference may occur, in which case the user may be required to take corrective
actions.

Japan Electronics and Information Technology Industries
Association (JEITA) statement
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Japan Electronics and Information Technology Industries Association (JEITA)
Confirmed Harmonics Guidelines with Modifications (products greater than 20 A
per phase)

Korea Communications Commission (KCC) statement

This is electromagnetic wave compatibility equipment for business (Type A). Sellers
and users need to pay attention to it. This is for any areas other than home.

Russia Electromagnetic Interference (EMI) Class A statement

People's Republic of China Class A electronic emission
statement

Taiwan Class A compliance statement
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Hardware Status
operating systems, supported 85

harmless events filter 311
Health summary 445
help

getting 683
help, World Wide Web 684

I
I/O module plug-ins 578
IBM Director Agent

encryption, enabling
IBM i (formerly i5/OS) 227
Linux 228, 231
Windows 233

IBM i (formerly i5/OS)
installing 213

installing
AIX 210
Linux for System x 215
Linux for X-Architecture 215
Power Systems 214
Windows 217

Linux, installing on
dirinstall script 228, 231
Net-SMNP, enabling 228, 231
Wake on LAN, enabling 228, 231

preparing, for installation 210, 214,
215, 217

Windows, installing on
encryption, enabling 233
features, selecting 233
InstallShield wizard, using 233
network driver, configuring 233
securing managed system 233
security state, setting 233
software-distribution settings 233
Wake on LAN, enabling 233

IBM Director Console
creating users 52

IBM Director Core Service
installing

Linux for System x 242
Windows 244

installing on
IBM i 246
Linux for POWER 246

preparing, for installation 242, 244
IBM Director Core Services

installing 240
IBM i 241
System p 241

preparing, for installation 241
IBM Enhanced Role Based Security

Snap-in 44
IBM Fabric Manager (IFM) 538, 539

predefined I/O address pool
subranges 541

IBM Fabric Manager (IFM) (continued)
stand-alone, with Configuration

Patterns 539
stand-alone, with Flex System

Manager 539
using with Configuration

Patterns 538, 539
IBM Flex System 535

System profiles 535
IBM Flex System FC5022 16Gb SAN

switch
discovering 608, 632
managing 608, 632
SMIA Configuration Tool 608, 632
Storage Control 608, 632
VMControl 608, 632

IBM Flex System FC5022 16Gb SAN
Switch

changing the IP address 636
changing the SMIA Configuration

Tool user ID and password 611,
634

discovery 610, 629
managing 610, 611, 629, 634, 636
SMIA Configuration Tool 611, 634,

636
Storage Control 610, 611, 629, 634,

636
VMControl 610, 611, 629, 634, 636

IBM Flex System Manager for mobile
devices 125, 126, 127, 128

Android 129
Android OS 129
Apple iOS 129, 130
BlackBerry OS 129
installing 129, 130

IBM Flex System Manager management
node

changing network settings 149
configuring network settings 149
IP address 149

IBM Flex System Manager management
software 6

Chassis Management Module
(CMM) 5

initial setup 132
managing external storage

subsystems 7
managing network switches 7
managing storage nodes 7
set up 137, 139, 140
setting up 132
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information center 684
initial setup

configuring chassis components 137,
139

Initial setup 132
installing

agent packages 218, 261
Common Agents 218, 261
IBM Director Core Service

IBM i 246
Linux for POWER 246

Level-1 agents 218, 261
Level-2 agents 218, 261
Platform Agents 218, 261
prerequisites 131
Virtualization Manager
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agents 218, 261
installing a compute node with Remote

Control 553, 554
installing agents 209

698 Systems Management Guide



InstallShield wizard
IBM Director Agent 233
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operating systems, supported 85

IP address, management node 149
ISMP

alert-forwarding strategies 575

J
Japan Electronics and Information

Technology Industries Association
statement 692

Japan VCCI Class A statement 692
Japan Voluntary Control Council for

Interference Class A statement 692
JEITA statement 692

K
Korea Communications Commission

statement 693

L
LDAP

See user registries
LED (see locator-LED setting) 583, 584
Legacy security policy 27, 33
Level-1 agents

installing 218, 261
Level-2 agents

installing 218, 261
Linux for POWER

installing
IBM Director Core Service 246

Linux installation
encryption, enabling 228, 231
IBM Director Agent 228, 231
starting 228, 231

locator-LED setting 583, 584
log in

after password reset 45
temporary password 45

logging in 45
after password reset 45
temporary password 45

logical partition
relocation 239

login
locked out of the web interface 45
temporary password 45

logs
audit 79
collecting 567

M
managed chassis

network requirements 22
managed network devices

network requirements 22
managed resources 5

checking firmware levels 513, 555
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configuring with IBM Flex System

Manager management
software 137, 139

Display Name 514
naming 514
network requirements 22
renaming 514

managed systems
preparing

AIX 293
IBM i 294
Windows 294
Windows Server 2003 295
Windows Server 2008 295, 301
Windows Vista 296
Windows XP 299

resource monitor 501
running command-line programs 370
securing

IBM Director Agent installation,
during 233

management domains 18, 503, 504
management modules

locator-LED setting 583
password, changing 579

management network 22
centralized user management

mode 149
changing network settings 149
decentralized user management

mode 149
management node

Common Agent 8
managed resources 8
management software 8
port availability 8
ports 8

Management Processor Assistant Agent
managed system, installing on 233

management software 513, 555
applications

SMIA Configuration Tool 608,
611, 632, 634, 636

backing up 96, 101
backup 96
capabilities 1
checking firmware of managed

resources 513, 555
disaster recovery 96
features 1
functions 1
IBM Flex System FC5022 16Gb SAN

switch 608, 632
IBM Flex System V7000 Storage

Node 599
IBM SAN Volume Controller 599
IBM Storwize 599
IBM Storwize V7000 599
IBM System Storage DS8000 599
IBM System Storage SAN24B-4

Express switch, discovering 608,
632

IBM XIV Storage System Gen3 599
optical media 673
recovering from optical media 667,

668

management software (continued)
recovery 667, 670, 673
Recovery DVDs 673
reinstallation 667, 670
reinstalling 667
restoring 96, 101
restoring from backup 102
storage tasks 599
supported storage 599
supported storage-network
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supported storage-network

devices 599
supported storage-network
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viewing the PCIe expansion

node 556
viewing the Storage expansion

node 557
what's new in version 1.3.2 1

management software problems
log in 45
password 45
recovery from optical media 673
recovery from partition 667

management software recovery 667, 668
manageV7000 593, 603
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network adapters 599
network switches 599
storage products 599
storage-network devices 599

managing chassis 136, 503, 523
remote 508

managing compute nodes 523, 525
Power Systems 587, 588, 591

managing IBM Flex System V7000
Storage Node 593

managing network switches 615
Managing Open Pages 117
managing storage resources 593, 595,
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managing 604, 605, 606, 615
problems with SMIA Configuration

Tool 613
setting SNMP 606
SMIA Configuration Tool 613

memory
usage resource monitor 501
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compiling 497
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network

configuration 22
requirements 22

network adapters
configuring with Configuration
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network devices

provisioning adapters with
Configuration Patterns 535

supported for Configuration
Patterns 535

supported for Configuration
Patterns 535

network devices
checking firmware levels 513, 555
IBM Flex System FC5022 16Gb SAN

switch, activating with management
software 608, 632

IBM Flex System FC5022 16Gb SAN
Switch, activating with management
software 611, 634, 636

IBM Flex System FC5022 16Gb SAN
Switch, discovering with
management software 610, 629

IBM System Storage SAN24B-4
Express switch 608, 632

network switches 7
discovering 615
installing Features on Demand

keys 95
managing 615
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software 599
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Network Time Protocol
See NTP servers
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electronic emission 690
FCC, Class A 690

NTP
See NTP servers
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operating system

installing on a compute node 531
support for tasks 85
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nodes 138, 544, 545, 546, 547, 548,
549, 551

installing RHEL Virtualization
profiles 546
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ESXi 552
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supported for FSM deployment 545,
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service processor 574
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changing 30, 31
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SELinux 284
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installing 218, 261
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Common Agent 582
Platform Agent 582
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service processor 580
System x 580, 581, 582
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Power Systems compute
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firewalls 11
IBM i

IBM Director Core Services,
installation of 241

Linux for System x
IBM Director Agent, installation
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IBM Director Core Service,

installation of 242
Linux for X-Architecture

IBM Director Agent, installation
of 215

Platform Agent managed system 240
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IBM Director Agent, installation
of 214
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System p

IBM Director Core Services,
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Windows
IBM Director Agent, installation

of 217
IBM Director Core Service,

installation of 244
problems

determining the source of
problems 677
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viewing 516, 675
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viewing 499

process monitors
creating 500
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viewing 499

processor
resource monitor 501
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recovery DVDs 667, 668
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Recovery DVDs 673
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See also Remote Control
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resolving problems 568, 569, 570, 571
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remote management 508
Remote Supervisor Adapter 573, 580
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password, changing 579
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removing 148
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unmanaging a chassis 519
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requirements

hardware 3
hardware and software 3
software 3

resetting a compute node 530
resource management 523
Resource manager 251
Resource Monitors

attributes 469
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resource types
types 576

resources
event automation plans 345

response file
dircon.rsp 246
modifying 246

restart compute node 529
restarting a compute node 530
restarting the service processor 530
restore 96, 147

1.1.0 105
1.1.1 105
1.2.0 105
earlier version 105
from a USB drive 103
from an SFTP server 104
from the hard disk drive 102, 103,
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compatibility 101
restoring

from backup 96
management software 96, 102

RHEL Virtualization profile 546
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Russia Class A electromagnetic

interference statement 693

Russia Electromagnetic Interference (EMI)
Class A statement 693

S
SAN24B-4 Express Switch 599
scalable partitions

Power On/Off 580
Scheduler

running
programs and processes 370

summary, viewing 336
scheduling backups 101
SCP, copying files with 106
Secure security policy 32
security 24, 25, 26, 27, 29, 30, 31, 32, 33,

76
anonymous command execution 373
certificate policies 36, 37
communication protocols 79
encryption 79
events filter 311
Legacy security policy 25
process management 370
Secure security policy 25

security policies
centralized management 20
changing 26
Legacy 25
managing 19
Secure 25

security policy
Secure 25

SELinux 284
serial access 558
serial console 558
server auditing 79
server logs

collecting 567
Server patterns 533, 534

network adapters 535
server profiles 535
service and support

before you call 683
hardware 684
software 684

Service and Support Manager 140
service processor

Power On/Off 580
service processors
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in-band communication 573
locator-LED setting 583
out-of-band communication 574
resource types 576

service request, submitting with IBM Flex
System Manager management
software 678

setting 148
setup wizard 132
SFTP server, backing up to 100
silent parameter 235
simple event filter

definition 311
predefined filters 311

smcli commands 48
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troubleshooting 608, 632
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SNMP Browser 496
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configuring

attributes 496
monitoring performance 496
viewing attributes 496

software
backing up 98, 99, 100
down-level version
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earlier version 105
restoring an image 102, 103, 104, 105
updates 375

software backups
See management software

software service and support telephone
numbers 684

status
out-of-sync 25
pending 25
summary, viewing 440

status entry
delete 490

storage
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supported devices 599
supported network adapters 599
supported network switches 599

Storage Control 599
rediscovering a storage farm 663
troubleshooting 663

storage events filter 311
Storage expansion node

monitoring 557
viewing in management

software 557
storage farm

rediscovering 663
troubleshooting 663

storage management 593, 595, 596, 599,
602, 603, 604, 605, 606, 613, 615

changing the FC5022 switch IP
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changing the SMIA Configuration
Tool user ID and password 611,
634

discovering an IBM Flex System
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SAN24B-4 Express switch 608, 632
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password 611, 634
storage management application 636
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configuring 604, 605, 606, 615
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managing 604, 605, 606, 615

storage network devices (continued)
SMIA Configuration Tool

problems 613
troubleshooting 613

SNMP 606
storage node 602

IBM Flex System Manager
management software user
interface 595, 596

managing 593, 603
storage nodes 7

checking firmware levels 513, 555
storage nodes, managing 593
storage subsystems, external 7
storage switches

configuring 604, 605, 606, 615
managing 604, 605, 606, 613, 615
setting SNMP 606, 613

storage volume 641, 643, 644, 647, 649
Storwize V7000 602

collecting inventory for 603
discovering 603
managing 603

subscriptions
See events

summary
BladeCenter and System x

management summary 577
supported SAN switches 599
supported storage 599
supported web browsers 110
SVC 599
switches

See network switches
system configuration 77
System profiles 535
system triggers 77
system variables

event filters 340
System x

Power On/Off 582
summary, viewing 577

systems
event filters 340

T
Taiwan Class A compliance

statement 693
task 76
tasks

locator-LED setting 583, 584
management server support 85
operating systems, supported 85
performing on multiple groups 118
Power On/Off 580, 581, 582
Resource Monitors 501
SNMP Browser 496
User Administration 52

telecommunication regulatory
statement 690

threshold event
simple event filter 311

threshold event filter 314
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activate 482
create 480

thresholds (continued)
deactivate 483
delete 483
edit 481
resource monitor 501
view 479

time
configuring 148

time range
event filters 340

toolbar
User Administration 52
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troubleshooting

IBM Flex System V7000 Storage
Node 659, 660

logical partition 239
manageV7000 command 659, 660
MEPs, duplicate 239
SMIA Configuration Tool 613
SSH to storage node 659, 660
Storage Control 663
storage farm 663

turn off compute node 529

U
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United States electronic emission Class A

notice 690
United States FCC Class A notice 690
unknown events filter 311
unmanaging chassis 517

removing guest operating systems on
VMs 519

removing operating systems 518
removing virtual servers 520

Update Manager 375
operating systems, supported 85

updates 145, 375
firmware 588
Power Systems compute nodes 588

Updating
IBM Flex System Manager

management software 135
updating a compute node 555
user

IDs
operating system 52

profiles 52
user accounts

DirAdmin and DirSuper 42
management server running

Linux 42
management server running

Windows 42
service account 42

User Administration
task 52

user groups 41
user IDs, predefined 38
user interfaces 109

IBM Flex System Manager for mobile
devices 125, 126, 127, 128, 129, 130

web interface 109, 110
user management 24, 39, 40, 41, 46, 144

decentralized 21
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external 20, 39, 40, 41, 141, 144
local 20, 39, 40, 41, 141, 144
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groups 39, 40, 41, 144
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V
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version 1.3.2

what's new 1
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installing
IBM Systems Director Common
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VIOS and VMControl 587
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virtual servers 519, 520
Virtualization Manager subagents

installing 218, 261
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VMware ESXi (vSphere)
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VMware ESXi limitation 552

W
Wake on LAN

enabling on AIX 222
enabling on VIOS 238
enabling on Windows

IBM Director Agent,
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warning events filter 311
Watchdog 268
web browsers, supported 110
web interface
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Access states 80
log in problems 45
overview 109
using 109

Web interface
open pages 117

web interface access problems 45
web interfaces

logging in 110
supported web browsers 110
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Windows
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preparing

managed system 294
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(Windows) 233
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Security settings 233
Software Distribution settings 233
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Common Agent 233
encryption, enabling 233
Platform Agent 251

Windows Server 2003
preparing

managed system 295
Windows Server 2008

preparing
managed system 295, 301
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preparing

managed system 296
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preparing
managed system 299
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Event Automation Plan 338, 342, 343
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importing automation data 368

Z
z/VM manageability access point agents

installing 218, 261

Index 703



704 Systems Management Guide





IBM®

Part Number: 00FH231

Printed in USA

(1P) P/N: 00FH231


	Contents
	Chapter 1. Overview of the IBM Flex System management node
	What’s new in version 1.3.2
	Before you begin
	Related documentation
	The IBM Documentation CD
	Hardware and software requirements
	Using the Documentation Browser

	Notices and statements in this document

	Managed resources
	Chassis Management Module (CMM) in an IBM Flex System environment
	X-Architecture compute nodes in an IBM Flex System environment
	Power Systems compute nodes in an IBM Flex System environment
	Storage systems and network switches in an IBM Flex System environment

	Port and operating system requirements
	Port availability
	Preparing firewalls and proxies for IBM Flex System Manager
	Operating systems supported by IBM Flex System Manager
	IBM Flex System Manager task support for VMware ESXi (vSphere) systems

	Management domains
	Chassis management
	Management software user registry
	Centralized user management
	Decentralized user management

	Network configuration and requirements
	Security
	Security policies
	Secure security policy
	Legacy security policy
	Changing the management software security policy

	Password policies
	Password policy settings
	Setting a new password
	Changing a user password
	Changing the system password
	Password policy settings for the Secure security policy
	Password policy settings for the Legacy security policy

	Certificate policies
	Implicit certificate policy
	Explicit certificate policy
	Changing the certificate policy

	Predefined user IDs and passwords
	Users, user groups, and roles
	Users and Groups page in the web interface
	Authenticating users to IBM Flex System Manager
	Authorizing users to IBM Flex System Manager
	Managing credentials in IBM Flex System Manager
	Managing access
	Managing auditing
	Communication protocols and supported encryption algorithms

	Access states of managed resources

	Agents
	IBM Flex System Manager task support by operating system and agent levels
	Choosing the level of agent capabilities to deploy on managed systems
	Choosing the level of agent capabilities to deploy on X-Architecture managed systems
	Choosing the level of agent capabilities to deploy on IBM Power Systems


	Features on Demand
	Using Features on Demand keys
	List of Features on Demand
	Installing Features on Demand keys on network switches

	Backing up and restoring the management software
	Backing up the management software image
	Backing up the management software image to the hard disk drive
	Backing up the management software image to a USB drive
	Backing up the management software image to a secure FTP server
	Scheduling management software image backups

	Restoring and version compatibility
	Restoring the management software image
	Restoring a management software image from the hard disk drive
	Restoring a management software image from a USB drive
	Restoring the management software image from a secure FTP server
	Restoring an earlier version of the management software image


	Moving files to and from the management node

	Chapter 2. User interfaces
	Using the web interface
	Accessing the management software web interfaces
	The web interface
	Finding and navigating resources
	The Welcome banner area
	Table view
	Managing and closing open pages in the web interface
	Groups

	Planning Secure Sockets Layer configuration on IBM Flex System Manager
	Requesting a CA signed certificate
	Receiving a CA signed certificate
	Creating a self-signed certificate
	Updating the Web browser with the new certificate


	Introduction to the IBM FSM Explorer console
	Finding groups, resources, and tasks in IBM FSM Explorer

	Using IBM Flex System Manager for mobile devices
	Downloading the IBM Flex System Manager for mobile devices application
	Setting up IBM Flex System Manager for mobile devices
	Creating a Java keystore and Certificate Signing Request to submit to a CA
	Installing a keystore on the management node
	Installing certificates on mobile device operating systems



	Chapter 3. Configuring the IBM Flex System Manager management software
	Initial setup
	Setting up the IBM Flex System Manager management node
	Checking and updating the management software
	Selecting chassis for management
	Configuring chassis components
	Deploying operating systems
	Updating chassis components
	Launching IBM FSM Explorer

	Additional setup
	Setting up Electronic Service Agent (ESA)
	Configuring the management software user registry
	Managing users and user groups
	Automate checking for updates
	Deploying common configurations
	Deploying agents

	Backing up the management software image after setup
	Adding or removing NTP servers
	Changing an IBM Flex System Manager management node IP address

	Chapter 4. Updating systems
	Planning to update systems
	Supported update tasks
	Update considerations for specific operating systems and platforms
	Update considerations for AIX systems
	Update considerations for Hardware Management Console systems
	Update considerations for IBM i systems
	Update considerations for Linux systems
	Update considerations for IBM Power I/O firmware
	Update considerations for Power Systems firmware
	Update considerations for X-Architecture compute nodes
	Update considerations for Virtual I/O Server systems
	Update considerations for VMware ESXi systems
	Update considerations for multi-node systems
	Update considerations for Nimitz firmware

	Determining the installed IBM Flex System Manager version

	Starting to monitor and update systems
	Configuring update manager
	Updating IBM Flex System Manager
	Updating without an Internet connection

	Acquiring and installing updates
	Acquiring and installing updates with the IBM Flex System Manager Web interface
	Showing needed updates
	Showing all installable updates
	Showing installed updates
	Checking for new updates
	Downloading updates
	Importing updates
	Exporting updates
	Installation staging
	Viewing information about updates
	Managing update groups
	Installing updates on systems
	Removing update files
	Uninstalling updates

	Acquiring and installing updates with the installneeded command

	Keeping systems in compliance
	Compliance policies
	Adding updates to a compliance policy
	Create and configure compliance policies
	Identifying systems that are out of compliance
	Resolving compliance issues


	Chapter 5. Installing agents
	Installing Common Agent
	Preparing for a Common Agent managed system
	Preparing to install Common Agent on AIX
	Preparing to install Common Agent on IBM i
	Preparing to install Common Agent on Linux on Power Systems
	Preparing to install Common Agent on X-Architecture systems
	Preparing VMware managed systems
	Preparing to install Common Agent on Windows

	Installing agents using the Agent Installation Wizard
	Installing Common Agent manually
	Installing Common Agent on AIX and VIOS
	Installing Common Agent on IBM i
	Installing Common Agent on Linux on Power Systems
	Installing Common Agent on Linux for X-Architecture compute nodes
	Installing Common Agent on Windows
	Installing Common Agent on Virtual I/O Server

	Duplicate MEPs appear after relocating logical partition from AIX system

	Installing Platform Agent
	Preparing for a Platform Agent managed system
	Preparing to install Platform Agent on IBM i
	Preparing to install Platform Agent on Linux on Power Systems
	Preparing to install Platform Agent on Linux for X-Architecture systems
	Preparing VMware managed systems
	Preparing to install Platform Agent on Windows

	Installing Platform Agents using the Deploy Agents wizard
	Installing Platform Agent manually
	Installing Platform Agent on IBM i
	Installing Platform Agent on Linux on Power Systems
	Installing Platform Agent on Linux for X-Architecture compute nodes
	Installing Platform Agent on Windows



	Chapter 6. Managing agents
	Common agent services
	Resource manager
	Agent manager
	Common agent

	Logging Platform Agent
	Importing agent packages
	Installing agents using the Agent Installation Wizard
	Restarting agents
	Restarting Common Agent
	Restarting Platform Agent
	Platform Agent Watchdog


	Setting the agent manager for IBM Flex System Manager
	Viewing the agent manager properties
	Adding a new agent manager
	Setting the active agent manager
	Deleting an agent manager
	Using a remote agent manager with IBM Flex System Manager
	Using the embedded agent manager of a remote IBM Flex System Manager

	Identifying, registering, and unregistering the agent manager used by a Common Agent
	Identifying the agent manager for a Common Agent managed system
	Unregistering the agent manager for a Common Agent managed system
	Registering a Common Agent managed system with the IBM Flex System Manager agent manager

	Changing the agent manager certificate
	Updating the agent manager certificate

	Securing Common Agent managed systems
	Changing the agent registration password

	Binding Platform Agent to specific IP addresses
	Changing the Common Agent IP address
	Critical services for monitoring Platform Agent hardware
	Configuring Platform Agent for SELinux policies
	Enabling and disabling tracing on Pegasus CIM Server
	Configuring Common Agent
	Configuring SNMP for Platform Agent on Linux to forward traps to the IBM Flex System Manager

	Chapter 7. Preparing agentless managed systems
	Configuring access to agentless managed systems
	Using sudo and key-pair authentication to configure access
	Sample sudo configuration file

	Preparing AIX managed systems
	Preparing IBM i managed systems
	Preparing VMware managed systems
	Preparing Windows managed systems
	Preparing Windows Server 2003 managed systems
	Preparing Windows Server 2008 managed systems
	Preparing Windows Vista managed systems
	Preparing to manage an agentless managed system running Windows Vista
	Preparing a Windows Vista system for Platform Agent managed system management
	Preparing a Windows Vista system for Common Agent managed system management

	Preparing Windows XP managed systems
	Preparing Windows Server 2012 managed systems


	Chapter 8. Automating tasks
	Events, filters, and actions in event automation plans
	Events
	Mapping SNMP traps to Flex System Manager events
	Forwarding SNMP traps from IBM Flex System Manager to any SNMP application

	Event filters
	Simple event filter
	Duplication event filter
	Exclusion event filter
	Recurring event filter

	Event actions
	Log to a log file
	Modify an event and send it
	Post to a newsgroup (NNTP)
	Send a Tivoli Enterprise Console event
	Send an Internet (SMTP) e-mail
	Send an e-mail to a mobile phone
	Send an event to Tivoli Event Integration Facility probe
	Send an SNMP INFORM request to an IP host
	Send an SNMP trap reliably to a NetView host
	Send an SNMP trap to an IP host
	Send events to Syslog server
	Set an event system variable
	Start a program on a system
	Start a program on the system that generated the event
	Start a task on a specified system
	Start a task on the system that generated the event
	Static group: add or remove group members
	Static group: add or remove the event-generating system
	Timed alarm that generates an event

	Monitoring events that are specific to the operating system

	Mapping SNMP traps to Flex System Manager events
	Viewing the automation manager summary
	Managing event automation plans
	Copying an event automation plan
	Creating an event automation plan
	Selecting the events that trigger an event action
	Creating an event automation plan based on an existing threshold

	Deactivating and activating an event automation plan
	Deleting an event automation plan
	Editing an event automation plan
	Suspending and resuming event automation plans
	Viewing event automation plans associated with a resource
	Viewing event automation plan properties

	Managing event actions
	Creating an event action
	Editing an event action
	Copying an event action
	Testing an event action
	Deleting an event action
	Saving and not saving an event-action history
	Viewing an event-action history
	Refreshing entries in an event-action history log
	Deleting entries from an event-action history log
	Viewing event action properties
	Event-data-substitution variables

	Managing event filters
	Creating, editing, or copying an event filter
	Editing an event filter
	Copying an event filter
	Viewing event filter properties
	Viewing predefined filter criteria
	Deleting an event filter

	Exporting and importing event automation plans, event filters, and event actions
	Migrating and importing event automation data from a previous version
	Using command automation
	Creating or editing a command definition
	Running a command definition
	Restricting anonymous command execution
	Restricting anonymous command execution on Linux
	Restricting anonymous command execution on Windows



	Chapter 9. Updating firmware and software
	Chapter 10. Updating systems
	Planning to update systems
	Supported update tasks
	Update considerations for specific operating systems and platforms
	Update considerations for AIX systems
	Update considerations for Hardware Management Console systems
	Update considerations for IBM i systems
	Update considerations for Linux systems
	Update considerations for IBM Power I/O firmware
	Update considerations for Power Systems firmware
	Update considerations for X-Architecture compute nodes
	Update considerations for Virtual I/O Server systems
	Update considerations for VMware ESXi systems
	Update considerations for multi-node systems
	Update considerations for Nimitz firmware

	Determining the installed IBM Flex System Manager version

	Starting to monitor and update systems
	Configuring update manager
	Updating IBM Flex System Manager
	Updating without an Internet connection

	Acquiring and installing updates
	Acquiring and installing updates with the IBM Flex System Manager Web interface
	Showing needed updates
	Showing all installable updates
	Showing installed updates
	Checking for new updates
	Downloading updates
	Importing updates
	Exporting updates
	Installation staging
	Viewing information about updates
	Managing update groups
	Installing updates on systems
	Removing update files
	Uninstalling updates

	Acquiring and installing updates with the installneeded command

	Keeping systems in compliance
	Compliance policies
	Adding updates to a compliance policy
	Create and configure compliance policies
	Identifying systems that are out of compliance
	Resolving compliance issues


	Chapter 11. Monitoring system status and health
	System status and health
	Viewing the status manager summary
	Viewing the performance summary
	Using the Health Summary task to view the status of your environment
	Scoreboard
	Dashboard
	Health summary
	Using the scoreboard to identify issues
	Adding a graphical monitor to the dashboard
	Removing a graphical monitor from the dashboard
	Adding systems to the health summary
	Using the health summary favorites group to add and remove systems in the health summary
	Using the Actions menu to add systems to the health summary
	Using Resource Explorer to add systems to the health summary

	Removing a group from the health summary

	Using Resource Explorer to view the status of a specific resource
	Scenarios: Using custom monitor views, thresholds, and event automation plans
	Scenario: Using a custom monitor view in an event automation plan to report disk data by using drive letter names
	Scenario: Using a custom monitor view in an event automation plan to report cluster drive data using drive letter names

	Monitors and thresholds
	Monitor views
	AIX Monitors view
	All Monitors view
	Column Management Monitors view
	Common CIM Monitors view
	Common Monitors view
	Network Monitors view
	SNMP Monitors view
	IBM i Monitors view
	IBM i resource-monitor attributes

	VIOS Monitors view

	Managing monitors
	Viewing a monitor
	Creating a monitor view
	Editing a monitor view
	Deleting a monitor view
	Graphing a monitor

	Managing thresholds
	Viewing a threshold
	Creating a threshold
	Editing a threshold
	Activating a threshold
	Deactivating a threshold
	Deleting a threshold

	Managing status set entries
	Viewing a specific status set entry
	Viewing status set entries for a specific resource
	Viewing status set entries for a group of resources
	Activating a status set entry
	Deactivating a status set entry
	Deleting a status set entry
	Deleting a Power Systems status set entry

	Managing the event log
	Creating an event log file
	Changing event log preferences
	Creating an event filter from an event
	Deleting an event
	Replying to an IBM i inquiry message event
	Viewing events

	Viewing SNMP device attributes
	Managing MIB files
	Compiling a MIB file
	Loading MIB files into memory

	Managing process monitors
	Viewing process monitors
	Creating and configuring a process monitor
	Removing process monitors

	Recording resource-monitor statistics

	Chapter 12. Managing a chassis
	Using management domains
	Adding or removing a chassis
	Using centralized user management
	Changing the user management mode of a managed chassis
	Recovering chassis management with a CMM after a management node failure

	Managing a remote chassis
	Managing and deleting event subscriptions
	Configuring a chassis
	Configuring chassis with Configuration Patterns
	Getting started with Configuration Patterns
	Chassis patterns
	Working with chassis pattern settings

	Chassis profiles
	Using a chassis placeholder

	Viewing firmware levels of managed resources
	Naming managed resources in a chassis
	Using the Chassis Manager to manage a chassis
	Viewing chassis events and problems

	Chapter 13. Unmanaging a chassis
	Removing operating system instances for each compute node
	Removing guest operating system instances on virtual servers
	Removing virtual servers
	Remanaging a chassis after unmanaging

	Chapter 14. Managing compute nodes
	Chassis Manager
	Using the Chassis Manager to manage compute nodes
	Using the global find function
	Using common actions
	Using overlays in the Chassis Manager
	Configuring compute nodes
	Turning off compute node power
	Restarting a compute node
	Resetting a compute node with the management software

	Provisioning compute nodes
	Modifying firmware and hardware configuration settings
	Configuring compute nodes with Configuration Patterns
	Configuration Patterns and IBM Fabric Manager (IFM)

	Methods for operating-system deployment to X-Architecture compute nodes
	Using the Deploy compute node images task to deploy operating systems
	Supported operating systems for the Deploy compute node images task
	Preparing to import and deploy compute node images
	Importing operating system images
	Operating-system settings during and after deployment

	Using FSM Remote Control to deploy operating systems
	Remotely installing an operating system on an X-Architecture compute node
	Installing an operating system on an X-Architecture compute node


	Viewing and installing compute node updates
	Viewing firmware levels of managed resources

	Viewing compute node events and problems
	Viewing PCIe expansion node details
	Viewing storage expansion node details
	Using FSM Remote Control with X-Architecture compute nodes
	Accessing compute nodes with Remote Control
	Using the Remote Control page
	Thumbnail area
	Toolbar
	Video session area

	Logs and traces
	Collecting server logs

	Solving Remote Control problems
	Remote Control application will not start
	Remote Control application hangs after login
	Remote Control cannot connect to a compute node
	You cannot connect to a compute node in single-user mode
	Remote Control can connect to a compute node, but no video is available
	A compute node does not appear in Remote Control
	State of compute node in Remote Control does not match state in management software
	A drive or image cannot be mounted to a compute node
	Storage media option is not shown in the list of remote media devices available for mounting



	Chapter 15. Managing X-Architecture compute nodes
	Service processor communication
	In-band communication requirements
	Out-of-band communication requirements
	Out-of-band communication and the standard CIM protocol
	Out-of-band alert-forwarding strategies
	Out-of-band event monitoring in a redundant environment
	Service processors and resource types

	Viewing the management summary
	Downloading and activating I/O module plug-ins
	Changing the password for the chassis management module
	Managing power state settings on X-architecture compute nodes
	Power On/Off task support using out-of-band communication
	Power On/Off task support using Wake on LAN technology on X-Architecture compute nodes
	Power On/Off task support by way of the operating system on X-Architecture compute nodes
	Changing the power state on X-Architecture compute nodes

	Using locator LED settings on IBM Flex System Managercompute nodes
	Locator LEDs and out-of-band and in-band communication
	Identifying hardware with the locator LED


	Chapter 16. Managing Power Systems compute nodes
	Power Systems Host Management
	CMM requirements for Power Systems compute nodes
	Planning for Power Systems compute node updates
	Updating firmware on Power Systems compute nodes

	Chapter 17. Using CLI commands for Power Systems compute nodes
	Chapter 18. Managing storage nodes
	Managing a Flex System V7000 manually
	Management software user interfaces and the Flex System V7000 storage node
	Creating storage volumes
	Viewing and managing a Flex System V7000 storage node

	Chapter 19. Managing external storage resources
	Supported storage systems and storage-network devices
	Managing and configuring the IBM Storwize V7000
	Managing an IBM Storwize V7000

	Managing and configuring storage network devices
	Configuring the IBM Flex System FC3171 8Gb SAN Switch
	Running discovery and inventory for an IBM Flex System Manager chassis-mounted Fibre Channel switch

	Configuring the IBM Flex System FC5022 16Gb SAN Switch
	Setting SNMP credentials for the Flex System FC5022 16Gb SAN Switch
	Discovering a Flex System FC5022 16Gb SAN switch with the SMIA Configuration Tool
	Discovering a Flex System FC5022 16 Gb SAN switch with the management software
	Changing the SMIA Configuration Tool user ID and password
	Troubleshooting the SMIA Configuration Tool

	Configuring the Flex System CN4093 10Gb Converged Scalable Switch
	Discovering and managing a network switch


	Chapter 20. Managing and configuring storage
	Planning for storage management
	Storage management in real time and using configuration templates
	Managing SMI-S providers
	SMI-S providers for IBM Flex System Manager
	Storage devices that require an SMI-S provider
	Where to obtain SMI-S providers
	Use of IP addresses with SMI-S providers

	Configuring SMI-S providers
	Configuring the SMI-S provider for IBM System Storage DS3000, DS4000, and DS5000
	Enabling Authentication for the NetApp SMI-S provider
	Enabling Authentication for the NetApp SMI-S provider (Version 10.19.GG.xx)


	Discovering and collecting inventory for storage devices
	Running Discovery and unlocking storage devices using SMI-S providers
	Running Direct Connection discovery and unlocking storage devices using SMI-S providers
	Running System Discovery for multiple SMI-S providers using multicast and broadcast
	Collecting inventory for devices managed by IBM Tivoli Storage Productivity Center
	Running discovery and inventory for an IBM Flex System Manager chassis-mounted Fibre Channel switch
	Discovering a Flex System FC5022 16 Gb SAN switch with the management software

	Working with external storage applications
	Installing and configuring external storage applications
	Installing and configuring IBM Tivoli Storage Productivity Center
	Configuring SNMP trap forwarding for IBM Tivoli Storage Productivity Center
	Installing and configuring IBM DS Storage Manager for DS4000
	Discovering a Flex System FC5022 16Gb SAN switch with the SMIA Configuration Tool
	Changing the SMIA Configuration Tool user ID and password
	Re-discovering the Flex System FC5022 16Gb SAN switch after changing the switch IP address

	Launching an external storage management application
	Requirements for IBM Tivoli Storage Productivity Center
	Requirements for IBM DS Storage Manager


	Viewing storage devices
	Storage Management Summary
	Viewing storage systems using storage groups
	Viewing storage volumes
	Viewing the health and status of storage devices
	Storage topology perspective

	Managing storage in real-time
	Managing storage volumes in real time
	Creating storage volumes
	Creating a storage volume in real-time


	Managing storage with configuration templates
	Viewing storage configuration templates
	Changing storage configuration templates
	Creating a configuration template for a storage volume


	Chapter 21. IBM Flex System Manager Storage Control
	IBM Flex System Manager Storage Control overview
	Supported SMI-S providers for DS3000, DS4000, and DS5000

	Updating Storage Control
	Managing storage with IBM Flex System Manager Storage Control
	Using Storage Control with IBM Tivoli Storage Productivity Center
	Adding a device to IBM Flex System Manager Storage Control
	Removing a device from IBM Flex System Manager Storage Control
	Monitoring health with IBM Flex System Manager Storage Control

	Troubleshooting IBM Flex System Manager Storage Control
	Access type for remote service access point is wrong
	Cannot communicate with Storage Control after changing the IBM DB2 password
	Cannot communicate with Storage Control after changing the management node IP address
	Discovering (or adding) a SAN Volume Controller or a Storwize family device in large configurations fails due to timeout
	Cannot manage an IBM Flex System V7000 Storage Node with the manageV7000 command
	Cannot SSH to IBM Flex System V7000 Storage Node from the management software
	Cannot unlock IBM Flex System V7000 Storage Node
	smcli mkdatasource hangs after a date change
	Run smcli mkdatasource for a storage device or a switch results in an unexpected error
	Column values for virtual server volumes in server-to-storage and storage-to-server reports might not match the volumes expected on the AIX virtual server
	Storage Control operations fail with SEVERE TPC Exception: OutOfMemoryError
	Rediscovering a storage farm that was deleted
	When SSH is removed or disabled, information on physical disks of IBM Flex System V7000 (nimitz) or IBM Storwize V7000 cannot be retrieved
	When you use Storage Control to manage a switch, the state of the switch is shown as Unknown
	Zone members are not discovered after changing the SNMP settings of switch
	Zone members are not retrieved if SNMP is disabled for failover on FC5022 switches


	Chapter 22. Management software recovery and reinstallation
	Reinstalling the management software from the recovery partition
	Reinstalling management software components from optical media after replacing the hard disk drive
	Reinstalling the management software from optical media after replacing an SSD
	Obtaining the IBM Flex System Manager Recovery DVDs

	Chapter 23. Solving problems
	Viewing problems
	Filtering problems

	Finding problem-resolution information through the management software web interface
	Submitting a service request
	Recovering a Chassis Management Module (CMM) after removing the management node
	Recovering management software access after an external user registry failure
	Recovering compute node boot settings after server pattern deployment

	Appendix. Getting help and technical assistance
	Before you call
	Using the documentation
	Getting help and information from the World Wide Web
	Software service and support
	Hardware service and support
	IBM Taiwan product service

	Notices
	Trademarks
	Important notes
	Particulate contamination
	Documentation format
	Telecommunication regulatory statement
	Electronic emission notices
	Federal Communications Commission (FCC) statement
	Industry Canada Class A emission compliance statement
	Avis de conformité à la réglementation d'Industrie Canada
	Australia and New Zealand Class A statement
	European Union EMC Directive conformance statement
	Germany Class A statement
	Japan VCCI Class A statement
	Japan Electronics and Information Technology Industries Association (JEITA) statement
	Korea Communications Commission (KCC) statement
	Russia Electromagnetic Interference (EMI) Class A statement
	People's Republic of China Class A electronic emission statement
	Taiwan Class A compliance statement


	Index
	A
	B
	C
	D
	E
	F
	G
	H
	I
	J
	K
	L
	M
	N
	O
	P
	R
	S
	T
	U
	V
	W
	X
	Z


